Oracle Utilities Network Management System
User’s Guide
Release 1.10.0.6
E36984-01

December 2012
Chapter 2

Trouble Management ................................................................................................................................................ 2-1

Managing Events with Trouble Management........................................................................................................ 2-1
Trouble Event Windows........................................................................................................................................... 2-1
Work Agenda......................................................................................................................................................... 2-2
Event Details ........................................................................................................................................................ 2-13
Service/Secondary Outage Manager..................................................................................................................... 2-19
Event Recorder ..................................................................................................................................................... 2-22

Damage Assessment .............................................................................................................................................. 2-23
Requests............................................................................................................................................................... 2-26
Outage Correction ............................................................................................................................................... 2-28

Managing Crews with Trouble Management......................................................................................................... 2-31
Trouble Management Windows for Managing Crews ........................................................................................ 2-31
Crew Administration............................................................................................................................................. 2-32
Crew Makeup....................................................................................................................................................... 2-35
Crew Actions ......................................................................................................................................................... 2-37
Crew List .............................................................................................................................................................. 2-40
Crew Information................................................................................................................................................ 2-42
Active Job Information....................................................................................................................................... 2-44
Other Crew Functions....................................................................................................................................... 2-46
AVL Crews............................................................................................................................................................. 2-47

Managing Calls with Trouble Management........................................................................................................ 2-49
Changing Rule Sets............................................................................................................................................... 2-49
Entering Trouble Calls......................................................................................................................................... 2-50
Using the Trouble Information Window............................................................................................................. 2-55
Viewing Call Information.................................................................................................................................. 2-61
Emailing Customer Lists..................................................................................................................................... 2-62

Viewing Trouble Summaries.................................................................................................................................. 2-63
Company Summary............................................................................................................................................ 2-63
Region Summary.................................................................................................................................................. 2-64

Using the Summaries Window.............................................................................................................................. 1-54
Using the Note Summary....................................................................................................................................... 1-54
Using the Tag Summary........................................................................................................................................ 1-55
Using the Abnormal Device Summary ................................................................................................................ 1-56
Viewing the Systems Alarm List ........................................................................................................................ 1-56
Using the SCADA Summary................................................................................................................................ 1-57
Using the Model Validation Environment........................................................................................................... 1-60
Logging In............................................................................................................................................................. 1-60
Using the Model Validation Environment Manager.......................................................................................... 1-60
Using the SqlX Database Query.......................................................................................................................... 1-61
Using the Object Debug (What) Window.............................................................................................................. 1-63
Using the Topology View Window....................................................................................................................... 1-64
Viewing Model Changes..................................................................................................................................... 1-65
Using the Model Build Report............................................................................................................................. 1-66
Viewing Attribute Information............................................................................................................................ 1-66
Model Validation Viewer..................................................................................................................................... 1-67

Using the Administration Environment............................................................................................................... 1-67
Logging In............................................................................................................................................................. 1-67
Using the Administration Environment Manager............................................................................................. 1-67
Using the Default ERT Editor Window................................................................................................................ 1-68
Using the Draw Link Window............................................................................................................................... 1-69
Using the View Areas Window............................................................................................................................ 1-71
Using the Administration Viewer........................................................................................................................ 1-72

Viewing Call Information ................................................................................................................................... 2-61
Viewing Attribute Information............................................................................................................................ 2-66
Model Validation Viewer..................................................................................................................................... 2-67
Using the Administration Environment............................................................................................................... 1-67
Logging In............................................................................................................................................................. 1-67
Using the Administration Environment Manager............................................................................................. 1-67
Using the Default ERT Editor Window................................................................................................................ 1-68
Using the Draw Link Window............................................................................................................................... 1-69
Using the View Areas Window............................................................................................................................ 1-71
Using the Administration Viewer........................................................................................................................ 1-72
Chapter 3
Model Management ................................................................................................................................................. 3-1
  Overview .......................................................................................................................................................... 3-1
  Logging In ................................................................................................................................................... 3-2
  Using the Model Management Window ........................................................................................................ 3-3
  Model Management Actions ...................................................................................................................... 3-5
  Displaying the Map History ....................................................................................................................... 3-5
  Displaying the Preprocessor Log................................................................................................................ 3-6
  Deleting a Pending Map............................................................................................................................... 3-6
  Building Maps ............................................................................................................................................ 3-6
  Rebuilding a Patch ....................................................................................................................................... 3-6
  Displaying the Patch Build Log .................................................................................................................. 3-6
  Displaying the Patch Build Report ........................................................................................................... 3-7
  Enabling and Disabling Model Building ...................................................................................................... 3-7

Chapter 4
Configuration Assistant ........................................................................................................................................... 4-9
  Getting Started with the Configuration Assistant ........................................................................................ 4-9
  Accessing Configuration Assistant ............................................................................................................. 4-9
  Logging In ................................................................................................................................................... 4-10
  Using the Configuration Assistant Window ................................................................................................ 4-10
  Print Preview .............................................................................................................................................. 4-11
  User Administration Tab ............................................................................................................................. 4-13
  Current Users Panel .................................................................................................................................. 4-13
  User Type Memberships Panel .................................................................................................................... 4-15
  User Log Panel .......................................................................................................................................... 4-16
  Event Management Rules Tab .................................................................................................................. 4-17
  Rule Categories Panel ............................................................................................................................... 4-17
  Currently Configured Rules Panel ........................................................................................................... 4-18
  Documentation Panel ............................................................................................................................... 4-21
  Event Details Options Tab .......................................................................................................................... 4-21
  Event Details Options Panel ...................................................................................................................... 4-21
  Work Agenda Predefined Filters Tab ........................................................................................................ 4-24
  Adding a Filter ............................................................................................................................................ 4-25
  Editing a Filter ............................................................................................................................................ 4-25
  Deleting a Filter ............................................................................................................................................ 4-25
  Saving an Exported User Configuration ................................................................................................... 4-26
  Default Restoration Times Tab ................................................................................................................ 4-26
  Adding or Changing a Device/Zone-Based Default Restoration Time ...................................................... 4-27

Chapter 5
Redliner.............................................................................................................................................................. 5-1
  Redliner Window ........................................................................................................................................... 5-1
  Working with Images .................................................................................................................................... 5-3
  Capturing an Image ..................................................................................................................................... 5-3
  Annotating an Image ............................................................................................................................... 5-3
  Saving an Image ....................................................................................................................................... 5-4
  Emailing an Image .................................................................................................................................... 5-4
  Printing an Image ....................................................................................................................................... 5-5

Chapter 6
Web Workspace..................................................................................................................................................... 6-1
  Getting Started with Web Workspace ........................................................................................................ 6-1
Chapter 9
Web Callbacks...................................................................................................................................................  9-1
  Overview......................................................................................................................................................... 9-1
  Starting Web Callbacks ................................................................................................................................. 9-1
    Logging In.................................................................................................................................................. 9-2
  Using the Web Callbacks Window .............................................................................................................. 9-3
    Web Callbacks Menus ............................................................................................................................... 9-3
    Toolbar ...................................................................................................................................................... 9-4
    Header......................................................................................................................................................... 9-4
    Callbacks Table......................................................................................................................................... 9-4
    Callbacks Summary Panel ....................................................................................................................... 9-5
    Callbacks Buttons ................................................................................................................................... 9-6
    Status Bar.................................................................................................................................................. 9-6
  Assigning Callbacks .................................................................................................................................. 9-6
    Assigning Callbacks to Users ................................................................................................................... 9-7
  Viewing Callback Assignments ................................................................................................................... 9-9
  Unassigning Callbacks ............................................................................................................................... 9-10
    Unassigning Callbacks for a Specific Event ......................................................................................... 9-11
    Unassigning All of Your Callbacks ........................................................................................................ 9-11
  Performing Callbacks ................................................................................................................................ 9-11
    Using the Perform Callbacks List Window ............................................................................................ 9-12
    Performing Assigned Callbacks for an Event ....................................................................................... 9-13
    Performing Unassigned Callbacks (Next Callback) ........................................................................... 9-14

Chapter 10
Storm Management.............................................................................................................................................. 10-1
  Getting Started with Storm Management ................................................................................................. 10-1
    Login Window ........................................................................................................................................ 10-1
    Logging In............................................................................................................................................... 10-2
  Using the Storm Management Window .................................................................................................... 10-2
    Menus..................................................................................................................................................... 10-3
    Toolbar .................................................................................................................................................. 10-5
    Status Bar.............................................................................................................................................. 10-7
    Print Preview ....................................................................................................................................... 10-8
    Zone Selection Panel ............................................................................................................................. 10-9
    Summary Information Panel .................................................................................................................. 10-9
    Storm Report Panel ............................................................................................................................... 10-10
  Using Storm Management Modes ........................................................................................................... 10-11
    Non-Storm Mode ................................................................................................................................. 10-12
      Using ERT Overrides .......................................................................................................................... 10-12
      Manual Overrides .............................................................................................................................. 10-16
    Storm Mode .......................................................................................................................................... 10-16
      Entering Storm Mode .......................................................................................................................... 10-17
      Using Define Storm Dialog ................................................................................................................ 10-17
      Placing a Control Zone in Storm Mode and Defining the Storm Information ..................................... 10-18
      Joining Existing Storms ....................................................................................................................... 10-18
      Joining a Control Zone to an Existing Storm ...................................................................................... 10-19
      Viewing Storm Information ............................................................................................................... 10-19
      Changing Storm Levels ...................................................................................................................... 10-20
      Changing Storm Types ....................................................................................................................... 10-20
      Forecasting Outages ............................................................................................................................ 10-21
      Using Forecast Profiles ....................................................................................................................... 10-22
      Working with Crew Information ......................................................................................................... 10-24
Chapter 12
Management Reporting .................................................................................................................. 12-1
Overview of Management Reporting .......................................................................................... 12-1
Using Business Objects .............................................................................................................. 12-2
Defining Reports ........................................................................................................................... 12-2
Running a Report .......................................................................................................................... 12-2
Sorting a Report ............................................................................................................................. 12-2
Using Oracle Discoverer ............................................................................................................. 12-4
Defining Reports .......................................................................................................................... 12-4
Running Reports ........................................................................................................................... 12-5
Editing and Drilling Down in Reports with Oracle Discoverer ................................................... 12-6
Using Oracle BI Publisher ........................................................................................................... 12-7
Defining Reports .......................................................................................................................... 12-7
Running a Report .......................................................................................................................... 12-8
Trouble Reporting Reports .......................................................................................................... 12-9
Outage Summary ............................................................................................................................ 12-9
Critical Customers Outages ......................................................................................................... 12-9
Daily Trouble Report .................................................................................................................... 12-10
Device Outage History .................................................................................................................... 12-12
Sustained Outage Summary .......................................................................................................... 12-13
Recurring Device Outages .......................................................................................................... 12-13
Reliability Indices Reports ............................................................................................................. 12-14
Using the Oracle Utilities Business Intelligence Graphical Portals and Zones ......................... 12-16
Business Intelligence Login Screen ............................................................................................... 12-16
Navigating in Business Intelligence .............................................................................................. 12-16
OMS Executive Overview Portal ................................................................................................. 12-17
Current Outages By Operating Region Portal ............................................................................. 12-17
Customer Restoration Portal ........................................................................................................ 12-19
Outage Analysis Portal ................................................................................................................... 12-20
Outages By Political Boundary Portal ............................................................................................ 12-20
Feeder Performance Portal ............................................................................................................ 12-20
Sustained Reliability Limits Portal ............................................................................................... 12-21
Monthly Reliability Limit Portal .................................................................................................... 12-22
Current Feeder Lockouts Portal .................................................................................................... 12-23
Momentary Reliability Limit Portal .............................................................................................. 12-23
Wire Down Event Portal ............................................................................................................... 12-23
Feeder Delivered Load Portal ....................................................................................................... 12-24
Historical Storms Portal .................................................................................................................. 12-25

Chapter 13
SCADA Extensions ......................................................................................................................... 13-1
Overview ....................................................................................................................................... 13-1
SCADA Measurements ................................................................................................................. 13-2
Using SCADA Features .................................................................................................................. 13-2
Using the SCADA Summary .......................................................................................................... 13-3
Understanding SCADA Information in the Viewer ...................................................................... 13-3
Using the SCADA Alarms List ...................................................................................................... 13-7
Displaying the SCADA Alarms List ............................................................................................. 13-7
Viewing a SCADA Alarm in the Viewer ....................................................................................... 13-8
Acknowledging SCADA Alarms .................................................................................................... 13-8
Silencing SCADA Alarms ............................................................................................................... 13-8
Chapter 14
Switching Management ......................................................................................................................... 14-1
Managing Switching Plans ...................................................................................................................... 14-1
Understanding Switching Plans ............................................................................................................. 14-2
Using the Switch Sheet Editor ................................................................................................................ 14-4
Using Web Request .............................................................................................................................. 14-11
Planned Switching ................................................................................................................................. 14-17
Creating a New Switching Plan Request ............................................................................................... 14-17
Opening a Switching Plan ...................................................................................................................... 14-18
Creating Switching Plan Steps ............................................................................................................. 14-19
Editing Switching Plans ....................................................................................................................... 14-21
Finding and Replacing a Device ........................................................................................................... 14-22
Reviewing a Switching Plan in Study Mode .......................................................................................... 14-23
Replaying Steps ............................................................................................................................... 14-23
Viewing the Device Addresses ........................................................................................................... 14-23
Viewing Impacted Customers ............................................................................................................... 14-23
Using Viewing Areas .......................................................................................................................... 14-27
Checking for Overlapping Switching Plans ....................................................................................... 14-28
Implementing a Switching Plan ........................................................................................................... 14-29
Working with Switching Plan Revisions ............................................................................................. 14-30
Emergency Switching ........................................................................................................................ 14-31
Event Associations ............................................................................................................................ 14-32
Using the Miscellaneous Log ............................................................................................................... 14-33
Viewing Switching Lists ....................................................................................................................... 14-34
Maintaining Safety Documents ........................................................................................................... 14-38
Using SCADA Control Tool Features ................................................................................................. 13-9
Switching Management SCADA Integration ....................................................................................... 13-10

Chapter 15
Web Switching Management .................................................................................................................. 15-1
Overview .............................................................................................................................................. 15-1
Switching Sheet Types ........................................................................................................................ 15-2
Switching Sheet States ......................................................................................................................... 15-2
Operating Modes ............................................................................................................................... 15-3
Starting Web Switching Management ................................................................................................. 15-3
    Logging into Web Switching Management with Operator's Workspace .............................................. 15-4
    Logging into Web Workspace with Web Switching Management ..................................................... 15-4
    Logging into Web Switching Management in Standalone mode ...................................................... 15-5
Understanding the Web Switching Management Window ................................................................. 15-5
Planned Switching .............................................................................................................................. 15-10
    Creating a Planned Switching Sheet ................................................................................................. 15-11
    Requesting Switching Sheets ......................................................................................................... 15-13
    Changing the Switching Sheet State ............................................................................................ 15-16
    Adding and Editing Steps ............................................................................................................. 15-18
    Reviewing a Switching Sheet in Study Mode ............................................................................... 15-35
    Replaying Steps ............................................................................................................................. 15-35
    Implementing a Planned Switching Sheet ..................................................................................... 15-35
Chapter 16
Power Flow, Suggested Switching, and Volt/VAr Optimization

Using Power Flow ......................................................... 16-1
Viewer Power Flow Information Visualization ......................... 16-2
Real-Time Power Flow Updates ........................................... 16-4
Viewing Power Flow Results in Real-Time ............................. 16-4
Viewing Power Flow Results in Study Mode ......................... 16-6
Using Power Flow with Look Ahead .................................... 16-7
Using Suggested Switching ................................................. 16-8
Suggested Switching Scenarios ............................................ 16-8
Using the Suggested Switching Tool ..................................... 16-9
Using Volt/VAr Optimization .............................................. 16-14
Overview ........................................................................ 16-14
Before You Begin .......................................................... 16-14
Running the Volt/VAr Optimization Tool .............................. 16-15

Chapter 17
Feeder Load Management .................................................. 17-1
Overview ................................................................................................................. 17-1
Feeder Load Management Updates ........................................................................ 17-2
Accessing Feeder Load Management Tools .............................................................. 17-2
Logging in to the Web DMS Environment ................................................................. 17-2
Using the Feeder Load Summary Window ................................................................. 17-3
Menu Options ........................................................................................................... 17-3
Toolbar ..................................................................................................................... 17-4
Status Bar .................................................................................................................. 17-4
Feeder Load Summary Panels ................................................................................... 17-5
Feeder Load Management Summary Updates ......................................................... 17-6
Feeder Load Management .......................................................................................... 17-6
Accessing the Feeder Load Management Window .................................................... 17-6
Using the Feeder Load Management Window ............................................................ 17-8
Viewing and Modifying Study Session Parameters .................................................. 17-20
Requesting a New Feeder Load Management Calculation ....................................... 17-21
Data Source and Data Quality ................................................................................... 17-21
Identifying Devices with SCADA Suspect and SCADA Non-Converged Results ....... 17-22

Chapter 18
Fault Location, Isolation, and Service Restoration ..................................................... 18-1
Overview ................................................................................................................... 18-1
Setting the FLISR Mode ............................................................................................ 18-3
  Enabling and Disabling FLISR Devices from the Control Tool ......................... 18-4
Using FLISR with Work Agenda ............................................................................. 18-4
Using the FLISR Report Tool ................................................................................... 18-5
  Executing FLISR in Automatic Mode ................................................................. 18-7
  Generating a Switch Plan (Manual Mode) ............................................................ 18-8
Viewing FLISR Disabled Devices .......................................................................... 18-9
Viewing FLISR Conditions ..................................................................................... 18-10
Using the FLISR Flow Summary Window ............................................................... 18-10

Chapter 19
Fault Location Analysis ............................................................................................. 19-1
Fault Location Process Overview ............................................................................. 19-1
Fault Location Algorithm ......................................................................................... 19-2
Using the Fault Location Analysis Tool .................................................................. 19-2
  Logging in to the Web DMS Environment .......................................................... 19-2
  Using the Fault Location Analysis Tool ............................................................... 19-3
  Confirming Fault Locations .................................................................................. 19-5
  Marking Fault Locations as Incorrect ................................................................ 19-5
  Correcting a Fault Location .................................................................................. 19-5
Viewing Fault Events in the Work Agenda ............................................................... 19-6
Viewing Fault Locations in the Viewer ................................................................... 19-6
  Fault Locations in the Viewer .............................................................................. 19-6
Fault Indicator Call Symbols in the Viewer ............................................................... 19-7

Appendix A
Event Status and Event Type Codes ......................................................................... A-1
  Event Status Codes ............................................................................................... A-1
  Event Type Codes ................................................................................................. A-3

Appendix B
Color Coding ............................................................................................................. B-1
  Crew Status .......................................................................................................... B-1
  Event Status .......................................................................................................... B-2
  FLISR Status .......................................................................................................... B-3
  Conductor Symbology ......................................................................................... B-4
Preface

This guide describes how to use the Oracle Utilities Network Management System application. It provides instructions for completing common tasks and also provides descriptions of the fields, windows, buttons, and menus you will use to perform those tasks. Note that this guide describes the default product configuration for a user with complete authorization for all functionality. Different terminology may have been configured for your implementation, layouts may be changed, and some users or user types may not have access to certain functionality.

Audience

This document is intended for users of the Oracle Utilities Network Management System application.

Related Documents

For more information, see the following documents:

• Oracle Utilities Network Management System Installation Guide
• Oracle Utilities Network Management System Quick Install Guide
• Oracle Utilities Network Management System Configuration Guide
• Oracle Utilities Network Management System Adapters Guide

Integration Guides

The following guides provide additional information for use when integrating with other Oracle Utilities applications.

• Oracle Utilities Network Management System – Mobile Workforce Management Interface Implementation Guide
• Oracle Utilities Network Management System – Mobile Workforce Management Interface User Guide
Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><strong>italic</strong></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>

Common Terminology

The following terms and acronyms are used in one or more adapter descriptions.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIS</td>
<td>Customer Information System</td>
</tr>
<tr>
<td>DTD</td>
<td>Document type definition, used to define XML documents</td>
</tr>
<tr>
<td>Generic IVR Adapter</td>
<td>A Unix application that generally executes on the OMS server machine. It supports the Trouble Call, Event Status, Affected Customers, Callback Request and Callback Response Data Flows.</td>
</tr>
<tr>
<td>HA</td>
<td>High availability, where Oracle Utilities Network Management System is configured with a pair of redundant servers. This is usually in the form of a hardware cluster and a shared drive that contains the database.</td>
</tr>
<tr>
<td>ISIS</td>
<td>Clients access services and tools through a central concurrency management and messaging system called Isis. Isis is a real-time implementation of message oriented middleware and comprises the backbone of the system, providing access to the server for each client and the communication required between tools and services. Isis delivers the organized information to the client applications.</td>
</tr>
<tr>
<td>IVR</td>
<td>Interactive Voice Response system</td>
</tr>
<tr>
<td>JMS</td>
<td>Job Management Service. The Oracle Utilities Network Management System call processing and outage prediction engine.</td>
</tr>
<tr>
<td>MQSeries</td>
<td>A queue-based messaging system developed by IBM. This system has been renamed to WebSphere MQ.</td>
</tr>
<tr>
<td>NMS</td>
<td>Oracle Utilities Network Management System</td>
</tr>
<tr>
<td>ODS</td>
<td>Object Directory Service. ODS improves performance of the Oracle Utilities Network Management System system by caching large amounts of device information that is likely to be requested by applications. This caching allows the requests to be handled very quickly without directly accessing the database.</td>
</tr>
<tr>
<td>OMS</td>
<td>Outage Management System</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SCADA</td>
<td>Supervisory Control and Data Acquisition system</td>
</tr>
<tr>
<td>SMService</td>
<td>System Monitor Service. SMService monitors the core processes in the system, essentially the services and interfaces.</td>
</tr>
<tr>
<td>XML</td>
<td>Extensible Markup Language</td>
</tr>
<tr>
<td>XML Schema</td>
<td>An XML standard for defining XML documents</td>
</tr>
<tr>
<td>XSL</td>
<td>XML Style Sheet, used to reformat XML documents</td>
</tr>
</tbody>
</table>
This chapter describes the Oracle Utilities Network Management System Operator’s Workspace. It includes the following topics:

- Getting Started With Operator’s Workspace
- Using the Operator's Workspace Viewer
- Using the Operator's Workspace Control Tool
- Viewing Summaries
- Using the Model Validation Environment
- Using the Administration Environment Manager

Getting Started With Operator’s Workspace

The Oracle Utilities Network Management System is a software suite designed from the ground up to specifically meet the needs of utilities' distribution operations centers. Oracle Utilities Network Management System - Operator's Workspace is the foundation on which several other Oracle Utilities Network Management System applications are built. It provides the navigation and framework needed for the rapid task management required in a control center.

This section covers system features used by many modules in the integrated Oracle Utilities Network Management System product. While certain features described in this chapter are configurable or optional, the general behavior of the features is consistent throughout the Oracle Utilities Network Management System. Features unique to a window or module are described within the chapter specific to that window or module.

Operator's Workspace topics include:

- Operator's Workspace Tools
- Common Features
- Sorting and Filtering Data
- Printing
- Logging In
- Using the Environment Manager
- Taking Authority
Operator’s Workspace Tools

Operator’s Workspace consists of several tools, including:

- The Environment Manager, which allows you to access the primary windows in Oracle Utilities Network Management System.
- The Viewer, which provides a dynamic view of the geographic maps of the distribution system.
- The Control Tool, which provides access to common device actions.
- The Work Agenda, which keeps a record of work to be completed by the user.

Common Features

There are a few features that are common to all Oracle Utilities Network Management System windows:

- **Title Bar**
  - The title bar tells you what window or dialog box you are using.

- **Menu Bar**
  - The menu bar provides drop-down menus for available actions. Menu options that are followed by an ellipsis […] indicate that the option opens another dialog box or window. There are a few menu options that appear in a number of Oracle Utilities Network Management System module windows:
    - File menu items typically start standard procedures (e.g., printing or saving) and exit the window; however, File menus can vary between windows.
    - Action menus provide access to features that are almost always specific to a particular window. Frequently used options on the Action menu are often repeated as buttons on the bottom of the window.
    - The Help menu appears on the right side of the menu bar on many applications. The Help documentation for the Oracle Utilities Network Management System product is accessible outside of the Oracle Utilities Network Management System applications via Internet Explorer.

- **Display Area**
  - The display area displays the data provided by the window and allows you to manipulate that data.

- **Buttons**
  - The buttons are used to perform an action or start a window. Button actions often correspond to Action menu options. Button text that is followed by an ellipsis […] indicates that the button opens another dialog box or window.
    
    **Note:** Always use the Exit button or File > Exit from the menu to close a window. Failing to do so may cause the window to disappear while it is still running and using system resources.
If a small black triangle appears to the right of text in a table cell, it indicates the cell contains more text that is not visible.

<table>
<thead>
<tr>
<th>Device</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>fuse_oh_317332</td>
<td>&lt;F1&gt;</td>
</tr>
<tr>
<td>xfmss_10-2220</td>
<td>&lt;F1&gt;</td>
</tr>
</tbody>
</table>

To view the text, drag the column border to resize the column.

**Sorting and Filtering Data**

You can sort and filter data in certain Oracle Utilities Network Management System windows by using the Sort and Filter menus located at the top of the window. You can sort tables to display the rows in a particular order or filter them to display a specific subset of the rows.

Each table (e.g., the Trouble Events lists in the Work Agenda window) has its own unique set of sorts and filters. You can create, modify, and save sorts and filters for a table. Saved user-defined sorts and filters exist until either you delete them or you log out of the Operator's Workspace environment.

The currently selected filter and sort are displayed at the top of the window. The current filter is also selected on the Filter menu. The current sort option is selected on the Sort menu.

This section includes the following topics:

- Sorting
- Filtering

**Sorting**

You can apply ascending or descending sorts to a single column in a table by selecting a column (click once on the column header) and then selecting **Ascending** or **Descending** from the Sort menu.

The heading row for the sorted column changes color. The sort description at the top of the tool changes to describe the sort that has been applied. For example, if you choose a descending sort, the description displays “Sort -> desc on: [Sort field].”

Each sortable window has its own default sort, which you can access by selecting “Default” from the Sort menu. You can modify the default sort using the Sort dialog box. You can also apply and save multiple column sorts using the Sort dialog box. The following table describes the options available on the Sort menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ascending</td>
<td>Sorts the data in a selected column in ascending order (A to Z or 0 to 9).</td>
</tr>
<tr>
<td>Descending</td>
<td>Sorts the data in a selected column in descending order (Z to A or 9 to 0).</td>
</tr>
<tr>
<td>Dialog</td>
<td>Opens the Sort dialog box, allowing you to create, modify, apply, and save sorts.</td>
</tr>
<tr>
<td>Default and other saved Sorts</td>
<td>Lists any predefined and user-defined sorts. Also available in the Current Sort options menu in the Sort dialog box (see User-Defined Sorts below).</td>
</tr>
<tr>
<td></td>
<td>Selecting a sort applies it.</td>
</tr>
</tbody>
</table>
User-Defined Sorts

User-defined sorts are only accessible to the user who creates them and are erased when the user logs out.

Use the Sort dialog to create, modify, apply, and save user-defined sorts. To open the Sort dialog box, select Dialog from the Sort menu. The Sort dialog contains the following fields and buttons:

- The Current Sort option menu presents a list of saved sorts for modification.
- The display area lists each column available in the table of data you are sorting. Each column heading has a corresponding option menu that allows you to specify the sort option (none, ascending, or descending) for that column in the table. Enter priority numbers in the fields just below the none/asc/desc menu in the Sort dialog box. The sort will begin with the lowest assigned number (starting with 0) and proceed sequentially (i.e., sort by the column with priority #0, then by the column with priority #1, etc.).
- The OK button applies the current sort to the table of data and exits the Sort dialog box.
- The Save button opens a dialog box for naming and saving the current sort. Saving automatically applies the sort. You can retrieve sorts through the Current Sort option menu and the Sort menu in the window.
- The Delete button opens a dialog box asking you to confirm the deletion of the selected sort. Once it is deleted, you can no longer retrieve the sort.
- The Show button applies the current sort settings to the table of data, but does not exit the Sort dialog box.
- The Exit button exits the Sort dialog box without applying the sort.

Creating a User-Defined Sort

To create a user-defined sort, complete these steps:

1. Select Dialog from the Sort menu.
2. Click on the drop-down menu of a column you want to sort by and select the sort option you want (none, ascending, or descending).
3. In the row beneath the drop-down list, specify the order in which you want the column sorted using 0 (zero) for the first priority, 1 (one) for the next, etc.
4. Repeat the two previous steps for any other columns you want to sort.
5. Click the OK button. The table is sorted according to the selected criteria. This sort is set as the default, and the Sort dialog box closes.

Note: You can view the sort by clicking on the Show button, but if you click Exit, the applied sort will be undone when the dialog box closes.

Saving a User-Defined Sort

Once you create a sort, you can save it for future use. To save a sort, click the Save button in the Sort Dialog box and name the sort. The system automatically applies the sort. The sort name appears in the Current Sort option menu in the Sort Dialog box as well as the Sort menu in the actual window.

Editing and Deleting Saved Sorts

To edit a saved sort, select the sort from the Current Sort drop-down menu in the Sort Dialog window.

To delete a saved sort, select it from the Current Sort drop-down menu and click Delete.
Filtering

In addition to sorting, certain windows allow you to filter the data displayed. You can apply and save additional user-defined filters using the Filter dialog box. The following table describes the options available on the Filter menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialog</td>
<td>Opens the Filter dialog box, allowing you to create, modify, apply, and save user-defined filters.</td>
</tr>
<tr>
<td>Default and other saved Filters</td>
<td>Lists any predefined and user-defined filters. Selecting a filter applies it. These options are also available in the Current Filter options menu in the Filter dialog box.</td>
</tr>
</tbody>
</table>

Filter Dialog

Use the Filter dialog box to create, modify, apply, and save user-defined filters. To open this dialog, select Dialog from the Filter menu. The Filter dialog displays the following fields and buttons:

- The Current Filter option menu presents a list of saved filters for modification.
- The display area lists each column available in the table of data you are filtering.
- Each column heading has a corresponding option menu that allows you to specify the filter criteria for that column in the table.
- Enter filter values in the text field below each option menu. For example, to display only rows where the Event # is greater than 5000, you would select “>” from the Event # option menu and enter 5000 in the text field.
- The following table describes each of the filters available from the Filter Options menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>No filter is applied to this field.</td>
</tr>
<tr>
<td>Match</td>
<td>Rows display only if the field value exactly matches the filter value.</td>
</tr>
<tr>
<td>Multi-match</td>
<td>Rows display only if the field value matches any of the filter values specified. Multiple filter values may be entered in the same field, separated by spaces.</td>
</tr>
<tr>
<td>Not</td>
<td>Rows display only if the field value does not match the filter value.</td>
</tr>
<tr>
<td>Multi-not</td>
<td>Rows display only if the field value does not match any of the filter values specified. Multiple filter values may be entered in the same field, separated by spaces.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Rows display only if the field value is greater than or equal to the filter value.</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Rows display only if the field value is less than or equal to the filter value.</td>
</tr>
<tr>
<td>Within</td>
<td>Table rows display only if the field value is between the two filter values. Both filter values may be entered in the same field, separated by a space.</td>
</tr>
<tr>
<td>Like</td>
<td>Table rows display only if the field value includes the filter value (e.g., “Status” includes “tat”).</td>
</tr>
</tbody>
</table>
Buttons

• The OK button applies the current filter to the table of data and exits the Filter dialog box.

• The Save button opens a dialog box for naming and saving the current filter. Saving automatically applies the filter. You can retrieve filters through the Current Filter option menu and the Filter menu in the window.

• The Delete button opens a dialog box asking you to confirm the deletion of the selected filter. Once it is deleted, you can no longer retrieve the filter.

• The Apply button applies the current filter settings to the table of data, but does not exit the Filter dialog box.

• The Exit button exits the Filter dialog box and removes any applied filter settings.

Creating a User-Defined Filter

To create a user-defined filter, complete these steps:

1. Select Dialog from the Filter menu.
2. Click on the drop-down menu of the column you want to filter by, and select the filter option you want.
3. In the row beneath the drop-down list, enter the desired filter criteria.
4. Repeat the two previous steps for any other columns you want to filter.
5. Click the OK button. The table is filtered according to the selected criteria, the filter is set as the default, and the Filter dialog box closes.

Note: You can view the filter by clicking on the Apply button, but if you click Exit, the applied filter will be undone before the dialog box closes.

Saving a User-Defined Filter

Once you create a filter, you can save it for future use. To save a filter, click on the Save button in the Filter Dialog box and name the filter. The system automatically applies the filter. The filter name appears in the Current Filter option menu in the Filter Dialog box as well as the Filter menu in the actual window.

Editing and Deleting Saved Filters

To edit a saved filter, select the filter from the Current Filter drop-down menu in the Filter Dialog window.

To delete a saved filter, select it from the Current Filter drop-down menu and click Delete.
Printing

In many windows, you can print a window capture of the current active window to a PostScript printer. Some windows can also generate ASCII and/or multi-page PostScript output.

Choose the Print option on the File menu to open the Print dialog box.

Print Dialog

The Print dialog displays the following information:

- **Printer Name** contains the name of the printer. Click the Change Printer... button to choose a different printer.
- **No. of Copies** specifies the number of copies to be printed.
- The **Page Options** area allows you to select what to print. The Current Screen option prints the current active window, while the All Pages option prints all information (in a table, for instance), even if it is not all visible in the current active window.
- The **Output Type** area allows you to select what type of output to print.
  - The Screen Capture option prints the screen as it appears on the user's display.
  - The Table option prints all data in a table as text without the graphical user interface.
  - The ASCII option prints ASCII format output, if available.
  - The PS Print Preview option presents the PostScript data as an HTML page in a browser for previewing, if available. The PS Print option sends the PostScript data (which is displayed with the PS Print Preview option) directly to the printer.
- The **Processing** area allows you to select the color quality of the printed output, which is Color, Halftone, or Black & White. The Reverse Color option produces output with colors reversed.
- The **Print Size** area allows you to select the orientation of the printed output, either Landscape or Portrait.
- The **Page Size** area allows you to select the paper size of the printed output, which is configurable for multiple sizes (e.g., 8.5 x 11.0).

Logging In

The Oracle Utilities Network Management System Login window is the first window you see in Operator's Workspace. In the lower left corner a status indicator displays a “services ready” message (in green) to indicate that the Oracle Utilities Network Management System services are operational (or “services not ready” in red to indicate they are not operational).

This section includes the following topics:

- **Logging In to Operator's Workspace**
- **User Types**

Logging In to Operator's Workspace

To log in, complete these steps:

1. From the Login window, make sure “services ready” appears in the lower left corner of the window.
2. Click on the Login button. The Login dialog box opens.
3. In the User Name field, type your user name (as assigned by your system administrator) and press the <Tab> key.
4. If you want a user type other than the default, select a user type from the User Type drop-down menu. See the following section for a description of each user type.

5. Type your Password. Passwords are case-sensitive.

6. Click OK. The system validates your password and proceeds to log you in if the validation was successful. Once you log in, the system starts the windows and functions available for that user type.

User Types

The User Type determines which windows are available and which functions you can perform once you login. User types include:

- **Full Operations** - Provides full access to all end-user Oracle Utilities Network Management System modules and their functions.
- **Trouble Operations** - Provides full access to all Oracle Utilities Network Management System - Trouble Management functions.
- **Trouble Maintenance** - Provides access to a subset of Oracle Utilities Network Management System Trouble Management functions suitable for maintaining, updating, and completing trouble records.
- **Switching Operations** - Provides full access to the Oracle Utilities Network Management System - Switching Management functions.
- **Switching Prep** - Provides access to a subset of Oracle Utilities Network Management System Switching Management functions suitable for preparing switching plans but does not allow switching plans to be executed.
- **Switching Request** - Provides access to a subset of Oracle Utilities Network Management System Switching Management functions suitable for preparing switching requests, but does not allow switching plans to be recorded or executed.
- **Administration** - Provides the SQL Admin tool for updating the database, as well as the View Area, Trouble Call Entry, and Outage Callbacks tools.
- **Model Validation** - Provides access to the tools necessary to review and maintain the Oracle Utilities Network Management System model.
- **Crew Operations** - Provides access to a subset of the Oracle Utilities Network Management System Trouble Management functions suitable for administering crews but does not allow actual dispatching of crews.
- **View Only** - Provides access to summary tools and a graphical Viewer for reviewing status of operations but does not provide the ability to modify crews, the status of events, or switching plans.
- **Outage Correction** - Provides access to the tools necessary to perform outage correction tasks.

Using the Environment Manager

The Environment Manager contains buttons for starting windows and managing the visual workspace. It appears on the right side of the desktop. The title bar indicates which environment you are logged into (e.g., Trouble Operations, Switching Management, etc.), which corresponds to the user type you selected when you logged in.

This section includes the following topics:

- **Annunciators**
- **Environment Manager Buttons**
- **Toolboxes**
• Viewers
• Administrative Tools
• Monitor Selector (Optional)
• Logging Out

Annunciators

Annunciators alert you to three types of unacknowledged events:
• Alarms
• Outage Events
• Non-Outage Events

If there are any unacknowledged alarms or outage events, the Unack Events annunciator changes from green to red. If there are any unacknowledged non-outage events, the Unack Non-Outages annunciator changes from green to red.

The annunciators section of the Environment Manager window also tells you which mode the Fault Location, Isolation, and Service Restoration (FLISR) module is running in, if applicable.

See Fault Location, Isolation, and Service Restoration on page 18-1 for more details.

Environment Manager Buttons

The Environment Manager provides a column of buttons for opening primary Oracle Utilities Network Management System Operator’s Workspace, Trouble Management, and Switching Management windows.

The following table describes how to use the buttons on the Environment Manager window to open primary windows.

<table>
<thead>
<tr>
<th>Button</th>
<th>Item Opened</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All List in Work Agenda</td>
<td>Displays events of any status with associated system and event information.</td>
</tr>
<tr>
<td>To Do</td>
<td>To Do List in Work Agenda</td>
<td>Displays events that have not yet been assigned or placed en route, along with associated system and event information.</td>
</tr>
<tr>
<td>In Progress</td>
<td>In Progress List in Work Agenda</td>
<td>Displays events associated with crews, along with associated system and event information.</td>
</tr>
<tr>
<td>Incomplete</td>
<td>Incomplete List in Work Agenda</td>
<td>Displays events that have been completed in the field but do not have information entered for them in the Event Details screen, along with associated system and event information.</td>
</tr>
</tbody>
</table>
The Environment Manager toolboxes provide access to secondary Oracle Utilities Network Management System windows. There are two standard toolboxes: a Summaries toolbox and a Miscellaneous Tools toolbox. Depending on whether or not Fault Location, Isolation, and Service Restoration (FLISR) is licensed for your system, there could be a third toolbox for FLISR tools. Note that FLISR Tools are not available if Web Switching Management is in use.

### Toolboxes

The Environments Manager toolboxes provide access to secondary Oracle Utilities Network Management System windows. There are two standard toolboxes: a Summaries toolbox and a Miscellaneous Tools toolbox. Depending on whether or not Fault Location, Isolation, and Service Restoration (FLISR) is licensed for your system, there could be a third toolbox for FLISR tools. Note that FLISR Tools are not available if Web Switching Management is in use.

<table>
<thead>
<tr>
<th>Button</th>
<th>Item Opened</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>Complete List in Work Agenda</td>
<td>Displays completed events with associated system and event information.</td>
</tr>
<tr>
<td>Authority</td>
<td>Authority window</td>
<td>Lets you manage control and monitoring of discrete zones of the operations area by subscribing particular users.</td>
</tr>
<tr>
<td>Crew Actions</td>
<td>Crew Actions window</td>
<td>Provides a visual representation of crews available for the subscribed authority zones.</td>
</tr>
<tr>
<td>Crew Admin</td>
<td>Crew Administration window</td>
<td>Enables you to create, activate and deactivate crews.</td>
</tr>
<tr>
<td>Crew List</td>
<td>Crew List window</td>
<td>Displays a list of crews and specific information about each crew.</td>
</tr>
<tr>
<td>Open Switching Plan List</td>
<td>Switching Plan Editor window</td>
<td>Allows you to open an existing switching plan or create switching plans for planned or emergency switching.</td>
</tr>
<tr>
<td>Switching Plan List</td>
<td>Switching Plans list in Work Agenda</td>
<td>Displays all saved switching plans.</td>
</tr>
<tr>
<td>Safety Doc List</td>
<td>Safety Documents list in Work Agenda</td>
<td>Displays all saved safety documents.</td>
</tr>
<tr>
<td>New Switching Plan</td>
<td>Switching Plan Editor (with a new switching plan number automatically assigned)</td>
<td>Allows you to create switching plans for planned or emergency switching operations.</td>
</tr>
</tbody>
</table>

### Toolboxes

The **Summaries** toolbox contains several summaries, including:

- Note Summary - See Using the Note Summary on page 1-54
- Tag Summary - See Using the Tag Summary on page 1-55
- Abnormal Device Summary - See Using the Abnormal Device Summary on page 1-56
- Trouble Summaries - See Viewing Trouble Summaries on page 2-63
- SCADA Summary - See Using the SCADA Summary on page 1-57

The **Miscellaneous Tools** toolbox contains various tools, including:

- Trouble Call Entry - See Web Call Entry on page 8-1
Getting Started With Operator’s Workspace

- Study Session Control - See **Using Real-Time and Study Modes** on page 1-24
- Model Changes - See **Using the Model Validation Environment** on page 1-60
- Device Commission Tool - See **Commissioning or Decommissioning Devices** on page 1-34
- Exit

The FLISR toolbox allows you to change the mode of operation of the FLISR module between Disable, Manual, and Automatic. The toolbox also contains various tools, including:

- Disable
- Manual
- Automatic
- FLISR Disable Summary
- FLISR Conditions
- Exit

**Note:** The FLISR toolbox is not available if Web Switching Management is licensed for your system.

**Viewers**

The Viewers section of the Environment Manager controls the display of the Viewer. For details on starting the different Viewers, see **Opening the Viewer** on page 1-19.

![Viewers](image)

**Administrative Tools**

The last three buttons on the Environment Manager perform basic functions.

- **Help** brings up the Help Information dialog.
- The **Refresh Apps** button refreshes any windows that have aborted unexpectedly. Use this button to restart a window without having to logout and log back in.
- The **Logout** button allows you to log out of the system. A message appears indicating Logout in progress. If there are unacknowledged or unassigned events, the system prompts for confirmation of the logout request.

**Monitor Selector (Optional)**

If you are logging into a UNIX desktop system with multiple CRT monitors, you will see the monitor selector on the Environment Manager. If you are logging into a Windows PC with
multiple windows, you will not see this selector because you can drag windows across different monitors. Since the UNIX desktops do not allow you to drag windows from one monitor to another, you must select which monitor to open a window on.

The monitor selector appears as a set of radio buttons on the Environment Manager, the same number as there are available monitors. For example, in a four-monitor configuration, if you select the third radio button and click on the Authority button, the Authority window opens on the third monitor.

Some windows have a designated monitor assignment and appear only on that monitor when started. If a workstation has fewer monitors than the window's designated monitor assignment, the window will appear on the monitor with the nearest available number. For example, in a dual monitor system, a window with a monitor-3 designation would start on the second monitor.

Logging Out

To log out of Environment Manager, complete these steps:

1. Click the Logout button on the Environment Manager. If you have unacknowledged events or unassigned acknowledged events in your Work Agenda Trouble Events Lists at the time you logout, a dialog box opens asking if you want to proceed with the logout.

2. Click OK to proceed with the logout.

Taking Authority

Control Zones are the discrete sections of a utility's electrical distribution system for which users are responsible. Control Zones can have child zones nested within them. Multiple users can have control over the same zone. You must take authority of control zones in order to see the trouble events, manage the crews, and perform device operations in those areas.

Use the Authority window to view the control zones within the distribution system and identify which users have authority over each zone.

This section includes the following topics:

• Using the Authority Window
• Viewing Control Zone Authority
• Subscribing to a Control Zone
• Unsubscribing from a Control Zone
• Searching for a Zone
• Unassigned Control Zone Alarm
• Using Control Zone Groups

Using the Authority Window

To access the Authority window, click the Authority button on the Environment Manager in Operator's Workspace or choose Authority... from the Web Workspace Tools menu.

The Authority window displays the following fields and buttons:

• The I am field displays the name of the user who is logged in.

• Rule Set Name is the analysis mode rule set that Trouble Management uses for the control zone.

• The All Zones area displays the control zones in the distribution system. Buttons at the bottom of the window allow you to filter which zones display (e.g., All Zones).

• Zone Users displays the user(s) currently subscribed to the selected control zone. If no user is subscribed to the selected control zone, “system” displays in this field.
• **Control Zone** lists the control zones(s) currently selected. Selected control zones are indicated by a blue highlight on the row.

• **Rule Set** lists the analysis mode rule set for a selected control zone. (Use the Change Rule Set... button, described below, to change rule sets.) If more than one zone is selected, this field will be blank because each zone may have a different rule set.

**Buttons**

• The **All Zones** button displays the entire set of control zones, and collapses the view to display only the top-level zone.

• The **My Zones** button displays only those zones to which the current user is subscribed.

• The **Users' Zones** button displays all zones that are not controlled by the system (*i.e.*, have been subscribed to by one or more users).

• The **System Zones** button displays only those zones controlled by the system (*i.e.*, have not been assigned to a user).

• The **Subscribe** button gives you control of the currently selected zone(s), which are displayed in the Control Zone field.

• The **Unsubscribe** button relinquishes control of the currently selected zone(s), which are displayed in the Control Zone field.

• The **Zone Search** button allows you to search for a zone by entering its name in a search dialog. If the system finds a match, the list of control zones expands and the matching zone is highlighted.

• The **Change Rule Set...** button allows you to change the analysis mode rule set used to analyze events in the selected zone.

• The **Groups** button allows you to take control of a group of frequently used control zones.

• The **Clear** button clears the list of control zones in the Control Zone field and de-selects the rows for those control zones.

• The **Exit** button exits the Authority window.

**Viewing Control Zone Authority**

To view control zone authority, complete these steps:

1. Click the **Authority** button on the Environment Manager. The Authority window opens with a list of all the control zones and the users who are assigned to them.

2. Click the + sign next to a zone to expand any collapsed zones and display all sub-zones within it.

3. Click the - sign next to a zone to collapse any zones.

**Subscribing to a Control Zone**

To subscribe to one or more control zones, complete these steps:

1. If the Authority window is not open, click on the **Authority** button on the Environment Manager to open it.

2. Expand the list of control zones (click the + signs) to locate the zone(s) you want to control.

3. Select the row(s) for the zone(s). The zone(s) will populate the Control Zone field.

4. Click on the **Subscribe** button. The Control Subscribe Request dialog box opens.

5. Click on the **Subscribe** button. You now have control over the zone(s) and your user name is listed in the Zone Users column.
Unsubscribing from a Control Zone

When you are finished working in a control zone, you can unsubscribe from the control zone. To unsubscribe, complete these steps:

1. If the Authority window is not open, click on the Authority button on the Environment Manager to open it.
2. Expand the list of Control zones (click the + signs) to locate the zone(s) you want to unsubscribe from.
3. Select (click on) the row(s) for the zone(s). The zone(s) will populate the Control Zone field.
4. Click on the Unsubscribe button. The Control Unsubscribe Request box opens.
5. Click on the Unsubscribe button in the dialog box. You no longer have control over that zone and your user name is removed from the Zone Users column.

Searching for a Zone

The Search feature can help you locate a control zone more quickly than expanding and viewing zones in the Authority window. To search for a zone, complete these steps:

1. In the Authority window, click on the Zone Search button. The Authority dialog opens.
2. Enter the name of the control zone in the Zone field.
   
   Note: This field is case-sensitive. You do not have to enter the complete name of the control zone.
3. Click on the Find Next button. If the system finds a match, the list of zones expands and the row that matches your search is selected.
4. If there are multiple matches, click the Find Next button to locate the next control zone that matches your search criteria.
5. When you have located the zone you want, click the Cancel button to close the search dialog box.

Unassigned Control Zone Alarm

If your workstation shuts down unexpectedly, the system automatically unsubscribes you from your control zones. If there are no other users subscribed to these zones, other users will receive an alarm to let them know that there are control zones that are not being monitored. They can view the unassigned zone alarms in the System Alarms list in the Work Agenda window.

Using Control Zone Groups

If you have a group of Control Zones you are frequently responsible for, your system administrator can create a predefined control zone group to use as a shortcut when you take authority. The groups are set up with a predefined name.

To join a control zone group, complete these steps:

1. Click the Groups button on the Authority window. A dialog box opens displaying the available groups.
2. Click the group you wish to join.
3. Click the OK button to join the group and close the dialog box.
4. Click the Apply button to join the group and keep the dialog box open.
Using the Operator’s Workspace Viewer

The Viewer presents a graphical representation of the electrical distribution system, with additional symbology for conditions such as outages, crew locations, notes, tags, etc. The Viewer dynamically updates with condition and electrical distribution changes.

Viewer topics include:

- Functional Areas
- Opening the Viewer
- Changing Viewer Display Options
- Searching and Loading Viewer Maps
- Navigating in the Viewer
- Panning and Zooming
- Focusing on a Device in the Viewer
- Using the Feeder Focus
- Using Real-Time and Study Modes
- Selecting Devices
- Identifying Symbology
- Hiding and Displaying Viewer Objects
- Setting Viewer Preferences
- Tracing from a Device
- Using Cameras
- Viewing Schematics
- Commissioning or Decommissioning Devices
Functional Areas

The Viewer window has five basic functional areas, as shown in the following figure:

The following table describes the five functional areas of the Viewer window:

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The drawing area where the distribution system is displayed.</td>
</tr>
<tr>
<td>2</td>
<td>The message area, which displays a description of actions taken (e.g., tracing to devices) or the selected object and current feeder name.</td>
</tr>
<tr>
<td>3</td>
<td>The toolbar with buttons providing access to Viewer functions.</td>
</tr>
<tr>
<td>4</td>
<td>The menu bar, also providing access to Viewer functions.</td>
</tr>
<tr>
<td>5</td>
<td>Pan bars allowing you to pan up, down, or across maps.</td>
</tr>
</tbody>
</table>

**Drawing Area**

The drawing area of the Viewer window displays dynamic maps that reflect the real-time status of the system (when the Viewer is in real-time mode). The icons and lines used to represent devices and conductors are called symbols, and the conventions that govern them are referred to as “symbology.”

**Message Area**

The message area of the Viewer window displays textual messages. It displays the name of the selected device, notices of mode changes, warnings, and error messages. For example, when you select a device, the message area displays the device and feeder name.
**Toolbar**

The toolbar provides buttons for accessing commonly used Viewer functions.

- The **Search** button opens the Search dialog box, which enables you to display a map in the drawing area that contains a specific device, area, customer name, etc.

- The **Hide/Display** button opens the Hide/Display dialog box, allowing you to select what object types are displayed in the drawing area.

- The **Camera** button opens the Camera dialog box, which lets you view map detail while keeping a visual relationship to the larger view.

- The **Load Maps** button loads all maps in the visible drawing area. If you move to an area of the Viewer that is not displaying a map, select the Load Maps option. The map partitions load, and the message area indicates how many partitions were loaded.

- The **Unload Maps** button unloads all maps, not just those in the visible drawing area.

- The **Menu** button toggles the menu bar at the top of the Viewer window on and off.

- The **Environment Manager** button toggles the Environment Manager on and off. If the Environment Manager is toggled off and the Viewer is then stopped, the Environment Manager will reappear.

- The **Supply Point Selection** button opens the Supply Point Selection dialog, which puts the Viewer in Supply Point Selection mode.

- The **Trace** button opens the Trace dialog box, used for showing the path from a selected device to other devices based on selected criteria.

- The **Real-Time** button sets the Viewer to real-time mode. Real-time mode displays the actual state of the distribution system. For more information on real-time mode, see **Using Real-Time and Study Modes** on page 1-24.

- The **Study** button sets the Viewer to study mode. Study mode allows you to make changes without affecting the actual state of the distribution system. Changes made in study mode are not visible to other users. For more information on study mode, see **Using Real-Time and Study Modes** on page 1-24.

- The **Object Focus** button centers the Viewer drawing area on the currently selected object, allowing you to focus the Viewer on a device associated with a selection (e.g., event, crew, etc.) in another window.

- The **Stop** button exits the Viewer window.
**Using the Operator’s Workspace Viewer**

**Menu Bar**

The Viewer window has four menus: File, View, Navigate, and Options. Many menu options and their associated dialog boxes have keyboard shortcuts that are indicated to the right of the menu option.

**File Menu**

The File menu is used to control the pieces of the map (called partitions) that are currently being displayed. The following table describes the File menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Opens the Search dialog box, which enables you to display a map in the drawing area that contains a specific device, area, customer name, etc.</td>
</tr>
<tr>
<td>Load Maps</td>
<td>Loads all maps in the visible drawing area. If you move to an area of the Viewer that is not displaying a map, select the Load Maps option. The map partitions load and the message area indicates how many partitions were loaded.</td>
</tr>
<tr>
<td>Unload Maps</td>
<td>Unloads all maps (not just those in the visible drawing area).</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the drawing area contents.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the Viewer window.</td>
</tr>
</tbody>
</table>

**View Menu**

The View menu is used to turn on and off the functional areas of the Viewer window and object types in the drawing area. The following table describes the View menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Bar</td>
<td>Toggles the menu bar at the top of the Viewer window on/off.</td>
</tr>
<tr>
<td>Bottom Toolbar</td>
<td>Toggles the Viewer toolbar on/off.</td>
</tr>
<tr>
<td>Pan Bars</td>
<td>Toggles the Viewer pan bars on/off.</td>
</tr>
<tr>
<td>Message Area</td>
<td>Toggles the Viewer message area on/off.</td>
</tr>
<tr>
<td>Big Symbols</td>
<td>Toggles Big Symbols on/off. See <a href="#">Viewing Big Symbols</a> on page 1-29 for more information.</td>
</tr>
<tr>
<td>Hide/Display …</td>
<td>Opens the Hide/Display dialog box, allowing you to select what object types are displayed in the drawing area.</td>
</tr>
</tbody>
</table>

**Navigate Menu**

The Navigate menu is used to select different ways to move about the map. The following table describes the Navigate menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan/Zoom…</td>
<td>Opens the Pan &amp; Zoom dialog box, used for panning across and zooming in and out on maps.</td>
</tr>
</tbody>
</table>
Using the Operator’s Workspace Viewer

Operator’s Workspace 1-19

Options Menu

The Options menu is used to change the different modes of the Viewer and select preferences. The following table describes the Options menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real Time</td>
<td>Sets the Viewer to real-time mode. Real-time mode displays the actual state of the distribution system. For more information on real-time mode, see Using Real-Time and Study Modes.</td>
</tr>
<tr>
<td>Study</td>
<td>Sets the Viewer to study mode. Study mode allows you to make changes without affecting the actual state of the distribution system. Changes made in study mode are not visible to other users. For more information on study mode, see Using Real-Time and Study Modes.</td>
</tr>
<tr>
<td>Trace…</td>
<td>Opens the Trace dialog box, used to show the path from a selected device to other devices based on selected criteria.</td>
</tr>
<tr>
<td>Preferences…</td>
<td>Opens a dialog box for setting Viewer preferences.</td>
</tr>
</tbody>
</table>

Pan Bars

Pan bars allow you to move around maps using your mouse. To view a different area of the map, click on the pan bar that is on the side of the map you want to view. The pan bars in the corners allow you to move diagonally. For example, click the pan bar in the upper left corner to move up and to the left in the map.

Opening the Viewer

You can open a single large Viewer window or up to four smaller Viewer windows and then switch between them.

Opening a Single Viewer

To open a single Viewer window as large as possible without obscuring the Environment Manager or Work Agenda window, complete these steps:

1. From the Environment Manager, click the single large Viewer icon:

2. Click Start Viewer.

Opening Up to Four Smaller Viewer Windows

To open other Viewers, click Start Viewer with one of the small Viewer icons toggled on VIEW1, VIEW2, VIEW3, and VIEW4.
Switching Between Viewer Windows

With more than one Viewer running, you can toggle between them using the VIEW1, VIEW2, VIEW3, and VIEW4 buttons. Each button is only enabled if its Viewer is running. Once you open a Viewer window, you can resize it.

If the Viewer window is minimized or hidden behind other windows, you can toggle back to it by clicking on the VIEW1, VIEW2, VIEW3, or VIEW4 button, depending on which Viewer window you want opened.

Changing Viewer Display Options

Use the procedures in this section to change the way objects appear in the Viewer.

Viewing Phases and Feeders

Viewer windows open by default in feeder coloring mode. In this mode, all conductors fed from a given feeder are displayed in the same color. The title bar displays (Feeder Mode) in addition to the Viewer name.

Displaying Conductor Coloring by Phases

To change all open Viewer's drawing areas to show conductor coloring by phases, select View Phases from the Options menu in the Viewer. In this mode, one and two phase conductors appear in the standard phase colors. Selecting this option changes the mode of all active Viewer windows. The title bar now displays (Phase Mode) in addition to the Viewer name.

Displaying Conductor Coloring by Feeders

To change all open Viewer's drawing areas to show conductor coloring by feeders, click the View Feeders button on the Environment Manager (in the Viewers section). Clicking this button changes the mode of all active Viewer windows.

Note: To have one Viewer window show phase coloring and another Viewer window to show feeder coloring, open one Viewer window and select View Phases from the Options menu. Then open another Viewer. The new Viewer will open by default in feeder coloring.

Searching and Loading Viewer Maps

In order to view a specific geographic area, you must load the map for that area. Devices and objects that are located within that geographic area will display on the map in the drawing area. To load a map, you can first select an area using the Search dialog box.

Using the Search Tool to Locate Map Areas and Objects

To locate a particular area or object in the Viewer, complete these steps:

1. Do one of the following to display the Search dialog:
   • Click the Search button on the toolbar, or
   • Select Search from the File menu. The Search dialog box appears.
2. In the Search dialog box, click on the search type (e.g., Feeder, Device, etc.).
3. Enter the term you want to search for in the text field (i.e., Enter Feeder/Device/etc.). You can also enter a partial term or no term at all.
4. Click the Search button.
   • If there is a match, the Viewer loads the appropriate maps. The device or area you searched for is centered in the drawing area.
• If you did not enter a term, a dialog box opens displaying a selection list of up to the first 100 items for the search type. Select the term from the list and click OK.

• If you entered a partial term, the dialog box displays the first 100 matches that include the partial term in numeric or alphabetic order.

• If there is no match, a message box indicates that the search failed.

Loading Viewer Maps

Once you have located an area or object using the Search dialog box, you can navigate to an adjacent area where the maps are not yet loaded. From here, you can load all the maps that should appear in the drawing area.

To load maps, do one of the following:

• Select Load Maps from the File menu,

• Press the <m> key, or

• Press the Load Maps button on the toolbar

Unloading Viewer Maps

To unload all maps (not just those in the visible drawing area), do one of the following:

• Select Unload Maps from the File menu,

• Press the Shift + <u> key, or

• Press the Unload Maps button on the toolbar

Navigating in the Viewer

There are a number of ways to navigate around the Viewer:

• Panning across, up, or down the maps using the Pan Bars

• Navigating Using Mouse Controls

• Navigating Using the Keyboard

• Panning and Zooming

Navigating Using Mouse Controls

To zoom in on the Viewer using the mouse, complete these steps:

• Move the pointer to the first corner of the area you want to zoom into and click the center mouse button.

• Move the pointer to the opposite corner of the area you want to zoom into and click the center mouse button. The area you designate expands to fill the drawing area.

To zoom out, press the <Ctrl> key on your keyboard and hold it down while you complete the above steps. The Viewer zooms out, centering on the designated area. To zoom out, you can also press the right mouse button. The Viewer will zoom out in increments.

The following table shows all of the mouse commands for the Viewer.

<table>
<thead>
<tr>
<th>To…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an object</td>
<td>Click the left mouse button.</td>
</tr>
<tr>
<td>Drag the map to change</td>
<td>Click and hold the right mouse button while dragging the map.</td>
</tr>
<tr>
<td>the view</td>
<td></td>
</tr>
</tbody>
</table>
Navigating Using the Keyboard

You can pan across, up, or down the maps and zoom in or out using the numeric keypad on your keyboard.

- To pan, turn your Num Lock on (by pressing the <Num Lk> key) and press any number (besides “5”). The map moves in the direction of the button on the keypad. For example, if you press “8,” the Viewer will pan up; if you press “7,” the Viewer will pan up and to the left.

- To zoom, turn your Num Lock off (by pressing the <Num Lk> key) and press “8” to zoom in and “2” to zoom out.

The following table shows all of the keyboard shortcuts for the Viewer.

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Use this keyboard shortcut...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Number Pad UP ARROW (Num Lock off)</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Number Pad DOWN ARROW (Num Lock off)</td>
</tr>
<tr>
<td>Zoom Out to see all maps loaded</td>
<td>Number Pad 0 (Num Lock on)</td>
</tr>
<tr>
<td>Zoom to Pre-defined Levels</td>
<td>1-5 (keys above alphabet)</td>
</tr>
<tr>
<td>Zoom to Previous Level</td>
<td>p</td>
</tr>
<tr>
<td>Panning</td>
<td>Number Pad Keys (1, 2, 3, 4, 6, 7, 8, 9) (Num Lock on)</td>
</tr>
<tr>
<td>Center the Selected Object</td>
<td>Number Pad 5 (Num Lock on)</td>
</tr>
<tr>
<td>View a Single Feeder (Feeder Focus)</td>
<td>Select a device and press the F key</td>
</tr>
<tr>
<td>Display control zone information of the selected object</td>
<td>o</td>
</tr>
</tbody>
</table>
Using the Operator’s Workspace Viewer

Panning and Zooming

To open the Pan and Zoom dialog box, select Pan/Zoom... from the Navigate menu. The Pan/Zoom dialog displays the following items:

- The Predefined Zoom Levels area contains buttons that zoom in or out of the map at predefined zoom levels, with 1 zooming in closest and 5 zooming out the farthest.
- The Zoom Control area contains buttons that deal with controlling zoom settings. The “big mountain” button zooms in. The “small mountain” button zooms out. The MAX button zooms the Viewer out to show the maximum area of maps loaded. The BOX button provides instructions on how to use the box zoom feature and the mouse buttons. The PREV button returns the Viewer to its previous zoom level as set by the last box zoom.
- The Pan Control area contains buttons that deal with Viewer panning. The arrow buttons cause the Viewer to pan across the map in the direction of the arrow. The CENTER button causes the Viewer to center on the last selected device.

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Use this keyboard shortcut...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase/Decrease Symbol Size</td>
<td>SHIFT + S / S</td>
</tr>
<tr>
<td>Turn on/off magnification of text, which keeps text readable while zoomed out</td>
<td>SHIFT + R</td>
</tr>
<tr>
<td>Increase/Decrease Text Size</td>
<td>SHIFT + T / T</td>
</tr>
<tr>
<td>Increase/Decrease Attribute Size</td>
<td>CTRL + S / CTRL + SHIFT + S</td>
</tr>
<tr>
<td>Reset all Symbol and Text Sizes</td>
<td>r</td>
</tr>
<tr>
<td>Toggle Electrical Layer On/Off</td>
<td>e</td>
</tr>
<tr>
<td>Toggle Background Layer On/Off</td>
<td>b</td>
</tr>
<tr>
<td>Toggle Text On/Off</td>
<td>d</td>
</tr>
<tr>
<td>Load Maps to fill Viewer</td>
<td>m</td>
</tr>
<tr>
<td>Unload All Maps</td>
<td>SHIFT + U</td>
</tr>
<tr>
<td>Toggle Menu On/Off</td>
<td>x</td>
</tr>
<tr>
<td>Print Viewer</td>
<td>CTRL + p</td>
</tr>
<tr>
<td>Exit Viewer window or Camera</td>
<td>CTRL + X</td>
</tr>
<tr>
<td>Show Selected Object’s Location and Feeder(s)</td>
<td>a</td>
</tr>
<tr>
<td>Show Selected Object’s Location Only</td>
<td>SHIFT + A</td>
</tr>
<tr>
<td>Show the (x, y) Coordinate and Map Name at the Pointer Position</td>
<td>l</td>
</tr>
<tr>
<td>Show the Distance from the Pointer Position to the Previous ‘L’-Key Pointer Position</td>
<td>SHIFT + L</td>
</tr>
<tr>
<td>Move the Camera window to a Different Corner of the Viewer (Does not change the focus of the Camera)</td>
<td>c</td>
</tr>
</tbody>
</table>
• The **Message Area** provides textual cues instructing you on how to use the box zoom feature. This text displays when you click the **BOX** button in the Zoom Control area of the window.

• The **Exit** button closes the Pan/Zoom dialog.

**Focusing on a Device in the Viewer**

The object focus feature allows you to focus on a specific device in the Viewer that is associated with a selected field in another window.

For example, if you select an event row in the Work Agenda and click the **Object Focus** button in the Viewer window, the Viewer finds the selected device, loads the required maps, and adjusts the pan and zoom to show the device in the center of the Viewer drawing area.

To focus on a device, complete these steps:

1. Select the event row in the Work Agenda.
2. Click the **Object Focus** button in the Viewer. The device associated with the event displays in the Viewer.

**Using the Feeder Focus**

At times, you may want to view only the devices on the same feeder as the selected device. The Viewer offers a Feeder Focus feature that traces from the selected device back to its feeder breaker and to all downstream devices on the same feeder.

**Note:** The Feeder Focus feature uses the real-time status or the status from the current study session. It does not display devices that may be part of the feeder in the nominal configuration but are not currently part of the feeder.

The Feeder Focus feature should not be used at times of heavy system activity such as those that occur when there are many outages in the system caused by major events and storms.

To use the Feeder Focus feature, complete these steps:

1. Select a device in the Viewer drawing area.
2. Select **Feeder Focus** from the Navigate menu. All symbols disappear except the feeder the device is on.
3. To turn Feeder Focus off and show all the symbols again, select **Object Focus** from the Navigate menu.

Unlike tracing (see **Tracing from a Device**), no other electrical devices are shown except those on the selected feeder. The Feeder Focus will not include de-energized downstream devices. While in Feeder Focus, you can still use Hide/Display, Declutter, and Big Symbols.

**Using Real-Time and Study Modes**

Oracle Utilities Network Management System applications start in real-time mode, where every action you perform is applied to the real-time model and displayed to all users. Certain windows (the Viewer, Control Tool, and Switching Plan Editor) allow you to change to study mode, where your actions are reflected in your study session on your workstation, but not recorded in the real-time model. Study mode is especially useful in “what if” studies, when you need to evaluate the effects of an action before you record it in real-time.

When in real-time mode, the Viewer displays status, topology, and condition information based on real-time operations information. All changes to these items made by any user in real-time mode are reflected on all real-time Viewers in the system.
When in study mode, the Viewer displays only status and topology changes you make on your workstation. Changes made in your study session are not reflected in the real-time model, and likewise changes made in real-time are not reflected in your study session.

A study session is created for a specific workstation the first time you put the Viewer into study mode. The study session is initially created as a copy of the current real-time model. From that point on, changes in the study session and real-time are independent of each other, with the exception that real-time outage and truck symbols will display in study mode. However, these symbols should be ignored since they are not applicable to study sessions. You can reset the study session to current real-time by using the Study Session Control tool. In addition, some Switching Management actions can also cause study session resets. Please refer to Chapter 14: Switching Management for more information.

Starting Study Mode
To toggle the Viewer to study mode, either:

- Select Study from the Options menu, or
- Click the button on the toolbar.

The Viewer window borders and dialog boxes change color to gray.

You can reset the study session to either the current real-time model or the nominal model using the Study Session Control dialog box in the Environment Manager Miscellaneous Tools toolbox.

Resetting Study Mode
To reset the study session to the current real-time model or the nominal model, complete the following steps:

2. Select the Study Session Control button in the Misc. Tools box. The Study Session Control dialog box appears.
3. Do one of the following:
   - Press the Real Time button to reset the study session to the current real-time model.
   - Press the Nominal button to reset the study session to the nominal model.
   - Press the Close Session button to close the current study session.

The Study Session Control dialog box disappears after the action.

Starting Real-Time Mode
To toggle the Viewer back to real-time mode, either:

- Select Real Time from the Options menu, or
- Click on the button on the toolbar.

The Viewer window borders and dialog boxes change color back to red.

Selecting Devices

Selecting Single Devices
To select a single device in the Viewer, simply move the mouse over the desired device and left-click the mouse. The Viewer will select the highest priority device that is closest to the mouse but still within the configured selection-radius. Problems may occur if the selection-radius is set too
high and if the area clicked has a multiple devices in close proximity. If that is the case, then you should use box selection to select the device.

Selecting Multiple Devices within a Rectangular Area
To select all devices within a rectangular area of the Viewer, left-click the mouse and drag across the Viewer window to create a selection box. When you release the left mouse button, the following occurs depending on your selection mode:

- In single-select mode, the Device Selection dialog appears and is populated with all devices present inside the selection box. To select a device, scroll through the list of device aliases in the dialog, select the desired device, and then click the Select button. To open the Control Tool window for the device, select the device and click the Control Tool button.

- In Supply Point Selection mode, the Device Selection dialog does not appear; instead, all supply points inside the box are added to the existing selections. (Use the Supply Point Selection button, described on page 1-17, to set Supply Point Selection mode.)

Selecting Multiple Devices within a Polygonal Area
To draw a more complex polygon and select all devices within that area, hold down both the <Ctrl> and the <Shift> keys and click the left mouse button (Control-Shift left-click). This places the first anchor point. Each subsequent Control-Shift left-click adds another vertex. To complete the polygon, hold down both the <Ctrl> and the <Shift> keys and click the right mouse button. The last vertex is connected to the first vertex. When you release the left mouse button, the following occurs depending on your selection mode:

- In single-select mode, the Device Selection dialog appears with all devices that were inside the polygon.

- In Supply Point Selection mode, all supply points inside the polygon are added to the existing selections. (Use the Supply Point Selection button, described on page 1-17, to set Supply Point Selection mode.)

Adding and Removing Selected Devices
When not in Supply Point Selection mode, only a single device can be selected at any given time. When you are in Supply Point Selection mode, you can modify your existing selection as described below: Use the Supply Point Selection button, described on page 1-17, to set Supply Point Selection mode.)

- To add a device to your selection, Shift left-click on an unselected device.

- To remove a device from your selection, Shift left-click on a selected device.

- If you hold down the <Shift> key while you are drawing a selection box, any unselected devices within the box are added to your selection and any selected devices within the box are removed from your selection.

Clearing Selections
Left-clicking the mouse in an empty space in the Viewer clears your current selection. The Viewer will automatically clear your current selection when you enter or leave the Supply Point Selection mode or when you unload all maps (<Shift>-U).
Identifying Symbology

**Device Symbology**

Changes in the status of a device (e.g., switches, fuses, breakers, etc.) are reflected by changes in symbology. For example, an open switch is a different color and shape than a closed switch. Standard device symbology uses certain conventions such as a red or brown device is closed, a green device is open, a large circle around a device indicates off-nominal, etc.

![Symbology Diagram](image)

**Condition Symbology**

Dynamic conditions on a device (e.g., “predicted service outage,” “crew on-site,” “notes,” etc.) are indicated with specific symbols attached to the device to which the conditions apply.

The following figures shows the Viewer with probable service outage, crew on-site, and pole-house wire down conditions:
Condition symbols display in specific areas around a device or object. The following table provides examples of where condition symbols display in relation to the device they are attached to.

<table>
<thead>
<tr>
<th>Area</th>
<th>Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>Above Left</td>
<td>Tags</td>
</tr>
<tr>
<td></td>
<td>Safety Documents</td>
</tr>
<tr>
<td>Above Right</td>
<td>Probable Service/Device Outages</td>
</tr>
<tr>
<td></td>
<td>Real Outages</td>
</tr>
<tr>
<td>Below Left</td>
<td>Dispatched Crews</td>
</tr>
<tr>
<td>Below Right</td>
<td>Notes</td>
</tr>
<tr>
<td></td>
<td>Call Clues</td>
</tr>
<tr>
<td></td>
<td>Associated Documents</td>
</tr>
</tbody>
</table>

**Conductor Symbology**

Conductor symbology changes color, dash patterns, and thickness for different types of conductors and topology states. The figure below shows examples of standard conductor symbology.

*Note:* Mesh/network symbology is also supported.
## Off-Nominal Status Symbology

The table below illustrates how symbology identifies devices in off-nominal states.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram 1" /></td>
<td>Both devices are identified in their normal states. Device A is normally open while Device B is normally closed.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Diagram 2" /></td>
<td>When Device B is opened, an outage is created (indicated by the RO symbol) and the downstream circuit is de-energized. The symbol for device B changes from red (closed) to green (open), and a circle appears around it.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Diagram 3" /></td>
<td>If Device A is then closed, it changes from green (open) to red (closed) and a circle appears around it. This figure shows both A and B with off-nominal state symbology.</td>
</tr>
</tbody>
</table>

## Viewing Big Symbols

To make the symbols for disconnects, breakers, and conditions prominent while zoomed out, click on the **Big Symbols** button from the View menu. The symbols remain large even as you zoom out but will still disappear at standard Declutter levels.
Hiding and Displaying Viewer Objects

At times, the maps in the Viewer become cluttered with symbols of all kinds. To help you focus on certain devices or conductors, the Viewer offers a Hide/Display feature that will hide classes of objects and a Declutter feature that will hide classes of objects at pre-defined zoom levels.

Hiding Objects
To hide objects in the Viewer, complete these steps:
1. Open the Hide/Display dialog box by either:
   - Clicking on the button on the toolbar, or
   - Selecting the Hide/Display… option from the View menu.
2. Click on (toggle on) the options you want to hide. The Viewer will hide all of the objects you selected.
3. Click the Close button on the dialog box.

You can also use the drop-down menu on the Hide/Display dialog box to choose between All Objects, Backbones Only, or Backbones & Laterals. This will hide objects that are not part of the feeder level.

Decluttering the Viewer
The Viewer also automatically hides objects based on pre-defined declutter zoom levels. This allows you to only see high-level information at higher zoom levels, removing small text and other items that are no longer readable at that zoom level.

Objects with associated conditions will not declutter. Declutter defaults to on, but you can turn it off with the Declutter (ON/OFF) option in the Hide/Display dialog box.

Displaying Hidden Objects
To display hidden objects in the Viewer, complete these steps:
1. Open the Hide/Display dialog box by either:
   - clicking on the button on the toolbar, or
   - selecting the Hide/Display… option from the View menu.
2. Click on (toggle off) the options you want to display. The Viewer will display all of the objects you selected.
3. Click the Close button on the dialog box.

Setting Viewer Preferences
The Preferences dialog box allows you to adjust the behavior and appearance of the Viewer.

Note: Viewer preferences are unique for each Viewer opened and are not saved when the Viewer window is exited.

To open the Preferences dialog box, select Preferences … from the Options menu in the Viewer window. The following table describes the preference options.

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify text size</td>
<td>Adjust the Text Size slide bar.</td>
</tr>
<tr>
<td>Modify symbol size</td>
<td>Adjust the Symbol Size slide bar.</td>
</tr>
</tbody>
</table>

1-30 Oracle Utilities Network Management System User’s Guide
Once you change your settings, you must click either the **OK** or **Apply Sizes** button to activate them.

## Tracing from a Device

Tracing is used to show the electrical path from a selected device to other devices based on criteria you select, in both real-time and study modes. The trace path is displayed on the Viewer by changing all conductors that are part of the path to a thick light blue.

### Opening the Trace Dialog

To display the Trace dialog, select a device in the Viewer and click the button on the Viewer toolbar or select **Trace** from the Options menu.

The Trace dialog displays the following fields and buttons:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify attribute size</td>
<td>Adjust the Attribute Size slide bar.</td>
</tr>
<tr>
<td>Apply selected sizes</td>
<td>Click the <strong>Apply Sizes</strong> button.</td>
</tr>
<tr>
<td>Return sizes to their default size</td>
<td>Click the <strong>Reset Sizes</strong> button.</td>
</tr>
<tr>
<td>Adjust the number of clicks required to open the Control Tool</td>
<td>Select the <strong>Single Click for Control</strong> option or the <strong>Double Click for Control</strong> option.</td>
</tr>
<tr>
<td>Turn on/off magnification of text, which keeps text readable while zoomed out.</td>
<td>Select the <strong>Toggle Readable</strong> option.</td>
</tr>
<tr>
<td>View all proposed model changes with special symbol emphasis</td>
<td>Select the <strong>Highlight Proposed Model Changes</strong> option</td>
</tr>
<tr>
<td>Turn the device name text on and off</td>
<td>Select the <strong>Device Names</strong> option.</td>
</tr>
<tr>
<td>Set the Viewer to automatically load background maps</td>
<td>Select the <strong>Load Background Maps</strong> option.</td>
</tr>
<tr>
<td>Set the Viewer to unload previously loaded maps when loading new maps (to minimize memory usage)</td>
<td>Select the <strong>Unload Maps Before Loading New Maps</strong> option.</td>
</tr>
</tbody>
</table>

Note: Tracing all connected devices will automatically trace both upstream and downstream. Tracing to source will automatically trace upstream.
The mode drop-down menu contains the options for the trace mode. The **RealTime** option performs the trace by using statuses currently displayed in the Viewer. The **Nominal** option performs the trace by assuming nominal statuses for all devices.

**Buttons**

- The **Trace** button performs a trace based on the criteria you have selected.
- The **Refresh** button removes the trace display from the Viewer drawing area and keeps the Trace Tool open.
- The **Exit** button removes the trace display from the Viewer drawing area and exits the Trace Tool.

**Executing Traces**

The following table describes how to execute various types of traces from the Trace dialog.

<table>
<thead>
<tr>
<th>To trace...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>To all connected devices</td>
<td>• Select “All Connected” in the Trace To field.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Trace</strong> button. The Viewer traces from the device to all connected devices stopping only at an energizing source.</td>
</tr>
<tr>
<td>To connected transformers</td>
<td>• Select “Transformer” in the Trace To field.</td>
</tr>
<tr>
<td></td>
<td>• Select the direction.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Trace</strong> button. The Viewer traces from the device to all transformers in the specified direction.</td>
</tr>
<tr>
<td>To connected switches</td>
<td>• Select “Switch” in the Trace To field.</td>
</tr>
<tr>
<td></td>
<td>• Select the direction.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Trace</strong> button. The Viewer traces from the device to the nearest switch in the specified direction.</td>
</tr>
<tr>
<td>To the energizing source</td>
<td>• Select “Source” in the Trace To field.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Trace</strong> button. The Viewer traces from the device upstream to the energizing source.</td>
</tr>
<tr>
<td>A specific phase</td>
<td>• Select the phase you want to trace.</td>
</tr>
<tr>
<td></td>
<td>• Select the tracing option (All Connected, Transformer, Switch, or Source).</td>
</tr>
<tr>
<td></td>
<td>• Select the direction.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Trace</strong> button.</td>
</tr>
<tr>
<td>Upstream</td>
<td>• Select either “Transformer” or “Switch” in the Trace To field.</td>
</tr>
<tr>
<td></td>
<td>• Select “Upstream” in the Upstream/Downstream drop-down menu.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Trace</strong> button.</td>
</tr>
<tr>
<td>Downstream</td>
<td>• Select either “Transformer” or “Switch” in the Trace To field.</td>
</tr>
<tr>
<td></td>
<td>• Select “Downstream” in the Upstream/Downstream drop-down menu.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Trace</strong> button.</td>
</tr>
</tbody>
</table>
Using the Operator’s Workspace Viewer

<table>
<thead>
<tr>
<th>To trace...</th>
<th>Do this...</th>
</tr>
</thead>
</table>
| Both upstream and downstream | • Select either “Transformer” or “Switch” in the Trace To field.  
• Select “All” in the Upstream/Downstream drop-down menu.  
• Click the Trace button.  
• (Tracing all connected devices and tracing to the source will automatically trace both upstream and downstream.) |
| Using statuses currently displayed in the Viewer | • Select “Real Time” from the Real Time/Nominal drop-down menu.  
• Select the tracing option (All Connected, Transformer, Switch, or Source).  
• Select the direction.  
• Click the Trace button. |
| Using Nominal statuses | • Select “Nominal” from the Real Time/Nominal drop-down menu.  
• Select the tracing option (All Connected, Transformer, Switch, or Source).  
• Select the direction.  
• Click the Trace button. |

Using Cameras

Camera windows provide a way to see map detail while retaining a visual relationship to the larger view.

To open the Camera dialog box, select **Cameras**... from the Navigate menu in the Viewer window or click the button on the toolbar.

Starting a Camera

To start a Camera window, complete these steps:

1. Select **Cameras**... from the Navigate menu. The Camera dialog box opens.
2. Click the **Start Camera** button to set the Camera drawing area contents.
3. Click (with the middle mouse button) in the Viewer to set the first coordinates of the rectangular area to be shown in the Camera.
4. Size the rectangle by dragging the mouse and click again (with the middle mouse button) to select the second coordinates. This rectangle defines the area that appears in the Camera window.
5. Click the button indicating in which quadrant of the Viewer window you want to display the Camera.

**Note:** You can only open one Camera window at a time from a given Viewer window. If you want to open multiple Cameras, you must open multiple Viewers.

The Camera window appears over the Viewer window in the quadrant selected in the Camera dialog box. You can move and position the Camera window like any other window.
Note: Big Symbols displayed in the Viewer do not display in the Camera window.

The rectangle drawn in the above steps stays in the Viewer to indicate the Camera view area. Once the Camera window is started, it has all of the same navigational features as any Viewer.

Moving a Camera Viewing Area
You can change what appears in the Camera by moving the rectangle in the originating Viewer. To move a Camera viewing area, complete these steps:

1. Click on the Drag Camera View button.
2. Click the left mouse button, hold, and drag the rectangle in the Viewer. The image in the Camera follows the rectangle.

Or:
1. Hold the <Shift> key.
2. Click the left mouse button, hold, and drag the rectangle in the Viewer. The image in the Camera follows the rectangle.

Closing a Camera
To close the Camera window, click on the Stop Camera button (or press <Ctrl>+X in the camera window). Click on the Exit button to close the Camera dialog box.

Note: If a Camera window is open, it will stay open even though the dialog box is closed.

Viewing Schematics
If you have Oracle Utilities Network Management System – Schematics installed with your system, you can use the Viewer to view your schematic maps.

To view schematic maps, complete the following steps:

1. In the Viewer, focus on the area you’d like to view the schematic representation of.
2. Select a 3-phase conductor in the area.
3. Select the Object Focus ( ) button. The schematic map of the area is loaded into the Viewer.
4. To toggle back to the topological map, select the Object Focus ( ) button again.

Commissioning or Decommissioning Devices

Symbology
The Viewer can highlight any device marked for construction or decommissioning via the “Highlight Proposed Model Changes” option in the Option -> Preferences panel. The Viewer can also toggle the visibility of unconstructed or decommissioned devices via the Hide/Display panel's “Ignored Devices” option. By default, highlighting is disabled and all devices marked for construction are hidden.

To view all devices that are currently either under construction or decommissioned, toggle the “Pending Devices” option in the Hide/Display panel.
Using the Commissioning Tool

Use the Commissioning Tool to commission a device that is currently in construction, or to decommission devices currently marked for removal.

**Note:** Pending Device changes can be made and reversed at any time and in any order.

Starting the Commissioning Tool


   **Note:** When the commissioning tool is active, the Viewer will only allow selection of devices that are marked as proposed changes.

Commissioning and Decommissioning Sets of Devices

To commission or decommission sets of devices, perform the following steps:

1. In the Viewer, load the pending device changes you wish to modify.
2. Turn on Highlighting in the Viewer preferences.
3. Enable the Pending Devices option in the Hide/Display panel.
4. Switch to study mode if you don’t want to affect the real-time model.
5. Start the Commissioning Tool.
6. Select all devices that need to be commissioned or decommissioned. Note that the Commissioning Tool automatically switches to the same mode as the Viewer and the list of device aliases appear.
7. Click the Approve Changes button.

**Note the following:**

- Devices being decommissioned are no longer are part of the topological model and are immediately deenergized, as are any devices downstream.

- Commissioned devices immediately become part of the topological model and energization is recalculated (i.e., a newly device attached to an energized conductor will become energized).

- Turning off highlighting and hiding “Pending Devices” will show the current state of the model.

- To undo any changes, follow the previous steps as if commissioning, but select **Undo Changes**. The Commissioning Tool will reverse the changes to all modified devices.

   **Note:** Undoing changes on an uncommissioned or decommission-pending device has no effect.
Using the Operator’s Workspace Control Tool

The Oracle Utilities Network Management System – Operator’s Workspace Control Tool window is a separate window you can open from the Viewer window. The Control Tool window allows you to perform actions on devices in the distribution system, such as opening or closing a device or placing a tag on a device.

This section includes the following topics:

- Opening the Control Tool
- Real-Time and Study Modes
- Control Tool Option Types
- Performing Device Operations
- Trouble Management and Operator’s Workspace Functions
- Using the Look Ahead Window
- Viewing the Device Operations List

Opening the Control Tool

To open the Control Tool window, double-click on a device in the Viewer. The operations that are available on the Control Tool differ depending on four factors:

- The type of device that you opened the Control Tool window from
- The current state of the device (For example, if you open the Control Tool window from a device that is closed, the close option is not enabled. You can only open the device.)
- Whether the Viewer window is in real-time or study mode
- The available phases of the device
Real-Time and Study Modes

In real-time mode, the Control Tool window is red and has all of the options available for the current operating conditions enabled. By contrast, in study mode the Control Tool window is gray and has certain options allowable for the device always disabled, such as Repredict Upstream/Downstream, View Call Pattern, Release Crews, Move Crew; and Update Event. Changes made using the Control Tool window while in study mode are only displayed to the current user and are not displayed to other users.

Control Tool Option Types

The options on the Control Tool window are grouped by function type. The following table describes those option types.

<table>
<thead>
<tr>
<th>Option Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Operations</td>
<td>Allows you to open and close a device, place and remove tags, grounds, etc.</td>
</tr>
<tr>
<td>Switching</td>
<td>Allows you to open switching plans and safety documents associated with the device. If multiple documents or plans are associated with a device, a dialog box opens displaying a selection list.</td>
</tr>
<tr>
<td>Trouble</td>
<td>Allows you to perform Oracle Utilities Network Management System – Trouble Management functions, such as repredicting outages to upstream devices.</td>
</tr>
<tr>
<td>Phase Operations</td>
<td>Allows you to operate all or specific phases of a device by toggling All or any combination of A, B, and C phases. Any phases not applicable to the device are disabled (e.g., the Control Tool for an A phase transformer will have B and C disabled).</td>
</tr>
<tr>
<td>Crew Information</td>
<td>Provides information about crew assignments for the selected device. The menu automatically lists the dispatched crew(s); if no crews are dispatched, the menu displays &quot;No Crew En Route.&quot; When multiple crews are assigned to an event, an individual crew may be selected from the list and device operations will be attributed them.</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Allows you to record the date and time an operation was performed. The field defaults to the current date and time, but you can adjust the date using the up and down arrow buttons next to the field. The date and time of the operation displays in the Event Recorder window. NOTE: this will also affect reported outage times.</td>
</tr>
<tr>
<td>Event Information</td>
<td>Allows you to select the specific event used in the action. For example, when there are multiple events on the selected device, this option will allow you to display the Event Details for a specific event in the list. If there are no events on the specified device, the most recently selected event in the Work Agenda is displayed instead.</td>
</tr>
<tr>
<td>Switching</td>
<td>Displays the Instructed action, if any, and enables the Complete, Abort, and Failed actions. See Managing Switching Plans on page 14-1 for more details.</td>
</tr>
</tbody>
</table>
Performing Device Operations

The Control Tool window allows you to perform device operations based on the current status of the device using the Operate button. There are three types of operations: open/close, tag placement, and grounding. You can perform these operations on all or some of the phases of a device. When you perform device operations, the Look Ahead window opens, displaying information about the potential impact of the device operation. For more information on the Look Ahead window, see Using the Look Ahead Window on page 1-49.

This section includes the following topics:

- Control Tool Operations
- Opening and Closing Devices
- Operating Phases on a Device
- Placing Tags on Devices
- Removing Tags from Devices
- Grounding a Device
- Removing a Ground from a Device
- Disabling an ATO
- Re-enabling an ATO

Control Tool Operations

When you open a Control Tool window for a device, you can perform device operations and view information about the device. A Control Tool window opened from a conductor also supports localized model editing.

When you select an option from the Control Tool window, the system performs the action and leaves the Control Tool window open. This allows you to perform multiple actions on the same device without having to open the Control Tool window for each action.

The Control Tool window displays the following options:

- The Operate – Instruct Open option allows you to indicate that you have issued an instruction to a crew to open the device. An Instructed flag appears on the device in the Viewer to alert other operators that device operations are underway on that device. No more device operations will be allowed on the device until the Instructed flag is cleared.
- The Operate – Instruct Close option allows you to indicate that you have issued an instruction to a crew to close the device. An Instructed flag appears on the device in the Viewer to alert other operators that device operations are underway on that device. No more device operations will be allowed on the device until the Instructed flag is cleared.
• The **Operate – Open** option allows you to open a closed device. Oracle Utilities Network Management System Trouble Management detects when opening a particular device will create an outage that is downstream of another outage. A dialog box will ask if you want to create an outage that is nested within another outage. Choosing Yes will create an outage on the opened device. The new outage will affect all of the downstream customers. These customers will no longer be part of the upstream outage. Choosing No will open the device without creating an outage on it. The upstream outage will be unaffected.

• The **Operate – Close** option allows you to close an open device. If you attempt to close a device that adjoins a grounded downstream conductor, a dialog box opens warning that the operation will energize a grounded section. Click **OK** to proceed with the operation or **Cancel** to abort.

• The **Tag/Flag – Instruct Place Tag** option allows you to indicate you have issued an instruction to a crew to place a tag on a device. An Instructed flag appears on the device in the Viewer to alert other operators that device operations are underway on that device. No more device operations will be allowed on the device until the Instructed flag is cleared.

• The **Tag/Flag – Instruct Remove Tag** option allows you to indicate you have issued an instruction to a crew to remove a tag from a device. An Instructed flag appears on the device in the Viewer window to alert other operators that device operations are underway on that device. No more device operations will be allowed on the device until the Instructed flag is cleared.

• The **Tag/Flag – Place Tag** option allows you to place a tag on a device. Placing a tag on a device prevents any user from opening or closing that device. A tag symbol appears attached to the device in the Viewer.

• The **Tag/Flag – Remove Tag** option allows you to remove a tag from a device. Removing a tag allows users to open or close the device.

• The **Tag/Flag – Place Safety Flag** option allows you to place a safety flag on a device. A safety flag indicates safety document is going to be placed against this device or that a safety document was recently on this device. Typically this occurs when a crew has either gone home for the day, that further work is required on or around the device at a later time, or that a safety document is between crew assignments. Placing a safety flag on a device does not prevent a user from opening or closing that device.

  **Note:** You must place a safety flag on a device before you can place a safety document on the device.

• The **Tag/Flag – Remove Safety Flag** option allows you to remove a safety flag from a device.

• The **Ground – Instruct Place Ground** option allows you to indicate you have issued an instruction to a crew to ground a device. An Instructed flag appears on the device in the Viewer to alert other operators that device operations are underway on that device. No more device operations will be allowed on the device until the Instructed flag is cleared.

• The **Ground – Instruct Remove Ground** option allows you to indicate you have issued an instruction to a crew to remove a ground from a device. An Instructed flag appears on the device in the Viewer to alert other operators that device operations are underway on that device. No more device operations will be allowed on the device until the Instructed flag is cleared.

• The **Ground – Place Ground** option allows you to ground a device or conductor. When grounding a device, you will be prompted to indicate the side of the device to ground by selecting an adjacent device or conductor. When grounding an energized conductor, a dialog box opens warning that the operation will ground a live section. Click **OK** to proceed with the operation or **Cancel** to abort.

• The **Ground – Remove Ground** option allows you to remove a ground from a device or conductor.
Using the Operator’s Workspace Control Tool

- The **Disable ATO** option allows you to suppress all automatic operations for the pair of ATO switches by placing a “DISABLED” condition on the selected switch. If either the Primary or Secondary ATO switch is disabled, neither will operate. Note that this condition does not block manual operations.

- The **Enable ATO** option allows you to re-enable automatic operations for the pair of ATO switches by removing the “DISABLED” condition from the selected switch.

- The **Cancel** button closes the Control Tool window.

### Opening and Closing Devices

You can open or close a device in the Viewer to reflect the current state of the device in the field. The device operations you can perform depend on the status of the device. For example, a Control Tool window opened from an open device will only allow you to close the device. You must have authority over the control zone where the device is located in order to operate the device.

To open or close a device, complete these steps:

1. Open a Viewer window and load the map that contains the device you want to open or close.
2. Double-click on the device. The Control Tool window opens.
3. Click the **Operate** button and select the open or close operation from the drop-down menu. The system immediately performs the action.

### Operating Phases on a Device

If a device has multiple phases and you only want to open or close one of the phases, you can select which phase you want to operate. To operate one or multiple phases, complete these steps:

1. Open a Viewer window and load the map that contains the device you want to open or close.
2. Double-click on the device. The Control Tool window opens.
3. Toggle off the phases of the device you do not want to operate.
4. Click the **Operate** button and select the open or close operation from the drop-down menu. The system immediately performs the action for the selected phase(s). The following figure shows a 3-phase switch with only B phase opened.
Placing Tags on Devices

You can tag devices in the Viewer window that are physically tagged in the field. Tags placed on devices in the system prevent users from performing open or close operations on the device. When you place a tag on a device, a tag symbol appears attached to that device in the Viewer. You can place multiple tags on a single device. When you do, the number of tags on the device appears in parentheses next to the tag in the Viewer.

You must have authority over the control zone where the device is located in order to tag the device.

To place a tag on a device, complete these steps:

1. Open a Viewer window and load the map that contains the device you want to tag.
2. Double-click on the device. The Control Tool window opens.
3. Click on the Tag button, and then select the Place Tag option from the drop-down menu. The tag appears on the device in the Viewer window.

Removing Tags from Devices

Before performing an open or close operation on a device, you must remove any tags on the device. To remove a tag from a device, complete these steps:

1. Open a Viewer window and load the map that contains the device you want to remove the tag from.
2. Double-click on the device. The Control Tool window opens.
3. Click on the Tag button, and then select the Remove Tag option from the drop-down menu. If there is only one tag on the device, it disappears from the Viewer window.

If there are multiple tags on the device, a dialog box opens displaying all of the tags. Select the tag you want to remove. The tag disappears from the Viewer window.
Grounding a Device

When you open a Control Tool window from certain devices or conductors (e.g., fuse or wire), the ground function is available. Grounding a device grounds all parts of the circuit connected to the grounding point. The Look Ahead window warns you if the grounding action will create a live, grounded circuit. The grounded circuit is highlighted in the Viewer and indicated by a grounding symbol at the selected device or midpoint of the selected conductor.

To ground a device, complete these steps:

1. Open a Viewer window and load the map that contains the device you want to ground.
2. Double-click on the device. The Control Tool window opens.
3. Click on the **Ground** button and select Place Ground from the drop-down menu. A Select Secondary Object dialog appears.
4. Click on the conductor attached to the device on the side you want to ground and the name of that conductor will appear in the dialog.
5. Click **OK** to proceed with the ground.
   - If you are grounding a live conductor, a warning box opens indicating that you are about to “ground a live section.” Click the **OK to Operate Device** button to proceed with the grounding action (a grounding symbol appears in the Viewer on the device), or click the **Cancel** button to abort the grounding action.

Removing a Ground from a Device

You can only remove a ground from the device or conductor on which the grounding was applied. To remove a ground from a device, complete these steps:

1. Open a Viewer window and load the map that contains the grounded device.
2. Double-click on the device. The Control Tool window opens.
3. Click on the **Ground** button and select Remove Ground from the drop-down menu. A Select Secondary Object dialog appears.
4. Click on the conductor attached to the device on the side with the ground you want to remove and the alias of that conductor will appear in the dialog.
5. Click **OK**, and the grounding symbol is removed from the Viewer.

Disabling an ATO

When you open a Control Tool window from a Primary or Secondary ATO switch, the ATO Disable function is available. Disabling either ATO switch prevents the system from automatically throwing-over or auto-returning the pair of switches.

To disable an ATO switch, complete these steps:

1. Open a Viewer window and load the map that contains the ATO switch.
2. Double-click on the ATO switch. The Control Tool window opens.
3. Click on the **Disable ATO** button. A DISABLED condition will appear on the ATO switch.

The ATO switches can now be operated manually, and energization can change, and the system will not automatically operate either ATO switch.

Re-enabling an ATO

You can only enable an ATO that has previously been disabled. (All ATO switches are enabled by default.)

To enable an ATO switch, complete these steps:

1. Open a Viewer window and load the map that contains the ATO switch.
2. Double-click on the ATO switch. The Control Tool window opens.

3. Click on the Enable ATO button. The DISABLED condition will disappear from the ATO switch.

Once both ATO switches are enabled, the system will once again set the ATO switches to their correct positions, based on the energization.

Trouble Management and Operator's Workspace Functions

The Control Tool window contains several Oracle Utilities Network Management System Trouble Management options. You can use these options to predict device outages upstream, view the call patterns for an outage, and view the customers associated with an outage event. These options correspond to buttons on the Control Tool window:

- Highlighting Events in the Work Agenda Window
- Viewing Call Patterns
- Moving Crews
- Opening the Service / Secondary Outages Manager for a Device
- Repredicting Upstream/Downstream
- Viewing the Customer List
- Viewing the Customer List
- Opening the Event Details Window
- Releasing Crews
- Placing Notes on Devices
- Viewing Device Attributes
- Editing Conductors
- Placing Jumpers
- Creating Momentary Outages

Highlighting Events in the Work Agenda Window

If an event is associated with a device, you can locate the event in the Work Agenda window by clicking the Highlight Event button on the Control Tool window. You must have the correct view of the Work Agenda window open in order to see the highlighted event (e.g., the In Progress list).

Viewing Call Patterns

You can view the calls associated with an event in the Viewer window by clicking the View Call Pattern button on the Control Tool window. A symbol appears attached to any transformers serving customers that have calls associated with the event.

Note: This option is only available on Control Tool windows that are opened from a predictable outage device, such as a switch or fuse, which has an open associated event.

To hide the symbols, open the Control Tool window from the device and click View Call Pattern again.

Moving Crews

You can move a crew to a different device using the Move Crew… button on the Control Tool window. The crew remains associated with the event at the original device but is relocated to a different device. You would typically use this when a crew is dispatched to a device but discovers
they need to spend a significant amount of time in another area to fix the actual cause of the problem. Moving a crew allows operators to know specifically where the crew is located. For more information, see Managing Crews with Trouble Management on page 2-31.

Opening the Service / Secondary Outages Manager for a Device
Use the Secondary Outages... button on the Control Tool window to open the Service/Secondary Outages Manager window and populate it with all customers on the selected device. For more information, see Service/Secondary Outage Manager on page 2-19.

Repredicting Upstream/Downstream
You can force the system to manually repredict a predicted outage either upstream or downstream from the current system predicted device. This is typically done when a crew finds that the problem is not at the predicted device.

- If the device is energized, the problem is actually one or more downstream outages.
- If the device is de-energized, the problem will actually be upstream.

Click the Repredict Upstream or Repredict Downstream button on the Control Tool window to manually repredict the outage to the next predictable upstream or downstream device. When repredicting downstream, the system distributes the event to multiple devices. Once a predicted outage is manually repredicted upstream or downstream, the system will treat the repredicted outages as non-grouping and no longer automatically repredict them.

For example, a crew finds that a predicted service outage (indicated by the “PSO” symbol) at a transformer is not actually where the trouble is located. Using the Control Tool window, you can repredict the outage upstream to the switch. When you repredict the outage, the switch displays a “PDO” (predicted device outage) symbol. The original predicted service outage displayed in one of Work Agenda’s Trouble Events list windows changes to a predicted device outage located at the switch.

Viewing the Customer List
You can view the customers downstream from a device by clicking Customer List... button on the Control Tool window. The Customers view of the Trouble Info window opens, listing all customers downstream from the device. The information displayed includes the device, name, address, phone number and account number of the customer.

Viewing the Customer List
You can view the meters downstream from a device by clicking Customer List... button on the Control Tool window. The Customers view of the Trouble Info window opens, listing all meters downstream from the device. The information displayed includes the device, phases, customer name, address, phone number and account number of the customer, as well as recent meter ping information. From this page, you can initiate a ping request, as well as monitor previous ping results.

Opening the Event Details Window
Use the Update Event button to open the Event Details window for the event selected on the Control Tool. This event number is selected on the Event Info drop-down menu on the right-hand side of the Control Tool. Options in the Event Info drop-down menu are taken from all active events on the device selected in the Viewer and the most recently selected Work Agenda row.

Releasing Crews
Releases all assigned and dispatched crews for the selected event on the Control Tool. The selected event is determined in the same manner as for the Update Event option.
Placing Notes on Devices
The Control Tool window allows you to place notes on devices. When you open the Control Tool window from a device, click the Note… button. A Note dialog box opens allowing you to enter notes that relate to the device. Once you enter and save the note, a note symbol displays attached to the device in the Viewer.

For more information, refer to the following sub-topics:

• Notes Dialog
• Creating a Note
• Viewing and Editing a Note
• Deleting a Note

Notes Dialog
The Notes dialog displays the following fields and buttons:

• The note field displays the date and time the note was created, along with the user name of the user that created the note.
• The Note field displays the text of the note selected in the note list.
• The New button creates a new note.
• The Edit button opens the selected note for editing.
• The Save button saves the note, or any edits to the note, and closes the Note dialog box.
• The Clear Note button clears the selected note's text.
• The Delete button deletes the selected note and closes the Note dialog box.
• The Exit button closes the Note dialog box.

Creating a Note
You can create one or more notes for a device using the Control Tool window. Once you save a note, a note symbol displays in the Viewer window next to the device. If you create multiple notes for a device, the number of notes is displayed in parentheses next to the note symbol.

To create a note:
1. Open a Viewer window and load the map that contains the device you want to add the note to.
2. Double-click on the device. The Control Tool window opens.
3. Click the Note… button. A note dialog box opens.
4. Type the note in the Note text field.
5. Click Save. The note dialog box closes and a note symbol appears attached to the device.

Viewing and Editing a Note
After you have created and saved a note, you can view and edit it. All notes for the selected device are listed in the note section of the Note window. You can also view notes in the Note Summary window (see Using the Note Summary on page 1-54).

To view and edit a note, complete these steps:
1. Open a Viewer window and load the map that contains the note you want to view or edit.
2. Double-click on the device that the note is attached to. The Control Tool window opens.
3. Click the Note… button. A note dialog box opens displaying the note(s).
4. Select the note you wish to view or edit. The note text displays in the Note field.
Using the Operator's Workspace Control Tool

5. If you want to edit the note, click the **Edit** button. Otherwise, click the **Exit** button.
6. Edit the note text.
7. Click **Save**. The note dialog box closes.

**Deleting a Note**

When a note is no longer needed, you can delete it. To delete a note, complete these steps:

1. Open a Viewer window and load the map that contains the note you want to delete.
2. Double-click on the device that the note is attached to. The Control Tool window opens.
3. Click the **Note…** button. A note dialog box opens displaying the note(s).
4. Select the note you wish to delete. The note text displays in the Description section.
5. Click the **Delete** button. The note dialog box closes and the note is deleted.

**Viewing Device Attributes**

The **Attributes…** button on the Control Tool window opens the Device Attributes window, which lists information about the selected device's properties (e.g., manufacturer, installation date, type, rating, etc.). Information displayed in this window is read-only. Click the **Print** button to print the attributes.

While the Device Attributes window is open, you can view information about another device by selecting that device in the Viewer window. The selected device's ID appears in the Selection field. Click the **Execute Query** button to display the information for the selected device in the description area. See **Viewing Attribute Information** on page 1-66 for more information.

**Editing Conductors**

You can use the Control Tool window to edit conductors in the system. The Control Tool window allows you to perform operations on selected conductors to make localized and controlled model edits. In addition to the model edit options, you can also apply or remove grounding, attach notes, and view and modify the device attributes for the conductor.

Because changes made using the Control Tool window transform the real-time model, the edited section is fully operable (e.g., you can open and close jumpers). The original conductors are broken and replaced by new conductors, and either a wire gap or jumper is inserted at the midpoint of the wire. There are two types of conductor modifications: creating an open point in a conductor and inserting a jumper.

**Note:** Model edits made using the Control Tool window are temporary model changes.

For more information, refer to the following sub-topics:

- **Creating an Open Point in a Conductor**
- **Removing an Open Point in a Conductor**

**Creating an Open Point in a Conductor**

You can edit a conductor in order to simulate an “open point,” either a wire down for an overhead conductor or a cut cable for an underground conductor. In both cases, an open point symbol is placed at the mid point of the selected conductor. To create an open point, complete these steps:

1. Open a Viewer window that contains the open conductor.
3. Select the desired phases from the Phases panel then click either the **Phase Wire Down** (OH) or **Cut Phase** (UG) button to create the open point.
Removing an Open Point in a Conductor
To remove an open point, complete these steps:
1. Open a Viewer window that contains the open conductor.
3. Select the desired phases from the Phases panel then click either the Put Up Wire (OH) or the Repair Cable (UG) button to remove the open point.

Placing Jumpers
In addition to creating an open point, you can insert a jumper on an overhead conductor or between overhead conductors. You can also place emergency cables between underground devices. The jumper is an active part of the model and fully operable. You can open and close a jumper as well as place tags and notes on the jumper.

For more information, refer to the following sub-topics:
• Jumper Symbol in the Viewer
• Jumper Types
• Inserting a Jumper
• Operating a Jumper
• Removing a Jumper

Jumper Symbol in the Viewer
The following Viewer window displays a point-to-point jumper symbol.
Jumper Types

The following table describes the different jumper types.

<table>
<thead>
<tr>
<th>Jumper Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In-line Jumper</td>
<td>In-line jumpers are placed in line. The position for the jumper is set to “closed” to maintain a continuous conductor. A closed jumper symbol displays at the midpoint of the selected conductor.</td>
</tr>
<tr>
<td>P-P Jumper / Emergency Cable</td>
<td>Point-to-point jumpers are placed between a selected conductor and the same phase on any other conductor. A dialog box allows you to specify the second conductor. You can select the conductor in the Viewer window. A point-to-point jumper symbol displays at the midpoints of the selected conductors. The default state for the inserted jumper is “closed.”</td>
</tr>
<tr>
<td>P-P Cross Phase</td>
<td>Point-to-point cross phase jumpers are placed between different phases on two different conductors. The Cross Phase dialog box allows you to select a live phase and the phase to pick up. The Select Device dialog box allows you to specify the second conductor. You can select the conductor in the Viewer window. A point-to-point jumper symbol displays, connecting the midpoints of the selected conductors. The default state for the inserted jumper is “closed.”</td>
</tr>
</tbody>
</table>

Inserting a Jumper

After the crew informs you what type of jumper they will insert, you can make the change in the system. To insert a jumper, complete these steps:

1. Open a Viewer window and load the map that contains the conductor where you want to place the jumper.
3. Select the type of jumper you want to insert. A dialog box opens unless you are doing an In-Line Jumper -- then go to the final step.
4. Select another conductor (in the Viewer window), and then click OK. Wait a moment as the system updates the model.
5. Click Yes in the Map Load Confirmation dialog box if you want to reload the map. The Viewer window displays the jumper.

Operating a Jumper

Like devices, you can open and close (Disconnect and Connect) jumpers. To open or close a jumper, complete these steps:

1. Open a Viewer window and load the map that contains the jumper you want to operate.
2. Double-click on the jumper. The Control Tool window opens.
3. Select the desired phases from the Phases panel then click the operation you want to perform, either Disconnect Jumper or Connect Jumper.

Removing a Jumper

Once a jumper has been removed in the field, you can remove the jumper from the system. This removes the jumper and fully restores the conductor. To remove a jumper, complete these steps:

1. Open a Viewer window and load the map that contains the jumper you want to remove.
Using the Operator's Workspace Control Tool

Creating Momentary Outages
You can create a past momentary outage by simulating a momentary interruption in the system. Momentary interruptions occur when a recloser operates and does not lock out. The Create Momentary... button is only enabled on Control Tool windows opened from reclosing devices. To create a momentary outage, complete these steps:
1. Open a Viewer window and load the map that contains the device that you want to create the momentary outage for.
2. Double-click on the device. The Control Tool window opens.
3. Adjust the date and time if necessary. The date and time specified must be in the past.
4. Click the Create Momentary... button. A dialog box opens.
5. Enter the number of momentaries.
6. Click OK. The momentary outage displays in the Work Agenda window with a status of “M-CMP.” In addition, two alarms display in the System Alarms list, one for opening and one for closing.

Using the Look Ahead Window
The Look Ahead window provides information concerning the results of performing an Open or Close operation. The Look Ahead window opens before the operation is actually performed and allows you to cancel the operation. The Look Ahead window operates in both real-time and study modes, and appears whenever a device operation is initiated from either the Control Tool or the Switching Plan Editor in energized portions of the distribution system.

The Look Ahead window displays tables of information about the operation. The information displayed depends on the results of performing the intended operation. The coloring of the Look Ahead window follows the same coloring scheme as the Viewer, Control Tool, and Switch Sheet Editor to indicate real-time (red) or study (gray) modes.

There are multiple views on the Look Ahead window, which you can access by clicking the buttons on the window (e.g., View Conditions). However, the information displayed in the header section of the Look Ahead window displays regardless of the table you are viewing.

For more information, refer to the following topics:

• Look Ahead Process
• Look Ahead Window
  • Counts Panel
  • ATO Customers Panel
  • Conditions Panel
  • Abnormal Devices Panel
  • Critical Customers Panel

Look Ahead Process
The Look Ahead window uses status and topology tracing to “look ahead” of the requested operation and determine its consequences. Based on this information, you can decide whether to
continue with an operation. The flow diagram below shows the basic logic of the Look Ahead window.
Look Ahead Window

The Look Ahead window displays the following fields:

- The **Device** field displays the name of the device being operated.
- The **Phase(s) to Operate** field displays the phase(s) of the device being operated.
- The **Loops/Parallels** field displays a warning if an operation will create or break loops or parallels and lists the feeders involved.

Buttons

The buttons at the bottom of the Look Ahead window provide access to tables that contain a variety of information related to the device operation. The buttons that are enabled depend on the state and conditions of the device. If conditions are present, you cannot open or close a device until you have viewed them.

- The **Open/Close** button allows you to proceed with an Open/Close operation. If an “open” operation opened the Look Ahead window, then the **Open** button appears. If it is a “close” operation, the **Close** button appears. The button is disabled if conditions are present that you have not yet viewed. Once you view any conditions, the button becomes enabled.
- The **Select Device** button allows you to return to the original device being operated. To resume viewing the device to operate after focusing on another device, click the **Select Device** button and then the “target” button in the Viewer.
- The **E-Mail** button allows you to attach a text file of the currently displayed table to an E-mail. A dialog box opens prompting you for standard E-mail information. You can attach additional files to the E-mail. Click **Send** to send the Email to the recipient with the attached text file and any other attached file.
- The **Print** button allows you to print the contents of the currently displayed table.
- The **Cancel** button allows you to terminate the operation without making any change to the device or the network.

The buttons at the top of the Look Ahead window provide access to more tables that contain a variety of information related to the device operation.

- The **View ATO Custs** button allows you to view all customers who will be affected momentarily by a resulting ATO operation. If no momentary outages will result from the proposed operation, the **View ATO Custs** button is disabled. Clicking this button opens the ATO Customers table.
- The **View Conditions** button allows you to view any special conditions upstream or downstream of the device such as a note, tag, or crew. If special conditions do not exist, the **View Conditions** button is disabled. Clicking this button opens the Conditions table.
- The **View Abnormal** button allows you to view any abnormal devices on the device feeder. If abnormal devices do not exist, the **View Abnormal** button is disabled. Clicking this button opens the Abnormal Devices table.
- The **View Critical** button allows you to view any critical customers affected by the device operation. If there are no critical customers downstream of the device, the **View Critical** button is disabled. Clicking this button opens the Critical Customers table.
- The **View Counts** button allows you to view the number of customers affected by the device operation. The Counts table is the default view for the Look Ahead window.

Counts Panel

The Counts panel displays the number of customers affected by the device operation. This is the default view for the Look Ahead window. The Counts table provides information for total Critical Customers with sub counts for three types of critical customers, Interrupting Current (phase), and Total Customers.
• The first set of two columns shows data for the total counts. The following three sets of two columns show data for each individual phase (A, B, and C), with the last set showing counts for 3-phase customers. The counts for the individual phases (A, B, C) and 3-phase will add up to the counts in the “total” columns (i.e., A+B+C+3=Total).

• The rows displayed in the counts table include Crit Customers, EMR Customers, MED Customers, KEY Customers, Interrupting Current, and total customers. Click on the View Counts button to access count information from any of the other views.

• The Drop/Pickup columns display the drop or pickup information for the device, depending on the action being performed. “Open” operations will display Drop results and “close” operations will display Pickup results. Information is displayed as counts picked up or dropped downstream of the device.

• The Fdr columns display the total counts for the feeder on which the device to operate is located.

ATO Customers Panel
The ATO Customers panel displays the number of customers affected by automatic ATO operations as a result of the device operation. These customers will not be listed in the Counts table.

On loss of the primary feed:
• The ATO Customers page will list customers downstream from a pair of enabled ATO switches with a live secondary feed, because they will experience a momentary outage.

• The ATO Customers page will not list customers downstream from a pair of ATOs if either the primary or secondary switch is disabled. These customers will appear on the Counts table, because they will experience a sustained outage.

• The ATO Customers page will not list customers downstream from a pair of ATOs if the secondary feed is already lost. These customers will appear on the Counts table, because they will experience a sustained outage.

On restoration of the primary feed:
• The ATO Customers page will list de-energized customers who will be auto-returned if the secondary feed is already lost.

• The ATO Customers page will list currently energized customers who will be auto-returned if the ATO is configured as a “break before make” on auto-return.

• The ATO Customers page will not list currently energized customers who will be auto-returned if the ATO is configured as a “make before break” on auto-return.

Similarly to the Counts table, the ATO Customers table provides information for total Critical Customers with sub counts for three types of critical customers, Interrupting Current (phase), and Total Customers.

The first column shows data for the total counts. The following three columns show data for each individual phase (A, B, and C), with the last set showing counts for 3-phase customers. The counts for the individual phases (A, B, C) and 3-phase will add up to the counts in the “total” columns (i.e., A+B+C+3=Total).

The rows displayed in the counts table include Crit Customers, EMR Customers, MED Customers, KEY Customers, Interrupting Current, and total customers. Click on the View ATO Custs button to access ATO Customer information from any of the other views.

Conditions Panel
The Conditions panel shows any special conditions currently active on the feeder including crew locations, outages, tags, notes, etc. If conditions are present, you must view the conditions table to complete the operation. Click on the View Conditions button to access condition information.
The Conditions table includes the following columns:

- The **Condition** column displays the type of condition that is present on the feeder such as a truck (crew), tag, note, etc.
- The **Device** column displays the name of the device on which the condition is located.
- The **Location** column indicates whether the condition is upstream or downstream of the current device.
- The **User** column displays the user name of the user that created the condition.
- The **Date** column displays the date and time that the condition was created.
- The **Description** column will display any text entered for the note, if the condition is a note.

**Abnormal Devices Panel**

The Abnormal Devices table displays data about abnormal devices on the same feeder as the device to operate. An “abnormal device” is any device that is not in its nominal state (e.g., an open device that is normally closed).

The Abnormal Devices table includes the following columns:

- The **Device** column displays the name of the device that is in an abnormal state.
- The **Nominal Status** column displays the normal status of the device.
- The **Current Status** column displays the current status of the device.

**Critical Customers Panel**

The critical table shows any critical customers downstream of the device. If critical customers are present, you do not need to view the critical table to complete the operation.

The critical table includes the following columns:

- The **Name** column displays the critical customer's name.
- The **Address** column displays the critical customer’s address.
- The **Phone** column displays the critical customer’s telephone number.

**Viewing the Device Operations List**

The Device Operations list on the Work Agenda window displays information about device operations performed using the Control Tool.

To view device information, select a row on Device Operations list and click the **Object Focus** button in a Viewer window.

The Device Operations list displays the following fields and buttons:

- The **User Date** column contains the date and time of the operation.
- The **Feeder** column contains the name of the feeder that the device is nominally on.
- The **Device** column contains the name of the device on which the operation occurred.
- The **Description** column contains a brief description of what type of operation occurred. Examples are “Device Operation” for an Open or Close, “PLACED [note]” if a note was put on the device and “REMOVED [note]” if a note was deleted from the device.
- The **Source** column contains the source of the device operation request. This value is typically a user's login ID.
- The **Value** column contains the state of the device (e.g., OPEN, CLOSED, etc.) immediately after the operation.
• The **Phase** column contains all of the phases that the device has available to be operated.
• The **Nominal** column contains the normal state of the device (e.g., OPEN, CLOSED, etc.).
• The **Exit** button exits the Device Operations list.

## Viewing Summaries

Oracle Utilities Network Management System Operator's Workspace includes a number of windows that provide summary information for data in the system. The summary windows allow you to view and edit notes, review abnormal device conditions, and view SCADA information.

This section contains the following topics:
- Using the Summaries Window
- Using the Note Summary
- Using the Tag Summary
- Using the Abnormal Device Summary
- Viewing the Systems Alarm List
- Using the SCADA Summary

### Using the Summaries Window

You can access most of the summary windows using the **Summaries** button on the Environment Manager. Click on the button or toggle box for the summary you want to view and the selected summary window will open. You can sort and filter the information displayed in each summary window. For more information, see **Sorting and Filtering Data** on page 1-3.

The Summary windows display the following information:
- The **Note Summary** button opens the Note Summary window that displays a list of notes that have been entered into the system using the Control Tool window.
- The **Tag Summary** button opens the Tag Summary window that displays a list of tags that have been entered into the system using the Control Tool window.
- The **Abn Device Summary** button opens the Abnormal Device Summary window that displays a list of devices that are not currently in their nominal state.
- The **Trouble Summaries** button opens the Trouble Summaries window that displays event-related information by company, region, branch, substation, feeder, and device. See **Viewing Trouble Summaries** on page 2-63 for more information.
- The **SCADA Summary** button opens the SCADA Summary window that displays SCADA-related information. See **Using the SCADA Summary** on page 13-3 for more information.
- The **Exit** button closes the Summaries dialog.

### Using the Note Summary

The Note Summary lists all notes that have been entered into the system. Notes are attached to devices via the Control Tool.

The Note Summary displays the following fields and buttons:
- The **Note #** column contains the unique number of the note attached to the device.
- The **User** column contains the user name of the individual that placed the note.
- The **Date Created** column contains the date and time the note was created.
• The **Substation** column contains the name of the substation that serves the device on which the note is located.

• The **Feeder** column contains the name of the feeder that serves the device on which the note is located.

• The **Device** column contains the name of the device on which the note is located.

• The **Note** column contains the note text.

• The **Delete** button deletes the selected note from the system. The note disappears from both the Note Summary the Viewer.

• The **Edit** button opens the Note Summary dialog box that allows you to edit the content of the note.

• The **Refresh** button updates the notes listed in the Note Summary. If you update a note (using the **Edit** button), then you must refresh the view on the Note Summary to view the changes.

• The **View** button displays in the Viewer the device on which the note is located, if you have a Viewer window open.

• The **Exit** button closes the Note Summary window.

**Editing a Note**

To edit a note, select a note from the Note Summary window, and then click the **Edit** button. The Note Summary dialog box opens. Do any of the following:

• To add or edit text, place the cursor in the Note field and type the text you want to add. Use the <Delete> key on the keyboard to remove unwanted text.

• To remove all note text, click the **Clear Note** button.

• To delete the note, click the **Delete** button.

• To save your changes, click **Save**. The Note Summary dialog box closes.

**Using the Tag Summary**

Use the Tag Summary window to see a list of all the tags that have been placed on devices using the Control Tool window.

The Tag Summary window displays the following fields and buttons:

• The **Tag #** column contains the unique number of the tag attached to the device.

• The **User** column contains the user name of the individual that placed the tag.

• The **Date Created** column contains the date and time the tag was created.

• The **Substation** column contains the name of the substation that serves the device on which the tag is located.

• The **Feeder** column contains the name of the feeder that serves the device on which the tag is located.

• The **Device** column contains the name of the device on which the tag is located.

**Buttons**

• The **Delete** button deletes the selected tag from the system. The tag disappears from both the Tag Summary the Viewer.

• The **Refresh** button updates the tags listed in the Tag Summary.

• The **View** button displays in the Viewer the device on which the tag is located, if you have a Viewer window open.
• The Exit button closes the Tag Summary window.

**Using the Abnormal Device Summary**

The Abnormal Device Summary lists all devices that are not in their nominal state. For example, if a switch that is nominally closed is currently open, it will display in the Abnormal Device Summary. If a SCADA system is integrated with Oracle Utilities Network Management System, any devices that are reported by a SCADA point as being in an off-nominal state will also display. This will also display any wire downs or jumpers, or emergency cables in either an open or closed state.

The Abnormal Device Summary displays the following fields and buttons:

- The Date contains the date and time that the device was last operated.
- The Feeder column contains the name of the feeder that serves the abnormal device.
- The Device column contains the name of the abnormal device.
- The Description column contains a description of the operation that caused the abnormal state.
- The Source column contains the source of the abnormal operation.
- The Value column contains the current state of the device.
- The Phase column contains the phases of the device.
- The Nominal column contains the normal state of the device.
- The Attributes button displays the Attributes window for the selected device.
- The View button displays in the Viewer the selected device, if you have a Viewer window open.
- The Exit button closes the Abnormal Device Summary window.

**Viewing the Systems Alarm List**

The Systems Alarm list window displays any system-wide alarms there may be. System-wide alarms may be generated whenever one of the Oracle Utilities Network Management System services fails or when there are control zones not under the authority of any user. Access the Systems Alarm list window by clicking on the System Alarms button on the Environment Manager.

The Systems Alarm list displays the following fields and buttons:

- The Date column contains the date and time at which the alarm was generated.
- The Description column contains a description of the alarm.
- The Who Ack column contains the name of the user that acknowledged the alarm, if any.
- The Date Ack column contains the date and time at which the user acknowledged the alarm, if any.
- The Acknowledge button is used to acknowledge the selected alarm. The Who Ack and Date Ack columns are then populated for the alarm row.
- The Clear button is used to remove a selected alarm from the list. You must first acknowledge the alarm before you can clear it.
- The Exit button closes the Systems Alarm list window.
Using the SCADA Summary

SCADA functionality is provided as an extension to Oracle Utilities Network Management System. An overview of SCADA extensions is provided in Chapter 13: SCADA Extensions.

The SCADA Summary provides the current values and qualities of all mapped SCADA measurements in Oracle Utilities Network Management System. Each row of this summary represents one measurement. There may be multiple unique measurements on one SCADA device. SCADA information includes digital and analog measurements, along with the quality codes and any user comments for each measurement. You can use the summary to view measurement information, manually replace current SCADA values, and inhibit updates.

This section contains the following topics:

- SCADA Summary Fields and Buttons
- Preventing Updates from SCADA
- Adding Comments to SCADA Measurements
- Deleting Comments from SCADA Measurements
- Manual Entry and Override of SCADA Values

SCADA Summary Fields and Buttons

To open the SCADA Summary, open the Summaries toolbox on the Environment Manager and select SCADA Summary.

The SCADA Summary displays the following fields and buttons:

- The Feeder column contains the name of the feeder reporting the SCADA measurements.
- The Device column contains the name of the device reporting the SCADA measurements.
- The Attribute column contains the SCADA measurement value (e.g., status, voltage, current).
- The Value column contains the last reported measurement value. The value can be status, digital, or analog. For status measurements, the values are displayed as a test pair, such as open/close, on/off, etc. Analog and digital values are shown as floating point and integer values.
- The Qual column contains the Quality codes for the measurement that indicates the quality of the SCADA measurement (e.g., out of scan, inhibited, manual override). Several quality codes can be listed.
- The Units column contains the unit of measurement value (e.g., amps, kVA). Status measurements do not have units.
- The Point Name column contains the source for the measurement, as configured in the ANALOG_MEASUREMENTS.source or DIGITAL_MEASUREMENTS.source column in the Oracle Utilities Network Management System database.
- The Type column contains a description of the measurement type, as configured in the ATTRIBUTES.description column in the Oracle Utilities Network Management System database for the matching attribute.
- The Comment column contains the user-entered comment for the SCADA measurement, if any.
- The Update button refreshes the information displayed in the SCADA Summary window.
- The Comment button allows you to enter a comment for the measurement for the device.
- The Inhibit option on the Action menu sets the “inhibit” quality code for the selected SCADA measurement. This suppresses any new updates from SCADA.
- The **Cancel Inhibit** option on the Action menu removes the “inhibit” quality code from the selected SCADA measurement. This retains the currently displayed value while allowing any subsequent updates from SCADA to be displayed.

- The **Manual Entry** option allows you to enter a new value and sets the “manual” quality code for the selected SCADA measurement. When a changed SCADA value is received by the system, it replaces the manually entered value and removes the “manual” quality code.

- The **Manual Override** option allows you to enter a new value and sets the “inhibit” and “manual” quality codes for the selected SCADA measurement. When a new SCADA value is received by the system, the value is held in reserve and the manually entered value remains.

- The **Cancel Override** option on the Action menu removes any “inhibit” and “manual” quality codes for the selected measurement and reverts the selected measurement to the last received value from the SCADA system.

- The **Inhibit Alarms** option on the Action menu prevents new updates from SCADA from being displayed. This also prevents any alarm updates that SCADA values may have generated.

- The **Cancel Inhibit Alarms** option on the Action menu cancels the inhibit alarms on the selected measurement, allowing updates from the SCADA system and resulting alarms based upon those values.

- The **Exit** button closes the SCADA Summary window.

**Sorting and Filtering**

You can sort and filter the SCADA Summary table using standard sort and filter capabilities (see Sorting and Filtering Data on page 6-11).

**Preventing Updates from SCADA**

To prevent a SCADA measurement from accepting updates from SCADA, complete these steps:

1. Select a row in the list that belongs to the device you want to inhibit.
2. Select the **Inhibit** option from the Actions menu.

**Adding Comments to SCADA Measurements**

To add comments to a SCADA measurement, complete these steps:

1. Select the row of the measurement you want to comment on.
2. Click the **Comment** button. A dialog box opens.
3. Type your comments in the **New Value** field.
4. Click the **Save** button. Your comments display in the **Comment** column of the SCADA Summary.

**Deleting Comments from SCADA Measurements**

To delete comments from a SCADA measurement, complete these steps:

1. Select the row of the measurement you want to delete the comment from.
2. Click the **Comment** button. The Comment dialog box opens with the existing comment appearing in the New Value field.
3. Click the **Delete** button. The comment disappears from the **Comment** column of the SCADA Summary.
Manual Entry and Override of SCADA Values

Occasionally, you may need to manually enter a status, digital value, or analog value for a SCADA measurement.

To enter a value, complete these steps:

1. Select the SCADA measurement row.
2. Click either the Manual Entry or Manual Override button:
   - A manual entry will allow future SCADA value changes to update the value you enter.
   - A manual override will retain a manually entered value until the Manual Override flag is removed by clicking the Cancel Override button. Manual Override can be useful when testing specific devices or RTU communications offline, since the test operations can be prevented from creating outages in Oracle Utilities Network Management System by putting manual overrides on the appropriate status measurements.

If the value for the selected measurement is a switch status measurement (i.e., open/close), a dialog box opens allowing you to select either open or close. If the value for the measurement is any other type of measurement (i.e., multi-state digital, analog), a dialog box opens allowing you to enter a value. Multi-state digitals are not available through the Oracle Utilities Network Management System SCADA ICCP Block 1, 2, and 5 Adapter.

3. Select/enter the desired value.
4. Click OK.

Note: Clicking on the Manual Override button “blocks” any new values coming from the SCADA measurement. It does not affect the physical SCADA device, it only blocks the value reported by the device to Oracle Utilities Network Management System.
Using the Model Validation Environment

The Model Validation Environment lets you study or edit information in the operations model, including database tables, model changes, and device attributes.

This section contains the following topics:

• Logging In
• Using the Model Validation Environment Manager
• Using the SqlX Database Query
• Using the Object Debug (What) Window
• Using the Topology View Window
• Viewing Model Changes
• Using the Model Build Report
• Viewing Attribute Information
• Model Validation Viewer

Logging In

When an authorized user logs into the system under the Model Validation user type, Oracle Utilities Network Management System opens with an Environment Manager that contains model validation and administrative tools.

To open the Model Validation Environment Manager, complete these steps:

1. Click on the Login button on the Oracle Utilities Network Management System Login screen. The Login dialog box opens.
2. Enter your user name and password.
3. Open the drop-down menu and select Model Validation.
4. Click OK.

Using the Model Validation Environment Manager

The Model Validation Environment Manager offers access to windows for viewing and editing database tables, device attributes, and more.

The Model Validation Environment Manager windows contains the following buttons:

• The Authority button opens the Authority window.
• The DB Query button opens the SqlX window for viewing table contents in the Relational Database Management System (RDBMS). This window is used for studying table data that controls system functions, including users, authorizations, and application configuration.
• The Object Debug button opens the What dialog box used for model debugging. It allows you to select devices in the Viewer window and display their model information.
• The Topology View button opens the Topology View window, which is used to walk through the electrical topology. It provides a “top view” of what the Viewer displays in the maps.
• The Model Changes button opens the Model Changes window that lists any model build patches that remain unresolved.
• The MB Report button opens an HTML-based overview of the model build progress and the status of patches built for model builds that have recently occurred.
• The **Attribute Info** button opens the Attributes window.

The last four buttons on the Environment Manager (**Help**, **Refresh Apps**, **Relogin**, **Logout**) perform exactly the same functions as the buttons on the Oracle Utilities Network Management System – Operator’s Workspace Environment Manager. For more information on these buttons, see **Administrative Tools** on page 1-11.

### Using the SqlX Database Query

The SqlX database query function allows you to quickly view the table contents in the relational database. This data is used for many administrative tasks such as adding users, changing authorizations, and reconfiguring an application. While knowledge of SQL will enhance your use of this feature, the SqlX window allows a user with little or no knowledge of SQL to search the database.

This section includes the following topics:

• Using the SqlX Window

• Performing SQL Queries Manually

• Performing SQL Queries Without Manually Entering Strings

### Using the SqlX Window

To open the SqlX window, click the **DB Query** button on the Model Validation Environment Manager. The SqlIX window displays the following buttons:

• The **Execute** button executes the current query. The query results display in the results area that takes up the largest portion of the display.

• The **Clear** button clears the current query and results data.

• The **Tables** button opens the SqlX Tables window and populates it with a list of all the tables in the RDBMS. This function may be used to quickly query the available tables and create a report showing the complete contents of any single table.

• The **Queries** button opens the SqlX Queries window that lets you create, store, and recall queries.

• The **Stack** button opens the SqlX Query Stack window, which lists all previously executed queries from the current SqlX session.

• The **Desc** button summarizes the selected table by displaying column names, allowable data types for the columns, and allowable size for the data type. This summary is useful when performing queries.

• The **Print** button opens the Print dialog box, allowing you to print the displayed information.

• The **Quit** button closes the SqlX window.

### Performing SQL Queries Manually

To manually perform a query, enter an SQL query string in the Query field and click the **Execute** button on the SqlX window. The columns in the database appear in the Query Results area.

### Performing SQL Queries Without Manually Entering Strings

To perform queries without manually entering SQL strings, use the SqlX Tables, SqlX Queries, and SqlX Query Stack windows. These windows enable users who are unfamiliar with SQL to perform queries. They are also helpful for users who know SQL, enabling them to quickly find and modify query strings.
Using the SqlX Tables Window

The SqlX Tables window lists all the tables contained in the database, allowing you to perform a query without having to manually enter a query string.

To access this window, click the Tables button in the SqlX window. The SqlX Tables window displays the following buttons:

- The **OK** button places the selected table name into the SqlX window's query field with a “select * from [table name]” string and closes the SqlX Tables window.
- The **Apply** button places the select table name into the SqlX window's query field with a “select * from [table name]” string, but leaves the SqlX Tables window open.
- The **Cancel** button closes the SqlX Tables window without displaying table data.
- The **Help** button is non-functional – the Help documentation for the Oracle Utilities Network Management System product is accessible outside of the Oracle Utilities Network Management System applications via Internet Explorer.

Selecting a Table

If you select a table name from the Database Tables list, the Selection field populates with the selected table name. You can manually modify the table selection in the Selection field.

Executing a Query

Click **Apply** or **OK** to place the table name in the SqlX window’s query field with a “select * from [table name]” string. The **OK** button closes the SqlX Tables window; the **Apply** button does not. When you execute this string in the SqlX window (click **Execute**), all information in the table will appear.

Using the SqlX Queries Window

The SqlX Queries window lets you create, store, and recall queries.

To open this window, click the Queries button from the SqlX window. The SqlX Queries window displays the following buttons:

- The **OK** button copies the currently selected query to the Query field in the SqlX window and closes the SqlX Queries window. When the query is executed in the SqlX window, the stored query title appears at the top of the results area.
- The **Apply** button copies the currently selected query to the Query field in the SqlX window and keeps the SqlX Queries window open. When the query is executed in the SqlX window, the stored query title appears at the top of the results area.
- The **Store** button stores the information in the Name, Title, and Query fields as a query. If a query is already stored with the same name, the new entry will replace the previous one.
- The **Delete** button deletes the selected query from storage.
- The **Cancel** button closes the SqlX Queries window.
- The **Help** button is non-functional – the Help documentation for the Oracle Utilities Network Management System product is accessible outside of the Oracle Utilities Network Management System applications via Internet Explorer.

Displaying a Query

The names of all the stored queries appear in the Stored Queries list at the top of the SqlX Queries window. If you select a query in the list, the Name, Title, and Query fields populate for the selected query. To display the query in the SqlX window, click on **Apply** or **OK**. The **OK** button closes the SqlX Queries window; the **Apply** button does not.

Creating a New Query

To create a new query, enter a name, title, and query string and click the **Store** button on the SqlX Queries window. The new query appears in the Stored Queries list.
Stacking Queries Using SqlX

The SqlX Query Stack lists all previously executed queries from the current SqlX session. Open the SqlX Query Stack window by clicking the Stack button in the SqlX window.

The Sqlx Query Stack displays the following buttons:

- The OK button copies the selected query to the Query field in the SqlX window and closes the SqlX Query Stack window.
- The Apply button copies the selected query to the Query field in the SqlX window, but does not close the SqlX Query Stack window.
- The Cancel button closes the SqlX Query Stack window without copying the selected query to the Query field in the SqlX window.
- The Help button is non-functional – the Help documentation for the Oracle Utilities Network Management System product is accessible outside of the Oracle Utilities Network Management System applications via Internet Explorer.

Selecting a Query to Execute in the SqlX Window

The Selection field displays the query selected from the Query Stack list.

To display the query in the SqlX window, click on Apply or OK. The OK button closes the SqlX Query Stack window; the Apply button does not.

Using the Object Debug (What) Window

Object Debug is used for model debugging. It allows you to select devices in the Viewer window and display their model information. This section includes the following topics:

- Opening the Object Debug window
- Retrieving Device Information
- Viewing the What Tool Dialog Box

Opening the Object Debug window

To open the Object Debug window, click the Object Debug button on the Model Validation Environment Manager. The Object Debug window displays the following buttons:

- The What button opens the What Tool dialog box, which displays information about the device, including identity, state, topological connections, feeder, and symbology.
- The Focus button sends a message to all Viewer windows to navigate to the selected device and center on it.
- The Quit button closes the What window.

Retrieving Device Information

To retrieve information about a device, complete these steps:

1. Select a device in the Viewer window to populate the Object field with that device.
2. Click the What button. The What Tool dialog box opens displaying information about the device, including identity, state, topological connections, feeder, and symbology.
3. Click the Focus button. The Attribute Information (Table Viewer) window opens showing the table in which the device appears. The Control Tool opens for the device. The Viewer centers on the device (if it is not already centered on it).

Viewing the What Tool Dialog Box

To open the What Tool dialog box, click the What button in the Object Debug (What) window. The What Tool dialog displays device information in three sections.
• The **Detailed Device Information** area displays device information, particularly graphical information (other than coordinates). The information displayed includes:
  • Device handle
  • Map containing the device
  • Display group
  • Symbology class and symbol ID
  • Energization status
  • Nominal state
  • Network Component Group (NCG)
  • Voltage
  • Rank (bitfield value)
  • Override color
  • Visibility settings
• The **Port A (from):Port B (to)** area displays all of the device’s topological information, such as current and nominal status, phases, and energization. The feeder for each phase is listed, meaning that the FID or FBD handle will be listed. Each of its ports are displayed with its connected branches. Special states of the following will be listed as Boolean values:
  • Isolated
  • Secured
  • Delegated
• The **Coordinate/Attribute Information** area lists of the coordinates of the object and object type in the model.

A detailed explanation of modeling information is beyond the scope of this document.

**Using the Topology View Window**

The Topology View window is used to walk through the electrical topology model, providing an overview of what the Viewer displays in the maps. This section includes the following topics:

• **Opening the Topology View**
• **Walking Through the Topology Model**

**Opening the Topology View**

To open the Topology View (TopView), click the **Topology View** button on the Model Validation Environment Manager. The Topology View window displays the following buttons:

• The **Reset** button sets all device statuses to nominal values.
• The **Focus** button focuses the Viewer window on the selected object and opens the Table Viewer window and the Control Tool, displaying information on the selected device.
• The **What** button opens the What window for studying model information about a selected device (see **Using the Object Debug (What) Window** on page 1-63).
• The **Details** button provides additional information about the branches and nodes. This information is not available through the Topology View window, but is printed to standard output.
• The **Quit** button closes the Topology View window.
Walking Through the Topology Model

To walk through the topology model, complete these steps:

1. Select a device in the Viewer window:
   • The Object field of the Topology View window populates with that device. One of the device's nodes is chosen arbitrarily and displayed in the Node field.
   • All branches connected to that node display in the main window with their second nodes listed.
2. To view another node, reselect the object in the Viewer window. The Node field toggles to another node.
3. Select one of the rows in the window. That object and node display in the Object and Node fields, with all branches connected to that node displaying in the main window.
   • Selecting a device in TopView also selects it in the Viewer. This is helpful when walking through the topology.
4. Repeat these steps to walk through the topology model.

Viewing Model Changes

The Model Changes window lets you manage model changes. It lists any model build patches that remain unresolved. These are patches that have been applied to the database but have not yet been committed into the model. The Model Changes window lets you select a patch and then perform one of two actions:

• Attempt to commit the patch
• Reject the patch

Using the Model Changes window

To open the Model Changes window, click on the Model Changes button on the Model Validation Environment Manager.

The Model Changes window displays the following fields and buttons:

• The Patch column contains the number assigned to the patch.
• The Description column contains the type of patch (e.g., model edit, incremental build, work order).
• The Reason column contains the reason the patch displays in the Model Changes window. Options include: System error, In progress, Real time data dependency, Dependent on uncommitted patch, Applied but not committed, Undo model edit, Permanent model edit.
• The Day column contains the date the patch was created.
• The Time column contains the time the patch was created.
• The Work Order column contains the name of the work order, if the patch is a work order.
• The Dependency column contains the model patch upon which the build is dependent. If there is more than one patch, the oldest one is listed.

Buttons

• The Re-Submit button resubmits the selected patch.
• The Reject button rejects the selected patch.
• The Reset button clears the list of partitions and refreshes the list of patches.
The View button focuses on the associated object if the patch is a model edit. If the patch is a work order, two Viewer windows open displaying a “before and after” of the work to be performed.

- The Show Log… button displays the error log for the selected patch.
- The Quit button closes the Model Changes window.

Menus

The File, Sort, and Filter menus on the Model Changes window are similar to other menus in Oracle Utilities Network Management System. For more information on these menus, see Getting Started With Operator’s Workspace on page 1-1.

Sort Menu

- **Patch** - Sorts the content of Model Changes window using Patch name.
- **Day** - Sorts the content of Model Changes window using date and time stamp of patch creation.
- **Work_Order** - Sorts the content of Model Changes window using work order name.

Filter menu

- **Model Edits** - Display only model edit patches in the Model Changes Window
- **Work Orders** - Displays only work order patches in the Model Changes Window.

Displaying Partition and Work Order Information

When you select a patch from the list at the top of the window, the table underneath the list displays a list of all partitions associated with that patch. If the patch is a work order, the name of the work order appears in the Work Order field.

Using the Model Build Report

For an overview of the model build progress and the status of patches built for model builds that have recently occurred, you can generate an HTML report with the Model Build Report window. Open the report by clicking the MB Report button on the Model Validation Environment Manager.

*Note:* You can adjust the timeframe of the generated report.

Colors indicate whether a patch build went through or failed. The report lists the maps in the queue to be built, the patch number, filename, date the patch was created, and point of failure.

Viewing Attribute Information

The Attributes window allows you to access information on selected devices:

To access device attribute information, complete these steps:

1. Open the Attributes window by clicking the Attribute Info button on the Model Validation Environment Manager.

2. If you know the name of the device you want to find attributes for, type it in the Selection field. If you don’t know the name of the device:
   - Open a Viewer window and load the map containing the device.
   - Locate and select the device in the Viewer by clicking on it. The device name appears in the Selection field of the Attribute Information window.

3. Click on the Execute Query button. The attribute data appears in the results area of the window.
4. To print the displayed information, click the Print button.
5. Click the Quit button to close the Table Viewer window.

Model Validation Viewer

The Viewers section of the Model Validation Environment Manager controls the display of the Viewer window. For further information on the Viewer, see Using the Operator's Workspace Viewer on page 1-15.

Using the Administration Environment

The Administration Environment lets you study or edit information in the operations model, including database tables, default ERT values, and viewing areas.

This section contains the following topics:
- Logging In
- Using the Administration Environment Manager
- Using the Default ERT Editor Window
- Using the Draw Link Window
- Using the View Areas Window
- Using the Administration Viewer

Logging In

When an authorized user logs into the system under the Administration user type, Oracle Utilities Network Management System opens with an Environment Manager that contains administrative tools. To open the Administration Environment Manager, complete these steps:

1. Click on the Login button on the Oracle Utilities Network Management System Login screen. The Login dialog box opens.
2. Enter your user name and password.
3. Open the drop-down menu and select Administration.
4. Click OK.

Using the Administration Environment Manager

The Administration Environment Manager offers access to windows for viewing and editing database tables, default ERT values, and more.

The Administration Environment Manager displays the following buttons:
- The SqlA button opens the SqlA window for viewing and modifying table contents in the Relational Database Management System (RDBMS). This window is used for studying and editing table data that controls system functions, including users, authorizations, and application configuration.
- The Trouble Call Entry button opens the Trouble Call Entry window. See Entering Trouble Calls on page 2-50 for more information about the Trouble Call Entry window.
- The Symbology Editor button opens the Symbology Viewer window that allows you to view and edit the Viewer symbols that represent aspects (devices, crew assignments, etc.) of the operations model. See Identifying Symbology on page 1-27 for more information about the Symbology Viewer window.
• The **Default ERT Editor** button opens the Default ERT Editor window that is used to manage the inputs for Oracle Utilities Network Management System Trouble Management default estimated restore time values.

• The **Authority** button opens the Authority window. See **Taking Authority** on page 1-12 for more information about the Authority window.

• The **View Documents** button opens the Draw Link window that allows you to associate devices in the electrical topology model with various documents, as well as to view those associated documents.

• The **View Areas** button opens the View Areas window that allows you to create and manage view areas that can be displayed in the Viewer window.

• The **Viewers** section of the Environment Manager controls the display of the Viewer. See **Using the Operator’s Workspace Viewer** on page 1-15 for more information about this section.

The last three buttons on the Environment Manager (Help, Relogin, Logout) perform exactly the same functions as the buttons on the Oracle Utilities Network Management System – Operator’s Workspace Environment Manager. For more information on these buttons, see **Administrative Tools** on page 1-11.

### Using the Default ERT Editor Window

The Default ERT Editor Window is used to manage the inputs for Oracle Utilities Network Management System Trouble Management default estimated restore time values. It allows you to modify the ERT values for each device class by control zone, as well as set a system-wide default ERT.

To open the Default ERT Editor window, click the **Default ERT Editor** button on the Administration Environment Manager. The Default ERT Editor window displays the following fields and buttons:

• The first column of the Default ERT Editor window lists the names of the device classes for which default ERT values have been configured. The values in this column are not editable.

• The remainder of the columns in the Default ERT Editor window correspond to each control zone for which default ERT values have been configured, and the cells contain the current default ERT value (in minutes) for a device with the corresponding device class in that zone.

• The **Active Default ERT** fields contain the currently active system-wide default ERT value that has been specified, if any. These fields are not editable.

• The **Modified Default ERT** fields are used to set and/or modify the Active Default ERT value.

**Buttons**

• The **Clear Modified ERT** button is used to clear any contents in the Modified Default ERT fields.

• The **Apply** button applies any changes made to the Default ERT Editor window.

• The **Exit** button exits the Default ERT Editor window.

### Modifying Default ERT Values for a Device/Zone

To modify existing default ERT values for a device class/zone, complete these steps:

1. Click the **Default ERT Editor** button on the Administration Environment Manager to bring up the Default ERT Editor window.
2. Click into the cell that corresponds to the device class and control zone whose default ERT value you wish to change.

3. Type the number of minutes you wish to use for the new default ERT value into the cell.

4. Repeat the two previous steps for any other default ERT values you wish to modify.

5. Press the Apply button. A confirmation dialog appears.

6. Press the OK button on the dialog to confirm your changes. Any new events will enter the system using the modified default ERT values, if applicable. Any existing events with an Est Src value = I in the Work Agenda will have their ERT values recalculated using the modified default ERT values, if applicable.

   Note: Invoking the Apply button causes a full re-examination of all events currently in the system, thus it is advised to use it sparingly when there are a large amount of events present.

Setting a System-Wide Default ERT
To set a system-wide default ERT value for the system, complete these steps:

1. Click the Default ERT Editor button on the Administration Environment Manager to bring up the Default ERT Editor window.

2. Type a date and time into the Modified Default ERT fields.

3. Press the Apply button. The following confirmation dialog appears.

4. Press the OK button on the dialog to confirm your changes. Any new events will enter the system using the system-wide default ERT value, if applicable. Any existing events with an Est Src value = I in the Work Agenda will have their ERT values reset to the system-wide default ERT value, if applicable.

   Note: Invoking the Apply button causes a full re-examination of all events currently in the system, thus it is advised to use it sparingly when there are a large amount of events present.

Removing a System-Wide Default ERT
To remove a system-wide default ERT value, complete these steps:

1. Click the Default ERT Editor button on the Administration Environment Manager to bring up the Default ERT Editor window.

2. Click the Clear Modified ERT button. The values in the Modified Default ERT fields are cleared.

3. Press the Apply button. A confirmation dialog appears.

4. Press the OK button on the dialog to confirm your changes. Any new events will enter the system using their regular default ERT values, if applicable. Any existing events with an Est Src value = I in the Work Agenda will have their ERT values recalculated using their regular default ERT values, if applicable.

   Note: Invoking the Apply button causes a full re-examination of all events currently in the system, thus it is advised to use it sparingly when there are a large amount of events present.

Using the Draw Link Window
The Draw Link window is used to associate devices in the electrical topology model with various documents, as well as to view those associated documents.

To open the Draw Link window, click the View Documents button on the Administration Environment Manager. The Draw Link window displays the following fields and buttons:
The **Selected Device** field lists which device is presently selected in the Viewer, as well as which documents are presently associated with the device, if any.

The **Unassign** button allows you to remove the association of the selected document with the selected device.

The **View** button allows you to view the selected document for the selected device.

The **Available Documents** field lists all of the contents of the $CES_DRAWINGS directory. The **Filter** button and the text field beside it may be used to filter the Available Documents list.

The **Associated Devices** field lists which devices have an association with the currently selected item in the Available Documents list.

**Buttons**

The **Assign** button allows you to associate the currently selected item in the Available Documents list with the Selected Device.

The **Preview** button allows you to view the currently selected item in the Available Documents list.

The **Quit** button closes the Draw Link window.

**Associating a Document With a Device**

To associate a document with a device, complete these steps:

1. Login to Operator’s Workspace as an Administration user. The Administration Environment Manager appears.

2. Select the **View Documents** option on the Environment Manager. The Draw Link Window appears.

3. Open a Viewer window. Locate the device you wish to create an association for, and select that device in the Viewer. The Draw Link window’s **Selected Device** field populates with the name of the selected device.

4. Select the item from the **Available Documents** list that you wish to associate with the selected device. The **Assign** and **Preview** buttons are now sensitized.

5. Click the **Preview** button to see the selected document. The selected document appears in a new window.

6. Click the **Assign** button to create the association between the selected document and selected device.
   - The field below the selected device populates with the name of the selected document, and the Associated Devices field populates with the name of the selected device.
   - In the Viewer window, a document condition now appears on the selected device.
   - Click the **Quit** button to exit the Draw Link window.

**Filtering the Available Documents List**

To filter the Available Documents list, complete these steps:

1. Select the **View Documents** option on the Environment Manager. The Draw Link Window appears.

2. Enter your filter criteria into the field next to the **Filter** button.

3. Click the **Filter** button. The Available Documents list is now filtered by the entered criteria.
Removing a Document Association

To remove an association between a document and a device, complete these steps:

1. Login to Operator’s Workspace as an Administration user. The Administration Environment Manager appears.

2. Select the **View Documents** option on the Environment Manager. The Draw Link Window appears.

3. Open a Viewer window. Locate the device you wish to remove an association for, and select that device in the Viewer. The Draw Link window’s **Selected Device** field populates with the name of the selected device, and the field below populates with all of the documents associated with that device.

4. In the field below the Selected Device, select the document you wish to disassociate from the device. The **Unassign** and **View** buttons are now sensitized.

5. Click the **View** button to see the selected document. The selected document appears in a new window.

6. Click the **Unassign** button to remove the association between the selected document and selected device.
   - The selected document is removed from the field below the Selected Device.
   - In the Viewer window, a document condition is removed from the selected device.

7. Click the **Quit** button to exit the Draw Link window.

Viewing Associated Documents

In addition to viewing associated documents from the Draw Link window while you are logged in to the Administration environment, documents may also be viewed by operators via the Control Tool.

To view associated documents via the Control Tool, complete these steps:

1. Open a Viewer window. Locate a device that has an associated document you wish to view. These devices will appear with a document condition on them in the Viewer window.

2. Double-click on the device to bring up the Control Tool. Select the **View Documents…** option from the Control Tool.
   - If only one document is associated with the device, the document will appear in a separate window.
   - If there is more than one document associated with the device, the non-administrative version of the Draw Link window will appear, listing each associated document for the selected device.
   - Select the document you wish to view, and then click on the **View** button. The document will appear in another window.
   - Click the **Quit** button to exit the Draw Link window.

Using the View Areas Window

The View Areas window lets you create and manage view areas that can be displayed in the Viewer window. For further information on the Viewer, see **Using the Operator’s Workspace Viewer** on page 1-15.

The View Areas window displays the following fields and buttons:

- The **Area Name** field contains the name of the view area that you are working with.
- The **Display View(s)** button is used to display the view area identified by the Area Name field in the Viewer window.
• The **Delete View(s)** button is used to permanently remove the view area identified by the Area Name field.

• The **Working Viewers** area is used to identify which Viewer window you are working with (VIEW 1, VIEW 2, VIEW 3, and VIEW 4).

• The **Capture** button is used to capture a new view area from the Viewer window specified in the Working Viewers area.

• The **View Area List...** button brings up the View Area Select dialog, which presents a list of currently defined view areas.

### Creating a New View Area

To create a new view area, complete these steps:

1. Open a Viewer window and locate the area that you wish to define a new view area for.
2. Click the **View Areas** button on the Administration Environment Manager to bring up the View Areas window.
3. Enter a name for the new view area into the Area Name field. The **Display View(s)** and **Delete View(s)** buttons are now enabled.
4. Click the **VIEW 1** button in the Working Viewers area. The **Capture** button is now enabled.
5. Click the **Capture** button. The message in the Viewer window indicates that the view area save was successful.

The newly defined view area will now be visible when you perform a Viewing Area search in the Search tool.

### Deleting a View Area

To delete an existing view area, complete these steps:

1. Click the **View Areas** button on the Administration Environment Manager to bring up the View Areas window.
2. Click on the **View Area List...** button. The View Area Select dialog appears.
3. Select the view area you wish to delete, and then click the **OK** button. The View Area Select dialog disappears, and the Area Name field is populated with the name of selected view area.
4. Click the **Delete View(s)** button. The view area has been permanently removed from the database. The deleted view area will no longer be visible in the View Area Select dialog.

### Using the Administration Viewer

The Viewers section of the Administration Environment Manager controls the display of the Viewer window. For further information on the Viewer, see *Using the Operator’s Workspace Viewer* on page 1-15.
This chapter covers the following topics:

- Managing Events with Trouble Management
- Managing Crews with Trouble Management
- Managing Calls with Trouble Management
- Viewing Trouble Summaries

Managing Events with Trouble Management

Oracle Utilities Network Management System – Trouble Management includes windows that help you manage trouble events. This chapter describes those windows and how to perform basic event functions. This section includes the following topics:

- Trouble Event Windows
- Work Agenda
- Event Details
- Service/Secondary Outage Manager
- Event Recorder
- Damage Assessment
- Requests
- Outage Correction

Trouble Event Windows

The following table highlights the basic functionality of each of the trouble event related windows.

<table>
<thead>
<tr>
<th>Window</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Agenda</td>
<td>Displays lists of trouble events</td>
</tr>
<tr>
<td></td>
<td>Allows you to acknowledge events</td>
</tr>
<tr>
<td></td>
<td>Allows you to group events</td>
</tr>
<tr>
<td></td>
<td>Allows you to associate devices with events</td>
</tr>
<tr>
<td>Event Details</td>
<td>Allows you to record trouble and restoration details for events</td>
</tr>
<tr>
<td></td>
<td>Allows you to record failed equipment information</td>
</tr>
</tbody>
</table>
Managing Events with Trouble Management

<table>
<thead>
<tr>
<th>Window</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service/Secondary Outage Manager</td>
<td>Allows you to confirm additional service or secondary outages</td>
</tr>
<tr>
<td>Event Recorder</td>
<td>Records detailed event action steps</td>
</tr>
<tr>
<td></td>
<td>Allows you to add comments</td>
</tr>
<tr>
<td></td>
<td>Allows you to record events discovered in the field that have not been reported by customers</td>
</tr>
<tr>
<td>Damage Assessment</td>
<td>Allows you to record damage assessment information for events</td>
</tr>
</tbody>
</table>

**Work Agenda**

The Work Agenda is the “switchboard” for managing operations across Oracle Utilities Network System modules. It displays dynamically updated system information. Different views list information about trouble events, switching plans, safety documents, device operations, and System alarms.

When you login to Oracle Utilities Network System Operator's Workspace, the Work Agenda opens by default to the To Do List. If you have closed Work Agenda, you can open it again by clicking on the All, To Do, In Progress, Incomplete, or Complete button on the Environment Manager.

Work Agenda topics include:

- Work Agenda Views
- Work Agenda Trouble Events Lists
- Acknowledging Events
- Setting the Work Queue
- Grouping Events
- Relating Events
- Unrelating Events
- Associating and Unassociating Calls with Devices
- Alerts

**Work Agenda Views**

The view options available depend upon which Oracle Utilities Network System modules are included in the system, how they are configured, and what external systems they interface with (if any). Each view has its own set of columns, buttons, and Actions menu options. This section focuses on the five Work Agenda Trouble Events List views. To access a different view, click on the File menu and select the list you want to see.
The following table describes the various Work Agenda views.

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Do List</td>
<td>Displays trouble events that require attention, as well as any trouble event alarms (events with Status NEW, F-NEW, S-NEW, P-NEW, M-NEW, UAS, F-UAS, S-UAS, P-UAS, M-UAS, W-UAS, SNT, T-SNT, M-SNT, W-SNT, RED, CRT, RSCH, NFY, VFY, and C-CNL). You can also access this view from the Environment Manager by clicking on the To Do button.</td>
</tr>
<tr>
<td>In Progress List</td>
<td>Displays most trouble events that have crew resources associated with them (e.g., a crew is onsite and is working to resolve the problem), as well as any trouble event alarms (events with Status ASN, F-ASN, ENR, F-ENR, S-ENR, W-ENR, S-ASN, W-ASN, ONS, F-ONS, S-ONS, W-ONS, SUS, S-SUS, W-SUS, RST, S-RST, RSCH, NFY, and VFY). You can also access this view from the Environment Manager by clicking on the In Progress button.</td>
</tr>
<tr>
<td>All List</td>
<td>Displays all trouble events of any status. You can also access this view from the Environment Manager by clicking on the All button.</td>
</tr>
<tr>
<td>Incomplete List</td>
<td>Displays all incomplete trouble events and events that have maintenance work pending (events with Status INC, S-INC, P-INC, M-INC, MNP, and S-MNP). Incomplete events are events that are complete in the field but the information for them has not been completely entered on the Event Details window. You can also access this view from the Environment Manager by clicking on the Incomplete button.</td>
</tr>
<tr>
<td>Completed List</td>
<td>Displays all completed and cancelled trouble events (events with Status CMP, F-CMP, S-CMP, P-CMP, M-CMP, W-CMP, CNL, F-CNL, and W-CNL). You can also access this view from the Environment Manager by clicking on the Completed button.</td>
</tr>
<tr>
<td>Device Operations List</td>
<td>Displays information about device operations performed using the Control Tool. See Using the Operator's Workspace Control Tool on page 1-36 for more information.</td>
</tr>
<tr>
<td>Systems Alarm List</td>
<td>Displays all current system alarms. You can also access this view from the Environment Manager by clicking on the System Alarms button.</td>
</tr>
<tr>
<td>SCADA Alarms List</td>
<td>Displays alarms reported by SCADA devices. See Using the SCADA Alarms List on page 13-7 for more information.</td>
</tr>
<tr>
<td>Switching Plan List</td>
<td>Displays all saved switching plans, which includes both planned and emergency switching operations. You can also access this view from the Environment Manager by clicking on the Switching Plan List button. See Switching Plan List on page 14-35 for more information.</td>
</tr>
<tr>
<td>Switching Templates List</td>
<td>Displays all saved switching templates. You can use templates for creating new switching plans from frequently used switching step sequences. See Switching Templates List on page 14-36 for more information.</td>
</tr>
<tr>
<td>Misc List</td>
<td>Displays the Miscellaneous Log. See Misc List on page 14-37 for more information.</td>
</tr>
</tbody>
</table>
In the Work Agenda, there are five lists that display trouble events. These views include:

- To Do List
- In Progress List
- All List
- Incomplete List
- Completed List

All of these lists contain similar columns and buttons, although not all columns and buttons appear on each of these views. These lists of outage and non-outage events are commonly referred to as the Trouble Events Lists.

The Trouble Events Lists prioritize events based on various conditions. Specifically, the lists are sorted in the following manner:

- Events are first sorted by emergency or hazardous conditions (E, then H, then blanks)
- Events are then sorted by the number of critical customers affected (# EMR, then # MED, then # KEY)
- Events are then sorted by their event priority value (a value established by the different types of clues an event has)
- Events are then sorted by the Customer minutes of interruption (Run CMI) value
- Events are then sorted by their Status value (To Do states, then In Progress states, then Incomplete states, then Complete states)

Event rows can be color-coded by status. To turn color codes on, toggle (click on) the Color Disabled button above the table. For more information about the color coding used to indicate event status on the Work Agenda, see Event Status on page B-2.

Trouble Events List Fields
The Trouble Events Lists displays the following fields:

- The Audio Enabled/Disabled radio button allows you to turn the audible alarm on and off.
- The Color Enabled/Disabled radio button allows you to turn the row color-coding on and off.
- The list title displays the list you are viewing (e.g., To Do List, All List, etc.).
• The Sort/Filter identifiers display which sort and/or filter is applied to the list.
• The Status column displays the status assigned to the event. See Event Status Codes on page A-1 for a complete list of status codes and descriptions.
• The Event # column displays the number the system has assigned to the event.
• The Feeder column displays the name of the feeder associated with the event.
• The E/H column indicates whether or not the event is an emergency or hazardous condition. An “E” in this column denotes extreme emergency, and an “H” in this column denotes hazardous.
• The Start Date column contains the date and time the event began.
• The # Out column contains the number of customers experiencing an outage for the event.
• The # Calls column contains the number of calls received for the event.
• The Clues column contains the clue codes for the calls received, if any.
• The Phases Out column contains the phases predicted out for the event.
• The Device column contains the name of the device associated with the event.
• The Location column contains either the address of the first customer that called if the event is a service outage or non-outage or the feeder location of the device if the event is a device outage.
• The Crew column contains the crew id(s) of the associated crew(s).
• The Est Restore Time column contains the estimated restoration time (ERT) for the event.
• The Est Src column contains the source of the ERT for the event. The possible values for the ERT Source, from highest precedence to lowest, are as follows:
  - C: User-entered via applications or tools (for example, mobile interface, Work Agenda, Event Details, or Crew tools) other than Storm Management.
  - G: Storm Management published global ERT from the ERT Override dialog.
  - D: Storm Management published global ERT delay from the ERT Override dialog.
  - P: Storm Management non-published global ERT from the ERT Override dialog.
  - M: Maximum ERT exceeded. The Storm Management calculated ERT is beyond a set threshold for maximum ERT; no ERT is shown.
  - O: Storm Management onsite ERT calculated when the event status goes to en route and updated when the status changes to onsite.
  - S: Storm Management calculated ERT based on outages and crews in Storm Management
  - I: Initial default ERT, based on the system-wide default ERT (if set) or else configured default ERT based on device class and control zone
  - N: none (no ERT)
• The Pred Type column contains the type of prediction (e.g., New, Revised, Device Operation, etc).
• The # Crit column contains the total number of critical customers experiencing an outage for the event.
• The Run CMI column contains the running total number of customer minutes of interruption for the event. This value is no longer calculated once the event has been restored.
• The # EMR column contains the number of emergency customers experiencing an outage for the event.
• The # MED column contains the number of medically urgent customers experiencing an outage for the event.
• The # KEY column contains the number of key customers experiencing an outage for the event.
• The Evt Type column contains a description of the type of event. See Event Type Codes on page A-3 for a complete list of event type codes and their descriptions.
• The Work Queue column contains the name of the work group queue that the event has been referred to.
• The Region column contains the control zone region where the event occurred.
• The Branch column contains the control zone branch where the event occurred.
• The Substation column contains the control zone substation where the event occurred.
• The Plan # column contains the switching plan number associated with the event, if any.
• The Restore Date column contains the actual restoration date and time of the event.
• The Grp Type column indicates whether the event is manually grouped or related. The possible types are:
  GRP – manually grouped
  REL – manually related
  TBG – to be grouped (seen while selecting events to group)
  TBR – to be related (seen while selecting events to relate)
  TBU – to be unrelated (seen while selecting events to unrelated)
• The Rel Event # column contains the event number of the parent or lead event when the event has a special relationship with one or more other events.
• The Rel Type column contains the type of special relationship that the event is involved in. The possible types are:
  L – lead event of a partial restoration
  M – momentary
  N – nested
  P – non-lead event of a partial restoration
  R – manually related
  S – switching (relationship between switching jobs and planned outages)
• The Sent to Mobile column indicates whether or not the event is in a state that makes it eligible to be sent to the mobile system.
• The Requested column indicates whether or not readings have been requested for this event. See Requests on page 2-26 for more information.
• If balloon details are enabled, the balloon dialog displays any case notes associated with an event when you click on the event in the table.

**Trouble Event List Buttons**

The Trouble Events Lists displays the following buttons:
• The Ack button acknowledges the selected event.
• The View button focuses the Viewer on the device associated with the selected event.
• The **Info…** button opens the Trouble Information window with information about the selected event.

• The **Event Details…** button opens the Event Details window with information about the selected event.

• The **Switching…** button opens the Switch Sheet Editor window and loads the switching plan associated with the selected event. If no plan is presently associated with the selected event, the Sheet Type popup dialog also opens, allowing you to create a new switching plan related to the selected event.

• The **Referral…** button opens the Work Queue dialog, allowing you to select a work group to refer the event to and enter any necessary remarks.

• The **More** button expands the Work Agenda window vertically to display more events. When the window is expanded, this button will return the window to its original size.

• The **Rel Crew** button releases the crew from the selected event. If more than one crew is associated with the event, a dialog box opens prompting you to select which crew to release.

• The **Send to Mobile** button changes the event status to a Sent status that is appropriate for the selected event (e.g., SNT, S-SNT, P-SNT, M-SNT, W-SNT). Also, if the Sent to Mobile column value happens to be “N” at the time the **Send to Mobile** button is pressed, it will update to a value of “Y”.

• The **Incomplete** button changes the event status to an Incomplete status that is appropriate for the selected event (e.g., INC, S-INC, P-INC, M-INC).

• The **Cancel Event** button cancels the selected event. A dialog box opens prompting you for a reason for the cancellation.

• The **Exit** button closes the Work Agenda window.

### Trouble Event List Menus

The following table describes the Trouble Event Lists menus.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>[View Names] – Allow you to toggle between views. Print – Opens the print dialog box to allow you to print the current list. Exit – Closes the Work Agenda window.</td>
</tr>
<tr>
<td>Sort</td>
<td>Allows you to sort the displayed list. For more information, see <strong>Sorting</strong> on page 1-3.</td>
</tr>
<tr>
<td>Filter</td>
<td>Allows you to filter the displayed list. The “Switching” option filters the currently selected view such that it displays only planned outages and switching jobs, if present. For more information, see <strong>Filtering</strong> on page 1-5.</td>
</tr>
<tr>
<td>Actions</td>
<td>Provides the same functionality as the Work Agenda buttons, plus additional options depending on the view.</td>
</tr>
</tbody>
</table>

**Actions Menu** - The table below describes the options available on the Trouble Event Lists Actions menu.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack</td>
<td>Acknowledges the selected event.</td>
</tr>
<tr>
<td>Menu Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View</td>
<td>Focuses the Viewer on the device associated with the selected event.</td>
</tr>
<tr>
<td>Info...</td>
<td>Opens the Trouble Information window with information about the selected event.</td>
</tr>
<tr>
<td>Event Details...</td>
<td>Opens the Event Details window with information about the selected event.</td>
</tr>
<tr>
<td>Switching…</td>
<td>Opens the Switch Sheet Editor window and loads the switching plan associated with the selected event. If no plan is presently associated with the selected event, the Sheet Type popup dialog also opens, allowing you to create a new switching plan related to the selected event.</td>
</tr>
<tr>
<td>Event Recorder...</td>
<td>Opens the Event Recorder that displays detailed information about the progress of the selected event. See Event Recorder on page 2-22 for more information.</td>
</tr>
<tr>
<td>Referral…</td>
<td>Opens the Work Queue dialog, allowing you to select a work group to refer the event to and enter any necessary remarks.</td>
</tr>
<tr>
<td>More</td>
<td>Expands the Work Agenda window vertically to display more events. When the window is expanded, this button will return the window to its original size.</td>
</tr>
<tr>
<td>Rel Crew</td>
<td>Releases the crew from the selected event. If more than one crew is associated with the event, a dialog box opens prompting you to select which crew to release.</td>
</tr>
<tr>
<td>Incomplete</td>
<td>Changes the status of the event to an Incomplete status that is appropriate for the selected event (e.g., INC, S-INC, P-INC, M-INC).</td>
</tr>
<tr>
<td>Cancel Event</td>
<td>Cancels the selected event. A dialog box opens prompting you for a reason for the cancellation.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Group dialog box, which allows you to manually group, relate and unrelate events.</td>
</tr>
<tr>
<td>Associate</td>
<td>Allows you to associate fuzzy events to a device.</td>
</tr>
<tr>
<td>Damage Assessment</td>
<td>Opens the Damage Assessment window with information about the selected event.</td>
</tr>
<tr>
<td>Auto Filter</td>
<td>Allows you to quickly filter the view by the selected cell value.</td>
</tr>
<tr>
<td>Auto Filter Off</td>
<td>Turns off any auto filter that has been applied.</td>
</tr>
<tr>
<td>Load Completed Events</td>
<td>By default, completed events are not loaded into the Work Agenda on startup for performance reasons. Use this button to load in completed events.</td>
</tr>
<tr>
<td>Send to Mobile</td>
<td>Changes the event status to a Sent status that is appropriate for the selected event (e.g., SNT, S-SNT, P-SNT, M-SNT, W-SNT). Also, if the Sent to Mobile column value happens to be “N” at the time the Send to Mobile button is pressed, it will update to a value of “Y”.</td>
</tr>
<tr>
<td>Confirm</td>
<td>Allows you to ping meter(s) for the selected event. If the event is a service outage, automatically initiates a ping for that meter. If event is a device outage, navigates to the Trouble Info Customers page, where you can select individual meters to ping.</td>
</tr>
</tbody>
</table>
Managing Events with Trouble Management

Acknowledging Events
To acknowledge an event, complete these steps:
1. Select the row of the event with NEW, S-NEW, P-NEW, M-NEW, or RED status in the Trouble Events List.
2. Click on the Ack button. The event becomes acknowledged and its status changes accordingly.

Setting the Work Queue
To set a Work Queue value for an event, complete these steps:
1. Select the desired event’s row in the Work Agenda.
2. Click on the Referral… button. The Work Queue dialog appears.
3. Select a value from the Refer To list.
4. Enter any desired remarks into the Remarks field.
5. Click the OK button. The Work Queue dialog disappears, and the Work Queue column of the selected row updates with the selected Refer To value.

Grouping Events
While the system automatically groups events according to the trouble analysis rules, you may come across some events that are related, but are not grouped because of data modeling issues (e.g., connectivity problems). You can manually group these events together using Event Grouping or Supply Point Grouping.

Group Dialog Box
The Group dialog box allows you to group events. To open the Group dialog box, select Group from the Actions menu in the Work Agenda window.

The Group Dialog displays the following fields:
- The Selected Events area displays all of the events that have been selected for grouping.
- The Group Method contains a selection of grouping options. The Merge option is used for event grouping. The Relate option does not group the selected events, but rather allows you to record a relationship between the events and enter notes in the Relationship Comments field. The Unrelate option allows you to remove one or more previously related events from the relationship.
- The Relationship Comments field allows you to enter comments about the relationship when the Group Method is set to “relate.”
- The Device field displays the device associated with the first selected event. This is the device that the manually grouped event(s) will be associated with.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Request</td>
<td>Navigates to the Requests page and displays ping(s) for the selected event.</td>
</tr>
<tr>
<td>Show FLISR Report</td>
<td>Displays the Fault Location, Isolation, and Service Restoration tool for the selected event. This option is not available if Web Switching Management is licensed for your system.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Work Agenda window.</td>
</tr>
</tbody>
</table>
Grouping Events

To group events, complete these steps:

1. Open the Group dialog box by selecting Group from the Work Agenda Actions menu.
2. Make sure the Group Method is “merge”.
3. In the Trouble Events list, select the row for the event that all subsequent events will be grouped to. The event number appears in the Selected Events field, and the device name appears in the Device field in the Group dialog box. This first event is called the lead event.
4. Select the row of an event in the Trouble Events list that you want to group to the first selected event. The event number for the event is added to the Selected Events field, but the device identification does not change.
5. If there are other events you want to add, select the row for those events in the Trouble Events list. The event numbers for the events are added to the Selected Events field.
6. To deselect a selected event, select its row again. The event number is removed from the Selected Events field.
7. Click on the OK button. The following occurs:
   - The selected events are grouped to the lead event.
   - The rows for the subordinate events disappear from the Trouble Events List.
   - The Event #, Device, and most other fields of the resulting event are taken from the lead event.
   - When grouping events to a SCADA outage, the begin time of the SCADA outage (a real outage caused by a SCADA device being opened from a SCADA interface) becomes the begin time of the resulting event.
   - When grouping various types of events to a non-SCADA outage, the begin time of the earliest outage becomes the begin time of the resulting event. (i.e., non-outage begin times will be ignored).
   - In all other cases, the earliest event begin time becomes the begin time of the resulting event.
   - Information from the first (earliest) call for an event (First Call Time, Location on a fuzzy event, non-outage or service outage) is taken from the first call out of all the calls in the resulting event.
   - Operator comment, Crew, # Out (for service outages and fuzzy events), # Calls, Clues, and all fields combined from the calls on the events is combined between all of the events involved in the grouping.
   - If the events that you selected do not meet the manual grouping rules, the system does not let you group them. An error message appears explaining the problem.

Event Grouping That is Allowed

- General fuzzy events (Fuzzy event which are not associated to a control zone) can group to any outage event.
- General fuzzy events with 0 customers out can group to any non-outage event or fuzzy event.
- General fuzzy events with more than 0 customers out can group with other fuzzy events with more than 0 customers out.
- Non-outage events can group to outage or non-outage events.
- Outage events can group to other outage events.
- Fuzzy events associated with a control zone can group to another event that is in the same control zone.
Event Grouping That is Not Allowed

- Outage events cannot group to non-outage events.
- Restored and completed events are not allowed to group with any other event.
- Meets (e.g., meet fire, etc.) cannot group with anything.
- Real outages and planned outages can not be grouped to another event.
- Switching events cannot group with anything (this restriction does not affect planned outages).
- A momentary outage cannot group with a event that is not a momentary outage.
- An outage is not allowed to group to another outage if it is not on the same device as or downstream from the lead outage.
- An event which is not a general fuzzy cannot group to a general fuzzy event.
- Fuzzy events associated with a control zone can not group to another event that is in a different control zone.
- A fuzzy event with more than 0 customers out can not be grouped into a non-outage event or a fuzzy event with 0 customers out.
- An event which is not a street intersection event (an event associated with a street intersection object rather than an electrical device) cannot group to a street intersection event.

Graphical Grouping

To add customers to an event graphically, follow these steps:

1. Select a probable outage in the Work Agenda
2. Press the Info… button to display the Trouble Info callers for this outage.
3. From the Trouble Info Callers page, you can navigate to the Supply Points page to view all existing Supply Points.
4. In the Viewer, press the Supply Point Selection button to toggle into Supply Point Selection mode. See Viewer Toolbar on page 1-17 for more details.
5. Using a box or polygon, select a group of supply points and press the Add Supply Points button on the Supply Point Selection Dialog. See Selecting Multiple Devices within a Polygonal Area on page 1-26 or Selecting Multiple Devices within a Rectangular Area on page 1-26 for more details.

New Supply Points rows are added to the table in green and marked as To Be Grouped (TBG)
6. Press the Update Event button to group the Supply Points into the event.
7. Enter an event grouping threshold (in hours) in the Update Job confirmation dialog.
   - The selected event now includes the selected supply points and the Work Agenda row now reflects the new customer count and call count, if other calls existed on the selected Supply Points.
   - Supply Points with calls that did not pass the selected grouping threshold are not added to the outage and are marked in yellow with FAIL in the Grp column.
   - You can also remove Supply Points from the event by selecting them and pressing the Remove button, then the Update Event button. Any calls on the removed Supply Points create new events.

Relating Events

To relate events, complete these steps:
1. Open the Group dialog box by selecting \textbf{Group} from the Work Agenda Actions menu.
2. Change the \textbf{Group Method} to “relate”. The Relationship Comments field is now accessible.
3. In the Trouble Events list, select the row for the event that all subsequent events will be related to. The event number appears in the Selected Events field.
4. Select the row of an event in the Trouble Events list that you want to relate to the first selected event.
5. If there are other events you want to add, select the row for those events in the Trouble Events list. The event numbers for the events are added to the Selected Events field.
6. Type a comment into the \textbf{Relationship Comments} field, if desired.
7. Click the \textbf{OK} button. The selected events are related to one another. The \textbf{Grp Type} column in the Work Agenda for each event now contains “REL”, the \textbf{Rel Type} column now contains “R”, and \textbf{Rel Event #} column now contains the event number of the earliest event.

### Unrelating Events

To unrelated events that have been related, complete these steps:

1. Open the Group dialog box by selecting \textbf{Group} from the Work Agenda Actions menu.
2. Change the Group Method to “unrelate.”
3. In the Trouble Events list, select the row for the event that you wish to unrelate. The event number appears in the Selected Events field.
4. If there are other events to you want to unrelate, select the row for those events in the Trouble Events list. The event numbers for the events are added to the Selected Events field.
5. Click the \textbf{OK} button. The selected events are unrelated. If two or more events are still part of that relationship, they remain related to each other. If the event that was displayed in the \textbf{Rel Event #} column was unrelated and two or more events are still part of that relationship, the \textbf{Rel Event #} column is updated with the event number of the earliest event remaining in the relationship.

### Associating and Unassociating Calls with Devices

Sometimes a call comes in reporting a problem that is not clearly related to a particular customer or device. Until a device is identified for the problem, the event is considered a “fuzzy call.” When more information becomes available, you can associate the fuzzy call with a device. You can also unassociate these calls using the Trouble Information window.

#### Associating a Fuzzy Call with a Device

To associate an event with a device, complete these steps:

1. Open a Viewer window and load the map containing the device you want to associate.
2. In the Work Agenda list, select the row of the fuzzy event that you want to associate.
3. In the Work Agenda window, select Associate from the Actions menu. The Associate dialog box opens.
4. In the Viewer, select the device you want to associate the fuzzy call to. The device identification appears in the Device field of the Associate dialog box.
5. Click \textbf{OK} in the Associate dialog box. The row for the fuzzy event disappears from the Work Agenda, and the Oracle Utilities Network System Trouble Management analysis engine re-analyzes the fuzzy call using the selected associated device.

#### Unassociating/Reassociating a Call from/to a Device

To unassociate a call from one device and reassociate it to another device, complete these steps:
Managing Events with Trouble Management

**Note:** If you are unassociating a call and you want to turn it into a fuzzy call, simply do not select a device to re-associate it with (i.e., omit the third and sixth steps below).

1. In the Work Agenda window, select the row for the event that contains the calls you want to unassociate.
2. Click on the **Info…** button. Call information about the event appears in the Trouble Information window.
3. Open a Viewer window and load the map containing the new device you would like to re-associate the call(s) with.
4. Select the call row(s) in the Trouble Information window.
5. In the Trouble Information window, select “Unassociate” from the Actions menu. The Unassociate dialog box opens.
6. Select a device in the Viewer to populate the New Device field in the Unassociate dialog box.
7. Click **OK**. The following occurs:
   - The call(s) are unassociated from the current device and associated with the new device.
   - The Oracle Utilities Network System Trouble Management analysis engine re-analyzes the event from which the calls were unassociated, as well as the unassociated calls using their new associated device.

**Alerts**

New and revised predicted events are sent to the Work Agenda from the Oracle Utilities Network System Trouble Management analysis engine. The system then alerts you to the new information with an audible alarm. The alarm will sound:

- Every three seconds continuously when an unacknowledged emergency or hazardous event or an event with a NFY status (Notify alarm) appears, until the event is acknowledged.
- Once every five minutes while there are any other unacknowledged events.

In addition, the system alerts you with Notify (NFY) alarms when:

- a dispatched crew has not been contacted by a specified time,
- the current time exceeds an Estimated Restore Time for an event, or
- an event that has a crew associated with it is repredicted to a new location by the Oracle Utilities Network System Trouble Management analysis engine.

**Event Details**

The Event Details window allows you to enter information about an event for reporting purposes. It displays various event information, including crew contact details, both the beginning and restoration times for the event, any partial restoration steps, and the operations event note.

Use Event Details to track information about the cause of an event and how the event is resolved. Some information is automatically entered into Event Details, and you can manually override some of this data. In addition, you can complete events from this window, giving you an opportunity to enter more detail about the event and validate the completion for proper event reporting.

This section includes the following topics:

- Using the Event Details Window
- Finding an Event
- Equipment Failure Panel
Managing Events with Trouble Management

**Recording Failed Equipment Information**

**Using the Event Details Window**

There are four ways to open Event Details for an event:

- Select a row in the Work Agenda, then click on the **Event Details**… button at the bottom of the window.
- Select a row in the Work Agenda, and then select **Event Details**… from the Actions menu.
- Select a dispatched crew in the Crew Actions window, click on the **Active Job Info**… button to bring up the Dispatch Information window, then click on the **Event Details**… button.
- Select a dispatched crew in the Crew List window, then click on the **Event Details**… button.

The Event Details window displays the following fields and buttons:

- The **Event #** is the number the system has assigned to the event.
- The **Device** is the name of the device associated with the event.
- The **Switching Plan #** is the switching plan number associated with the event, if any.
- **Zone(s)** displays the control zone(s) where the associated device is located.
- The **Next Crew Contact Required at** table displays when the operator next anticipates receiving contact from the associated crew(s). The **Crew ID** column contains the crew name, and the **Date** column contains the date and time at which the next contact is expected. When the crew is initially dispatched, its contact time is set to two hours from the current time by default.
- The field beside the **Reset Selected Crew Contact Time** button is for entering the date and time that will go into the system if you click on the **Reset Selected Crew Contact Time** button.
- **Event Began** contains the date and time at which the event began. This field is editable.
- **Est # of Cust Out** contains the number of customers experiencing an outage for this event.
- **Event Restored** contains the date and time of event restoration (i.e., when the outage area was re-energized). This field is editable.
- The **Partial Restoration Log** table displays information related to restoration if the event is restored in stages. The Partial Restoration Log table does not display when the event is a non-outage. This table contains the following columns:
  - The **# Cust Out Before** column contains the total number of customers out at each stage.
  - The **Operation Time** column contains the date and time of the operation.
  - The **Device** column displays the device operated at each stage.
  - The **# Cust Restored** column contains the total number of customers that were restored at each stage.
  - The **# Cust Added** column contains the total number of customers that were added at each stage.
  - The **# Cust Out After** column contains total number of customers still without power after each stage.
  - The **Remarks** column contains any comments or remarks entered by the user.
  - The **Event #** column contains the event number associated with each partial restoration step.
• The **Copy Event Details to Partial Restoration Events** button is used to copy the values from many of the Event Details fields for the current event to all of the other events related to it via partial restoration. Any previously stored Event Details information for the related events will be overwritten (except for system-populated fields such as Event #, Device, Zone(s), Event Began, Est # of Cust Out, and Event Restored).

• The **Est Time to Restore (HH:MM)** field is used to enter the estimated time from the current time to complete the restoration in hours and minutes. The field also accepts entries in number of minutes greater than one hour, e.g., it is possible to enter “90” and the ERT is updated with a time 90 minutes from the current time. This field is used with the Update ERT button to update the fields. The Est Time to Restore (HH:MM) field is not displayed when the event is a non-outage.

• The **Est Restore Date** fields display the date and time of estimated restoration. These fields are editable. The Est Restore Date fields are not displayed when the event is a non-outage.

• The **Est Time to Repair (HH:MM)** field is used to enter the estimate time to repair in hours and minutes. This field is used when the crew on-site is only assessing the job and providing an estimate for the time it will take another crew to do the work. This field is editable, and Oracle Utilities Network System Storm Management uses the value, if installed.

• The **Operations Event Note** is a text field for you to enter notes about the event. These are notes that are made available to the call takers to pass on any specific details about the event to new callers associated with this event.

### Event Details Drop-Down Lists

The following table describes the Event Details drop-down lists.

<table>
<thead>
<tr>
<th>Drop-Down List</th>
<th>Allows you to designate...</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>What type of system the failure is on (e.g., overhead transmission, underground distribution, supply, etc.).</td>
</tr>
<tr>
<td>Sub-System</td>
<td>Whether the sub-system is primary or secondary, radial or mesh, or a service drop.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of device that is experiencing the problem.</td>
</tr>
<tr>
<td>Failure</td>
<td>The type of failure that is occurring</td>
</tr>
<tr>
<td>Interrupting Device</td>
<td>The type of interrupting device involved with the event.</td>
</tr>
<tr>
<td>Weather</td>
<td>Weather conditions at the time of the event.</td>
</tr>
<tr>
<td>Environment</td>
<td>Environmental factors that have been involved with the event, such as humidity and salt spray.</td>
</tr>
<tr>
<td>Vegetation</td>
<td>The type of vegetation issues involved with the event, such as tree or vine, location (on or off ROW), and severity (contact or uprooted).</td>
</tr>
<tr>
<td>Foreign Interference</td>
<td>Animals, vehicles, or any other type of foreign body that has contributed to the event.</td>
</tr>
<tr>
<td>Defective Equipment</td>
<td>The type of equipment defect involved with the event (e.g., age deterioration, customer equipment, etc.).</td>
</tr>
<tr>
<td>Scheduled</td>
<td>Whether or not the event was planned and if it was planned for safety purposes</td>
</tr>
<tr>
<td>Utility Error</td>
<td>The reason for the event if it was caused by the utility company.</td>
</tr>
</tbody>
</table>
### Event Details Buttons

- **Exclude from Interruption Indices** button allows you to designate if you want to exclude this event from the interruption indices calculations done by the Oracle Utilities Network Management System – Trouble Reporting product.

- **Reason for Exclusion** field provides free-form text entry of the reason for the exclusion of this event from the interruption indices.

- **Post-Completion Edit Log** table displays information related to event details being edited after the event is completed. The **Who** column contains the user id of who performed the edit. The **Date** column contains the date and time of the edit. The **Reason** column contains a description of why the edit was made. The **Changed Field** column contains the name of the field that was edited. The **Original Value** column contains the value that the field had prior to being edited.

- **Save** button saves the data you have entered in the Event Details fields.

- **Switching** button opens a new emergency switch plan.

- **Secondary Outages** button opens the Service/Secondary Outages Manager for you to create confirmed service and secondary outages for any of the customers associated with the event, if the event is an outage.

- **Equip Failure** button opens the Equipment Failure window for you to enter information about failed equipment related to the event.

- **Maintenance** button checks to see if the required fields have been entered, and if so, changes the event status to “MNP” (Maintenance Pending) if the event is presently in a status that’s eligible to transition to “MNP”. If the required fields (Remedy, Operations Event Note) have not been entered, an error message will open reminding you to do so, and the state transition will not be invoked.

- **Complete Event** button checks to see if the required fields have been entered, and if so, the event is completed. If the required fields (Remedy and Failure) have not been entered, an error message will open reminding you to do so, and the completion will not occur.

- **Exit** button closes the Event Details window. If you have not yet saved your revisions, a dialog box will open asking if you want to save them before exiting.

### Finding an Event

The Event Details Find Event dialog may be used to load details for an event that may no longer be accessible from the Work Agenda or Crew tools but is still in the Oracle Utilities Network System database.

### Find Event Dialog

To access the Find event dialog, select Find Event from the Event Details File menu. The Event Details Find Event dialog displays the following fields and buttons:

- **Event #** field is used to specify an event number as your search criteria. In this case, an exact match search is performed.

- **Event from/to** fields are used to specify a date and time range as your search criteria. You may leave either the from or to field blank for this type of search, but not both. You may
specify just a date, but in that case, the time is automatically assumed to be the current time. You may specify just a time, but in that case, the date is automatically assumed to be a) the current date, if the time is later than the current time or b) tomorrow’s date, if the time is earlier than the current time.

- The Search button is used to execute the search for the event based upon the entered search criteria.
- The table below the search criteria area is populated with any events found that match the search criteria.
- The Event # is the number the system has assigned to the event.
- The Device is the name of the device associated with the event.
- Outage Time contains the date and time at which the event began.
- # Cust contains the number of customers experiencing an outage for this event.
- The Load button populates the Event Details window with the information for the selected event in the table.
- The Clear button clears the search criteria fields and results.
- The Close button exits the Find Event Dialog.

Finding an Event by Event Number
To find an event by the event number, complete these steps:

1. In the Event Details window, select the Find Event option from the File menu. The Find Event dialog opens.
2. Enter the event number you wish to find into the Event # field.
3. Press the Search button. If the event is found, the table populates with the relevant information. If the event is not found, the table does not populate.
4. Select the event row from the table and press the Load button. The Event Details window populates with the information for the selected event.
5. Press the Close button on the Find Event dialog to exit from it.

Finding an Event by Event
To find an event by the event, complete these steps:

1. In the Event Details window, select the Find Event option from the File menu. The Find Event dialog opens.
2. Enter a desired date range into the Event from/to fields.
3. Press the Search button. If events are found that fall within the criteria, the table populates with the relevant information. If no events are found, the table does not populate.
4. Select the event row from the table and press the Load button. The Event Details window populates with the information for the selected event.
5. Press the Close button on the Find Event dialog to exit from it.

Equipment Failure Panel
Event Details lets you record detailed information about any failed equipment related to an event. You can record and track the type of equipment that failed, the manufacturer, serial number, and voltage details.

To record this information, use the Equipment Failure panel.

To access the Equipment Failure panel from the Event Details window, click the Equip Failure… button. The Equipment Failure Panel displays the following fields and buttons:
Managing Events with Trouble Management

- **Item** is automatically populated with the Failure option selected in Event Details.
- The **Manufacturer** button opens the Manufacturers panel, providing a list of manufacturers to select from.
- **Serial #** is an editable (alphanumeric) field for you to enter the serial number for the equipment.
- **Primary Voltage** is an editable (alphanumeric) field for you to enter the primary voltage of the equipment.
- **Secondary Voltage** is an editable (alphanumeric) field for you to enter the secondary voltage of the equipment.
- **Rating** is an editable (alphanumeric) field for you to enter the rating of the equipment. The drop-down list beside the Rating field allows you to select the rating units.
- **Phase** allows you to designate whether the equipment is single-phase or three-phase.
- **Type** is an editable (alphanumeric) field for you to enter the type of equipment.
- **Size** is an editable (alphanumeric) field for you to enter the size of the equipment.
- Both the **OK** button and **Exit** button save the entered information and exit the Equipment Failure window.

**Recording Failed Equipment Information**

To record information about a failed device, complete these steps:

1. In the Event Details window, click the **Equip Failure…** button. The Equipment Failure panel opens.
2. Click the **Manufacturer** button, select the manufacturer, and click **OK**.
3. Enter the serial number, primary and secondary voltage, rating, type, and size of the equipment, as applicable.
4. Click on the drop-down list next to the Rating field and select the rating unit, as applicable.
5. Select the phase.
6. Click **OK**.
Service/Secondary Outage Manager

If you need to confirm a probable service outage or create new confirmed service/secondary outage events when a crew reports in from a site, you can use the Service/Secondary Outage Manager window. This window displays a table listing either all of the customers downstream of the predicted or confirmed outage device (when accessed via Event Details) or all of the customers connected to the selected device (when accessed via the Control Tool).

This section includes the following topics:

- Using the Service/Secondary Outage Manager window
- Creating a Confirmed Service Outage
- Creating a Confirmed Secondary Outage
- Creating a Confirmed Service and Secondary Outage for the Same Customer
- Restoring a Customer with a Confirmed Service or Secondary Outage

Using the Service/Secondary Outage Manager window

To access the Service/Secondary Outage Manager window, do one of the following:

- click the Secondary Outages… button on the Event Details window, or
- select a device in the Viewer that has customers connected to it, bring up the Control Tool, then click on the Secondary Outages… button.

The Service/Secondary Outage Manager window displays the following columns:

- The Device column contains the name of the device the customer is connected to.
- The Address column contains the customer’s address.
- The Call Date column contains the date and time of the customer’s call, if any.
- The Service column contains “YES” to indicate the customer is part of a confirmed service outage. Otherwise, it is blank.
- The Secondary column contains “YES” to indicate the customer is part of a confirmed secondary outage. Otherwise, it is blank.
- The Grouping column contains “YES” to indicate the customer has called in and their call has a groupable trouble code. Otherwise, it is blank.
- The Prediction column contains “SERVICE” to indicate the customer is involved in a probable service outage, “PRIMARY” to indicate the customer is involved in a probable device outage, or “CONFIRMED” to indicate the customer is involved in a confirmed service or confirmed secondary outage. Otherwise, it is blank.

Note: If a customer is affected by one or more service/secondary outages, there will be a separate row in Service/Secondary Outage Manager for each of these outages with Prediction of either SERVICE or CONFIRMED, as appropriate. In all other cases, exactly one row per customer will be displayed (customer being defined as having a unique device and account number).

If a customer is not affected by service or secondary outage, but is affected by a predicted device outage on the transformer, the Prediction will be PRIMARY. In all other cases, the Prediction will always be blank. However, the Call Date may still be populated if there is an outage call for the customer.

- The Restored column contains “YES” to indicate the customer has had their confirmed service or confirmed secondary outage restored. However, information must be entered in the Event Details window in order to complete it. Otherwise, it is blank.
- The Name column contains the name of the customer.
• The **Phone** column contains the phone number of the customer.

• The **Account Number** column contains the account number of the customer.

• The **Cust Type** column contains the customer type designation (e.g., 1, 2, 3).

• The **Event #** column displays the number the system has assigned to the customer's event.

**Color Coding**

The rows in the Service/Secondary Outage Manager window are color-coded to designate when a customer has a confirmed service outage, a confirmed secondary outage, or when the customer has been restored. When a customer is affected by multiple outages, multiple rows will be displayed representing the different outages.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Confirmed Service Outage</td>
</tr>
<tr>
<td>Melon</td>
<td>Confirmed Secondary Outage</td>
</tr>
<tr>
<td>Blue</td>
<td>Restored</td>
</tr>
</tbody>
</table>

**Service/Secondary Outage Manager Buttons**

• The **OK** button applies any changes and closes the Service/Secondary Outage Manager window.

• The **Apply** button applies any changes without closing the Service/Secondary Outage Manager window.

• The **Service** button toggles the Service column value between blank and “YES”. If you click on the **OK** or **Apply** button after toggling this value to “YES”, then a confirmed service outage is created for the customer. If multiple customers have had their service column values toggled to “YES” when the **OK** or **Apply** button is pressed, then a confirmed service outage is created for each individual selected customer. If the selected row is for a predicted outage for which the customer has an incident, their incident will be removed from the event it is currently involved in (and that event will be repredicted) and become associated with the confirmed service outage. If the customer is selected to be involved in both a confirmed service and secondary outage, their incident will be associated with the confirmed service outage only.

• The **Secondary** button toggles the Secondary column value between blank and “YES”. If you click on the **OK** or **Apply** button after toggling this value to “YES”, then a confirmed secondary outage is created for the customer. If multiple customers have had their secondary column values toggled to “YES” when the **OK** or **Apply** button is pressed, then one secondary outage is created for all of those selected customers. If the selected row is for a predicted outage for which the customer has an incident, their incident will be removed from the event it is currently involved in (and that event will be repredicted) and become associated with the confirmed secondary outage.

• The **Grouping** button toggles the Grouping column value between “YES” and blank if the selected customer has called in. If you click on the **OK** or **Apply** button after toggling this value from “YES” to blank, and that incident is a non-groupable incident currently involved in a probable outage, then the incident will be changed from non-groupable to groupable and get repredicted. The purpose of this button is to turn calls that initially came into the system as non-groupable into groupable ones.

• The **Restore** button toggles the Restore column value between blank and “YES”. If you click on the **OK** or **Apply** button after toggling this value to “YES”, then all confirmed events the customer is involved in are restored (but not completed). Pop up warnings appear if you try to restore a customer that is not involved in an event at all, if you try to restore a customer...
that is not part of a confirmed service or confirmed secondary outage, or if you try to restore a customer that is already restored. Only confirmed service and secondary outages created in this window can be restored from here.

- The **Event Details…** button opens the Event Details window for the row’s event. If the customer is involved in more than one event, there are multiple rows in the Service/Secondary Outage Manager with each row representing a different outage.

- The **Exit** button exits the Service/Secondary Outage Manager window.

**Service/Secondary Outage Manager Menus**

The table below describes the Service/Secondary Outage Manager menus.

- File Menu options are:
  - **Print** – Opens the print dialog box to allow you to print the current list.
  - **Exit** – Closes the Service/Secondary Outage Manager window.

- Sort Menu - Allows you to sort the information in the list. For more information, see **Sorting** on page 1-3.

- Filter Menu - Allows you to filter the information in the list. For more information, see **Filtering** on page 1-5.

- Actions Menu - Allows you to perform the same function as the buttons at the bottom of the window. See the list of buttons and their descriptions in the previous section.

**Creating a Confirmed Service Outage**

To create a confirmed service outage for a customer, complete these steps:

1. Select the row in the Service/Secondary Outage Manager for the applicable customer.
2. Click the **Service** button. The **Service** column is now populated with “YES”.
3. Click the **Apply** button. The Service/Secondary Outage Manager refreshes. The row for the selected customer is now colored green, and the **Prediction** column is now populated with “CONFIRMED”. A new event row appears in the Work Agenda Trouble Event Lists. A CSVO symbol appears on the customer's device in the Viewer window.

**Creating a Confirmed Secondary Outage**

To create a confirmed secondary outage for a customer, complete these steps:

1. Select the row in the Service/Secondary Outage Manager for the applicable customer.
2. Click the **Secondary** button. The **Secondary** column is now populated with “YES”.
3. Click the **Apply** button. The Service/Secondary Outage Manager refreshes. The row for the selected customer is now colored melon, and the **Prediction** column is now populated with “CONFIRMED”. A new event row appears in the Work Agenda Trouble Event Lists. A CSCO symbol appears on the customer's device in the Viewer window.

**Creating a Confirmed Service and Secondary Outage for the Same Customer**

To create a confirmed service outage and secondary outage for a customer, complete these steps:

1. Select the row in the Service/Secondary Outage Manager for the applicable customer.
2. Click the **Service** button. The **Service** column is now populated with “YES”.
3. Click the **Secondary** button. The **Secondary** column is now populated with “YES”.
4. Click the **Apply** button. The Service/Secondary Outage Manager refreshes. There are now 2 rows for the customer with **Prediction** column populated with “CONFIRMED”. One row is green and has the **Service** column populated with “YES” and the other row is melon and
has the **Secondary** column populated with “YES”. Both a CSVO and CSCO symbol appear on the customer's device in the Viewer window.

### Restoring a Customer with a Confirmed Service or Secondary Outage

To restore a confirmed service or secondary outage for a customer, complete these steps:

1. Select the row in the Service/Secondary Outage Manager for the applicable customer.
2. Click the **Restore** button. The **Restore** column is now populated with “YES”.
3. Click the **Apply** button. The Service/Secondary Outage Manager refreshes. The row for the selected customer is now colored blue. The CSVO/CSCO symbol disappears from the customer's device in the Viewer window.

### Event Recorder

Detailed information about an event is displayed in the Event Recorder. The Event Recorder works as a “flight recorder” for events, logging the progress of event completion step by step. Event Recorder topics include:

- **Using the Event Recorder Window**
- **Adding a Comment to an Event**

#### Using the Event Recorder Window

To access the Event Recorder from the Work Agenda, select an event and choose Event Recorder from the Actions menu.

The Event Recorder window displays the following fields and buttons:

- The **Active Crews** table displays information about crews associated with the event. The **Crew ID** column contains the crew identifier. The **Contact** column contains the name of the crew contact person. The **Mobile #** column contains the mobile number for the crew contact. The **Pager #** contains the pager number for the crew contact. The **ASN/ENR Date** column contains the date and time the crew was assigned/dispatched to the event. The **Status** column contains the current status of the crew for this event.

- The **Release Crew** button releases the crew selected in the Active Crews table from the event.

- The **Event Action Steps** table displays information about each step of action that has taken place for the event. The **Crew ID** column contains the crew identifier of the crew that pertains to the step, if any. The **Date of Operation** contains the date and time the operation occurred, if a device is associated with the step. The **Date Reported** column contains the date and time the step was recorded in the system. The Date of Operation is non-editable. The **Description** column contains the description of the action that occurred for the step. The **User ID** column contains the id of the user who performed the action.

#### Buttons

- The **Refresh** button re-populates the Event Action Steps table with the most recently saved version of the steps.
- The **Save** button saves all newly added rows in the Event Action Steps table.
- The **Comment** button adds a new, editable comment row to the end of the Event Action Steps table.
- The **Delete** button deletes the selected step from the Event Action Steps table.
- The **Exit** button exits the Event Recorder window.
Adding a Comment to an Event

To add a comment to an event, complete these steps:

1. In the Event Recorder, click on the Comment button. A new row appears in the Event Action Steps table.
2. If there is a crew associated with your comment, click in the cell of the new row under the Crew column and type the crew name.
3. Click in the Description cell of the new row and type your comments.
4. Click the Save button. Your comment step is saved, and the system date and time you entered it is saved in the Date Reported column.

Sometimes a crew out in the field may discover and report an issue that hasn’t been identified by a customer. As an operator, you may wish to get these events recorded in Oracle Utilities Network System. One way to do so is to use the window.

To access the window, click the Summaries toolbox on the Environment Manager, then select the option. The window displays the following fields and buttons:

- The Selected Device field displays the name of the device on which to create the event.
- The Event Start field allows you to enter the start date and time for the event using the date picker.
- The Outage/Non-Outage buttons allow you to designate whether the event should be created as an outage or non-outage.
- The OK button creates the new event on the selected device and closes the window.
- The Cancel button closes the window without creating a new event.
- The Help... button provides help for the window.

Damage Assessment

When a crew out in the field is assessing damage that has occurred, you may wish to record the damage information in Oracle Utilities Network Management System. You can use the Damage Assessment window to record the type of damage and automatically estimate how long the repairs will take given that damage, as well as what materials are required to the repair.

This section contains the following topics:

- Creating a Damage Report
- Using the Damage Assessment Window

Creating a Damage Report

1. Select the desired event in the Work Agenda Trouble Event List window.
2. Select the Damage Assessment… option from the Actions menu. The Damage Assessment window appears populated with information regarding the event.
3. Enter the name of the crew performing the assessment in the Crew ID field.
4. Complete the relevant information in the Damage Specifics section.
5. Complete the relevant information in the Required Material section.
6. Press the OK button. The Damage Assessment window disappears and the damage report is saved. The Est Crew Repair Hours value is now accessible to Oracle Utilities Network System Storm Management, if installed.
Using the Damage Assessment Window

Use the Damage Assessment window to record damage information associated from the Work Agenda Actions menu. This window contains the following components:

- Damage Location Section
- Damage Specifics Section
- Damage Assessment Menu
- Damage Assessment Buttons

Damage Location Section

The Damage Location section of the Damage Assessment window contains information regarding the location of the event, as well as which crew is reporting the damage and when. This section displays the following fields:

- The Crew ID contains the name of the crew reporting the damage. This field must be filled in prior to saving the report. If you try to save a report with the field blank, an error dialog appears.
- The Mobile # field allows you to enter the mobile phone number of the crew.
- The Report Date field contains the date that the damage was reported. This is initially auto-populated with the current date when you bring up the window. This field must be filled in prior to saving the report. This field is not editable.
- The Report Time field contains the time that the damage was reported. This is initially auto-populated with the current time when you bring up the window. This field must be filled in prior to saving the report. This field is not editable.
- The Feeder field displays the name of the feeder on which the event is located. This field is not editable.
- The Device field displays the name of the device on which the event is located. This field is not editable.
- The Event # field displays the system-assigned number for the event. This field is not editable.
- The Location field displays the location of the event. This is initially auto-populated with the address of the first customer call for the event.
- The Company field displays the name of the company in which the event is located. This field is not editable.
- The Region field displays the name of the region in which the event is located. This field is not editable.
- The Branch field displays the name of the branch in which the event is located. This field is not editable.
- The Substation field displays the name of the substation in which the event is located. This field is not editable.

Damage Specifics Section

The Damage Specifics section of the Damage Assessment window contains information regarding the specific damage that was found. This section displays the following fields and buttons:

- The Affected Section drop-down menu allows you to specify what type of network section is affected (Backbone, Lateral, Secondary, Service).
- The Phase Affected drop-down menu allows you to specify which phase(s) is affected.
• The **Location** drop-down menu allows you to specify in what type of location the damage is (Street, Rear Lot Line, Other).

• The **Load Affected** checkbox allows you to specify whether or not any load is affected.

• The **Tree Crew Required** toggle button allows you to indicate whether or not a tree crew is required to repair the damage.

• The **Type of Crew Needed** drop-down menu allows you to specify what type of crew is needed to repair the damage (Service, Trouble, Tree Crew, Line, Eval).

• The **Street Light Damage Noted** toggle button allows you to indicate whether or not any street light damage is noted.

• The **Comments** field allows you to specify additional comments regarding the damage specifics (up to 255 characters).

• The **Est Crew Repair Hours** field is auto-populated by the entries into the damage type table below it. If you have Oracle Utilities Network System Storm Management installed, when this damage report is saved, this value is what Oracle Utilities Network System Storm Management will begin to use as the Repair minutes value for this event.

• The damage type table allows you to specify the type of damage observed and whether or not it's accessible.

  The **Damage Type** column contains the description of the type of damage.

  In the **Accessible** column, you can enter how many instances of each type of damage are accessible.

  In the **Inaccessible** column, you can enter how many instances of each type of damage are inaccessible.

  As you make your entries into this table, the **Est Crew Repair Hours** field above it is updated with the number of minutes estimated to perform the repairs for the event, based upon your entries.

**Required Material Section**

The Required Material section of the Damage Assessment window contains information regarding what materials are needed to repair the damage. This section displays the following fields:

• The **Part Id** field contains the identification number of the selected part. This field is initially auto-populated by your Part Name selection.

• The **Part Name**… button brings up a drop-down menu of part names. After you select a part name from the menu, the Part Id field is auto-populated with a default part number.

• The **Qty** field allows you to specify how many of each part are required.

• The **Save** button saves your selected part name, id and quantity to the parts table. If you try to save without a part name, id or quantity specified, an error dialog will appear:

• The **Delete** button removes the selected row from the parts table.

• The parts table records the name and quantity of parts required for the repair. The **Part Id** column contains the identification number of the part. The **Part Name** column contains the name of the type of part. The **Qty** column contains the required quantity of that part.

• The **Comments** field allows you to specify additional comments regarding the required material (up to 255 characters).
Damage Assessment Menu

- File Menu
  - **Save** – saves the damage report without closing the Damage Assessment window.
  - **Print** – opens the Print dialog box for printing out hard copies of the Damage Assessment window.
  - **Cancel** – closes the Damage Assessment window, but first asks the user if any unsaved changes should be saved.
  - **Exit** – closes the Damage Assessment window and auto-saves any unsaved changes.

- Edit Menu
  - **Clear** – resets all fields in the Damage Assessment window back to their default values.

Damage Assessment Buttons

- The **OK** button saves the damage report and closes the Damage Assessment window.
- The **Apply** button saves the damage report without closing the Damage Assessment window.
- The **Clear** button resets all fields in the Damage Assessment window back to their default values.
- The **Cancel** button closes the Damage Assessment window, but first asks the user if any unsaved changes should be saved.

Requests

The Work Agenda Requests and Completed Requests lists are available from the Work Agenda File menu. These pages display information about each set of ping requests. This section includes the following topics:

- Accessing the Requests List
- Creating an Request for a Service Outage
- Creating an Request for a Device Outage
- Creating an Request Without an Outage
- Completing Requests

Accessing the Requests List

To access the Requests List from the Trouble Events List:
1. Select the Work Agenda event row with an active ping request.
2. Press the **Show Request** button. The Work Agenda navigates to the Requests page and auto-filters on the selected event.

To access the Requests List from the Requests page:
1. Select a row with an active event.
2. Press the **Show Event** button. The Work Agenda navigates to the active Trouble Events List and highlights the select event row.

The Requests List displays the following fields and buttons:

- The **Request #** column is the system-generated index of the request.
- The **Device** column is the start device.
- The **Feeder** column is the device’s feeder.
- The **Substation** column is the device's substation.
• The **Request Date** column is the date the ping was requested.
• The **Event #** column is the outage event (or 0 if N/A).
• The **# Queried** column is the number of meters pinged.
• The **# Responded** is the total number of responses received to date.
• The **# Off** column is the number of deenergized responses received.
• The **Status** column displays ACT=active, CMP=completed, CNL=canceled.
• The **Who Requested** column displays the login user name that initiated the request.
• The **Show Event** button navigates back to the Active Trouble Events List page for the selected row’s event.
• The **Complete** button completes the ping request (see **Completing Requests** on page 2-28).
• The **Cancel** button cancels the ping request and takes no further action.
• The **Exit** button closes the tool.

### Creating an Request for a Service Outage

To create a ping request for a service outage:

1. Select the event row in the Work Agenda and press the **Confirm** button. A dialog appears, asking whether you wish to perform a simple ON/OFF ping, or a full ping.
2. Select the desired action and press **Ok**. The row is updated with a Y in the **Requested** column, and a new row is added to the Requests page for the event.

### Creating an Request for a Device Outage

To create a ping request for a device outage:

1. Select the event row in the Work Agenda and press the **Confirm** button. The Trouble Info Customers page displays all -enabled meters for the selected event.
2. Double-click on each row you wish to ping to set the row as To Be Pinged (TBP).
3. Press the **Confirm** button. A dialog appears, asking you whether you wish to perform a simple ON/OFF ping, or a full ping.
4. Select the desired action and press **Ok**. The table refreshes to display the chosen rows as Has Been Pinged (HBP) by the login user at the current Request Date.

The Work Agenda row updates with a Y in the **Requested** column, and a new row is added to the Work Agenda Requests page for the event.

### Creating an Request Without an Outage

To create a ping request without an outage:

1. Press the **Customer List…** button on the Control Tool. The Trouble Info Customers page displays all -enabled meters downstream from the selected device.
2. Double-click on each row you wish to ping to set the row as To Be Pinged (TBP).
3. Press the **Confirm** button. A dialog appears, asking you whether you wish to perform a simple ON/OFF ping, or a full ping.
4. Select the desired action and press **Ok**. The table refreshes to display the chosen rows as Has Been Pinged (HBP) by the login user at the current Request Date.

A new row is added to the Work Agenda Requests page with no event information.
Completing Requests

From the Work Agenda Requests page, select a ping row and press the Complete button. The options presented to you depend on the status of the original event:

Event Completed/Restored and Any Meters Off

- A dialog appears that lists meters still off
- You can highlight meters to submit as new calls and press Ok, or Cancel to ignore them
- ping request transitions to the CMP state

Event Completed/Restored and All Meters On

- ping request transitions to the CMP state

Event Active and All Meters Off

- A dialog appears that lists meters that are off
- You can press Ok to navigate back to the Trouble Events List and confirm the event, or Cancel
- ping request transitions to the CMP state

Event Active and All Meters On

- A dialog appears that lists meters that are on
- You can press Ok to cancel the associated event, or Cancel
- ping request transitions to the CMP state

Event Active and Any Meters On

- A dialog appears that lists meters that are on and indicate that the prediction device is incorrect. User can navigate to the Viewer to repredict downstream, if desired.
- ping request transitions to the CMP state

No Event and Any Meters Off

- A dialog appears that lists meters that are off
- You can highlight meters to submit as new calls and press Ok, or Cancel
- ping request transitions to the CMP state

No Event and All Meters On

- ping request transitions to the CMP state

Outage Correction

After an outage is completed, you can revise the outage restoration sequence and times by re-recording the outage restoration sequence in study mode. This requires you to log in as an Outage Correction user type.

This Outage Correction environment only includes the tools needed to re-record a completed outage in study mode:

- The Work Agenda only contains the Completed List.
- The Viewer cannot enter real-time mode.
- The Switch Sheet Editor can only display the Outage Correction switch plan type, and cannot enter real-time mode.
Re-Recording the Outage Restoration Sequence in Study Mode

1. From the Event Details for a completed event, press the **Switching…** button to create an Outage Correction switch plan, if one does not already exist for the event.

   **Note:** You can turn on recording in the Outage Correction plan and record the corrected outage and restoration steps in the Viewer, using the Control Tool's date/time selector to save the correct operation times.

2. Once you have recorded the entire set of outage and restoration steps, press the **Correct Outage** button. A confirmation dialog appears.

3. Press **OK** on the confirmation dialog to proceed. The system attempts to validate the proposed plan using the process depicted in the following diagram:
Upon success, the Work Agenda updates with the new outage time, customer count, and outage device. The Event Details, when re-loaded will reflect any partial restorations changes as well.

Note: Since outages may be corrected long after the outage has been completed, this algorithm computes outage details against the current study network. After recording steps for an outage correction, you should turn off recording and operate devices to set your study session to the baseline, in order to replicate the network as it was at the time of the outage.

Managing Crews with Trouble Management

This section describes how to manage crews in Trouble Management. It includes the following topics:

- Trouble Management Windows for Managing Crews
- Crew Administration
- Crew Makeup
- Crew Actions
- Crew List
- Crew Information
- Active Job Information
- Other Crew Functions
- AVL Crews

Trouble Management Windows for Managing Crews

Oracle Utilities Network Management System – Trouble Management has a number of windows that allow you to manage crews efficiently. Each window has a special function. This section describes the various windows and functions that relate to managing crews. The table below highlights the functionality of the windows involved with crew management.

<table>
<thead>
<tr>
<th>Window</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crew Administration</td>
<td>Allows you to activate, deactivate, delete, and temporarily transfer crews to different control zones.</td>
</tr>
<tr>
<td>Crew Makeup</td>
<td>Allows you to edit and create new crews.</td>
</tr>
<tr>
<td>Crew Actions</td>
<td>Provides a visual representation of crew status and classification; allows you to assign and place en route crews to events; provides access to the Crew Makeup, Crew Information and Active Job Information windows.</td>
</tr>
<tr>
<td>Crew List</td>
<td>Displays a list of crews and allows you to open the Crew Information and Event Details windows.</td>
</tr>
<tr>
<td>Crew Information</td>
<td>Displays detailed crew information not shown in the Crew List and allows you to unassign a crew from an event and open the Active Job Information window.</td>
</tr>
</tbody>
</table>
Crew Administration

The Crew Administration window allows you to activate, deactivate, and delete crews, as well as temporarily assign crews to a different control zone. To open the Crew Administration window, click on the Crew Admin button on the Environment Manager.

Crew Administration topics include:

• Using the Crew Administration Window
• Activating a Crew
• Making a Crew Inactive
• Transferring a Crew to Another Control Zone
• Deleting a Crew

Using the Crew Administration Window

Menus

The Crew Administration menus are:

• File Menu
  • New – Opens the Crew Makeup dialog box for you to create a new crew.
  • Edit – Opens the Crew Makeup dialog box for the crew you have selected. From here you can make edits to the crew.
  • Delete – Permanently deletes the selected crew.
  • Print – Opens the Print dialog box.
  • Exit – Closes the Crew Administration window.

• Filter Menu
  • Allows you to filter the list of crews by type or to show only the crews in your subscribed control zone. Selecting All in this menu will turn off any filters and show all crews in the system.

• Actions Menu
  • Activate – Activates the selected crew.
  • Deactivate – Deactivates the selected crew.
  • Transfer Zone… – Temporarily transfer the crew to a different control zone.
  • Release Temp Zone – Return the crew from its temporary control zone assignment back to its original control zone.
  • Toggle Mobile Off – Allows the user to override the mobile flag setting of “Yes” for a mobile crew in order to activate it from the Oracle Utilities Network Management System.
Managing Crews with Trouble Management

**Toggle Mobile On** – Allows the user to turn off the override of the mobile flag and set it back to “Yes”.

**Crew Administration Lists**

The Crew Administration window display the following lists:

- **Control Zone** list displays all the control zones in the system. To view the crews assigned to a specific control zone, click on the name of that zone in this list.

- **Inactive** list displays all the inactive crews assigned to the selected control zone. When a crew in the Inactive list is activated, it will be automatically placed On Shift. To view information about an inactive crew, select the crew name in this list. The information appears in the fields at the bottom of the window.

- **Active** list displays all the active crews assigned to the selected control zone. The Active list displays both On Shift and Off Shift crews. When a crew in the Active list is deactivated, it will be automatically placed Off Shift. To view information about an active crew, select the crew name in this list. The information appears in the fields at the bottom of the window.

  **Note:** The **My Crews** button must be toggled off in order to work with the Control Zone list.

**Crew Administration Buttons**

The Crew Administration window displays the following buttons.

- **Transfer Zone…** button opens the Control Zones dialog box, which allows you to temporarily transfer the crew to a zone you have authority over.

- **Release Temp Zone** button returns the crew from its temporary control zone assignment back to its original control zone. If a crew is temporarily assigned to another zone, that zone name will appear in the Temporary Zone field on the lower left-hand corner of the Crew Administration window.

- **My Crews** button filters the list of crews to only show the crews assigned to the control zones you have authority over.

- **The forward arrow button** activates the selected inactive crew and moves the crew name to the Active list.

- **The backward arrow button** inactivates the selected active crew and moves the crew name to the Inactive list.

**Activating a Crew**

To activate a crew, complete these steps:

1. In the Crew Administration window, select the crew you want to activate in the Inactive list. The information for that crew displays in the fields at the bottom of the window.

2. Click on the forward arrow button to move the crew to the Active list. The crew becomes active and the name of the crew moves from the Inactive list to the Active list.

  **Notes:** You cannot activate crews that are assigned to a control zone that you do not have authority over. In that case, you must first transfer the crew to a control zone that you have authority over.

You cannot activate crews that are mobile crews (Mobile Flag = “Yes”) without first overriding the mobile flag setting. This is done by selecting the mobile crew in the Inactive list and then selecting the **Toggle Mobile Off** option from the Actions menu.
Making a Crew Inactive
To deactivate a crew, complete these steps:

1. In the Crew Administration window, select the crew you want to deactivate in the Active list. The information for that crew displays in the fields at the bottom of the window.
2. Click on the backward arrow button to move the crew to the Inactive list. The crew becomes inactive and the name of the crew moves from the Active list to the Inactive list.

Notes:
- You cannot make an assigned or en route/onsite crew inactive.
- You cannot deactivate crews that are assigned to a control zone that you do not have authority over.
- You cannot deactivate mobile crews (Mobile Flag = “Yes”) from within Oracle Utilities Network Management System. Only mobile crews that have had their mobile flag overridden (Mobile Flag = “No (Overridden)”) may be deactivated from within Oracle Utilities Network Management System.

Transferring a Crew to Another Control Zone
To temporarily transfer a crew to another control zone, complete these steps:

1. Select the name of the crew you want to move in the Active or Inactive list. Make sure the My Crews radio button is toggled off if you want crews in other control zones to be visible to you.
2. Open the Control Zones dialog box by either clicking the Transfer Zone… button or by selecting Transfer Zone… from the Actions menu. The Control Zones dialog box will appear and contain the control zones that you presently have authority over.
3. In the Control Zones dialog box, select the name of the control zone you want to move the crew to in the Items list.
4. Click the OK button. The crew’s Temporary Zone field populates with the new zone name. The Control Zone field remains unchanged.
5. To return the crew to its original control zone assignment, either click the Release Temp Zone button or select the Release Temp Zone option from the Actions menu. The Temporary Zone field becomes blank.

Notes: Transferring a crew to another control zone is only a temporary change. Once a crew is deactivated, it will revert back to its original control zone assignment. If you wish to permanently change a crew’s assigned control zone, use the Edit button to bring up the Crew Makeup window and make the change there.

You can only transfer crews to control zones that you have authority over.

Deleting a Crew
To delete a crew, complete these steps:

1. If the crew is active, you must first deactivate it using the Making a Crew Inactive on page 2-34 procedures listed above.
2. With the crew highlighted in the Inactive list, select Delete from the File menu. A dialog box appears asking you to confirm the delete.
3. Click OK. The crew is deleted from the system.

Note: You cannot delete mobile crews (Mobile Flag = “Yes” or “No (Overridden)”) from within Oracle Utilities Network Management System.
Crew Makeup

The Crew Makeup window allows you to edit and create new crews.

Crew Makeup topics include:

• Using the Crew Makeup Window
• Creating a New Crew
• Filtering Crew Personnel
• Removing Personnel from a Crew
• Removing a Vehicle from a Crew
• Editing a Crew

Using the Crew Makeup Window
To open the Crew Makeup window, select New... or Edit... from the File menu in the Crew Admin window or click either the New... or Edit... button in the Crew Actions window. The Crew Makeup window displays the following fields and buttons:

• The Type drop-down list allows you to select the type of crew (e.g., Line, Eval, Trouble).
• The Temp/Perm drop-down list allows you to specify whether a crew is temporary or permanent. When a crew is set to temporary, a dialog box appears whenever it is deactivated asking if the crew should be removed.
• The Edit... button opens the Control Zones dialog box, allowing you to select the Control Zone the crew will be assigned to.
• The Add... (Personnel) button opens the Personnel dialog box, allowing you to enter a crew member’s name and select their job type.
• The Select Personnel... button opens the Select Personnel dialog box, allowing you to select from a pre-defined list of personnel.
• The Remove (Personnel) button removes the selected individual from the personnel list.
• The Add… (Vehicles/Equipment) button opens the Vehicles/Equipment dialog box, allowing you to assign vehicles to the crew.
• The Select Vehicles/Equipment… button opens the Select Vehicles/Equipment dialog, allowing you to select from a pre-defined list of vehicles/equipment.
• The Remove (Vehicles/Equipment) button removes the selected vehicle from the Vehicles/Equipment list.
• The OK button saves the crew changes and closes Crew Makeup.
• The Apply button saves the crew changes and leaves Crew Makeup open.
• The Cancel button closes Crew Makeup without saving any changes.

Creating a New Crew
To create a new crew, complete these steps:

1. Open the Crew Makeup window either by selecting New... from the File menu in Crew Administration or by clicking on the New… button in Crew Actions.
2. Enter the Crew ID, mobile and pager numbers, and contact.
3. Select the crew type and temporary or permanent from the drop-down lists.
4. Click the Edit… button to open the Control Zone dialog box. Select a control zone and click OK.
5. Click the **Add… (Personnel)** button to open the Personnel dialog box. Enter a crew member's name and select their job title, then click **Apply**.

    Or,

    Click the **Select Personnel…** button to open the Select Personnel dialog box. Select one or more rows from the Select Personnel dialog (using the <Ctrl> and/or <Shift> keys), then click **OK**.

6. Repeat the previous step until all crew members are added, then click **OK** to close the Personnel dialog box.

    **Note:** The Crew Size field increases with each person you add to the crew. If you want to add crew members without listing their names, you can change the number in this field. The system will not let you enter a number smaller than the number of individuals listed.

7. Click on the **Add… (Vehicles/Equipment)** button to open the Vehicles/Equipment dialog box. Select the vehicle type, and then click **Apply**.

    Or,

    Click the **Select Vehicles/Equipment…** button to open the Select Vehicles/Equipment dialog box. Select one or more rows from the Select Vehicles/Equipment dialog (using the <Ctrl> and/or <Shift> keys), then click **OK**.

8. Repeat the previous step until all vehicles are added, then click **OK** to close out of the dialog box.

9. Click **Ok** to save the crew.

### Filtering Crew Personnel

Press the Filter button in the Select Personnel dialog to display the Crew Personnel Filter dialog. In the Crew Personnel Filter, filter a filter can be applied to the Personnel table by choosing one of the columns (**District**, **Employee ID**, **Employee Name**, or **Job Title**), typing in the filter text, and clicking **OK**. The Select Personnel dialog will only display the personnel which fully or partially matches the filter text.

### Removing Personnel from a Crew

To remove an individual from a crew you have open in Crew Makeup, select his or her name in the Personnel list and click **Remove**. The name disappears from the Personnel list and the number in the Crew Size field decreases by one.

### Removing a Vehicle from a Crew

To remove a vehicle from a crew you have open in Crew Makeup, select the vehicle from the Vehicles/Equipment list and click **Remove**. The vehicle disappears from the Vehicle/Equipment list.

### Editing a Crew

To edit a crew, complete these steps:

1. Open the Crew Makeup window either by selecting **Edit…** from the File menu in Crew Administration or by clicking the **Edit…** button in the Crew Actions window.

2. Make the changes to the crew.

3. Click **Ok** to save the changes.

    **Note:** You may not edit mobile crews (Mobile Flag = “Yes” or “No (Overridden)” from within Oracle Utilities Network Management System.
Crew Actions

The Crew Actions window contains buttons representing each crew. The buttons display the Crew ID and are color coded to show status. The Crew Actions window allows you to assign and place en route crews to an event and access the Crew Makeup, Crew Information, and Active Job Information windows.

The Crew Actions window opens by default when you login to Oracle Utilities Network Management System. If it has been closed, you can open it again by clicking on the Crew Actions button on the Environment Manager.

Note: By default, only On Shift crews are displayed on the Crew Actions window. To include Off Shift crews, check the Off Shift checkbox on the Crew Filter dialog.

Crew Actions topics include:

- Color Coding
- Crew Actions Buttons
- Assigning a Crew
- Placing a Crew En Route Using Crew Actions
- Changing Crew Availability
- Finding the Event a Crew is En Route To
- Filtering the Crew Actions Window

Color Coding

The table below describes the color coding used on the Crew Actions and Crew List windows.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>En Route</td>
</tr>
<tr>
<td>Dark Green</td>
<td>ONSite</td>
</tr>
<tr>
<td>Yellow</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Cyan</td>
<td>Assigned</td>
</tr>
<tr>
<td>Orange</td>
<td>Suspended</td>
</tr>
<tr>
<td>White</td>
<td>Available</td>
</tr>
</tbody>
</table>

Crew Actions Buttons

The Crew Actions window displays the following buttons:

- The Show All Crews drop-down menu allows you to filter the crews that are displayed. When you click on an event row in the Work Agenda window and then select one of the items in this drop-down list (region, branch, substation, etc.), Crew Actions will filter out any crews that are not assigned to the same region/branch/substation/etc. as the selected event. If a crew is assigned to a control zone level higher than the selected filter level (e.g., the crew is assigned to a Region and the filter applied is Substation), the crew will not be filtered out when the selected event also resides in that crew’s assigned control zone.

- The New… button opens the Crew Makeup window for you to create a new crew.

- The Edit… button opens the Crew Makeup window for you to edit the selected crew.

- The Locate Crew button will focus the Viewer on the selected crew, if the crew is an AVL crew.
Managing Crews with Trouble Management

- The **View** button will focus on the device associated with the en route/onsite event and the Work Agenda window will highlight the associated event row, if the crew is en route/onsite.

- The **Availability…** button opens the Crew Availability dialog box where you can change the availability of a crew.

- The **Assign** button assigns the selected crew to the event selected in the Trouble Events list of the Work Agenda.

- The **En Route** button places the selected crew en route to the event selected in the Trouble Events list of the Work Agenda window. The En Route action is not allowed for an Off Shift crew.

- The **Onsite** button places the selected crew onsite to the event it is currently en route to.

- The **Active Job Info…** button opens the Active Job Information window.

- The **Crew Info…** button opens the Crew Information window.

- The **Filter** button opens the Crew Actions Filter dialog box where you can select the filter criteria by which the crew icons are displayed. You can filter by crew type, control zone, and whether or not to include inactive crews.

- The **Switching…** button opens the Switch Sheet Editor window and loads the switching plan associated with the event the crew is en route to/onsite at, if the crew is en route to/onsite at a planned event.

- The **Exit** button closes the Crew Actions window.

**Assigning a Crew**

You do not have to assign a crew to an event before placing it en route. Assigning merely lines up the event for the crew to work later. To assign a crew to an event, complete these steps:

1. Locate the event you want to assign the crew to in the Trouble Events list of the Work Agenda. Select the row of that event.
2. Select the crew you want to assign the event to in the Crew Actions window.
3. Click the **Assign** button. The button for the crew turns cyan (unless it is currently unavailable, i.e., yellow), and the event information is automatically entered into the Crew Information window for the crew.

   **Note:** You can assign multiple events to a single crew. You can also assign multiple crews to a single event.

**Placing a Crew En Route Using Crew Actions**

To place an On Shift crew en route to an event, complete these steps:

1. Locate the event you want to place the crew en route to in the Trouble Events list of the Work Agenda. Select the row of that event.
2. Select the crew you want to place en route in the Crew Actions window. The crew must be On Shift and cannot already be en route to another event.
3. Click the **En Route** button. If the selected crew is unavailable, you will be prompted to first make the crew available. The icon for the crew turns green, and the event information is automatically entered into the Crew Information window for the crew.

   **Note:** You can place multiple crews en route to a single event.

**Changing Crew Availability**

Making a crew available/unavailable is different from making it active/inactive. When a crew is inactive (e.g., finished working for the day), the crew does not appear in the Crew Actions window (unless you have the Inactive Crews filter toggled off). When a crew is unavailable, (e.g., at lunch),
it appears in the Crew Actions window (in yellow). You can assign an unavailable crew, but you cannot place it en route. See Activating a Crew on page 2-33 and Making a Crew Inactive on page 2-34 for more information on active/inactive crews.

To change a crew’s availability, complete these steps:

1. Select the crew you want to change in the Crew Actions window. You cannot change an en route/onsite crew.
2. Click on the Availability… button. The Update Crew Availability dialog box opens.
3. Click on the Available Yes/No drop-down list and select “Yes” to make the crew available or “No” to make it unavailable.
4. If you are making an available crew unavailable, click in the Description field and type a brief reason for the change (e.g., on break).
5. Click OK. The crew icon changes to yellow. If you now try to place the crew en route to an event, a dialog box will appear asking if you want to make the crew available.

   Note: You can assign events to both available and unavailable crews.

Finding the Event a Crew is En Route To

To find the event a crew is en route to, select the crew in the Crew Actions window and click the View button. The Trouble Events list opens in the Work Agenda with the event row highlighted, and the Viewer focuses on the device associated with the en route event.

Note: The Work Agenda event row will only appear if the event is on the list you currently have displayed in the Work Agenda window. The Viewer will only focus on the device if you have a Viewer window open.

Filtering the Crew Actions Window

To filter the crews that appear in the Crew Actions window, complete these steps:

1. Click the Filter… button in the Crew Actions window. The Crew Actions Filter dialog box appears.
2. If you want to exclude certain crew types, click on the types you do not want to view.
3. If you want inactive crews to appear, click on the Inactive Crews option.
4. If you want to view only the crews assigned to a particular control zone, click on the name of the control zone in the Crew Zone list.
5. Do one of the following:
   - Click Apply to view the changes in the Crew Actions window without closing the Crew Actions Filter dialog box, or
   - Click OK to close the dialog box and apply the filters you’ve selected.

Note: You can also filter the crews by Company/Region/Branch/Substation/Feeder of the event selected in the Work Agenda window. To use this feature, select an event (in the Work Agenda window), click on the Show All Crews drop-down list (in the Crew Actions window), and select the option (Company, Region, etc.) you want. This filter works in addition to any filters you have set using the Crew Actions Filter dialog box.
**Crew List**

The Crew List window shows all crews while color-coding the rows to indicate status. Like the Crew Actions window, the Crew List window lets you display a filtered view of crews and open the Crew Information window for more detailed information.

Unlike Crew Actions, the Crew List window also lets you open the Event Details window so you can enter reporting information and close the event.

Crew List topics include:

- Using the Crew List Window
- Filtering the Crew List
- Using Crew Search

**Using the Crew List Window**

To open the Crew List window, click the Crew button. The Crew List displays the following fields and buttons:

- The **Control Zone** column contains the name of the control zone the crew is assigned to.
- The **Crew ID** column contains a string that identifies the crew. The user in the Crew Makeup window assigns this string.
- The **Crew Type** column contains the type of crew (e.g., Eval, Service, Line, etc.).
- The **Contact** column contains the contact name for the crew.
- The **Crew Size** column contains the number of crew members.
- The **Feeder** column contains the feeder for the device where the crew is en route/onsite.
- The **Device** column contains the name of the device the crew is en route to/onsite at.
- The **Est Restore Time** column contains the date and time when the event the crew is en route to is estimated to be restored.
- The **# Asgn** column contains the number of events assigned to the crew.
- The **Crew Hrs Wkd** column contains the elapsed time since the crew started its shift (the On Shift Time).
- The **Active** column indicates whether or not the crew is active (Y = yes, N = no).
- The **Mobile Flag** column indicates whether or not the crew is a mobile system.
- The **On Shift** column indicates whether the crew is currently on shift (Yes=on shift, No=not on shift).
- The **Crew Info…** button opens the Crew Information window. (See Crew Information on page 2-42.)
- The **Event Details…** button opens the Event Details window for the event the crew is en route to/onsite at. (See Event Details on page 2-13.)
- The **Crew Search…** button opens the Crew Search dialog. (See Using Crew Search on page 2-41.)
- The **Switching…** button opens the Switch Sheet Editor window and loads the switching plan associated with the event the crew is en route to/onsite at, if the crew is en route to/onsite at a planned event.
- The **Exit** button closes the Crew List window.

**Crew List Color Codes**

The table below describes the Crew List color codes.
<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>En Route</td>
</tr>
<tr>
<td>Dark Green</td>
<td>Onsite</td>
</tr>
<tr>
<td>Yellow</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Cyan</td>
<td>Assigned</td>
</tr>
<tr>
<td>Orange</td>
<td>Suspended</td>
</tr>
<tr>
<td>White</td>
<td>Available</td>
</tr>
</tbody>
</table>

If a crew is unavailable (e.g., on break), it will appear in the Crew List as either “Unavailable” or the entered reason will appear in the Feeder/Device columns.

**Filtering the Crew List**

To filter the list of crews displaying in the Crew List window, complete these steps:

1. Click on the Filter menu.
2. Choose one of the following:
   - To filter the list to only display a specific crew type or On Shift/Off Shift status, select the type. The menu closes and the list is filtered.
   - To create a more detailed filter using any of the columns in the Crew List, select **Dialog**. The Filter Dialog box opens and you can create and apply a filter as described in *Filtering* on page 1-5.

   To turn a filter off, select **All** from the Filter menu.

**Using Crew Search**

To search for a crew member or a type of crew vehicle, use the Crew Search dialog. To bring up the Crew Search dialog, click the **Crew Search…** button on the Crew List window.

**Searching for a Crew Member**

To search for a particular crew member, complete these steps:

1. Click the **Crew Search…** button on the Crew List window. The Crew Search dialog appears.
2. Enter the member’s name (or portion of the name) into the **Enter member name** field.
   
   **Note**: The search is case-sensitive.
3. Click the **OK** button. The search is performed.
   - If no matches are found, an error dialog appears.
   - If multiple matches are found, a dialog appears, which allows you to select the desired crew member. Select the desired crew and press the **OK** button.
   - If there is only one match found, or after you’ve selected the desired member from the Select Crew dialog, the Crew Information window opens with information regarding the crew that the member belongs to, and the crew’s row is selected in the Crew List window.
Searching for a Vehicle

To search for a particular type of crew vehicle, complete these steps:

1. Click the Crew Search… button on the Crew List window. The Crew Search dialog appears.
2. Change the Search for option to “vehicle”. Below the Search for option now appears a drop-down menu of vehicle types to choose from.
3. Select the desired vehicle type.
4. Click the OK button. The search is performed.
   - If no matches are found, an error dialog appears.
   - If one or more match is found, the Select Crew dialog appears.
     - Select the desired crew and press the OK button. The Crew Information window opens with information regarding the crew that the member belongs to, and the crew’s row is selected in the Crew List window.

Crew Information

The Crew Information window displays detailed crew information not shown in Crew Actions or the Crew List. It allows you to unassign a crew or access the Active Job Information window to place a crew en route to any of its assigned events.

This section includes the following topics:

- Using the Crew Information Window
- Unassigning a Crew
- Placing a Crew En Route to an Assigned Event

Using the Crew Information Window

To open the Crew Information window, do any of the following:

- From the Crew List window, select the row of the crew you want to view and click on the Crew Info… button.
- From the Crew List window, select the row of the crew you want to view and select Crew Info… from the Actions menu.
- From the Crew Actions window, select the icon of the crew you want to view and click on the Crew Info… button.

The top section of the Crew Information windows displays information about the selected crew. The middle section displays information about the event the crew is en route to, if any. The bottom section displays information about the events assigned to the crew, if any.

The Crew Information window displays the following fields and buttons:

- The Crew ID field displays the string that identifies the crew. This string is assigned by the user in the Crew Makeup window.
- The Mobile # field displays the crew’s mobile phone number.
- The Pager # field displays the crew’s pager number.
- The Contact field displays the name of the crew’s contact person.
- The Type field displays the type of crew (e.g., Eval, Service, Line, etc.).
- The Temp/Perm field displays whether the crew is a temporary crew or a permanent crew.
- The Control Zone field displays the control zone the crew is assigned to.
- The Personnel field displays the names of all the crew members and their job titles.
• The **Vehicles/Equipment** field displays the vehicles assigned to the crew.
• The **Event #** field displays the event number of the event the crew is en route to/onsite at.
• The **Feeder** number displays the name of the feeder for the device where the crew is en route to/onsite at.
• The **Est Restore Time** field displays the date and time when the event the crew is en route to/onsite at is estimated to be restored.
• The **Device** field displays the name of the device related to the event.
• The **Event #** column contains the event number of the event the crew is assigned to.
• The **Assign Date** column contains the date the crew was assigned to the event.
• The **Assign Time** column contains the time the crew was assigned to the event.
• The **Feeder** column contains the name of the feeder involved in the event.
• The **Device** column contains the name of the device related to the event.
• The **# Calls** column contains the number of customer calls received for the event.
• The **# Out** column contains the number of customers experiencing an outage for the event.
• The **Suspended** column indicates whether the assignment is an event that the crew was previously en route to but suspended from (Y = yes, N = no).

**Buttons**

• The **Drop Assignment** button removes the event from the list of crew assignments.
• The **Place En Route** button opens the Active Job Information window for you to place the crew en route to an event on the assigned list. You must select an event on the assigned list before you click this button. The En Route action is not allowed for an Off Shift crew.
• The **Cancel** button closes the Crew Information window.

**Unassigning a Crew**
To drop an assignment from a crew, complete these steps:

1. In the Crew Information window, select the assigned event. The buttons at the bottom of the window become enabled.
2. Click the **Drop Assignment** button. A message box opens asking if you are sure you want to remove the assignment.
3. Click **Yes**. The following occurs:
   • The crew is unassigned from the event.
   • The event is removed from the list of crew assignments.
   • The crew button/crew row changes to white (if the crew is not en route or assigned to another event).

**Placing a Crew En Route to an Assigned Event**
If a crew has been assigned to an event, you can place the crew en route to the event using the Crew Info window.
To place the crew en route to the assigned event, complete these steps:

1. In the Crew Actions window, select the assigned crew.
2. Click the **Crew Info...** button. The Crew Information window opens.
3. Select the row for the event in the assignments table.
Managing Crews with Trouble Management

4. Click the **Place En Route** button. The Active Job Information window opens and the crew is placed en route to the event.

**Active Job Information**

The Active Job Information window provides basic crew information, event location, and a list of calls associated with the selected crew. This section includes the following topics:

- Using the Active Job Information Window
- Updating Event Information
- Placing a Crew En Route using the Active Job Information Window
- Moving a Crew
- Suspending a Crew
- Returning a Suspended Crew to a Non-Suspended Status
- Releasing a Crew from an En Route/Onsite Event

**Using the Active Job Information Window**

To open the Active Job Information window, do one of the following:

- From **Crew Actions**, select the en route/onsite crew you want to view active job information about and then click the **Active Job Info…** button. The Active Job Information window opens.
- From **Crew Information**, select the row of the assigned event you want to place the crew en route to. Then click on the **Place En Route** button. The Active Job Information window opens.

The Active Job Information window displays the following fields and buttons:

- The **Crew ID** field displays the string that identifies the crew. This string is assigned by the user in the Crew Makeup window.
- The **Contact** field displays the name of the crew’s contact person.
- The **Event #** field displays the event number of the event the crew is en route to/onsite at.
- The **Feeder** number displays the name of the feeder for the device where the crew is en route to/onsite at.
- The **Device** field displays the name of the device related to the event.
- The table in the middle of the window displays information regarding each call received for the en route/onsite event. The **Address** column contains the address of the caller. The **Call Date** column contains the date on which the call was received. The **Call Time** column contains the time at which the call was received. The **CMT** column indicates whether or not customer comments were entered on the call (Y = yes, N = no).
- The **View All Calls** drop-down menu toggles a filter on or off to show only calls with customer comments.
- The **Call Info…** button opens the Call Information window, used to view customer call information for a selected row.
- The **Not Onsite** drop-down menu is a toggle for you to designate whether the crew has arrived onsite yet or not. The field to the right of the menu is editable and populates with the current time when you toggle the crew to **Onsite**.
- The **Not Suspended** drop-down menu is a toggle for you to designate whether the crew has been suspended from the event. The field to the right of the menu is editable and populates with the current time when you toggle the crew to **Suspended**.
• The **Est Time to Restore (HH:MM)** field allows you to enter the estimated amount of time for the event to be restored. This field does not allow negative numbers to be entered.

• The **Update ERT** button, when clicked, will take the value you typed in the Est Time to Restore (HH:MM) field and update the Estimated Restore Date and Estimated Restore Time fields based on the current system date and time.

• The **Operations Event Note** field allows you to enter notes about the event.

**Buttons**

• The **OK** button saves the changes you have made and closes the Active Job Information window.

• The **Event Details…** button opens the Event Details window for the en route/onsite event.

• The **Move Crew…** button opens the Move Crew dialog box where you enter the location you want to move the crew to, either manually or by selecting a device in the Viewer.

• The **Release Crew** button releases the crew from the event.

• The **Cancel** button closes the Active Job Information window without saving any changes.

**Updating Event Information**

To update event information, complete these steps:

1. Open the Active Job Information window by selecting a crew in Crew Actions and clicking **Active Job Info…**

2. To update the Estimated Restore Date or time, enter the Estimated Time to Restore and click the **Update ERT** button. The Est Restore Date and time will change accordingly.

3. To add event notes, enter them in the Operations Event Notes field.

4. Click **OK**. The Active Job Information window closes and your changes are saved.

**Placing a Crew En Route using the Active Job Information Window**

To place a crew en route to an assigned event, complete these steps:

1. In the Crew Information window, select the row of the assigned event you want to place the crew en route to.

2. Click the **Place En Route** button. The Active Job Information window appears with the Crew and Event information fields populated. The button/row for the crew turns green and the event information is automatically entered into the Crew Information window for the crew.

   If you try to place en route a crew that has already been placed en route to an event, an error dialog box will appear.

**Moving a Crew**

Moving a crew does not change the event the crew is en route to, rather, it moves the crew to another device location and keeps it associated with the same event. By default, Oracle Utilities Network Management System Trouble Management locates a crew at the predicted or confirmed clearing device so that graphically the crew appears to be at the same location as the outage symbol in the Viewer. In some cases, the crew may actually have to work at a location different from the clearing device. It is not required or necessary to move the crew, but moving the crew to the actual device location is helpful in keeping more accurate track of what is going on in the field.

To move a crew, complete these steps:

1. Open the Active Job Information window for the crew you want to move.

2. Click the **Move Crew…** button. The Move Crew dialog box opens.
3. Either type in the name of the device that is the new crew location or select the new device location in the Viewer window.

4. Click **OK**. The crew symbol moves on the Viewer map, and the crew's Device updates on the Crew List. The crew remains en route to/onsite at that same event.

**Suspending a Crew**

Occasionally, you may need to remove a crew from an event and send them to another, higher-priority event. When the crew finishes work on the higher-priority event, they will return to the current event to finish it. To reroute a crew to another event without losing its assignment to the current event, the system lets you suspend a crew.

To suspend a crew, complete these steps:

1. Open the Active Job Information window from the Crew Actions window by clicking on the crew you want to reroute and then clicking the **Active Job Info…** button.

2. Click on the **Not Suspended** toggle button and select **Suspended**.

3. Click **OK**. The crew's button/row changes to orange to indicate the crew is suspended. You can now place the crew en route to the new event.

**Returning a Suspended Crew to a Non-Suspended Status**

Once a suspended crew has completed their higher-priority event, you can return the crew back to their original assignment. To remove the suspended status from the crew, simply place the crew en route back to the original event. (See **Placing a Crew En Route Using Crew Actions** or **Placing a Crew En Route using the Active Job Information Window**.)

If the crew cannot return to the original assignment, you can simply drop the assignment from the crew using the procedures for **Unassigning a Crew**. When you drop the assignment, the crew will no longer be suspended.

**Releasing a Crew from an En Route/Onsite Event**

To release a crew from an en route/onsite event, complete these steps:

1. Open the Active Job Information window for the crew you want to release.

2. Click the **Release Crew** button. The following occurs:

   • The crew will be released from the event.
   • The crew’s active job information will be removed from the Crew List window.
   • The crew button/row changes to white (if the crew is not assigned to another event).

**Other Crew Functions**

There are other crew functions that can be performed using other windows. This section describes those functions.

**Releasing a Crew using Work Agenda**

To release a crew from an event using the Work Agenda window, complete these steps:

1. Select the row in the Trouble Events list for the event that the crew is assigned or en route to.

2. Click the **Rel Crew** button.

   • The crew is released from the event.

   **Note:** If more than one crew is associated with the event, a dialog will appear, prompting you to select which crew to release.

   • The crew’s active job information is removed from the Crew List window.
• The crew button/row changes to white (if the crew is not assigned or en route to another event).

Moving a Crew using the Control Tool
To move a crew using the Control Tool, complete these steps:
1. In the Viewer window, locate the device that the crew is en route to/onsite at.
2. Double-click on the device to bring up the Control Tool.
4. Either type in the name of the device that is the new crew location or select the new device location in the Viewer window.
5. Click OK. The crew symbol moves on the Viewer map, and the crew’s Device updates on the Crew List. The crew remains en route to/onsite at that same event, however.

AVL Crews

In a system that has AVL-enabled crews, there are special AVL crew condition symbols that will appear in the Viewer window. These condition symbols also have their own set of Control Tool options.

AVL Crew Symbols
The AVL crew condition symbols consist of a truck, whose color denotes its status (assigned, en route, unavailable, etc.), a directional arrow indicating its direction of travel, the Crew ID of the crew, and miles per hour reading indicating how fast it is traveling. Below are examples of what these symbols may look like in the Viewer window:

The table below describes the AVL crew condition symbol color codes.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>White</td>
<td>Available</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td>Cyan</td>
<td>Assigned</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
</tbody>
</table>

The following figure shows a crew that is available and unassigned:
Managing Crews with Trouble Management

Managing Crews with Trouble Management

AVL Crew Control Tool Options

The AVL crew condition symbols have their own special set of control tool options.

Using the Control Tool for an AVL Crew

To bring up a control tool for an AVL crew, complete these steps:

1. In the Viewer window, locate the AVL crew condition symbol.
2. In the Work Agenda window, select the row of the event you wish to associate with the AVL crew, if any.
3. Double-click on the AVL crew condition symbol to bring up the Control Tool.

The Control Tool window for an AVL crew contains the following buttons:

- The Assign button assigns the selected crew to the event indicated in the Event Info section of the Control Tool window.
Managing Calls with Trouble Management

As calls come in from customers reporting outages and other problems, they can be sent into the Oracle Utilities Network Management System or entered directly within Oracle Utilities Network Management System. Oracle Utilities Network Management System – Trouble Management analyzes the calls and applies a set of analysis rules. It then groups the calls based upon those rules and presents the information to you in terms of trouble events. Customers may also request to be called back as a customer service and to verify restoration.

This section displays the following topics:

• Changing Rule Sets
• Entering Trouble Calls
• Using the Trouble Information Window
• Viewing Call Information
• Emailing Customer Lists

Changing Rule Sets

Rule sets are a collection of analysis rules that Oracle Utilities Network Management System Trouble Management uses to determine how and when certain devices will be predicted out and how fast a prediction moves upstream. For example, a rule set might cause fuses to be predicted out if three or more service outages are predicted on downstream transformers. Meanwhile, circuit breakers might require five downstream device outages to cause an upstream prediction to them.

You can change the rule set for the control zone(s) you have authority over using the Authority window.

To change the rule set for a control zone, complete these steps:

1. Click the Authority button in the Environment Manager. The Authority window opens.
2. Select the row of the control zone you want to change.
3. Click the Change Rule Set… button. A dialog box opens.
4. In the Rule Sets available list, select the rule set you want to change to.
5. Click the OK button. The rule set for that control zone is updated. Oracle Utilities Network Management System Trouble Management will begin grouping and prioritizing new trouble calls in that control zone based on the new rule set.

Note: You can only change the rule set for one row at a time.
Managing Calls with Trouble Management

**Entering Trouble Calls**

Use the Trouble Call Entry window to enter trouble calls.

### Using the Trouble Call Entry Window

To access this window, click the **Misc Tools** button on the Environment Manager and then the **Trouble Call Entry** toggle button on the Misc Tools dialog. The Trouble Call Entry window displays the following fields and buttons:

- **The Call ID** field is used to enter the unique call identifier in order to recall previous calls.
- **Account #** contains the customer's account number.
- **Telephone** contains the customer's telephone number.
- **Name** contains the customer's name.
- **Address** contains the customer's address.
- **City** contains the customer's city, state, and zip code.
- **Customer Type** contains the customer's type value.
- **Customer Device** contains the name of the customer's service device.
- **Reported State Date** contains the date and time the problem began for the customer.
- **The Callback Requested** button designates whether or not the customer wants to receive a follow up call.
- **Customer Comment** is a text field for you to enter any further comments about the customer complaint.
- **The Event/Customer Info** field contains summary information for any known existing event that may be affecting that customer, including the event type and number of customers affected. The system automatically populates this field.
- **The Operations Event Note** field contains notes entered by operations staff, if any.
- **Estimated Restore Time** contains the date and time at which the event is estimated to be restored.

### Buttons

- **The Power** button displays the type of power problem reported by the customer (**e.g.**, Dim Lights), if any. When you click here, a drop-down list of power problems displays.
- **The Cause** button displays the potential cause of the problem reported by the customer (**e.g.**, Tree Limb on Wire), if any. When you click here, a drop-down list of causes displays.
- **The Description** button displays any additional descriptive clues as reported by the customer (**e.g.**, Sagging Wire). When you click here, a drop-down list of descriptions displays.
- **The Street Light** button displays any problem with street lighting (**e.g.**, Traffic Signal Out). When you click here, a drop-down list displays.
- **The Meter** button displays the action to take with the customer's meter (**e.g.**, Disconnect). When you click here, a drop-down displays.
- **The Meet** button indicates whether the crew is needed to meet the fire or police departments or an electrician. When you click here, a drop-down displays.
- **The Priority** button indicates if the trouble is high priority or life threatening. When you click here, a drop-down displays.
- **The Cancel Call** button allows you to cancel previous calls from the customer.
- **The Submit Call** button saves the currently displayed customer call and clears the fields.
• The **Search** button searches the database for the customer based on information you have entered in the Trouble Call Entry fields.

• The **Next** Customer button finds the next customer attached to the same device.

• The **Clear Form** button clears all the fields in the Trouble Call Entry window.

• The **Event History** button opens the Event History For dialog box, which displays information on previous events for the customer.

• The **Meet** button opens the Meet dialog, which allows you to enter an appointment for the customer.

• The **Print** button opens the Print dialog box to print the currently displayed customer call.

• The **Exit** button exits the Trouble Call Entry window.

### Entering a Trouble Call

To enter a trouble call, complete these steps:

1. Open the Trouble Call Entry window by clicking the **Misc Tools** button on the Environment Manager and then the **Trouble Call Entry** toggle button on the Misc Tools dialog.

2. Do one of the following:
   - Type the name of the customer in the **Name** field, or
   - Type the customer’s account number in the **Account #** field.

3. Click the **Search** button. The customer’s information populates the fields in the window.
   - If there are multiple customers with the same name, the Search Results window opens listing all of the customers that match the name you entered. Select the customer you are looking for and click **OK**.
   - If there are 4 or fewer customers with the same name, the Trouble Call Entry window will populate with the information for the first customer found. You can use the **Next Customer** button to navigate through the rest of the matches.
   - If there are over 100 customers that match the name you entered, a message box prompts you to enter more information.

4. Enter information about the complaint by selecting items from the Request drop-down menus.

5. If the customer would like to receive a follow-up call, click on the **Callback Requested** toggle.

6. Enter any customer comments in the Customer Comment field.

7. Click the **Submit Call** button. The fields clear and a dialog opens to display the unique identifier (Call ID) for the call just entered. Oracle Utilities Network Management System Trouble Management will either add the call to a current event or post a new event in the Work Agenda. It will also post the appropriate flags (e.g., probable service outage, broken pole, etc.) on the device in the Viewer.

### Entering Fuzzy Calls

Fuzzy calls are calls that are not initially associated with a device. For example, a fuzzy call results when you receive a call from the police reporting that a pole is down at a street intersection. When more information becomes available, you can associate a fuzzy call with a device. For information on associating a fuzzy call, see **Unassociating/Reassociating a Call from/to a Device** on page 2-12.

To enter a fuzzy call, complete these steps:
1. Open the Trouble Call Entry window by clicking the Misc Tools button on the Environment Manager and then the Trouble Call Entry toggle button on the Misc Tools dialog.

2. Clear all the fields by clicking the Clear Form button.

3. Enter the street name or intersection in the Address field.

4. Click the Search button. A Call Entry Message appears telling you there is no match for this address, but the call may be saved.

5. Click OK.

6. Enter information about the complaint by selecting items from the drop-down menus.

7. Click Submit Call. The fields clear and a dialog opens to display the unique identifier (Call ID) for the call just entered. A new event appears in the Trouble Events List of the Work Agenda with an unknown device type and the location you entered.

Meets

Meets are appointments to meet someone, usually at a specified date and time. For example, a customer may call up and request a voltage check at their home next Thursday at 9:00am. Meets may also be of a more immediate nature, such as the Fire Department calling up and requesting that someone come out immediately to disconnect power at a location for safety reasons.

This section includes the following topics:

- Using the Meets Dialog
- Creating a New Scheduled Meet
- Creating a New ASAP Meet
- Rescheduling a Meet
- Canceling a Meet

Using the Meets Dialog

To display the Meets dialog, click the Meets button on the Trouble Call Entry window. The Meets dialog displays the following fields and buttons:

- The Scheduled/ASAP buttons allow you to designate whether the meet should be a scheduled (future) meet or an ASAP (critical) meet.
- The Scheduled Date field allows you to specify the date of the scheduled meet.
- The Scheduled Time field allows you to specify the time of the scheduled meet.
- The New Meet button closes the Meet dialog and sends in a meet call for the customer.
- The Reschedule Meet button closes the Meet dialog and sends in a reschedule meet call for the customer.
- The Cancel Meet button closes the Meet dialog and sends in a cancel meet call for the customer.
- The Exit button closes the Meet dialog and returns you to the Trouble Call Entry window.

Creating a New Scheduled Meet

To create a scheduled (future) meet for a customer, complete these steps:

1. Complete all but the last step as described in the Entering a Trouble Call on page 2-51 section (do everything except click the Submit Call button).

2. Click the Meet button. The Meet dialog appears with the Scheduled button already selected.

3. Enter a date in the future into the Scheduled Date field.

4. Enter a time into the Scheduled Time field.
5. Click the **New Meet** button. The Meet dialog disappears. The fields clear in the Trouble Call Entry window and a dialog opens to display the unique identifier (Call ID) for the call just entered. Oracle Utilities Network Management System Trouble Management will post a new event in the Work Agenda with an **Evt Type** of “MEET”, a **Status** of “NEW”, and a **Start Date** consisting of the Scheduled Date and Time you specified. It will also post a future meet symbol on the device in the Viewer.

**Creating a New ASAP Meet**

To create an ASAP (critical) meet for a customer, complete these steps:

1. Complete all but the last step as described in the **Entering a Trouble Call** on page 2-51 section (do everything except click the **Submit Call** button).
2. Click the **Meet** button. The Meet dialog appears with the Scheduled button already selected.
3. Select the **ASAP** button. The Scheduled Date and Scheduled Time fields are disabled.
4. Click the **New Meet** button. The Meet dialog disappears. The fields clear in the Trouble Call Entry window and a dialog opens to display the unique identifier (Call ID) for the call just entered. Oracle Utilities Network Management System Trouble Management will post a new event in the Work Agenda with an **Evt Type** of “MEET”, a **Status** of “RED”, and a **Start Date** consisting of the current date and time. It will also post a critical meet symbol on the device in the Viewer, and a continuous audible alarm will sound every 3 seconds until the event is acknowledged in the Work Agenda. Acknowledging the critical meet changes its **Status** to “CRT”.

**Rescheduling a Meet**

To reschedule an existing meet for a customer, complete these steps:

1. Open the Trouble Call Entry window by clicking the **Misc Tools** button on the Environment Manager and then the **Trouble Call Entry** toggle button on the Misc Tools dialog.
2. Do one of the following:
   - Type the name of the customer in the **Name** field, or
   - Type the customer’s account number in the **Account #** field.
3. Click the **Search** button. The customer’s information populates the fields in the window.
4. Click the **Meet** button. The Meet dialog appears.
5. To reschedule the meet to a different scheduled date/time:
   - Enter a date in the future into the **Scheduled Date** field.
   - Enter a time into the **Scheduled Time** field.
6. To reschedule the meet to ASAP:
   - Select the **ASAP** button. The Scheduled Date and Scheduled Time fields are disabled.
7. Click the **Reschedule Meet** button. The Meet dialog disappears. The fields clear in the Trouble Call Entry window and a dialog opens to display the unique identifier (Call ID) for the call just entered. Oracle Utilities Network Management System Trouble Management will update the existing meet event in the Work Agenda with the appropriate **Start Date** value. If the meet was previously a future meet and is now ASAP, its **Status** will change to “RED”, its symbol will change to a critical meet symbol in the Viewer, and a continuous audible alarm will sound every 3 seconds until the event is acknowledged in the Work Agenda. If the meet was previously an ASAP meet and is now a future meet, its **Status** will change to “NEW”, and its symbol will change to a future meet symbol in the Viewer.

**Canceling a Meet**

To cancel an existing meet for a customer, complete these steps:
1. Do one of the following:
   • Type the name of the customer in the Name field, or
   • Type the customer's account number in the Account # field.

2. Click the Search button. The customer's information populates the fields in the window.

3. Click the Meet button. The Meet dialog appears.

4. Click the Cancel Meet button. The Meet dialog disappears. The fields clear in the Trouble Call Entry window and a dialog opens to display the unique identifier (Call ID) for the call just entered. Oracle Utilities Network Management System Trouble Management will update the existing meet event in the Work Agenda with a Status of “C-CNL”.

5. Select the “C-CNL” event row in the Work Agenda and click the Cancel button. The Cancel dialog appears.

6. Enter a reason in the Reason Text field, and then click the Ok button. The meet event's Status is now “CNL”, indicating that it has been canceled.

**Aging of Meets**

As a future meet nears its scheduled time, Oracle Utilities Network Management System Trouble Management will automatically turn the scheduled future meet into an ASAP critical meet. The threshold for this to occur is once the difference between the scheduled time and the current time is 20 minutes or less.

**Event History**

When you have a customer's information loaded in the Trouble Call Entry window, you may view their past outage event history by bringing up the Event History dialog.

**Displaying the Event History**

To bring up a customer's outage event history, press the Event History button. (If a customer doesn't have any outage event history, the system displays a message indicating that no event history exists.)

The Event History displays the following fields and buttons:

• At the upper-left hand corner of the dialog appears the customer's name.

• The Date/Time column contains the start date and time of the past event.

• The Dur (min) column contains the duration of the past event, in minutes.

• The Type column contains the Type drop-down menu option that was selected in the Event Details window for the past event.

• The Failure column contains the Failure drop-down menu option that was selected in the Event Details window for the past event.

• The Remedy column contains the Remedy drop-down menu option that was selected in the Event Details window for the past event.

• Both the OK and Cancel button close the Event History dialog.
Using the Trouble Information Window

Oracle Utilities Network Management System Trouble Management displays customer information about trouble events using the Trouble Information window. The Trouble Information window has three main views. The view that opens initially depends on from where you open the window.

This section includes the following topics:

- Trouble Information Views
- Callers View
- Customers View
- Critical Customer View
- Supply Points View
- Customers View

Trouble Information Views

The table below describes the various Trouble Information views.

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Callers</td>
<td>Lists all calls associated with an event.</td>
</tr>
<tr>
<td>Customers</td>
<td>Lists all the customers: located on/downstream from a given device, when accessed via the Control Tool affected by a given event, when accessed via the Trouble Event Lists affected on a given device, when accessed via Trouble Summaries</td>
</tr>
<tr>
<td>Critical Customer</td>
<td>Lists all of the customers designated as critical that are affected in a given control zone/on a given device, when accessed via Trouble Summaries</td>
</tr>
</tbody>
</table>

Callers View

The Callers view lists all calls associated with an event.

Callers View topics include:

- Displaying the Callers View
- Moving a Customer to a Different Device
- Ungrouping Calls

Displaying the Callers View

To open the Callers view by selecting an event in the Trouble Events List (in the Work Agenda window) and clicking the Info... button. The Callers View displays the following fields and buttons:

- The Event # field displays the number assigned to the event by the system.
- The list title displays how many calls the event has, as well as how many calls are still active and how many have been restored.
- The Updated field displays the date and time at which the Callers view was last populated, as this list is not dynamically updated.
- The Feeder field displays the feeder on which the affected device resides.
- The Device field displays the name of the device associated with the event.
- The Device Type field displays the type of device associated with the event.
Managing Calls with Trouble Management

- The **Customer Comment** field displays any customer comments that were entered by the call taker for the selected call.
- The **Sort/Filter** identifiers display which sort and/or filter is applied to the view.
- The **Clues** column displays the trouble code clues received for the call.
- The **Device** column displays the name of the customer's service device.
- The **Name** column displays the customer's name.
- The **Telephone** column displays the customer's telephone number.
- The **Date** column displays the date and time of the customer's call.
- The **Crit** column displays the customer type value of the customer.
- The **CMT** column displays “Y” if the call contains customer comments and “N” if it does not.
- The **Address** column displays the customer's address.
- The **Account #** column displays the customer's account number.
- The **Meter #** column displays the customer's meter number.
- The **Active** column indicates whether or not customer is considered to still be actively out (Y) or restored (N).
- The **Grp** column indicates whether the event is to be manually ungrouped. The possible types are:
  - TBU
  - N/A
- The **Customers** button changes the Trouble Information window to the Customer View.
- The **Customers** button changes the Trouble Information window to the Customer View.
- The **Supply Points** button changes the Trouble Information window to the Supply Points View.
- The **Call Info…** button opens the Call Information window for the selected call.
- The **Move Customer…** button opens the Move Customer dialog box, allowing you to move a customer to a new device.
- The **Exit** button closes the Trouble Information window.

**Menus**

The File, Sort, and Filter menus are similar to other menus in Oracle Utilities Network Management System. For detailed information on these menus, see *Getting Started With Operator's Workspace* on page 1-1.
The following table describes the options available on the Callers view Actions menu.

<table>
<thead>
<tr>
<th>Action Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Info...</td>
<td>Opens the Call Information window for the selected call.</td>
</tr>
<tr>
<td>Customers</td>
<td>Changes the Trouble Information window to the Customers View.</td>
</tr>
<tr>
<td>Supply Points</td>
<td>Changes the Trouble Information window to the Supply Points View.</td>
</tr>
<tr>
<td>Customers</td>
<td>Changes the Trouble Information window to the Customers View.</td>
</tr>
<tr>
<td>Ungroup</td>
<td>Opens the Ungroup dialog box, allowing you to ungroup calls from the event.</td>
</tr>
<tr>
<td>Unassociate</td>
<td>Opens the Unassociate dialog box, allowing you to unassociate calls from their device and (optionally) associate them with a new device.</td>
</tr>
<tr>
<td>Move Customer...</td>
<td>Opens the Move Customer dialog box, allowing you to move a customer to a new device.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Trouble Information window.</td>
</tr>
</tbody>
</table>

**Moving a Customer to a Different Device**

You can move a customer to a different device if you discover the customer is associated with an incorrect device.

To move a customer to a different device, complete these steps:

1. Locate the device you want to move the customer to in the Viewer window.
2. Select the event row in the Trouble Events list (in the Work Agenda window) for the customer you want to move.
3. Click the **Info...** button. The Trouble Info window opens in the Callers View.
4. Select a caller row in the list of callers that corresponds with the customer you want to move.
5. Either click the **Move Customer...** button or select **Move Customer...** from the Actions menu. A dialog box opens displaying the name, address, and device information for the customer.
6. Go back to the Viewer window and click on the device you want to move the customer to. The identification of the new device appears in the New Device field in the Move Customer dialog box.
7. Click **OK**. Although the map does not reflect the change, the system considers the customer as served by the new device, and the customer’s call is re-analyzed by the Trouble Analysis engine using the new device information.

**Note:** Moving a customer to a new device is a temporary change since Oracle Utilities Network Management System Trouble Management does not directly modify the customer information. However, Oracle Utilities Network Management System Trouble Management will track the change and successive calls for that customer will be associated with the new device. Your technical department must make permanent changes to the customer information.
Ungrouping Calls

You can ungroup calls that were automatically grouped by the system as a result of trouble analysis rules. For example, you would ungroup a call from an event that is not actually related to the event, but rather should be its own non-groupable event.

To ungroup calls, complete these steps:

1. Select the event row in the Trouble Events list (in the Work Agenda window) you want to ungroup and click the Info… button. The Trouble Information window opens.
2. Select the row(s) in the Trouble Info window for the call(s) you want to ungroup.
3. Select Ungroup from the Actions menu. The Ungroup dialog box opens.
4. Click OK.

- In the Work Agenda, the calls are ungrouped and a new event row appears in the Trouble Events list with the appropriate device association.
- In the Work Agenda, the ungrouped calls are removed from the # Calls column for the event they were ungrouped from.

Note: Events that are manually ungrouped will not be automatically grouped again by the system. However, you can manually group them again.

Customers View

Depending upon where it’s accessed from, the Customers view lists all the customers located on/downstream from a given device, affected by a given event, or affected on a given device.

To open this view, click on the Customers button in the Callers view. The Customers View displays the following fields and buttons:

- The Event # field displays the number assigned to the event by the system.
- The list title displays either how many customers are located on/downstream from a given device, affected by a given event, or affected on a given device, depending upon from where the view is accessed.
- The Updated field displays the date and time at which the Customers view was last populated, as this list is not dynamically updated.
- The Feeder field displays the feeder on which the associated device resides.
- The Device field displays the name of the associated device.
- The Device Type field displays the type of the associated device.
- The Customer Comment field displays any customer comments that were entered by the call taker for the selected customer, if any.
- The Sort/Filter identifiers display which sort and/or filter is applied to the view.
- The Clues column displays the trouble code clues received for the customer’s call, if any.
- The Device column displays the name of the customer’s service device.
- The Name column displays the customer's name.
- The Telephone column displays the customer’s telephone number.
- The Date column displays the date and time of the customer's call, if any.
- The Crit column displays the customer type value of the customer.
- The CMT column displays “Y” if the call contains customer comments and “N” if it does not.
- The # Calls column displays how many times a customer has called for the event.
Managing Calls with Trouble Management

• The **Address** column displays the customer's address.
• The **Account #** column displays the customer's account number.
• The **Meter #** column displays the customer's meter number.
• The **Callers** button changes the Trouble Information window to the Callers View.
• The **Supply Points** button changes the Trouble Information window to the Supply Points View.
• The **Customers** button changes the Trouble Information window to the Customers View.
• The **Call Info…** button opens the Call Information window for the selected customer, if they have called in.
• The **Email** button opens the Email dialog, which allows you to email the list of customers currently displayed in the Customers View.
• The **Exit** button closes the Trouble Information window.

**Critical Customer View**

The Critical Customer view lists all of the customers designated as critical that are affected in a given control zone/on a given device.

To open the Critical Customer view, click on the **Show Crit Cust…** button in the Trouble Summaries window. The Critical Customer view displays the following fields and buttons:

• The **Event #** field displays the number assigned to the event by the system.
• The list title displays either how many critical customers are affected in a given control zone or on a given device, depending upon from where the view is accessed.
• The **Updated** field displays the date and time at which the Critical Customer view was last populated, as this list is not dynamically updated.
• The **Feeder** field displays the feeder on which the associated device resides.
• The **Device** field displays the name of the associated device.
• The **Device Type** field displays the type of the associated device.
• The **Customer Comment** field displays any customer comments that were entered by the call taker for the selected customer, if any.
• The Sort/Filter identifiers display which sort and/or filter is applied to the view.
• The **Clues** column displays the trouble code clues received for the customer's call, if any.
• The **Device** column displays the name of the customer's service device.
• The **Name** column displays the customer's name.
• The **Telephone** column displays the customer's telephone number.
• The **Date** column displays the date and time of the customer's call, if any.
• The **Crit** column displays the customer type value of the customer.
• The **CMT** column displays “Y” if the call contains customer comments and “N” if it does not.
• The **# Calls** column displays how many times a customer has called for their current event.
• The **Address** column displays the customer's address.
• The **Account #** column displays the customer's account number.
• The **Meter #** column displays the customer's meter number.
• The Call Info… button opens the Call Information window for the selected customer, if they have called in.
• The Exit button closes the Trouble Information window.

Supply Points View
Depending upon where it’s accessed from, the Supply Points view lists all of the supply Points located downstream from a given device, or all of the supply points associated with a given event.

To open this view, click the Supply Points button in the Callers or Customers view. The Supply Points View displays the following fields:
• The Event # field displays the number assigned to the event by the system.
• The list title displays how many supply points the event has.
• The Feeder field displays the feeder on which the affected device resides.
• The Device field displays the name of the device associated with the event.
• The Device Type field displays the type of device associated with the event.
• The Device column displays the name of the customer’s service device.
• The # Customers column displays the sum of all customers attached to the supply point.
• The # KEY column displays the sum of all KEY customers attached to the supply point.
• The # EMR column displays the sum of all EMR customers attached to the supply point.
• The # MED column displays the sum of all MED customers attached to the supply point.
• The # Crit Tot column displays the sum of all critical customers attached to the supply point.
• The Control Zone column displays the supply point’s control zone name.
• The # Calls column displays the sum of all calls entered for the event from the supply point.
• The Grp column displays the pending action for the row:
  • TBG – To Be Grouped
  • TBU – To Be Ungrouped
  • FAIL – Action failed

See Graphical Grouping on page 2-11 for more information.

Customers View
Depending upon where it’s accessed from, the Customers view lists all the -enabled meters located on/downstream from a given device or affected by a given event.

To open this view, click on the Customers button in the Callers or Customers view. The Customers View displays the following fields and buttons:
• The Event # field displays the number assigned to the event by the system.
• The list title displays either how many Customers are located on/downstream from a given device, affected by a given event, or affected on a given device, depending upon from where the view is accessed.
• The Updated field displays the date and time at which the Customers view was last populated, as this list is not dynamically updated.
• The Feeder field displays the feeder on which the associated device resides.
• The Device field displays the name of the associated device.
• The Device Type field displays the type of the associated device.
• The Customer Comment field displays any customer comments that were entered by the call taker for the selected customer, if any.
• The Sort/Filter identifiers display which sort and/or filter is applied to the view.
• The Clues column displays the trouble code clues received for the customer's call, if any.
• The Device column displays the name of the customer’s service device.
• The Phases column displays the phases of the customer’s service device.
• The Name column displays the customer's name.
• The Telephone column displays the customer's telephone number.
• The Date column displays the date and time of the customer's call, if any.
• The Crit column displays the customer type value of the customer.
• The CMT column displays “Y” if the call contains customer comments and “N” if it does not.
• The # Calls column displays how many times a customer has called for the event.
• The Address column displays the customer's address.
• The Account # column displays the customer’s account number.
• The Meter # column displays the customer’s meter number.
• The Request # column displays the index of the last ping request.
• The Request Date column displays the date of the last ping request.
• The Completed By column displays the login name of the user who completed the last ping request.
• The Received Date column displays the date of the last reading.
• The Probability column displays the probability percentage from the last reading.
• The Status column displays the ON/OFF response from the last reading.
• The Customers button changes the Trouble Information window to the Customers View.
• The Callers button changes the Trouble Information window to the Callers View.
• The Call Info… button opens the Call Information window for the selected customer, if they have called in.
• The Confirm button initiates a ping request for the selected meters.
• The Update button refreshes the table with the latest response information.
• The Exit button closes the Trouble Information window.

See Requests on page 2-26 for more information.

Viewing Call Information

Information about logged calls is displayed in the Call Information window. This window replaces the paper tickets previously used to track outages. An event (represented by a single row in the Trouble Events list of the Work Agenda) can have multiple calls if calls have been grouped to one event. The Call Information window may be accessed either from the Trouble Information window or the Dispatch Information window. You cannot edit the fields in the Call Information window; they are for display only.
Using the Call Information Window

To open the Call Information window from the Trouble Information window, select the row of the call you want to display and then click on the Call Info… button or select Call Info… from the Actions menu.

To open the Call Information window from the Dispatch Information window, select the row of the call you want to display and click on the Call Info… button.

The Call Information window displays the following fields and buttons:

- **Account #** displays the customer's account number.
- **Event Status** displays the current status of the event that this call is a part of.
- **Telephone** displays the customer's phone number.
- **Event #** displays the number assigned to the event by the system.
- **Name** displays the customer's name.
- **Clues** displays the short description representation of the Request drop-down menu selections that were entered in the Trouble Call Entry window when the call was logged.
- **Address** displays the customer's address.
- **Reported Start Date** displays the date and time the problem began for the customer.
- **City** displays the customer's city, state and zip code.
- **Call Taker ID** displays the user name of the person who entered the call.
- **Customer Type** displays the customer type value for the customer.
- **Crew ID** displays the name of the crew that has been dispatched to the event, if any.
- **Customer Device** displays the name of the customer's service device.
- **Callback Date** displays the date and time by which the customer has requested a follow up call.
- **Zone(s)** displays the control zone(s) the customer is located in.
- **Customer Comment** displays any customer comments that were entered at the time the call was logged.

**Buttons**

- The **Print** button opens the Print dialog box to print the currently displayed customer call information.
- The **Exit** button exits the Call Information window.

Emailing Customer Lists

The Email dialog allows you to email the list of customers from the Trouble Information Customers View to designated recipients. The recipient(s) will receive an email message with an attached CSV file containing the current contents of the Trouble Information Customers table. You may also add other file attachments to the email message.

**Opening the Email Dialog**

To open the Email dialog, click on the Email button on the Customers view.

**Sending an Email**

To email the contents of the Trouble Information Customers table, complete these steps:

1. Select the Email button on the Customers View. The Email dialog appears.
Viewing Trouble Summaries

The Trouble Summaries window displays the current event information grouped according to control zone level from company to device.

To access the Trouble Summaries window, click the Summaries toolbox on the Environment Manager, then clicking Trouble Summaries. The following summaries are available:

- **Company Summary**
- **Region Summary**
- **Branch Summary**
- **Substation Summary**
- **Feeder Summary Window**

The data displayed at each level gives you a summary of the event information in a specific area. The buttons on the bottom of the Trouble Summaries window change depending on the control zone level you are viewing. The table on the Trouble Summaries window displays information relating to the summary level that you have selected. Many of the columns are the same from one level to another (e.g., the same columns display for the Company, Region, and Branch). The SUM row in the Company, Region, and Branch summaries displays the total numbers for each column in the table.

Company Summary

The Company Summary provides information about each region within the utility with active events. If you want to view additional detail on a particular region, you can select the row for the region and click the Region Summary button or double-click on the row for the region to view the Region Summary.

The Company Summary window displays the following fields and buttons:

- The Last Update field displays the date and time at which the Company Summary was last refreshed.
- The Region column contains the name of the region within the company level.
- The Est Rest Time column contains the latest date and time of estimated restoration in the region.
- The Fdrs Out column contains the number of feeders in the region that are considered out of service. Specifically, this is the number of events in the region where the device class of the probable/confirmed outage device is circuit.
- The # Calls column contains the number of customers in the region that have called.
- The # Out column contains the number of customers in the region experiencing an outage.
- The # of Device Outages column contains the total number of device outages in the region.
Viewing Trouble Summaries

- The **# of Service Outages** column contains the total number of service outages in the region.
- The **# Not Dispatched** column contains the total number of events in the region that do not have crews dispatched.
- The **# Crit** column contains the number of critical customers in the region experiencing an outage.

**Buttons**

- The **Region Summary** button displays the Region Summary information for the selected region.
- The **Show Crit Cust…** button opens the Trouble Information Critical Customer view, which either displays all affected critical customers in the Company if no row was selected when the button is pressed, or displays the critical customers affected for the selected region if a region row is selected when the button is pressed.
- The **Refresh** button updates the data displayed in the Company Summary. The information in the table is not dynamically updated. The date and time that the information was last updated is shown above the table in the Last Update field.
- The **Exit** button closes the Company Summary window.

**Region Summary**

The Region Summary provides information about each branch within a selected region with active events. If you want to view additional detail on a particular branch, you can select the row for the branch and click the **Branch Summary** button or double-click on the row for the branch to view the Branch Summary.

The Region Summary displays the following fields and buttons:

- The **Last Update** field displays the date and time at which the Region Summary was last refreshed.
- The **Branch** column contains the name of the branch within the region.
- The **Est Rest Time** column contains the latest date and time of estimated restoration in the branch.
- The **Fdrs Out** column contains the number of feeders in the branch that are considered out of service. Specifically, this is the number of events in the branch where the device class of the probable/confirmed outage device is circuit.
- The **# Calls** column contains the number of customers in the branch that have called.
- The **# Out** column contains the number of customers in the branch experiencing an outage.
- The **# of Device Outages** column contains the total number of device outages in the branch.
- The **# of Service Outages** column contains the total number of service outages in the branch.
- The **# Not Dispatched** column contains the total number of events in the branch that do not have crews dispatched.
- The **# Crit** column contains the number of critical customers in the branch experiencing an outage.
- The **Branch Summary** button displays the Branch Summary information for the selected branch.
- The **Show Crit Cust…** button opens the Trouble Information Critical Customer view, which either displays all affected critical customers in the region if no row was selected when the
button is pressed, or displays the critical customers affected for the selected branch if a branch row is selected when the button is pressed.

- The **Refresh** button updates the data displayed in the Region Summary. The information in the table is not dynamically updated. The date and time that the information was last updated is shown above the table in the Last Update field.
- The **Exit** button closes the Region Summary window.

### Branch Summary

The Branch Summary provides information about each substation within a selected branch with active events. If you want to view additional detail on a particular substation, you can select the row for the branch and click the **Substation Summary** button or double-click on the substation row to view the Substation Summary.

The Branch Summary displays the following fields and buttons:

- The **Last Update** field displays the date and time at which the Branch Summary was last refreshed.
- The **Substation** column contains the name of the substation within the branch.
- The **Est Rest Time** column contains the latest date and time of estimated restoration in the substation.
- The **Fdrs Out** column contains the number of feeders in the substation that are considered out of service. Specifically, this is the number of events in the substation where the device class of the probable/confirmed outage device is circuit.
- The **# Calls** column contains the number of customers in the substation that have called.
- The **# Out** column contains the number of customers in the substation experiencing an outage.
- The **# of Device Outages** column contains the total number of device outages in the substation.
- The **# of Service Outages** column contains the total number of service outages in the substation.
- The **# Not Dispatched** column contains the total number of events in the substation that do not have crews dispatched.
- The **# Crit** column contains the number of critical customers in the substation experiencing an outage.
- The **Substation Summary** button displays the Substation Summary information for the selected substation.
- The **Show Crit Cust…** button opens the Trouble Information Critical Customer view, which either displays all affected critical customers in the branch if no row was selected when the button is pressed, or displays the critical customers affected for the selected substation if a substation row is selected when the button is pressed.
- The **Refresh** button updates the data displayed in the Branch Summary. The information in the table is not dynamically updated. The date and time that the information was last updated is shown above the table in the Last Update field.
- The **Exit** button closes the Branch Summary window.

### Substation Summary

The Substation Summary provides information about each feeder served by a selected substation with active events. If you want to view additional detail on a particular feeder, you can select the
row for the branch and click the **Feeder Summary** button or double-click the feeder row to view the Feeder Summary.

The Substation Summary displays the following fields and buttons:

- The **Last Update** field displays the date and time at which the Substation Summary was last refreshed.
- The **Feeder** column contains the name of the feeder within the substation.
- The **# Calls** column contains the number of customers on the feeder that have called.
- The **# Out** column contains the number of customers on the feeder experiencing an outage.
- The **# of Device Outages** column contains the total number of device outages on the feeder.
- The **# Not Dispatched** column contains the total number of events on the feeder that do not have crews dispatched.
- The **# Crit** column contains the number of critical customers on the feeder experiencing an outage.
- The **First Call Date** column contains the date and time of first event on the feeder.
- The **Feeder Summary** button displays the Feeder Summary information for the selected feeder.
- The **Show Crit Cust…** button opens the Trouble Information Critical Customer view, which either displays all affected critical customers in the substation if no row was selected when the button is pressed, or displays the critical customers affected for the selected feeder if a feeder row is selected when the button is pressed.
- The **Refresh** button updates the data displayed in the Substation Summary. The information in the table is not dynamically updated. The date and time that the information was last updated is shown above the table in the Last Update field.
- The **Exit** button closes the Substation Summary window.

### Feeder Summary Window

The Feeder Summary provides information about each device with active events within a selected feeder. It also displays a summary row for the feeder. If you want to view additional affected customer information for particular feeder or device, you can select the row for the feeder/device and click the **Customer Summary** button or double-click on the row to view the Customer Summary on the Trouble Info window.

The Feeder Summary displays the following fields and buttons:

- The **Last Update** field displays the date and time at which the Feeder Summary was last refreshed.
- The **Feeder/Device** column contains the name of the feeder or device on the feeder.
- The **# Calls** column contains the number of customers on the feeder/device that have called.
- The **# Out** column contains the number of customers on the feeder/device experiencing an outage.
- The **# of Device Outages** column contains the total number of device outages on the feeder/device.
- The **# of Service Outages** column contains the total number of service outages on the feeder/device.
• The **# Not Dispatched** column contains the total number of events on the feeder/device that do not have crews dispatched.

• The **# Crit** column contains the number of critical customers on the feeder/device experiencing an outage.

• The **First Call Date** column contains the date and time of first event on the feeder/device.

• The **Customer Summary** button opens the Trouble Information Customers view, which displays information about the customers on the selected feeder/device.

• The **Show Crit Cust** button opens the Trouble Information Critical Customer view, which either displays all affected critical customers on the feeder if no row was selected or a feeder row is selected when the button is pressed, or displays all affected critical customers on the device if a device row is selected when the button is pressed.

• The **Refresh** button updates the data displayed in the Feeder Summary. The information in the table is not dynamically updated. The date and time that the information was last updated is shown above the table in the Last Update field.

• The **Exit** button closes the Feeder Summary window.
This chapter describes how to manage changes to your system data model.

**Note:** For complete information about configuring, validating, and testing the data model, see “Building the System Data Model” in the Oracle Utilities Network Management System Configuration Guide.

This chapter includes the following topics:

- **Overview**
- **Logging In**
- **Using the Model Management Window**
- **Model Management Actions**

## Overview

Model Management is a tool for managing changes to your system model. The process of extracting updates from the GIS and updating the model is unique for each company. Typically, model updates are handled by a set of scripts that run automatically on a regular schedule. If there are problems in the update process, the model administrator can use the Model Management tool to identify and resolve the problems and then re-apply the model updates.

The following describes the model update process and introduces several terms that are used in this chapter:

- **GIS Data Extraction** is the customer-specific process by which data is extracted from the GIS to Oracle’s vendor-neutral model preprocessor (MP) file format.
- MP files must be **preprocessed** before they can be built into the model. Preprocessing converts the MP files into the .mb file format required by the Model Builder.
- A set of transactions (.mb files), collectively referred to as a **patch**, are submitted to the Model Builder for processing. Patches are applied to or built into the core operations model.
- The **Model Builder (MBService)** processes the .mb files, saves the information into the Oracle Utilities Network Management System Operations Model RDBMS, and writes out a set of **maps**, which are used by the Viewer to display portions of the system model.
- If any problems arise during preprocessing or model building, you can use the Model Management tool to perform the following tasks:
  - Identify maps that need to be built (referred to as pending maps)
  - View a list of recent patches and their statuses
  - Display all patches that were applied to a particular map
To log in to Model Management, complete these steps:

1. Depending on how your system was installed, do one of the following:
   - Click the **Model Management** icon found under the appropriate program group in your Windows Start Menu.
   - Double-click the **Model Management** icon on your desktop.
   - Open a web browser and type the Model Management URL in the browser’s address field.

   The Model Management Login window displays.

2. Enter your user name in the User Name field.

3. Enter your password in the Password field.

4. Click the **Validate** button. The bottom portion of the Login window sensitizes.

5. Select the appropriate User Type from the drop-down menu.

6. Click the **Login** button. Upon successful login, the Model Management window opens.
Using the Model Management Window

The Model Management window displays the following information:

- Pending Map Section
- Patches Section
- Menu and Toolbar Options
- Status Bar

Model Management actions include:

- Displaying the Map History
- Displaying the Preprocessor Log
- Deleting a Pending Map
- Building Maps
- Rebuilding a Patch
- Displaying the Patch Build Log
- Displaying the Patch Build Report
- Enabling and Disabling Model Building

Pending Map Section

The Pending Maps section lists all maps that need to be built. This section displays the following columns:

- **Map Name** displays the name of the model map.
- The **Pending Actions** column displays one of the following:
  - **To be preprocessed**: The updates have not been preprocessed. Updates must be preprocessed into .mb files before they can be built into the model.
  - **To be committed**: The updates were preprocessed into .mb files, but have not been committed (built into the model).
- The **Last Build Status** displays the status of the last attempt to build the map. Statuses are:
  - **New**: No attempt has yet been made to complete the pending action.
  - **Failed submit**: The patch was submitted to the Model Builder but the map could not be built. See Rebuilding a Patch on page 3-6 for details on correcting this problem.
  - **Failed commit**: The patch was submitted to the Model Builder but the map could not be committed due to a dynamic data error. See Rebuilding a Patch on page 3-6 for details on correcting this problem.
  - **In progress**: The pending action is currently in progress.

Patches Section

The Patches section lists all patches for the last 24 hours. To see patches for another time period, change the beginning and ending dates above the list as desired, then click the **Refresh** button.

The Patches section displays the following columns:

- The **Patch** column displays the patch number. The system assigns a number to a patch when it is submitted.
Using the Model Management Window

- **Map Name(s)** displays the name of the model map(s).
- **Creation Date** displays the date the patch was created.
- **Commit Date** displays the date the patch was submitted to the Model Builder.
- **Build Status** displays the status of the patch submission. Statues are:
  - **Successful** - The patch was successfully applied and the model was updated.
  - **Failed Submit** - The patch was submitted to the Model Builder, but the map could not be built. See **Rebuilding a Patch** on page 3-6 for details on correcting this problem.
  - **Failed commit** - The patch was submitted to the Model Builder, but the map could not be committed due to a dynamic data error. See **Rebuilding a Patch** on page 3-6 for details on correcting this problem.
  - **In Progress** - The patch is currently being processed by the Model Builder. The map file(s) are either being parsed, being applied, or being committed to the database.

Menu and Toolbar Options

The Model Management menu bar provides access to commonly used functions. Most of the functions in the Actions menu are also available on the toolbar. The toolbar icon is shown next to the menu option in the following list.

- **File Menu**
  - ![Print](print_icon) **Print** - Lets you print the contents of the Model Management window.
  - ![Exit](exit_icon) **Exit** - Closes the Model Management window and exits the application.

- **Actions Menu**
  - ![Refresh](refresh_icon) **Refresh** - Refreshes both the Pending Maps and Patches lists.
  - ![Halt Model Build](halt_icon) **Halt Model Build** - Stops all model build activity. See **Enabling and Disabling Model Building** on page 3-7 for more information.
  - ![Enable Model Build](enable_icon) **Enable Model Build** - Enables model building activity that was previously halted.
  - **Run Full Model Build** - Rebuilds the entire system model, not just individual maps.
  - ![Run Post Process](post_process_icon) **Run Post Process** - Runs the post-processing script. Post processing takes place after maps are built. The default post-processing script performs a recompute and recache of the control zones in DDSERVICE, but this can be modified to perform various tasks, such as generating control zones or computing EE details from the model.
  - ![Enable Model Build Reporting](report_icon) **Enable Model Build Reporting** - Enables or disables model build reporting. The Model Build Report lists all objects that were modified when a particular patch was applied. If enabled, a checkmark appears next to the menu option.
  - ![Build Map](build_icon) **Build Map** - Prompts you to enter one or more map names and then rebuilds the specified maps. If you are entering multiple map names, separate names with spaces, as shown below:

```
Landbase_49132336 Primary_49132336
```
Status Bar

The status bar displays the following information:

- **Maps to Build** - The total number of maps that need to be built. These maps are displayed in the Pending Maps section of the screen.
- **Failed Map** - The total number of maps that could not be built (were submitted and failed).
- **Model Build Status**:
  - **Enabled** - Model building is currently enabled. To disable, choose ⏹️ Halt Model Build.
  - **Halted** - Model building has been halted. To re-enable, choose 🎁 Enable Model Build.
  - **In Progress** - A model build is currently in progress.

Model Management Actions

You can perform the following actions from the Model Management window:

- Displaying the Map History
- Displaying the Preprocessor Log
- Deleting a Pending Map
- Building Maps
- Rebuilding a Patch
- Displaying the Patch Build Log
- Displaying the Patch Build Report
- Enabling and Disabling Model Building

Displaying the Map History

To view a list of all patches that affect a particular map, follow these steps:

1. Select a map from the Pending Maps list on the Model Management window.
2. Right-click and select **Map History** from the pop-up menu. The Map History dialog opens. The columns on this dialog match the columns in the Patches list on the Model Management window.
3. Filter the list as desired by typing the target text in the filter boxes at the top of each column.
4. To take action on an item in the list, right-click the item and then select one of the following options from the pop-up menu:
   - **Rebuild Patch**
   - **Patch Build Log**
   - **Patch Build Report**
Displaying the Preprocessor Log

The preprocessor log displays information and warnings generated during preprocessing. Follow these steps to display the preprocessor log file associated with a map:

1. Select a map from the Pending Maps list on the Model Management window.
2. Right-click and select Preprocessor Log from the pop-up menu. The preprocessor log opens.

Deleting a Pending Map

You can delete a pending map if you do not want the map to be rebuilt. Follow these steps:

1. Select the map you want to delete from the Pending Maps list on the Model Management window.
2. Right-click and select Delete from the pop-up menu. A confirmation window appears.
3. Click Yes to confirm deletion.
4. Click the Refresh button on the toolbar. The map is removed from the Pending Maps list.

Building Maps

To build one or more pending maps, follow these steps:

1. Select the map you want to build from the Pending Maps list on the Model Management window.
2. Right-click and select Build Map(s) from the pop-up menu. The system builds the selected map and displays the results in the Result dialog.
3. Review the results and then click Close.
4. Click the Refresh button on the toolbar. If the build was successful, the map is removed from the Pending Maps list and a new row is displayed in the Patches list for this map.

Rebuilding a Patch

To rebuild a patch, follow these steps:

1. Select a patch from the Patches list on the Model Management window.
2. Right-click and select Rebuild Patch from the pop-up menu. The results of the rebuild process are displayed in the Results dialog.
3. Review the results, and then click Close.
4. Click the Refresh button on the toolbar. A new row is displayed in the Patches list for this patch.

Displaying the Patch Build Log

The Patch Build Log displays information and warnings generated during the build process. To display the log for a specific a patch build, follow these steps:

1. Select a patch from the Patches list on the Model Management window.
2. Right-click and select Patch Build Log... from the pop-up menu. The log entries are displayed in the Patch Build Log dialog.
3. Click Close to exit.
Displaying the Patch Build Report

The Patch Build Report contains a list of all objects that were modified when a particular patch was built.

**Note:** The Patch Build Report is only generated if Model Build Reporting is enabled at the time the patch was built. Use the **Enable Model Build Reporting** option on the Actions menu to enable or disable Model Build Reporting.

To display the build report associated with a patch, follow these steps:

1. Select a patch from the Patches list on the Model Management window.
2. Right-click and select **Patch Build Report...** from the pop-up menu. The Patch Build Report dialog is displayed.
3. Review the report, and then click **Close**.

Enabling and Disabling Model Building

You can temporarily suspend all model building activity if needed. This is useful if, for example, a major storm causes widespread outages. By halting model builds, you can lighten the load on the system while it manages the outages. When storm damage has been repaired, you can resume model building.

To stop model building, select **Halt Model Build** from the Actions menu or click the toolbar icon.

To resume model building, select **Enable Model Build** from the Actions menu or click the toolbar icon.
Oracle Utilities Network Management System – Configuration Assistant provides a graphical view of the Oracle Utilities Network Management System configuration options and allows the user to add, edit, and store configuration changes.

This chapter includes the following topics:

• Getting Started with the Configuration Assistant
• Using the Configuration Assistant Window
• User Administration Tab
• Event Management Rules Tab
• Event Details Options Tab
• Work Agenda Predefined Filters Tab
• Default Restoration Times Tab

Getting Started with the Configuration Assistant

This section includes the following topics:

• Accessing Configuration Assistant
• Logging In

Accessing Configuration Assistant

Configuration Assistant is accessed using a URL (web address) or as a local application, depending on your site’s policy. Your system administrator determines the web address, if applicable. If accessing Configuration Assistant from a browser, complete these steps:

• Open your web browser by clicking the shortcut on the desktop, or from the Start menu.
• In the Address field of the browser, enter the URL for Configuration Assistant, then press Enter. Please wait while Configuration Assistant starts.
• If this is the first time running an Oracle Utilities Network Management System Windows-based product on your PC, you may be prompted to do a one-time download of a Java plug-in. If so, select Yes/Accept/Agree on all subsequent dialogs until Configuration Assistant opens.

Note: You or your system administrator can add Configuration Assistant to your Start menu and/or create a shortcut icon on your desktop for quick access to Configuration Assistant. When you start up Configuration Assistant for the
Using the Configuration Assistant Window

first time, it will (depending on installation method) ask if you want to install a shortcut in your Start menu and on your desktop.

Logging In

The Login window is the first Configuration Assistant window you see. You must enter a valid user name and password, and then click the Login button. Once your user name and password are validated, the main Configuration Assistant window opens.

To log in to Configuration Assistant, complete these steps:

1. Depending on how your system was installed, either:
   • Click the Configuration Assistant icon found under the appropriate program group in your Windows Start Menu, or
   • Double click the Configuration Assistant icon on your desktop, or
   • Open a web browser and type the Configuration Assistant URL in the browser's Address field. The Configuration Assistant Login window displays.

2. Enter your User ID. This is the user name provided to you by the system administrator.

3. Enter your Password.

4. Click the Validate button. The bottom portion of the Configuration Assistant Login window sensitizes.

5. Select the appropriate User Type. This drop-down menu contains the list of user types within your authority.

6. Click the Login button. The appropriate Configuration Assistant window opens, based upon the User Type selected.

Using the Configuration Assistant Window

This section describes the menus, toolbar options, and tabs that are available from the Configuration Assistant window. Topics include:

• Configuration Assistant Menus
• Toolbar
• User Administration Tab
• Event Management Rules Tab
• Event Details Options Tab
• Work Agenda Predefined Filters Tab
• Default Restoration Times Tab

Configuration Assistant Menus

The Configuration Assistant menu bar provides access to all functions. There are two menus on the Configuration Assistant menu bar:

• File Menu
• Action Menu
• Help Menu
Using the Configuration Assistant Window

File Menu

- **Export Configuration...** - Generates SQL statements for the current state of the configuration associated with every tab on the application. Once generated, the SQL statements are displayed in a window with options to save or print the information.

- **Print Preview** - Opens the Print Preview dialog, which allows you to print out the User Administration tab, Event Management Rules tab, Event Details Options tab, and Work Agenda Predefined Filter tab information from the current Configuration Assistant window.

- **Exit** - Closes the Configuration Assistant window.

Action Menu

- **Create Client Installer...** - Launches the client installer application. See the Oracle Utilities Network Management System Installation Guide for details.

Help Menu

- **Configuration Assistant Help** - Opens the Configuration Assistant online help file.

- **About Configuration Assistant** - Opens a dialog that displays information regarding what version of the application is presently running, as well as version and other information about the Oracle Utilities Network Management System Web Gateway that the application is using.

Toolbar

The Configuration Assistant toolbar provides a shortcut to many of the options available from the Configuration Assistant menus. The Configuration Assistant displays the following buttons:

- **Export Configuration** - Generates SQL statements for the current state of the configuration associated with every tab on the application. These SQL statements may then be saved to a file and/or printed.

- **Print Preview** - Opens the Print Preview dialog, which allows you to print out the User Administration panel, Event Management Rules panel, Event Details Options panel, and Work Agenda Predefined Filter panel information from the current Configuration Assistant window.

- **Exit** - Closes the Configuration Assistant window.

Print Preview

The Print Preview dialog appears whenever one of the printing options is selected in Configuration Assistant.

The following table describes the buttons on the Print Preview dialog:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous Page</td>
<td>Used to traverse the preview to the previous page in a multi-page output.</td>
</tr>
<tr>
<td>Next Page</td>
<td>Used to traverse the preview to the next page in a multi-page output.</td>
</tr>
</tbody>
</table>
The Print Preview dialog also allows you to set the margins of the output interactively. First, position your cursor over the preview output until you see a red outline. Next, while the cursor over the red outline, click and hold your left mouse button and drag the red line to the desired location.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Out</td>
<td>Used to zoom out on the contents of the preview.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Used to zoom in on the contents of the preview.</td>
</tr>
<tr>
<td>Scale Out</td>
<td>Used to scale out the font used for the print output.</td>
</tr>
<tr>
<td>Scale In</td>
<td>Used to scale in the font used for the print output.</td>
</tr>
<tr>
<td>Toggle Orientation</td>
<td>Toggles the page orientation of the output between portrait and landscape.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Brings up the Page Setup dialog, which allows you to select paper size and source, set page orientation, set margins, and select the printer.</td>
</tr>
<tr>
<td>Reset to Default Setting</td>
<td>Reverts the preview window back to its default settings.</td>
</tr>
<tr>
<td>Print</td>
<td>Sends the print output to your selected printer, and then closes the Print Preview dialog.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Print Preview dialog without printing any output.</td>
</tr>
</tbody>
</table>
User Administration Tab

The User Administration tab allows an administrator to add a user, remove a user, modify the set of user types associated with a user, and view a user’s login activity. This tab contains four panels:

- Current Users Panel
- User Type Memberships Panel
- User Log Panel

From this tab, you can perform the following tasks:

- Adding a User
- Editing a User
- Removing a User
- Saving Exported User Configuration
- Changing User Type Memberships
- Rearranging Current User Types
- Resetting a User Login

Current Users Panel

The Current Users panel lists all of the users currently configured to use one or more modules of Oracle Utilities Network Management System, and allows you to add, edit and remove users.

Each time you select a row in the Current Users table, the User Type Memberships and User Log panels repopulate with information that pertains to the selected user.

The Current Users Panel displays the following fields and buttons:

- The Username column contains the Oracle Utilities Network Management System login name of the user.
- The Full Name column contains the full name of the user.
- The Last Logon column contains the date and time the user last logged on.
- The Last Logoff column contains the date and time the user was last logged off.
- The Add button allows you to create a new user.
- The Remove button allows you to remove an existing user.
- The Edit button allows you to modify the Username and Full Name of the user.
- The Refresh button refreshes the table with the current contents of the database.
- The Service Recache button causes the Oracle Utilities Network Management System services to recache with the changes you’ve made in the Configuration Assistant window. If you do not do this, your changes will not be recognized until Oracle Utilities Network Management System services are restarted.
- The Export Configuration... button generates SQL statements for the current state of the configuration associated with the User Administration tab. These SQL statements may then be saved to a file and/or printed.
Adding a User
To add a new user to Oracle Utilities Network Management System, complete these steps:

1. Display the User Administration tab on the Configuration Assistant window.
2. Click the Add button in the Current Users panel. The Add / Edit User Information dialog appears.
3. Enter the user information in the data fields:
   - Username: the new user's system login name.
   - Full Name: the user's full name.
   - Default Zone Set: optionally, add the name of the control zone set that the user will be automatically subscribed to when they log in to the system.
   - Excluded Zone Set: optionally, enter a zone set that the user cannot subscribe to.
4. Select the user's account setting:
   - Active User: designates an active user account; required to login to NMS.
   - Priority User: used for callback processing, which sends priority customer callback notifications to users with the Priority User account setting selected.
   - External User: designates an external system user agent that connects to NMS via an interface, such as Web Callbacks or IVR.

   **Note: Temporarily Inactivating a User**

   When a user will be inactive for a period of time, unselect the Active User checkbox from the User Account Settings. The inactive user cannot login to NMS.
5. Click the Save button. The new user is added to the Current Users table.

   If the Username that was entered already exists, an error appears.

Editing a User
To edit the name information for an Oracle Utilities Network Management System user, complete these steps:

1. Display the User Administration tab on the Configuration Assistant window.
2. Select the user you wish to edit in the Current Users table.
3. Click the Edit button. The Add / Edit User Information dialog appears.
4. Modify any of the enabled fields as desired.
5. Click the Save button. The user information is updated in the Current Users table.

   If the Username was modified to a name that already exists, an error appears.

Removing a User
To remove a user from Oracle Utilities Network Management System, complete these steps:

1. Display the User Administration tab on the Configuration Assistant window.
2. Select the user you wish to remove in the Current Users table.
3. Click the Remove button. A confirmation dialog appears.
4. Click Yes to remove the user. Click No to cancel the removal.
**Saving Exported User Configuration**

To generate and save SQL statements for the current state of the configuration associated with the User Administration tab, complete the following steps:

1. Display the User Administration tab on the Configuration Assistant window.
2. Click the **Export Configuration**... button beneath the Current Users table. A dialog appears indicating that the configuration is being generated.
3. Once the generation is finished, the Generated Configuration dialog appears.
4. To save the generated SQL statements to a file, click the **Save** button. The Save Configuration File dialog appears.
5. Type a name for the file into the File field. The Save Configuration File dialog disappears.
6. To print out the generated SQL statements, click the **Print** button. The Print Preview dialog appears.
7. Adjust the scale, orientation, and page setup as desired.
8. Click the **Print** button to print the page(s). The Print Preview dialog disappears and the print output appears at your selected printer.
9. Click the **Cancel** button to close the Generated Configuration dialog.

**User Type Memberships Panel**

The User Type Memberships Panel lists all of the products and user types a selected user is currently configured to access. You may add or remove access to products and user types for a selected user.

The User Type Membership Panel displays the following fields and buttons:

- The **Products** column lists the Oracle Utilities Network Management System product modules that a user may be configured to have login access to. When you select an item in the Product column, the Remaining User Types and Current User Types columns populate to show you which user types the selected user currently does and does not have access to for the selected product.
- The **Remaining User Types** column lists the user types for the selected product that the selected user does not currently have access to.
- The **Current User Types** column lists the user types for the selected product that the selected user does currently have access to.
- The **Add Selected User Type(s)** button allows you to grant access to a selected user type from the Remaining User Types column to the selected user.
- The **Remove Selected User Type(s)** button allows you to remove access to a selected user type from the Current User Types column from the selected user.

**Changing User Type Memberships**

To modify the user type memberships for a user, complete the following steps:

1. Display the User Administration tab on the Configuration Assistant window.
2. Select the user whose memberships you wish to modify in the Current Users table. The User Type Memberships table populates with the current user type information for the selected user.
3. Select the desired product from the Products column. The Remaining User Types and Current User Types columns populate with the current user type information for that product for the selected user.
4. Select the user type(s) from the Remaining User Types column that you’d like to add to the user for the selected product. The Add Selected User Type(s) button becomes sensitized.

5. Click the Add Selected User Type(s) button. The selected user type(s) now appear in the Current User Types column.

6. Select the user type(s) from the Current User Types column that you’d like to remove the user from for the selected product. The Remove Selected User Type(s) button becomes sensitized.

7. Click the Remove Selected User Type(s) button. The selected user type(s) now appear in the Remaining User Types column.

Rearranging Current User Types

To rearrange the order of appearance of the configured user types on the login window(s), complete the following steps:

1. Display the User Administration tab on the Configuration Assistant window.

2. Select the user whose memberships you wish to modify in the Current Users table. The User Type Memberships table populates with the current user type information for the selected user.

3. Select a user type in the Current User Types column that you wish to move in the list. The arrows to the right of the column are now sensitized.

4. Click the appropriate arrow to change the user type order:
   • Click the button to move the selected user type up to the top of the list.
   • Click the button to move the selected user type up one position in the list.
   • Click the button to move the selected user type down one position in the list.
   • Click the button to move the selected user type down to the bottom of the list.

User Log Panel

The User Log panel displays the login history for the selected user. From this panel you may also fix log entries for a user that is unable to login because the system thinks the user is already logged in from elsewhere (e.g., a system error of some sort prevented the database from being updated with the correct information).

The User Log panel displays the following fields and buttons:

• The Host column displays the name of the host machine that the user was logged in from.
• The Display column displays the name of the display machine that was being used.
• The Product column displays the name of the product the user was logged in to.
• The User Type column displays the name of the user type the user was logged in as.
• The Login Date displays the date and time of the user login.
• The Login Status displays the status of the user login (e.g., SUCCESSFUL).
• The Logout Date displays the date and time of the user logout.
• The Logout Status displays the status of the user logout (e.g., SUCCESSFUL).
• The Reset Login button allows you to force a logout entry into the database for a user that is still logged in, per the User Log information. This is useful in cases where a user's client may have crashed for some reason and the user's loss of client isn't recorded in the database as a logout. The system also unsubscribes the user from any zones to which they were subscribed.

Resetting a User Login
To reset a user login, complete the following steps:

1. Display the User Administration tab on the Configuration Assistant window.
2. Select the user whose login you wish to reset in the Current Users table. The User Log table populates with the login history for the selected user.
3. Select the row in the User Log table that pertains to the login you wish to reset (this must be a row where the Logout Date, Logout Status, and Logout Method columns are blank). The Reset Login button sensitizes.
4. Click the Reset Login button. The User Log table updates the selected row with the current date and time for the Logout Date, FORCED for the Logout Status, and SYSTEM for the Logout Method.

Note that if the user is currently logged in, they will be forced out and their subscribed control zones, if any, will be released.

Event Management Rules Tab
The Event Management Rules tab allows an administrator to add, edit, remove, update, and activate Event Management Rules in the Oracle Utilities Network Management System. These rules govern the behavior and output of Oracle Utilities Network Management System Trouble Management in various situations, such as outage prediction, crew behavior, momentary outage processing, etc.

The Event Management Rules tabs contains three panels:

• Rule Categories Panel
• Currently Configured Rules Panel
• Documentation Panel

From this tab, you can perform the following tasks:

• Selecting a Category to View
• Resizing the Rule Categories Panel
• Filtering the Currently Configured Rules Table
• Adding a Rule to the Configuration
• Removing a Rule from the Configuration
• Editing a Rule in the Configuration
• Saving Exported Configuration

Rule Categories Panel

The Rule Categories panel displays the following buttons:

• The Expand All button expands all of the rule category folders to display their contents.
• The Collapse All button collapses all of the rule category folders.
**Selecting a Category to View**

When you select a category folder from the Rule Categories panel, the folder expands to display the names of the Event Management Rules within that category. Some of the categories may also have sub-categories.

When an individual rule is displayed in the list, a symbol appears to the left of the rule. The ● symbol indicates that the rule is already configured in at least one rule set. The ✗ symbol indicates that the rule is not presently configured in any rule set.

When you select an individual rule (or certain categories) in the list, the Documentation panel on the Event Management Rules tab populates with documentation for the selected rule.

**Resizing the Rule Categories Panel**

You can resize the rule categories panel by dragging the right side of the panel to the left or right. You can also quickly expand or collapse it by clicking the directional arrows next to the upper right corner of the rules categories panel.

---

**Currently Configured Rules Panel**

The Currently Configured Rules panel on the Event Management Rules Tab lists the entire collection of SRS rules currently configured for Oracle Utilities Network Management System, and it allows you to add, edit and remove rules.

The Currently Configured Rules panel displays the following fields and buttons:

- The **Set Name** column displays the Set Name that the rule is configured in.
- The **Incident Type** column displays the configured Incident Type value of the rule.
- The **Rule Name** column displays the rule name.
- The **Rule Value 1** column displays the configured Rule Value 1 value of the rule.
- The **Rule Value 2** column displays the configured Rule Value 2 value of the rule.
- The **NCG Class** column displays the configured ncg class value of the rule.
- The **NCG Index** column displays the configured ncg index value of the rule.
- The **Rule Value Integer 1** column displays the configured Rule Value Integer 1 value of the rule.
- The **Rule Value Integer 2** column displays the configured Rule Value Integer 2 value of the rule.
- The **Rule Value Integer 3** column displays the configured Rule Value Integer 3 value of the rule.
- The **Rule Value Integer 4** column displays the configured Rule Value Integer 4 value of the rule.
• The **Rule Value Integer 5** column displays the configured Rule Value Integer 5 value of the rule.

• The **Add** button allows you to add a rule to the configuration.

• The **Remove** button allows you to remove a selected rule from the configuration.

• The **Edit** button allows you to edit the selected rule in the configuration.

• The **Refresh** button refreshes the table with the current contents of the database.

• The **Service Recache** button causes the Oracle Utilities Network Management System services to recache with the changes you’ve made in the Configuration Assistant window. If you do not do this, your changes will not recognized until Oracle Utilities Network Management System services are restarted.

• The **Export Configuration...** button generates SQL statements for the current state of the configuration associated with the Event Management Rules tab. These SQL statements may then be saved to a file and/or printed.

**Filtering the Currently Configured Rules Table**

To filter the Currently Configured Rules table based upon a selected column value, complete these steps:

1. Display the Event Management Rules tab on the Configuration Assistant window.

2. Click into the cell that contains the value you want to filter the Currently Configured Rules table by.

3. Position your cursor over the relevant cell value, then right-click. A pop-up menu with the option **Toggle Auto Filter** appears.

4. Click the **Toggle Auto Filter** option on the pop-up menu. The Currently Configured Rules table is now filtered by the selected column/cell value combination. The label above the table displays what filter is currently applied to the table.

5. To remove the filtering, right-click over any portion of any row in the Currently Configured Rules table. A pop-up menu with the option **Toggle Auto Filter** appears, and a check now appears next to the option.

6. Click the **Toggle Auto Filter** option on the pop-up menu. The Currently Configured Rules table now contains all of its rows once again, as the filtering has been removed.

**Adding a Rule to the Configuration**

To add a rule to the configuration, complete these steps:

1. Display the Event Management Rules tab on the Configuration Assistant window.

2. Click on the **Add** button beneath the Currently Configured Rules table. The Event Management Rule Fields dialog appears. If you had first selected a row in the Currently Configured Rules table, the dialog will be initialized with the values from that row.

3. Select the name of the rule you wish to add from the Rule Name drop-down menu.

4. Select the name of the rule set you wish to add the rule to from the Ruleset drop-down menu.

5. Indicate whether or not you want the rule to be activated in the rule set by checking (or unchecking) the **Active** checkbox.

6. Enter the desired configuration values for the remainder of the fields.

7. Click the **Save** button to save the newly added rule.

8. If the newly added rule already exists in the specified rule set, a conformation dialog appears.
• Clicking **Yes** overwrite the existing configuration of the rule with the new configuration that you specified. Clicking **No** will not add the new rule and preserve the existing one.

**Note:** This is the only validation currently performed when adding a rule. Please refer to the individual rule documentation for further information regarding what the valid values are for a particular rule.

**Removing a Rule from the Configuration**

To remove a rule from the configuration, complete these steps:

1. Display the Event Management Rules tab on the Configuration Assistant window.
2. Select the rule you wish to remove in the Currently Configured Rules table.
3. Click the **Remove** button. A confirmation dialog appears.
4. Click **Yes** to go ahead and remove the rule. Click **No** to cancel the removal.

**Editing a Rule in the Configuration**

To edit a rule in the configuration, complete these steps:

1. Display the Event Management Rules tab on the Configuration Assistant window.
2. Select the rule you wish to edit in the Currently Configured Rules table.
3. Click the **Edit** button. The Event Management Rule Fields dialog appears.
4. Modify the rule fields as desired.
5. Click on the **Save** button. The rule information is updated in the Currently Configured Rules table.

• If the rule was modified such that it has a name of a rule that already exists in another rule set, an error dialog appears.

• Clicking **Yes** will overwrite the existing configuration of the rule with the new configuration that you specified. Clicking **No** will not add the new rule and will instead preserve the existing one.

**Note:** This is the only validation currently performed when editing a rule. Please refer to the individual rule documentation for further information regarding what the valid values are for a particular rule.

**Saving Exported Configuration**

To generate and save SQL statements for the current state of the configuration associated with the Event Management Rules tab, complete the following steps:

1. Display the Event Management Rules tab on the Configuration Assistant window.
2. Click the **Export Configuration...** button beneath the Currently Configured Rules table. A dialog appears indicating that the configuration is being generated. Once the generation is finished, the Generated Configuration dialog appears.
3. To save the generated SQL statements to a file, click the **Save** button. The Save Configuration File dialog appears.
4. Type a name for the file into the File name field. The Save Configuration File dialog disappears.
5. To print out the generated SQL statements, click the **Print** button. The Print Preview dialog appears.
6. Adjust the scale, orientation, and page setup as desired.
7. Click the **Print** button to print the page(s). The Print Preview dialog disappears and the print output appears at your selected printer.
8. Click the **Cancel** button to close the Generated Configuration dialog.

**Documentation Panel**

When you select an individual rule (or certain categories) from the list in the Rule Categories panel of the **Event Management Rules Tab**, the Documentation panel populates with documentation for the selected rule.

**Event Details Options Tab**

The Event Details Options tab allows an administrator to configure the contents of each of the option menus that reside on the Trouble Management and Web Trouble Event Details windows. (See **Event Details** on page 2-13 for more information.)

This tab contains one panel:

- **Event Details Options Panel**

Use this tab to perform the following tasks:

- **Adding an Option**
- **Removing an Option**
- **Editing an Option**
- **Saving Exported Event Details Configuration**
- **Rearranging Options**

**Event Details Options Panel**

The Event Details Options panel allows you to add, edit, remove, and reorder the contents of each of the option menus that reside on the Trouble Management and Web Trouble Event Details windows.

The Event Details Options panel displays the following fields and buttons:

- The **Event Type** allows you specify which event type configuration you want to modify the options of (e.g., Outage, Non Outage, Planned Event, Switching Event).
- The **Event Details Option Menus** selection menu contains a list of the option menus that exist for the selected Event Type.
- The **Options for Currently Selected Menu** table populates with the currently configured options for the selected option menu and event types.
- The **Add** button allows you to add a new option to the selected option menu for the selected event type.
- The **Remove** button allows you to remove the selected option.
- The **Edit** button allows you to edit the selected option.
- The **Refresh** button refreshes the table with the current contents of the database.
- The **Export Configuration**... button generates SQL statements for the current state of the configuration associated with the Event Details Options tab. These SQL statements may then be saved to a file and/or printed.

**Adding an Option**

To add a new option to an option menu, complete the following steps:

1. Display the Event Details Options tab on the Configuration Assistant window.
2. Select the Event Type whose option menu you wish to change.
3. Select the option menu you wish to change from the Event Details Option Menus drop-down list.
4. Click the **Add** button. The Add/Edit Option dialog appears.
5. Type the name of the option you wish to add into the Option Name field.
6. Click the **Save** button to save the new option. The Options for Currently Selected Menu table updates with the new option.
   - If you enter the name of an option that already exists, an error dialog appears.

### Removing an Option

To remove an option from an option menu, complete the following steps:

1. Display the Event Details Options tab on the Configuration Assistant window.
2. Select the Event Type whose option menu you wish to change.
3. Select the option menu you wish to change from the Event Details Option Menus drop-down list.
4. Select the option you wish to remove from the Options for Currently Selected Menu table.
5. Click the **Remove** button. A confirmation dialog appears.
6. Click **Yes** to go ahead and remove the option. Click **No** to cancel the removal.

### Editing an Option

To edit an existing option, complete the following steps:

1. Display the Event Details Options tab on the Configuration Assistant window.
2. Select the Event Type whose option menu you wish to change.
3. Select the option menu you wish to change from the Event Details Option Menus drop-down list.
4. Select the option you wish to edit from the Options for Currently Selected Menu table.
5. Click the **Edit** button. The Add/Edit Option dialog appears.
6. Make the desired changes in the Option Name field.
7. Click the **Save** button to save the new option. The Options for Currently Selected Menu table updates with the edited option.
   
   **Note:** If you enter the name of an option that already exists, an error dialog appears.

### Saving Exported Event Details Configuration

To generate and save SQL statements for the current state of the configuration associated with the Event Details Options tab, complete the following steps:

1. Display the Event Details Options tab on the Configuration Assistant window.
2. Click the **Export Configuration...** button beneath the Options for Currently Selected Menu table. A dialog appears indicating that the configuration is being generated.
3. Once the generation is finished, the Generated Configuration dialog appears.
4. To save the generated SQL statements to a file, click the **Save** button. The Save Configuration File dialog appears.
5. Type a name for the file into the File name field. The Save Configuration File dialog disappears.
6. To print out the generated SQL statements, click the **Print** button. The Print Preview dialog appears.

7. Adjust the scale, orientation, and page setup as desired.

8. Click the **Print** button to print the page(s). The Print Preview dialog disappears and the print output appears at your selected printer.

9. Click the **Cancel** button to close the Generated Configuration dialog.

---

**Rearranging Options**

To rearrange the order of appearance of the options on an option menu, complete the following steps:

1. Display the Event Details Options tab on the Configuration Assistant window.

2. Select the Event Type whose option menu you wish to change.

3. Select the option menu you wish to change from the Event Details Option Menus drop-down list. The Options for Currently Selected Menu table populates with the options for the selected option menu and event type.

4. Select an option in the table that you wish to move in the list. The arrows to the right of the column are now sensitized.

5. Use the arrow buttons to rearrange options:
   - Click the button to move the selected user type up to the top of the list.
   - Click the button to move the selected user type up one position in the list.
   - Click the button to move the selected user type down one position in the list.
   - Click the button to move the selected user type to the bottom of the list.
The Work Agenda Predefined Filters tab on the Configuration Assistant window allows you to add, modify, and delete pre-defined filters for the Work Agenda. These pre-defined filters are used to remove (hide) specified rows from the Work Agenda list so that only the desired events are shown. Use this tab to perform the following tasks:

- Adding a Filter
- Editing a Filter
- Deleting a Filter
- Print Preview

The Work Agenda Predefined Filters tab displays the following fields and buttons:

- The Current Filter drop-down displays the name of the currently displayed filter and allows you to select an existing predefined filter.

- The Filter Option Table contains the following columns:
  - The Column Name column displays all columns by which you can filter.
  - The Filter Type column displays the available filter types:
    - Any - No filter is applied. All values for this column are included. This is the default.
    - Match - When this filter type is selected, the Work Agenda will include only items where the value of the column specified in the Column Name field matches the value specified in the Value field.
    - Like - When this filter type is selected, the Work Agenda will include only items where the value of the column specified in the Column Name field includes the value specified in the Value field.
    - Not Like - When this filter type is selected, the Work Agenda will include only items where the value of the column specified in the Column Name field does not include the value specified in the Value field.
    - Multi-Match - When this filter type is selected, the Work Agenda will include only items where the value of column specified in the Column Name field matches any of the values specified in the Value field.
    - Not - When this filter type is selected, the Work Agenda will include only items where the value of column specified in the Column Name field does not match the value specified in the Value field.
    - Multi-not - When this filter type is selected, the Work Agenda will include only items where the value of column specified in the Column Name field does not match any of the values specified in the Value field.
    - > - When this filter type is selected, the Work Agenda will include only items where the value of the column specified in the Column Name field is greater than the value specified in the Value field.
    - < - When this filter type is selected, the Work Agenda will include only items where the value of the column specified in the Column Name field is less than the value specified in the Value field.
  - The Value column allows you to enter the filter value.
  - The Add button allows you to add a new filter.
  - The Save button allows you to save a new filter or edit an existing filter.
  - The Delete button allows you to remove the selected filter.
• The **Refresh** button refreshes the table with the current contents of the database.

• The **Export Configuration**... button generates SQL statements for the current state of the configuration associated with the Work Agenda Predefined Filter tab. These SQL statements may then be saved to a file and/or printed.

### Adding a Filter

To add a new filter, follow these steps:

1. Click the **Add** button on the Work Agenda Predefined Filters tab. The Add Filter Name dialog is displayed.
2. Enter a meaningful name for the filter and click **OK**. The new filter name is displayed in the Current Filter box. The Filter Options table displays a list of columns by which you can filter the Work Agenda. By default, the Filter Type for all columns is Any, indicating that no filter is currently applied.
3. To apply a filter to a particular column, select the desired Filter Type (described in the previous section) and enter the filter Value. For example, to filter the Work Agenda by restore date, locate the Restore Date column, then select ‘>’ from the Filter Type drop-down, and enter a date in the Value column. The filter will display only events with a Restore Date greater than the date you entered.
4. Repeat step 3 for each column you want to filter by.
5. Click **Save**. The new filter criteria are saved.

**Note:** To make the new filter criteria available in the Work Agenda, the name of the new filter needs to be added to the OTHER_FILTERS column in the DYNTABLE_VIEWS table for the desired Work Agenda view.

### Editing a Filter

To edit an existing filter, follow these steps:

1. From the Current Filters combo box, select the filter you want to edit.
2. Modify the filter settings as needed. To remove a filter, select **Any** from the Filter Type drop-down for that column. To filter by a particular column, select the desired Filter Type and enter a filter Value.
3. Click **Save**. The filter is updated and will be available from the Work Agenda.

### Deleting a Filter

To delete an existing filter, follow these steps:

1. From the Current Filters combo box, select the filter you want to delete.
2. Click the **Delete** button. A confirmation dialog is displayed.
3. Click **OK** to confirm the deletion. The filter is deleted and will no longer be available from the Work Agenda.

**Note:** The Trouble Management Work Agenda has ‘views’ that typically apply filters. The standard views are “All,” “To Do,” “In Progress,” “Incomplete,” and “Completed.” If you delete the filter that is applied for a view, then the view will no longer apply a filter of that name. If you later create a new filter of that name, it will not be applied in the Trouble Management Work Agenda without additional configuration done outside of Configuration Assistant. This limitation does not impact the Web Trouble Work Agenda.
Saving an Exported User Configuration

To generate and save SQL statements for the current state of the configuration associated with the Work Agenda Predefine Filter tab, complete the following steps:

1. Display the Work Agenda Predefine Filter tab on the Configuration Assistant window.
2. Click the Export Configuration... button beneath the Current Filter table. A dialog appears indicating that the configuration is being generated.
3. Once the generation is finished, the Generated Configuration dialog appears.
4. To save the generated SQL statements to a file, click the Save button. The Save Configuration File dialog appears.
5. Type a name for the file into the File name field. The Save Configuration File dialog disappears.
6. To print out the generated SQL statements, click the Print button. The Print Preview dialog appears.
7. Adjust the scale, orientation, and page setup as desired.
8. Click the Print button to print the page(s). The Print Preview dialog disappears and the print output appears at your selected printer.
9. Click the Cancel button to close the Generated Configuration dialog.

Default Restoration Times Tab

The Default Restoration Times tab on the Configuration Assistant window displays the current default restoration time configuration and allows you to modify the ERT values for each device class by control zone.

Note: To change the system-wide default restoration time, see Setting the System-Wide Estimated Restoration Time on page 7-22.

The Default Restoration Times tab displays the following fields and buttons:

- The Control Zone column displays the control zone to which the default restoration time applies.
- The Device Class column displays the device class to which the default restoration time applies.
- The User column displays the user who configured this default restoration time.
- The Default Restoration Times (minutes) column displays the number of minutes to be used for the default restoration time for this control zone-device class combination.

Buttons

- The Add button opens the Add Default Restoration Time dialog so you can add a default restoration time for a particular device class-control zone combination.
- The Remove button marks the selected default restoration time for deletion. The item will not be deleted until you click Save.
  
  Note: To unmark the item, click Refresh and then indicate that you do not want to save your changes.
- The Save button saves any changes you have made.
- The Refresh button refreshes the screen. If you have any unsaved changes, the system asks whether you want to save them or not.
- The Export Configuration button opens the Generated Configuration window, which displays the SQL statements used to generate the current configuration. Click Save the save the configuration to a file, or click Print to print it.

**Adding or Changing a Device/Zone-Based Default Restoration Time**

To edit an existing default restoration time, click the Default Restoration Time column for the row you want to change. Enter the new value and press Enter. The row color changes to indicate that it has been modified. (By default, changed rows display a green background, but this can be customized during product configuration.) Use the Save button on the toolbar to save your changes.

To add a default restoration time for a specific device class-control zone combination, follow these steps:

1. From the Configuration Assistant window, click the Default Restoration Times tab.
2. Click the Add button. The Add Default Restoration Time window appears.
3. Click the Control Zone Selection icon to display a list of control zones, then select one and click OK.
4. Click the Select button next to the Device Class field to display a list of classes, then select one and click OK.
5. The Default Restoration Times (minutes) column displays the number of minutes to be used for the default restoration time for this control zone-device class combination.
6. Click OK. A new row is added to the table. (By default, new rows display a cyan background.)
Redliner provides tools for the capture, annotation, emailing and saving of images. You can use these tools to document and collaborate on Oracle Utilities Network Management System and other related screens. You can save screen captures as JPEG files that may be marked-up, commented upon, or distributed via email. You can also use Redliner for sending detailed information to other work groups including customer service centers, marketing, media relations, and technical support.

This chapter includes the following topics:

• Redliner Window
• Working with Images

Redliner Window

The Redliner main window is used to capture and annotate images. You can perform other actions in the window using the menu or buttons on the toolbar. You will initially access Redliner through a desktop shortcut or from your computer’s Start menu.

Menus

There are three menus on the Redliner menu bar: File, Action, and Help.

File Menu

The following table describes the File Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Refreshes the transparent image window by taking a new screen capture and clearing any user edits.</td>
</tr>
<tr>
<td>Save…</td>
<td>Opens the Save JPEG image dialog, which allows you to save the current image as a JPEG file.</td>
</tr>
<tr>
<td>Print…</td>
<td>Opens the Print dialog, which allows you to print the image.</td>
</tr>
<tr>
<td>Email…</td>
<td>Opens the Redliner Email dialog, which allows you to email the image as an attachment.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Redliner window.</td>
</tr>
</tbody>
</table>
Action Menu

The following table describes the Action Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Refreshes the transparent image window by taking a new screen capture and clearing any user edits.</td>
</tr>
<tr>
<td>Email Settings…</td>
<td>Opens the Redliner Preferences dialog, which allows you to enter email settings such as SMTP Server, Display Name, Reply to Address, etc.</td>
</tr>
</tbody>
</table>

Help Menu

The following table describes the Help Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redliner Help</td>
<td>Opens the Oracle Utilities Network Management System's online help content for Redliner.</td>
</tr>
<tr>
<td>About…</td>
<td>Opens a dialog that displays information regarding what application is present running.</td>
</tr>
</tbody>
</table>

Toolbar

The Redliner toolbar provides a shortcut to many of the options available from the Redliner menus. The toolbar appears below the menu bar.

The following table describes the buttons on the Redliner Toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw</td>
<td>Allows user to draw in the transparent image window. Note that this toggle button is mutually exclusive with the Insert Text button.</td>
</tr>
<tr>
<td>Insert Text</td>
<td>Allows user to insert text into the transparent image window by opening up the Insert Text dialog. Note that this toggle button is mutually exclusive with the Draw button.</td>
</tr>
<tr>
<td>Change Color</td>
<td>Opens the Select Color dialog, which allows you to select a color to use.</td>
</tr>
</tbody>
</table>

Status Bar

The status bar appears at the bottom of the Redliner window, providing operating details for the application.

- The left-most field displays the locked/unlocked status of the image in the transparent image window.
- The center field displays whether Redliner is in drawing or text edit mode.
- The right-most field displays the current color selection.
Working with Images

This section describes how to work with images using Redliner. It includes the following topics:

• Capturing an Image
• Annotating an Image
• Saving an Image
• Emailing an Image
• Printing an Image

Capturing an Image

The Redliner transparent image window captures your screen at and refreshes when resized and repositioned to reflect the windows, desktop, and images behind the tool. The window can be resized and repositioned infinitely in order to capture the exact image needed.

Once the image has been edited, however, the image becomes locked, and repositioning and resizing will not change the image. The locked/unlocked status is always indicated on the Redliner status bar.

To reset the image capture and remove any editing you have performed, select the File -> New or Action -> Refresh.

Annotating an Image

The options on the Redliner toolbar are used to annotate a captured image.

• Use the Draw button to draw freehand on the image.
• Use the Insert button to type text on the image.
• Use the Change Color button to select which color to use with the Draw and Insert Text options.

Drawing

To draw on a Redliner captured image, complete these steps:

1. Click the Draw button on the toolbar.
2. Click and hold the left mouse button while dragging the cursor around the image to draw freehand lines on the image.

Note: There is no undo action for drawing.

Inserting Text

To insert text onto a Redliner captured image, complete these steps:

1. Click the Insert Text button on the toolbar.
2. Place the mouse cursor over the transparent image window and single-click the left mouse button. The Insert Text dialog appears.
3. Select the desired Font, Style, and Size from the Text Properties section of the dialog.
4. Type the desired text into the Text to Insert field.
5. Press the OK button. The text appears at the location the cursor was at when the left mouse button was clicked to bring up the Insert Text dialog.

Note: There is no undo action for text insertion.
Changing the Color of Lines or Text
To change the color of the text and/or lines to be added to an image, complete these steps:

1. Click the Change Color button on the toolbar. The Select Color dialog appears.
2. Select a color from the Swatches tab of the Select Color dialog.
3. Use the options on the HSB (Hue/Saturation/Brightness) and RGB (Red/Green/Blue) tabs of the Select Color dialog to adjust the selected color, if desired.
4. Click the OK button. The Select Color dialog closes, and the newly selected color appears in the right-most field of the status bar.
5. Click either the Draw button or Insert Text button to proceed to use the newly selected color on the image.

Saving an Image
To save an image that you have captured in the Redliner window, complete these steps:

1. Select the Save… option from the File menu. The Save JPEG Image dialog appears.
2. Type the name you wish to give the image into the File name field.
3. Click the Save Image button on the dialog. The Save JPEG Image dialog closes and a JPEG file is saved with the name and location you specified in the Save JPEG Image dialog.

Emailing an Image
You may email the current contents of the Redliner window to someone directly from Redliner. The image capture is automatically attached as a JPEG file to the email, and the Redliner Email dialog allows you to enter standard email information including recipient(s) (To:), carbon copy recipients (Cc:), and subject heading (Subject:) in the appropriate fields.

Email Settings
Before you can send email from Redliner, you must first configure the email settings in the Redliner Preferences dialog. To configure the settings, complete these steps:

1. Select the Email Settings… option from the Action menu. The Redliner Preferences dialog appears.
2. Type your name into the Display Name: field. This is name that will appear as the sender’s name in the email sent to the recipient.
3. Type your email address into the Reply to Address: field. This is the address that will appear as the sender’s email address in the email sent to the recipient.
4. Change the name in the Attachment Name: field, if desired. This is the name that the image attachment will be given in the email sent to the recipient.
5. Type the name of your SMTP server into the SMTP Server Name: field. Your system administrator can provide you with this information.

   Note: Redliner keeps a history of the email addresses that you have emailed images to. Press the Clear button beside the Clear Address History field to clear out this history.

6. Press the OK button on the Redliner Preferences dialog.

Sending an Email
To email the image captured in the Redliner window, complete these steps:

1. Select the Email… option from the File menu. The Redliner Email dialog appears.
2. Type the email address(es) of the recipient(s) into the To: field.
3. Type the email address(es) of the carbon copy recipient(s) into the Cc: field, if any.
4. Type an email subject into the Subject: field.
5. Type any additional accompanying text for the email.
6. Press the Send Mail button to send the email.
7. If the email is successfully sent, a confirmation dialog appears.
8. If the email is not successfully sent, an error dialog appears.
9. Click the OK button on the Sending Email dialog. The Sending Email dialog closes.

Printing an Image

To print the image captured in the Redliner window, complete these steps:
1. Select Print… from the File menu. The Print dialog appears.
2. Select the desired printer, page properties, print range, and copies in the Print dialog.
3. Press the OK button on the Print dialog. The Print dialog closes, and the output appears at your desired printer.
This chapter describes the Web Workspace application. It includes the following topics:

• Getting Started with Web Workspace
• Using the Work Agenda
• Using the Web Workspace Viewer
• Using the Web Workspace Control Tool
• Viewing Summaries
• Using the Alarms and Devices Lists
• Using the User Log

Getting Started with Web Workspace

The Web Workspace is a real-time application that can serve as the foundation for all other Oracle Utilities Network Management System application modules. It also can be used in conjunction with the Operator's Workspace application, in which case Web Workspace allows utilities to decentralize their operations during heavy workload and storm situations. You can use Web Workspace in remote operations offices in order to better coordinate crew dispatching and operations functions. Web Workspace shares data with other Oracle Utilities Network Management System modules to ensure the most accurate and current data is displayed to your users.

Web Workspace is the base module that centers on the graphical representation of the electrical system. The Web Trouble module augments the Web Workspace module with crew and event management capabilities.

This section includes the following topics:

• Logging In
• Understanding the Web Workspace Window
• Common Web Workspace and Web Trouble Features
• Dockable Windows Navigation
• Sorting and Filtering Data
• Saving User Preferences
• Taking Authority
• Creating an Event
• Printing
Logging In

You will initially access Web Workspace from a web browser, which will download the application to your computer. Subsequently, you may start it through a desktop shortcut, from your browser Favorites, or from your computer’s Start menu.

Using the Login Window

The Login window is the first Web Workspace window you see. The Login window displays the following fields and buttons:

- The **User ID** field allows you to enter the user name provided to you by the system administrator.
- The **Password field** allows you to enter the password provided to you by the system administrator.
- The **Validate** button verifies your login credentials. If the user name and password are not entered correctly, the system displays an error dialog box.
- The **User Type** drop-down menu contains the list of user types within your authority.
- The **Login** button allows you to complete the login process. Once you click the Login button, the appropriate Web Workspace windows open, based upon the User Type selected.
- The **Quit** button exits the Login window.

Logging In

To log in to Web Workspace, complete these steps:

**Note**: For instructions on logging in to Web Workspace with Web Switching Management, see Starting Web Switching Management on page 15-3.

1. Depending on how your system was installed, do one of the following:
   - Click the Web Workspace icon found under the appropriate program group in your Windows Start Menu.
   - Double click the Web Workspace icon on your desktop.
   - Open a web browser and type the Web Workspace URL in the browser’s Address field.

   The Web Workspace Login window displays.

2. Enter your user name.

3. Enter your password.

4. Click the **Validate** button. The bottom portion of the Web Workspace Login window sensitizes.

5. Select the appropriate User Type from the drop-down menu.

6. Click the **Login** button. The Web Workspace main window appears.
Understanding the Web Workspace Window

The Web Workspace window displays a menu and toolbar at the top of the window, which is used to launch or interact with other tools. In addition, those other tools typically have their own menus and toolbars, and display in panels within the Web Workspace window or in a separate window.

When the Web Workspace window is initially displayed, the Work Agenda tab is displayed in the panel directly below the Web Workspace toolbar, and the Work Agenda tab is active. The Crew Actions and Authority tabs are displayed in a lower panel of the window.

Web Workspace Menu and Toolbar

This section describes the menu and toolbar options available from Web Workspace.

Note: Menu and toolbar options may vary depending on your system's configuration. For example, if you are running Web Workspace with Web Switching Management, you will have additional menu options not available in Web Workspace alone. See Web Switching Management on page 15-1 for more information about using Web Workspace with Web Switching Management. For information about the Work Agenda menu and toolbar, see Work Agenda Menus and Toolbar on page 6-17.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Submenu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Switching Sheet...</td>
<td>Allows you to create a new switching sheet. This option is displayed only if you are running Web Workspace with Web Switching Management.</td>
<td>![Icon]</td>
</tr>
<tr>
<td></td>
<td>Event...</td>
<td>Allows you to create a new event.</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>
### Getting Started with Web Workspace

#### Tools Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Submenu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Switching Sheet...</td>
<td>Allows you to open a new switching sheet. This option is displayed only if you are running Web Workspace with Web Switching Management.</td>
<td>![Icon]</td>
</tr>
<tr>
<td></td>
<td>Safety Document...</td>
<td>Allows you to open a new safety document. This option is displayed only if you are running Web Workspace with Web Switching Management.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Logout</td>
<td></td>
<td>Logs you out of Web Workspace.</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>

#### Menu Option Submenu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Submenu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Agenda 1...</td>
<td></td>
<td>Opens the To Do List in the Work Agenda, which displays events that have not yet been assigned or dispatched, along with associated system and event information.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Work Agenda 2...</td>
<td></td>
<td>Opens a second Work Agenda window.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Viewer 1...</td>
<td></td>
<td>Opens the Viewer window.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Viewer 2...</td>
<td></td>
<td>Opens a second Viewer window.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Condition Summaries...</td>
<td></td>
<td>Displays the Condition Summaries window. The predefined filters include Notes, Tags, Pending Construction, Pending Decommission, and (if licensed for FLISR) FLISR Actions and FLISR Disabled.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>SCADA Summary...</td>
<td></td>
<td>Displays the SCADA Summary window. See Using the SCADA Summary Window on page 6-75 for more information.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Request List...</td>
<td></td>
<td>Open the Requests window. See Displaying the AMR Requests List on page 7-19.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Alarms and Devices List</td>
<td>Abnormal Devices List...</td>
<td>Displays a list of off-nominal devices in the subscribed authority zones. See Abnormal Devices List on page 6-78.</td>
<td>![Icon]</td>
</tr>
<tr>
<td></td>
<td>Device Operations List...</td>
<td>Displays all recent operations performed in the user's control zones. See Device Operations List on page 6-79.</td>
<td>![Icon]</td>
</tr>
<tr>
<td></td>
<td>SCADA Alarms List...</td>
<td>Displays a list of all SCADA alarms in the subscribed authority zones. See SCADA Alarms List on page 6-79.</td>
<td>![Icon]</td>
</tr>
<tr>
<td></td>
<td>System Alarms List...</td>
<td>Displays a list of system alarms. See System Alarms List on page 6-79</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Menu Option</td>
<td>Submenu Option</td>
<td>Description</td>
<td>Toolbar Icon</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Authority...</td>
<td></td>
<td>Opens the Authority window, which lets you manage control and monitoring of discrete zones of the operations area by subscribing particular users.</td>
<td>![authority_icon]</td>
</tr>
<tr>
<td>Crews...</td>
<td></td>
<td>Displays a list of crews and specific information about each crew.</td>
<td>![crews_icon]</td>
</tr>
<tr>
<td>Switching Overlaps...</td>
<td></td>
<td>Opens the Global Overlaps Tool. This option is displayed only if you are running Web Workspace with Web Switching Management.</td>
<td>![switching_icon]</td>
</tr>
<tr>
<td>Miscellaneous Log...</td>
<td></td>
<td>Opens the Miscellaneous Log. This option is displayed only if you are running Web Workspace with Web Switching Management.</td>
<td>![miscellaneous_icon]</td>
</tr>
<tr>
<td>User Preferences...</td>
<td></td>
<td>Opens the User Preference dialog, which allows you to save or restore your current environment.</td>
<td>![user_preferences_icon]</td>
</tr>
<tr>
<td>Note: you can only save preferences for the first instances of the Work Agenda and the Viewer. The Work Agenda filter is not affected by saving preferences; it will always start with the To Do filter applied.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Log...</td>
<td></td>
<td>Opens the User Log window, which displays a list of all single-user actions within a certain time period. See Using the User Log on page 6-83.</td>
<td>![user_log_icon]</td>
</tr>
<tr>
<td>Manage Documents...</td>
<td></td>
<td>Opens the Manage Documents window, which allows you to associate documents to objects. See Associating Documents to Devices on page 6-70.</td>
<td>![manage_documents_icon]</td>
</tr>
<tr>
<td>Feeder Load Summary...</td>
<td></td>
<td>Opens the Feeder Load Summary Tool, which displays a list of the current feeder loads. This option is only displayed if Feeder Load Management is configured for your system.</td>
<td>![feeder_load_icon]</td>
</tr>
<tr>
<td>FLISR Mode</td>
<td>Disabled</td>
<td>Allows you to set the Fault Location, Isolation, and Service Restoration mode. This option is displayed only if FLISR is licensed for your system and you are running Web Workspace with Web Switching Management.</td>
<td>![flISR_icon]</td>
</tr>
<tr>
<td></td>
<td>Manual</td>
<td></td>
<td>![manual_icon]</td>
</tr>
<tr>
<td></td>
<td>Automatic</td>
<td></td>
<td>![automatic_icon]</td>
</tr>
<tr>
<td>FLM Status</td>
<td>Disabled</td>
<td>• Disabled: FLM forecasts have been disabled, usually due to a model build.</td>
<td>![disabled_icon]</td>
</tr>
<tr>
<td></td>
<td>Enabled</td>
<td>• Enabled: FLM forecasts are currently enabled.</td>
<td>![enabled_icon]</td>
</tr>
<tr>
<td>Note: only Administrators may change the FLM status.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Help Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Workspace Help</td>
<td>Launches the online help system and loads the Web Workspace content.</td>
</tr>
<tr>
<td>Web Switching Help</td>
<td>Launches the online help system and loads the Web Switching content. This option is available in the Web Workspace with Web Switching Management and the Web Switching Request environments.</td>
</tr>
<tr>
<td>About &lt;application name&gt;</td>
<td>Opens a window with environment and software information.</td>
</tr>
<tr>
<td>Calculate Network Latency...</td>
<td>Runs a network diagnostic utility and returns the results in the Network connectivity results window.</td>
</tr>
</tbody>
</table>

### Common Web Workspace and Web Trouble Features

There are several features that are common to nearly all Web Workspace and Web Trouble windows. The following sections describe those features.

- The **title bar** tells you what window or dialog box you are using.
- The **menu** provides drop-down menus for available actions. Menu options that are followed by an ellipsis [...] indicate that the option opens another window or dialog box.
  - The **File** menu items typically start standard procedures (e.g., printing or saving) and exit the window; however, File menus can vary between windows.
  - The **Sort** and **Filter** menus allow you to modify how table data is sorted and filtered.
  - The **Actions** menu provides access to features that are almost always specific to a particular window. Frequently used options on the Actions menu are often repeated as buttons on the bottom of the window.
  - The **Help** menu appears on the menu bar on many applications.
- The **toolbar** provides quick access to common functions.
- The **display area** displays the data provided by the window and allows you to manipulate that data.
- The **buttons** are used to perform an action or open a window. Button actions often correspond to Action menu options. A button name that is followed by an ellipsis [...] indicates that the button opens another window or dialog box.
Dockable Windows Navigation

Web Workspace can be configured to use special windows called Dockable windows. This allows Web Workspace to have multiple tools running in one window. The following figure shows Web Workspace window that includes dockable Work Agenda, Crew Actions, and Authority windows.

Adjusting Dockable Window Size and Positions

To adjust the dockable window positions, move the cursor to the divider line, which will cause it to change to a double arrow. Then hold the left mouse button and drag the divider to the desired position.
Moving Dockable Windows

The dockable windows can be moved from one location to the other. To do this, grab the title of window (to the right of the tab name) and move to the desired location. As you move the window around, you can see where the window would be dropped if the mouse button were released. To move a dockable window, click in the window’s tab name (such as the Crew Action tab), then hold the left mouse button and drag the window to the desired position.

In the example above, the selected window would be moved to the shaded area in the upper-right side of the screen.

Note the following about dockable windows:

- If you drop a window to the right of another window, it displays in a separate window to the right.
- If you drop a window in the middle of an existing window, it displays as a tab of the existing window:
- If you want a window to exist independently of the other windows, either move the window completely away from the existing dockable windows or hold down the <Ctrl> key as you release the mouse button.
Taking Authority

Control Zones are discrete sections of a utility's electrical distribution system for which users are responsible. You must take authority of control zones in order to see trouble events, manage crews, and perform device operations in those areas.

The Authority window allows you to take authority over one or more control zones. You can examine and change the assignment of control zones, view the control zones within the distribution system, and identify which users have authority over each zone.

Use the Authority window to perform the following tasks:

- Using the Authority Window
- Subscribing to a Control Zone
- Unsubscribing from a Control Zone
- Searching for a Zone

Using the Authority Window

To view the Authority window, select **Authority...** from the Web Workspace **Tools** menu. The Authority window displays the following fields and buttons:

**Fields**

- The **Zones** area displays a hierarchical list, depicted as a directory structure, of the control zones in the distribution system. Click the “+” sign next to a zone to expand a collapsed zone and display all sub-zones within it. Click the “-” sign next to a zone to collapse the display of any sub-zones within that zone.
- The **User Name** field displays the name of the user who is logged in.
- **Zone Users** displays the user(s) currently subscribed to the selected control zone. If no user is subscribed to the selected control zone, “system” displays in this field.
- **Control Zone** displays the currently selected control zone.
- **Rule Set** displays the rule set currently being used.

**Buttons**

- The **All Zones** button displays the entire set of control zones, and collapses the view to display only the zones under the top-level zone. There is also an option under the Authority window’s Actions menu for this action.
- The **My Zones** button displays only those zones to which the current user is subscribed. There is also an option under the Authority window’s Actions menu for this action.
- The **Users’ Zones** button displays all zones that are not controlled by the system (i.e., have been subscribed to by one or more users). There is also an option under the Authority window’s Actions menu for this action.
- The **System Zones** button displays only those zones controlled by the system (i.e., have not been assigned to a user). There is also an option under the Authority window’s Actions menu for this action.
- The **Subscribe...** button gives you control of the currently selected zone (displayed in the Control Zone field). There is also an option under the Authority window’s Actions menu for this action.
- The **Unsubscribe...** button relinquishes control of the currently selected zone(s) (displayed in the Control Zone field). There is also an option under the Authority window’s Actions menu for this action.
- The **Change Rule Set...** button allows you to change the analysis mode rule set used to analyze events in the selected zone.
• The Zone Search button allows you to search for a zone by entering its name, or the first part of its name, in a search dialog box. If the system finds a match, the list of control zones will expand and highlight the matching zone. There is also an option under the Authority window's Actions menu for this action.

• The Exit button exits the Authority window. There is also an option under the Authority window's File menu for this action.

Subscribing to a Control Zone
To subscribe to one or more control zones, complete these steps:
1. Expand the list of Control zones (click the “+” signs) to locate the zone you want to control.
2. Select the row for that zone. The zone will populate the Control Zone field.
   • To select multiple adjacent zones, hold down SHIFT and click the first and last zones to select all of the zones in that range; to select multiple non-adjacent zones, hold down CTRL and click each zone individually.
3. Click on the Subscribe button. A Subscribe dialog box opens.
4. Click on the Subscribe button in the dialog box. You are now subscribed to the selected zone(s).

Unsubscribing from a Control Zone
When you are finished working in a control zone, you can unsubscribe from the control zone. To unsubscribe, complete these steps:
1. If the Authority window is not open, select Tools>Authority... from the Web Workspace menu to open it.
2. Click on the My Zones button to locate the zone you want to unsubscribe from.
3. Select the row for that zone. The zone will populate the Control Zone field.
4. Click on the Unsubscribe button. An Unsubscribe dialog box opens.
5. Click on the Unsubscribe button in the dialog box. You are now unsubscribed from the zone.

Searching for a Zone
The Search feature can help you locate a control zone more quickly than expanding and viewing zones in the Authority window. To search for a zone, complete these steps:
1. In the Authority window, click the Zone Search button. A Search Tool dialog box opens.
2. Enter the name or first part of the name of the control zone in the Zone field, and then click the Find Next button. The search is not case-sensitive, but you must match exactly in your typing of spaces, hyphens, etc. If the system finds a match, the list of control zones expands and that zone is highlighted.
3. If there are multiple matches, click the Find Next button to locate the next control zone that matches your search criteria.
4. When you locate the zone you want, click the Cancel button to close the Search Tool dialog box.

Example
Two users (“nms1” and “nms22”) may both have work to do in control zone “METRO”. Each user would select “METRO” and click the Subscribe button. A Subscribe dialog box would appear and each user would click the Subscribe button in the dialog box. Both nms1 and nms22 would be allowed control over the zone. All users subscribed to a zone are listed in the Zone Users
field when the zone is selected in the zones tree; “nms1, nms22” would be displayed in the Zone Users field when METRO is selected.

**Sorting and Filtering Data**

You can perform single-column sorts and filters in certain Web Workspace windows. Some of the Web Workspace windows also allow you to create your own user-defined sorts and filters. These options, if available, will be found under the Sort and Filter menus located at the top of the window. If you right-click on the table header, these options appear in a pop-up menu. You can sort tables to display the rows in a particular order or filter them to display a specific subset of the rows.

**Sorting**

You can apply ascending or descending sorts to a single column in a table (where configured) by clicking once on the column header; clicking a second time on the column header will sort the rows in the opposite order. An arrow appears next to the column label identifying if the sort is ascending or descending.

Sort topics include:

- Using the Sort Dialog Box
- Creating a User-Defined Sort
- Editing and Deleting Saved Sorts

**Using the Sort Dialog Box**

Some windows allow you to create, modify, apply, and save user-defined sorts. Sorts are saved for each application, user and user type. Thus, if a user logs in with multiple user types, each of the types will have their own set of sorts.

If a table supports user-defined sorts, select **Sort Dialog...** from the Sort menu or click the **Sort** button on the toolbar to display the Sort Dialog. You can also right-click the table header and then select **Sort...** from the pop-up menu.

The Sort Dialog displays the following items:

- The **Current Sort** drop-down menu presents a list of saved sorts for modification. When you select a sort from the list, the sort criteria are displayed.
- The table within the dialog allows you to specify the order in which the sort criteria is applied, which column in the application is to be used in the sort criteria, and in which direction the sort is to be applied (ascending, descending).
- The **OK** button applies the current sort to the table of data and exits the Sort dialog.
- The **Save...** button opens a dialog box for naming and saving the current sort. Saving automatically applies the sort. You can retrieve sorts through the option menu on the Sort dialog and the Sort menu in the window.
- The **Delete** button opens a dialog box asking you to confirm the deletion of the selected sort. Once it is deleted, you can no longer retrieve the sort.
- The **Show** button applies the current sort settings to the table of data, but does not exit the Sort dialog.
- The **Help...** button displays help for using the Sort dialog.
- The **Exit** button exits the Sort dialog.
- The **Current Sort** drop-down presents a list of saved sorts for modification.
Creating a User-Defined Sort

To create a user-defined sort, complete these steps:

1. Open the Sort Dialog by selecting Sort Dialog… from the Sort menu or by right-clicking the table header and selecting Sort… from the pop-up menu.

2. In the row for Order 1, click on the drop-down menu under Column and select the first column you wish to sort by, and then click on the drop-down menu under Direction and select which order you wish to sort the column by.

3. Repeat the previous step for any other columns you additionally want to sort by.

4. Click the Save… button. The Store the Sort? dialog appears, prompting you to name the sort.

5. Click the Yes button. The Store the Sort? dialog appears, and the name you provided now appears in the option menu of saved sorts.

6. Click the OK button. The Sort dialog closes, and the sort is saved to the database.

Editing and Deleting Saved Sorts

You can use the option menu in the Sort Dialog to select a saved sort for modification. You can also delete a saved sort by selecting it from this menu and clicking on the Delete button.

Quick Sorting

You can resort the contents of a list by clicking on a column header. Click once to sort in ascending order; click again to sort in descending order. A ▲ or ▼ icon indicates the current sort column and sort direction. (▲ indicates ascending order; ▼ indicates descending order.)

Filtering

In addition to sorting, certain windows allow you to filter the data displayed.

Filtering topics include:

• Using the Filter Dialog
• Creating a User-Defined Filter
• Editing and Deleting Saved Filters
• Dynamic Filtering
• Auto Filtering

Using the Filter Dialog

The Filter dialog box is used to create, modify, apply, and save user-defined filters. User-defined filters are only accessible to the user who creates them and are erased when the user logs out unless they have been saved by saving User Preferences.

To display this dialog, select Filter Dialog… from the Filter menu or click the Filter button on the toolbar. You can also right-click on the table header, and then select Filter… from the pop-up menu.

The Filter dialog displays the following items:

• The Current Filter drop-down menu presents a list of saved filters for modification. When you select a filter from the list, the filter criteria are displayed.

• The Column Name column displays the name of each column available in the table of data you are filtering.
The Operator column displays the type of filter, as described in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>any</td>
<td>No filter is applied to this field.</td>
</tr>
<tr>
<td>match</td>
<td>Table rows display only if the field value exactly matches the filter value.</td>
</tr>
<tr>
<td>like</td>
<td>Table rows display only if the field value includes the filter value (e.g., “Status” includes “tat”).</td>
</tr>
<tr>
<td>not like</td>
<td>Table rows display only if the field value does not include the filter value (e.g., “Status” does not include “tot”).</td>
</tr>
<tr>
<td>multi-match</td>
<td>Matches with multiple arguments. Multiple filter values may be entered in the same field, separated by spaces.</td>
</tr>
<tr>
<td>not</td>
<td>Table rows display only if the field value does not match the filter value.</td>
</tr>
<tr>
<td>multi-not</td>
<td>Not with multiple arguments. Multiple filter values may be entered in the same field, separated by spaces.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to. Table rows display only if the field value is greater than or equal to the filter value.</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to. Table rows display only if the field value is less than or equal to the filter value.</td>
</tr>
</tbody>
</table>

The Match Value field is the value you want to filter by. For example, to show only data for the current day, you would set the Type to Match and the Value to the current date.

The Save button opens a dialog box for naming and saving the current filter. Saving automatically applies the filter. You can retrieve filters through the Current Filter option menu and the Filter menu in the window.

The Delete button opens a dialog box asking you to confirm the deletion of the selected filter. Once it is deleted, you can no longer retrieve the filter.

The Apply button applies the current filter settings to the table of data, but does not exit the Filter dialog box.

The Help button displays help for the Filter dialog.

The Exit button exits the Filter dialog box and removes any applied filter settings.

**Creating a User-Defined Filter**

To create a user-defined filter, complete these steps:

1. Open the Filter Dialog by selecting Show Filter Dialog from the Filter menu or by right-clicking the table header and selecting Filter... from the pop-up menu.
2. Click on the Operator drop-down menu of a column you want to filter by and select the option you want.
3. In the Match Value column next to the selected Operator, enter the desired filter value.
4. Repeat the two previous steps for any other columns you want to filter by.
5. Click the Save button. A dialog box appears, prompting you to name the filter.
6. Type a name into the field and click Yes. The table is filtered according to the selected criteria, and the Filter field above the table now displays the name of your newly created filter.
You can view the filter by clicking on the **Apply** button, but if you click Exit, the applied filter will be undone before the dialog box closes.

**Editing and Deleting Saved Filters**

You can use the Current Filter drop-down menu in the Filter Dialog window to select a saved filter for modification. You can also delete a saved filter by selecting it from this menu and clicking on the **Delete** button.

**Dynamic Filtering**

Some lists provide a row of blank edit boxes below the column headers, as shown below:

<table>
<thead>
<tr>
<th>Status</th>
<th>Event #</th>
<th>Feeder</th>
<th>Start Date</th>
<th>Out</th>
<th>Run CML</th>
<th>Calls</th>
<th>Class</th>
<th>Phases Out</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEW</td>
<td>1002</td>
<td>2413</td>
<td>06/11/10 15:41</td>
<td>108</td>
<td>2:03:20</td>
<td>1</td>
<td>ABC</td>
<td></td>
</tr>
<tr>
<td>NFY</td>
<td>1001</td>
<td>2413</td>
<td>06/11/10 15:00</td>
<td>108</td>
<td>2:03:03</td>
<td>1</td>
<td>ABC</td>
<td></td>
</tr>
</tbody>
</table>

Use these boxes to filter the list by the values in any column. Type all or part of the text you want to filter by in the appropriate edit box. The list is filtered to display items that contain matching values in this column. For example, to see only events with a status of "NEW," type "NEW" in the Status edit box. You can combine filter criteria by typing values for more than one column. As you type in each edit box, the list is filtered immediately based on entries in all boxes.

**Auto Filtering**

Some lists support auto filtering (also referred to as cell filtering), which allows you to filter the list by the value of any cell. To use auto filtering, right-click the cell by which you want to filter, and select the **Toggle Auto Filter** option. (When enabled, the menu option is checked.) The list is refreshed to display only rows where the value matches the selected cell. For example, if you click on a cell in the Feeder column with a value of "2413" and enable auto filter, the table will refresh to display only events for Feeder 2413. Click the option again to turn off cell filtering.

**Saving User Preferences**

Web Workspace starts with a standard configuration for window locations and sizes, font sizes, visible tools, and tool settings, such as column size and order. You can make adjustments to the workspace and then save those changes for future sessions. Preferences are saved as follows:

**Windows**

The set of currently open windows are saved and used as the set of windows to display when you login. This feature is restricted to the following windows:

- Condition Summary
- Crew Actions
- Viewer 1
- Service Alarms
- SCADA Summary
- Work Agenda 1
- FLM Summary

**Non-Docked Window Attributes**

- Size
- Placement (does not apply to dialog boxes)

**Table Attributes**

- Column widths
- Column ordering

**Note:** to save user preferences for switching tools, each switching plan type (e.g., emergency, planned, etc.) needs to be saved separately. Ensure that only one switch plan of each type is displayed when you save your preferences.
To save your preferences (for the supported windows), select **Save Preferences** from the Web Workspace **Preferences** menu. Preferences are saved locally on the client PC; therefore, your saved preferences will not be available if you login from another computer.

### Restoring Default Preferences

To restore the default environment settings, select **Restore Preferences** from the Web Workspace **Preferences** menu.

### Creating an Event

If a crew in the field discovers an event that has not been identified by a customer, you may use the **Create Event** window to add the event to the Network Management System.

To open the Create Event window, select **New** and then **Event...** from the Web Workspace **File** menu. The Create Event window displays the following fields and buttons:

- The **Selected Device** field displays the name of the device on which to create the event.
- The **Event Start** field and calendar button allow you to enter the start date for the event.
- The **Outage** and **Non-Outage** options allow you to designate whether the event should be created as an outage or non-outage.
- The **OK** button creates the new event on the selected device and closes the Create Event window.
- The **Help** button displays help for the current window.
- The **Cancel** button closes the Create Event window without creating a new event.

### Logging Out

Use the **Logout** toolbar button or select **File>Logout** to initiate the logout process for a Web Workspace session. The user is unsubscribed from all control zones for which they had authority, and all current windows close. The Web Workspace Login window is redisplayed.

### Printing

Printing is an option from several of the Web Workspace and Web Trouble windows. This section describes the basic printing functionality.

The Print Preview dialog box appears whenever one of the printing options is selected in Web Workspace or Web Trouble.

The following table describes the buttons on the Print Preview dialog box.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Previous Page]</td>
<td>Used to traverse the preview to the previous page in a multi-page output.</td>
</tr>
<tr>
<td>![Next Page]</td>
<td>Used to traverse the preview to the next page in a multi-page output.</td>
</tr>
<tr>
<td>![Zoom Out]</td>
<td>Used to zoom out on the contents of the preview.</td>
</tr>
</tbody>
</table>
The Print Preview dialog box also allows you to set the margins of the output interactively. Follow these steps:

1. Position your cursor over the preview output until you see a red outline and your cursor becomes a double-headed arrow.
2. While the cursor is a double-headed arrow, click and hold your left mouse button and drag the red line to the desired location.
Using the Work Agenda

The Work Agenda displays event (or work) data. These events vary based on the modules and interfaces that have been implemented, but may include switching actions (with Switching Management), outage events (with Outage Management), etc. Events may be in various states, such as **New**, **In Progress**, **Incomplete**, or **Complete**.

This section includes the following topics:

- **Work Agenda Views**
- **Work Agenda Menus and Toolbar**

Work Agenda Views

Work Agenda *views* are filters based on event type and/or status. These filtered views are referred to as *lists* and the list name is displayed on the Work Agenda tab. For example, in the standard Network Management System product offering, the Web Workspace starts with Work Agenda open in the **To Do** list view, which displays all new and unassigned events that require attention, and the tab is labeled “Work Agenda: To Do.”

**Note:** The scope of the data displayed in the Work Agenda is determined by the zones to which you are currently subscribed. See [Taking Authority](#) on page 6-9 for more information about subscribing to zones.

Work Agenda Menus and Toolbar

This section lists and describes the menu options and toolbar icons available in the Web Work Agenda.

**File Menu.** The table below describes the options available on the File menu.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Displays the Print Preview dialog so you can view or print the list.</td>
<td>![Print Icon]</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Work Agenda window.</td>
<td>![Exit Icon]</td>
</tr>
</tbody>
</table>

**Sort Menu** - The table below describes the options available on the Sort menu.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Dialog...</td>
<td>Opens the Sort dialog, allowing you to create, modify, apply, and save user-defined sorts. See <a href="#">Using the Sort Dialog Box</a> on page 6-11.</td>
<td>![Sort Dialog Icon]</td>
</tr>
<tr>
<td>Default</td>
<td>Applies the default sort.</td>
<td>![Default Icon]</td>
</tr>
</tbody>
</table>
**Filter Menu** - The table below describes the options available on the Filter menu.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outages</td>
<td>Displays all outage events.</td>
<td></td>
</tr>
<tr>
<td>Non Outages</td>
<td>Displays all non-outage events.</td>
<td></td>
</tr>
<tr>
<td>Both</td>
<td>Displays both outage and non-outage events.</td>
<td></td>
</tr>
<tr>
<td>Filter Dialog...</td>
<td>Opens the Filter dialog where you can create, modify, apply, and save user-defined filters. See Using the Filter Dialog on page 6-12.</td>
<td></td>
</tr>
<tr>
<td>All</td>
<td>Displays all trouble events of any status.</td>
<td>![All Icon]</td>
</tr>
<tr>
<td>Completed</td>
<td>Displays all completed and cancelled trouble events (that is, events with Status CMP, F-CMP, S-CMP, P-CMP, M-CMP, W-CMP, CNL, F-CNL, and W-CNL).</td>
<td>![Completed Icon]</td>
</tr>
<tr>
<td>Default</td>
<td>Applies the filter for the currently selected view (for example, the To Do list displays only events with Status NEW, S-NEW, P-NEW, M-NEW, UAS, S-UAS, P-UAS, M-UAS, W-UAS, RED, CRT, NFY, and C-CNL).</td>
<td>![Default Icon]</td>
</tr>
<tr>
<td>In Progress</td>
<td>Displays most trouble events that have crew resources associated with them (for example, a crew is onsite and is working to resolve the problem), as well as any trouble event alarms (events with Status ASN, F-ASN, ENR, F-ENR, S-ENR, W-ENR, S-ASN, W-ASN, ONS, F-ONS, S-ONS, W-ONS, SUS, S-SUS, W-SUS, RST, S-RST, RSCH, NFY, and VFY).</td>
<td>![InProgress Icon]</td>
</tr>
<tr>
<td>Incomplete</td>
<td>Displays all incomplete trouble events and events that have maintenance work pending (that is, events with Status INC, S-INC, P-INC, M-INC, MNP, and S-MNP). Incomplete events are events that are complete in the field but the information for them has not been completely entered on the Event Details window.</td>
<td>![Incomplete Icon]</td>
</tr>
<tr>
<td>Switching</td>
<td>Displays all events that have an associated planned switching sheet in a Scheduled (or later) status.</td>
<td>![Switching Icon]</td>
</tr>
<tr>
<td>To Do List</td>
<td>Displays trouble events that require attention, as well as any trouble event alarms (events with Status NEW, F-NEW, S-NEW, P-NEW, M-NEW, UAS, F-UAS, S-UAS, P-UAS, M-UAS, W-UAS, SNT, S-SNT, P-SNT, M-SNT, W-SNT, RED, CRT, RSCH, NFY, VFY, and C-CNL).</td>
<td>![ToDo List Icon]</td>
</tr>
</tbody>
</table>
### Actions Menu - The table below describes the options available on the Actions menu. It also indicates whether the option displays in a pop-up menu when you right-click a row in the Work Agenda.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
<th>Right-Click Y/N</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ack</td>
<td>Acknowledges the selected event.</td>
<td>🔄</td>
<td>Y</td>
</tr>
<tr>
<td>View...</td>
<td>Opens Viewer 1, if not already open, and then focuses Viewer 1 on the device from the selected Work Agenda row.</td>
<td>📐</td>
<td>Y</td>
</tr>
<tr>
<td>Trouble Info...</td>
<td>Opens the Trouble Info window with information about the selected event. See <a href="#">Using the Trouble Info Window</a> on page 7-42 for more information.</td>
<td>📝</td>
<td>Y</td>
</tr>
<tr>
<td>Event Details...</td>
<td>Opens the Event Details window with information about the selected event. See <a href="#">Event Details</a> on page 7-2 for more information.</td>
<td>📝</td>
<td>Y</td>
</tr>
<tr>
<td>Referral...</td>
<td>Opens the Work Queue dialog, allowing you to select a work group to refer the event to and enter any necessary remarks. See <a href="#">Setting the Work Queue</a> on page 7-12 for more information.</td>
<td>📐</td>
<td>Y</td>
</tr>
<tr>
<td>Release Crew(s)...</td>
<td>Opens the Release Crew(s) dialog box, which allows you to release assigned en route or onsite crews from an event. See <a href="#">Releasing Crews from an Event Selected in the Work Agenda</a> on page 7-38 for more information.</td>
<td>🗑️</td>
<td>Y</td>
</tr>
<tr>
<td>Incomplete</td>
<td>Changes the status of the event to an Incomplete status that is appropriate for the selected event (e.g., INC, S-INC, P-INC, M-INC).</td>
<td>📮</td>
<td>N</td>
</tr>
<tr>
<td>Cancel Event</td>
<td>Cancels the selected event. A dialog box opens prompting you for a reason for the cancellation.</td>
<td>🗑️</td>
<td>Y</td>
</tr>
<tr>
<td>Group Events...</td>
<td>Opens the Group Events dialog box, which allows you to manually group, relate, and un-relate events. See <a href="#">Event Grouping</a> on page 7-12 for more information.</td>
<td></td>
<td>N</td>
</tr>
<tr>
<td>Associate Event...</td>
<td>Allows you to associate the selected fuzzy event to a device. See <a href="#">Associating and Unassociating Calls with Devices</a> on page 7-15 for more information.</td>
<td></td>
<td>N</td>
</tr>
<tr>
<td>Send to Mobile</td>
<td>Changes the event status to a Sent status that is appropriate for the selected event (e.g., SNT, S-SNT, P-SNT, M-SNT, W-SNT). Also, if the Sent to Mobile column value happens to be “N” at the time the <strong>Send to Mobile</strong> button is pressed, it will update to a value of “Y”.</td>
<td></td>
<td>N</td>
</tr>
<tr>
<td>Menu Option</td>
<td>Description</td>
<td>Toolbar Icon</td>
<td>Right-Click Y/N</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Find Selection</td>
<td>Scrolls the currently selected event back into view should it scroll off of the list.</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Auto Filter</td>
<td>Allows you to quickly filter the table by the selected cell value.</td>
<td>Y (toggle)</td>
<td></td>
</tr>
<tr>
<td>Auto Filter Off</td>
<td>Turns off any auto filter that has been applied.</td>
<td>Y (toggle)</td>
<td></td>
</tr>
<tr>
<td>Load Completed Events</td>
<td>By default, completed events are not loaded into the Work Agenda on startup for performance reasons. Use this button to load in completed events.</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Load Completed Event…</td>
<td>Opens the Load Completed Event Dialog, which allows you to load a specific completed event by specifying its Event #.</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Event Log…</td>
<td>Opens the Event Log window for the selected event. See Using the Event Log on page 7-22 for more information.</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Switching…</td>
<td>Opens the switching sheet associated with the selected event. If multiple sheets exist, you are prompted to select one. This option is only available if you running Web Workspace for Web Switching Management. See Web Switching Management on page 15-1 for more information.</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>AMR Confirm…</td>
<td>Allows you to request meter pings from the AMR system for the selected event. See Creating AMR Requests on page 7-20 for more information.</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Show AMR Request…</td>
<td>Displays a list of active and completed AMR requests for the selected event.</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Update ERT(s)…</td>
<td>Opens the Update ERT dialog so you can enter a new ERT for all selected events.</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>System-Wide Default ERT…</td>
<td>Opens the System-Wide Default ERT dialog, which allows you to view and modify the system-wide default restoration time value. (Use the Configuration Assistant to set restoration times for specific control zone/device class combinations.)</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Fault Location Analysis…</td>
<td>Displays the Fault Location Analysis tool for the selected fault event.</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Damage Assessment…</td>
<td>Opens the Damage Assessments window, which displays a list of damage assessments associated with the selected event and allows you to add additional damage assessments. See Damage Assessment Window on page 7-16.</td>
<td>Y</td>
<td></td>
</tr>
</tbody>
</table>
Help Menu - The table below describes the options available on the Help menu.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
<th>Right-Click Y/N</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Agenda Help</td>
<td>Opens the online help system to the Work Agenda tool help content.</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>(F1)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>About Web Trouble</td>
<td>Opens a window with environment and software information.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Opening Multiple Work Agenda Windows

You can open more than one Work Agenda. To open a new Work Agenda, select the Work Agenda 1 or Work Agenda 2 option from the Web Workspace Tools menu. The new Work Agenda displays as a tab next on the Web Workspace window, to the right of any existing Work Agenda tabs.

When you select a row in one Work Agenda window, the system automatically selects the row for that event in all other Work Agendas (if the row is not being filtered).

All Work Agendas are subscribed at the same level as the original Work Agenda and other tools, but can have their own dynamic sorts and filters applied. The selected events are shared across the Work Agendas.
Work Agenda Data Fields

The Work Agenda displays the following fields and buttons:

Summary Row

The summary row tabulates data for the events in the displayed (filtered) events list.

- The **Total Events in View** field displays the number of events in the currently displayed view.
- The **Est Cust Out** field displays the number of customers estimated to be affected by the events in the currently displayed view of the Trouble Events list.
- The **Calls** field displays the number of calls entered for the events in the currently displayed view of the Trouble Events list.
- The **Pri Calls** field displays the number of priority calls entered for the events in the currently displayed view of the Trouble Events List.
- The **EMR Cust Out** field displays the number of emergency customers affected by the events in the currently displayed view of the Trouble Events list.
- The **MED Cust Out** field displays the number of medical customers affected by the events in the currently displayed view of the Trouble Events list.
- The **KEY Cust Out** field displays the number of key customers affected by the events in the currently displayed view of the Trouble Events list.
- The **Crews En Route/Onsite** field displays the number of crews en route to/onsite at the events in the currently displayed view of the Trouble Events list.

Directly above the events list, the Sort identifier displays which sort is applied to the list. To the right is the list title, which indicates the list you are viewing (e.g., To Do List, All List, etc.). The **Audio Enabled** checkbox, on the far right, allows you to turn the audible alarm on and off.

Event List Table

- The **Status** column displays the status assigned to the event. See **Event Status Codes** on page A-1 for a complete list of status codes and descriptions.
- The **Event #** column displays the number the system has assigned to the event.
- The **Feeder** column displays the name of the feeder associated with the event.
- The **E/H** column indicates whether or not the event is an emergency or hazardous condition. An “E” in this column denotes extreme emergency, and an “H” in this column denotes hazardous.
- The **Start Date** column contains the date and time the event began.
- The **# Out** column contains the number of customers experiencing an outage for the event.
- The **Run CMI** column contains the current customer minutes interrupted value for the event. Note that this value is automatically updated once a minute. By default, the CMI is 0 for restored events, but this can be customized
- The **# Calls** column contains the number of calls received for the event.
- The **Clues** column contains the clue codes for the calls received, if any.
- The **Phases Out** column contains the phases predicted out for the event.
- The **Device** column contains the name of the device associated with the event.
- The **Location** column contains either the address of the first customer that called if the event is a service outage or non-outage or the feeder location of the device if the event is a device outage.
• The **Crew** column contains the crew ID(s) of the associated crew(s).

• The **Est Restore Time** column contains the estimated restoration time (ERT) for the event.

• The **Est Src** column contains the source of the ERT for the event. The possible values for the ERT Source, from highest precedence to lowest, are as follows:
  - C: User-entered via applications or tools (for example, mobile interface, Work Agenda, Event Details, or Crew tools) other than Storm Management.
  - G: Storm Management published global ERT from the ERT Override dialog.
  - D: Storm Management published global ERT delay from the ERT Override dialog.
  - P: Storm Management non-published global ERT from the ERT Override dialog.
  - M: Maximum ERT exceeded. The Storm Management calculated ERT is beyond a set threshold for maximum ERT; no ERT is shown.
  - O: Storm Management onsite ERT calculated when the event status goes to en route and updated when the status changes to onsite.
  - S: Storm Management calculated ERT based on outages and crews in Storm Management
  - I: Initial default ERT, based on the system-wide default ERT (if set) or else configured default ERT based on device class and control zone
  - N: none (no ERT)

• The **Pred Type** column contains the type of prediction (e.g., New, Revised, Device Operation, etc.) or type of notification for NFY events (e.g., Crew contact required).

• The **Restore Date** column contains the actual restoration date and time of the event.

• The **# Crit** column contains the total number of critical customers experiencing an outage for the event.

• The **# EMR** column contains the number of emergency customers experiencing an outage for the event.

• The **# MED** column contains the number of medically urgent customers experiencing an outage for the event.

• The **# KEY** column contains the number of key customers experiencing an outage for the event.

• The **Evt Type** column contains a description of the type of event. See **Event Type Codes** on page A-3 for a complete list of event type codes and their descriptions.

• The **Work Queue** column contains the name of the work group queue that the event has been referred to.

• The **Region** column contains the control zone region where the event occurred.

• The **Branch** column contains the control zone branch where the event occurred.

• The **Substation** column contains the control zone substation where the event occurred.

• The **Plan #** column contains the switching sheet number associated with the event, if any. The switching sheet number is prefixed by the switching sheet type (such as “Plan” or “Emer”).
• The **Grp Type** column indicates whether the event is manually grouped or related. The possible types are:
  - GRP – manually grouped
  - REL – manually related

• The **Rel Event #** column contains the event number of the parent or lead event when the event has a special relationship with one or more other events.

• The **Rel Type** column contains the type of special relationship that the event is involved in. The possible types are:
  - L – lead event of a partial restoration
  - M – momentary
  - N – nested
  - P – non-lead event of a partial restoration
  - R – manually related
  - S – switching (relationship between switching jobs and planned outages)

• The **Sent to Mobile** column indicates whether or not the event is in a state that makes it eligible to be sent to the mobile system.

• The **AMR Requested** column indicates whether or not a request was made to the AMR system to verify power to the meter.

• The **Dmg Asmt** column contains a value of 'Y' if the event has damage assessment associated with it; otherwise, the column contains 'N'.

• The **Operations Event Note** field, below the list, displays the Operations Event Note for the selected event, if any.

**Filtering, Sorting, and Selecting Columns**

When you right-click the events table header in the Work Agenda table header, a pop-up menu displays a list of options that allow you to perform the following functions:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter...</td>
<td>Displays the Filter Dialog so you can create, modify, apply, and save user-defined filters. See Using the Filter Dialog on page 6-12.</td>
</tr>
<tr>
<td>Sort...</td>
<td>Displays the Sort Dialog so you can modify the default sort. See Using the Sort Dialog Box on page 6-11.</td>
</tr>
<tr>
<td>Select Columns...</td>
<td>Opens a dialog that displays a list of columns that can be displayed in the Work Agenda table. A checkmark appears next to columns that are currently displayed. To remove a column from the table, uncheck the box. To add a column that is not currently displayed, check the box. Click OK to exit. Note: These settings are applied immediately and affect only the current user session. To save these settings as the default view for the Work Agenda (for the currently logged-in user), select User Preferences from the Tools menu, then click Save.</td>
</tr>
</tbody>
</table>

The Work Agenda table supports **Quick Sorting**, **Dynamic Filtering**, and **Auto Filtering**.
Using the Web Workspace Viewer

The Viewer presents a graphical representation of the electrical distribution system, with additional symbology for conditions such as outages, crew locations, notes, tags, etc. The Viewer dynamically updates with condition and electrical distribution changes.

This section includes the following topics:

• Starting the Viewer
• Understanding the Viewer Window
• Displaying Device Details
• Understanding the Viewer Coloring (View) Mode
• Searching and Loading Viewer Maps
• Navigating in the Viewer
• Viewer Focus
• Using Feeder Focus
• Toggling Between Real-Time and Study Mode
• Selecting Devices
• Identifying Symbology
• Hiding and Displaying Viewer Objects
• Executing Traces
• Using the Commissioning Tool

Starting the Viewer

To open a Viewer window, select the Viewer 1... option on the Web Workspace Tools menu. To start a second Viewer, select Viewer 2... After you have opened the viewer, selecting the menu option will change the focus to that viewer window.
Understanding the Viewer Window

The following diagram shows the functional areas of the Viewer:

1. Menu Bar
2. Toolbar
3. Document Indicator
4. Pan and Zoom Controls
5. Drawing Area
6. Tag Symbol
7. Outage Symbol
8. Crew Symbol
9. Note Indicator
10. Scale Legend
11. Mode and View Indicator
12. Message Area

**Drawing Area**

The drawing area of the Viewer window displays dynamic maps that reflect the real-time status of the system. The icons and lines used to represent devices and conductors are called symbols, and the conventions that govern them are referred to as “symbology.”

**Message Area**

The message area of the Viewer is where the Viewer displays an indication of the global device, which could be selected in or outside the Viewer. This area displays the device alias, the feeder name, and the substation name.
# Menus and Toolbar

The menus and toolbar in the Viewer provide access to common functions.

## File Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Toolbar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Opens the Print Preview window, which allows you to print the contents of the Viewer window.</td>
<td>![Print Button]</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the Viewer.</td>
<td>![Exit Button]</td>
</tr>
</tbody>
</table>

## Actions Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Toolbar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>[Keyboard Shortcut]</strong></td>
<td>Description</td>
<td>Toolbar Button</td>
</tr>
<tr>
<td>Search</td>
<td>Opens the Search dialog box, which allows you to enter search criteria and execute a search in the Viewer.</td>
<td>![Search Button]</td>
</tr>
<tr>
<td>Hide/Display...</td>
<td>Opens the Hide / Display dialog box, which allows you to select the types of information that are displayed on the map. See <strong>Hiding and Displaying Viewer Objects</strong>.</td>
<td>![Hide Button]</td>
</tr>
<tr>
<td>Back</td>
<td>Moves to the previous view before a pan, zoom, or object focus operation (if any) changed the focus location in the Viewer. This button functions similar to a web browser's back button, storing a dozen “views.”</td>
<td>![Back Button]</td>
</tr>
<tr>
<td>Forward</td>
<td>Moves to the next view if the Back button has been used. It functions similar to a web browser's forward button.</td>
<td>![Forward Button]</td>
</tr>
<tr>
<td>Feeder Focus [F]</td>
<td>Shows only the selected device's feeder at a zoom level that will allow the Viewer to display the feeder in its entirety.</td>
<td>--</td>
</tr>
<tr>
<td>Zoom In [Z]</td>
<td>Zooms in on the map to show a smaller area in more detail.</td>
<td>--</td>
</tr>
<tr>
<td>Zoom Out [Shift-Z]</td>
<td>Zooms out on the map to show a larger area.</td>
<td>--</td>
</tr>
<tr>
<td>Text Bigger [Shift-T]</td>
<td>Increases the text font size.</td>
<td>![Bigger Text Button]</td>
</tr>
<tr>
<td>Text Smaller [T]</td>
<td>Decreases the text font size.</td>
<td>![Smaller Text Button]</td>
</tr>
<tr>
<td>Symbols Bigger [Shift-S]</td>
<td>Increases the size of symbols.</td>
<td>![Bigger Symbols Button]</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Toolbar Button</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Symbols Smaller [S]</td>
<td>Decreases the size of symbols.</td>
<td></td>
</tr>
<tr>
<td>Reset Scale [R]</td>
<td>Resets the size of both symbols and text to its default size.</td>
<td></td>
</tr>
<tr>
<td>Focus</td>
<td>Focuses the Viewer on selected devices or devices associated with selected events.</td>
<td></td>
</tr>
<tr>
<td>Load Maps [M]</td>
<td>Allows you to explicitly load additional maps to display more of the surrounding area or additional detail.</td>
<td></td>
</tr>
<tr>
<td>Unload Maps [Shift-U]</td>
<td>Unloads all maps, not just those in the visible drawing area.</td>
<td></td>
</tr>
<tr>
<td>Commissioning Tool...</td>
<td>Opens the Commissioning Tool, which allows you to commission a device that is currently in construction, or to decommission devices currently marked for removal.</td>
<td></td>
</tr>
<tr>
<td>Feeder Name(s) [Shift-F]</td>
<td>Causes the right status bar to display the names of the feeders and substations feeding the selected device for parallel or meshed conditions; for tie points, it will display the names of both feeders.</td>
<td></td>
</tr>
<tr>
<td>Save View Area...</td>
<td>Saves the viewing area after prompting for a name for the saved area. If a view area already exists with that name, you will be asked if you want to replace it.</td>
<td></td>
</tr>
<tr>
<td>Delete View Area...</td>
<td>Deletes the viewing area after prompting for confirmation.</td>
<td></td>
</tr>
</tbody>
</table>

### DMS Menu

This menu is only displayed if the Distribution Management System is licensed for your system.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Toolbar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feeder Load Management..</td>
<td>The Feeder Load Management button opens the Feeder Load management window.</td>
<td></td>
</tr>
<tr>
<td>Suggested Switching...</td>
<td>Displays the Suggested Switching wizard. This option is only enabled if a device is currently selected in the Viewer and you are using Web Workspace with Web Switching Management. See Using Suggested Switching on page 16-8.</td>
<td></td>
</tr>
<tr>
<td>Volt/VAr Optimization..</td>
<td>Displays the Volt/VAr Optimization wizard. This option is only enabled if a device is currently selected in the Viewer and you are using Web Workspace with Web Switching Management. See Using Volt/VAr Optimization on page 16-14.</td>
<td></td>
</tr>
</tbody>
</table>
Options Menu

<table>
<thead>
<tr>
<th>Option (</th>
<th>Description</th>
<th>Toolbar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Phases</td>
<td>Sets the Viewer's drawing areas to show conductor coloring by phases.</td>
<td>--</td>
</tr>
<tr>
<td>View Feeders</td>
<td>Sets the Viewer drawing area to feeder coloring mode.</td>
<td>--</td>
</tr>
<tr>
<td>View Currents</td>
<td>Sets the Viewer's drawing areas to show coloring by the current range.</td>
<td>--</td>
</tr>
<tr>
<td>View Loading</td>
<td>Sets the Viewer's drawing areas to show coloring by load (i.e., per unit current).</td>
<td>--</td>
</tr>
<tr>
<td>View Voltage Per Unit</td>
<td>Sets the Viewer's drawing areas to show coloring by per unit voltage (i.e., per unit voltage range).</td>
<td>--</td>
</tr>
<tr>
<td>View Nominal Voltages</td>
<td>Sets the Viewer's drawing areas to show coloring by the nominal voltage range.</td>
<td>--</td>
</tr>
<tr>
<td>Show Flow Direction [D]</td>
<td>Overlays flow direction arrows the selected view option.</td>
<td>--</td>
</tr>
<tr>
<td>Big Symbols [Shift-B]</td>
<td>Allows you to toggle Big Symbols on or off. Displays a checkmark if big symbols are currently displayed.</td>
<td>--</td>
</tr>
<tr>
<td>Real Time</td>
<td>If you are currently in Study mode, select this to switch to real-time mode.</td>
<td>--</td>
</tr>
<tr>
<td>Study</td>
<td>If you are currently in real-time mode, select this to switch to Study mode.</td>
<td>--</td>
</tr>
<tr>
<td>Reset Study Session...</td>
<td>Resets the study session to either the current real-time model or the nominal model.</td>
<td>--</td>
</tr>
<tr>
<td>Close Study Session</td>
<td>Closes the current study session.</td>
<td>--</td>
</tr>
<tr>
<td>Power Flow Real-Time Options...</td>
<td>The Power Flow Options button opens the Power Flow Options dialog.</td>
<td>--</td>
</tr>
</tbody>
</table>
Help Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer Help [F1]</td>
<td>Opens online help content for the Viewer.</td>
</tr>
<tr>
<td>About Web Workspace</td>
<td>Opens the About dialog with information on the release version and related system information.</td>
</tr>
<tr>
<td>Legend</td>
<td>Opens the Viewer Legend window that displays information about the current Viewer view. See Understanding the Viewer Coloring (View) Mode on page 6-34 for more information.</td>
</tr>
</tbody>
</table>

Additional Toolbar Options

The following toolbar options do not have corresponding menu options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The Control Tool button toggles the Control Tool mode on or off. If on, this mode opens the Control Tool dialog box when you select a device in the Viewer. This button also toggles off the Trace button (exiting Trace mode) if it was on.</td>
</tr>
<tr>
<td></td>
<td>The Trace button toggles the Trace mode on or off. If on, this mode opens the Trace dialog box when you select a device in the Viewer. This button also toggles off the Control Tool button (exiting Control Tool mode) if it was on.</td>
</tr>
<tr>
<td></td>
<td>The Supply Points Mode button causes the Viewer to display supply points for potential selection. This allows supply points to be graphically grouped and added to an outage.</td>
</tr>
<tr>
<td></td>
<td>The Device Details button toggles device details on or off. See Displaying Device Details on page 6-32.</td>
</tr>
</tbody>
</table>

Context Menu Options

When you right-click on certain objects in the Viewer window, a context menu displays a list of options available for the selected object.

Crew Options

The following options are displayed when you right-click a crew symbol in the Viewer window:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign</td>
<td>Assigns the crew selected in the Viewer to the event currently selected in Work Agenda. See Assigning a Crew on page 7-30 for more information.</td>
</tr>
<tr>
<td>Release Crew</td>
<td>Releases the crew selected in the Viewer from the en route/onsite event selected in the Work Agenda. See Releasing a Crew from an Event on page 7-38 for more information.</td>
</tr>
</tbody>
</table>
Using the Web Workspace Viewer

### Event Options
The following options are displayed when you right-click on an event symbol in the Viewer window:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crew Info...</td>
<td>Opens the Crew Info dialog for the selected crew. See Crew Info on page 7-34 for more information.</td>
</tr>
<tr>
<td>Active Job Info...</td>
<td>Opens the Active Job Info dialog for the selected crew. This is enabled only if an en route or onsite crew is selected. See Active Job Info on page 7-36 for more information.</td>
</tr>
<tr>
<td>Show En Route Location...</td>
<td>Shows the AVL location of the crew that is currently en route to the selected event. This option is only available for AVL crews.</td>
</tr>
<tr>
<td>Release Crews</td>
<td>Releases all assigned, en route, and onsite crews from the event selected in the Viewer. See Releasing a Crew from an Event on page 7-38 for more information.</td>
</tr>
</tbody>
</table>

### Device Options
The following options are displayed when you right-click on a device in the Viewer window:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Tool...</td>
<td>Opens the Control Tool.</td>
</tr>
<tr>
<td>Device Details...</td>
<td>Displays the Device Details balloon dialog above the selected device.</td>
</tr>
<tr>
<td>Trace...</td>
<td>Opens the Trace Tool, which allows you to display the path from a selected device to other devices based on specific criteria.</td>
</tr>
</tbody>
</table>
Displaying Device Details

Device Details provides information about devices selected in the Viewer. Device Details is enabled by clicking the Device Details button in the Viewer’s toolbar or by right-clicking a device and selecting Device Details... from the options menu.

![Device Details window](image)

Note: the Viewer's Device Details button is highlighted ( ) when enabled.

When enabled, selecting a device will automatically launch a balloon-style window above the device in the Viewer. Device Details has four tabs that provide the following information:

- **Device Info**: The information contained in the Device Info tab varies depending on the type of device and its current condition, but may include the following types of information:
  - Event information, such as number of customers affected, when the event began, estimated restoration time, event type, event number
  - Event Note
  - Location
  - Device Notes
  - Crew information
- **SCADA**: The SCADA tab is only enabled in systems that have implemented SCADA Extensions; see Displaying SCADA Measurements with Device Details on page 13-5 for details.
- **Power Flow Results**: The Power Flow Results tab is only enabled in systems that have implemented Power Flow Extensions; see Viewing Power Flow Results in Real-Time on page 16-4 for details.
- **Fault Details:** The Fault Details tab shows fault currents at the select point in the model. Depending on the conductor selected, data will be displayed for the following fault types:
  - Single Phase Fault
  - Line to Line Fault
  - Three Phase Fault

Click the \( ? \) icon to display help for the active Device Details tab.
Understanding the Viewer Coloring (View) Mode

When the Viewer is launched, the network model is displayed in Feeder View mode where all conductors fed from a given feeder are displayed in the same color. The View mode indicator is displayed in the Viewer's status bar next to the Real-Time/Study Mode indicator.

Changing the Coloring Mode

To change to a different coloring mode, select the view from the Viewer Options menu. For example, to change to the Phase coloring mode, select View Phases from the Options menu.

Viewing the Color Legend

To see the color legend for the view, select Legend... from the Viewer Help menu. Certain coloring rules (i.e., Energized, Abnormally Radial) display the default color in the legend, but get overridden by the feeder color for each specific circuit.

Searching and Loading Viewer Maps

In order to view a specific geographic area, you must load the map(s) for that area. Devices and objects that are located within that geographic area will display in the drawing area. To load the associated map(s), you can first select an area using the Search dialog box.

Using the Search Tool to Locate Map Areas and Objects

To locate a particular area or object in the Viewer, complete these steps:

1. Click the Search button ( ) on the Viewer toolbar. The Search dialog box opens.
2. Select the Search Type you wish to perform (Exact Match, Wildcard Before, Wildcard After, Wildcard Before and After, Soundex) from the Search Type option menu.
3. Select the Search Case option you wish to use (Case Insensitive, Case Sensitive) from the Search Case option menu. Case Sensitive means that “elbow” won’t match “ELBOW”.
4. Enter your search result limit in the Search Result Limit field (default value is 100).
5. Click the desired search field and either enter search criteria or leave the field blank to return all possible values.
6. Press ENTER or click the Search button.
7. If there is only one match, the Viewer will shift focus to the search result. If there are multiple matches, a Search Results dialog box displays the search results and the Search dialog box closes. For example, an Intersection search using the term Oaklynn returns six matches.

8. Select a row in the Search Results dialog box and click the OK button. The object appears centered in the Viewer and the Search Results dialog box closes.

   **Note:** If none of the results are what you wanted, click Cancel in the Search Results dialog box. The Search Results dialog box closes and the Search dialog box is redisplayed.

### Loading and Unloading Viewer Maps

Once you have located an area or object using the Search dialog box, you can navigate to an adjacent area where the maps are not yet loaded. From here, you can load all the maps that should appear in the drawing area.

To load maps, do one of the following:

- Select **Load Maps** from the Actions menu, or
- Press the M key, or
- Click the **Load Maps** button ( ) on the toolbar.

To unload all maps (not just those in the visible drawing area), do one of the following:

- Select **Unload Maps** from the Actions menu, or
- Press Shift-U, or
- Click the **Unload Maps** button ( ) on the toolbar.

   **Note:** unless your system is configured to unload maps with each focus, any loaded maps will continue to be loaded until you explicitly unload maps or you switch mode (i.e., from study to real-time or from real-time to study).

   If there are more devices displayed than the configured maximum, which is 500,000 in the product configuration, the viewer will unload the maps that have the oldest access time to get the total under the limit.
Navigating in the Viewer

There are a number of ways to navigate around the Viewer:

- Pan left, right, up, down, or diagonally in the map using the pan compass, shown below.
  ![Pan Compass](image)

  Click the ^ button (center top) to pan the map to the north; click the > button to pan to the east; click the button in the top right corner to pan to the northeast; etc.

- Use the + and - buttons to zoom in and out. You can also drag the zoom slider (shown below) toward the plus sign to zoom in or toward the minus sign to zoom out.
  ![Zoom Slider](image)

  The scale indicator (shown below) displays the current zoom scale.
  ![Scale Indicator](image)

  The scale is hidden if a schematic view, such as a substation, is selected.

- Navigate using your mouse controls, as described in the next section.

- Navigate to a device using the Object Focus feature. See Viewer Focus on page 6-37.

Navigating Using Mouse Controls

There are various mouse controls you can use to navigate within the Viewer. The following table shows all of the mouse commands for the Viewer.

<table>
<thead>
<tr>
<th>To…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an object</td>
<td>Click the left mouse button.</td>
</tr>
<tr>
<td>Select multiple objects</td>
<td>Press and hold the &lt;Shift&gt; key, then click and hold the left mouse button and draw the rectangle around the objects you want to select. This opens the Select a Device dialog box that lists all objects in the selected area.</td>
</tr>
<tr>
<td>Box Zoom</td>
<td>Box Zoom allows you to focus in on an object by &quot;boxing in&quot; the area you want to focus on. Click and hold the middle mouse button to begin drawing the rectangle and release it to complete drawing the rectangle.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Click the middle mouse button or scroll the mouse scroll wheel upward (if available).</td>
</tr>
</tbody>
</table>
Viewer Focus

The Viewer's **Focus** option is context aware and will function according to your selection.

- If you select an object in the Viewer, clicking the Viewer Focus button will focus on that object.
- If you select an event in the Work Agenda and click the Viewer Focus button, the Viewer will focus on the device/object associated with the event.

**Focus on Viewer Selection**

If you select an object in the Viewer and click the Focus button, the Viewer will center the object and zoom in/out as necessary. If the object is part of a schematic view, the first Focus action will display the object in the schematic view. Each successive click will cycle the Viewer through alternate schematic views, if available, until it cycles back to the standard topology view.

**Note:** The Operator's Workspace Viewer has a schematics generation utility that will replace schematic views as the model changes. The Web Workspace Viewer does not have this automatic schematic generation capability, so viewing schematics may not reflect the current state of the network.

**Example: Substation Breaker Focus**

1. A substation breaker is selected.
2. Click Focus; the first schematic view appears with the device centered in the schematic view.

3. Click Focus; a more zoomed in schematic appears that provides more detail on the substation, but without the feeder lines.

4. Click Focus to return to the original network view.

**Focus on Selection Made in another Window**

When you make a selection of an event in another window (e.g., the Work Agenda) and click the Viewer Focus button, the Viewer will find the device and focus the drawing area on it.
Using Feeder Focus

At times, you may want to view only the devices on the same feeder as the selected device. The Viewer offers a Feeder Focus feature that traces from the selected device back to its feeder breaker and to all downstream devices on the same feeder.

**Note:** The Feeder Focus feature uses the real-time status or the status from the current study session. It does not display devices that may be part of the feeder in the nominal configuration but not currently part of the feeder.

The Feeder Focus feature should not be used at times of heavy system activity such as those that occur when there are many outages in the system caused by major events and storms.

To use the Feeder Focus feature, complete these steps:

1. Select a device in the Viewer drawing area.
2. Select **Feeder Focus** from the Actions menu. All symbols disappear except the feeder the device is on.
3. To turn Feeder Focus off and show all the symbols again, select **Feeder Focus** again.

Unlike tracing, no other electrical devices are shown except those on the selected feeder. The Feeder Focus will not include de-energized downstream devices. While in Feeder Focus, you can still use Hide/Display, Declutter, and Big Symbols.

Toggling Between Real-Time and Study Mode

Oracle Network Management System applications start in real-time mode, where every action you perform is applied to the real-time model and displayed to all users. Certain windows (the Viewer and the Control Tool) allow you to change to study mode, where your actions are reflected in your study session on your workstation, but not recorded in the real-time model. Study mode is especially useful in “what if” studies, when you need to evaluate the effects of an action before you record it in real-time.

When in real-time mode, the Viewer displays status, topology, and condition information based on real-time operations information. All changes to these items made by any user in real-time mode are reflected on all real-time Viewers in the system.

When in study mode, the Viewer displays only status and topology changes you make on your workstation. Changes made in your study session are not reflected in the real-time model, and likewise changes made in real-time are not reflected in your study session.

A study session is created for a specific workstation the first time you put the Viewer into study mode. The study session is initially created as a copy of the current real-time model. From that point on, changes in the study session and real-time are independent of each other. You can reset the study session to current real-time by using the Study Session Control tool. In addition, some Web Switching Management actions can also cause study session resets. Please refer to the Web Switching Management chapter for more information.

**Note:** It is recommended that you reset study session(s) to real-time as often as makes sense (e.g., when starting a new switching plan, testing a new ‘what if’ scenario, etc.). This is especially important during high load periods (e.g., a storm).

Switching to Study Mode

To toggle the Viewer to study mode, do one of the following:

- Select **Study** from the Options menu, or

- Click on the button on the toolbar.
The Viewer window borders change color to gray.

- You can reset the study session to either the current real-time model or the nominal model using the Viewer's Reset Study Session… button in the Options menu.

**Switching to Real-Time Mode**

To toggle the Viewer back to real-time mode, do one of the following:

- Select Real Time from the Options menu, or
- Click on the button on the toolbar.

The Viewer window borders and dialog boxes change color back to red.

**Selecting Devices**

**Single Device Selection**

To select a single device in the Viewer, simply move the mouse over the desired device and left-click the mouse. The Viewer will select the highest priority device that is closest to the mouse but still within the configured selection-radius. Problems may occur if the selection-radius is set too high and if the area clicked has a multiple devices in close proximity. If that is the case, then you may want to select multiple devices using box selection and then select the device from the Select a Device dialog box list of devices within the selection area.

**Multiple Device Selection (Box Selection)**

To perform a box selection, hold down the <Shift> key, click the left mouse button, and drag across the Viewer window to create a selection box. When you release the left mouse button, the Select a Device dialog box appears and is populated with all devices inside the selection box. Click any device in the list to highlight it in the Viewer; highlighting changes the device symbology to the selection color, but the device is not selected until a selection action is initiated.

The Select a Device dialog box provides the following actions:

- **Select** - selects the highlighted device and closes the dialog box.
- **Control Tool** - selects the highlighted device, opens its Control Tool, and closes the dialog box.
- **Device Details** - selects the highlighted device, opens the Device Details window above the device in the Viewer, and closes the dialog box.
- **Cancel** - closes the dialog box. The last highlighted device, if any, will remain highlighted in the Viewer, but will not be selected for subsequent Viewer actions.

In Supply Points mode, the Device Selection dialog box does not appear; instead all supply points inside the box are selected. (To enable this mode, click the Supply Points Mode button on the Viewer toolbar.)

**Polygon Selection**

An advanced form of box selection is polygon selection. To begin a polygon selection, hold down both the <Alt> key and click the left mouse button. This places the first anchor point. Each subsequent Alt-left click adds another vertex. To complete the polygon, hold down Alt and click the right mouse button. This will finish the polygon by connecting the last vertex to the first vertex.

In single-select mode, when you release the right mouse button, the Device Selection dialog box will appear with all devices that were inside the polygon. In Supply Points mode, all supply points inside the polygon are selected. (To enable Supply Point Selection mode, click the Supply Points Mode button on the Viewer toolbar.)
**Multiple Selections**

When not in Supply Point Selection mode, only a single device can be selected at any given time. If you are in Supply Point Selection mode, you can modify your existing selection by holding the <Ctrl> key. (To enable Supply Point mode, click the Supply Points Mode button on the Viewer toolbar.)

Ctrl-left click on an unselected device will add it to your selection. Control-left click on a selected device to remove it from your selection. Holding the <Ctrl> key while doing a box selection will add any unselected devices in the box.

**Identifying Symbology**

**Device Symbology**

Changes in the status of a device (e.g., switches, fuses, breakers, etc.) are reflected by changes in symbology. For example, an open switch is a different color and shape than a closed switch. Standard device symbology uses certain conventions such as a red or brown device is closed, a green device is open, a large circle around a device indicates off-nominal, etc.

---

Overhead Transformer
Switch (Closed)
Switch (Open)
Capacitor

Pad-Mounted Transformer
Elbow
Fuse
SCADA Breaker
**Condition Symbology**

Dynamic conditions on a device (e.g., “predicted service outage,” “crew on-site,” “notes,” etc.) are indicated with specific symbols attached to the device to which the conditions apply.

Condition symbols display in specific areas around a device or object. The following table provides examples of where condition symbols display in relation to the device they are attached to. The following figure displays the Viewer with probable device outage, crew on-site, note and tag conditions.

<table>
<thead>
<tr>
<th>Area</th>
<th>Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>Above Left</td>
<td>Tags</td>
</tr>
<tr>
<td>Above Right</td>
<td>Probable Service/Device Outages</td>
</tr>
<tr>
<td></td>
<td>Real Outages</td>
</tr>
<tr>
<td>Below Left</td>
<td>En route/Onsite Crews</td>
</tr>
<tr>
<td>Below Right</td>
<td>Notes</td>
</tr>
<tr>
<td></td>
<td>Call Clues</td>
</tr>
</tbody>
</table>

**Conductor Symbology**

Conductor symbology changes color, dash patterns, and thickness for different types of conductors and topology states.

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Line Pattern</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overhead Line</td>
<td>Solid</td>
<td>Varies</td>
</tr>
<tr>
<td>Underground Cable</td>
<td>Dashed</td>
<td>Varies</td>
</tr>
<tr>
<td>Deenergized</td>
<td>Dashed</td>
<td>Black-White</td>
</tr>
<tr>
<td>Partially Energized</td>
<td>Dashed</td>
<td>Black-Grey</td>
</tr>
<tr>
<td>A Phase</td>
<td>Thin</td>
<td>Red</td>
</tr>
<tr>
<td>B Phase</td>
<td>Thin</td>
<td>Yellow</td>
</tr>
<tr>
<td>C Phase</td>
<td>Thin</td>
<td>Blue</td>
</tr>
<tr>
<td>Loop</td>
<td>Magenta</td>
<td></td>
</tr>
<tr>
<td>Parallel</td>
<td>Purple</td>
<td></td>
</tr>
</tbody>
</table>
**Off-Nominal (Abnormal) Status Symbology**

The table below illustrates how symbology identifies devices in off-nominal (abnormal) states.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Example Image 1" /></td>
<td>This illustration shows three 3-phase switches (marked A, B, and C) in their normal states. Switch A is normally open; Switches B and C are normally closed.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Example Image 2" /></td>
<td>When Switch C is opened, an outage is created (indicated by the RO symbol) and the downstream circuit is de-energized. The symbol for Switch C changes from red (closed) to green (open), and a green circle appears around it to indicate that it is abnormally open.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Example Image 3" /></td>
<td>Switch A is closed to re-energize the circuit. The switch symbol changes to red (closed) and a red circle appears around the switch to indicate that it is abnormally closed.</td>
</tr>
</tbody>
</table>
SCADA Symbology

The system displays a cyan S to indicate that a device has SCADA measurements available for it.

Viewing Big Symbols

To make the symbols for disconnects, breakers, and conditions prominent while zoomed out, click on the Big Symbols button from the Options menu. The symbols remain large even as you zoom out but will still disappear at standard Declutter levels.
Hiding and Displaying Viewer Objects

At times, the maps in the Viewer become cluttered with symbols of all kinds. To help you focus on certain devices or conductors, the Viewer offers a Hide/Display feature that will hide classes of objects. The Hide/Display dialog box allows you to select the objects that you want displayed on the maps in the Viewer.

To change the objects that are displayed in the Viewer, complete these steps:

1. Click the Hide/Display (Hide/Display) toolbar button.
2. Click on the check boxes to designate which objects you want displayed in the Viewer. Objects to be displayed are checked; objects to be hidden are not. Objects include:
   - Landbase - Refers to the display of landbase data from the Map Definition Utility.
   - Landbase Text - Refers to the display landbase text from the Map Definition Utility.
   - Overhead Conductors
   - Underground Cables
   - Electrical
   - Supply Nodes
   - Electrical text
   - Measurements - Refers to SCADA measurements. For more information, see SCADA Measurements on page 13-2.
   - Declutter (On/Off) - See Decluttering the Viewer on page 6-46 for details.
   - Hide Conditions with Devices (On/Off) - See Hiding Conditions with Devices on page 6-46 for details.
   - Spatial Landbase - Refers to the display of Spatial Landbase data from an Oracle Locator or Oracle Spatial base map defined using Oracle MapBuilder. MapBuilder is a standalone graphical tool for creating and editing styles, themes, and base maps. It replaces the Map Definition Utility that was provided in previous releases.
   - The first drop-down allows you to define the Network Level to display. Options are:
     - All Primary (the default)
     - Backbone Only
     - Primary and Secondary
     - Backbone and Lateral
   - The second drop-down allows you to configure the display of Phases. Options are:
     - All Phases (the default)
     - 3-Phase Only
     - Multi-Phase
   - The third drop-down allows you to configure the Construction Pending display. Options are:
     - Hide Pending Devices (the default)
     - Show Pending Devices
3. Click the Refresh button to refresh the Viewer area based on your settings.
4. Click the Close button.
Decluttering the Viewer
The Viewer automatically hides objects based on pre-defined declutter zoom levels. This allows you to only see high-level information at higher zoom levels, removing small text and other items that are no longer readable at that zoom level. When an object is decluttered, any associated conditions and text will also be decluttered. The declutter option in enabled by default, but you can turn it off by unchecking the Declutter (ON/OFF) option in the Hide/Display dialog box (see previous section for details).

Hiding Conditions with Devices
The Hide Conditions with Devices option, which is checked (i.e., “on”) by default, will hide all conditions when their associated devices are hidden, either due to other Hide/Display options or decluttering. When not checked, the conditions will always display, even when their devices do not.

Executing Traces
The trace feature allows you to display the path from a selected device to other devices based on specific criteria. The trace path is displayed on the Viewer by changing all conductors that are part of the path to a thick light blue.

This section includes the following topics:

- Trace Types
- Executing a Trace
- Inspecting Direct Connections and Navigating to Connected Objects
- Performing Repeated Traces

For a description of the fields and buttons on the Trace dialog box, see Using the Trace Dialog Box.

Trace Types
The following table describes the various types of traces.

<table>
<thead>
<tr>
<th>Trace Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Connected</td>
<td>Traces from the selected device to all connected devices, stopping only at energizing sources.</td>
</tr>
<tr>
<td>To Transformer</td>
<td>Traces from the selected device to upstream and downstream transformers.</td>
</tr>
<tr>
<td>To Switch</td>
<td>Traces from the selected device to upstream and downstream switches.</td>
</tr>
<tr>
<td>To Source</td>
<td>Traces from the selected device to its energizing source.</td>
</tr>
</tbody>
</table>

Using the Trace Dialog Box
Use the Trace dialog box to execute traces of all types.

To display the Trace dialog box, click the Trace button on the Viewer toolbar and select an object. The Trace dialog displays the following fields and buttons:

- The first drop-down menu allows you to select the trace type, as described in the table above.
- The second drop-down menu contains the options for the trace direction:
  - **Upstream** - Constrains the trace to be only upstream of the selected device.
  - **Downstream** - Constrains the trace to be only downstream of the selected device.
  - **All** - Allows the trace to be both downstream and upstream of the selected device.
Using the Web Workspace Viewer

**Note:** Tracing all connected devices will automatically trace both upstream and downstream. Tracing to source will automatically trace upstream.

- The third drop-down menu allows you to select the trace mode:
  - **Current Session** - Performs the trace by using statuses currently displayed in the Viewer. This is the default.
  - **Nominal** - Performs the trace by assuming nominal statuses for all devices.
- The checkboxes enable you to select specific phase(s) to trace. By default, all available phases on the selected object are checked.

### Advanced Trace Dialog Fields

Click the **Advanced** button in the bottom-right corner of the Trace dialog to display additional information about the selected object, including detailed topology. You can also inspect direct connections and navigate to connected objects.

When you click the Advanced button, the Trace dialog expands to display the following information:

- **Device Details** section displays the following device information:
  - Device type
  - Device handle
  - Network Component Group (NCG)
  - Map containing the device
  - Display group

- **Symbol Details** section displays the following symbol information:
  - Symbology class
  - Symbol ID
  - Coloring status
  - Valid statuses
  - Coloring rule

- **Connectivity Details** section displays the following connection information:
  - Feeders
  - Current statuses
  - Nominal statuses
  - Other statuses

- **Connections** section displays a list of connected nodes for the selected object. You can expand the list of connections for each node and focus the Viewer on an object in the list. For more information, see *Inspecting Direct Connections and Navigating to Connected Objects* on page 6-49.

### Trace Dialog Toolbar

- **Trace** toolbar button executes the trace.
- **Clear** toolbar button erases the trace color from the Viewer and returns to normal color.
- **Refresh** toolbar button performs the trace again. This is useful if devices have been operated or the model was rebuilt.
- **Help** toolbar button displays online help for the Trace function.
The **Exit** toolbar button removes the trace display from the Viewer drawing area and exits the Trace Tool.

## Executing a Trace

To execute a trace, complete these steps:

1. Click the **Trace** button on the Viewer toolbar to enter Trace mode.
2. In the Viewer drawing area, select the device you want to trace from. The Trace dialog opens. (See **Using the Trace Dialog Box** on page 6-46 for field descriptions.)
3. Select the trace type, direction, mode, and phase(s) for the trace, as described in the following table:

<table>
<thead>
<tr>
<th>To trace...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>To all connected devices</td>
<td>Select “All Connected” from the drop-down and then click the <strong>Trace</strong> button. The Viewer traces from the device to all connected devices stopping only at an energizing source.</td>
</tr>
<tr>
<td>To connected transformers</td>
<td>Select “To Transformer” from the first drop-down and select the direction from the second drop-down. Click the <strong>Trace</strong> button. The Viewer traces from the device to all transformers in the specified direction.</td>
</tr>
<tr>
<td>To connected switches</td>
<td>Select “To Switch” from the first drop-down and then select the direction from the second drop-down. Click the <strong>Trace</strong> button. The Viewer traces from the device to the nearest switch in the specified direction.</td>
</tr>
<tr>
<td>To the energizing source</td>
<td>Select “To Source” from the first drop-down. Click the <strong>Trace</strong> button. The Viewer traces from the device upstream to the energizing source.</td>
</tr>
<tr>
<td>A specific phase</td>
<td>Select the phase you want to trace. Select the tracing option (All Connected, To Transformer, To Switch, or To Source) and the direction, then click the <strong>Trace</strong> button.</td>
</tr>
<tr>
<td>Upstream</td>
<td>Select either “To Transformer” or “To Switch” from the first drop-down, and then select “Upstream” from the second drop-down. Click the <strong>Trace</strong> button.</td>
</tr>
<tr>
<td>Downstream</td>
<td>Select either “To Transformer” or “To Switch” from the first drop-down, and then select “Downstream” from the second drop-down. Click the <strong>Trace</strong> button.</td>
</tr>
<tr>
<td>Both upstream and downstream</td>
<td>Select either “To Transformer” or “To Switch” from the first drop-down, and the select “All” from the second drop-down menu. Click the <strong>Trace</strong> button. (Tracing all connected devices and tracing to the source will automatically trace both upstream and downstream.)</td>
</tr>
<tr>
<td>Using statuses currently displayed in the Viewer</td>
<td>Select “Current Session” from the third drop-down menu. Select the tracing option (All Connected, To Transformer, To Switch, or To Source) and the direction, then click the <strong>Trace</strong> button.</td>
</tr>
<tr>
<td>Using nominal statuses</td>
<td>Select “Nominal” from the third drop-down menu. Select the tracing option (All Connected, To Transformer, To Switch, or To Source) and the direction, then click the <strong>Trace</strong> button.</td>
</tr>
</tbody>
</table>
4. When you have finished tracing, click the Exit button on the Trace dialog box.

**Inspecting Direct Connections and Navigating to Connected Objects**

Use the advanced fields on the Trace dialog to inspect direct connections and navigate to connected objects.

1. Click the Trace button on the Viewer toolbar to enter Trace mode.

2. In the Viewer drawing area, select the device you want to trace from. The Trace dialog opens.

3. Click the Advanced button in the bottom-right corner of the Trace dialog. The dialog expands to display detailed connection information.

4. In the Connections box at the bottom of dialog, click the + sign to expand a node and display all connection branches.

5. Right-click a connection row and select Focus from the pop-up menu. The Viewer focuses on the object and colors it with the specified color. The Trace dialog displays details for the newly selected object, including a list of its connections. Refer to **Advanced Trace Dialog Fields** on page 6-47 for more information.

6. Repeat steps 4 and 5 needed to inspect more connections.

**Performing Repeated Traces**

To perform repeated traces:

1. Select different trace options and devices to trace from, using the procedure above.

2. Click the Exit button on the Using the Trace Dialog Box. The box closes and any current trace lines are cleared.

3. Click the Trace button on the Viewer toolbar again to toggle off Trace mode.

**Using the Commissioning Tool**

The Commissioning Tool allows you to commission a device that is currently in construction or decommission devices currently marked for removal.

To open the Commissioning Tool, select **Commissioning Tool**... from the Actions menu in the Viewer. The Commissioning Tool displays two panels:

- The Waiting for Approval Panel displays a list of devices that need to be approved and indicates their current statuses (To Commission or To Decommission).

- The Approved Panel displays a list of approved devices that now may be removed and indicates their current statuses (Commissioned or Decommissioned).

If no pending devices are currently selected, both panels will be empty.

The status bar at the bottom of the Commissioning Tool window indicates the current real-time or study mode status.
You can perform the following actions on the devices displayed in the Commissioning Tool window:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Approve the selected device(s)</strong></td>
<td>Select one or more devices in the Waiting for Approval list and click the <img src="" alt="green checkmark" /> toolbar button (or use the right-click menu option). The devices are moved to the Approved list and their symbols in the Viewer change from red or green to gray.</td>
</tr>
<tr>
<td><strong>Focus on the device in the master Viewer window</strong></td>
<td>Select a single device in either list and click the <img src="" alt="red circle" /> toolbar button (or use the right-click menu option).</td>
</tr>
<tr>
<td><strong>Remove the selected device(s) from the list</strong></td>
<td>Select one or more devices in either list and click the <img src="" alt="red X" /> toolbar button (or use the right-click menu option).</td>
</tr>
<tr>
<td><strong>Undo the approval for the selected device(s)</strong></td>
<td>Select one or more devices in the Approved list and click the <img src="" alt="blue reverse triangle" /> toolbar button (or use the right-click menu option). The devices are moved to the Waiting For Approval list and their symbols in the Viewer change from gray back to red or green.</td>
</tr>
</tbody>
</table>

**Commissioning and Decommissioning Devices**

To commission or decommission sets of devices, perform the following steps:

1. In the Viewer, load the pending device changes you wish to modify. You can select multiple devices.
2. Enable the **Show Pending Devices** option in the Hide/Display dialog.
3. Switch to study mode if you don’t want to affect the real-time model.
4. Select **Commissioning Tool...** from the Viewer’s Actions menu. Selected devices pending approval are listed in the Waiting for Approval panel.
5. Select the devices you want to commission or decommission, then click the **Approve** toolbar button.

**Note:**

- Devices being decommissioned are no longer are part of the topological model and are immediately deenergized, as are any devices downstream.
- Commissioned devices immediately become part of the topological model and energization is recalculated (*i.e.*, a newly device attached to an energized conductor will become energized).
Selecting Pending Devices

When you select a device in the Viewer that is pending construction or decommission, the device is listed in one of the panels in the Commissioning Tool. You can select multiple devices by clicking the left mouse button and dragging to select the desired objects.

The Viewer displays the following commissioning-related conditions:

- Unapproved pending construction (green)
- Approved pending construction (gray)
- Unapproved pending decommission (red)
- Approved pending decommission (gray)

Use the **Show Pending Devices** option in the Hide/Display dialog to display or hide pending devices.
Using the Web Workspace Control Tool

The Control Tool, which is a component of Oracle Utilities Network Management System Web Workspace, lets you perform actions on devices. It is typically brought up from the Viewer, although it can also be brought up from an event in the Work Agenda window. The actions you can perform on devices include tagging a device, placing a note on a device, re-predicting an outage upstream or downstream from a device, and opening and closing a device.

Control Tool topics include:

- Understanding the Control Tool
- Operating Devices
- Tagging Devices
- Placing Grounds
- Disabling ATOs
- Highlighting Events in the Work Agenda
- Repredicting Upstream/Downstream
- Viewing Associated Customers
- Using Notes
- Viewing Device Attribute Information
- Toggling Call Display
- Viewing Customers
- Placing Jumpers
- Creating Momentary Outages
- Using the Look Ahead Window
- Associating Documents to Devices
- Associating Damage Assessments to a Device
- Completing and Instructing Actions

For related topics, see also:

- Using SCADA Control Tool Features on page 13-9
- Web Switching Management on page 15-1
- Working with Safety Documents on page 15-61
Understanding the Control Tool

The Control Tool lets you perform device operations based on the current status of the device. For example, if a device is already open, you can close it. If the device is closed, you can open it. You can operate all or some of the phases of a device (if the device is a multi-phase device).

You can access the Control Tool from the Viewer by clicking the button on the Viewer toolbar. This puts you in Control Tool mode. Select a device by clicking on the device symbol (with the left mouse button) in the Viewer. If you click on the drawing area of the Viewer without selecting a device, the system selects the nearest device. You may also access the Control Tool from the Viewer by simply double-clicking on a device.

The name of the device is displayed at the top of the Control Tool. On the left side of the screen are a set of buttons for the options you can perform. The options that appear differ depending on the type of device that the Control Tool was opened from (cable/conductor vs. actual device such as a transformer, fuse, etc.).

Control Tool Options

Control Tool operations and functions are performed by clicking the buttons displayed on the Control Tool window. The following table describes the Control Tool buttons and the actions they perform.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operations...</td>
<td>Allows you to perform the following operations on a device: Open, Close, Instruct Open, Instruct Close, Open and Tag, Instruct Open and Tag, Remove Tag and Close Device, Instruct Remove Tag and Close, and Undo Open.</td>
</tr>
<tr>
<td>Tag/Flag...</td>
<td>Allows you to Place Tag, Instruct Place Tag, Remove Tag, and Instruct Remove Tag.</td>
</tr>
<tr>
<td>Ground...</td>
<td>Allows you to Place Ground, Instruct Place Ground, Remove Ground, and Instruct Remove Ground.</td>
</tr>
<tr>
<td>Enable FLISR</td>
<td>Enables Fault Location, Isolation, and Service Restoration. This is only enabled if FLISR is licensed for your system and it is currently disabled. See Fault Location, Isolation, and Service Restoration on page 18-1 for more information.</td>
</tr>
<tr>
<td>Disable FLISR</td>
<td>Disables FLISR if it is currently enabled.</td>
</tr>
<tr>
<td>Highlight Event</td>
<td>Displays the event in the Work Agenda. You must have the correct view of the Work Agenda window open in order to see the highlighted event (e.g., the In Progress list).</td>
</tr>
<tr>
<td>Repredict Upstream</td>
<td>Allows you to manually repredict the outage to the next predictable upstream device.</td>
</tr>
<tr>
<td>Repredict Downstream</td>
<td>Allows you to manually repredict the outage to the next predictable downstream device.</td>
</tr>
<tr>
<td>View Documents...</td>
<td>Allows you to view documents associated with devices.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note...</td>
<td>Allows you to place notes on devices.</td>
</tr>
<tr>
<td>Attributes...</td>
<td>Displays the Device Attributes window, which lists information about the selected device's properties.</td>
</tr>
<tr>
<td>Damage Assessment...</td>
<td>Opens the Damage Assessments window, which displays a list of damage assessments associated with the device selected in the Viewer and allows you to add new damage assessments. See Damage Assessment Window on page 7-16.</td>
</tr>
<tr>
<td>Toggle Call Display</td>
<td>Toggles the call display on or off. When enabled, a symbol is displayed in the Viewer window for any transformers that have calls associated with the event. This option is only available on Control Tool windows that are opened from a predictable outage device, such as a switch or fuse, which has an open associated event.</td>
</tr>
<tr>
<td>Customer List...</td>
<td>Displays the customers downstream from a device.</td>
</tr>
<tr>
<td>Customer List...</td>
<td>Displays the meters downstream from a device.</td>
</tr>
<tr>
<td>Switching Plan(s)...</td>
<td>Allows you to open a switching plan associated with the device. If multiple plans are associated with the device, the Device to Sheet Operation List displays a list of switching sheets and associated operations. Each operation represents a step in the switching sheet. Select a sheet operation and click Open. See Web Switching Management on page 15-1 for more information on using Web Switching Management.</td>
</tr>
<tr>
<td>Safety Document(s)...</td>
<td>Allows you to open safety documents associated with the device. If multiple documents are associated with the device, select a document from the Device to Safety Document List and click Open. See Working with Safety Documents on page 15-61 for more information on working with safety documents.</td>
</tr>
<tr>
<td>SCADA Summary...</td>
<td>Opens the SCADA Summary window. See SCADA Summary on page 6-75 for more information.</td>
</tr>
<tr>
<td>Operate Phases</td>
<td>Allows you to operate all or specific phases of a device by toggling All or any combination of A, B, and C phases. Any phases not applicable to the device are disabled (e.g., the Control Tool for an A phase transformer will have B and C disabled). This option is disabled if the selected device is ‘gang-operated.’</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Allows you to record the date and time an operation was performed. The field defaults to the current date and time, but you can adjust the date using the up and down arrow buttons next to the field. The date and time of the operation displays in the Event Recorder window. Note that this will also affect reported outage times.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays Control Tool help.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Control Tool.</td>
</tr>
</tbody>
</table>
Operating Devices

You can open or close a device in the Viewer to reflect the current state of the device in the field. The device operations you can perform depend on the status of the device. For example, a Control Tool window opened from an open device will only allow you to close the device. In real-time mode, you must have authority over the control zone where the device is located in order to operate the device.

If a device has multiple phases and you only want to open or close one of the phases, you can select which phase you want to operate using the toggle buttons in the Operate Phases section on the right side of the Control Tool.

Note: Phase selection is disabled when the selected device is ‘gang-operated’.

Only phases present for the device that the Control Tool was opened from are displayed (e.g., the Control Tool for an A phase transformer will display B and C phases). A label above the Operate Phases section indicates which phases are currently closed.

Step-by-step instructions are presented in the following sections for common operations. Separate instructions are not provided for the Instruct versions of operations, such as Instruct Open and Instruct Close.

- Opening a Device
- Undoing the Open Operation
- Closing a Device

Opening a Device

To open one or more phases on a device:

1. Do one of the following:
   - In the Viewer, ensure that the button is selected, indicating that you are in Control Tool mode. Click on the closed device that you want to open.
   - In the Viewer, double-click on the closed device you want to open.

The Control Tool opens.

2. Select the phase or phases that you want to open by placing a check mark in the check box alongside the phase. If you wish to open all closed phases, you may leave ALL selected (which is the default).

3. Click the Open button. The selected phase(s) for the device open. If no phase is selected, an error message displays.

Undoing the Open Operation

You can undo an Open operation, which is different than closing a device. With the Undo Open operation, any RDO that would have been restored will revert back to a predicted outage. As a result, no restore time is set for the associated job and the job remains active.

Closing a Device

To close one or more phases on a device:

1. Do one of the following:
   - In the Viewer, ensure that the button is selected, indicating that you are in Control Tool mode. Click on the open device you want to close.
   - In the Viewer, double-click on the open device you want to close.
The Control Tool opens.

2. Select the phase or phases you want to close by placing a check mark in the check box alongside the phase. If you wish to close all open phases, you may leave ALL selected (which is the default).

3. Click the Close button. The selected phase(s) for the device close.

**Tagging Devices**

You can tag devices in the Viewer window that are physically tagged in the field. Tags placed on devices in the system prevent users from performing open or close operations on the device. When you place a tag on a device, a tag symbol appears attached to that device in the Viewer. You can place multiple tags on a single device. When you do, the number of tags on the device appears in parentheses next to the tag in the Viewer. You must have authority over the control zone where the device is located in order to tag the device.

**Placing a Tag**

To place a tag on a device:

1. Do one of the following:
   - In the Viewer, ensure that the button is selected, indicating that you are in Control Tool mode. Click on the device that you want to tag.
   - In the Viewer, double-click on the device you want to tag.

   The Control Tool opens.

2. Click the Place Tag button. A tag symbol displays next to that device in the Viewer. If a tag symbol already existed (the device had at least one current tag), a number in parentheses next to the tag symbol will indicate the updated current number of tags.

**Removing a Tag**

To remove a tag from a device:

1. Do one of the following:
   - In the Viewer, ensure that the button is selected, indicating that you are in Control Tool mode. Click on the device that has the tag.
   - In the Viewer, double-click on the device that has the tag.

   The Control Tool opens.

2. Click the Remove Tag button. The Remove Tag dialog box opens, displaying a list of the tags on that device, including when the tag was placed and the user who placed it.

3. Select the row of the tag you want to remove and click the Remove button. The tag is removed. The number next to the tag symbol is decreased by one, unless there is now only one tag left, in which case the number is removed. If the last tag is removed, the tag symbol is removed from the Viewer.
Placing Grounds

When you open a Control Tool window from certain devices or conductors (e.g., fuse or wire), the ground function is available. Grounding a device grounds all parts of the circuit connected to the grounding point. The Look Ahead window warns you if the grounding action will create a live, grounded circuit. The grounded circuit is highlighted in the Viewer and indicated by a grounding symbol at the selected device or midpoint of the selected conductor.

Grounding a Device

To ground a device, complete these steps:

1. Open a Viewer window and load the map that contains the device you want to ground.
2. Double-click on the device. The Control Tool window opens.
3. Click on the Ground... button and select Place Ground from the drop-down menu. A Select Secondary Object dialog box appears.
4. Click on the conductor attached to the device on the side you want to ground and the name of that conductor will appear in the dialog box.
5. Click OK to proceed with the ground.

If you are grounding a live conductor, a warning box opens indicating that you are about to “ground a live section.” Click the OK to Operate Device button to proceed with the grounding action (a grounding symbol appears in the Viewer on the device), or click the Cancel button to abort the grounding action.

Removing a Ground from a Device

You can only remove a ground from the device or conductor on which the grounding was applied. To remove a ground from a device, complete these steps:

1. Open a Viewer window and load the map that contains the grounded device.
2. Double-click on the device. The Control Tool window opens.
3. Click on the Ground... button and select Remove Ground from the drop-down menu. A Select Secondary Object dialog box appears.
4. Click on the conductor attached to the device on the side with the ground you want to remove. The alias of that conductor appears in the dialog box.
5. Click OK. The grounding symbol is removed from the Viewer.
Disabling ATOs

When you open a Control Tool window from a Primary or Secondary ATO switch, the ATO Disable function is available. Disabling either ATO switch prevents the system from automatically throwing-over or auto-returning the pair of switches.

Placing a DISABLED Condition

To place a tag on a device:

1. Do one of the following:
   - In the Viewer, ensure that the button is selected, indicating that you are in Control Tool mode. Click on the ATO switch that you want to disable
   - In the Viewer, double-click on the ATO switch you want to disable.

   The Control Tool opens.

2. Click on the Disable ATO button.

3. A DISABLED condition will appear on the ATO switch.

The ATO switches can now be operated manually, and energization can change, and the system will not automatically operate either ATO switch.

Removing a DISABLED Condition

To re-enable the ATO switch:

1. Do one of the following:

   - In the Viewer, ensure that the button is selected, indicating that you are in Control Tool mode. Click on the ATO switch that has the DISABLED condition.
   - In the Viewer, double-click on the ATO switch that has the DISABLED condition.

   The Control Tool opens.

   - Click on the Enable ATO button. The DISABLED condition will disappear from the ATO switch.

   Once both ATO switches are enabled, the system will once again set the ATO switches to their correct positions, based on the energization.

Highlighting Events in the Work Agenda

If an event is associated with a selected device, you can find it in the Work Agenda window using the Highlight Event button on the Control Tool. You must have the correct view of the Work Agenda window open in order to see the highlighted event (e.g., the In Progress list).

Note: If there are multiple events associated with a device, only the first one found will be highlighted.
Repredicting Upstream/Downstream

You can force the system to manually repredict a predicted outage either upstream or downstream from the current system predicted device. This is typically done when a crew finds that the problem is not at the predicted device.

- If the device is energized, the problem is actually one or more downstream outages.
- If the device is de-energized, the problem will actually be upstream.

Clicking the **Repredict Upstream** or **Repredict Downstream** button manually repredicts the outage to the next predictable upstream or downstream device. When repredicting downstream, the system distributes the event to one or more devices. Once a predicted outage is manually repredicted upstream or downstream, the system will treat the repredicted outages as non-grouping and no longer automatically repredict them.

For example, a crew finds that a predicted service outage (indicated by the “PSO” symbol) at a transformer is not actually where the trouble is located. Using the Control Tool window, you can repredict the outage upstream to the switch. When you repredict the outage, the switch displays a “PDO” (predicted device outage) symbol. The original predicted service outage displayed in one of Work Agenda’s Trouble Events list windows changes to a predicted device outage located at the switch.

Viewing Documents Associated with a Device

To view documents associated with a device, complete these steps:

1. Open a Viewer window. Locate a device that has an associated document you wish to view. (Devices with associated documents have a “DOC” condition symbol.)
2. Double-click on the device to bring up the Control Tool.
3. Select the **View Documents…** option from the Control Tool.

   - The Manage Documents window appears, which lists any associated documents for the selected device.
   - Select the document and click the **View Document** button to open the document for viewing.
   - Click the **Quit** button to exit the Manage Documents window.

For instructions on associating documents to devices, see **Violations Tab** on page 6-68. Note that this function is available only to administrative users.

Using Notes

The Control Tool window allows you to place notes on devices. Note text is displayed in the **Displaying Device Details** balloon dialog in the Viewer.

Open the Device Notes dialog box from the Control Tool by clicking the **Note…** button. All notes for the selected device are listed in the Notes field. You can add or edit note text in the Note Text field.

The Device Notes dialog box displays the following fields and buttons:

- The **Object** field displays the object class of the device.
- The **Object Name** field displays the name or ID of the device.
- The **Notes** field lists the notes that have been entered for the device with an indication of who and when.
- The **Note Text** field displays the text of the selected note.
- The **New** button allows you to enter a new note for the device.
Using the Web Workspace Control Tool

- The **Edit** button allows you to edit the text of the selected note.
- The **Delete** button deletes the selected note.
- The **Refresh** button refreshes the Device Notes dialog box. It will show any notes for the device created by another user after you opened the Device Notes dialog box.
- The **Exit** button closes the Device Notes dialog box.

**Creating a Note**

You can create one or more notes for a device using the Control Tool window. Once you save a note, a note symbol displays in the Viewer window next to the device. If you create multiple notes for a device, the number of notes is displayed in parentheses next to the note symbol.

To enter a note, complete these steps:

1. In the Viewer, open the Control Tool for the device that you want to enter the note for.
2. On the Control Tool, click the **Note…** button. The Device Notes dialog box opens with the name of the device listed at the top.
3. Click the **New** button. The Note Text field changes to an Add/Edit Text field.
4. Click in the Add/Edit Text field and enter the note text.
5. Click **Save**. The note is saved. The note number, user name, and the date and time that you saved the note displays in the Notes field. A note symbol appears in the Viewer next to the device. If a note symbol already existed, a number appears in parentheses next to the note symbol with the current number of notes.
6. Click **Exit** to close the Device Notes dialog box.

**Editing a Note**

To edit an existing note from the Control Tool, complete these steps:

1. In the Viewer, open the Control Tool for the device that contains the note you want to edit.
2. On the Control Tool, click the **Note…** button. The Device Notes dialog box opens with the name of the device listed at the top and the note(s) listed in the Notes field.
3. Select the note that you want to edit. The current note text will display in the Note Text field.
4. Click the **Edit** button. The Note Text field changes to an Add/Edit Text field.
5. Click in the Add/Edit Text field and edit the note text as needed.
6. Click **Save**. The note is saved.
7. Click **Exit** to close the Device Notes dialog box.

**Note:** The Notes field at the top will continue to show the original author and creation time.

**Deleting a Note**

You can delete a note once it no longer applies to the device or the event.

To delete a note, complete these steps:

1. In the Viewer, open the Control Tool for the device that contains the note you want to delete.
2. On the Control Tool, click the **Note…** button. The Device Notes dialog box opens with the name of the device listed at the top and the note(s) listed in the Notes field.
3. Select the note that you want to delete.
4. Click the **Delete** button. The note is deleted from the Device Notes dialog box. If it was the only note for the device, then the note symbol disappears from the Viewer. Otherwise, the number in parentheses next to the note is decreased (or removed if it becomes 1).

5. Click **Exit** to close the Device Notes dialog box.

**Viewing Device Attribute Information**

You can access attribute information related to a device using the Control Tool. Device attributes include physical and reference information about a device, such as location and rating. To view device attributes, complete these steps:

1. In the Viewer, make sure that the **Control Tool** button is selected, indicating that you are in Control Tool mode. Click on a device in the Viewer.

   Or,

   Double-click on a device in the Viewer.

   The Control Tool opens.

2. Click the **Attributes…** button on the Control Tool. The Device Information window opens.

   **Note:** The information in the Device Information window is view-only.

**Toggling Call Display**

You can view the calls associated with an event in the Viewer window by clicking the **Toggle Call Display** button. A symbol appears attached to any transformers serving customers that have calls associated with the event. If there were multiple calls with the same “clues” then a number will appear in parentheses next to the call symbol. To hide the symbols, open the Control Tool window from the device and click the **Toggle Call Display** button again.

**Viewing Associated Customers**

To view the customers on and downstream from a device, click the **Customer List…** button on the Control Tool. The Customers view of the Trouble Info window opens, listing all customers on and downstream from the device. See **Using the Trouble Info Window** on page 7-42 for more information.

   **Note:** You cannot toggle over to the Calls view when you open the Trouble Info window from this Customer List option.

**Viewing Customers**

To view the meters downstream from a device, click the **Customer List…** button on the Control Tool window. The Customers view of the Trouble Info window opens, listing all meters downstream from the device. The information displayed includes the device, phases, customer name, address, phone number and account number of the customer, as well as recent meter ping information. From this page, you can initiate a ping request, as well as monitor previous ping results. See **Using the Trouble Info Window** on page 7-42 for more information.
Placing Jumpers

In addition to creating an open point, you can insert a jumper on an overhead conductor or between overhead conductors. You can also place emergency cables between underground devices. The jumper is an active part of the model and fully operable. You can open and close a jumper as well as place tags and notes on the jumper.

The following table describes the different jumper types.

<table>
<thead>
<tr>
<th>Jumper Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In-line Jumper</td>
<td>In-line jumpers are placed in line. The position for the jumper is set to “closed” to maintain a continuous conductor. A closed jumper symbol displays at the midpoint of the selected conductor.</td>
</tr>
<tr>
<td>P-P Jumper / Emergency Cable</td>
<td>Point-to-point jumpers are placed between a selected conductor and the same phase on any other conductor. A dialog box allows you to specify the second conductor. You can select the conductor in the Viewer window. A point-to-point jumper symbol displays at the midpoints of the selected conductors. The default state for the inserted jumper is “open.”</td>
</tr>
<tr>
<td>P-P Cross Phase</td>
<td>Point-to-point cross phase jumpers are placed between different phases on two different conductors. The Cross Phase Selection dialog box allows you to select a live phase and the phase to pick up. The Select Secondary dialog box allows you to specify the second conductor. You can select the conductor in the Viewer window. A point-to-point jumper symbol displays, connecting the midpoints of the selected conductors. The default state for the inserted jumper is “open.”</td>
</tr>
<tr>
<td>Tap Generator</td>
<td>Tap Generators are used to add an energization point to the model. A Selection Required dialog box allows you to specify the tap location by clicking on the location in the Viewer.</td>
</tr>
</tbody>
</table>

Inserting a Jumper

After the crew informs you what type of jumper they will insert, you can make the change in the system. To insert a jumper, complete these steps:

1. Open a Viewer window and load the map that contains the conductor where you want to place the jumper.
3. Select the appropriate button for the type of jumper you want to insert.
   - If you are placing a point-to-point jumper, point-to-point cross phase, or emergency cable, the Select Secondary dialog box opens. Continue with the next step.
   - If you are placing an in-line jumper, skip to step 5.
4. Select another conductor (in the Viewer window), and then click OK.
   - If you are placing a point-to-point cross phase, the Cross Phase Selection dialog box opens. Select a phase for each device, and click OK.
Using the Web Workspace Control Tool

5. A dialog will appear notifying you that there is a model edit in progress; the dialog will disappear after the model build is completed. The viewer will then refresh to display the jumper.

   Note: you may click OK to dismiss the dialog or it can be moved to the side while performing other operations.

Operating a Jumper
Like devices, you can open and close (Disconnect and Connect) jumpers. To open or close a jumper, complete these steps:

1. Open a Viewer window and load the map that contains the jumper you want to operate.
2. Double-click on the jumper. The Control Tool window opens.
3. Select the desired phases from the Phases panel, then click the operation you want to perform, either Disconnect Jumper or Connect Jumper.

Removing a Jumper
Once a jumper has been removed in the field, you can remove the jumper from the system. This removes the jumper and fully restores the conductor. To remove a jumper, complete these steps:

1. Open a Viewer window and load the map that contains the jumper you want to remove.
2. Double-click on the jumper. The Control Tool window opens.
3. Click the Remove Jumper button on the Control Tool window. The Model Edit in progress dialog will appear; once the model has been updated, the Viewer will refresh and the jumper will be removed.

Placing/Performing a Tap Edit
To perform a tap edit:

1. Open a Viewer window.
2. Load the map containing the conductor where you want to place the jumper.
4. Select the Tap Generator button.
5. Select a location in the Selection Required dialog box and click OK. The model edit is performed and a new energization point appears in the map at the selected spot.

Creating Momentary Outages
You can create a momentary outage by simulating a momentary interruption in the system. Momentary interruptions occur when a recloser operates and does not lock out. The Create Momentary… button is only enabled on Control Tool windows opened from reclosing devices. To create a momentary outage, complete these steps:

1. Open a Viewer window and load the map that contains the device that you want to create the momentary outage for.
2. Double-click on the device. The Control Tool window opens.
3. Adjust the date and time if necessary.
4. Click the Create Momentary… button. A dialog box opens
5. Enter the number of momentaries. Values between 1 and 100 enable the OK button.
6. Click OK. The momentary outage displays in the Work Agenda window with a status of M-CMP. In addition, two alarms display in the System Alarms list, one for opening and one for closing.
Using the Look Ahead Window

The Look Ahead window provides information concerning the results of performing a requested device operation. The Look Ahead window uses system status and topology tracing to “look ahead” of the requested operation and determine its consequences.

The Look Ahead window displays whenever a switching operation is initiated from the Control Tool in energized or de-energized portions of the distribution system. After determining the consequences, the Look Ahead window either displays the appropriate dialog box or gathers additional data for display. You can use the information displayed in the Look Ahead window to decide whether to continue with the operation.

This section includes the following topics:

- Understanding the Look-Ahead Process
- Drop Count Tab
- Pickup Count Tab
- ATO Customers Tab
- View Conditions Tab
- View Abnormal Tab
- View Critical Tab
- Violations Tab
Understanding the Look-Ahead Process

The Look Ahead window uses status and topology tracing to “look ahead” of the requested operation and determine its consequences. Based on this information, you can decide whether to continue with an operation.

The flow diagram below shows the basic logic of the Look Ahead window.
The Look Ahead window displays a warning if an operation will create or break loops or parallels. Counts, conditions, and abnormal device information are not available when dealing with loops and parallels.

The Look Ahead window displays whenever a switching operation is initiated from the Control Tool in energized, as well as de-energized, portions of the distribution system. If the operation will energize or de-energize the system, additional data is gathered and displayed in the Look Ahead window.

The information displayed depends on the results of performing the operation. A tab is enabled only if table information is available. You cannot open or close a device until you view any abnormal devices or conditions (see View Abnormal Tab on page 6-68).

Note: If you attempt to open a switch in a deenergized area, the system displays the Create Nested Outage dialog box before displaying the Look Ahead window. Do one of the following:

- Click Yes to create a nested outage.
- Click No to open the switch without creating a nested outage.
- Click Cancel to cancel the operation.

The Look Ahead Window

The Look Ahead window contains tabs and tables that display event- and device-related information. The items on the Look Ahead window are described below:

- Header and Power Flow Results
- Drop Count Tab
- Pickup Count Tab
- ATO Customers Tab
- View Conditions Tab
- View Abnormal Tab
- View Critical Tab

Header and Power Flow Results

- The Device field displays the name of the device being operated.
- The Phase(s) to Operate field displays the phase(s) of the device being operated.
- The Run Power Flow button allows you to generate a Power Flow solution for the device. The Power Flow Results are displayed at the top of the Look Ahead Dialog. If any violations occurred during the run, the Violations Tab tab is enabled and the violations are listed.

For example, if you open a tie switch and then click the Run Power Flow button, the Power Flow Results panel displays the Breaking Current amps, the voltage difference, and the number of violations.

See Chapter 16, Power Flow, Suggested Switching, and Volt/VAr Optimization for more information about Power Flow. This button is only available if Power Flow is licensed for your system.
Drop Count Tab
The Drop Count tab displays the number of customers affected by the device operation. This tab provides information for Total Customers and total Critical Customers, with sub counts for three types of critical customers.

- The **Drop** columns display the drop information for the device. Information is displayed as counts dropped downstream of the device.
- The **Feeder** columns display the total counts for the feeder on which the device to operate is located.
- The first set of Drop and Feed columns shows data for the total counts.
- The following three sets (A, B, and C) show data for each individual phase.
- The last set shows counts for multi-phase customers. The counts for the individual phases (A, B, C) and multi-phase add up to the counts in the first or total columns (i.e., A+B+C+Multi-Phase = Total).

Pickup Count Tab
The Pickup Count tab displays the number of customers affected by the device operation. This tab provides information for Total Customers and total Critical Customers, with sub counts for three types of critical customers.

- The first set of two columns shows data for the total counts. The following three sets of two columns show data for each individual phase (A, B, and C), with the last set showing counts for multi-phase customers. The counts for the individual phases (A, B, C) and multi-phase will add up to the counts in the “total” columns (i.e., A+B+C+Multi-Phase = Total).
- The **Pickup** columns display the pickup information for the device. Information is displayed as counts picked up downstream of the device.
- The **Feeder** columns display the total counts for the feeder on which the device to operate is located.

ATO Customers Tab
The ATO Customers tab displays the number of customers affected by automatic ATO operations as a result of the device operation. These customers are not listed in the Counts table.

On loss of the primary feed:

- The ATO Customers page lists customers downstream from a pair of enabled ATO switches with a live secondary feed, because they will experience a momentary outage.
- The ATO Customers page does not list customers downstream from a pair of ATOs if either the primary or secondary switch is disabled. These customers appear on the Counts table, because they will experience a sustained outage.
- The ATO Customers page does not list customers downstream from a pair of ATOs if the secondary feed is already lost. These customers appear on the Counts table, because they will experience a sustained outage.

On restoration of the primary feed:

- The ATO Customers page lists de-energized customers who will be auto-returned if the secondary feed is already lost.
- The ATO Customers page lists currently energized customers who will be auto-returned if the ATO is configured as a “break before make” on auto-return.
- The ATO Customers page does not list currently energized customers who will be auto-returned if the ATO is configured as a “make before break” on auto-return.
Similarly to the Counts table, the ATO Customers table provides information for total Critical Customers with sub counts for three types of critical customers, Interrupting Current (phase), and Total Customers.

The first column shows data for the total counts. The following three columns show data for each individual phase (A, B, and C), with the last set showing counts for 3 phase customers. The counts for the individual phases (A, B, C) and 3-phase will add up to the counts in the “total” columns (i.e., A+B+C+3=Total).

The rows displayed in the counts table include Crit Customers, EMR Customers, MED Customers, KEY Customers, Interrupting Current and total customers. Click on the View ATO Custs button to access ATO Customer information from any of the other views.

**View Conditions Tab**

The View Conditions tab shows any special conditions currently active on the circuit, including crew locations, tags, notes, etc. If conditions are present, you must view the conditions table to complete the operation. Click on the View Conditions tab to access condition information.

The Conditions table displays the following columns:

- The **Condition** column displays the type of condition that is present on the feeder such as a truck_location (crew), tag, note, etc.
- The **Device** column displays the name of the device on which the condition is located.
- The **Location** column indicates whether the condition is upstream or downstream of the current device.
- The **UserName** column displays the user name of the user that created the condition.
- The **Date/Time** column displays the date and time that the condition was created.

**View Abnormal Tab**

The View Abnormal tab displays data about abnormal devices on the same feeder as the device to operate. An “abnormal device” is any device that is not in its nominal state (e.g., an open device that is normally closed).

The Alarms and Devices table displays the following columns:

- The **Device** column displays the name of the device that is in an abnormal state.
- The **Nominal Status** column displays the normal status of the device.
- The **Current Status** column displays the current status of the device.

**View Critical Tab**

The View Critical tab shows customers classified as critical (e.g., emergency, medical, key) that would be impacted by the proposed device operation.

The Critical Customers table displays the following columns:

- The **Name** column displays the critical customer's name.
- The **Address** column displays the critical customer's address.
- The **Phone** column displays the critical customer's telephone number.

**Violations Tab**

The Violations tab displays a list of all violations reported by Power Flow the last time Power Flow was run on this device. If Power Flow has not been run or no violations were encountered, this tab is grayed.

Click the **Run Power Flow** button on the Look Ahead Dialog to run Power Flow. The Power Flow results are displayed at the top of the dialog. If violations are encountered during the run, the Violations Changes tab is enabled and the violations are listed in the violations table.
The violations table displays the following columns:

- **Device** – The device’s name
- **Violation** – The violation or warning name. See Data Source and Data Quality on page 17-21 for range of values and colors for this column.
- **Phase** – The phase that the violation is on
- **Value Before** – The value before the action
- **% Before** – the ratio of the value before to the limit
- **Value After** – The value after the action
- **% After** – the ratio of the value after the action to the limit
- **Limit** – The violation/warning limit
- **Status** – The result of the action on the violation.
  - **Removed** – the violation has been removed by the action.
  - **Added** – a new violation will be added due to the action.
  - **Better** – changed from violation to warning after the action or the percent decreased (increased for under voltage violations/warnings) more than the threshold.
  - **Worse** – changed from warning to violation after the action or which percent increased (decreased for under voltage violations/warnings) more than the threshold.

Three options menus enable filtering of the table data:

- Violations Only, Warnings Only, or Violations and Warnings
- Changes, After, or Before:
  - Changes: only shows changed violations resulting from the action
  - Before: shows the violations before the action
  - After: shows the violations after the action
- Violation Types: Conductor, Power Transformer, Distribution Transformer, Switch, Voltage, Backfeed, and Feeder Capacity

Each violation change has a specific background and font color-code:

- Added - red background, white foreground
- Worse - orange background, black foreground
- Better - yellow background, black foreground
- Removed - green background, black foreground

See Chapter 16, Power Flow, Suggested Switching, and Volt/VAr Optimization for more information about Power Flow.

**Buttons**

- The **Open** button opens the device. If an “open” operation is being performed on a closed device, the Open button is enabled. If special conditions exist, then you must view the View Conditions tab before the Open button becomes enabled. Likewise, if abnormal device statuses exist, then you must view the View Abnormal tab before the Open button becomes enabled.
- The **Close** button closes the device. If a “close” operation is being performed on an open device, the Close button is enabled. If special conditions exist, then you must view the View Conditions tab before the Close button becomes enabled. Likewise, if abnormal device
statuses exist, then you must view the View Abnormal tab before the Close button becomes enabled.

- The **Cancel** button cancels the device operation and closes the Look Ahead window.

## Associating Documents to Devices

The Manage Documents window allows you to associate devices in the electrical topology model with various documents, as well as to view those associated documents.

*Note:* This feature is available only to administrative users. Non-administrative users can only view associated documents. See **Viewing Associated Documents** on page 6-71 for details.

This section includes the following topics:

- Using the Manage Documents Window
- Associating a Document with a Device
- Removing a Document Association
- Viewing Associated Documents

### Using the Manage Documents Window

To open this window, select **Manage Documents...** from the Web Workspace Tools menu. The Manage Documents window displays the following fields and buttons:

- The **Selected Device** field lists the device selected in the Viewer.
- The **Manage Documents** field lists any documents associated to the device.
  - The **Unassociate** button allows you to remove the association between the selected device and a document selected in the Manage Documents field.
  - The **View Document** button allows you to view the selected document.
- The **Available Documents** field lists the contents of the $CES_DRAWINGS directory. Use the blank text field to filter the Available Documents list. (Type all or part of the document you are looking for. The list is dynamically updated to display document names that include the text you enter.)
- The **Associated Devices** field lists which devices have an association with the currently selected item in the Available Documents list.
- The **Associate** button allows you to associate the currently selected item in the Available Documents list with the Selected Device.
- The **View Document** button allows you to view the currently selected item in the Available Documents list.
- The **Exit** button closes the Manage Documents window.

### Associating a Document with a Device

*Note:* This feature is available only to administrative users. Non-administrative users can only view associated documents. See **Viewing Associated Documents** on page 6-71 for details.

To associate a document with a device, complete these steps:

1. Login to Web Workspace as an Administration user.
2. Select **Manage Documents...** from the Tools menu. The Manage Documents window opens. (See the previous section for field descriptions.)
3. Open a Viewer window. Locate and select the device to associate to a document. The Manage Document window's Selected Device field populates with the selected device's name.

4. Select the item from the Available Documents list that you wish to associate with the selected device. The Associate and View Document buttons are now sensitized.

5. Click the View Document button to see the selected document. The selected document appears in a new window.

6. Click the Associate button to create the association between the selected document and selected device. The following occurs:
   • The field below the selected device populates with the name of the selected document, and the Associated Devices field populates with the name of the selected device.
   • In the Viewer window, a document condition now appears on the selected device.

7. Click the Exit button to exit the Manage Documents window.

**Removing a Document Association**

Note: This feature is available only to administrative users. Non-admin users can only view associated documents. See Viewing Associated Documents on page 6-71 for details.

To remove an association between a document and a device, complete these steps:

1. Login to Web Workspace as an Administration user.

2. Select Manage Documents from the Tools menu. The Manage Documents window opens.

3. Open a Viewer window. Locate and select the device that you wish to disassociate from a document. The Manage Document window's Selected Device field populates with the name of the selected device and the Manage Documents pane lists all associated documents.

4. In the field below the Selected Device, select the document you wish to disassociate from the device. The Unassociate and View Document buttons are now sensitized.

5. Click the View button to see the selected document. The selected document appears in a new window.

6. Click the Unassociate button to remove the association between the selected document and selected device. The following occurs:
   • The selected document is removed from the field below the Selected Device.
   • In the Viewer window, a document condition is removed from the selected device.

7. Click the Exit button to exit the Manage Documents window.

**Viewing Associated Documents**

Administrations can view associated documents from the Manage Documents window while logged in to the Administration environment (see Associating a Document with a Device on page 6-70). Non-administrative users can view documents from the Control Tool. See Viewing Documents Associated with a Device on page 6-59.
Associating Damage Assessments to a Device

You can enter damage assessment for a device. Damage assessment incidents are not included in counts for the event. The damage assessment trouble code has an associated clue symbol Damage Assessment clue symbol (letters 'DA' in a red circle), which will be displayed in Viewer at the damage location.

When you enter damage assessment information, you can select one or more crew types needed to repair the reported damage.

If multiple damage assessments exist for an event, the system will calculate the estimated repair time by adding together estimated repair times from each active damage assessment.

To enter damage assessment information for a device, complete the following steps:

1. Open the Web Workspace Viewer.
2. Select a device and open the Control Tool for the device.
3. Click the Damage Assessment... button. The Damage Assessments window opens for the selected device. If any damage assessment records exist for this device, they are displayed in the list.
4. Click the New Damage Assessment toolbar button. The Damage Assessment window opens.
5. Complete additional fields on this screen as needed. See Damage Assessment Window on page 7-16 for field descriptions.
6. Click the Save button on the toolbar.
7. Use the Complete toolbar button to complete the damage assessment. When a damage assessment record is completed, its status changes to inactive and its symbol is removed from Viewer.

Completing and Instructing Actions

When you perform actions in the Control Tool while you are recording in Web Switching Management, the system automatically populates fields in the associated switching sheet as follows:

- The date field on the Control Tool window, which defaults to the current date and time, is used to populate the Completed Date field in the associated switching sheet when an operation is completed in the Control Tool.
- If steps are instructed to a crew, this date is used to populate the Instructed Date field in the switching sheet.

The Instructed Actions area below the date field displays a list of actions that have been instructed on the selected device. The drop-down allows you to select an instructed action to complete.

The Show Sheet... button displays the sheet that contains the selected instructed action so you can execute the actions from Web Switching Management.

Note: This option is available only when Web Switching Management is licensed. This allows you to navigate to the switching sheet so you can perform the step from there. If you are not using Web Switching Management, you can Complete, Abort, or Fail the selected instructed action from the Control Tool.
Viewing Summaries

Web Workspace includes windows that provide summary information for data in the system:

- Condition Summaries
- SCADA Summary

Related Topics

- Using the Feeder Load Summary Window

Condition Summaries

The Condition Summaries window lists all conditions, including notes, tags, pending decommissions or constructions, and FLISR actions.

This section includes the following topics:

- Using the Condition Summaries Window
- Using the Condition Summary Balloon Details
- Editing or Deleting Conditions

Using the Condition Summaries Window

To view the Condition Summaries window, select **Condition Summaries...** from the Actions menu in Web Workspace.

The Condition Summaries includes the following fields and buttons:

- The **Type** column contains the type of condition, such as Note, Tag, Pending Construction, Pending Decommission, FLISR Action, and Associated Document.
- **Condition #** is the system-assigned identifier of the condition.
- The **Date Created** column contains the date and time the condition was created.
- The **Substation** column contains the name of the substation that serves the device on which the condition is located.
- The **Feeder** column contains the name of the feeder that serves the device on which the condition is located.
- The **User** column contains the user name of the individual who placed the condition.
- The **Device** column contains the name of the device on which the condition is located.
- The **Phase** column contains the name of the phase associated with the condition.
- The **Condition Info** column contains the text of the note or other condition.

Toolbar and Menu Options

- The **Refresh** button refreshes the Condition Summaries window to display the most recent updates. If you edit a condition using the Edit button, you must refresh the summary to see your changes. The Refresh option on the File menu performs the same function.

- The **Print Preview** button displays the Print Preview window, from which you can view and print the summary. The Print Preview option on the File menu performs the same function.

- The **Delete** button deletes the selected condition from the system. A confirmation dialog box prompts you to confirm before deleting. Once deleted, the condition disappears.
from both the Summary and the Viewer. The Delete Row option on the File menu performs the same function.

- The Sort button displays the Sort dialog box. The Sort Dialog option on the Sort menu performs the same function. See Using the Sort Dialog Box on page 6-11 for more information.

- The Filter button displays the Filter dialog box. The Filter Dialog option on the Filter menu performs the same function. See Using the Filter Dialog on page 6-12 for more information. Predefined filters include Notes, Tags, Pending Construction, Pending Decommission, and (if licensed for FLISR) FLISR Actions and FLISR Disabled.

- The Edit button opens the Edit balloon so you can edit the condition. The Edit option on the Actions menu performs the same function. See Editing a Note on page 6-60 for more information.

- The Balloon Details button enables or disables balloon details for the condition. When this is enabled, clicking a condition brings up the View balloon dialog box, which displays the text and provides additional options. The Enable View Balloon option on the Actions menu performs the same function. See Using the Condition Summary Balloon Details on page 6-74 for more information.

- The View Device button focuses the Viewer on the device on which the condition is located, if you have a Viewer window open. The View option on the Actions menu performs the same function.

### Using the Condition Summary Balloon Details

The View balloon dialog box displays the note text for the row selected in the Condition Summaries list.

To open the View balloon:

1. If not already enabled, click the Balloon Details button on the Condition Summaries window to enable this feature.
2. Click on a condition. The View balloon opens, displaying details for the selected condition. To close the View balloon, click the X in the top right corner of the dialog box.

### Editing or Deleting Conditions

To edit a condition, select the condition from the Condition Summaries window, and then click . The Edit balloon dialog box opens. This dialog also appears if you double-click a condition when Balloon Details are turned off.

From this dialog, you can also perform the following tasks:

- Edit the condition information as desired, then click the Save button.
- Use the Focus button to focus the Viewer on the device.
- Use the Print button to print the condition text.
• Use the Revert button to revert to the last saved version of the condition text.

• Use the Delete button to delete the condition. You can also delete a condition by selecting it from the Condition Summaries window, then clicking from the Condition Summaries toolbar. When prompted, confirm the deletion.

**Sorting and Filtering**

The Conditions Summaries table supports Quick Sorting, Dynamic Filtering, and Auto Filtering.

**SCADA Summary**

SCADA functionality is provided as an extension to Oracle Utilities Network Management System. For an overview of SCADA extensions, see SCADA Extensions on page 13-1.

The SCADA Summary provides the current values and qualities of all mapped SCADA measurements in Oracle Utilities Network Management System. Each row of this summary represents one measurement. There may be multiple unique measurements on one SCADA device. SCADA information includes digital and analog measurements, along with the quality codes and any user comments for each measurement. You can use the summary to view measurement information, manually replace current SCADA values, and inhibit updates.

This section includes the following topics:

• Using the SCADA Summary Window
• Preventing Updates from SCADA
• Manual Entry and Override of SCADA Values

**Using the SCADA Summary Window**

To open the SCADA Summary, select SCADA Summary... from the Tools menu in Web Workspace.

The SCADA Summary displays the following fields and buttons:

• The Feeder column contains the name of the feeder reporting the SCADA measurements.
• The Device column contains the name of the device reporting the SCADA measurements.
• The Value column contains the last reported measurement value. The value can be status, digital, or analog. For status measurements, the values are displayed as a test pair, such as open/close, on/off, etc. Analog and digital values are shown as floating point and integer values.
• The Quality column contains the Quality codes for the measurement that indicates the quality of the SCADA measurement (e.g., out of scan, inhibited, manual override). Several quality codes can be listed.
• The Point Name column displays the name of the SCADA measurement, as used in the SCADA system.
• The Attribute column contains a description of the measurement type, as configured in the ATTRIBUTES.description column in the Oracle Utilities Network Management System database for the matching attribute.
Toolbar Buttons

- **The Refresh** button refreshes the SCADA Summary data with any changes since the summary was opened or last refreshed.

- **The Inhibit** button sets the “inhibit” quality code for the selected SCADA measurement. This suppresses any new updates from SCADA.

- **The Cancel Inhibit** button removes the “inhibit” quality code from the selected SCADA measurement. This retains the currently displayed value while allowing any subsequent updates from SCADA to be displayed.

- **The Manual Entry** button allows you to enter a new value and sets the “manual” quality code for the selected SCADA measurement. When a changed SCADA value is received by the system, it replaces the manually entered value and removes the “manual” quality code.

- **The Manual Override** button allows you to enter a new value and sets the “inhibit” and “manual” quality codes for the selected SCADA measurement. When a new SCADA value is received by the system, the value is held in reserve and the manually entered value remains.

- **The Cancel Override** button removes any “inhibit” and “manual” quality codes for the selected measurement and reverts the selected measurement to the last received value from the SCADA system.

- **The Exit** button closes the SCADA Summary window.

Menu Options

- **The Print** option on the File menu allows you to print the SCADA Summary list.

- **The Exit** option on the File menu closes the SCADA Summary.

- **The Filter** menu options allow you to filter the list to display:
  - All Measurements
  - Equipment
  - Analogs
  - Digitals
  - Statuses
  - Show Filter Dialog (see Using the Filter Dialog on page 6-12)
  - All

- **The Help** menu options display standard Help and About windows.

Preventing Updates from SCADA

To prevent a SCADA measurement from accepting updates from SCADA, complete these steps:

1. Select **SCADA Summary...** from the Tools menu in Web Workspace. The SCADA Summary window opens.

2. Select a row in the SCADA Summary list that belongs to the device you want to inhibit.
3. Select the Inhibit button.

**Manual Entry and Override of SCADA Values**
Occasionally, you may need to manually enter a status, digital value, or analog value for a SCADA measurement. For example, you may need to enter fault current and a fault current indicator to trigger Fault Location Analysis (if applicable). See *Fault Location Analysis* on page 19-1 for more information.

If the value for the selected measurement is a switch status measurement (*i.e.*, open/close), you can choose *Show Control Tool...* from the pop-up menu to manually operate the switch. Otherwise, use the following procedure to enter a value manually:

1. Select SCADA Summary... from the Tools menu in Web Workspace. The SCADA Summary window opens.
2. Select the SCADA measurement row in the SCADA Summary list.
3. Click either the Manual Entry or Manual Override button.

    - Manual Entry will allow future SCADA value changes to update the value you enter.
    - Manual Override will retain a manually entered value until the Manual Override flag is removed by clicking the Cancel Override button. Manual Override can be useful when testing specific devices or RTU communications offline, since the test operations can be prevented from creating outages in Oracle Utilities Network Management System by putting manual overrides on the appropriate status measurements.

If the value for the measurement is a multi-state digital, analog, or any type of measurement other than a switch status measurement (open/close), a dialog box opens, allowing you to enter a value.

**Note:** Multi-state digitals are not available through the Oracle Utilities Network Management System SCADA ICCP Block 1, 2, and 5 Adapter.

4. Enter the desired measurement value.
5. Click OK.

**Note:** Clicking on the Manual Override button “blocks” any new values coming from the SCADA measurement. It does not affect the physical SCADA device, it only blocks the value reported by the SCADA device to Oracle Utilities Network Management System.

**Sorting and Filtering**
The SCADA Summary table supports Quick Sorting, Dynamic Filtering, and Auto Filtering.
Using the Alarms and Devices Lists

The Alarms and Devices Lists window provides the following views:

- Abnormal Devices List
- Device Operations List
- SCADA Alarms List
- System Alarms List

To display the Alarms and Devices Lists window, select **Alarms and Devices Lists** from the Web Workspace Tools menu, then select one of the views above.

All views support the following functions:

- Toolbar and Menus and Toolbar
- Acknowledging Alarms
- Silencing Alarms
- Removing Alarms from the List
- Turning Audio Notification On and Off
- Preventing a Device from Reporting SCADA Alarms

**Abnormal Devices List**

The Abnormal Devices view displays all devices that are not in their nominal state. For example, if a switch that is nominally closed is currently open, it will display in the Abnormal Device Summary. If a SCADA system is integrated with Oracle Utilities Network Management System, any devices that are reported by a SCADA point as being in an off-nominal state will also display. This will also display any wire downs or jumpers, or emergency cables in either an open or closed state.

To access the Abnormal Device Summary, select **Alarms and Devices Lists>Abnormal Device Summary**… from the Work Agenda Tools menu.

The Abnormal Devices List displays the following fields:

- The **Date** column contains the date and time that the device was last operated.
- The **Feeder** column contains the name of the feeder that serves the abnormal device.
- The **Device** column contains the name of the abnormal device.
- The **Description** column contains a description of the operation that caused the abnormal state.
- The **Source** column contains the source of the abnormal operation.
- The **Value** column contains the current state of the device.
- The **Phase** column contains the phases of the device.
- The **Attribute** column contains the type of operation. In the Abnormal Devices List, this column displays ‘status.’
- The **Nominal** column contains the normal state of the device.

Related Topics:

- Silencing Alarms
- Removing Alarms from the List
- Turning Audio Notification On and Off
Device Operations List

The Device Operations List displays all recent operations performed in the user's control zones. To access the Device Operations List, select Alarms and Devices Lists>Device Operations List… from the Work Agenda Tools menu.

This list displays the same columns as the Abnormal Devices List.

Related Topics:
• Silencing Alarms
• Removing Alarms from the List
• Turning Audio Notification On and Off

System Alarms List

The System Alarms List displays a list of all system alarms. To access the System Alarms List, select Alarms and Devices Lists> System Alarms List… from the Work Agenda Tools menu.

The System Alarms List displays the following fields:
• The Date column contains the date and time the alarm was generated.
• The Description column contains a description of the alarm.
• The Source column contains the originator of the alarm.
• The Who Ack column contains the ID of the user who acknowledged the alarm.
• The Time Ack column contains the date/time stamp when the alarm was acknowledged.

Related Topics:
• Silencing Alarms
• Removing Alarms from the List
• Turning Audio Notification On and Off
• Preventing a Device from Reporting SCADA Alarms

SCADA Alarms List

The SCADA Alarms view is only available if your system supports SCADA extensions. For more information about SCADA extensions, see SCADA Extensions on page 13-1.

To access the SCADA Alarms List, select Alarms and Devices Lists>SCADA Alarms List… from the Work Agenda Tools menu.

The SCADA Alarms List displays the following fields:
• The Date column contains the date and time the alarm was generated.
• The Feeder column contains the feeder on which the device in the alarm is located.
• The Device column contains the identification of the device associated with the alarm.
• The Description column contains a description of the alarm.
• The Source column contains the originator of the alarm.
• The Value column contains the last reported measurement value. The value can be status, digital, or analog. For status measurements, typically a value of “0” indicates open and a value of “1” indicates closed. Any special tags placed on the device would be indicated by a digital value.
• The **Phase** column contains the phase of the measurement, described as A, B, C, or a combination of phases.

• The **Attribute** column contains the type of SCADA measurement (e.g., current, voltage).

• The **Nominal** column contains the nominal value of the measurement that is in alarm (only for digital).

• The **Quality** column provides additional information about the SCADA measurement (e.g., out of scan, inhibited, manual override) that is in alarm.

• The **Limit** column contains the configurable threshold value. If the analog crosses a low or high threshold, the system creates a limit alarm, and the threshold value appears here.

• The **Who Ack** column contains the ID of the user who acknowledged the alarm.

• The **Time Ack** column contains the date/time stamp when the alarm was acknowledged.

Related Topics:

• **Silencing Alarms**

• **Removing Alarms from the List**

• **Turning Audio Notification On and Off**

• **Preventing a Device from Reporting SCADA Alarms**
Menus and Toolbar

The following table describes the Alarms and Devices Lists menus.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Print</td>
<td>Opens up the Print Preview dialog box, which allows you to print out the contents of the table.</td>
</tr>
<tr>
<td>File</td>
<td>Exit</td>
<td>Closes the Abnormal Device Summary window.</td>
</tr>
<tr>
<td>Filter</td>
<td>Device Operations List</td>
<td>Opens the Device Operations view.</td>
</tr>
<tr>
<td>Filter</td>
<td>System Alarms List</td>
<td>Opens the System Alarms view.</td>
</tr>
<tr>
<td>Filter</td>
<td>SCADA Alarms List</td>
<td>Opens the SCADA Alarms view.</td>
</tr>
<tr>
<td>Filter</td>
<td>Abnormal Devices List</td>
<td>Opens the Abnormal Devices view.</td>
</tr>
<tr>
<td>Filter</td>
<td>Show Filter Dialog</td>
<td>Opens the Filter dialog box, allowing you to create, modify, apply, and save user-defined filters.</td>
</tr>
<tr>
<td>Filter</td>
<td>All</td>
<td>Displays all alarms of the selected alarm type.</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td>Allows you to display the About Web Workspace dialog box.</td>
</tr>
</tbody>
</table>

Toolbar

The options on the Alarms and Devices Lists toolbar vary depending on the current view. The following table describes the toolbar options and identifies which buttons are applicable to each view.

Note: Toolbar options are also displayed as pop-up menu options when you right-click a row in the alarm list.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Acknowledge]</td>
<td>Acknowledges the selected alarms. This button does not display in the Abnormal Devices view.</td>
</tr>
<tr>
<td>![Clear]</td>
<td>Clears the selected alarms. This button does not display in the Abnormal Devices view.</td>
</tr>
<tr>
<td>![Silence]</td>
<td>Silences the selected alarms. This button displays only in the SCADA Alarms view.</td>
</tr>
<tr>
<td>![Audio Enabled]</td>
<td>Enables or disables alarm sounds (beeping). This button displays only in the SCADA Alarms view.</td>
</tr>
<tr>
<td>![Exit]</td>
<td>Closes the Alarms and Devices Lists window.</td>
</tr>
</tbody>
</table>
Using the Alarms and Devices Lists

Acknowledging Alarms

To acknowledge an alarm, complete these steps:

1. In the Alarms and Devices List, select the row of the alarm you want to acknowledge.
2. Click the **Acknowledge** button. The following occurs:
   - The alarm becomes acknowledged.
   - Its audible alarm is silenced.
   - Your user name appears in the **Who Ack** field.
   - The current date and time appears in the **Date Ack** field.

Silencing Alarms

To silence an alarm, complete these steps:

1. In the Alarms and Devices List, select the row of the alarm you want to silence.
2. Click the **Silence** button.
   - The audio notification for the alarm becomes silent.
   - The alarm is still not acknowledged.
   - Subsequent new alarms will cause the audio notification to sound.

Removing Alarms from the List

To remove an alarm from the Alarms and Devices List, complete these steps:

1. In the Alarms and Devices List, select the row of the alarm you want to silence.
2. Click the **Clear** button. The alarm disappears from the list.

   **Note:** You can remove multiple alarms by selecting multiple rows before you click the Clear button. Select multiple rows by clicking a row, holding the mouse button, and dragging the pointer over the additional rows.

Turning Audio Notification On and Off

To turn audio notification on or off, click on the Audio Enabled checkbox at the top of the Work Agenda window. The audio for the entire system (all alarms) will toggle on or off.

Preventing a Device from Reporting SCADA Alarms

To prevent a device from reporting Alarms, complete these steps:

1. In the Alarms and Devices List, select the row of an alarm that belongs to the device you want to inhibit.
2. Click the **Inhibit Alarm** button.
   - The device will not report SCADA alarms until the inhibit is cancelled.
   - An “I” appears next to the device in the Viewer indicating the device is inhibited.
   - An “I” appears in the Quality columns of the SCADA Alarms List and the SCADA Summary.

   **Note:** Inhibiting alarms does not affect the physical SCADA device; it only prevents Oracle Utilities Network Management System SCADA Extensions from reporting an incoming alarm.
Using the User Log

The User Log displays a log of actions taken by a user.

To open the User Log, select User Log... from the Web Workspace Tools menu.

The User Log displays the following fields and buttons:

- The **User ID** field opens with the current user's identification, but the field may be edited to load log entries for a different user; for a different user log, enter their user ID and click the  button.

- The **Begin Time** and **End Time** fields allow you to filter the User Log by time. To load log entries for a specific time period:
  - Enter a starting date in the Begin Time field.
  - Enter an ending date in the End Time field.
  
  *Note:* You can enter a beginning date, an ending date, or both.

  - Click the  button. The list is refreshed to display only entries with a date and time greater than or equal to the Begin Time and less than or equal to the End Time.

- The **User Comment** allows you to enter a user comment log entry. Type the note text into this field and then click the  button.

  *Note:* The User Log does not automatically refresh, so the new comment will not appear in the table until the user log is reloaded.

- The **Date/Time** field displays the date/time at which the log entry occurred.

- The **Event** field displays the Event # associated with the log entry.

- The **User** field displays the user that initiated the action.

- The **Text** field displays a description of the log entry.

- The  button displays the Print Preview dialog box so you can view or print the log.

- The  button closes the User Log window.

- The  button loads the User Log for the for the current filter parameters (User ID, Begin Time, and End Time).

- The  button clears the User Log.

- The  button displays the device associated with the log entry in the Viewer.

- The  button displays the Event Details window for the event associated with the log entry.
This chapter describes the Web Trouble application. It includes the following topics:

- Overview
- Managing Events with Web Trouble
- Managing Crews with Web Trouble
- Managing Calls with Web Trouble

Overview

Oracle Utilities Network Management System - Web Trouble augments the Web Workspace module with crew and event management capabilities. Web Workspace's crew dispatch and management functions facilitate operations in daily maintenance and outage restoration situations.

The windows, menu bar, and buttons on the Web Trouble window are common to both Web Trouble and Web Workspace. Refer to the following topics for details on using and navigating common application components:

- Logging In
- Common Web Workspace and Web Trouble Features
- Dockable Windows Navigation
- Sorting and Filtering Data
Managing Events with Web Trouble

Oracle Utilities Network Management System – Web Trouble includes windows that help you manage trouble events. This section describes those windows and how to perform basic event functions. It includes the following topics:

- Work Agenda Trouble Events List
- Event Details
- Acknowledging Events
- Setting the Work Queue
- Event Grouping
- Associating and Unassociating Calls with Devices
- Associating Damage Assessments to an Event
- Working with AMR Requests
- Updating the ERT for Selected Events
- Setting the System-Wide Estimated Restoration Time
- Using the Event Log

Work Agenda Trouble Events List

The Work Agenda Trouble Events list displays outages (new, predicted, and confirmed) and non-outages, along with associated system and event information. The Trouble Events lists can organize events based on critical customers, emergency calls, number of customers out, etc. You can customize the order in which the columns display.

Event rows are color-coded by status. For more information about the color coding used to indicate event status on the Work Agenda, see Event Status on page B-2.

A summary of the total number of events, calls, and estimated customers out for the currently selected view (subject to any filtering) appears at the top of the Work Agenda window above the Trouble Events list. This area also provides totals within specific categories for types of calls and customers, as well as a summary of dispatched crews.

New and revised predicted events are sent to the Work Agenda from the Oracle Utilities Network Management System Trouble Management analysis engine. The system then alerts you to the new information with an audible alarm. The alarm will sound:

- Every three seconds continuously when an event with a NFY status (Notify alarm) appears, until the event is acknowledged.
- Once every five minutes while there are any other unacknowledged events.

Event Details

The Event Details window is used to enter and track information about the cause of an event and how the event is resolved. It displays event information, including crew contact details, both the begin and restoration times for the event, any partial restoration steps, and the operations event note. Some information is automatically entered into Event Details, and you can manually override some of this data. In addition, you can complete events from this window, giving you an opportunity to enter more detail about the event and validate the completion for proper event reporting.

This section contains the following topics:
• Using the Event Details Window
• Updating the Estimated Restoration Time
• Recording Failed Equipment Information
• Copying Event Details to Related Partial Restoration Events
• Completing an Event

Using the Event Details Window
To open Event Details, double-click the event row in the Trouble Events list on the Work Agenda window. You can also select an event and then click the Event Details toolbar button or select Event Details... from the Actions menu.

The Event Details window contains the following tabs:

• Job Actions
• Completion Actions
• Equipment Failure

Menus and Toolbar
The Event Details window displays a toolbar, as well as a Help and File. The Help menu displays the standard Help and About options. The table below describes the options on the File menu.

The Event Details window contains the following tabs:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves the current event. If the event has already been completed, you are prompted to provide a reason for the update.</td>
<td>![Save Icon]</td>
</tr>
<tr>
<td>Print Tab...</td>
<td>Opens the Print Preview dialog and allows you to print the current contents of the Job Actions tab.</td>
<td>![Print Icon]</td>
</tr>
<tr>
<td>Print All...</td>
<td>Opens the Print Preview dialog and allows you to print the contents of all three Event Details tabs.</td>
<td>![Print Icon]</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits Event Details. You must press the Save button before pressing the Exit button if you wish to save any revisions you may have made.</td>
<td>![Exit Icon]</td>
</tr>
</tbody>
</table>

Actions Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete Event</td>
<td>Sets the status of the current event to Complete. If the required fields (Remedy and Failure) have not been entered, this option will not be available. This option is not available when the event is a switching job or planned outage.</td>
<td>![Complete Icon]</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the case notes and details for the currently loaded event to all other events related to it based on its partial restoration.</td>
<td>![Copy Icon]</td>
</tr>
<tr>
<td>Event Log...</td>
<td>Opens the Event Log.</td>
<td>![Log Icon]</td>
</tr>
</tbody>
</table>
Event Information Pane
The top section of the Event Details window contains event attributes:

- The **Event #** is the number the system has assigned to the event.
- The **Device** is the name of the device associated with the event.
- The **Switching Plan #** is the switching sheet number associated with the event, if any. The switching sheet number is prefixed by the switching sheet type.
- The **Zone** displays the control zone(s) where the associated device is located.

Job Actions
The Job Actions tab lets you view detailed information about the event. The first section displays summary information about the event, including the duration and scope of the event. The second section displays partial restoration information. The third section allows you to enter estimated restore and repair time information as well as operations event notes. The fourth section allows you to manage crew contact times.

For instructions on updating the ERT, see **Updating the Estimated Restoration Time** on page 7-7.

The Job Actions tab displays the following fields and buttons:

- **Event Began** contains the date and time at which the event began. This field is editable except for switching jobs. For switching jobs, you must edit the Completed Date in the switching step itself. See **Steps Tab** on page 15-18 for more information.
- **Est # of Cust Out** contains the estimated number of customers experiencing an outage for this event.
- **Event Restored** contains the date and time of event restoration (i.e., when the outage area was re-energized). This field is editable except for switching jobs. For switching jobs, you must edit the Completed Date in the switching step itself. See **Steps Tab** on page 15-18 for more information.

The **Partial Restoration Log** table displays information related to restoration if the event is restored in stages. This table does not display when the event is a non-outage. This table contains the following columns:

- The **# Cust Out Before** column contains the total number of customers out at each stage.
- The **Operation Time** column contains the date and time of the operation. User can modify values in this column as long as the changes do not alter the order of partial restoration steps. Changing partial restoration step operation time can affect outage restoration time if it is the final restoration step for the outage.
- The **Device** column displays the device operated at each stage.
- The **# Cust Restored** column contains the total number of customers that were restored at each stage.
The # Cust Added column contains the total number of customers that were added at each stage.

The # Cust Out After column contains total number of customers still without power after each stage.

The Remarks column contains any comments or remarks entered by the user.

The Event # column contains the event number associated with each partial restoration step.

The Est Time to Restore (HH:MM) field displays the estimated time from the current time to complete the restoration in hours and minutes. The Est Time to Restore (HH:MM) field is not displayed when the event is a non-outage or switching job. To set the ERT, enter a value in this field and click the Update ERT button.

The Est Restore Date fields display the date and time of estimated restoration. The Est Restore Date fields are not displayed when the event is a non-outage. To clear the ERT (leave it blank), click the Clear ERT button.

The Est Time to Repair (HH:MM) field is used to enter the estimate time to repair in hours and minutes. This field is used when the crew on-site is only assessing the job and providing an estimate for the time it will take another crew to do the work. This field is editable, and Oracle Utilities Network Management System Storm Management uses the value, if installed. The Est Time to Repair (HH:MM) field is not displayed when the event is a switching job.

The Operations Event Note is a text field for you to enter notes about the event. These are notes that are made available to the call takers to pass on any specific details about the event to new callers associated with this event.

En Route/Onsite Crews Section

The Next Crew Contact Required at table displays when the operator next anticipates receiving contact from the associated crew(s).

Use the Reset Selected Crew Contact Time button to reset the crew contact time to the date and time you enter in the Date field beside this button.

The En Route/Onsite Crews table contains the following columns:

- The Crew ID column of the table contains the crew name.
- The Contact column displays the contact name for the assignment.
- The Mobile # is the mobile phone number of the crew.
- The En Route Date column contains the time at which the crew was placed en route to the event. This column is empty if the crew has not arrived yet.
- The On Site Date column contains the time at which the crew arrived on site.
- The Contact Required By column contains the date and time at which the next contact is expected.

Completion Actions

The Completion Actions tab lets you view detailed information about the event, as well as enter information about the actions taken to complete the event. The first section displays summary information about the event, including the duration and scope of the event. The second section lets you enter information about the cause of the outage, the affected system and subsystem, environmental factors, and the actions that were taken to restore the outage. The third section
allows you to exclude the event from the interruption indices calculations. The fourth section displays a log of changes made to the event details after the event was completed.

For instructions on completing an event, see Completing an Event on page 7-8.

The Completion Actions tab displays the following fields and buttons:

- **Event #** is the number the system has assigned to the event.
- **Device** is the name of the device associated with the event.
- **Switching Plan #** is the switching sheet number associated with the event, if any. The switching sheet number is prefixed by the switching sheet type.
- **Zone** displays the control zone(s) where the associated device is located.
- **Event Began** contains the date and time at which the event began. This field is editable except for switching jobs.
- **Est # of Cust Out** contains the estimated number of customers experiencing an outage for this event.
- **Event Restored** contains the date and time of event restoration (i.e., when the outage area was re-energized). This field is editable except for switching jobs.
- **Details** section displays the following drop-down lists.
  - **System** drop-down lets you specify what type of system the failure is on (e.g., overhead transmission, underground distribution, supply, etc.).
  - **Sub-System** indicates whether the sub-system is primary or secondary, radial or mesh, or a service drop.
  - **Type** drop-down lets you specify the type of device that is experiencing the problem.
  - **Failure** drop-down lets you specify the type of failure that is occurring.
  - **Interrupting Device** drop-down lets you specify the type of interrupting device involved with the event.
  - **Weather** drop-down lets you specify weather conditions at the time of the event.
  - **Environment** drop-down lets you specify environmental factors that have been involved with the event, such as humidity and salt spray.
  - **Vegetation** drop-down lets you specify the type of vegetation issues involved with the event, such as tree or vine, location (on or off ROW), and severity (contact or uprooted).
  - **Foreign Interference** drop-down lets you specify animals, vehicles, or any other type of foreign body that has contributed to the event.
  - **Defective Equipment** drop-down lets you specify the type of equipment defect involved with the event (e.g., age deterioration, customer equipment, etc.)
  - **Scheduled** drop-down lets you specify whether or not the event was planned and if it was planned for safety purposes.
  - **Utility Error** drop-down lets you specify the reason for the event if it was caused by the utility company.
  - **Other** drop-down lets you specify if the cause is something other than that listed in the drop-down menus or if the cause is unknown.
  - **Remedy** drop-down lets you specify the task performed to resolve the event.
- **Interruption Indices** section displays the following fields:
• The Exclude This Event checkbox allows you to designate if you want to exclude this event from the interruption indices calculations done by the Oracle Utilities Network Management System – Trouble Reporting application. The Exclude from Interruption Indices checkbox is not displayed when the event is a switching job or planned outage.

• The Reason for Exclusion field provides free-form text entry of the reason for the exclusion of this event from the interruption indices. The Reason for Exclusion field is not displayed when the event is a switching job or planned outage.

• The Post-Completion Edit Log table displays information related to an edit to the event details after the event is completed. This table contains the following columns:
  - The Who column contains the user ID of who performed the edit.
  - The Date column contains the date and time of the edit.
  - The Reason column contains a description of why the edit was made.
  - The Field column contains the name of the field that changed.
  - The Previous Value column contains the value the field was changed from.

**Equipment Failure**

The Equipment Failure tab lets you record detailed information about any failed equipment related to an event. You can record and track the type of equipment that failed, the manufacturer, serial number, and voltage details.

For instructions on entering failed equipment details, see Recording Failed Equipment Information on page 7-8.

The Equipment Failure tab displays the following fields and buttons:

- **Item** is automatically populated with the Failure option selected in the Event Details tab.
- The **Manufacturer** drop down menu provides a list of manufacturers to select from.
- **Serial #** is an editable (alphanumeric) field for you to enter the serial number for the equipment.
- **Date of Manufacture** is an editable (date/time) field for you to enter the date of manufacture of the equipment.
- **Date of Installation** is an editable (date/time) field for you to enter the date of installation of the equipment.
- **Primary Voltage** is an editable (alphanumeric) field for you to enter the primary voltage of the equipment.
- **Secondary Voltage** is an editable (alphanumeric) field for you to enter the secondary voltage of the equipment.
- **Rating** is an editable (alphanumeric) field for you to enter the rating of the equipment. The drop-down menu beside the Rating field allows you to select the rating units.
- **Phase** allows you to designate whether the equipment is single-phase or three-phase.
- **Type** is an editable (alphanumeric) field for you to enter the type of equipment.
- **Size** is an editable (alphanumeric) field for you to enter the size of the equipment.

**Updating the Estimated Restoration Time**

After a crew has arrived onsite and provided information regarding when the event will be restored, you can update this information using Event Details. To update the estimated restoration time, complete these steps:

1. Select the event in the Work Agenda window.
Managing Events with Web Trouble

2. Click the Event Details toolbar button or select Event Detail... from the Actions menu. The Event Details window opens.

3. On the Job Actions tab, enter the amount of time (in hours and minutes) that the crew will take to restore the outage in the Est Time to Restore field.

4. Click the Update ERT button. The updated time displays in the Est Restore Date fields, and other windows that display the Est Restore Date will be updated.

Recording Failed Equipment Information

To record information about a failed device, complete these steps:

1. From the Event Details window, click on the Equipment Failure tab.

2. Select the manufacturer from the Manufacturer drop down menu.

3. Enter the serial number, dates of manufacture and installation, primary and secondary voltage, rating, type, and size of the equipment, as applicable.

4. Click on the drop-down list next to the Rating field and select the rating unit, as applicable.

5. Select the Phase.

6. Click the Save toolbar button. The information is saved to the database for the event. The Event Details tab re-displays.

Copying Event Details to Related Partial Restoration Events

You can copy the case notes and other event details for the currently loaded event to all other events related to it based on its partial restoration.

Note: Any previously stored Event Details information for the related events will be overwritten (except for system-populated fields such as Event #, Device, Zone(s), Event Began, Est # of Cust Out, and Event Restored).

1. Select the event in the Work Agenda window.

2. Click the Event Details toolbar button or select Event Detail... from the Actions menu. The Event Details window opens.

3. Make any desired changes to the event details. Any comments you enter in the Operations Event Note will be applied to all related partial restoration events.

4. Click the Copy toolbar button or select Copy from the Actions menu. The corresponding event details are copied to all related partial restoration event(s) of the currently displayed event.

Completing an Event

After a crew has reported that an event is complete, you can update the event information in the Event Details window and complete the event. To complete an event, follow these steps:

1. Select the event in the Work Agenda window.

2. Click the Event Details toolbar button or select Event Detail... from the Actions menu. The Event Details window opens.

3. Click the Completion Actions tab.

4. Select the appropriate options from the drop-down menus. Typically, you must select a Failure and a Remedy. Additional options may be required, based on your configuration. Once the required options have been provided, the Complete Event button is enabled.

5. Select Complete Event from the Actions menu. The event information is updated, the event is marked as “complete,” and the Event Details window closes.
Confirm Outages

If you need to confirm a probable service outage or create new confirmed service/secondary outage events when a crew reports in from a site, you can use the Confirm Outages window. This window displays a table listing either all of the customers downstream of the predicted or confirmed outage device (when accessed from the Work Agenda) or all of the customers connected to the selected device (when accessed via the Control Tool).

This section includes the following topics:

- Using the Confirm Outages Window
- Creating a Confirmed Service Outage
- Creating a Confirmed Secondary Outage
- Creating a Confirmed Service and Secondary Outage for the Same Customer
- Restoring a Customer with a Confirmed Service or Secondary Outage

Using the Confirm Outages Window

To access the Confirm Outages window, do one of the following:

- Select Confirm Outages… from the Work Agenda Actions menu.
- Select a device in the Viewer that has customers connected to it, bring up the Control Tool, then click on the Confirm Outages… button.

The Confirm Outages window displays the following columns:

- The Device column contains the name of the device the customer is connected to.
- The Address column contains the customer's address.
- The Name column contains the name of the customer.
- The Customer Type column contains the customer type code.
- The Prediction column contains “Confirmed Service” to indicate the customer is involved in a probable service outage, “Confirmed Secondary” to Otherwise, it is blank.
- The Restored column contains “Yes” to indicate the customer has had their confirmed service or confirmed secondary outage restored. However, information must be entered in the Event Details window in order to complete it. Otherwise, it is blank.
- The Grouping column contains “Yes” if the confirmed outage has been made groupable.
- The Event # column displays the number the system has assigned to the customer's event. If a customer call is made groupable, the event number will change if the call is grouped to an existing or repredicted event.
- The Call Time column displays the time when the customered call was received.
- The Telephone column contains the customer's telephone number.
- The Account # column contains the customer's account number.
Managing Events with Web Trouble

Color Coding
The rows in the Confirm Outages window are color-coded to designate when a customer has a confirmed service outage, a confirmed secondary outage, or when the customer has been restored. When a customer is affected by multiple outages, multiple rows will be displayed representing the different outages.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Confirmed Service Outage</td>
</tr>
<tr>
<td>Orange</td>
<td>Confirmed Secondary Outage</td>
</tr>
<tr>
<td>Blue</td>
<td>Restored</td>
</tr>
</tbody>
</table>

Confirm Outages Buttons

- The button displays the Print Preview dialog box so you can view or print the log.
- The button refreshes the data with any changes since the window was opened or last refreshed.
- The button closes the window.
- The button opens the Event Details.

Confirm Outages Menus

- File menu options are:
  - Print – Opens the print dialog box to allow you to print the current list.
  - Refresh – Refreshes the data.
  - Exit – Closes the Confirm Outages window.
- Actions menu options are:
  - Confirm Service – Confirms a service outage for the selected row(s).
  - Confirm Secondary – Confirms a secondary outage for the selected row(s).
  - Restore – Sets the outage to restored. The Restored column is populated with “Yes”.
  - Make Groupable – Sets a non-fuzzy call to groupable. The Groupable column is populated with “Yes”.
  - Event Details... – Opens the Event Details window.

Creating a Confirmed Service Outage
To create a confirmed service outage for a customer, complete these steps:

1. Select the row in the Confirm Outages window for the applicable customer.
2. Select Confirm Service from either the right-click option menu or from the Actions menu.
3. The Confirm Outages window refreshes. The row for the selected customer is now colored green, and the Prediction column is now populated with “Confirmed Service”. A new event row appears in the Work Agenda Trouble Event list. A CSVO symbol appears on the customer’s device in the Viewer window.
Creating a Confirmed Secondary Outage
To create a confirmed secondary outage for a customer, complete these steps:
1. Select the row in the Confirm Outages window for the applicable customer.
2. Select **Confirm Secondary** from either the right-click option menu or from the Actions menu.
3. The Confirm Outages window refreshes. The row for the selected customer is now colored orange and the **Prediction** column is now populated with “Confirmed Secondary”. A new event row appears in the Work Agenda Trouble Event list. A **CSCO** symbol appears on the customer’s device in the Viewer window.

Creating a Confirmed Service and Secondary Outage for the Same Customer
To create a confirmed service outage and secondary outage for a customer, complete these steps:
1. Select the row in the Confirm Outages window for the applicable customer.
2. Select **Confirm Service** as described above; the Confirm Outages window will refresh with the confirmed service data. Likewise, with the same row selected, select **Confirm Secondary**.
3. The Confirm Outages window refreshes. There are now 2 rows for the customer with **Prediction** column populated with the outage type (*i.e.*, **Confirmed Service** and **Confirmed Secondary**). Both a CSVO and CSCO symbol appear on the customer’s device in the Viewer window.

Restoring a Customer with a Confirmed Service or Secondary Outage
To restore a confirmed service or secondary outage for a customer, complete these steps:
1. Select the row in the Confirm Outages for the applicable customer.
2. Select **Restore** from either the right-click option menu or from the Actions menu.
3. The Confirm Outages window refreshes. The row for the selected customer is now colored blue and the **Restore** column is populated with “Yes”. The CSVO/CSCO symbol disappears from the customer’s device in the Viewer window (or the CSVO/CSCO numbers are decreased by one).
Managing Events with Web Trouble

Acknowledging Events

To acknowledge an event, complete these steps:

1. Select the row of the event with NEW, S-NEW, P-NEW, M-NEW, or RED status in the Work Agenda Events List.

2. Click on the **Acknowledge** toolbar button or select **Acknowledge** from the Actions menu. The event becomes acknowledged and its status changes accordingly.

Setting the Work Queue

To set a Work Queue value for an event, complete these steps:

1. Select the desired event's row in the Work Agenda.

2. Click on the **Referral** toolbar button or select **Referral...** from the Actions menu. The Work Queue dialog appears.

3. Select a value from the **Refer To** list.

4. Enter any desired remarks into the **Remarks** field.

5. Click the **OK** button. The Work Queue dialog disappears, and the Work Queue column of the selected row updates with the selected Refer To value.

Event Grouping

While the system automatically groups events according to the trouble analysis rules, you may come across some events that are related, but are not grouped because of data modeling issues (e.g., connectivity problems). You can manually group these events together using the Group Events dialog box.

**Group Events Dialog Box**

The Group Events dialog box allows you to group events. To open the Group Events dialog box, select **Group Events** from the Actions menu in the Work Agenda window.

The Group Events Dialog displays the following fields:

- The **Selected Events** area displays all of the events that have been selected for grouping.
- The **Group Method** contains a selection of grouping options:
  - The **merge** option is used for event grouping.
  - The **relate** option does not group the selected events, but rather allows you to record a relationship between the events and enter notes in the Relationship Comments field.
  - The **unrelate** option allows you to remove one or more previously related events from the relationship.
  - The **Relationship Comments** field allows you to enter comments about the relationship when the Group Method is set to “relate.”
### Grouping Events

To group events, complete these steps:

1. Open the Group Events dialog box by selecting **Group Events** from the Work Agenda Actions menu.

2. Make sure the **Group Method** is “merge.”

3. In the Trouble Events list, select the row for the event that all subsequent events will be grouped to. The event number appears in the Selected Events field.

4. Select the row of an event in the Trouble Events list that you want to group to the first selected event. The event number for the event is added to the Selected Events field.

5. If there are other events you want to add, select the row for those events in the Trouble Events list. The event numbers for the events are added to the Selected Events field.

6. To deselect a selected event, select its row again. The event number is removed from the Selected Events field.

7. Click on the **OK** button.
   - The selected events are grouped to the first selected event.
   - The rows for the subordinate events disappear from the Trouble Events List.
   - The number of customer calls are added together and their sum appears in the # Calls column.

### Grouping Rules

If the events that you selected do not meet the manual grouping rules, the system will not let you group them. An error message will appear explaining the problem. Manual grouping rules include the following:

- General fuzzy events can group to any outage.
- Fuzzy events associated with a control zone can only group to other events in the same control zone.
- Non-outage events can group to outage or non-outage events.
- Outage events can group to other outage events, but outage events cannot be grouped to other outage events that they are not downstream of.
- Real outages (i.e., outages that have a device opened/closed in the Viewer causing a segment of the model to be de-energized) cannot group to one another.
- Outage events cannot group to non-outage events.
- Meets (e.g., meet fire, etc.) cannot group to anything.
- Switching jobs cannot group to anything.

### Graphical Grouping (Supply Points Mode)

To add customers to an event graphically, follow these steps:

1. Select a probable outage in the Work Agenda.

2. Click the **Trouble Info** toolbar button or select **Trouble Info...** from the Actions menu to display the Trouble Info callers for this outage.

3. Select **Supply Points** from the File menu to display the Supply Point Summary.

4. In the Viewer, press the **Supply Points Mode** button to toggle into Supply Points mode.
5. Using a box or polygon, select a group of supply points. All supply points inside the box or polygon are highlighted. (See Selecting Devices on page 6-40 for details on selecting devices in the Viewer.)

6. Do one of the following:
   - To add a single supply point, right-click on the supply point and select Add Supply Points from the pop-up menu. A row is added to the Trouble Info Supply Points table in green and marked as To Be Grouped (TBG).
   - To add all highlighted supply points, hold down the Alt key and right-click on a highlighted supply point, then select Add Supply Points from the pop-up menu. The Supply Points rows are added to the Trouble Info Supply Points table in green and marked as To Be Grouped (TBG).

   **Note:** To display a list of highlighted supply points, Alt-right-click and then select Show Supply Points from the pop-up menu. The Supply Point Summary table on the Trouble Info window displays details for the highlighted supply points.

7. Press the Update Event button on the Trouble Info Supply Points view to group the Supply Points into the event.

8. Enter an event grouping threshold (in hours) in the Update Job confirmation dialog.
   - The selected event will now include the selected supply points and the Work Agenda row will now reflect the new customer count and call count, if other calls existed on the selected Supply Points.
   - Supply Points with calls that did not pass the selected grouping threshold are not added to the outage and will be marked in yellow with FAIL in the Grp column.
   - You can also remove Supply Points from the event by selecting them and clicking the Remove button, then the Update Event button. Any calls on the removed Supply Points will create new events.

**Relating Events**

To relate events, complete these steps:

1. Open the Group Events dialog box by selecting Group Events from the Work Agenda Actions menu.
2. Change the Group Method to “relate.” The Relationship Comments field is now accessible.
3. In the Trouble Events list, select the row for the event that all subsequent events will be related to. The event number appears in the Selected Events field.
4. Select the row of an event in the Trouble Events list that you want to relate to the first selected event.
5. If there are other events you want to add, select the row for those events in the Trouble Events list. The event numbers for the events are added to the Selected Events field.
6. Type a comment into the Relationship Comments field, if desired.
7. Click the OK button. The selected events are related to one another. The Grp Type column in the Work Agenda for each event now contains “REL”, the Rel Type column now contains “R”, and Rel Event # column now contains the event number of the earliest event.
Unrelating Events
To unrelated events that have been related, complete these steps:

1. Open the Group Events dialog box by selecting Group Events from the Work Agenda Actions menu.
2. Change the Group Method to “unrelate.”
3. In the Trouble Events list, select the row for the event that you wish to unrelate. The event number appears in the Selected Events field.
4. If there are other events that you want to unrelate, select the row for those events in the Trouble Events list. The event numbers for the events are added to the Selected Events field.
5. Click the OK button. The selected events are unrelated. If two or more events are still part of that relationship, they remain related to each other. If the event that was displayed in the Rel Event # column was unrelated and two or more events are still part of that relationship, the Rel Event # column is updated with the event number of the earliest event remaining in the relationship.

Associating and Unassociating Calls with Devices
Sometimes a call comes in reporting a problem that is not clearly related to a particular customer or device. Until a device is identified for the problem, the event is considered a “fuzzy call.” When more information becomes available, you can associate the fuzzy call with a device. You can also unassociate these calls using the Trouble Info window.

Associating a Fuzzy Call with a Device
To associate a call with a device, complete these steps:

1. Open a Viewer window and load the map containing the device you want to associate.
2. In the Work Agenda list, select the row of the fuzzy event that you want to associate.
3. In the Work Agenda window, select Associate Event... from the Actions menu. The Associate Event dialog box opens.
4. In the Viewer, select the device you want to associate the fuzzy call to. The device identification appears in the Device field of the Associate dialog box.
5. Click OK in the Associate Event dialog box. The row for the fuzzy event disappears from the Work Agenda, and the Oracle Utilities Network Management System analysis engine re-analyzes the fuzzy call using the selected associated device.

Unassociating/Reassociating a Call from/to a Device
To unassociate a call from one device and reassociate it to another device, complete these steps:

Note: If you are unassociating a call and you want to turn it into a fuzzy call, simply do not select a device to re-associate it with (i.e., omit the third and sixth steps below).

1. In the Work Agenda window, select the row for the event that contains the calls you want to unassociate.
2. Click on the Trouble Info toolbar button or select Trouble Info... from the Actions menu. Call information about the event appears in the Trouble Info window.
3. Open a Viewer window and load the map containing the new device you would like to re-associate the call(s) with.
4. In the Trouble Info window, select the row for the call you wish to unassociate from its present device.
5. Select Unassociate from the Trouble Info Actions menu. The Unassociate dialog box opens.
6. Select a device in the Viewer to populate the New Device field in the Unassociate dialog box.
7. Click OK on the Unassociate dialog.
   - The call is unassociated from the current device and associated with the new device, if specified.
   - The Oracle Utilities Network Management System Trouble Management analysis engine re-analyzes the event from which the calls were unassociated, as well as the unassociated calls using their new associated device.

**Associating Damage Assessments to an Event**

When a crew out in the field is assessing damage that has occurred, you may wish to record the damage information in Oracle Utilities Network Management System. You can use the Damage Assessment window to record the type of damage as well as what materials are required to repair. If multiple damage assessments exist for an event, the system will calculate the estimated repair time by adding together estimated repair times from each active damage assessment. You can also select one or more crew types needed to repair the reported damage.

The damage assessment trouble code has an associated clue symbol, which will be displayed in Viewer at the damage location.

*Note:* Damage assessment incidents are not included in counts for the event.

To enter damage assessment information for an event, complete the following steps:

1. Select an event from the Event List in the Work Agenda.
2. Select **Damage Assessment...** from the Actions menu. The Damage Assessments window opens. If any damage assessment records exist for this event, they are displayed.
3. Click the **New** button on the toolbar. The Damage Assessment window opens. The following fields are pre-populated: Event #, Crew (if the outage has a single crew assigned/en-route or onsite), Report Date, Damage Location (based on the location of the outage device), and Phases Affected (based on phases of the outage device).
4. Complete additional fields on this screen as needed. See the following section for field descriptions.
5. Click the **Save** button on the toolbar.
6. Use the **Complete** toolbar button to complete the damage assessment. When a damage assessment record is completed, its status changes to inactive and its symbol is removed from Viewer.

**Damage Assessment Window**

Use the Damage Assessment window to enter damage assessment information for an event or device.

The Damage Assessment window is displayed when you do one of the following:

- Click the **Damage Assessment...** option from the Actions menu in the Work Agenda, and then click the **New Damage Assessment** or **Open Selected Damage Assessment** button from the Damage Assessments window.
- Click the **Damage Assessment...** button from the Control Tool, and then click the **New Damage Assessment** or **Open Selected Damage Assessment** toolbar button from the Damage Assessments window.

The Damage Assessment window displays the following fields and buttons:

- **Event #** is the ID of the event associated with this damage assessment.
- **Crew** is the crew that performed the damage assessment.
• The Select Crew button opens the Select Crew dialog so you can select a crew to associate with this assessment.

• Mobile # is the mobile number of the crew that performed the damage assessment.

• Report Date is the date and time when damage assessment was performed. Click to use the date picker to set the date.

Damage Location Section
• Feeder is the name of the feeder.
• Device is the device alias.
• Damage location is the street address where the damage assessment was performed.
• Company is the company-level control zone name.
• Region is the region-level control zone name.
• Branch is the branch-level control zone name.
• Substation is the substation-level control zone name.

Damage Specifics Section
• Phases Affected displays a checkmark beside each affected phase.
• Section Affected allows you to specify the section affected by the damage. You can select from a list or enter a value manually.
• Location allows you to specify the damage location. You can select from a list or enter a value manually.
• The Load Affected checkbox indicates whether the damage affects customers. If checked, the damage assessment will generate an outage incident; otherwise, a non-outage incident will be generated. When damage assessment is performed for an existing non-outage event, this checkbox will be unchecked and non-editable.
• The Street Light Damage Noted checkbox indicates whether street line damage is reported.
• The Required Crew Types indicates the types of crews needed to repair the damage. Check each one that applies.
• The Damage Type column in the Damage Specifics table displays all known types of damage.
• The Accessible column in the Damage Specifics table displays the number of accessible instances of a particular type of damage. Enter a value for each applicable damage type. When you modify a row, its background changes to green.
• The Inaccessible column in the Damage Specifics table displays the number of inaccessible instances of the particular type of damage. Enter a value for each applicable damage type. When you modify a row, its background changes to green.
• Comments contains any remarks associated with the damage specifics.
Required Material Section

- The Add Required Part button opens the Add Required Part dialog so you can select a part and specify a quantity.
- The Remove Required Part button allows you to mark a row in the Required Material list for removal. Rows marked for removal display a red background.
- Part ID contains the IDs of parts required to repair the damage.
- Part Name contains the names of parts required to repair the damage.
- Quantity displays the quantity of the specified part.
- Comments displays remarks associated with the required material.
- The status bar displays the damage assessment status (active/completed) and the estimated time to repair the reported damage. This is calculated from the information entered into the Damage Specifics table.

Toolbar Buttons

- The Reload toolbar button reloads the currently displayed damage assessment.
- The Save toolbar button saves the damage assessment information.
- The Complete toolbar button completes the damage assessment. When a damage assessment record is completed, its status changes to inactive and its symbol is removed from the Viewer. Completed damage assessments are not considered when estimated time to repair is calculated for the event.
- The toolbar Exit button closes the Damage Assessment window.
Managing Events with Web Trouble

Working with AMR Requests

This section describes how to work with AMR requests. It includes the following topics:

• Displaying the AMR Requests List
• Creating AMR Requests for Service Outages
• Creating AMR Requests for Device Outages
• Creating an AMR Request Without an Outage
• Completing AMR Requests
• Canceling AMR Requests
• Re-submitting AMR Requests

Displaying the AMR Requests List

To display the complete AMR Requests list, select AMR Requests List... from the Web Workspace Tools menu.

To display the AMR Requests for a particular event, select the event in the Work Agenda, then select Show AMR Requests... from the Actions menu.

The AMR Requests List displays the following fields and buttons:

• The Request # column is the system-generated index of the request.
• The [Device] column is the start device.
• The Feeder column is the device’s feeder.
• The Substation column is the device’s substation.
• The Request Date column is the date the ping was requested.
• The Who Requested column displays the login user name that initiated the request.
• The Event # column is the outage event (or 0 if N/A).
• The # Queried column is the number of meters pinged.
• The # Responded is the total number of responses received to date.
• The # Off column is the number of deenergized responses received.
• The Status column displays ACT=active, CMP=completed, CNL=canceled.
• The Complete Date column displays the date completed.
• The Who Completed column displays the login user name that completed the request.
• The Show Event button navigates back to the Active Trouble Events List page for the selected row’s event.
• The Resubmit button resubmits (re-pings) the AMR request.
• The Complete button completes the ping request.
• The Cancel button cancels the ping request and takes no further action.
• The Exit button closes the tool.
Creating AMR Requests

This section includes the following topics:

- Creating AMR Requests for Service Outages
- Creating AMR Requests for Device Outages
- Creating an AMR Request Without an Outage

Creating AMR Requests for Service Outages

To create an AMR request for an existing service outage, follow these steps:

1. Select an existing PSO event in the Work Agenda, then select AMR Confirm… from the Actions menu. The AMR Query Type dialog is displayed. 
   
   **Note:** You can also bring up this dialog by selecting AMR Confirm... from the Trouble Info window.

2. Select the AMR query type (either Simple Query or Complex Query), and click OK. A new AMR request is created for the meter affected by the selected event.
   
   **Note:** If you attempt to create an AMR request for a customer that is part of an active AMR request, the AMR Rejected Meters dialog is displayed. This dialog lists the customer information associated with the meter that was rejected. Click OK to continue.

Creating AMR Requests for Device Outages

To create an AMR request for an existing device outage, follow these steps:

1. Select an existing device outage in Work Agenda.

2. Select AMR Confirm... from the Actions menu in Work Agenda. The Trouble Info tool is displayed, showing information about customers affected by the selected event.

3. Select customers whose meters should be pinged.

4. Select AMR Confirm… from the Actions menu in Trouble Info. The AMR Query Type dialog is displayed.

5. Select the AMR query type and click OK. A new AMR request is created for the selected meters.
   
   **Note:** If you attempt to create an AMR request for a customer that is part of an active AMR request, the AMR Rejected Meters dialog is displayed. This dialog lists the customer information associated with the meter that was rejected. Click OK to continue.

Creating an AMR Request Without an Outage

To create an AMR request without an existing outage, follow these steps:

1. Double-click on a device in Viewer to bring up Control Tool.

2. Click AMR Customer List… in Control Tool. The Trouble Info tool is displayed, showing information about AMR-enabled customers for the selected event.

3. Select customers whose meters should be pinged.

4. Select AMR Confirm… from the Actions menu in Trouble Info. The AMR Query Type dialog is displayed.

5. Select the AMR query type and click OK. A new AMR request is created for the selected meters.
   
   **Note:** If you attempt to create an AMR request for a customer that is part of an active AMR request, the AMR Rejected Meters dialog is displayed. This dialog...
lists the customer information associated with the meter that was rejected. Click OK to continue.

### Completing AMR Requests

To complete an AMR request, select a row on the AMR Requests list and click the **Complete** button. The options presented to you depend on the status of the original event. See **Completing Requests** on page 2-28 for a description of each option.

### Canceling AMR Requests

To cancel AMR requests, select one or more rows on the AMR Request list and click the **Cancel** button. The canceled AMR requests disappear from the list of active AMR requests.

### Re-submitting AMR Requests

To resubmit active AMR requests, select one or more rows on the AMR Request list and click the **Resubmit** button. A confirmation window appears, asking whether you want to cancel the active request before submitting the new request. Click **Yes** to confirm.

### Updating the ERT for Selected Events

You can set the estimated restoration time for one or more events selected in Work Agenda.

*Note:* Updating the ERT from the Work Agenda is not allowed for some event types. For Notify Alarms, Planned Outages, and Switching jobs, the user cannot set or clear the ERT. For Non Outages, Critical Meets, Future Meets, Real and Probable Momentary Outages, and Fault Current Events, the user can clear the ERT, but cannot set it.

If the ERT update operation cannot be performed on one or more of the selected events, the **Ignored ERT Updates** dialog will be displayed when the other updates have completed. The **Ignored ERT Updates** dialog list the events where the ERT was not updated.

To set the ERT for selected events, follow these steps:

1. From the Work Agenda events list, select all the events for which you want to update the ERT.
2. Select **Update ERT(s)...** from the Actions menu. The Update ERT dialog opens.
3. Enter the new ERT using the calendar tool.
4. Click the **Set ERT** button. The Update ERT dialog closes, and the new ERT value is displayed for the selected events in the Work Agenda list.

### Clearing the ERT

To clear the ERT for events selected in Web Work Agenda, follow these steps:

1. Select one or more events in Web Work Agenda.
2. Select **Update ERT(s)...** from the Actions menu. The Update ERT dialog opens.
3. Click the **Clear ERT** button. The Update ERT dialog closes, and the ERT values for the selected events are cleared in the Work Agenda list.
Setting the System-Wide Estimated Restoration Time

Use this procedure to view and modify the system-wide default ERT value. The system-wide ERT is used for all events; it overrides any default ERTs defined at the control zone/device class level in the Configuration Assistant.

To set the system-wide default, follow these steps:

2. Enter a new value in the New System-Wide ERT field, using the calendar tool.
   
   **Note:** Only future dates are allowed.
3. Click the Set ERT button. The dialog closes and the specified ERT becomes the default for any new events for which no specific default is specified. All not completed events with an Est Src value of I or N in the Work Agenda will have their ERT values reset to the system-wide default ERT value.
   
   **Note:** This action causes a full re-examination of all events currently in the system; thus, it is advised to use it sparingly when there are a large number of events present.

Clearing the System-Wide Estimated Restoration Time

Use this procedure to clear the system-wide default ERT value so that all events will use the default values specified for their control zone and device class combination, as defined in the Configuration Assistant. (See Adding or Changing a Device/Zone-Based Default Restoration Time on page 4-27.)

**Note:** If you clear the system-wide default ERT and no default ERT has been defined that matches the control zone/device class of an event, the event will not be assigned a default ERT. The ERT will remain empty for the event unless you manually change it.

To clear the system-wide default, follow these steps:

2. Click the Clear ERT button. The dialog closes and the previously specified ERT is no longer used as the default for any new events. The ERT for an event will default to the value defined for its control zone and device class.
   
   **Note:** This action causes a full re-examination of all events currently in the system; thus, it is advised to use it sparingly when there are a large number of events present.

Using the Event Log

The Event Log displays a list of all actions taken for an event and displays the Operations Event Notes for the event. You cannot edit existing actions, but you can add a comment.

To display the Event Log for a particular event, select a row in the Work Agenda list and select Event Log... from the Actions menu. The Event Log opens, displaying all log entries for this event. The Operations Event Notes field is populated with the comments for this event.

The Event Log displays the following fields and buttons:

- The Event # field displays the Event # loaded in Event Log. This field is editable so that a user can load a different event by number.
- The Operations Event Notes field displays the existing Operations Event Notes for the event.
• The + button allows you to add a note to the event. Type the note text in the blank edit field, and then click this button.

  **Note:** The Event Log does not automatically refresh, so the new note will be displayed the next time the event is loaded.

• The table displays a list of log entries. For each entry, the following columns are displayed:
  • The **Date/Time** field displays the date/time at which the log entry occurred.
  • The **User** field displays the user that initiated the action.
  • The **Text** field displays a description of the log entry.

**Menu and Toolbar Options**

To display entries for a different event:

1. Use the **button or Actions>Clear** menu option to clear the entire tool.

2. Enter a new event in the Event # field.

3. Click the **button or select Actions>Load Action Steps** to repopulates the table with the action steps for the new event listed in the Event # field.

Use the **button or Actions>Show Device in Viewer** menu option to focus the Viewer window on the event.

Use the **button or Actions>Event Details** menu option to open the Event Details window for the event.

Use the **button or File>Print** menu option to print the current contents of the Event Log.

Use the **button or File>Exit** menu option to close the Event Log.
Managing Crews with Web Trouble

Oracle Utilities Network Management System – Web Trouble allows you to manage crews efficiently. This section describes the various windows and functions that relate to managing crews. It includes the following topics:

- Crew Actions
  - Assigning a Crew
  - Placing a Crew En Route Using the Crew Actions Window
  - Changing Crew Availability
  - Finding the Event a Crew is En Route To
  - Activating a Crew and Making a Crew Inactive
  - Setting a Crew’s Status to On Shift and Setting a Crew’s Status to Off Shift
  - Deleting a Crew

- Crew Makeup
  - Creating a New Crew
  - Removing Personnel from a Crew
  - Removing a Vehicle from a Crew
  - Editing a Crew

- Crew Info
  - Unassigning a Crew
  - Placing a Crew En Route to an Assigned Event
  - Suspending a Crew

- Active Job Info
  - Moving a Crew
  - Releasing a Crew from an Event
  - Updating Event Information
Crew Actions

Use the Crew Actions window to view and manage crews. The Crew Actions window opens by default when you login to Oracle Utilities Network Management System Web Workspace. It is displayed below the Web Work Agenda window. You can also display this window by selecting Crew... from the Web Workspace Tools menu.

The Crew Actions window displays a Menu and Toolbar and provides two views: Crew List View and Crew Icons View.

From the Crew Actions window, you can perform the following tasks:

- Assigning a Crew
- Placing a Crew En Route Using the Crew Actions Window
- Changing Crew Availability
- Finding the Event a Crew is En Route To
- Activating a Crew and Making a Crew Inactive
- Setting a Crew’s Status to On Shift and Setting a Crew’s Status to Off Shift
- Deleting a Crew

Menu and Toolbar

The Crew Actions window displays a toolbar and menu bar, as described in the following tables.

### File Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>New...</td>
<td>Opens the Crew Makeup window, which allows you to define a new crew.</td>
<td>![Plus Icon]</td>
</tr>
<tr>
<td>Edit...</td>
<td>Opens the Crew Makeup window, which allows you to edit the currently selected crew. This is enabled only if a non-mobile crew is selected.</td>
<td>![Pen Icon]</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the currently selected crew after prompting for confirmation. This is enabled only if an inactive non-mobile crew is selected.</td>
<td>![Trash Icon]</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Crew Actions window.</td>
<td>![Stop Icon]</td>
</tr>
</tbody>
</table>

### View Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icons</td>
<td>Switches to the Icons view if the List view is currently active.</td>
<td></td>
</tr>
<tr>
<td>List</td>
<td>Switches to List view if Icons view is currently active.</td>
<td></td>
</tr>
</tbody>
</table>
### Filter Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Submenu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Dialog...</td>
<td></td>
<td>Opens the Filter Dialog, which allows you to create a custom filter.</td>
</tr>
<tr>
<td>Parent Zones</td>
<td>Include</td>
<td>• Include: Display crews created for zones that are parents of the subscribed zones.</td>
</tr>
<tr>
<td></td>
<td>Exclude</td>
<td>• Exclude: Exclude crews created for zones that are parents of the subscribed zones.</td>
</tr>
<tr>
<td>All</td>
<td></td>
<td>Changes the filter to display all crews.</td>
</tr>
<tr>
<td>Eval</td>
<td></td>
<td>Changes the filter to display only crews of type Eval.</td>
</tr>
<tr>
<td>Inactive</td>
<td></td>
<td>Changes the filter to display only crews that are inactive.</td>
</tr>
<tr>
<td>Line</td>
<td></td>
<td>Changes the filter to display only crews of type Line.</td>
</tr>
<tr>
<td>On Shift</td>
<td></td>
<td>Changes the filter to display only crews that are on shift.</td>
</tr>
<tr>
<td>Off Shift</td>
<td></td>
<td>Changes the filter to display only crews that are active but off shift.</td>
</tr>
<tr>
<td>Service</td>
<td></td>
<td>Changes the filter to display only crews of type Service.</td>
</tr>
<tr>
<td>Tree Crew</td>
<td></td>
<td>Changes the filter to display only crews of type Tree Crew.</td>
</tr>
<tr>
<td>Trouble</td>
<td></td>
<td>Changes the filter to display only crews of type Trouble.</td>
</tr>
</tbody>
</table>
### Actions Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crew Info...</td>
<td>Opens the Crew Info dialog for the selected crew.</td>
<td>![Info Icon]</td>
</tr>
<tr>
<td>Switching...</td>
<td>Opens the switch plan to which the selected crew is associated. This is enabled only if a crew is selected and Web Switching Management is licensed for your system. If more than one plan is associated with the crew, a dialog prompts you to select one.</td>
<td></td>
</tr>
<tr>
<td>View…</td>
<td>Opens Viewer #1, focused on the device where the selected crew is en route or onsite, and selects event in the Work Agenda Event List to which the crew is en route or onsite. This is enabled only if an en route or onsite crew is selected.</td>
<td>![Viewer Icon]</td>
</tr>
<tr>
<td>Locate Crew...</td>
<td>Displays the selected crew in the Viewer window at the current coordinates of the crew. This option is available only for AVL crews.</td>
<td></td>
</tr>
<tr>
<td>Availability...</td>
<td>Opens the Update Crew Availability dialog for the selected crew.</td>
<td></td>
</tr>
<tr>
<td>Assign</td>
<td>Assigns the selected crew to the event currently selected in Work Agenda.</td>
<td></td>
</tr>
<tr>
<td>En Route</td>
<td>Puts the selected crew en route to the event currently selected in Work Agenda. This is enabled only if the selected crew is an on-shift, available, non-mobile crew that is not currently en route or onsite.</td>
<td></td>
</tr>
<tr>
<td>Active Job Info...</td>
<td>Opens the Active Job Info dialog for the selected crew. This is enabled only if an en route or onsite crew is selected.</td>
<td></td>
</tr>
<tr>
<td>Toggle Mobile On</td>
<td>Turns off override for a crew that is currently overridden by the Toggle Mobile Off action.</td>
<td></td>
</tr>
<tr>
<td>Toggle Mobile Off</td>
<td>Overrides the selected crew to act as a non-mobile crew. Enabled if an active off shift mobile crew is selected. Not available to view only users.</td>
<td></td>
</tr>
<tr>
<td>Activate</td>
<td>Activates the selected crew. This is enabled only if an inactive non-mobile crew is selected.</td>
<td></td>
</tr>
<tr>
<td>Deactivate</td>
<td>Deactivates the selected crew. This is enabled only if the selected crew is an off-shift, active non-mobile crew that has no assignments.</td>
<td></td>
</tr>
<tr>
<td>Set On Shift...</td>
<td>Opens a dialog that allows you to enter an on-shift time for the selected crew. This is enabled only if an off-shift active crew is selected.</td>
<td></td>
</tr>
<tr>
<td>Set Off Shift...</td>
<td>Opens a dialog that allows you to enter an off-shift time. This is enabled only if the selected crew is an on-shift crew that is not en route or onsite.</td>
<td></td>
</tr>
</tbody>
</table>
Crew List View

The Crew List view on the Crew Actions window displays a list of crews, in table format. The crews that appear in the list are based on the current filter settings. See Crew Status on page B-1 for a list of color codes used to indicate crew status.

The Crew List contains the following fields and buttons:

- The Control Zone column contains the name of the control zone the crew is assigned to.
- The Crew ID column contains a string that identifies the crew.
- The Crew Type column contains the type of crew (e.g., Eval, Service, Line, etc.).
- The Contact column contains the contact name for the crew.
- The Crew Size column contains the number of crew members.
- The Feeder column contains the feeder for the device where the crew is en route/onsite.
- The Device column contains the name of the device where the crew is en route/onsite.
- The Est Restore Time column contains the date and time when the event where the crew is en route/onsite is estimated to be restored.
- The # Asgn column contains the number of events assigned to the crew.
- The Crew Hrs Wkd column contains the length of time the crew has been active.
- The Mobile Flag column indicates whether this is a mobile crew.
- The Status field displays the crew's current status. Valid statuses are:
  - Inactive
  - Off Shift
  - On Shift

Crew Icons View

The Crew Actions window displays buttons that are color-coded to represent the status of each crew. See Crew Status on page B-1 for a list of color codes used to indicate crew status. In this view, use the Actions menu to perform actions on the selected crew icon.

Activating a Crew

You can set a crew to Inactive status to indicate that it is available for work. You can only activate a crew if its current status is Inactive.

To activate a crew, complete these steps:

1. In the Crew Actions window, select the inactive crew you want to activate.
2. Select Activate from the Actions menu. (In List view, you can also right-click the crew and then select Activate from the pop-up menu.) The status changes to Off Shift.

   **Note:** You cannot activate a crew if its Mobile Flag is Yes. You must choose the Toggle Mobile Off option on the Actions menu to change the mobile status before activating. The Mobile Flag columns displays No (Override), indicating that the crew's mobile status has been manually overridden.

3. You can now set the crew's status to On Shift. See Setting a Crew’s Status to On Shift on page 7-29.
Setting a Crew's Status to On Shift

Setting an active crew’s status to On Shift indicates that the crew has started working the shift and sets the time the crew sent on shift. You can only set a crew’s status to On Shift if its current status is Active.

To put a crew On Shift, follow these steps:
1. In the Crew Actions window, select the active crew you want to put On Shift.
2. Select Set On Shift... from the Actions menu. (In List view, you can also right-click the crew and then select Set On Shift... from the pop-up menu.) The Set Crew On Shift dialog opens.
3. To set the On Shift time to the current time, click OK.
   To specify a different time, click the button and then select the date/time the crew went on shift. Click OK to close the dialog. The On Shift Time field is populated with the selected date/time.
4. Click OK to set the shift time. The crew’s status changes to On Shift.

Setting a Crew's Status to Off Shift

Setting an active crew’s status to Off Shift indicates that the crew has stopped working the shift and sets the time at which the crew went off shift. You can only set a crew’s status to Off Shift if its current status is On Shift.

To put a crew Off Shift, follow these steps:
1. In the Crew Actions window, select the On Shift crew you want to put Off Shift.
2. Select Set Off Shift... from the Actions menu. (In List view, you can also right-click the crew and then select Set Off Shift... from the pop-up menu.) The Set Crew Off Shift dialog opens.
3. To set the Off Shift time to the current time, click OK.
   To specify a different time, click the button and then select the date/time the crew went off shift. Click OK to close the dialog. The Off Shift Time field is populated with the selected date/time.
4. Click OK to set the shift time. The crew’s status changes to On Shift.

Making a Crew Inactive

You can deactivate a crew to indicate that it is not available for work. You can only deactivate a crew if its current status is Active or Off Shift and it has no current assignments.

To deactivate a crew, complete these steps:
1. In the Crew Actions window, select the active or off shift crew you want to deactivate.
2. Select Deactivate from the Actions menu. (In List view, you can also right-click the crew and then select Deactivate from the pop-up menu.) The status changes to Inactive.
Deleting a Crew

To delete a crew, complete these steps:

- **Note:** You can only delete a crew if it is inactive. You cannot delete a mobile crew, even if the mobile flag has been overridden.

1. If the crew is active, you must first deactivate it (see Making a Crew Inactive). If a crew is on shift, you must first set the crew to off shift (see Setting a Crew's Status to Off Shift) and then deactivate it before you can delete it.

2. Select the crew in the Crew Actions window.

3. Select **Delete** from the Actions menu. (In List view, you can also right-click the crew and then select Delete from the pop-up menu.) A dialog prompts you to confirm the deletion.

4. Click **OK**. The crew is deleted from the system.

Assigning a Crew

You do not have to assign a crew to an event before placing it en route. Assigning merely lines up the event for the crew to work later. To assign a crew to an event, complete these steps:

1. In the Trouble Events list of the Work Agenda, locate the event you want to assign the crew to. Select the row of that event.

2. Select the crew you want to assign the event to in the Crew Actions window.

3. Select **Assign** from the Actions menu. (In List view, you can also right-click the crew and then select Assign from the pop-up menu.) The crew color changes to the Assigned color (the default is cyan), unless it is currently unavailable or enroute. The event information is automatically entered into the Crew Info window for the crew.

   - **Note:** You can assign multiple events to a single crew. You can also assign multiple crews to a single event.

Placing a Crew En Route Using the Crew Actions Window

To place a crew en route to an event, complete these steps:

- **Note:** You can only place a crew en route to an event if the crew is an on-shift, available, non-mobile crew that is not currently en route or onsite to an event.

1. In the Trouble Events list of the Work Agenda, locate the event you want to place the crew en route to. Select the row of that event.

2. Select the crew you want to place en route in the Crew Actions window.

3. Select **En Route** from the Actions menu. (In List view, you can also right-click the crew and then select En Route from the pop-up menu.) The icon for the crew turns green, and the event information is automatically entered into the Crew Info and Active Job Info windows for the crew.

   - **Note:** You can place multiple crews en route to a single event.
Changing Crew Availability

Making a crew available/unavailable is different from making it active/inactive. When a crew is inactive (e.g., finished working for the day), the crew does not appear in the Crew Actions window. When a crew is unavailable, (e.g., at lunch), it appears in the Crew Actions window (in yellow). You can assign an unavailable crew, but you cannot place it en route. See Activating a Crew and Making a Crew Inactive for more information on active/inactive crews.

To change a crew’s availability, complete these steps:

1. Select the crew you want to change in the Crew Actions window. You cannot change an en route/onsite crew.
2. Select Availability… from the Actions menu. (In List view, you can also right-click the crew and then select Availability… from the pop-up menu.) The Update Crew Availability dialog box opens.
3. Click on the Available button to make the crew available or the Unavailable to make it unavailable.
4. If you are making an available crew unavailable, click in the Description field and type a brief reason for the change (e.g., on break).
5. Click OK. The crew icon changes to yellow.

Note: You can assign events to both available and unavailable crews.

Finding the Event a Crew is En Route To

To find the event a crew is en route to, select the crew in the Crew Actions window and then select the View toolbar button or select View... from the Actions menu. The event row is highlighted in the Work Agenda Trouble Events list, and Viewer 1 focuses on the device associated with the en route event.

Note: The Work Agenda event row will only be highlighted if the Work Agenda window is open and the event is on the list you currently have displayed in the Work Agenda window. The Viewer will only focus on the device if you have the Viewer 1 window open.

Filtering the Crew Actions Window

To filter the crews that appear in the Crew Actions window, complete these steps:

1. Select Filter Dialog… from the Actions menu in the Crew Actions window. The Crew Filter dialog box appears.
2. If you want to exclude certain crew types, click on the types you do not want to view.
3. Do one of the following:
   - Click Apply to view the changes in the Crew Actions window without closing the Crew Filter dialog box, or
   - Click OK to close the dialog box and apply the filters you’ve selected.
Crew Makeup

The Crew Makeup window allows you to perform the following tasks:

- Creating a New Crew
- Removing Personnel from a Crew
- Removing a Vehicle from a Crew
- Editing a Crew

To open the Crew Makeup window, select New... or Edit... from the File menu in the Crew Actions window or click either the New... or Edit... button in the Crew Actions window.

The Crew Makeup window displays the following fields and buttons:

- The Crew ID field displays the alphanumeric ID that identifies the crew.
- The Mobile # field displays the mobile telephone or radio number.
- The Pager # field displays the pager number.
- The Contact field displays the Name of the contact person for the crew.
- The Crew Size field displays the Number of members of the crew. The crew size is initially set to zero.
- The Type drop-down allows you to select the type of crew (e.g., Line, Eval, Trouble).
- The Temp/Perm drop-down allows you to define the crew as either temporary or permanent. When a crew is set to temporary, you would normally delete it when it is deactivated.
- The Control Zone field displays the control zone that the crew is assigned to. When you click the Edit... button, a Control Zone dialog box opens letting you assign the crew to the selected control zone.
- The Personnel list displays the name and job title of each crew member. You can add crew members by clicking the Add... or Select Personnel... buttons. You can remove a crew member by selecting their row in the Personnel table and clicking the Remove button.
- The Vehicles/Equipment list displays the vehicles or equipment assigned to the crew. You can add vehicles or equipment by clicking the Add... or Select Personnel... buttons. You can remove a vehicle or piece of equipment by selecting the item and clicking the Remove button.

Buttons

- The Edit... button opens the Control Zones dialog box, allowing you to select the Control Zone the crew will be assigned to.
- The Add... (Personnel) button opens the Add Personnel dialog box, allowing you to enter a crew member's name and select their job type.
- The Select Personnel... button opens the Select Personnel dialog box, allowing you to select from a pre-defined list of personnel.
- The Remove... (Personnel) button removes the selected individual from the personnel list.
- The Add... (Vehicles/Equipment) button opens the Add Vehicle/Equipment dialog box, allowing you to assign vehicles to the crew.
- The Select Vehicles/Equipment... button opens the Select Vehicles/Equipment dialog box, allowing you to select from a pre-defined list of vehicles/equipment.
- The Remove... (Vehicles/Equipment) button removes the selected vehicle from the Vehicles/Equipment list.
- The OK button saves the crew changes and closes Crew Makeup.
• The Cancel button closes Crew Makeup without saving any changes.

Creating a New Crew
To create a new crew, complete these steps:

1. Open the Crew Makeup window either by selecting New... from the File menu in Crew Actions or by clicking the New... button in Crew Actions.
2. Enter the Crew ID, mobile and pager numbers, and contact.
3. Select the crew type and temporary or permanent from the drop-down lists.
4. Click the Edit... button to open the Control Zone dialog box. Select a control zone and click OK.
5. Click the Add... (Personnel) button to open the Add Personnel dialog box. Enter a crew member's name and select their job title, then click OK.
   Or,
   Click the Select Personnel... button to open the Select Personnel dialog box. Select one or more rows from the Select Personnel dialog (using the <Ctrl> and/or <Shift> keys), then click OK.
6. Repeat the previous step until all crew members are added.
7. Click on the Add... (Vehicles/Equipment) button to open the Add Vehicle/Equipment dialog box. Select the vehicle type, and then click OK.
   Or,
   Click the Select Vehicles/Equipment... button to open the Select Vehicles/Equipment dialog box. Select one or more rows from the Select Vehicles/Equipment dialog (using the <Ctrl> and/or <Shift> keys), then click OK.
8. Repeat the previous step until all vehicles are added.
9. Click OK on the Crew Makeup dialog to create the crew.

Removing Personnel from a Crew
To remove an individual from a crew you have open in Crew Makeup, select his or her name in the Personnel list and click Remove. The name disappears from the Personnel list.

Removing a Vehicle from a Crew
To remove a vehicle from a crew you have open in Crew Makeup, select the vehicle from the Vehicles/Equipment list and click Remove. The vehicle disappears from the Vehicles/Equipment list.

Editing a Crew
To edit a crew, complete these steps:

1. Open the Crew Makeup window either by selecting Edit... from the File menu or by clicking the Edit toolbar button in the Crew Actions window.
2. Make the changes to the crew.
3. Click OK on the Crew Makeup dialog to save the changes.
Crew Info

The Crew Info window displays detailed crew information not shown in Crew Actions window. It allows you to unassign a crew or access the Active Job Info window to place a crew en route to any of its assigned events.

Crew Info topics include:

• Using the Crew Info Window
• Unassigning a Crew
• Placing a Crew En Route to an Assigned Event

Using the Crew Info Window

To open the Crew Info window, do the following:

1. From the Crew Actions window List view, select the row of the crew you want to view.
   From the Crew Actions window Icons view, select the icon of the crew you want to view.
2. Click on the Crew Info… button or select Crew Info... from the Actions menu.

The Crew Info window contains the following fields and buttons:

• The Crew ID field displays the string that identifies the crew.
• The Mobile # field displays the crew’s mobile phone number.
• The Pager # field displays the crew’s pager number.
• The Contact field displays the name of the crew’s contact person.
• The Type field displays the type of crew (e.g., Eval, Service, Line, etc.).
• The Temp/Perm field displays whether the crew is a temporary crew or a permanent crew.
• The Control Zone field displays the control zone the crew is assigned to.
• The Status field displays the crew’s current status. Valid statuses are:
  • Inactive
  • Off Shift
  • On Shift
• The Mobile Flag field indicates whether this is a mobile crew.
• The Out of Range field indicates whether the crew is currently out of range (no connectivity).

Personnel Section

• The Name column displays the names of all the crew members.
• The Job Title column displays the job titles of all crew members.
• The Empl ID column displays the employee ID of all crew members.

Vehicles/Equipment Section

• The Type field displays the vehicle types assigned to the crew.
• The Vehicle ID column displays the ID of all vehicles assigned to the crew.
Active Job Section
- The Event # field displays the event number of the event where the crew is currently en route/onsite, if any.
- The Feeder number displays the name of the feeder for the device where the crew is currently en route/onsite, if any.
- The Est Restore Time field displays the date and time when the event to which the crew is en route/onsite is estimated to be restored.
- The Device field displays the name of the device related to the event.

Current Assignment Section
- The Event # column contains the event number of the event the crew is assigned to.
- The Assign Time column contains the time the crew was assigned to the event.
- The Feeder column contains the name of the feeder involved in the event.
- The Device column contains the name of the device related to the event.
- The # Calls column contains the number of customer calls received for the event.
- The # Out column contains the estimated number of customers experiencing an outage for the event.
- The Suspended column indicates whether the assignment was suspended.

Buttons
- The Drop Assignment button removes the selected event from the list of crew assignments.
- The Place En Route button opens the Active Job Info window for you to place the crew en route to an event on the assigned list. You must select an event on the assigned list before you click this button.
- The Help... button displays help for the current window.
- The Cancel button closes the Crew Info window.

Unassigning a Crew
To drop an assignment from a crew, complete these steps:

1. In the Crew Information window, select the event from the Current Assignments table. The buttons at the bottom of the window become enabled.
2. Click the Drop Assignment button. A message box opens asking if you are sure you want to remove the assignment.
3. Click OK.
   - The crew is unassigned from the event.
   - The event is removed from the list of crew assignments.
   - The crew button/crew row changes to white (if the crew is not en route/onsite, unavailable, or assigned to another event).
Placing a Crew En Route to an Assigned Event

If a crew has been assigned to an event, you can place the crew en route to the event using the Crew Info window.

To place the crew en route to the assigned event, complete these steps:

1. In the Crew Information window, select the event from the Current Assignments table. The buttons at the bottom of the window become enabled.
2. Click the **Place En Route** button. The Active Job Info window opens and the crew is placed en route to the event.

Active Job Info

The Active Job Info window provides basic crew information, as well as information for the event where they are en route to/onsite at. It allows you to move and release crews. You can also use the Active Job Info window to record that a crew has arrived onsite, enter an estimated restoration time, and add an operations event note.

This section includes the following topics:

- Using the Active Job Info Window
- Updating Event Information
- Moving a Crew
- Releasing a Crew from an Event
- Suspending a Crew

Using the Active Job Info Window

You can open the Active Job Info window either from the Crew Actions window or while placing a crew en route from the Crew Info window.

To open the Active Job Info window from Crew Actions, complete these steps:

1. In the Crew Actions window, select the en route/onsite crew you want to view active job information about.
2. Select **Active Job Info…** from the Actions menu. (From the List view, you can also right-click the crew and select **Active Job Info...** from the pop-up menu.) The Active Job Info window opens.

To open the Active Job Info window from Crew Info, complete these steps:

1. In the Crew Info window, select the row of the assigned event you want to place the crew en route to.
2. Click on the **Place En Route** button. The Active Job Info window opens.

The Active Job Info window displays the following fields and buttons:

- The **Crew ID** field displays the string that identifies the crew.
- The **Contact** field displays the name of the crew’s contact person.
- The **Event #** field displays the event number of the event where the crew is en route/onsite.
- The **Feeder** number displays the name of the feeder for the device where the crew is en route/onsite.
- The **Device** field displays the name of the device related to the event.
- The **Not Onsite** drop-down menu is a toggle for you to designate whether the crew has arrived onsite yet or not. The field to the right of the drop-down is editable and populates
with the current time when you toggle the crew to **Onsite**. You may use the calendar button to the right of the date/time field to specify a different time.

- The **Suspend Crew** checkbox indicates whether the crew is suspended. To suspend this crew, click the checkbox. The field to the right of the checkbox is editable and populates with the current time when you check this box. You may use the calendar button to specify a different time.

- The **Est Time to Restore (HH:MM)** field allows you to enter the estimated amount of time (in hours and minutes) for the event to be restored. If you enter a value here (to the left of the Update Time button) and then click the **Update Time** button, the system updates the Est Time to Restore (displayed to the right of the button) based on the value you entered. You can also enter the Est Time to Restore field directly if you prefer.

- The **Operations Event Note** field allows you to enter notes about the event.

**Buttons**

- The **OK** button saves the changes you have made and closes the Active Job Info window.

- The **Move Crew…** button opens the Choose Work location dialog box where you enter the location you want to move the crew to by selecting a device in the Viewer.

- The **Release Crew** button releases the crew from the event and closes the Active Job Info window.

- The **Cancel** button closes the Active Job Info window without saving any changes to the estimated restore time or Operations Event.

  **Note:** If you moved the crew, the change is still saved.

### Updating Event Information

To update event information, complete these steps:

1. Open the Active Job Info window by selecting an en route/onsite crew in Crew Actions and then selecting **Active Job Info…** from the Actions menu.

2. To update the Estimated Restore Date or time, enter the Estimated Time to Restore and click the **Update Time** button. The Est Restore Date and time will change accordingly. You can also directly edit the estimated restore date and time field.

3. You can add event notes in the Operations Event Notes field.

4. Click **OK**. The Active Job Info window closes and your changes are saved.

### Moving a Crew

Moving a crew does not change the event the crew is en route to/onsite at; rather, it moves the crew to another device location and keeps it associated with the same event. By default, Oracle Utilities Network Management System locates a crew at the predicted or confirmed clearing device so that graphically the crew appears to be at the same location as the outage symbol in the Viewer. In some cases, the crew may actually have to work at a location different from the clearing device. It is not required or necessary to move the crew, but moving the crew to the actual device location is helpful in keeping more accurate track of what is going on in the field.

To move a crew, complete these steps:

1. Open the Active Job Info window for the crew you want to move by selecting the crew in the Crew Actions window and then selecting **Active Job Info…** from the Actions menu.

2. Click the **Move Crew…** button. The Choose Work location dialog box opens.

3. Select the new device location in the Viewer window, or select an event in from the Trouble Events list in the Work Agenda that has the same device as the one where the crew is now working.
4. Click **OK**. The crew symbol moves on the Viewer map, and the crew’s Device updates in the Active Job Info, Crew Info, and Crew Actions windows. The crew remains en route to/onsite at that same event.

**Releasing a Crew from an Event**

You may release crews from an en route/onsite event using either the Work Agenda or the Crew Actions Active Job Info window.

**Releasing a Crew from the Active Job Info**

1. Open the Active Job Info window for the crew you want to release by selecting the crew in the Crew Actions window and then selecting **Active Job Info…** from the Actions menu.

2. Click the **Release Crew** button. The following occurs:
   - The crew is released from the event.
   - The crew's active job information is removed from the Crew Info window.
   - The crew button/row changes to white (if the crew is not assigned to another event).
   - The Active Job Info window closes.

**Releasing Crews from an Event Selected in the Work Agenda**

1. Select a row in the Work Agenda with en route or onsite crews.

2. Select **Release Crews**... from the Actions menu. The **Release Crew(s)** dialog box opens listing the crew(s) assigned to the event. One or more crews may be selected:

3. Click a crew name to select one crew.
   - Click, hold, and drag to select multiple adjacent crews.
   - Control-click to select multiple non-adjacent crews.

4. With the crew(s) selected, click **Release** to release the crews from the event.

The **Release Crew(s)** dialog box will close, the crew will no longer be associated with the event, and the crew symbology will disappear from the Viewer.
Suspending a Crew

You can suspend a crew that is currently en route or on site to an event. Suspending the crew indicates that the crew is not able to complete the work at this time and is expected to resume work on the assignment at a later time.

To suspend a crew from an en route/onsite event, complete these steps:

1. Open the Active Job Info window for the crew you want to release by selecting the crew in the Crew Actions window and then selecting Active Job Info… from the Actions menu.
2. Click the Suspend checkbox. The suspend date and time defaults to the current date and time. To specify a different date and time, click the calendar icon and then select the date and time the crew was suspended.

The following occurs:

- The Active Job Info window closes.
- The crew button in the Icons view and the crew row in the List view change to the Suspended color (orange, by default).
- The Current Assignments table in the Crew Info window displays Yes in the Suspended column for this assignment.

Using Drag and Drop

Oracle Utilities Network Management System Web Workspace supports drag and drop between Crew Actions and the Viewer, as well as between the Viewers or within the Viewer itself.

Placing a Crew En Route

You can place a crew en route to a device in the Viewer either by dragging a crew icon from the Crew Actions window to the affected device in the Viewer, or by dragging a crew symbol on another device already in a Viewer to the affected device.

Note: You can cancel the in-progress dispatch or move of a crew by pressing the <Esc> key on your keyboard, or simply dragging the crew outside the Viewer and then releasing the mouse button.

Placing a Crew En Route from Crew Actions Window

To place a crew en route from the Crew Actions window using drag and drop, complete these steps:

1. Focus the Viewer on the device that has the event you wish to place the crew en route to.
2. In the Crew Actions window, click on an undispatched, available crew and drag your cursor into the Viewer window, positioning it over the device associated with the event you wish to place the crew en route to.
3. When you see the desired device highlighted in the Viewer, release the mouse button.

- If multiple events are on the device, a dialog prompts you to specify which event the crew should be placed en route to. Select the appropriate event.
- The crew symbol appears at the device. The Crew Actions and Work Agenda windows update to indicate that the crew is now en route to the event.

Placing a Crew En Route from the Viewer

To place a crew en route from the Viewer using drag and drop, complete these steps:

1. Focus the Viewer such that you can see both the symbol of the crew you wish to re-dispatch and the event you wish to re-dispatch the crew to. Alternatively, you can open two Viewers
and focus one Viewer on the crew's current location, and the other Viewer on the new location.

2. In the Viewer window, click and drag the crew symbol to the device that has the event you wish to place the crew en route to.

3. When you see the device highlighted in the Viewer, release the mouse button.
   - If multiple events are on the device, a dialog prompts you to specify which event the crew should be placed en route to. Select the appropriate event.
   - The crew symbol appears at the device. The crew is released from its previous event and placed en route to the new event. The Crew Actions and Work Agenda windows update to indicate that the crew is now en route to the new event and no crew is en route to the old event.

**Moving a Crew with Drag and Drop**

Moving a crew does not change the event the crew is en route to, rather, it moves the crew to another device location and keeps it associated with the same event. By default, Oracle Utilities Network Management System locates a crew at the predicted or confirmed clearing device so that graphically the crew appears to be at the same location as the outage symbol in the Viewer. In some cases, the crew may actually have to work at a location different from the clearing device. You are not required to move the crew to the actual device location, but moving the crew can help you keep more accurate track of what is going on in the field.

**Moving a Crew from the Crew Actions Window**

To move a crew from the Crew Actions window using drag and drop, complete these steps:

1. Focus the Viewer on the device you wish to relocate the crew to.
2. In the Crew Actions window, click the en route crew and drag your cursor into the Viewer window, positioning it over the device that has the event you wish to relocate the crew to.
3. When you see the relocation device highlighted in the Viewer, release the mouse button. A confirmation dialog appears.
4. Click **OK** if you wish to complete the move or **Cancel** if you wish to cancel the move.

**Moving a Crew from the Viewer**

To move a crew in the Viewer using drag and drop, complete these steps:

1. Focus the Viewer such that you can see both the symbol of the crew you wish to relocate and the device you wish to relocate the crew to. Alternatively, you can open two Viewers and focus one Viewer on the crew's current location, and the other Viewer on the new location.
2. In the Viewer window, click and drag the crew symbol to device that you wish to relocate the crew to.
3. When you see the relocation device highlighted in the Viewer, release the mouse button. A confirmation dialog appears.
4. Click **OK** on the dialog if you wish to complete the move or **Cancel** if you wish to cancel the move.
Managing Calls with Web Trouble

Oracle Utilities Network Management System – Web Trouble includes windows that help you manage trouble calls. This section describes those windows and how to perform basic call management functions. It includes the following topics:

- Changing Rule Sets
- Using the Trouble Info Window
- Viewing Call Info
- Ungrouping Calls
- Moving Customers to a Different Device
- Unassociating/Reassociating a Call from/to a Device
- Editing Clues
- Creating AMR Requests for Device Outages

Changing Rule Sets

Rule sets are a collection of analysis rules that Oracle Utilities Network Management System Trouble Management uses to determine how and when certain devices will be predicted out and how fast a prediction moves upstream. For example, a rule set might cause fuses to be predicted out if three or more service outages are predicted on downstream transformers. Meanwhile, circuit breakers might require five downstream device outages to cause an upstream prediction to them.

You can change the rule set for control zone(s) over which you have authority over using the Authority window.

To change the rule set for a control zone, complete these steps:

1. Select Authority from the Tools menu in the Work Agenda. The Authority window opens.
2. Select the row of the control zone you want to change.
3. Click the Change Rule Set… button. A dialog box opens.
4. In the Rule Sets Available list, select the rule set you want to change to.
5. Click the OK button. The rule set for that control zone is updated. Oracle Utilities Network Management System Trouble Management will begin grouping and prioritizing new trouble calls in that control zone based on the new rule set.

Note: You can only change the rule set for one row at a time.
Using the Trouble Info Window

Oracle Utilities Network Management System Web Trouble displays customer information about trouble events using the Trouble Info window. The Trouble Info window has two main views. The view that opens initially depends on where you open the window from.

The table below describes the various Trouble Info views.

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Callers View</td>
<td>Lists all calls associated with an event.</td>
</tr>
<tr>
<td>Customers View</td>
<td>Lists all the customers:</td>
</tr>
<tr>
<td></td>
<td>• located on/downstream from a given device, when accessed via the Control Tool</td>
</tr>
<tr>
<td></td>
<td>• affected by a given event, when accessed via the Work Agenda</td>
</tr>
<tr>
<td></td>
<td>Trouble Event lists</td>
</tr>
<tr>
<td>Supply Points View</td>
<td>Lists all the supply points associated with the event, or downstream from the selected device.</td>
</tr>
<tr>
<td>AMR Customers View</td>
<td>Depending on where it’s accessed from, the AMR Customers view lists all the AMR-enabled meters located on/downstream from a given device or affected by a given event.</td>
</tr>
</tbody>
</table>

Trouble Info Menu and Toolbar

The following table describes the menu options and toolbar buttons on the Trouble Info window.

File Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Callers</td>
<td>Changes the Trouble Info window to the Callers View.</td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td>Changes the Trouble Info window to the Customers View.</td>
<td></td>
</tr>
<tr>
<td>Supply Points</td>
<td>Changes the Trouble Info window to the Supply Points View.</td>
<td></td>
</tr>
<tr>
<td>AMR Customers</td>
<td>Changes the Trouble Info window to the AMR Customers View. If AMR Customers is the currently selected view, the view is refreshed.</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Opens the Print Preview dialog, allowing you to print the current contents of the current view.</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Trouble Info window.</td>
<td></td>
</tr>
</tbody>
</table>
### Actions Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Info...</td>
<td>Opens the <em>Call Info Window</em> for the selected call.</td>
<td><img src="image" alt="Info" /></td>
</tr>
<tr>
<td>Ungroup</td>
<td>Opens the Ungroup dialog box, allowing you to ungroup the selected calls from the event.</td>
<td></td>
</tr>
<tr>
<td>Unassociate</td>
<td>Opens the Unassociate dialog box, allowing you to unassociate selected calls from their current devices and (optionally) associate them with a new device. See <a href="#">Unassociating a Call from a Device</a> for more information.</td>
<td></td>
</tr>
<tr>
<td>Move Customers...</td>
<td>Opens the Move Customers dialog box, allowing you to move selected customers to a new device. See <a href="#">Moving Customers to a Different Device</a> for more information.</td>
<td></td>
</tr>
<tr>
<td>Edit Clues...</td>
<td>Opens the Edit Clues dialog box for the selected call. See <a href="#">Editing Clues</a> for details.</td>
<td><img src="image" alt="Clues" /></td>
</tr>
<tr>
<td>AMR Confirm...</td>
<td>Opens the AMR Query Type dialog, allowing you to request meter pings from AMR system for the selected customers, if applicable. See <a href="#">Creating AMR Requests</a> for details.</td>
<td><img src="image" alt="AMR" /></td>
</tr>
</tbody>
</table>

### Help Menu

The Help menu displays the standard Help and About options.

### Callers View

The Trouble Info Callers view (Call List) lists all calls associated with an event. Open the Callers view by selecting an event in the Trouble Events List (in the Work Agenda window) and clicking the Info… button.

You can perform the following task from the Callers View:

- Ungrouping Calls
- Moving Customers to a Different Device
- Editing Clues
- Viewing Call Info
- Unassociating a Call from a Device
- Viewing AMR Customers for a Device

The Callers View displays the following fields:

- The Event # field displays the number assigned to the event by the system.
- The list title displays how many calls the event has.
- The Feeder field displays the feeder on which the affected device resides.
- The Event Device field displays the name of the device associated with the event.
• The **Device Type** field displays the type of device associated with the event.
• The **Customer Comment** field displays any customer comments that were entered by the call taker for the selected call.
• The **Clues** column displays the trouble code clues received for the call.
• The **Device** column displays the name of the customer's service device.
• The **Name** column displays the customer's name.
• The **Telephone** column displays the customer's telephone number.
• The **Date** column displays the date of the customer's call.
• The **Time** column displays the time of the customer’s call.
• The **Crit** column displays the customer type value of the customer.
• The **Cmt** column displays “Y” if the call contains customer comments and “N” if it does not.
• The **Address** column displays the customer's address.
• The **Account #** field displays the customer's account number.

### Ungrouping Calls

You can ungroup calls that were automatically grouped by the system as a result of trouble analysis rules. For example, you would ungroup a call from an event that is not actually related to the event, but rather should be its own non-groupable event. To ungroup calls, complete these steps:

1. Select the event row in the Trouble Events list (in the Work Agenda window) you want to ungroup and click the **Trouble Info...** button. The Trouble Info window opens to the Callers view.
2. Select the row(s) in the Calls table that you want to ungroup.
3. Select **Ungroup** from the Actions menu. The Ungroup dialog box opens with the device related to the event populated in the Device field.
4. Click **OK**.

   • In the Work Agenda, the calls are ungrouped and new event row(s) appear in the Trouble Events list with the appropriate device association.
   • In the Work Agenda, the number of calls associated with the original event is updated to not include the ungrouped call(s).

   **Note:** Events that are manually ungrouped will not be automatically grouped again by the system. However, you can manually group them again.

### Moving Customers to a Different Device

You can move customers to a different device if you discover they are associated with an incorrect device. To move customers to a different device, complete these steps:

1. Select an event in the Work Agenda’s Trouble Events list that has at least one call.
2. Click the **Trouble Info…** button. The Trouble Info window opens to the Callers view.
3. Switch to the **Customers View** by clicking the **Customers** button ( ).
4. Select one or more customers to move to a different device.
   • To select multiple adjacent customers, click the first customer row and then SHIFT-click the last customer row.
   • To select multiple non-adjacent customers, CTRL-click each customer row individually.
5. Select **Move Customers…** from the Actions menu. The Move Customers dialog appears.
6. Select a device in the Viewer to move the customers to. The New Device field on the Move Customers dialog is populated.

7. Click **OK**. The Move Customers dialog closes.

   **Note:** If the selected customers were previously moved to a new device, a confirmation dialog (i.e., **Overwrite Moved Customers**) is displayed. Do one of the following:
   - Click **Yes** to continue and overwrite the existing customer move record.
   - Click **Cancel** to cancel your selection and return to the Move Customers dialog to select a different device.
   - Click **No** to abort the move completely.

8. The event is then re-analyzed using the new device information. If it does not repredict into the same event, the # Calls and # Customers for the original event are adjusted. Either the call is grouped into another existing event or a new event is created.

   **Notes:**
   - Customers may be moved from, but not to, decommissioned devices.
   - Moving customers to a new device is a temporary change since NMS does not directly modify the customer data model information. However, NMS will track the change and successive calls for that customer will be associated with the new device. Your technical department must make permanent changes to the customer information.

**Editing Clues**

You can edit the clues associated with a call, which will cause the call’s trouble code to be changed. You can also enter comments that will be appended to the existing call comments.

To edit clues for a call, complete these steps:

1. Select an event in the Trouble Events list (in the Work Agenda window) with at least one call.
2. Select the **Info…** button. The Trouble Info window opens to the Callers view.
3. Select a row in the Calls table.
4. Click the **Edit Clues** toolbar button or select **Edit Clues...** from the Action menu. The Edit Clues dialog opens.
5. Use the drop-down boxes to select different clues.
6. Enter remarks in the Comments box, if desired.

   **Note:** The Customer Remarks section is view-only.

7. Click **OK**. The system performs a reprediction to see if the event can now be grouped to other events or be grouped to by other events, based on the updated clues. The system also recalculates the dispatch priority and target response time for any event associated with this call.
Unassociating a Call from a Device
You can move a customer to a different device if you discover the customer is associated with an incorrect device. To move a customer to a different device, complete these steps:

1. Select an event in the Trouble Events list (in the Work Agenda window) with at least one call.
2. Select the Info… button. The Trouble Info window opens to the Callers view.
3. Select a row in the Calls table and select Unassociate from the Actions menu.

Note: you may also unassociate multiple calls by selecting multiple rows in the Calls table and selecting Unassociate from the Actions menu.

Customers View
Depending on where it’s accessed from, the Trouble Info Customers view lists all of the customers located on/downstream from a given device, or all of the customers affected by a given event. Open this view by clicking on the Customers button in the Callers view.

The Customers View displays the following fields:

• The Event # field displays the number assigned to the event by the system. This field is not displayed if the Customers View is accessed from the Customer List… button of the Control Tool.

• The list title displays either how many customers are located on/downstream from a given device or affected by a given event, depending on where the view is accessed from.

• The Feeder field displays the feeder on which the associated device resides. This field is not displayed if the Customers View is accessed from the Customer List… button of the Control Tool.

• The Event Device field displays the name of the associated device. This field is not displayed if the Customers View is accessed from the Customer List… button of the Control Tool.

• The Device Type field displays the type of the associated device. This field is not displayed if the Customers View is accessed from the Customer List… button of the Control Tool.

• The Device column displays the name of the customer’s service device.

• The Name column displays the customer’s name.

• The Telephone column displays the customer’s telephone number.

• The Crit column displays the customer type value of the customer.

• The Address column displays the customer’s address.

• The Account # column displays the customer’s account number.

Supply Points View
Depending on where it’s accessed from, the Trouble Info Supply Points view lists all of the supply Points located downstream from a given device, or all of the supply points associated with a given event. Open this view by clicking on the Supply Points toolbar button or selecting Supply Points from the File Menu in the Trouble Info Callers or Customers view.

The Supply Points View displays the following fields:

• Event Information

  • The Event # field displays the number assigned to the event by the system.

  • The Feeder field displays the feeder on which the affected device resides.

  • The Event Device field displays the name of the device associated with the event.

  • The Device Type field displays the type of device associated with the event.
• **Supply Point Summary** displays totals for all supply points. (See below for descriptions of the columns in this section.)

• The table below the Supply Point Summary lists the following information for each supply point.
  - The **Device** column displays the name of the customer's service device.
  - The **# Customers** column displays the sum of all customers attached to the supply point.
  - The **# EMR** column displays the sum of all EMR customers attached to the supply point.
  - The **# MED** column displays the sum of all MED customers attached to the supply point.
  - The **# KEY** column displays the sum of all KEY customers attached to the supply point.
  - The **# Crit Tot** column displays the sum of all critical customers attached to the supply point.
  - The **Control Zone** column displays the supply point's control zone name.
  - The **Grp** column displays the pending action for the row:
    - TBG – To Be Grouped
    - TBU – To Be Ungrouped
    - FAIL – Action failed

Use the **View** button to view a selected device in the Viewer.

Click the **Remove** button to remove a device from the list.

For information about the **Update Event** button, see [Graphical Grouping (Supply Points Mode)](page-7-13) on page 7-13 for more information.

**AMR Customers View**

Depending upon where it’s accessed from, the Trouble Info - AMR Customers view lists all the AMR-enabled meters located on/downstream from a given device or affected by a given event.

Open this view by clicking on the **AMR Customers** toolbar button or selecting **AMR Customers** from the File Menu in the Trouble Info Callers or Customers view.

**Event Information**

Event Information populates the top portion of the AMR Customer View.

- The **Event Information** field displays the number assigned to the event by the system.
- The list title displays how many AMR Customers are located on/downstream from a given device, affected by a given event, or affected on a given device.
- The **Updated** field displays the date and time at which the Customers view was last populated, as this list is not dynamically updated.
- The **Feeder** field displays the feeder on which the associated device resides.
- The **Event Device** field displays the name of the associated device.
- The **Device Type** field displays the type of the associated device.

**Customer Table**

The Customer table portion of the AMR Customers View displays information for the individual customers.

- The **Device** column displays the name of the customer's service device.
• The **Phases** column displays the phases of the customer's service device.
• The **Name** column displays the customer's name.
• The **Telephone** column displays the customer's telephone number.
• The **Crit** column displays the customer type value of the customer.
• The **Address** column displays the customer's address.
• The **Account #** column displays the customer's account number.
• The **Meter #** column displays the customer's meter number.
• The **Request #** column displays the index of the last AMR ping request.
• The **Request Date** column displays the date of the last AMR ping request.
• The **Requested By** column displays the login name of the user who made the last AMR ping request.
• The **Completed By** column displays the login name of the user who completed the last AMR ping request.
• The **Received Date** column displays the date of the last AMR reading.
• The **Probability** column displays the probability percentage from the last AMR reading.
• The **Status** column displays the ON/OFF response from the last AMR reading.

**Ping Response Request and Response Behavior**

The **AMR Customer** table displays the most recent ping result when the result came after a ping request or a response. In the interval between the ping request and response, the table displays the ping request number and the status is empty. If a status is received after a ping request, or without a ping request, the table displays the status without a ping request number. If the ping was received after the latest unrequested status, the ping request number and the ping status result are displayed.

**Related Information**

See [Working with AMR Requests](#) on page 7-19 for more information.

**Viewing AMR Customers for a Device**

To view AMR customers for a particular device:

1. Select a device in Viewer and open the device in the Control Tool.
2. Click the **AMR Customers…** button in the Control Tool. Trouble Info opens, and the AMR Customers table is populated with the customer information for AMR-enabled customers on the selected device.

**Viewing Call Info**

Detailed information about a logged call is displayed in the Call Info window. An event (represented by a single row in the Trouble Events list of the Work Agenda) can have multiple calls if calls have been grouped to one event. The Call Info window may be accessed from the Trouble Info window. You cannot edit the fields in the Call Info window; they are for display only.

To open the Call Info window from the Trouble Info Callers View window, select the row of the call you want to display and either click on the **Call Info...** button or select **Call Info...** from the Actions menu.
Call Info Window

The Call Info window displays the following fields and buttons:

• **Account #** displays the customer's account number.
• **Event Status** displays the current status of the event that this call is a part of.
• **Telephone** displays the customer's phone number.
• **Event #** displays the number assigned to the event by the system.
• **Name** displays the customer's name.
• **Clues** displays the short description representation of the Request drop-down menu selections that were entered when the call was logged.
• **Address** displays the customer’s address.
• **Reported Start Date** displays the date and time the problem began for the customer.
• **City** displays the customer's city, state and zip code.
• **Call Taker ID** displays the user name of the person who entered the call.
• **Customer Type** displays the customer type value for the customer.
• **Crew ID** displays the name of the crew that has been placed en route to/is onsite at the event, if any.
• **Customer Device** displays the name of the customer's service device.
• **Callback Date** displays the date and time by which the customer has requested a follow up call, if specified.
• **Zone(s)** displays the control zone(s) the customer is located in.
• **Customer Comment** displays any customer comments that were entered at the time the call was logged.

Buttons

• The **Print** button opens the Print Preview dialog, which allows you to print the currently displayed customer call information.
• The **Exit** button exits the Call Info window.

Menus

The following table describes the Call Info menus.

• **File Menu**
  • **Print** – Opens up the Print Preview dialog, which allows you to print out the contents of the currently displayed customer call information
  • **Exit** – Closes the Call Info window
• **Help Menu**
  • The Help menu displays the standard Help and About options.
Oracle Utilities Network Management System - Web Call Entry is used to enter and access customer call and event information. The application streamlines data entry and allows access to customer call, event, and dispatch information by personnel in various operations settings. Web Call Entry shares a database with other Oracle Utilities Network Management System applications. This allows you to view certain data that operations personnel and crew supervisors have entered into the system. The event history and call history information for a customer is often helpful when you are handling a new call from a customer reporting a service outage.

This chapter includes the following topics:

- Logging in to Web Call Entry
- Using the Web Call Entry Window
- Searching for a Customer
- Viewing the Call History
- Viewing the Event History
- Entering a Customer Call
- Entering a Fuzzy Call
- Cancelling a Customer Call
- Viewing the Outages Summary

Logging in to Web Call Entry

Web Call Entry is accessed using a URL (web address) or as a local application, depending on your site's policy. Your system administrator determines the web address, if applicable. If accessing Web Call Entry from a browser, complete these steps:

To log in to Web Workspace, complete these steps:

1. Depending on how your system was installed, do one of the following:
   - Click the Web Call Entry icon found under the appropriate program group in your Windows Start Menu.
   - Double click the Web Call Entry icon on your desktop.
   - Open a web browser and type the Web Call Entry URL in the browser's Address field.

   The Web Call Entry Login window displays.

2. Enter your user name.
3. Enter your password.
4. Click the **Validate** button. The bottom portion of the Web Call Entry Login window sensitizes.

5. Select the appropriate User Type from the drop-down menu.

6. Click the **Login** button. The Web Call Entry main window appears.

7. If this is the first time running an Oracle Utilities Network Management System Windows-based product on your PC, you may be prompted to do a one-time download of a Java plugin. If so, select **Yes** (or Accept or Agree) on all subsequent dialogs until Web Call Entry opens.

   **Note:** You or your system administrator can add Web Call Entry to your Start menu and/or create a shortcut icon on your desktop for quick access to Web Call Entry. When you start up Web Call Entry for the first time, it will (depending on installation method) ask if you want to install a shortcut in your Start menu and on your desktop.

---

**Using the Web Call Entry Window**

The Web Call Entry window contains sections that display specific types of information. These sections include the menu bar, toolbar, header, customer information, request information, and event- and crew-related information.

The following topics describe how to use this window:

- **Menu and Toolbar**
- **Field Descriptions**

**Related Topics:**

- **Searching for a Customer**
- **Viewing the Call History**
- **Viewing the Event History**
- **Entering a Customer Call**
- **Entering a Fuzzy Call**
- **Cancelling a Customer Call**
- **Viewing the Outages Summary**

---

**Menu and Toolbar**

The Web Call Entry menu and toolbar provide access to commonly used functions. Most of the functions in the Actions menu are also available on the toolbar.

**File Menu**

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outages Summary...</td>
<td>Opens the Outages Summary window.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the Web Call Entry window.</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>
### Actions Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Search</td>
<td>Searches for customers based on the search criteria entered into the Searchable Information section. The system displays up to the first 100 customers located in the database that match the criteria.</td>
<td>![icon]</td>
</tr>
<tr>
<td>Intersection Search</td>
<td>Searches for a street intersection based on one or two street names entered into the Intersection Search section. The order of the street names does not matter for matching purposes.</td>
<td>![icon]</td>
</tr>
<tr>
<td>Call Search</td>
<td>Searches through previous calls based on the search criteria entered into the Searchable Information section. The system displays up to the first 100 calls located in the database that match the criteria.</td>
<td>![icon]</td>
</tr>
<tr>
<td>Submit Call</td>
<td>Saves the call details entered into the request sections and clears the form.</td>
<td>![icon]</td>
</tr>
<tr>
<td>Call History...</td>
<td>Opens a Call History dialog box listing the current and previous calls from the customer. This option is disabled if a previous call does not exist.</td>
<td>![icon]</td>
</tr>
<tr>
<td>Event History...</td>
<td>Opens an Event History dialog box listing the current and previous events involving the customer. Note that the customer need not have called to be part of an event. This option is disabled if a previous event does not exist.</td>
<td>![icon]</td>
</tr>
<tr>
<td>Clear Form</td>
<td>Removes customer, event, and crew information from the fields on the window. Remember to save the call, if desired, before clearing the fields.</td>
<td>![icon]</td>
</tr>
</tbody>
</table>

### Options Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
</table>
| Set Wild Card Searching | Allows you to set the wild card search option. Wild card searching allows you to enter partial names or numbers in the searchable fields and all matching results will be returned. For example, if you have the wild card searching set to Both, and you enter “anders” into the Name field, the system returns customers named “Anderson”, “Andersen”, and “Sanders”.  
  - **Before** - puts a wild card before the search string  
  - **After** - puts a wild card following the search string  
  - **Both** - puts a wild card both before and after the search string  | ![icon]      |
Field Descriptions

This section describes the fields and buttons on the Web Call Entry window.

Searchable Information

The Searchable Information section allows you to enter search criteria to locate information for the customer calling to report a problem or request service. You can execute a search with full or partial data by entering information in any of the searchable fields and then either clicking the Search button or selecting Search from the Actions menu. If there is more than one match for the query, results are displayed in a Customer Selection table. From the Customer Selection table, you can select the appropriate record. For more information, see Searching for a Customer.

The Searchable Information section displays the following fields:

- The **Call ID** field contains the unique Call ID generated when a call is entered. A successful search on this field will open the Call History window with information from this call.
- The **Account #** field contains the customer account number. Enter all or part of the account number to search for the customer.
- The **Telephone** field contains the customer telephone number. Enter all or part of the telephone number to search for the customer.
- The **Name** field contains the customer name. Enter all or part of the customer name to search for the customer.
- The **Address** field contains the customer address or the address for the problem location. Enter all or part of the address to search for the customer or problem location.
- The **City** field contains the city, state, and zip code. This is a view-only field that is populated when a search is performed.

Help Menu

The Help menu displays the standard Help and About options.
Intersection Search Section

The Intersection Search section allows you to enter one or two street names and see a list of all matching street intersections containing the name(s). This allows the entry of a call that can be associated to the street intersection, which is helpful if someone is reporting a traffic light that is out or a customer has an outage but is not correctly located in the database.

The Intersection Search section displays the following fields:

- The **Street 1** field is required for searches and should just contain the street name with no numeric address part and no suffix such as St, Ln, Rd, S., W., etc. Capitalization does not matter.
- The **Street 2** field is optional for searches and should just contain the street name with no numeric address part and no suffix such as St, Ln, Rd, S., W., etc. Capitalization does not matter.

  Note: The order of the street names does not matter. If the database has “W 50th ST & BIRCH ST” as the intersection, it still will be found if you enter “Birch” for **Street 1**.

Additional Customer Information

The Additional Customer Information section displays the following fields:

- The **Account Type** field is a view-only field that indicates the type of customer account (e.g., electric).
- The **Customer Type** field is a view-only field that indicates the type of customer (e.g., critical). If a customer type has not been designated for the customer, this field will have 'STD'.
- The **Customer Device** field is a view-only field that indicates the device name associated with the customer.
- The **ERT to Report** field is used to track the estimated restore times (ERTs) given to a caller. If the customer is part of one or more outages, the **ERT to Report** field will default to the latest of the ERTs for outages affecting that customer. The button on the right opens a calendar dialog from which the reported date and time can be selected.

Callback Request

The Callback Request section allows you to specify a ‘call before’ date/time and an optional callback phone number, or indicate if no callback was requested. The information you enter in these fields is saved to the database and used by other Oracle Utilities Network Management System applications and possibly other 3rd party systems that are interfaced to Oracle Utilities Network Management System.

The Callback Request section includes the following fields:

- **Call Before Date** is a radio button that allows you to indicate that the customer would like to be contacted (called back) when the event is restored. Click on the calendar button to select a date and time after which the callback should not be performed. The date field can be left blank if the customer does not indicate a restriction.
- **No Callback Requested** is a radio button that allows you to indicate that the customer does not want to be called back regarding the event.
- The **Callback Phone** field contains an optional phone number, to be entered if the customer wishes to be called back at a different number (e.g., their cell phone) than the primary phone number on their account.
Request
The Request section allows you to enter general details provided by the caller. The information you enter in these fields is saved to the database and used by other Oracle Utilities Network Management System applications and possibly other 3rd party systems that are interfaced to Oracle Utilities Network Management System.

- **Power** is a drop-down menu that allows you to select the status of the power (e.g., dim lights).
- **Cause** is a drop-down menu that allows you to select the cause (if known) of the event (e.g., tree limb on wire).
- **Description** is a drop-down menu that allows you to select an additional description of the event (e.g., sagging wire).
- **Street Light** is a drop-down menu that allows you to indicate problems with streetlights or traffic lights.
- **Meter** is a drop-down menu that allows you to select an action needed in regard to the meter (e.g., connect).
- **Meet** is a drop-down menu that allows you to indicate whether emergency or other personnel should be met on the scene (e.g., meet fire).
- **Priority** is a drop-down menu that allows you to indicate whether the event is a priority situation (e.g., extreme/life).
- **Other** is a drop-down menu that allows you to cancel previous calls from this customer or enter in “informational” calls when the customer calls back to simply ask for more information about their event.

*Note:* The actual set of drop-down menus may be different at your company.

Customer Comment
- The **Customer Comment** field allows you to enter a note based on the remarks of the caller.

Operations Event Note
- The **Operations Event Note** field displays any dispatcher or crew notes that may have been entered into the system, such as waiting for special equipment or for traffic police to secure an area. This field is view-only.

Event Information
The Event Information section is view-only and populated with information only if one or more active events are associated with the customer. The Event Information table displays information about each active event associated with the customer. To view the Operations Event Note if there are multiple events, select the desired event from the table.

The Event Information Section displays the following columns:

- **Event #** column contains the unique number assigned to the event. The event number is also displayed in other Oracle Utilities Network Management System applications in order to track the status of the event.
- **Event Device** column contains the name of the device associated with the event.
- **Event Type** column contains a classification of the event. See Event Type Codes on page A-3 for a complete list of event type codes and their descriptions.
- **Start Date** column contains the date and time the event began.
- **Est Rest Time** column contains the date and time the operations center or the crew predicts the event will be resolved.
• The **Trouble Codes** column contains the trouble codes that were entered when the call was taken (*e.g.*, Sagging wire). See **Event Type Codes** on page A-3 for a complete list of event type codes and their descriptions.

• The **# Cust** column contains the estimated number of customers affected by the event.

**Crew Information**

The Crew Information section displays the following information about any crew currently associated with active events.

• The **Event #** column contains the unique number assigned to the event. The event number is also displayed in other Oracle Utilities Network Management System applications in order to track the status of the event.

• The **Crew ID** column contains the identification name or number of the crew.

• The **Assigned Date** column contains the date and time the crew was assigned to the event.

• The **# Assignments** column contains the total number of events to which the crew is assigned.

• The **En Route Date** column contains the date and time the crew was placed en route to the event.

• The **On Site Date** column contains the date and time the crew arrived on site.

**Planned Outages Information**

The Planned Outages Information section displays the following information about any upcoming planned outage that the customer will be a part of.

• The **Planned Start** column contains the date and time the planned switching work is scheduled to begin.

• The **Planned Finish** column contains the date and time the planned switching work is scheduled to end.

• The **Office** column contains the office responsible for the switching plan.

• The **Work Location** column contains the street address or specific location for the switching operation.

• The **Description of Work** column contains a general description about what the planned switching work is trying to accomplish.

**Searching for a Customer**

When a customer calls in, you can enter the details for the call in Web Call Entry. First you must search for the customer in order to populate the necessary information for submitting the call.

To search for a customer, complete these steps:

1. Verify that you have selected the preferred search option settings. Select the **Options** menu to view the current settings.

2. Enter all or part of the customer's information in the **Searchable Information** fields (*e.g.*, name, telephone number, etc.). Typically you will fill in search information in only one of the fields for a search.

3. Click the **Search** button on the toolbar, or press **Enter**. If a match is found, the customer information is displayed on the Web Call Entry window.

4. If more than one customer matches the search criteria, the Customer Selection dialog box displays the search results display in a table that contains the customer's account number,
name, address, city, state, zip code, and telephone number. You can use this information to confirm that you are entering an event for the correct customer.

5. Select the customer from the list and click the OK button. The customer's information displays on the main Web Call Entry window.

### Searching for a Customer Using the Call ID

When a customer calls in to follow up on a previous call, you can search for that call in Web Call Entry.

To search for a call using the original call ID, complete these steps:

1. Enter the call ID in the Searchable Information Call ID field.

2. Click the Search button on the toolbar, or press Enter. If a match is found, the Call History window opens. (See Viewing the Call History on page 8-8.) Skip to step 5.

3. If more than one call matches your search criteria, the Call Selection dialog box opens. The search results display in a table that contains the call date/time, name, address, city, state, zip code, and telephone number. You can use this information to confirm that you are retrieving the correct call.

4. Select a call from the list and click the OK button. The call's information displays on the main Web Call Entry window.

5. Confirm that it is the correct call and click the Load button. The Call History window closes and the call information displays in the Web Call Entry window.

### Search for a Call using Caller Information

To search for a call using previous caller information, complete these steps:

1. Verify that you have selected the preferred search option settings. Select the Options menu to view the current settings.

2. Enter all or part of the caller's information in the Searchable Information fields (e.g., name, telephone number, etc.) Typically you will fill in search information in only one of the fields for a search.

3. Click the Call Search button on the toolbar. If a match is found, the call information is displayed.

4. If more than one call matches the search criteria, the Call Selection dialog box opens (see above). The search results display in a table that contains the call date/time, name, address, city, state, zip code, and telephone number. You can use this information to confirm that you are retrieving the correct call.

5. Select a call and click the OK button. The call information displays in the Web Call Entry window.

### Viewing the Call History

Web Call Entry allows you to view the call history for a customer. This is important for managing the relationship with customers who are repeat callers. Once you have selected a call from the customer’s call history, you can view the details for the call.

The Call History window offers a table summary of each call a customer has made that is still within the database. The calls are chronologically ordered by call date, but can be sorted by any of the other columns by clicking on the column header. Click the column header once to sort in one direction (e.g., ascending order), and click a second time to sort in the other direction (e.g., descending order).
You can access the Call History window by clicking on the **Call History** button on the toolbar or selecting **Call History...** from the Actions menu.

**Note:** Your system administrator sets up the amount of call history data available.

### Call History Section

The Call History window displays the following fields and buttons:

- **The Call Date column** contains the date and time the customer call was entered.
- **The Trouble Codes column** contains the trouble conditions for the event (*e.g.*, out).
- **The Customer Comment column** contains comments from the customer as entered by the call taker, if any.
- **The Active column** is an indicator of whether the call is active. Values are:
  - Y - Yes, call (and associated event) are still active
  - N - No, call (and associated event) are resolved
  - C - Cancelled, customer called back to cancel call
  - E - Cancelled, operator cancelled event via Work Agenda
- **The Reported ERT column** contains the ERT value that was explicitly provided to the customer on that call.
- **The Call ID column** contains the unique ID generated when call is entered into system.

If you select a row in the table, the details for that call are displayed in the window below the table. The call details include customer information, callback request information, event information (*e.g.*, cause), and customer comments. The information on the Call History window is view-only except for the Callback Phone and the Customer Comment area. The fields on the Call Details window generally match the fields on the main Web Call Entry window:

### Call Taker ID

- **The Call Taker ID field** displays the ID of the user who recorded the call.

### Control Zone

- **The Control Zone field** displays the Control Zone where the problem is located.

### Call Information

- **The Reported Start Date field** is a field that indicates when the event was first reported to have started.

### Customer Information

- **The Call ID field** contains the unique Call ID generated when a call is entered.
- **The Account # field** contains the customer account number.
- **The Telephone field** contains the customer telephone number.
- **The Name field** contains the customer name.
- **The Address field** contains the customer address or the address for the problem location.
- **The City field** contains the city, state, and zip code.
- **The Customer Type field** is a field that indicates the type of customer (*e.g.*, critical). If a customer type has not been designated for the customer, this field will have '0'.
- **The Customer Device field** is a field that indicates the device name associated with the customer.
Callback Request

- **Call Before Date** is a radio button that indicates that the customer wanted to be contacted (called back) when the event is restored.
- **No Callback Requested** is a radio button that indicates that the customer did not want to be called back regarding the event.
- The **Callback Phone** field contains an optional phone number that was entered if the customer wished to be called back at a different number than the primary phone number on their account.

Last Callback

- This displays the last **Callback Time** and **Callback Result**.

Request

- **Power** is a drop-down menu that indicates the status of the power (*e.g.*, dim lights).
- **Cause** is a drop-down menu that indicates the cause (if known) of the event (*e.g.*, tree limb on wire).
- **Description** is a drop-down menu that indicates an additional description of the event (*e.g.*, sagging wire).
- **Street Light** is a drop-down menu that indicates problems with streetlights or traffic lights.
- **Meter** is a drop-down menu that indicates an action needed in regard to the meter (*e.g.*, connect).
- **Meet** is a drop-down menu that indicates whether emergency or other personnel were to be met on the scene (*e.g.*, meet fire).
- **Priority** is a drop-down menu that indicates whether the event is/was a priority situation (*e.g.*, extreme/life).
- **Other** is a drop-down menu that indicates whether or not the call was simply an “informational” one (the call to cancel a previous call doesn't show up in the Call History, so this would never display the value of “Cancel”).

Customer Comment

- The **Customer Comment** field displays the remarks of the caller, if any.

Toolbar Buttons

- The **Load** toolbar button loads the main Web Call Entry window with Customer and Event Information based on this call, and closes the Call History window. (Only enabled if search was based on Call ID.)
- The **Save** toolbar button saves any changes to the Callback Phone or Customer Comment fields and closes the Call History window.
- The **Cancel** toolbar button allows you to cancel the selected call.
- The **Close** toolbar button closes the Call History dialog box.
- The **Help** toolbar button displays help for this window.
Viewing the Event History

Web Call Entry allows you to view the event history for a customer. This is important for managing the relationship with customers who have experienced additional recent outages. Once you have selected an event from the customer's event history, you can view the details of the event.

The Event History window box offers a table summary of each event related to the customer that is still in the database. The events are chronologically ordered by start date, but can be sorted by any of the other columns by clicking on the column header. You can access the Event History window by clicking on the Event History button on the toolbar or selecting Event History... from the Actions menu.

Note: Your system administrator sets up the amount of event history data available.

The Event History window displays the following fields and buttons:

**Event History Section**
- The **Event #** column contains the unique number assigned to the event. The event number is also displayed in other Oracle Utilities Network Management System applications in order to track the status of the event.
- The **Start Date** column contains the date and time the event was reported to have begun. This is typically the same time as when the first call was entered.
- The **End Date** column contains the date and time the event was resolved. If this field is empty, then the event has not been completed in Oracle Utilities Network Management System.
- The **Event Type** column indicates whether the event was an outage or non-outage. (OUT - An outage event where some customers were without power, NON - A non-outage event, such as street light always on/off.)
- If you select a row in the table, the details for that event are displayed in the window below the table. The event details include the event number, device and feeder information, and event time information. The information on the Event History window is view-only. Many of the fields on the Event History window match the Event Information and other fields on the main Web Call Entry window.

**Event Information Section**
- The **Event #** field displays the unique number assigned to the event. The event number is also displayed in other Oracle Utilities Network Management System applications in order to track the status of the event.
- The **Feeder** field displays the feeder associated with the event.
- The **Event Device** field displays the device associated with the event.
- The **Est Cust Affected** field displays the estimated number of customers affected by the event.
- The **First Call At** field displays the date and time the first call was entered.
- The **Event Start Date** field displays the date and time the event was reported to have begun. This is typically the time the first call was entered.
- The **Event Restored At** field displays the date and time the event was resolved. If this field is empty, then the event has not been completed in Oracle Utilities Network Management System.
- The **Remedy** field displays the value from the Event Details Remedy drop-down if it has been populated from Trouble Management or Web Trouble.
Entering a Customer Call

After you have located the information for a customer and have reviewed any call history and event history, you can proceed to enter a call. You enter all call information in the main Web Call Entry window.

To enter a customer call, complete these steps:

1. Search for the customer information. (For details on how to search for customer information, see Searching for a Customer.)

2. If the customer wishes to be called back when the event is complete, click the Call Before Date radio button. If part of your business process, and if the customer indicates a restriction, click on the Calendar button (at right) to enter the date and time after which the customer no longer wants to be called. If the customer provides a different phone number for the callback, enter it in the Callback Phone field.

3. Select the appropriate options from the drop-down menus in the Request section. These are necessary for operations personnel to understand and quickly resolve the event.

4. In the Customer Comments field, enter any information that the customer provides that will assist the operations personnel or the crew.

5. Save the call by clicking the Submit Call button on the toolbar or selecting the Submit Call option from the Actions menu. A popup dialog will display with a Call ID.

Cause Factors

- The **Scheduled** field displays the value from the Event Details Scheduled drop-down if it has been populated from Trouble Management or Web Trouble.

- The **Utility Error** field displays the value from the Event Details Utility Error drop-down if it has been populated from Trouble Management or Web Trouble.

- The **Other** field displays the value from the Event Details Other drop-down if it has been populated from Trouble Management or Web Trouble.

- The **Foreign Interf.** field indicates any foreign interference associated with the outage.

- The **Vegetation** field displays the value from the Event Details Vegetation drop-down if it has been populated from Trouble Management or Web Trouble.

- The **Defective Equip.** field displays the value from the Event Details Defective Equip. drop-down if it has been populated from Trouble Management or Web Trouble.

- The **Environment** field displays the value from the Event Details Environment drop-down if it has been populated from Trouble Management or Web Trouble.

- The **Weather** field displays the value from the Event Details Weather drop-down if it has been populated from Trouble Management or Web Trouble.

Operations Cancellation Reason

- The **Operations Cancellation Reason** field displays the reason given for canceling the event if cancelled by operations personnel. Typically done if event was inadvertently entered in the system.

Operations Cancellation Reason

- The **Operations Event Note** field displays notes entered regarding the event. These notes may include crew remarks and resolution issues.

Toolbar Buttons

- The **Close** button closes the Event History window.

- The **Help** button displays help for this window.
6. Provide the Call ID to the customer, and then click the **OK** button to dismiss the dialog.

### Entering an Informational Call

A customer may call back to ask when their power is expected to be restored. If you need to keep track of when estimated restore times (ERTs) are provided to a customer, complete these steps:

1. Search for the customer information. (For details on how to search for customer information, see [Searching for a Customer](#) on page 8-7.)

   **Note:** The **ERT to Report** field will default to the latest of the ERTs for outages affecting that customer. If the field is blank, or if a different ERT is given to the customer (*e.g.*, by rounding the listed ERT up to the next half hour), then modify the field to display the actual ERT that the customer is told. Select the button on the right to open a calendar dialog from which the reported date and time can be selected.

2. In the Request section of the main Web Call Entry window, select the **Informational** option from the Other drop-down.

3. Save the call by clicking the **Submit Call** button on the toolbar or selecting the Submit Call option from the Actions menu.

### Entering a Fuzzy Call

Fuzzy calls are calls that are not initially associated with a customer or device. For example, a fuzzy call results when you receive a call from the police reporting that a pole is down at a street intersection. It can later be associated with a specific device.

The search will not match on a specific customer, but will instead display the “fuzzy call” dialog as shown below.

To enter a fuzzy call, complete these steps:

1. Enter the address information (*e.g.*, cross streets). A fuzzy call should have some address information filled in, even if it just an intersection.

2. Click the **Search** toolbar icon or select the **Search** option from the Actions menu. A dialog appears, indicating that there was no match for the search criteria, but the call can be edited or saved.

3. If you know the control zone associated with the trouble location indicated by the caller, click on the **Control Zone Selection** button to the right of the Control Zone field. Select the control zone from the tree display and then click the **OK** button.

4. Click the **Edit Call** button.

5. If the caller wishes to be called back when the event is resolved, click the **Call Before Date** radio button. Then, click on the **Calendar** button (at right) to enter the date and time after which the customer no longer wants to be called. Enter the caller’s phone number in the **Callback Phone** field.

6. Select the appropriate options from the drop-down menus in the **Request** section, such as Power, Cause, Description, Street Light, Meter, Meet, Priority, and Other. (See [Callback Request](#) for details.) These are necessary for operations personnel to understand and quickly resolve the event.

7. In the **Customer Comments** field, enter any information that the caller provides that will assist the operations personnel or the crew.

8. Save the call by clicking the **Submit Call** button on the toolbar or selecting the Submit Call option from the Actions menu.
Note: This button is only enabled if the Address field was filled in when the search was done.

A popup dialog displays the Call ID.

9. Provide the Call ID to the caller, and then click the OK button to close the dialog.

Cancelling a Customer Call

You can cancel a call from the Call History window. This is useful if a customer calls back to indicate that the problem related to the initial call has been resolved. You can cancel fuzzy calls using this procedure.

Note: The original call is not removed from the system; rather, its status is changed to C (cancelled) and a new call is created with a status of N, indicating that the original call and its associated event have been resolved.

To cancel a customer call, complete these steps:

1. Search for the customer information. (For details on how to search for customer information, see Searching for a Customer.)

2. Click the Call History button on the toolbar or select Call History... from the Actions menu.

3. Select the call in the Call History list. The Cancel button is enabled.

4. Click the Cancel button on the toolbar. The Cancel Call dialog is displayed.

5. Enter the reason for the cancellation, and click OK.

6. You can view the original cancelled call and the new call entry in the Call History.

Cancelling All Calls For a Customer Account

Use this procedure to cancel all calls for a customer account.

1. Search for the customer information. (For details on how to search for customer information, see Searching for a Customer on page 8-7.)

1. In the Request section of the main Web Call Entry window, select the Cancel option from the Other drop-down.

1. Save the call by clicking the Submit Call button on the toolbar or selecting the Submit Call option from the Actions menu.

Note: Fuzzy calls must be cancelled in the Work Agenda. See the previous procedure.

Viewing the Outages Summary

The Outages Summary window presents the user with a view-only summary of the total active outage events in the system. The information in the window dynamically updates as new calls come in and as new outages are created and restored. The events are sorted by default on the E/H and # Out values, but can be sorted by any of the other columns by clicking on the column header. You can access the Outages Summary by clicking on the Outages Summary button on the toolbar or selecting Outages Summary from the File menu.

The Outages Summary window contains two tables. The top table is a summary and the table below it displays a row for each event in the summary table.
The summary table at the top of the Outages Summary window displays the following columns:

- The **Events in View** field displays the number of events currently displayed in the Outages Summary.
- The **Est Cust Out** field displays the number of customers estimated to be affected by the events currently displayed in the Outages Summary.
- The **Calls** field displays the number of calls entered for the events currently displayed in the Outages Summary.
- The **Pri Calls** field displays the number of priority calls entered for the events currently displayed in the Outages Summary.
- The **EMR Cust Out** field displays the number of emergency customers affected by the events currently displayed in the Outages Summary.
- The **MED Cust Out** field displays the number of medical customers affected by the events currently displayed in the Outages Summary.
- The **KEY Cust Out** field displays the number of key customers affected by the events currently displayed in the Outages Summary.
- The **Crews En Route/Onsite** field displays the number of crews en route to/onsite at the events currently displayed in the Outages Summary.

The **Current Outages** table displays the following columns:

- The **E/H** column indicates whether or not the event is an emergency or hazardous condition. An “E” in this column denotes extreme emergency, and an “H” in this column denotes hazardous.
- The **# Out** column contains the number of customers experiencing an outage for the event.
- The **# Crit** column contains the total number of critical customers experiencing an outage for the event.
- The **# Calls** column contains the number of calls received for the event.
- The **Region** column contains the control zone region where the event occurred.
- The **Branch** column contains the control zone branch where the event occurred.
- The **Substation** column contains the control zone substation where the event occurred.
- The **Location** column contains either the address of the first customer that called if the event is a service outage or non-outage or the feeder location of the device if the event is a device outage.
- The **Start Date** column contains the date and time the event began.
- The **Est Restore Date** column contains the estimated restoration time (ERT) for the event.
- The **Est Src** column contains the source of the ERT for the event. The possible source values are:
  - **N** - none (no ERT)
  - **S** - Oracle Utilities Network Management System - Storm Management
  - **P** - Oracle Utilities Network Management System Storm Management “non-published global ERT”
  - **O** - Oracle Utilities Network Management System Storm Management “onsite ERT” used when the crew is en route or onsite. If the crew is en route, the ERT includes the travel time plus the repair time; if the crew is onsite, the ERT only includes the repair time.
• G - Oracle Utilities Network Management System Storm Management “published global ERT”
• C - User-entered (assumed to have been provided by the crew)
• I - Initial default ERT
• The Clues column contains the clue codes for the calls received, if any.
• The Status column displays the status assigned to the event. See Event Status Codes on page A-1 for a complete list of status codes and descriptions.
• The Crews column contains the crew id(s) of the associated crew(s).

The Operations Event Note field displays the Operations Event Note for the selected event, if any.

Buttons
• The Auto Filter button allows you to quickly filter the view by the selected cell value.
• The Auto Filter Off button turns off any auto filter that has been applied.
• The Exit button closes the Outages Summary window.

The following table describes the Outages Summary menus.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Print</td>
<td>Opens up the Print Preview dialog, which allows you to print out the Outages Summary window.</td>
</tr>
<tr>
<td>File</td>
<td>Exit</td>
<td>Closes the Outages Summary window.</td>
</tr>
<tr>
<td>Filter</td>
<td>Auto Filter</td>
<td>Allows you to quickly filter the view by the selected cell value.</td>
</tr>
<tr>
<td>Filter</td>
<td>Auto Filter Off</td>
<td>Turns off any auto filter that has been applied.</td>
</tr>
<tr>
<td>Actions</td>
<td>Default Sort</td>
<td>Applies the default sort to the Outages Summary.</td>
</tr>
<tr>
<td>Help</td>
<td>Web Call Entry Help</td>
<td>Opens a help dialog for the current window.</td>
</tr>
<tr>
<td>Help</td>
<td>About Web Call Entry</td>
<td>Opens the standard About dialog.</td>
</tr>
</tbody>
</table>
This chapter describes the Web Callback functionality. It includes the following topics:

- Overview
- Starting Web Callbacks
- Using the Web Callbacks Window
- Assigning Callbacks
- Viewing Callback Assignments
- Unassigning Callbacks
- Performing Callbacks

**Overview**

Oracle Utilities Network Management System - Web Callbacks is an application used to manage callback requests for customers who have called in reporting an outage. When the outage is resolved, Web Callbacks provides the information necessary to call customers. Web Callbacks allows you to assign groups of callbacks to users and outsourcing agencies, and also supports a “one-at-a-time” approach, where you can select an outage and perform the next callback. Callbacks are only created for customers who called in and had “Callback Requested” indicated when their call was entered.

Web Callbacks displays information about the outage and the original customer call, and allows you to save the results of the callback (power restored, phone busy, power still out, etc.). Customers whose power is not restored are re-introduced into the Oracle Utilities Network Management System for re-analysis and restoration. A Still Out trouble code clue, which appears in Clues field in Work Agenda and Trouble Info, is added to calls re-introduced in this way. Web Callbacks interfaces with other Oracle Utilities Network Management System modules to display customer comments and operations remarks.

**Starting Web Callbacks**

Web Callbacks is accessed using a URL (web address) or as a local application, depending on your site's policy. Your system administrator determines the web address, if applicable. If accessing Web Callbacks from a browser, complete these steps:

- Open your web browser by clicking the shortcut on the desktop, or from the Start menu.
- In the Address field of the browser, enter the URL for Web Callbacks, then press Enter. Please wait while Web Callbacks starts.
Starting Web Callbacks

- If this is the first time running an Oracle Utilities Network Management System Windows-based product on your PC, you may be prompted to do a one-time download of a Java plug-in. If so, select Yes/Accept/Agree on all subsequent dialogs until Web Callbacks opens.

  **Note:** You or your system administrator can add Web Callbacks to your Start menu and/or create a shortcut icon on your desktop for quick access to Web Callbacks. When you start up Web Callbacks for the first time, it will (depending on installation method) ask if you want to install a shortcut in your Start menu and on your desktop.

Logging In

The Login window is the first Web Callbacks window you see. You must enter a valid user name and password, and then click the **Validate** button. Once your user name and password are validated, the system populates the option menu that allows you to select a user type.

The Login window displays the following fields and buttons:

- The **User ID** field allows you to enter the user name provided to you by the system administrator.
- The **Password** field allows you to enter the password provided to you by the system administrator.
- The **Validate** button verifies your login credentials. If the user name and password are not entered correctly, the system displays a warning dialog box.
- The **User Type** drop-down menu contains the list of user types within your authority.
- The **Login** button allows you to complete the login process. Once you click the Login button, the Web Callbacks window opens.
- The **Quit** button exits the Login window.

Logging In

To login to Web Callbacks, complete these steps:

1. Depending on how your system was installed, do one of the following:
   - Click the **Web Callbacks** icon found under the appropriate program group in your Windows Start Menu.
   - Double-click the **Web Callbacks** icon on your desktop.
   - Open a web browser and type the Web Callbacks URL in the browser’s Address field.

   The Web Callbacks Login window displays.

2. Enter your user name in the User Name field.
3. Enter your password in the Password field.
4. Click the **Validate** button. The bottom portion of the Web Callbacks Login window sensitizes.
5. Select the appropriate User Type from the drop-down menu.
6. Click the **Login** button. The main Web Callbacks window will display.
Using the Web Callbacks Window

The Web Callbacks main window displays all of the events that have callbacks that must be completed. You can perform callback actions in the window using the menu, the buttons on the toolbar, or the buttons at the bottom of the window.

This following topics describe how to use the Web Callbacks window:

- **Web Callbacks Menus**
- **Toolbar**
- **Header**
- **Callbacks Table**
- **Callbacks Summary Panel**
- **Callbacks Buttons**
- **Status Bar**

Related Topics:

- **Starting Web Callbacks**
- **Assigning Callbacks**
- **Viewing Callback Assignments**
- **Unassigning Callbacks**
- **Performing Callbacks**

**Web Callbacks Menus**

The Web Callbacks menu bar provides access to all functions. The commonly used functions are also available on the toolbar and in buttons at the bottom of the window. There are three menus on the Web Callbacks menu bar: File, Actions, and Help.

- **File Menu**
  - **Exit** - Closes the Web Callbacks window and exits the application. A confirmation dialog will be displayed.

- **Actions Menu**
  - **View My Callback Lists** – Opens the View My Callback Lists window, which displays a list of callbacks assigned to you.
  - **Perform Next Callback** – Opens the Perform Next Callback window, which allows you to perform the next callback for the selected event.
  - **Assign Callbacks** – Opens the Assign Callbacks window, which allows you to assign callbacks for the selected event.

- **Help Menu**
  - **About Web Callbacks** - Opens a dialog that displays information regarding what version of the application is presently running, as well as version and other information about the Oracle Utilities Network Management System Web Gateway that the application is using.
Using the Web Callbacks Window

Toolbar

The Web Callbacks toolbar provides a shortcut to many of the options available from the Web Callbacks menus. The following table describes the buttons on the Web Callbacks Toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="View My Callbacks Lists" /></td>
<td>Opens the View My Callback Lists window, which displays a list of callbacks assigned to you.</td>
</tr>
<tr>
<td><img src="image" alt="Perform Next Callback" /></td>
<td>Opens the Perform Next Callback window, which allows you to perform the next callback for the selected event.</td>
</tr>
<tr>
<td><img src="image" alt="Assign Callbacks" /></td>
<td>Opens the Assign Callbacks window, which allows you to assign callbacks for the selected event.</td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td>Closes the Web Callbacks window and exits the application. A confirmation dialog will be displayed.</td>
</tr>
</tbody>
</table>

Header

Beneath the Web Callbacks Toolbar is the header section. This section contains information regarding who is logged in to the application.

- The **User Name** field displays your Web Callbacks login user name. This field is not editable.

Callbacks Table

The Web Callbacks table contains a detailed list of each resolved event that still has callbacks remaining. These rows are color-coded by the status of the callback (not started vs. in progress).

The Callbacks Table displays the following columns:

- The **Event #** column contains the unique number of the event.
- The **# Callbacks** column contains the number of callbacks for the event.
- The **# Pri** column contains the number of callbacks from priority calls for the event.
- The **% Comp** column contains the percentage of callbacks completed for the event.
- The **# Rem** column contains the number of callbacks remaining for the event.
- The **# Asn** column contains the number of remaining callbacks for the event that have been assigned.
- The **Start Date** column contains the reported start date and time of the event.
- The **Restore Date** column contains the date and time the event was restored.
- The **Device** column contains the name of the device associated with the event.
- The **Status** column contains the status of callbacks for the event:
  - **In Progress** - Some callbacks for the event have been completed.
  - **Not Started** - Some callbacks for the event may have been assigned, but no callbacks are completed.
• The **Substation** column contains the name of the substation for the device associated with the event.

• The **Zone** column contains the name of the branch office where the event occurred.

• The **# Users** column contains the number of users with assigned callbacks for the event.

**Callbacks Table Column Features**

Web Callbacks allows you to sort columns of its table by clicking on the particular column. The column displays an ascending sort after the first click and a descending sort after the second. A black arrow displays the direction of the sort. Clicking on other columns will initially sort based on the opposite sort type from the last column (ascending if previous column was sorted descending) and the sort direction reverses with subsequent clicks.

**Sorting Callbacks**

To sort based on a callback list column, complete these steps:

1. Click on the column that you want to sort. The column sorts in ascending order, indicated by a black arrow pointing upward.
2. Click again to sort the column in descending order, indicated by a black arrow pointing downward.
3. Click on a different column and the list is sorted ascending based on that column.

**Rearranging Columns**

You can dynamically rearrange the columns in a Web Callbacks list by dragging and releasing the column headers. To rearrange the columns, complete these steps:

1. On the column header for the column you want to move, click and hold down the mouse button with the pointer.
2. Move the pointer to drag the column left or right to the new location.
3. Release the mouse button. The column appears in the new location.

Note that this change is temporary. The next time you start Web Callbacks, the columns will display in their default order.

**Callbacks Summary Panel**

The Callbacks Summary panel appears in the lower portion of the Web Callbacks window. This panel displays summary information from the callback list. The Callbacks Summary panel includes the following fields:

• The **# Callbacks** field displays the total number of callbacks from events that still have active callbacks.

• The **% Complete** field displays the total percentage of callbacks listed in # Callbacks that are complete.

• The **# Remaining** field displays the total number of callbacks not completed, based on the # Callbacks.

• The **# Priority Calls** field displays the total number of callbacks that were priority, meaning those where the original call was for a priority situation (e.g., hazardous downed wire).

  **Note:** Once all callbacks for an event have been completed, they are removed from the data displayed in the Callbacks Summary Panel. As a result, the % Complete can actually decrease when the last callback for an event is completed and that event is removed from the calculation.
Assigning Callbacks

Callbacks Buttons

The buttons on the bottom of the main Web Callbacks window comprise commonly used functions.

- The View My Callbacks Lists… button opens the View My Callback Lists window, which displays a list of callbacks assigned to you.
- The Perform Next Callback… button opens the Perform Next Callback window, which allows you to perform the next callback for the selected event.
- The Assign Callbacks… button opens the Assign Callbacks window, which allows you to assign callbacks for the selected event.

Status Bar

The status bar appears at the bottom of the Web Callbacks window, providing informational messages to the user at various times. Messages will appear in the status bar when callbacks are assigned, unassigned, or cancelled, when callbacks are saved or when a new callbacks user is created.

Assigning Callbacks

The Assign Callbacks window is used to assign callbacks for a specific event to you and/or other logged in users in order to manage the completion of the callback requests. If callbacks have been assigned to a user and that person is unable to complete the callbacks in a timely fashion, you can unassign those callbacks.

To access the Assign Callbacks window, select an event in the main Web Callbacks window, and then do one of the following:

- Select the Assign Callbacks… option from the Actions menu, or
- Click the Assign Callbacks button [X] on the toolbar, or
- Click the Assign Callbacks… button beneath the Callbacks Summary panel.

This section includes the following topics:

- Using the Assign Callbacks Window
- Assigning Numbers of Callbacks
- Assigning Percentages of Callbacks
- Assigning All Remaining Callbacks
- Reassigning All Remaining Callbacks
- Unassigning Callbacks

Using the Assign Callbacks Window

The Event Info panel at the top of the Assign Callbacks window provides summary information about the event. The Event Callbacks panel provides a current status of callback assignments for the event per user, and allows you to change the number or percentage of assigned callbacks for each user.

Note: When assigning callbacks to multiple users, you can assign a specific number of callbacks for the event to each user, or assign a percentage of the callbacks to each user.

The Assign Callbacks window displays the following fields and buttons:

- The Event # field displays the event number for which callbacks are being assigned.
• The **Device** field displays the name of the device associated with the event.
• The **Substation** field displays the name of the substation associated with the event.
• The **Total Callbacks** field displays the total number of callbacks for the event.
• The **% Complete** field displays the percentage of callbacks that are complete for the event.
• The **# Unassigned** field displays the number of callbacks for the event that have not been assigned.
• The **User Name** column contains the user name for each user currently logged in to the system. Other users appear in this column if they are permanently available (e.g., a third party agency or IVR system). You can assign callbacks to any user in this column.
• The **Include Priority Calls** column contains a check box that allows you to specify whether you want to include priority calls in the callback assignments for the user. This option may not be available for certain users, such as third party agencies or IVR.
• The **% Assigned** column contains the percentage of the total number of callbacks assigned to the user for the event. You can assign a specific percentage to the user by editing this field and then pressing the <Enter> key. If the percentage does not result in an exact number of callbacks (e.g., the callback assignment would be 4.78), the system rounds to the nearest number (in this case, 5).
• The **# Asn** column contains the number of callbacks assigned to the user for the event. You can assign a specific number of callbacks to each user by editing this field and then pressing the <Enter> key.
• The **# Pri** column contains the number of callbacks for priority calls assigned to the user for the event. This column is not editable.
• The **# Rem** column contains the number of callbacks remaining assigned to the user for the event. This column is not editable.
• The **% Comp** column contains the percentage of the total number of callbacks assigned to the user for the event that are complete. This column is not editable.

**Buttons**

• The **Save** button saves any callback assignment changes and closes the Assign Callbacks window. There is also an option under the Assign Callbacks window's Actions menu for this action.
• The **Unassign** button unassigns the remaining uncompleted callbacks for the event for the selected user and closes the Assign Callbacks window. There is also an option under the Assign Callbacks window's Actions menu for this action.
• The **Assign Remaining** button assigns the remaining unassigned callbacks for the event to the selected user and closes the Assign Callbacks window. There is also an option under the Assign Callbacks window's Actions menu for this action.
• The **Exit** button closes the Assign Callbacks window without saving any changes. There is also an option under the Assign Callbacks window's File menu for this action.

**Assigning Callbacks to Users**

You can assign callbacks to yourself or to another user that is currently logged into the system, or to an external service if it has been set up in your system. All of the users that have access to the system can assign callbacks to themselves and to others.

**Assigning Numbers of Callbacks**

When assigning callbacks for an event, you can assign all callbacks to a single user or distribute the callbacks to multiple users. To assign a specific number of callbacks, follow these steps:
Assigning Callbacks

1. Select an event with multiple unassigned callbacks from the Web Callbacks main window.

2. Do one of the following:
   - Click the Assign Callbacks button on the toolbar, or
   - Select the Assign Callbacks… option from the Actions menu, or
   - Click the Assign Callbacks… button below the Callbacks Summary panel. The Assign Callbacks window opens.

3. Select the # Asn column for a user from the list of users.

4. Type the number of callbacks you want to assign to the user.

5. If the event has additional callbacks, select the column for another user and enter the number of callbacks that you want to assign to that user.

6. Once you have assigned all of the callbacks that you want to assign, click the Save button. The Assign Callbacks window closes.

Assigning Percentages of Callbacks

When assigning callbacks for an event, you can assign all callbacks to a single user, or distribute the callbacks to multiple users by percentage. To assign a percentage of callbacks for an event to a user, complete these steps:

1. Select an event with multiple unassigned callbacks from the Web Callbacks main window.

2. Do one of the following:
   - Click the Assign Callbacks button on the toolbar, or
   - Select the Assign Callbacks… option from the Actions menu, or
   - Click the Assign Callbacks… button below the Callbacks Summary panel. The Assign Callbacks window opens.

3. Select the % Assigned column for a user.

4. Type “50” and press Enter. This will assign 50% of the callbacks to the selected user.

5. Click the Save button. The Assign Callbacks window closes.

Assigning All Remaining Callbacks

To assign all remaining callbacks for an event to a single user, complete these steps:

1. Select an event with multiple unassigned callbacks from the Web Callbacks main window.

2. Do one of the following:
   - Click the Assign Callbacks button on the toolbar, or
   - Select the Assign Callbacks… option from the Actions menu, or
   - Click the Assign Callbacks… button below the Callbacks Summary panel. The Assign Callbacks window opens.

3. Select the User Name column for a user.

4. Click the Assign Remaining button. All remaining unassigned callbacks are assigned to the selected user. The Assign Callbacks window closes.

Reassigning All Remaining Callbacks

To reassign all remaining event callbacks for a user to another user, complete these steps:

1. Select the event with assigned callbacks for a user from the Web Callbacks main window.

2. Do one of the following:
• Click the **Assign Callbacks** button on the toolbar, or
• Select the **Assign Callbacks…** option from the Actions menu, or
• Click the **Assign Callbacks…** button below the Callbacks Summary panel. The Assign Callbacks window opens.

3. Select the **User Name** column for the user with uncompleted assigned callbacks.

4. Click the **Unassign** button. All remaining assigned callbacks for the selected user are now unassigned. The Assign Callbacks window closes.

5. Reopen the Assign Callbacks window using one of the methods above.

6. Select the **User Name** column for the user you wish to perform the remaining callbacks.

7. Click the **Assign Remaining** button. All remaining unassigned callbacks are assigned to the selected user. The Assign Callbacks window closes.

### Viewing Callback Assignments

With the View My Callback Lists window, you can view all of the callbacks currently assigned to you. To access the View My Callback Lists window, do any of the following:

• Select the **View My Callback Lists…** option from the Actions menu, or
• Click the **View My Callback Lists** button [X] on the toolbar, or
• Click the **View My Callbacks Lists…** button beneath the Callbacks Summary panel.

This section includes the following topics:

• **View My Callback Lists Window**
• **Viewing Your Callback Assignments**
• **Canceling Your Callback Assignments**

### View My Callback Lists Window

The View My Callback Lists window displays the following fields and buttons:

• The **User Name** field displays the user name that you are logged in as.

• The **# of Callback Lists** Assigned field displays the total number of events for which you have callback assignments.

• The **Event #** column contains the event number associated with the callback list.

• The **# Callbacks** column contains the number of callbacks assigned to you for the event.

• The **# Pri** column contains the number of priority calls among your assigned callbacks for the event.

• The **% Comp** column contains the percentage of your assigned callbacks that are complete.

• The **# Rem** column contains the number of callbacks assigned to you for the event that need to be completed.

• The **Restore Date** column contains the date and time the event was restored.

• The **Device** column contains the name of the device associated with the event.

• The **Substation** column contains the name of the substation for the device associated with the event.

**Buttons**

• The **Unassign All** button unassigns all of your remaining callbacks for all lists. This might be done if you are taking a break and therefore need to make the callbacks available for others to
Unassigning Callbacks

do. There is also an option under the View My Callback Lists window's Actions menu for this action.

• The **Perform Callback List**… button opens the Perform Callback List window for the selected event, which allows you to enter the callback response for each callback assigned to you from that event. There is also an option under the View My Callback Lists window's Actions menu for this action.

• The **Cancel Callbacks** button allows you to cancel all of your remaining callbacks for the selected event and consider them complete.

• The **Exit** button closes the View My Callback Lists window.

Viewing Your Callback Assignments

To view callbacks assigned to you, complete these steps:

1. Do one of the following:
   - Click the **View My Callback Lists** button on the toolbar, or
   - Select the **View My Callback Lists**… option from the Actions menu, or
   - Click the **View My Callback Lists**… button below the Callbacks Summary panel.

   The View My Callback Lists window opens, displaying all events with callbacks assigned to you.

2. Click the **Exit** button to exit the View My Callbacks Lists window.

Canceling Your Callback Assignments

To cancel callbacks assigned to you for a specific event, complete these steps:

1. Do one of the following:
   - Click the **View My Callback Lists** button on the toolbar, or
   - Select the **View My Callback Lists**… option from the Actions menu, or
   - Click the **View My Callback Lists**… button below the Callbacks Summary panel.

   The View My Callback Lists window opens, displaying all events with callbacks assigned to you.

2. Select the row of the event you wish to cancel your assigned callbacks for.

3. Click the **Cancel Callbacks** button. A confirmation dialog appears.

4. Click the **Yes** button on the confirmation dialog. Your assigned callbacks for that event are now considered complete. If there are no more uncompleted callbacks assigned to other users remaining for that event, that event row will disappear from the window. Otherwise, that event row will remain displayed until all callbacks for that event are complete.

5. Click the **Exit** button to exit the View My Callbacks Lists window.

Unassigning Callbacks

You can unassign callbacks that have not been completed. You may unassign callbacks for a single event, or unassign all callbacks assigned to you.

**Note:** If you exit Web Callbacks, the system automatically unassigns all of your remaining callbacks.

This section includes the following topics:

• **Unassigning Callbacks for a Specific Event**
• Unassigning All of Your Callbacks

Unassigning Callbacks for a Specific Event

To unassign callbacks for a specific event, complete these steps:

1. On the main Web Callbacks window, select the event for which you want to unassign callbacks.

2. Do one of the following:
   • Click the Assign Callbacks button on the toolbar, or
   • Select the Assign Callbacks option from the Actions menu, or
   • Click the Assign Callbacks… button below the Callbacks Summary panel. The Assign Callbacks window opens.

3. Select the User Name column for the user whose callbacks you wish to unassign.

4. Do one of the following:
   • To unassign all of the user’s remaining callbacks for the event, click the Unassign button. The Assign Callbacks window closes.
   • To unassign a portion of the user's remaining callbacks for the event, enter a lower number of callbacks in the # Asn column for the user, or a lower percentage of callbacks in the % Assigned column, then press the <Enter> or <Tab> key. Click the Save button. The Assign Callbacks window closes.

Unassigning All of Your Callbacks

To unassign all of your callbacks, complete these steps:

1. Do one of the following:
   • Click the View My Callback Lists button on the toolbar, or
   • Select the View My Callbacks Lists… option from the Actions menu, or
   • Click the View My Callback Lists… button below the Callbacks Summary panel.

   The View My Callback Lists window opens, displaying all events with callbacks assigned to you.

2. Click the Unassign All button. A confirmation dialog appears.

3. Click Yes on the confirmation dialog. The View My Callback Lists window closes.

Performing Callbacks

Once you have assigned callbacks to yourself, or another user has assigned callbacks to you, you can complete those callbacks using the Perform Callback List window. You may also perform callbacks that are unassigned (not currently assigned to any user) using the Perform Next Callback window.

The Perform Callback List window is used to record the results as you are completing your assigned callbacks for an event. The Event Information panel at the top of the window provides summary information about the event. The Event Callbacks Summary panel provides a status of your callback assignments for the event. The callback list table lists customers who have requested a callback for the event, and the Additional Customer Information panel provides more details regarding the customer selected in the callbacks list table.

This section includes the following topics:

• Accessing the Perform Callback List
Performing Callbacks

- Using the Perform Next Callback Window
- Performing Assigned Callbacks for an Event
- Performing Unassigned Callbacks (Next Callback)

Accessing the Perform Callback List
To access the Perform Callback List window:

1. Do one of the following:
   - Click the View My Callback Lists button on the toolbar, or
   - Select the View My Callback Lists… option from the Actions menu, or
   - Click the View My Callback Lists… button below the Callbacks Summary panel.

   The View My Callback Lists window opens, displaying all events with callbacks assigned to you.

2. Select a row for an event in the View My Callback Lists table and either:
   - Select the Perform Callback List… option from the Actions menu, or
   - Click the Perform Callback List… button.

   The Using the Perform Callbacks List Window opens.

Using the Perform Callbacks List Window
The Perform Callbacks List window displays the following information:

- The Event # field displays the event number for which callbacks are being performed.
- The Substation field displays the name of the substation associated with the event.
- The Zone field displays the name of the branch office associated with the event.
- The Device field displays the name of the device associated with the event.
- The Start Date field displays the date and time the event began.
- The Restore Date field displays the date and time the event was restored.
- The Operations Event Note field displays any comments entered for the event by operations staff.
- The # Callbacks field displays the total number of your assigned callbacks for the event.
- The # Remaining field displays the number of your callbacks remaining for the event.
- The % Complete field displays the percentage of your callbacks that are complete for the event.
- The Account # column contains the customer account number.
- The Name column contains the name of the customer to be called back.
- The Telephone column contains the telephone number on record for the customer.
- The Callback Phone column contains the alternate telephone number (e.g., cell phone) for the customer, if provided during original call.
- The Call Before Date column contains the date and time after which the customer does not wish to be called.
- The Callback Status column is a drop-down menu that lets you select the result of the call to the customer. This is the only editable field on the form. See Callback Status on page B-4 for status colors and descriptions.
Performing Callbacks

- The **Callback Date** column contains the date and time the callback was performed. This column is automatically populated when you change the Callback Status.

- The **Customer Type** column contains an indication of whether the customer is a critical customer (e.g., medical or key account).

- The **Priority** checkbox indicates whether or not the callback is associated with a priority call.

- The **Device** field in the Additional Customer Information panel displays the name of the selected customer's service device.

- The **Address** field displays the selected customer's service address.

- The **City** field displays the selected customer's city.

- The **Clues** field displays the trouble code clues received for the customer's call.

- The **Customer Comment** field displays the customer comments entered when the customer called, if any.

**Buttons**

- The **Save** button saves all callback status changes since the last save. This can be done after each callback (recommended), after every several callbacks, or just before exiting. There is also an option under the Perform Callback List window's File menu for this action.

- The **Cancel Callbacks** button allows you to cancel all of your remaining callbacks for the selected event and consider them complete.

- The **Exit** button closes the Perform Callback List window, returning you to the View My Callback Lists window. There is also an option under the Perform Callback List window's File menu for this action.

**Performing Assigned Callbacks for an Event**

Once you have been assigned a number of callbacks, you can begin completing them. To perform a callback, complete these steps:

1. Do one of the following:
   - Click the **View My Callback Lists** button on the toolbar, or
   - Select the **View My Callback Lists…** option from the Actions menu, or
   - Click the **View My Callback Lists…** button below the Callbacks Summary panel.

   The View My Callback Lists window opens, displaying all events with callbacks assigned to you.

2. Select a row for an event in the View My Callback Lists table and either:
   - Select the **Perform Callback List…** option from the Actions menu, or
   - Click the **Perform Callback List…** button.

   The Perform Callback List window opens displaying the details of the event and information for each customer to be called back.

3. Select a row for the callback you want to perform. At this time, you would physically make the call to the customer. Use the Callback Phone number if it exists. Otherwise use the number listed in the Telephone column.

4. Once the call is complete, change the Callback Status based on the result (e.g., restored).

5. Click the **Save** button.

6. Make any remaining callbacks and change the Callback Status accordingly. Make sure that you click the **Save** button before exiting if you aren't saving after each call.
Performing Callbacks

7. Click the Exit button when you have completed all of the callbacks.

Performing Unassigned Callbacks (Next Callback)

You can perform callbacks that are not assigned to any user using the Perform Next Callback window. This window allows you to select events from the main window and perform callbacks that have not yet been assigned to a user. The Perform Next Callback window displays the same information as the Perform Callback List window, just in a different order.

The callback that displays is automatically assigned to you so it cannot be assigned to anyone else. If you save a Callback Status of anything other than “Restored,” “Not Restored,” or “Cancel,” the callback is not considered complete and remains assigned to you. If you do not save a Callback Status, the callback will be unassigned when you exit the Perform Next Callback window. You can also continue to process unassigned callbacks for this event by clicking the Next Callback button.

This section includes the following topics:
• Using the Perform Next Callback Window
• Performing the Next Unassigned Callback for an Event

Using the Perform Next Callback Window

To access the Perform Next Callback window, select an event in the main Web Callbacks window that has unassigned callbacks remaining, and then do one of the following:
• Click the Perform Next Callback button on the toolbar, or
• Select the Perform Next Callback… option from the Actions menu, or
• Click Perform Next Callback… button beneath the Callbacks Summary panel.

The Perform Next Callback Window displays the following fields and buttons:
• The Event # field displays the event number for which callbacks are being performed.
• The Substation field displays the name of the substation associated with the event.
• The Zone field displays the name of the branch office associated with the event.
• The Device field displays the name of the device associated with the event.
• The Start Date field displays the date and time the event began.
• The Restore Date field displays the date and time the event was restored.
• The Operations Event Note field displays any comments entered for the event by operations staff.
• The # Callbacks field displays the total number of callbacks for the event.
• The # Remaining field displays the number of callbacks remaining for the event.
• The % Complete field displays the percentage of callbacks that are complete for the event.
• The Account # field displays the selected customer's account number.
• The Name field displays the name of the customer to be called back.
• The Address field displays the selected customer's service address.
• The City field displays the selected customer's city.
• The Customer Type field displays an indication of whether the customer is a critical customer (e.g., medical or key account).
• The Device field in the Customer Information panel displays the name of the selected customer's service device.
• The Clues field displays the trouble code clues received for the customer's call.
Performing Callbacks

- The **Customer Comment** field displays the customer comments entered when the customer called, if any.
- The **Priority** checkbox indicates whether or not the callback is associated with a priority call.
- The **Telephone** field displays the telephone number on record for the customer.
- The **Callback Phone** field displays the alternate telephone number (e.g., cell phone) for the customer, if provided during original call.
- The **Callback Status** column is a drop-down menu that lets you select the result of the call to the customer. See **Callback Status** on page B-4 for status colors and descriptions.
- The **Callback Date** column contains the date and time the callback was performed. This column is automatically populated when you change the Callback Status.

**Buttons**

- The **Next Callback** button populates the Perform Next Callback window with the next unassigned callback for this event, if any, and assigns the callback to you. There is also an option under the Perform Next Callback window’s Actions menu for this action.
- The **Save** button saves the result for this callback and enables the Next Callback button. There is also an option under the Perform Next Callback window’s File menu for this action.
- The **Exit** button closes the Perform Next Callback window. There is also an option under the Perform Next Callback window's File menu for this action.

**Performing the Next Unassigned Callback for an Event**

To perform the next unassigned callback for an event, complete these steps:

1. On the Web Callbacks main window, select an event that has unassigned callbacks remaining (# Asn column less than # Rem column).
2. Do one of the following:
   - Click the **Perform Next Callback** button on the toolbar, or
   - Select the **Perform Next Callback…** option from the Actions menu, or
   - Click the **Perform Next Callback…** button beneath the Callbacks Summary panel.
   If all callbacks for the selected event have been assigned, an error dialog displays.
3. Place the phone call to the customer, using the phone number listed in the Callback Phone field, if provided. Otherwise, use the number in the Telephone field.
4. When the call is complete, select the appropriate option from the Callback Status drop-down menu.
5. Click the **Save** button.
6. If there are unassigned callbacks remaining for the event and you want to perform them, click the **Next Callback** button and repeat the three previous steps.
7. Click the **Exit** button to close the Perform Next Callback window.

**Note:** The callback accessed from the Perform Next Callback window is assigned to you when the window opens to prevent another user from being assigned to it as well. If you save a result for the callback that does not actually complete it (e.g., Busy, No Answer) and then exit the Perform Next Callback window, it will remain assigned to you. If you exit the Perform Next Callback window without saving a result for the callback, the callback returns to being unassigned.
This chapter describes the Storm Management application. It includes the following topics:

• Getting Started with Storm Management
• Using the Storm Management Window
• Using Storm Management Modes
• Additional Storm Management User Types
• Understanding Storm Management Calculations

Getting Started with Storm Management

The Storm Management application enables you to manipulate the event and crew information that the system will use to make its calculations. This section describes the login, menus, toolbar, and status bar, and other common sections of the Storm Management window.

You will initially access Storm Management from a web browser, which will download the application to your computer. Subsequently, you may start it through a desktop shortcut, from your browser Favorites, or from your computer's Start menu.

Note: Many utilities have different rules sets configured for storms versus normal conditions, which will affect the operation of Storm Management. Changing rule sets is done using the Change Rule Set... button on the Authority window. For information on changing rule sets in the Operator's Workspace, see Changing Rule Sets on page 2-49. For information on changing rule sets in the Web Workspace, see Changing Rule Sets on page 7-41.

Login Window

The Login window is the first Storm Management window you see. You must enter a valid user name and password, and then click the Validate button. Once your user name and password are validated, the system populates the option menu that allows you to select a user type. You will see different initial windows and options depending upon the user type specified.

The Login window displays the following fields and buttons:

• The User ID field allows you to enter the user name provided to you by the system administrator.

• The Password field allows you to enter the password provided to you by the system administrator.
• The **Validate** button verifies your login credentials. If the user name and password are not entered correctly, the system displays a warning dialog box.

• The **User Type** drop-down menu contains the list of user types within your authority.

• The **Login** button allows you to complete the login process. Once you click the **Login** button, the appropriate Storm Management window opens, based upon the User Type selected.

• The **Quit** button exits the Login window.

### Logging In

To login to Storm Management, complete these steps:

1. Depending on how your system was installed, do one of the following:
   - Click the **Storm Management** icon found under the appropriate program group in your Windows Start Menu, or
   - Double click the **Storm Management** icon on your desktop, or
   - Open a web browser and type the Storm Management URL in the browser's Address field. The Storm Management Login window displays.

2. Enter your user name.

3. Enter your password.

4. Click the **Validate** button. The bottom portion of the Storm Management Login window sensitizes.

5. Select the appropriate **User Type** from the drop-down menu.

6. Click the **Login** button. The appropriate Storm Management window opens.

7. Click the **Login** button to finish logging in.

### Using the Storm Management Window

This section describes how to use the menus, toolbar, and status bar on the Storm Management window. It includes the following topics:

- **Menus**
- **Toolbar**
- **Status Bar**
- **Print Preview**
- **Zone Selection Panel**
- **Summary Information Panel**
- **Storm Report Panel**

Related Topics:

- **Using Storm Management Modes**
  - **Non-Storm Mode**
  - **Storm Mode**

- **Additional Storm Management User Types**
- **Understanding Storm Management Calculations**
Menus

There are four menus on the Storm Management menu bar: System, Storm, Crew, and Help.

- System Menu
- Storm Menu
- Crew Menu
- Help Menu

System Menu

The options in the System menu are available in both storm and non-storm modes. The following table describes the System Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Storm Mode..</td>
<td>Used to transition a control zone between the Storm Management non-storm and storm modes of operation. Opens the Define Storm dialog, prompting you to enter the information required to transition between modes. This option is not available in study mode.</td>
</tr>
<tr>
<td>Save Changes</td>
<td>Saves any changes made in the window outside of the Crew Information table.</td>
</tr>
<tr>
<td>ERT Override...</td>
<td>While it is periodically simulating the entire restoration process, Storm Management calculates an estimated assessment and restoration time for each eligible event. These estimates for each event are accessible to other modules (e.g., may be displayed in an Oracle Utilities Network Management System - Trouble Management/Web Trouble Work Agenda column and available in Oracle Utilities Network Management System - Web Call Entry). This option opens the ERT Override dialog, which allows the accessibility of the Storm Management estimates to other modules to be turned on and off at any control zone level, and also allows for an alternate “global” estimate to be applied at any control zone level instead.</td>
</tr>
<tr>
<td>Force Simulation Run</td>
<td>Immediately invokes the simulation of the entire restoration process, recalculating the estimates. This option is typically only used in study mode.</td>
</tr>
<tr>
<td>Retrieve Update</td>
<td>Refreshes the window with the most recent information from the system. In most cases, the window refreshes itself on a periodic basis. But, if there are unsaved changes in the Storm Management window at the time the automatic refresh is due to occur, the window will not refresh. Instead, an alert appears in the status bar indicating that an update is available, and the Retrieve Update option must be invoked in order to refresh the window with the new update. This allows you to continue making your changes and save them first before refreshing.</td>
</tr>
</tbody>
</table>
### Storm Menu

The options in the Storm menu are only enabled when Storm Management is in storm mode. The following table describes the Storm Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Study Mode</td>
<td>Toggles the Storm Management window between real-time and study modes of operation. The current mode is displayed in the status bar.</td>
</tr>
<tr>
<td>Export Study Session</td>
<td>When in study mode, allows you to export the current study session crews and parameters to the real-time session.</td>
</tr>
<tr>
<td>Reset Study Session</td>
<td>When in study mode, allows you to reset the current study session with the current real-time session crews and parameters.</td>
</tr>
<tr>
<td>Forecast Profiles…</td>
<td>Opens the Forecast Profiles dialog, which is used to save and pre-load outage forecasting parameters. This option is only available in storm mode at the simulation level.</td>
</tr>
<tr>
<td>Calculate Crews…</td>
<td>Opens the Calculate Crews dialog, which is used to determine the approximate number of crews needed to complete assessment and repair by a specified date and time.</td>
</tr>
</tbody>
</table>

### Crew Menu

The options in the Crew menu are only enabled when Storm Management is in storm mode. The following table describes the Crew Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Crew…</td>
<td>Opens the Add Crew Group dialog, which enables you to define new crew groups for the Crew Information table. See Adding Crew Groups on page 10-28 for more information.</td>
</tr>
<tr>
<td>Edit Crew…</td>
<td>Opens the Edit Crew Group dialog, which enables you to change crew data for a selected crew group in the Crew Information table. See Editing Crew Groups on page 10-30 for more information.</td>
</tr>
<tr>
<td>Delete Crew</td>
<td>Removes the selected crew group from the Crew Information table. A warning dialog opens, prompting you for confirmation before deleting.</td>
</tr>
</tbody>
</table>
### Help Menu

The options in the Help menu are available at all times. The following table describes the Help Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Storm Management</td>
<td>Opens a dialog that displays information regarding what version of the application is presently running, as well as version and other information about the Oracle Utilities Network Management System Web Gateway that the application is using.</td>
</tr>
</tbody>
</table>

### Toolbar

The Storm Management toolbar provides a shortcut to many of the options available from the Storm Management menus. The following table describes the buttons on the Storm Management Toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Storm Mode</td>
<td>Used to transition a control zone between the Storm Management non-storm and storm modes of operation. Opens the Define Storm dialog, prompting you to enter the information required to transition between modes. This option is not available in study mode.</td>
</tr>
<tr>
<td>Save Changes</td>
<td>Saves any changes made in the window outside of the Crew Information table.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ERT Override</td>
<td>While it is periodically simulating the entire restoration process, Storm Management calculates an estimated assessment and restoration time for each eligible event. These estimates for each event are accessible to other modules (e.g., may be displayed in a Work Agenda column). This option opens the ERT Override dialog, which allows the accessibility of the Storm Management estimates to other modules to be turned on and off at any control zone level, and also allows for an alternate “global” estimate to be applied at any control zone level instead.</td>
</tr>
<tr>
<td>Force Simulation Run</td>
<td>Immediately invokes the simulation of the entire restoration process, recalculating the estimates. This option is typically only used in study mode.</td>
</tr>
<tr>
<td>Retrieve Update</td>
<td>Refreshes the window with the most recent information from the system. In most cases, the window refreshes itself on a periodic basis. But, if there are unsaved changes in the Storm Management window at the time the automatic refresh is due to occur, the window will not refresh. Instead, an alert appears in the status bar indicating that an update is available, and the Retrieve Update option must be invoked in order to refresh the window with the new update. This allows you to continue on with your changes and save them first before refreshing.</td>
</tr>
<tr>
<td>Toggle Study Mode</td>
<td>Toggles the Storm Management window between real-time and study modes of operation. The current mode is displayed in the status bar. This option is only available in storm mode.</td>
</tr>
<tr>
<td>Export Study Session</td>
<td>When in study mode, allows you to export the current study session crews and parameters to the real-time session.</td>
</tr>
<tr>
<td>Reset Study Session</td>
<td>When in study mode, allows you to reset the current study session with the current real-time session crews and parameters.</td>
</tr>
<tr>
<td>Forecast Profiles</td>
<td>Opens the Forecast Profiles dialog, which is used to save and pre-load outage forecasting parameters. This option is only available in storm mode at the simulation level.</td>
</tr>
<tr>
<td>Calculate Crews</td>
<td>Opens the Calculate Crews dialog box, which is used to determine the approximate number of crews needed to complete assessment and repair by a specified date. This option is only available in storm mode.</td>
</tr>
<tr>
<td>Add Crew</td>
<td>Opens the Add Crew Group dialog box, which lets you define new crew groups for the Crew Information table. This option is only available in storm mode.</td>
</tr>
<tr>
<td>Edit Crew</td>
<td>Opens the Edit Crew Group dialog box, which lets you change crew data for a selected crew group in the Crew Information table. This option is only available in storm mode.</td>
</tr>
</tbody>
</table>
Using the Storm Management Window

Status Bar

The status bar appears at the bottom of the Storm Management window, providing operating details for the system. The status bar displays the following fields:

- **Last Update** field displays a timestamp indicating the date and time at which the most recent estimates were calculated.
- **New Upd** field is an indicator that appears when there are unsaved changes at the time the automatic refresh of the Storm Management window is due to occur. The refresh does not occur until you click the Retrieve Update button on the toolbar or select the Retrieve Update option from the System menu. This field is blank at all other times.
- **Real-Time/Study Mode** field displays STUDY MODE in gray when the currently selected control zone is in the Storm Management study mode of operation and REAL-TIME MODE in red when the zone is in real-time mode.
- **Storm/Non-Storm Mode** field displays NON-STORM MODE in gray when the currently selected control zone is in the Storm Management non-storm mode of operation and STORM MODE in orange when the currently selected zone is in the Storm Management storm mode of operation.
- **ERT Override** field indicates whether any control zone in the system presently has its Storm Management estimates accessible to other modules (e.g., may be displayed in an Oracle Utilities Network Management System Trouble Management/Web Trouble Work Agenda column and available in Oracle Utilities Network Management System Web Call Entry) or overridden by an alternate estimate. If they are not accessible, or if they are overridden, this field displays ON. If not, this field displays OFF.
- **Lookups** field indicated the historical lookup value Shift, Season, and Day Type attributes that apply to the current time.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Crew</td>
<td>Removes the selected crew group from the Crew Information table. A warning dialog box opens, prompting you for confirmation before deleting. This option is only available in storm mode.</td>
</tr>
<tr>
<td>Move Crew</td>
<td>Opens the Move Crew Group dialog box, used to transfer crews from the selected crew group in the Crew Information table to another control zone. This option is only available in storm mode.</td>
</tr>
<tr>
<td>Apply Crew Changes</td>
<td>Saves changes made in the Crew Information table. Unapplied changes in the Crew Information table are highlighted in different colors. This option is only available in storm mode.</td>
</tr>
<tr>
<td>Import Crews</td>
<td>Opens the Import Crews dialog box. In real-time mode, this dialog box enables you to import crews from Oracle Utilities Network Management System into the Crew Information table. In study mode, it additionally enables you to import crew group information from the real-time session or the applied manual override or outage forecasting parameters from the real-time session into study mode. This option is only available in storm mode.</td>
</tr>
</tbody>
</table>
Print Preview

The Print Preview dialog appears whenever one of the printing options is selected in Storm Management.

The following table describes the buttons on the Print Preview dialog.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous Page</td>
<td>Used to traverse the preview to the previous page in a multi-page output.</td>
</tr>
<tr>
<td>Next Page</td>
<td>Used to traverse the preview to the next page in a multi-page output.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Used to zoom out on the contents of the preview.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Used to zoom in on the contents of the preview.</td>
</tr>
<tr>
<td>Scale Out</td>
<td>Used to scale out the font used for the print output.</td>
</tr>
<tr>
<td>Scale In</td>
<td>Used to scale in the font used for the print output.</td>
</tr>
<tr>
<td>Toggle Orientation</td>
<td>Toggles the page orientation of the output between portrait and landscape.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Brings up the Page Setup dialog, which allows you to select paper size and source, set page orientation, set margins, and select the printer.</td>
</tr>
<tr>
<td>Reset to Default Setting</td>
<td>Reverts the preview window back to its default settings.</td>
</tr>
<tr>
<td>Print</td>
<td>Sends the print output to your selected printer, and then closes the Print Preview dialog.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Print Preview dialog without printing any output.</td>
</tr>
</tbody>
</table>
Setting Margins
You can use the Print Preview dialog to set the margins of the output interactively. Follow these steps:

1. Position your cursor over the preview output until you see a red outline and your cursor becomes a double-headed arrow.
2. While the cursor is a double-headed arrow, click and hold your left mouse button and drag the red line to the desired location.

Zone Selection Panel
The Storm Management window information is displayed on a per control zone basis, supporting views for the top three levels of the control zone hierarchy in the operations model. The top-level (usually the “Company” level) control zone view displays when Storm Management starts up. The Zone Selection tree in the upper left hand corner of the window lists all of the available zones for selection.

Selecting the Control Zone to View
You can view the information for another control zone by selecting that zone in the Zone Selection tree. The data displayed applies to the selected zone and all of its children. However, some components may be disabled if the currently selected control zone is not at the simulation level.

Resizing the Zone Selection Panel
You can resize the Zone Selection panel by dragging the right side of the panel to the left or right.

Summary Information Panel
The Storm Management Summary Information panel, located in the upper right corner of the window, provides an overview of the estimates for both the selected zone and the Company level zone. Each time you select a different control zone from the Zone Selection tree, the Summary Information Panel refreshes to display the information for the newly selected zone. (If you select the Company level zone, the Summary Information table contains only the one row of Company information.)

The Summary Information Panel displays the following fields:

- The **Zone** column contains the name of the Company level zone and the currently selected zone.
- The **Est Assessed By** column contains the estimated date and time when all assessment within the control zone will be complete.
- The **Est Restored By** column contains the estimated date and time when all events within the control zone will be restored.
• The ERT Override field displays the alternate estimated restoration time, if a published or non-published control-zone wide alternate estimate is currently being applied to the selected zone. See ERT Override Dialog on page 10-12 for more information.

Storm Report Panel

The Storm Management Storm Report is the main panel on the Storm Management window. It provides an overview of the historical averages, actual averages, and estimates for each outage type in the currently selected control zone. Each time you select a different control zone from the Zone Selection tree, the Storm Report Panel refreshes to display the information for the newly selected zone.

The Storm Report Panel displays the following columns:

• The Outage Types column contains the name of the Storm Management outage type category.

• The Actual Outages column contains the actual number of unrestored events of the corresponding outage type in the currently selected control zone.

• The Total Outages column contains the total number of forecasted outages of the corresponding outage type in the currently selected control zone. If the currently selected control zone is operating storm mode, this value may be assigned or calculated as a percentage of the Actual Outages column using the Storm Management outage forecasting functionality. If the currently selected control zone is operating in non-storm mode, the value of this column is equal to the value of the Actual Outages column, because the outage forecasting functionality is not available in non-storm mode.

• The Travel to Assess column contains the average number of minutes between dispatch of an assessment crew and the arrival of that crew on the job site. The number outside of the parentheses is the historical average used in the Storm Management estimate calculations. The number in parentheses is the actual average that has been occurring out in the field over the past 2 hours.

• The Assess column contains the average number of minutes taken to assess the effort needed to restore/repair the event. The number outside of the parentheses is the historical average used in the Storm Management estimate calculations. The number in parentheses is the actual average that has been occurring out in the field over the past 2 hours.

• The Travel to Repair column contains the average number of minutes between dispatch of the repair crew and the arrival of that crew on the job site. The number outside of the parentheses is the historical average used in the Storm Management estimate calculations. The number in parentheses is the actual average that has been occurring out in the field over the past 2 hours.

• The Repair column contains the average number of minutes taken to restore/repair the event. The number outside of the parentheses is the historical average used in the Storm Management estimate calculations. The number in parentheses is the actual average that has been occurring out in the field over the past 2 hours.

• The Clean column contains the average number of minutes taken to by the repair crew to clean up after the event is restored before going to the next job. The number outside of the parentheses is the historical average used in the Storm Management estimate calculations. The number in parentheses is the actual average that has been occurring out in the field over the past 2 hours.

• The Total Time to Assess hrs:min column contains the raw amount of time required to assess all outages of the corresponding outage type in the currently selected control zone, in hours and minutes. The very basic formula for calculating this value is the following: (Travel to Assess + Assess) * number of Actual Outages. However, if any outage forecasting or manual overrides are currently applied, or if the simulation has any of the outages projected to be assessed at a time that would use a different Travel to Assess or Assess time other than
what's currently displayed in the Storm Management window, then that basic formula no longer holds.

- The **Estimated Assessed By** column contains the estimated date and time at which the last of all outages with the corresponding outage type in the currently selected control zone will be assessed.

- The **Total Time to Restore hrs:min** column contains the raw amount of time required to repair all events of the corresponding outage type in the currently selected control zone, in hours and minutes. The very basic formula for calculating this value is the following: 
  \[(\text{Travel to Repair} + \text{Repair}) \times \text{number of Actual Outages in non-storm mode}, \text{or } (\text{Travel to Repair} + \text{Repair} + \text{Clean}) \times \text{number of Actual Outages in storm mode} \]. However, if any outage forecasting or manual overrides are currently applied, or if the simulation has any of the outages projected to be repaired at a time that would use a different Travel to Repair or Repair or Clean time other than what's currently displayed in the Storm Management window, then that basic formula no longer holds.

- The **Estimated Restored By** column contains the estimated date and time at which the last of all outages with the corresponding outage type in the currently selected control zone will be restored.

- The **Forecast Mode** drop-down menu enables you to select what kind of outage forecasting you want to apply. This field is only enabled when the currently selected control zone is one at the simulation level operating under storm mode. List options include:
  - **% Change** - Allows the % Change cell beneath the Actual Outages column to become editable, enabling you enter a percentage greater than 100. This increases the value in the Total Outages column for each outage type by that percentage.
  - **Value** - Allows the Total Outages cell for each outage type row to become editable. It also disables the % Change cell under the Actual Outages column.

### Using Storm Management Modes

Storm Management has three modes of operation: Non-storm, Storm, and Study. Non-storm mode applies to everyday operations. Storm mode is useful during and after a storm or other high volume outage period. In this mode, the estimate calculations factor in crew availability. Study mode enables you to manipulate parameters that affect the estimate calculations, such as outage forecasting, manual overrides and crew information without altering the current real-time calculations. Also, once in study mode, the user can export parameters from the study session back into the real-time session. This section provides details on how to use the following Storm Management modes to analyze and manipulate its output:

- **Non-Storm Mode**
- **Storm Mode**
- **Study Mode**
Non-Storm Mode

Non-storm mode applies to everyday operations. When calculating estimates, crew resources are not taken into account because it is assumed there are enough crews available to handle all events. All control zone views operate in non-storm mode until explicitly placed into storm mode.

This section includes the following topics:

• Using ERT Overrides
• Manual Overrides

Using ERT Overrides

While it is periodically simulating the entire restoration process, Storm Management calculates an estimated assessment and restoration time for each eligible event. These estimates for each event are accessible to other modules (e.g., may be displayed in an Oracle Utilities Network Management System – Trouble Management/Web Trouble Work Agenda column). However, it is not always prudent to have these estimates available to these other modules. For example, when you initially enter storm mode and the available crew resources have not been fully defined, the calculated estimates would be rather inaccurate.

This section includes the following topics:

• ERT Override Dialog
• Turning Off Accessibility of the Estimates
• Overriding the Estimates
• Changing Publish/Non-Publish or Default ERT Information
• Turning Accessibility of Projections Back On/Removing Overrides
• Printing ERT Overrides

ERT Override Dialog

You can turn off the accessibility of Storm Management estimates to other modules by using the ERT Override dialog. To open the ERT Override dialog, do one of the following:

• Select the ERT Override... option from the System menu, or
• Click the ERT Override button on the toolbar.

The ERT Override dialog can also export a “global” estimated restoration time for all events at any control zone level.

The ERT Override dialog contains the following fields and buttons:

• The Zone column contains the control zone that is having its Storm Management calculated estimates made inaccessible or overridden. Once you click in the Zone column, a button displays. This button opens the Control Zone Selection dialog.

• The ERT Override column contains the estimated restoration date and time for all events within the control zone to be displayed outside of Storm Management. Once you click in the ERT Override column, a button displays. This button opens a calendar that enables you select a date and time. The date/time you enter must be in the future. This field may be left blank.

• The Publish Projections column contains a checkbox that indicates whether or not the ERT Override value is published to other modules for the affected events.

• The User column displays the id of the user who provided the ERT override/delay value.

• The Add button adds a new default row to the table in the ERT Override dialog. That default row may then be edited to contain the desired control zone, ERT Override date/time, and
publish values. If a row marked for removal is selected, pressing the Add button will undo the removal mark. New, unsaved rows display in the table as green. Edited, unsaved rows display in the table as cyan.

- The **Remove** button marks the selected row for removal from the table in the ERT Override dialog. Rows marked for removal display in the table as red.
- The **OK** button applies the specified overrides to any newly added or modified row’s respective control zones, and any rows marked for removal will have all overrides removed from their respective control zones. If the ERT Override table contains more than one row for the same zone, an error dialog will appear and no changes will be saved.
- The **Print…** button brings up the Print Preview dialog, which allows you to print out the contents of the ERT Override dialog.
- The **Cancel** button closes the dialog without saving changes, and leaves the accessibility/overrides of the Storm Management estimates as they were.
- The **Refresh** button repopulates the ERT Override dialog with the latest information from the server. A confirmation dialog will open if there are unsaved changes.

**Note:** Applying overrides to the Storm Management estimates has no effect on events that have a crew onsite or events that have had an ERT manually entered in Oracle Utilities Network Management System. Those events will retain the display of their present manually entered/Storm Management ERT.

The following table describes what occurs when different combinations of ERT Override column and Publish Projections column values are applied.

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
</table>
| The Publish Projections checkbox is checked and you enter a date and time in the ERT Override column for that row… | All events in that control zone will receive that date and time as their default ERT value outside of Storm Management:  
The ERT Override value displays in the ERT Override field of the Summary Information table along with the word “Published”.  
The ERT Override value displays for current outages in that control zone in other modules.  
New outages in that control zone receive the ERT Override value until you turn the override of the Storm Management estimates off. |
| The Publish Projections checkbox is checked and you did not enter a date and time in the ERT Override column for that row… | Publishing an empty ERT Override value is not a supported operation. Such entries will not be saved. Correct way to hide ERT values is to uncheck Publish Projections checkbox. |
| If the Publish Projections checkbox is not checked and a date and time are entered in the ERT Override column for that row… | All events in that control zone will receive a blank value as their default ERT value outside of Storm Management, regardless of whether or not a date and time is entered in the ERT Override column for that row; current and new events display a blank ERT value in other modules until you turn the override of the Storm Management estimates off:  
The ERT Override value displays in the ERT Override field of the Summary Information table along with the word “Non-Published”. |
### Turning Off Accessibility of the Estimates

To turn the accessibility of the estimates off, complete these steps:

1. Do one of the following:
   - Click the **ERT Override** button on the toolbar, or
   - Select the ERT Override option from the System menu. The ERT Override dialog opens.
2. Click the **Add** button to add a new row to the ERT Override table.
3. Click into the Zone cell of the new row, and then click the button on the right of the Zone field.
   - The Control Zone Selection dialog opens.
4. Select the control zone whose estimates you wish to make inaccessible.
5. Click **OK**.
   - The Control Zone Selection dialog closes.
   - The zone you selected populates the Zone field.
7. Click **OK**. Storm Management's calculated estimates for that control zone are no longer accessible to other Oracle Utilities Network Management System windows and the ERT Override dialog closes.

### Overriding the Estimates

To override the estimates to a default “global” ERT for the events in a zone, complete these steps:

1. Do one of the following:
   - Click the **ERT Override** button on the toolbar, or
   - Select the ERT Override option from the System menu. The ERT Override dialog opens.
2. Press the **Add** button to add a new row to the ERT Override table.
3. Click into the Zone cell of the new row, and then click the button on the right of the Zone field.
   - The Control Zone Selection dialog opens.
4. Select the control zone whose estimates you wish to make inaccessible and click **OK**.
   - The Control Zone Selection dialog closes.

---

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the Publish Projections checkbox is not checked and a date and time are not provided in the ERT Override column for that row...</td>
<td>All events in that control zone will receive a blank value as their default ERT value outside of Storm Management, regardless of whether or not a date and time is entered in the ERT Override column for that row; current and new events display a blank ERT value in other modules until you turn the override of the Storm Management estimates off: The ERT Override field in the Summary Information panel contains the word “Non-Published”.</td>
</tr>
</tbody>
</table>
The zone you selected populates the Zone field.

5. Click into the ERT Override cell of the new row, and then click on the Calendar button.

6. Select a date and time for the new default ERT. Click OK on the Calendar dialog to close it.

7. Click out of the ERT Override cell and into a different cell to ensure the ERT Override time is saved.

8. Make sure the Publish Projections checkbox is checked.

9. Click OK. Storm Management’s calculated estimates for that control zone are no longer displayed to other modules; the provided ERT Override value is displayed instead. The ERT Override dialog closes.

Changing Publish/Non-Publish or Default ERT Information

If you have the accessibility of the Storm Management estimates turned off, you can revise the default ERT, or you can change from publishing the default ERT to not publishing it or vice versa, without having to first turn the accessibility back on. To do this, complete these steps:

1. Do one of the following:
   - Click the ERT Override button on the toolbar, or
   - Select ERT Override... option from the System menu. The ERT Override dialog opens.

2. If you want to update the ERT Override for a zone, click into the ERT Override cell of the applicable row, click on the Calendar button.

3. Select a date and time, then click OK.

4. Click out of the ERT Override cell and into a different cell to ensure the ERT Override time is saved.

5. Check or uncheck the Publish Projections checkbox for the applicable row.

6. Click OK. The following occurs:
   - The ERT Override dialog closes.
   - The default ERT is published and/or revised if the Publish Projections checkbox was checked, or
   - The default ERT is not published if the Publish Projections checkbox was not checked.

Turning Accessibility of Projections Back On/Removing Overrides

To turn the accessibility of the Storm Management estimates back on and/or remove ERT Overrides, complete these steps:

1. Do one of the following:
   - Click the ERT Override button on the toolbar, or
   - Select the ERT Override... option from the System menu. The ERT Override dialog opens.

2. Select the row that corresponds to the zone for which you want to turn the accessibility of estimates back on/remove the applied ERT Override.

3. Press the <Esc> key on your keyboard.

4. Click Remove.

5. Repeat previous steps as needed.

6. Click OK. The following occurs:
   - All eligible events immediately receive the most recently calculated Storm Management estimates.
If all rows have been removed from the ERT Override table, the status bar indicates ERT Override is off.

### Printing ERT Overrides
To print the contents of the ERT Override dialog, complete these steps:

1. Do one of the following:
   - Click the **ERT Override** button on the toolbar, or
   - Select the **ERT Override...** option from the System menu. The ERT Override dialog opens.
2. Click the **Print...** button. The Print Preview dialog opens.
3. Adjust the scale, orientation, and page setup as desired.
4. Click the **Print** button on the toolbar to print the page(s). The Print Preview dialog disappears and the print output appears at your selected printer.

### Manual Overrides
It may occur that the actual averages are significantly different from the historical averages. The % Change row of the Storm Report lets you temporarily manually override each category of the historical averages. The percentage you enter changes the lookup values used in the calculation of the estimates. This functionality is only available when the currently selected control zone is at the simulation level.

#### Overriding Historical Averages
To override the historical averages, complete these steps:

1. Make sure the currently selected control zone is at the simulation level.
2. Click in the cell of the % Change row for the column of the corresponding historical average category you want to change.
3. Revise the percentage in the cell to the value you want to use.
4. Click **Enter**.
5. Click the **Save** button on the toolbar or select Save from the System menu. The historical averages in the column immediately update to reflect the change.

Storm Management will use the modified values when recalculating estimates during the next scheduled simulation iteration. The modified values stay in place until you manually change the % Change row back to 100% or, if applied during storm mode, you exit storm mode. The historical averages are not changed in the database.

### Storm Mode
Storm mode is useful during and after a storm or other high volume outage period. In this mode, the estimate calculations factor in crew availability.

Once a crew arrives onsite at an event, the Storm Management estimate calculation will then use the actual crew arrival time rather than the projected arrival time. The estimate calculation can adjust again when a crew reports an estimated repair time based upon observed field conditions.

This section includes the following topics:

- **Entering Storm Mode**
- **Using Define Storm Dialog**
- **Placing a Control Zone in Storm Mode and Defining the Storm Information**
• Joining Existing Storms
• Joining a Control Zone to an Existing Storm
• Viewing Storm Information
• Changing Storm Levels
• Changing Storm Types
• Forecasting Outages
• Using Forecast Profiles
• Working with Crew Information
• Exiting Storm Mode

**Entering Storm Mode**

To enter storm mode for a control zone, complete these steps:

1. Do one of the following:
   • Select **Toggle Storm Mode** from the System menu, or
   • Click the **Toggle Storm Mode** button on the toolbar.

   The Define Storm dialog opens. Enter the storm data.

2. Click the **Ok** button.

   **Note:** You can only enter storm mode from real-time mode. Once in storm mode, you can switch to study mode.

**Using Define Storm Dialog**

The Define Storm dialog opens once you toggle to storm mode. You must enter information about the storm before Storm Management will change modes. The information you provide here is used to populate parts of the Storm Information section of the window.

The Define Storm dialog displays the following fields and buttons:

• The **Zone** field displays the Name of the currently selected zone. This control zone and all of its children that aren't already in storm mode will be placed into storm mode as a part of this storm. This field is not editable.

• The **Storm Name** field allows you to enter the name of the storm. This value is used in conjunction with the current date as the unique identifier of the storm. If this field is not populated when you click the **Ok** button, an error appears. Click **Ok** to close the message and correct the error.

• **Special Condition** is a drop-down menu of storm types that indicate a pre-defined condition existing with the storm. This condition may also dictate a different set of historical average values be used in the estimate calculations made by the system.

• **Storm Level** is a drop-down menu of severity levels for the storm. This value is recorded for information and reporting purposes only and has no effect on the estimate calculations.

• **Start Date** is the date and time at which the storm started. When you uncheck the “Use current time” option, the button on the right of this field opens a calendar that enables you to select the date and time. Valid dates and times are those prior to (and including) the current time. If your entry is invalid, an error message appears. Click **Ok** to close the message and correct the error.

• The **Use Current Time** checkbox is selected by default. This option allows you to leave the Start Date field blank and have the current system time on the server be used as the Start
Placing a Control Zone in Storm Mode and Defining the Storm Information

To place a control zone in storm mode and define the storm information, complete these steps:

1. Make sure the desired control zone is selected in the Zone Selection panel, and that the zone is in non-storm mode.

2. Do one of the following:
   - Select the Toggle Storm Mode option from the System menu, or
   - Click the **Toggle Storm Mode** button on the toolbar. The Define Storm dialog opens.

3. Provide information in the Storm Name field.

4. Select a Special Condition from the drop-down list, if desired.

5. Select a Storm Level from the drop-down list, if desired.

6. Select a date and time for the storm’s Start Date. Either:
   - Leave the Use Current Time option checked.
   - Uncheck the Use Current Time option. Click the Start Date calendar button and select a date and time for the storm’s start date. Click **OK**. The calendar closes, and the selected date and time populate the Start Date field.

7. In the Define Storm dialog, click **Ok**. The following occurs:
   - The Storm Information panel appears in between the Zone Selection and Summary Information panels. The Crew Information panel appears below the Zone Selection and Storm Report panels.
   - Storm Management operates in storm mode for the selected control zone.
   - If the selected control zone has any child zones not already operating in storm mode, the child zones operate in storm mode as part of this same storm.

   **Note:** If your system has a control zone set up directly beneath the top-level control zone to contain all of the fuzzy events in the system, that fuzzy control zone cannot be placed into storm mode. That fuzzy zone will only go into storm mode when its parent zone is placed into storm mode.

Joining Existing Storms

If you try to place a control zone into storm mode and either: 1) there are other control zones at the same level that are already operating in storm mode, or 2) the selected zone has children that are currently operating in storm mode, then the Define Storm dialog opens with a Join Existing Storm panel. This panel gives you the option of adding the currently selected control zone to an existing storm rather than creating a separate new one.

The Join Existing Storm panel lists the existing storms that the selected control zone can be added to. When you select a storm from the list, the Storm Details section of the dialog populates with the information that pertains to the selected storm, and then the only editable field is the Start Date.
The Join Existing Storm panel displays the following buttons:

- The **Clear Selection** button deselects the storm in the list and reverts the fields of the Storm Details section back to their default, editable values. This button is only enabled when an existing storm is selected from the list.

- The **Ok** button saves the entered storm information and closes the dialog. Storm Management is now operating in storm mode for the corresponding control zone(s).

- The **Cancel** button discards the entered storm information and closes the dialog without switching the currently selected control zone into storm mode.

## Joining a Control Zone to an Existing Storm

To join a control zone to an existing storm, complete these steps:

1. Make sure the desired control zone is selected in the Zone Selection tree, and that the zone is in non-storm mode.

2. Do one of the following:
   - Select the Toggle Storm Mode option from the System menu, or
   - Click the **Toggle Storm Mode** button on the toolbar. The Define Storm dialog opens with the Join Existing Storm panel displayed.

3. In the Join Existing Storm panel, select the storm you want the selected zone to join.

4. Select a date and time for the storm’s start date using one of the methods below:
   - Leave the Use Current Time option checked. The current system time on the server will be used as the Start Date of the storm in this control zone.
   - Uncheck the Use Current Time option. The Start Date of the storm you selected to join will be used as the Start Date of the storm in this control zone, unless you explicitly edit it.
   - To then edit the Start Date, click on the Start Date calendar button and select a date and time for the storm’s start date. Click **OK**. The calendar closes, and the selected date and time populate the Start Date field.

5. In the Define Storm dialog, click **Ok**. The following occurs:
   - The Storm Information panel appears in between the Zone Selection and Summary Information panels. The Crew Information panel appears below the Zone Selection and Storm Report panels.
   - Storm Management operates in storm mode for the selected control zone.
   - If the selected control zone has any child zones not already operating in storm mode, the child zones operate in storm mode as part of this same storm.

   **Note:** If all of the children of a zone are eventually placed under the same storm individually with the Join Existing Storm panel, the parent zone is automatically placed into storm mode when the last child zone is joined to that storm. The parent zone adopts the earliest Start Date of all of its children.

## Viewing Storm Information

Once in storm mode, the Storm Information panel is visible. The Storm Information panel (located between the Zone Selection panel and the Summary Information panel) displays most of the data provided when you entered into the Define Storm dialog when you placed the zone into storm mode.
The Storm Information Panel displays the following fields:

- The **Storm Name** field displays the name of the storm. This field is not editable and is populated by information entered into the Storm Name field of the Define Storm dialog.

- The **Storm Start** field displays the starting date of the storm. This field is not editable and is populated by information entered into the Start Date field of the Define Storm dialog.

- **Storm Level** is a drop-down menu of severity levels of the storm. It is initially populated by the option selected on the Storm Level drop-down menu of the Define Storm dialog. If you modify the Storm Level for a control zone that has child zones as part of the same storm, the Storm Level for all of those child zones will be changed to the modified value as well.

- **Special Condition** is a drop-down menu of special storm types. It is initially populated by the option selected on the Special Condition drop-down menu of the Define Storm dialog. If you modify the Special Condition for a control zone that has child zones as part of the same storm, the Special Condition for all of those child zones will be changed to the modified value as well.

### Changing Storm Levels

The Storm Level value is recorded for information and reporting purposes only and has no effect on the estimate calculations.

To change the Storm Level selection, complete these steps:

1. Make sure the currently selected control zone is at the simulation level and operating in storm mode.
2. In the Storm Information panel, select the new storm type from the Storm Level drop-down menu.
3. Click the Save Changes button or select Save Changes from the System menu.
   - Any child zones of the currently selected zone that are also part of this same storm will receive the new storm level as well.

### Changing Storm Types

The storm type listed in the Special Condition drop-down menu is linked to a specific set of historical average values. If the characteristics of a zone’s storm change, you can change the Special Condition value and have the system use a new set of historical average values in its estimate calculations for that zone.

To change the Special Condition storm type, complete these steps:

1. Make sure the currently selected control zone is at the simulation level and operating in storm mode.
2. In the Storm Information panel, select the new storm type from the Special Condition drop-down menu.
3. Click the Save Changes button or select Save Changes from the System menu.
   - The Storm Report panel immediately repopulates with the historical averages for the new storm type.
   - Any child zones of the currently selected zone that are also part of this same storm will receive the new storm type as well.
   - Storm Management will use the historical average values that apply to the new storm type when recalculating estimates for events in that control zone, as well as its child zones that belong to the same storm, during the next scheduled simulation iteration.
Example of Changing Storm Types
For example, the Branch level of the control zone hierarchy is the simulation level. A Wind/Rain storm was defined for the Stark branch zones, which includes the Lake, Alliance, and Massillon zones. However, the temperature in the Alliance zone was cold enough for ice to form. The Special Condition in the Stark zone is set to Wind/Rain storm, so estimates being calculated for Alliance could be inaccurate due to the increased travel time involved in the icy conditions observed there.

If you change Special Condition in the Alliance zone to Ice, the historical value averages in the Storm Report repopulate with values appropriate for an ice storm. When the next scheduled simulation iteration occurs, the events in the Alliance zone receive estimates calculated using the historical averages for Ice, while the events in all other control zones in the Stark region continue to receive estimates calculated using the historical averages for Wind/Rain.

Forecasting Outages
Outage forecasting takes into account future storm load. It provides more accurate estimated restoration projections in the early stages of a storm by simulating the expected impact of the storm. Outage forecasting can be performed in a control zone at the simulation level currently operating storm mode.

Forecasting Outages by Percentage
To perform outage forecasting by percentage, complete these steps:

1. Make sure the Forecast Mode field in the Storm Report panel is set to % Change, and the current control zone is at the simulation level.
2. Click in the % Change cell beneath the Actual Outages column.
3. Revise the percentage in the cell to the value you want to use. This value must be greater than or equal to 100%.
4. Press Enter.
5. Click the Save Changes button on the toolbar or select Save Changes from the System menu. The following occurs:
   - The value in the Actual Outages column for each outage category is multiplied by the percentage in the % Change row and the result is displayed in the Total Outages column for each outage type. If any outage type currently has an Actual Outages value of 0, then 0 will remain displayed in the Total Outages column until at least one event of that outage type appears.
   - New outages that enter the system reflect the forecasting percentage and update the Total Outages column accordingly.
   - During the next scheduled simulation, the Storm Management estimates calculation takes into account the increased outage percentage. The modified percentage stays in place until the value in the % Change row is changed back to 100 or until storm mode is exited for the control zone.

Forecasting Outages by Value
The Total Outages column of the Storm Report is a calculated column containing the number of total forecasted outages for each outage type. When the currently selected control zone is at the simulation level and operating in storm mode, you can override the value of this column by editing individual cells within the column.

To perform outage forecasting by value, complete these steps:

1. Make sure the Forecast Mode field is set to Value and the current control zone is at the simulation level.
2. Click in the cell beneath the Total Outages column for the Outage Type whose value you wish to forecast.

3. Enter the new value.

4. Click Enter.

5. Click the Save Changes button on the toolbar or select Save Changes from the System menu. The following occurs:
   - The Total cell value beneath the Total Outages column updates to reflect the new sum using the modified forecast values.
   - During the next scheduled simulation, the Storm Management estimates calculation takes into account the increased number of outages.
   - As new outages enter the system, the Total Outages column stays the same until the number of Actual Outages for an outage type exceeds the number of total outages. Once that occurs, Value forecasting is no longer applied to that outage type.

   **Note**: If you enter an invalid value into the Total Outages column, the cell reverts to its previous value when the Save button is pressed.

### Using Forecast Profiles

You may want to define and save one or more outage forecasting profiles to be used for analysis and resource planning prior to a storm’s occurrence. You can create, edit, delete, and apply forecasting profiles by using the Forecast Profiles window.

This section includes the following topics:

- Forecast Profiles Window
- Adding a Profile
- Editing a Profile
- Removing a Profile
- Applying a Profile
- Printing Forecast Profiles

#### Forecast Profiles Window

To open the Forecast Profiles window, complete these steps:

1. Make sure the currently selected control zone is at the simulation level.

2. Do one of the following:
   - Select the **Forecast Profiles**… option from the System menu, or
   - Click the **Forecast Profiles** on the toolbar.

The Forecast Profiles window displays the following fields and buttons:

- The **Add Profile** button adds a new default row to the table in the Forecast Profiles dialog. That default row may then be edited to contain the desired profile name and outage type values. If a row marked for removal is selected, pressing the Add Profile button will undo the removal mark. New, unsaved rows display in the table as green. Edited, unsaved rows display in the table as cyan.

- The **Remove Profile** button marks the selected row for removal from the table in the Forecast Profiles window. Rows marked for removal display in the table as red.

- The **Save Profiles** button saves any new or modified profiles, and any rows marked for removal will be deleted. If the Forecast Profiles table contains more than one row with the same profile name, an error dialog will appear and no changes will be saved.
• The **Profile Name** column contains a unique name for the profile.
• The remaining columns correspond to each Storm Management outage type category. These columns contain the number of outages of that outage type that comprise the forecast profile.

**Buttons**

• The **Apply Profile** button applies the selected forecast profile values into the Total Outages column of the Storm Report panel.
• The **Print…** button brings up the Print Preview dialog, which allows you to print out the contents of the Forecast Profiles dialog.
• The **Cancel** button closes the dialog without saving changes, and leaves the forecast profiles as they were.

**Adding a Profile**

To add a new outage forecasting profile:

1. Do one of the following:
   • Click the **Forecast Profiles** button on the toolbar, or
   • Select **Forecast Profiles** from the System menu. The Forecast Profiles dialog opens.
2. Click the **Add Profile** button to add a new row to the Forecast Profiles table.
3. Click into the Profile Name cell of the row and specify a unique name for this profile.
4. Click in the desired outage type cells of the row and specify a number of outages.
5. Click the **Save Profiles** button. The Forecast Profiles dialog closes and the new profile is saved for later use.

**Editing a Profile**

To edit an existing outage forecasting profile:

1. Do one of the following:
   • Click the **Forecast Profiles** button on the toolbar, or
   • Select **Forecast Profiles** from the System menu. The Forecast Profiles dialog opens.
2. Click into the desired cell of the desired forecast profile and modify the profile name/outage type count.
3. Click the **Save Profiles** button. The Forecast Profiles dialog closes and the edited profile is saved for later use.

**Removing a Profile**

To remove an existing outage forecasting profile:

1. Do one of the following:
   • Click the **Forecast Profiles** button on the toolbar, or
   • Select the Forecast Profiles option from the System menu. The Forecast Profiles dialog opens.
2. Click into the any cell of the forecast profile to be removed.
3. Press the `<Esc>` key on your keyboard.
4. Click the **Remove Profile** button.
5. Click the **Save Profiles** button. The Forecast Profiles dialog closes and the marked profile is removed.
Applying a Profile
To apply an outage forecasting profile:

1. Do one of the following:
   - Click the Forecast Profiles button on the toolbar, or
   - Select Forecast Profiles from the System menu. The Forecast Profiles dialog opens.

2. Click into the any cell of the forecast profile to be applied.

3. Click the Apply Profile button. The Forecast Profiles dialog closes, and the Total Outages column of the Storm Report for each outage type is now populated with the corresponding value from the forecast profile.

4. Click the Save Changes button. The Total cell value beneath the Total Outages column updates to reflect the new sum using the modified forecast values. For any outage type where the Actual Outages value exceeds the forecasted value, the Total Outages column for that outage type will instead display the Actual Outages value rather than the forecasted value.

Printing Forecast Profiles
To print the contents of the Forecast Profiles dialog, complete these steps:

1. Do one of the following:
   - Click the Forecast Profiles button on the toolbar, or
   - Select Forecast Profiles... from the System menu. The Forecast Profiles dialog opens.

2. Click the Print… button. The Print Preview dialog opens.

3. Adjust the scale, orientation, and page setup as desired.

4. Click the Print button on the toolbar to print the page(s). The Print Preview dialog disappears and the print output appears at your selected printer.

Working with Crew Information
Storms create critical outage situations that make it vital to account for crew resources. For example, you may need to move a crew to a different control zone depending on the backlog of outages within each zone. This section includes the following topics:

- Crew Information Panel
  - Hiding the Crew Information Table
  - Sorting the Crew Information Table
- Applying Changes Importing Crews
- Importing Crews
- Adding Crew Groups
- Editing Crew Groups
- Deleting Crew Groups
- Moving Crew Groups

Crew Information Panel
The Crew Information table, located directly below the Storm Report, lists all of the crews identified in Storm Management for the currently selected control zone and its children. Crews of certain skill and availability within a control zone are grouped together. Each row in the Crew Information table represents a group of crews. The buttons above the table let you modify the information for each group. There are buttons on the toolbar that perform the same functions.
The Crew Information panel displays the following fields and buttons:

- The **# Crews** column contains the number of crews that belong to the group.
- The **Zone** column contains the name of the control zone that crew group is assigned to.
- The **Company** column contains the name of the company that the crew group works for. This column is for informational purposes and does not affect the outcome of the estimate calculations.
- The **Crew Type** column contains the type of crew within the group. This indicates the type of work performed by the crews. The options here match the crew types defined in the Crew Makeup window of Oracle Utilities Network Management System Trouble Management.
- The **Start Date** column contains the date and time at which each crew in the group is available for work.
- The **End Date** column contains the date and time at which each crew in the group becomes unavailable for work.
- The **Hours On** column contains the length of the shift worked by each crew in the group.
- The **Hours Off** column contains the length of time between shifts worked by each crew in the group (i.e., the number of hours that the each crew in the group has off after completing each shift).
- The **Add Crew** button opens the Add Crew Group dialog, which lets you define new crew groups for the Crew Information table.
- The **Edit Crew** button opens the Edit Crew Group dialog, which lets you change crew data for a selected crew group in the Crew Information table.
- The **Delete Crew** button removes the selected crew group from the Crew Information table. A warning dialog opens, prompting you for confirmation before deleting.
- The **Move Crew** button opens the Move Crew Group dialog, used to transfer crews from the selected crew group in the Crew Information table to another control zone.
- The **Apply Crew Changes** button saves changes made in the Crew Information table. Unapplied changes in the Crew Information table are highlighted in different colors.
- The **Import Crews** button opens the Import Crews dialog. In real-time mode, this dialog lets you import crews from Oracle Utilities Network Management System Trouble Management into the Crew Information table. In study mode, it additionally lets you import crew group information from the real-time session or the applied manual override or outage forecasting parameters from the real-time session into study mode.

**Hiding the Crew Information Table**

You can hide the Crew Information table by clicking the button in the upper left corner of the table next to the **Add Crew** button.

The Storm Management window below has had the Crew Information table hidden.
Sorting the Crew Information Table

You can sort the Crew Information table in ascending or descending order according to any column in the table.

To sort the Crew Information table, click on the column heading of the column you want to sort by. The table sorts in ascending order of the selected column, and an up arrow appears on the column heading, indicating that the sort is ascending.

Click the same heading again to toggle to descending sort order. A down arrow appears, and the table re-sorts.

Applying Changes

A highlighted row in the Crew Information table indicates that there have been changes entered but not yet saved.

- Green highlighted rows are new rows that are added to the table.
- Cyan highlighted rows are rows that have been edited or updated.

A crew group may have been added, edited, moved or imported but the changes are not permanent until you do one of the following:

- Select the **Apply Crew Changes** option from the Crews menu,
- Click the **Apply Crew Changes** button above the Crew Information table, or
- Click the **Apply Crew Changes** button on the toolbar.

Once you save the changes, the corresponding rows in the Crew Information table are no longer highlighted. If at the time of the application there are rows in the Crew Information table that contain the same data in all of their columns (except the # Crews column), then those rows are combined. The numbers of crews for each row are added together and the sum appears in the # Crews column.

If you try to change the control zone view while there are unsaved changes in the Crew Information table, a dialog prompts you to do one of the following:

- The **Yes** button saves the changes in the Crew Information table and moves to the newly selected control zone.
- The **No** button discards the changes in the Crew Information table and moves to the newly selected control zone.
- The **Cancel** button closes the dialog without altering the changes in the Crew Information table or moving to the selected control zone.

Importing Crews

The crew information used by Storm Management is maintained separately from that in Oracle Utilities Network Management System Trouble Management. However, crew information defined in Oracle Utilities Network Management System Trouble Management can be imported into Storm Management with the Import Crews dialog.
To open the Import Crews dialog when in storm mode, do one of the following:

- Click the **Import Crews…** button above the Crew Information table,
- Click the **Import Crews…** button on the toolbar, or
- Select **Import Crews...** from the Crew menu.

**Note:** Changes made within Storm Management to the imported crews will not affect the data in Oracle Utilities Network Management System Trouble Management.

The Import Crews dialog serves two functions:

- In real-time mode, it lets you import crew information from Oracle Utilities Network Management System Trouble Management into the Crew Information table, based on specified filtering criteria.
- In study mode, it lets you import Oracle Utilities Network Management System Trouble Management crew information, as well as the manual override/outing forecasting parameters of the currently selected control zone and any crew information from real-time mode into study mode.

**Import Crews Window**

The Import Crews window contains the following fields and buttons:

- **The Current Zone** field displays the name of the currently selected control zone. This field is not editable.
- **The Reset** option, when checked, replaces all crews currently in the Crew Information table with the imported crews. When not checked, the imported crews are added to the existing data in the Crew Information table.
- **The Real Crews** option is checked by default. This option imports crew information from Oracle Utilities Network Management System Trouble Management. This option is only deselectable in study mode.
- **The Crew Groups** option, when checked, lets you import the crew groups from the real-time session. This option is only enabled in study mode.
- **The Parameters** option, when checked, lets you import the outage forecasting and manual overrides from real-time mode for the selected control zone. This option is only enabled in study mode.
- **The Zone** option, when checked, option imports only crews from the specified control zone. The button on the right opens the Control Zone Selection dialog. (In this dialog, click on the zone you want and click OK.)
- **The Company** option is only enabled when the Real Crews Import Criteria option is not selected. It imports only the crews with the Company specified in the drop-down list.
- **The Crew Type** option, when checked, imports only the crews whose type matches the crew type specified in the drop-down menu.
- **The Real Crew Status** option, when checked, imports the crews whose status in Oracle Utilities Network Management System Trouble Management matches the status specified in the drop-down menu. Available crew status options are On-Shift (crew is active and currently on shift), Off-Shift (crew is active and currently off shift) and Inactive (crew is currently not active). This option is only enabled when the Real Crews Import Criteria is selected.
- **The Import** button imports the crew information and/or outage forecasting and manual override parameters as specified and closes the dialog. In the Crew Information table, the imported data is highlighted and crews with identical parameters are automatically combined into the same group. To confirm the changes and remove the highlighting, click on the **Apply Crew Changes** button.
• The **Cancel** button discards the import criteria options and closes the dialog without importing anything.

### How to Import Crews

To import crews, complete these steps:

1. Make sure the currently selected control zone is operating in storm mode.
2. Do one of the following:
   • Click the **Import Crews…** button above the Crew Information table,
   • Click the **Import Crews…** button on the toolbar, or
   • Select **Import Crews...** from the Crew menu.
3. Select the import criteria and filters for the crews you want to import.
4. Click **Import**. If an imported crew is not an identical match to any existing crew group rows in the Crew Information table, then it’s added to the table as a new row and highlighted in green. If an imported crew is an identical match to any existing crew group rows in the Crew Information table, then the number of crews in the existing crew group row is incremented and the row is highlighted in cyan.
5. To apply the changes, do one of the following:
   • Click the **Apply Crew Changes** button above the Crew Information table,
   • Click the **Apply Crew Changes** button on the toolbar, or
   • Select **Apply Crew Changes** from the Crew menu.

### Example of Importing Crews

The highlighted rows in the Crew Information table below show the results of importing crews into real-time without using the Reset option. The Hours On and Hours Off values default to 8 and 16 respectively for any crew information imported from Oracle Utilities Network Management System Trouble Management.

- Green highlighted rows are new rows that are being added to the table.
- Cyan highlighted rows are crew groups that are having crews added to them. The # Crews column has been increased to reflect the new number of crews in the group.

  **Note:** The End Date column is not populated because there is no corresponding value defined in Oracle Utilities Network Management System Trouble Management.

### Adding Crew Groups

You can add new crew groups to Crew Information table using the Add Crew Group dialog. To open the Add Crew Group dialog, do one of the following:

- Click the **Add Crew…** button above the Crew Information table,
- Click the **Add Crew…** button on the toolbar, or
- Select **Add Crew...** option from the Crew menu when in storm mode.

The Add New Crew Group dialog contains the following fields and buttons:

- The **Zone** field is the control zone that the crew group is assigned to. The default value is the control zone that Storm Management is currently viewing. The button on the right opens the Control Zone Selection dialog. (In this dialog, click on the zone you want and click **OK**.)
- The **Company** drop-down menu is the name of the company that the crew group works for. This column is for informational purposes and does not affect the outcome of the estimate calculations.
• The Crew Type drop-down menu is the type of crew within the group. This indicates the type of work performed by the crews. The options here match the crew types defined in the Crew Makeup window of Oracle Utilities Network Management System Trouble Management.

• The # Crews field allows you to specify the number of crews that belong to the group.

• The Start Date field is the date and time at which each crew in the group is available for work. The button on the right opens a calendar dialog to select the date and time from.

• The Avail Until field is the date and time at which each crew in the group becomes unavailable for work. The button on the right opens a calendar dialog to select the date and time from.

• The Hours On field allows you to specify the length of the shift worked by each crew in the group, beginning at the Start Date.

• The Hours Off field allows you to specify the length of time between shifts worked by each crew in the group (i.e., the number of hours that the each crew in the group has off after completing each shift).

• The OK button confirms the details and schedule for the new crew group, inserts the information into the Crew Information table, and closes the dialog. You must save the new crews by clicking the Apply Crew Changes button or selecting the Apply Crew Changes option from the Crew menu.

• The Cancel button discards the details and schedule and closes the dialog without inserting any information.

When there is at least one crew in the table, you can display the pop-up menu by selecting and then right-clicking a row in the Crew Information table.

• The Copy Crew option copies the selected row in the Crew Information table.

• The Paste Crew option inserts the copied crew into the Crew Information table below the current line.

• The Add Crew option inserts a new row into the Crew Information table containing default values. Once the new row is added, you can change the values in each column.

Adding Crew Groups Using the Add Crew Group Window

To add crew groups to the Crew Information Table, complete these steps:

1. In storm mode, do one of the following:
   • Click the Add Crew… button above the Crew Information table,
   • Click the Add Crew… button on the toolbar, or
   • Select Add Crew… from the Crew menu.

The Add Crew Group dialog opens.

2. To add the crew group to a different control zone, click the button on the right of the Zone field. A Control Zone Selection dialog opens. Select the zone you want and click OK.

• Select the Company and Crew Type from the drop-down menus.

• To change the Start Date to something other than the current date and time, click the calendar button to the right of the Start Date field. Select the date and time you want and click the OK button.

• Click the calendar button to the right of the End Date field. Select the date and time you want and click the OK button. The End Date may be left blank.

• To change the Hours On and Hours Off values, select the text in the fields and type the value you want.
• Click OK in the Add Crew Group dialog. If the newly defined crew group is not an identical match to any existing crew group rows in the Crew Information table, then it's added to the table as a new row and highlighted in green. If the newly defined crew group is an identical match to any existing crew group rows in the Crew Information table, then the number of crews in the existing crew group row is incremented and the row is highlighted in cyan. Either

  • Click the Apply Crew Changes button above the Crew Information table,
  • Click the Apply Crew Changes button on the toolbar, or
  • Select the Apply Crew Changes option from the Crew menu when in storm mode.

The Crew Group is saved in the Crew Information Table and its row is no longer highlighted.

Adding Crew Groups with the Right-Click Pop-Up Menu
You can also add crews directly in the Crew Information table by using the right-click pop-up menu. There must be at least one row in the Crew Information table. To do this, complete these steps:

1. Place your cursor in a row in the Crew Information table and right-click the mouse. The pop-up menu appears, with the Add Crew option enabled.

2. Select Add Crew from the pop-up menu. A new row appears in the Crew Information table with the default values, highlighted in green.

Editing Crew Groups
Once you have imported or added crew groups, you can modify the details of a crew group. Modify crew information using the Edit Crew Group dialog.

To open the Edit Crew Group dialog, select a row in the Crew Information table and then do one of the following:

• Click the Edit Crew… button above the table,
• Click the Edit Crew… button on the toolbar, or
• Select Edit Crew… from the Crew menu when in storm mode.

The Edit Crew Group dialog contains the same fields as the Add Crew Group dialog. The fields are populated with data from the selected row of the Crew Information table.

Editing Crew Groups with the Edit Crew Group Dialog
To edit a crew group using the Edit Crew Group dialog, complete these steps:

1. Select the row in the Crew Information table for the crew group you want to edit. Either:
   • Click the Edit Crew… button above the table,
   • Click the Edit Crew… button on the toolbar, or
   • Select the Edit Crew… option from the Crew menu when in storm mode.

The Edit Crew Group dialog opens.

2. Edit the fields you want to modify.

3. Click OK. The changes appear in the table with the modified row highlighted in cyan.

4. Save the changes by doing one of the following:
   • Click the Apply Crew Changes button above the Crew Information table,
   • Click the Apply Crew Changes button on the toolbar, or
   • Select Apply Crew Changes from the Crew menu.
Editing Crew Groups within the Crew Information Table

You can also edit crews directly in the Crew Information table. To do this, complete these steps:

1. Click the cell of the row that you want to edit. Depending on the type of data in the cell, one of the following occurs:
   - A cursor appears within the cell.
   - A calendar dialog opens for you to select a new date and/or time.
   - A Control Zone Selection dialog opens.
   - A drop-down list opens.

2. Make changes by either editing the value in the cell or selecting from the dialog or drop-down list. (In the Control Zone Selection dialog, click on the zone you want and click OK. In the calendar dialog, select a new date and/or use the spinners to set a new time.). The edited row becomes highlighted in cyan.

3. Click the Apply Crew Changes button above the table or on the toolbar or select Apply Crew Changes from the Crew menu. The following occurs:
   - Your edits are saved.
   - The row is no longer highlighted.
   - The changes are used during the next scheduled simulation iteration.

Deleting Crew Groups

To delete a crew group from the Crew Information table, complete these steps:

1. Select the crew group in the Crew Information table.

2. Do one of the following:
   - Click the Delete Crew… button above the table,
   - Click the Delete Crew… button on the toolbar, or
   - Select the Delete Crew option from the Crews menu when in storm mode.

   A message box opens, requesting confirmation that the selected crew group should be deleted.

3. Click Yes to confirm the delete. The crew group disappears from the Crew Information table.

   Note: The No button cancels the delete.

Moving Crew Groups

Each crew group is assigned to a specific control zone when it is created. During your analysis, you may want to adjust your crew resource allocation by reassigning crews to different control zones. The Move Crew Group dialog enables you to move all or part of the crews within a selected crew group to different control zones.

To open the Move Crew Group dialog, select a crew group from the Crew Information Table and then do one of the following:

- Click the Move Crew… button above the Crew Information table,
- Click the Move Crew… button on the toolbar, or
- Select Move Crew... from the Crews menu when in storm mode.

   Note: The Move Crew… button is only enabled when a crew group is selected in the Crew Information table.
Move Crew Group Window

The Move Crew Group window contains the following fields and buttons:

- **Company** field displays the name of the company that the crew group works for. This field is not editable.

- **Crew Type** field displays the type of crew within the group. This indicates the type of work performed by the crews. It matches the crew types defined in the Crew Makeup window of Oracle Utilities Network Management System Trouble Management. This field is not editable.

- **From Zone** field displays the current control zone of the selected crew group. This field is not editable.

- **To Zone** is the control zone that the specified number of crews is moving to. The button on the right opens the Control Zone Selection dialog. (In this dialog, click on the zone you want and click **OK**.)

- **# Crews** field allows you to specify the number of crews within the selected crew group to move to the new control zone. If you enter a number greater than the number of existing crews, an error will occur when you click **OK**.

- **OK** button confirms the details of the move and closes the dialog. If all of the crews in a group are being moved, the original crew group row now appears highlighted in cyan with the control zone modified. If only part of the crews is being moved from a crew group, the original group row is now highlighted in cyan with the number of crews decreased appropriately. A new crew group row appears highlighted in green with the number of specified crews to move and new control zone (all other fields in the row are the same as the original crew group).

- **Cancel** button discards the details about the move and closes the dialog without saving any information.

Moving Crews to Another Control Zone

To move crews to another control zone, complete these steps:

1. Select a crew group row in the Crew Information Table.
2. Do one of the following:
   - Click the **Move Crew…** button above the Crew Information table,
   - Click the **Move Crew…** button on the toolbar, or
   - Select **Move Crew…** option from the Crews menu.

   The Move Crew Group dialog opens.

3. Click the button on the right of the To Zone field. The Control Zone Selection dialog opens.
4. Select the control zone you want to move the crews to and click **OK**. The Control Zone Selection dialog closes, and the zone you selected populates the To Zone field.
5. If you only want to move part of the crews in the group, enter the number of crews you want to move in the # Crews field.
6. Click **OK**. The dialog closes.

   If all of the crews in a group are being moved, the original crew group row now appears highlighted in cyan with the control zone modified.

   If only part of the crews is being moved from a crew group, the original group row is now highlighted in cyan with the number of crews decreased appropriately. A new crew group row appears highlighted in green with the number of specified crews to move and new control zone (all other fields in the row are the same as the original crew group).
7. Click the **Apply Crew Changes** button above the table or on the toolbar or select Apply Crew Changes from the Crew menu. The following occurs:
   - The crew groups are moved to their assigned control zones.
   - The modified rows are no longer highlighted.
   - The updated information is used during the next scheduled simulation iteration.

**Moving Entire Crew Groups Using the Table Edit Features**

You can also move a crew group by clicking directly in the Zone field of the crew group row and changing the control zone. To move a crew group in this way, complete these steps:

1. Click in the Zone field for the crew group you want to move. The row becomes selected, and the Control Zone Selection dialog appears.
2. Select the zone you want to move the crew group to and click **OK**.
3. Click in a different field of the row. The Zone field updates to reflect the zone you just selected, and the row becomes highlighted in cyan.
4. Click the **Apply Crew Changes** button above the table or on the toolbar or select **Apply Crew Changes** from the Crew menu. The modified row moves to its new control zone and is no longer highlighted. The updated information is used during the next scheduled simulation iteration.

**Moving Partial Crew Groups Using the Right-Click Pop-Up Menu**

You can also move partial crew groups directly from the Crew Information table. To do this, complete these steps:

1. Select a crew group row in the Crew Information Table.
2. Copy a selected crew group using the right-click Copy Crew option.
3. Paste it as a new row in the table using the right-click Paste Crew option.
4. Edit the Zone cell in the new row by clicking on it, selecting the new control zone and clicking **OK**.
5. Edit the # Crews cell in the original row.
6. Edit the # Crews cell in the new row.
7. Click the **Apply Crew Changes** button above the table or on the toolbar, or select **Apply Crew Changes** from the Crew menu. The following occurs:
   - The new row moves to its assigned control zone.
   - The modified rows are no longer highlighted.
   - The updated information is used during the next scheduled simulation iteration.

**Exiting Storm Mode**

To exit storm mode for a selected control zone, do one of the following:

- Select the Toggle Storm Mode option from the System menu, or
- Click the **Toggle Storm Mode** button on the toolbar.

These options are only available if the currently selected control zone is operating in real-time mode and storm mode.

**Define Storm Dialog**

Once you press the Toggle Storm Mode, the Define Storm dialog opens, prompting you for the End Date of the storm in this zone.
The Define Storm dialog displays the following fields:

- The **Zone** field displays the name of the currently selected zone. This control zone and all of its children that aren’t already in non-storm mode will be placed into non-storm mode, ending the storm in this zone(s). This field is not editable.

- The **Storm Name** field displays the name of the storm. This field is not editable.

- The **Special Condition** field displays a storm type that indicates a pre-defined condition existing with the storm. This condition may also dictate a different set of historical average values be used in the estimate calculations made by the system. This field is not editable.

- The **Storm Level** field displays the severity level for the storm. This value is recorded for information and reporting purposes only and has no effect on the estimate calculations. This field is not editable.

- The **Start Date** field displays the date time at which the storm started in this zone. This field is not editable.

- The **End Date** field contains the date and time at which the storm ended in this zone. When you uncheck the “Use current time” option, the button on the right of this field opens a calendar that lets you select the date and time. Valid dates and times are those prior to (and including) the current time. If your entry is invalid, an error message appears. Click **OK** to close the message and correct the error.

- The **Use Current Time** checkbox is selected by default. This option allows you to leave the End Date field blank and have the current system time on the server be used as the End Date of the storm in this zone. Deselecting this option enables the calendar button to the right of the End Date field.

### Setting the Storm End Date

To set the storm’s end date, complete these steps:

1. Select a date and time for the storm’s end date. Either:
   - Leave the Use Current Time option checked.
   - Uncheck the Use Current Time option. Click on the End Date calendar button and select a date and time for the storm’s end date. Click **OK**. The calendar closes, and the selected date and time populate the End Date field. Valid dates are those between the start date and time of the storm and the current date and time.

2. Click the **Ok** button on the Define Storm dialog.
   - Storm Management returns to non-storm mode for the selected control zone.
   - If the control zone had any child zones in the same storm, the child zones are also returned to non-storm mode.

   **Note:** The **Cancel** button discards the End Date without saving it. The Define Storm dialog closes and the currently selected control zone stays in storm mode.

### Study Mode

Study mode enables you to manipulate parameters that affect the estimate calculations, such as outage forecasting, manual overrides and crew information, without altering the current real-time calculations. The Storm Management window appears below in study mode.

This section includes the following topics:

- **Entering Study Mode**
- **Calculating Crew Resources**
- **Importing Crews and Parameters**
• Exporting Crews and Parameters
• Calculating Estimates in Study Mode
• Exiting Study Mode

Entering Study Mode
To toggle between study mode and storm mode, do one of the following:

• Select **Toggle Study Mode** from the Storm menu, or
• Click the **Toggle Study Mode** button on the toolbar.

You can only enter study mode from a control zone that is currently in storm mode.

The first time you enter a study session, several portions of the Storm Management window are not populated as they were in the real-time session:

• The Summary Information table’s Est Assessed By and Est Restored By columns are empty.
• The Storm Report table’s Total Time to Assess and Total Time to Restore columns display zeros.
• The Storm Report table’s Estimated Assessed By and Estimated Restored By columns are empty.
• Outage forecasting parameters that existed in the real-time session are not applied.
• Manual overrides that existed in the real-time session are not applied.
• The Crew Information table is empty.
• The Last Update field of the status bar does not contain a time.

Once you create a study session, it remains active throughout the storm. You may find a need to toggle between study and real-time modes repeatedly during a storm. Each time you re-enter study mode, Storm Management loads the saved data saved from the most recent visit to the study session.

The status bar at the bottom of the Storm Management window identifies the current operating modes, as shown below for study, storm mode.

When in study mode, the window’s refresh interval is disabled, and estimate calculations using the data in the study mode session must be triggered manually. However, the system does continue to make real-time estimate calculations for all control zones.

Calculating Crew Resources
In storm mode, Storm Management can calculate the approximate number of crews that the system requires to complete assessment and restoration in the currently selected control zone by a specified date. You can enter variables used in the calculation and see the results in the Calculate Crews dialog.

To open the Calculate Crews dialog, do one of the following:

• Select **Calculate Crews** from the Storm menu when in storm mode, or
• Click the **Calculate Crews** button on the toolbar.

The Calculate Crews dialog displays the following fields and buttons:

• The Assessment **Desired Date** field contains the assessment completion time you want to achieve. The button on the right of this field opens a calendar that enables you to select a date and time. You must select a date and time later than the current time. The value you enter (and the system uses) displays in the upper left corner above the Used Crews table after the results are calculated. You may leave this field blank if you wish to Calculate Crews for Repair only.
• The Assessment **Work Efficiency (%)** field contains the efficiency of the assessment crews as a percentage. This value affects the amount of work to be completed and is applied along with performance factor values associated with the crew type. You must specify the assessment work efficiency as a percentage between 1 and 100. The value you enter (and the system uses) displays to the right of the Estimated Assessed By date above the Used Crews table after the results are calculated.

• The Repair **Desired Date** field contains the repair completion time you want to achieve. The button on the right of this field opens a calendar that enables you to select a date and time. You must select a date and time later than the current time. The value you enter (and the system uses) displays to the left of the Repair Eff percentage above the Used Crews table after the results are calculated. You may leave this field blank if you wish to Calculate Crews for Assessment only.

• The Repair **Work Efficiency (%)** field contains the efficiency of the repair crews as a percentage. This value affects the amount of work to be completed and is applied along with performance factor values associated with the crew type. You must specify the assessment work efficiency as a percentage between 1 and 100. The value you enter (and the system uses) displays above the right corner of the Used Crews table after the results are calculated.

• The **Hours** field contains the number of hours that equal one crew unit. The results are returned in crew units rounded to the next whole integer. The value entered and used by the calculation displays above the Unused Crews table.

• The **Calculate Crews** button calculates the number of crews based on the specified data. It populates the Used Crews and Unused Crews panels with the results.

• The **Reset** button resets the entries in the Assessment Desired Date and Work Efficiency, the Repair Desired Date and Work Efficiency, and the Crew Unit Hours fields back to their default values.

• The **Print…** button brings up the Print Preview dialog, which allows you to print out the contents of the Calculate Crews dialog.

• The **Cancel** button closes the dialog.

• The **Outage Types** column contains the name of the Storm Management outage type category.

• The **Assessment Units Existing** column contains the number of existing assessment crews units that can assess each outage type by the specified date.

• The **Assessment Units Needed** column contains the number of additional assessment crew units needed to assess each outage type by the specified date.

• The **Assessment Units Total** column contains the total number of assessment crew units needed to assess each outage type by the specified date.

• The **Repair Units Existing** column contains the number of existing repair crews units that can repair each outage type by the specified date.

• The **Repair Units Needed** column contains the number of additional repair crew units needed to repair each outage type by the specified date.

• The **Repair Units Total** column contains the total number of repair crew units needed to repair each outage type by the specified date.

• The **Crew Type** column indicates the type of work performed by the crews. It matches the crew types defined in the Crew Makeup window of Oracle Utilities Network Management System.

• The **Unused Units** column contains the number excess crew units for each crew type that are found to exist by the calculation.
Calculating Crews Needed to Assess and Restore Outages by a Given Time

To calculate the number of crew units needed to assess and repair all events in the currently selected control zone by a specific time, complete these steps:

1. From a control zone in storm mode, do one of the following:
   - Select **Calculate Crews** option from the Storm menu, or
   - Click the **Calculate Crews…** button on the toolbar.

2. Click on the Assessment Desired Date calendar button.

3. From the calendar dialog, select the date and time you want all assessment completed by and click **OK**.

4. Select the percentage in the Assessment Work Efficiency (%) field and type the percentage you want to use.

5. Click the **Repair Desired Date** calendar button.

6. From the calendar dialog, select the date and time you want all repair completed by and click **OK**.

7. Select the percentage in the Repair Work Efficiency (%) field and type the percentage you want to use.

8. Click the **Calculate Crews** button. Storm Management estimates the number of crew units needed and unused and displays the results in the Used Crews and Unused Crews tables.

Printing Calculate Crews Results

To print the contents of the Calculate Crews dialog, complete these steps:

1. Do one of the following:
   - Click the **Calculate Crews** button on the toolbar, or
   - Select **Calculate Crews...** option from the System menu. The Calculate Crews dialog opens.

2. Click the **Print…** button. The Print Preview dialog opens.

3. Adjust the scale, orientation, and page setup as desired.

4. Click the **Print** button to print the page(s). The Print Preview dialog disappears and the print output appears at your selected printer.

Importing Crews and Parameters

In study mode, the Import Crews dialog has additional options not available in real-time mode. It enables you to import Oracle Utilities Network Management System Trouble Management crew information, as well as the manual override/outage forecasting parameters of the currently selected control zone and any crew information from real-time mode into study mode.

Importing Real-Time Crews and Parameters into the Study Session

To open the Import Crews dialog, do one of the following:

1. Click the **Import Crews…** button above the Crew Information table,

2. Click the **Import Crews…** button on the toolbar, or

3. Select **Import Crews...** from the Crew menu.

The following fields are only activated in study mode:

- The **Crew Groups** option, when checked, enables you to import the crew groups from the real-time session.
• The **Parameters** option, when checked, option enables you to import the outage forecasting and manual overrides from real-time mode for the selected control zone.

• The **Company** option is only enabled when the Real Crews Import Criteria option is not selected. It imports only the crews with the Company specified in the drop-down menu.

Once you click the **Import** button, Storm Management Crew Information panel looks and behaves as it does in real-time mode.

The window below shows how the Crew Information table would look if real-time crew groups are imported with no filters. All of the real-time crews are imported.

---

**Importing Real-Time Session Information into the Study Session**

To import crews, complete these steps:

1. Make sure the currently selected control zone is operating in study mode.

2. Do one of the following:
   • Click the **Import Crews**… button above the Crew Information table,
   • Click the **Import Crews**… button on the toolbar, or
   • Select **Import Crews**... from the Crew menu.

3. Uncheck the Real Crews option under the Import Criteria section.

4. Check the Crew Groups option under the Import Criteria section.

5. Check the Parameters option under the Import Criteria section.

6. Click **Import**. The following occurs:
   • Any outage forecasting and manual override parameters that exist for this control zone in the real-time session are applied to the Storm Report table, but not yet saved.
   • The Save Changes button in the toolbar becomes sensitized.
   • The Crew Information table is now populated with the crew groups that exist for this control zone in the real-time session. If an imported crew is not an identical match to any existing crew group rows in the Crew Information table, then it’s added to the table as a new row and highlighted in green. If an imported crew is an identical match to any existing crew group rows in the Crew Information table, then the number of crews in the existing crew group row is incremented and the row is highlighted in cyan.

7. Apply the outage forecasting and manual override changes by either:
   • Clicking the **Save Changes** button on the toolbar, or
   • Selecting Save Changes from the System menu.

8. Apply the Crew Info table changes by doing one of the following:
   • Click the **Apply Crew Changes** button above the Crew Information table,
   • Click the **Apply Crew Changes** button on the toolbar, or
   • Select **Apply Crew Changes** from the Crew menu.

The Crew Information table updates to display only those crews belonging to the currently selected control zone. The crew groups that are removed from the current view are saved in the study session for their appropriate control zones. You can view them by selecting their control zone from the Zone Selection tree.
Resetting the Current Study Session to Match the Real-Time Session

In the course of working with the study session, the user may want to start over by resetting the state of the study session to the current state of the real-time session.

1. To reset the study session, do one of the following:
   • Click the **Reset Study Session** button on the toolbar, or
   • Select **Reset Study Session** from the Storm menu.

   The Reset Study Session confirmation dialog will appear.

2. Click the **Yes** button on the confirmation dialog to proceed. The confirmation dialog closes.

   The Crew Information table updates with the crews defined in the real-time session. Special Condition, Forecast mode and override information in the Storm Report table are also updated to match the real-time session.

   **Note:** This operation affects all control zones, not just the currently selected zone.

Exporting Crews and Parameters

Once the user is satisfied with the simulation parameters in study mode, the parameters can be exported back into the real-time session.

To export the study session parameters, complete these steps:

1. Do one of the following:
   • Click the **Export Study Session** button on the toolbar, or
   • Select **Export Study Session** from the Storm menu.

   The Export Study Session confirmation dialog appears.

2. Click the **Yes** button on the confirmation dialog to proceed. The confirmation dialog closes.

   The contents of the Crew Information as well as Special Condition, Forecast mode and override information in the Storm Report table are copied into the real-time session.

   **Note:** This operation affects all control zones in the real-time session, not just the currently selected zone.

Calculating Estimates in Study Mode

Because estimate calculations using the data in the study mode session must be triggered manually, you must use the **Force Simulation Run** button to calculate the results.

   **Note:** While you are working in study mode, Storm Management continues to calculate restoration times for control zones operating in real-time.

To calculate estimates in study mode, do one of the following:

• Select **Force Simulation Run** option from the System menu, or

• Click the **Force Simulation Run** button on the toolbar.

The Summary Information table and Storm Report table update to display the estimates. The status bar indicates the time at which the forced simulation was last executed in the study session.

   **Note:** Each time you make changes in the Storm Management window in study mode, you must press the **Force Simulation Run** button in order to view the results of the changes. Because every time you press the **Force Simulation Run** button causes Storm Management to completely re-analyze and calculate estimates for all events in the system, forcing a simulation could slow down system performance at times. It is recommended you keep forced simulations at a minimum.
When Storm Management completes a forced simulation in real-time mode, a confirmation message is displayed.

**Note:** Once you’ve found the optimal settings in your study session, you must manually re-enter them into real-time mode to apply them to the storm.

### Exiting Study Mode

To exit study mode, do one of the following:

- Click the **Toggle Study Mode** button on the toolbar, or
- Select **Toggle Study Mode** from the Storm menu.

If there are unsaved changes, a dialog opens prompting you for options to save the changes.

**Note:** You must exit study mode before you can exit storm mode.

### Additional Storm Management User Types

Storm Management provides two additional user types: View Only and Administration. The View Only type is available for users who need to see the data without making changes to it. The Administration user type provides authorized users with the capability to view and edit storm-related data.

This section includes the following topics:

- **View Only**
- **Administration**

#### View Only

Some users do not have a need to manipulate the various parameters on the Storm Management window, but rather need to monitor and analyze the information that’s presented. The View Only version of the Storm Management window is available for this type of user.

Open the View Only Storm Management window by clicking the Storm Management icon found under the appropriate program group in your Windows Start Menu, or by double clicking the Storm Management icon on your desktop (depending upon how it was installed). The Storm Management Login window will appear.

Login with a User Type of “View Only” to proceed to the View Only window.

#### View Only Menus

There are three menus on the View Only Storm Management menu bar: System, Storm, and Help.

#### View Only System Menu

The options in the System menu are available in storm and non-storm modes.

The following table describes the System Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve Update</td>
<td>Refreshes the window with the most recent information from the system.</td>
</tr>
<tr>
<td>Print All…</td>
<td>Opens the Print Preview dialog, which allows you to print out the Summary Information panel, Storm Report panel, Storm Information panel (if present), Crew Information panel (if present), and status bar information from the current Storm Management window.</td>
</tr>
</tbody>
</table>
Additional Storm Management User Types

View Only Storm Menu
The option in the Storm menu is only enabled when Storm Management is in storm mode for the selected control zone.

The following table describes the Storm Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Crews...</td>
<td>Opens the Calculate Crews dialog, which is used to determine the approximate number of crews needed to complete assessment and repair by a specified date and time.</td>
</tr>
</tbody>
</table>

View Only Help Menu
The option in the Help menu is available at all times.

The About Storm Management option on the Help Menu opens a dialog that displays information regarding what version of the application is presently running, as well as version and other information about the Web Gateway that the application is using.

View Only Toolbar
The Storm Management toolbar provides a shortcut to many of the options available from the Storm Management menus.

The View Only Storm Management toolbar displays the following buttons.

- The Retrieve Update button refreshes the window with the most recent information from the system. In most cases, the window refreshes itself on a periodic basis. But, if there are unsaved changes in the Storm Management window at the time the automatic refresh is due to occur, the window will not refresh. Instead, an alert appears in the status bar indicating that an update is available, and the Retrieve Update option must be invoked in order to refresh the window with the new update. This allows you to continue on with your changes and save them first before refreshing.

- The Calculate Crews button opens the Calculate Crews dialog box, which is used to determine the approximate number of crews needed to complete assessment and repair by a specified date. This option is only available in storm mode.

Administration
Upon completion of a storm (i.e., all of the control zones belonging to the storm have been transitioned back to the non-storm mode of operation), authorized users can change completed storm data with Storm Management’s Administration window. Users can view completed storm records and make changes to the control zone, storm type, storm level, and beginning and ending dates of the storm.

You can open the Administration window by clicking the Storm Management icon found under the appropriate program group in your Windows Start Menu, or by double clicking the Storm Management icon on your desktop (depending upon how it was installed). The Storm Management Login window will appear.

Login with a User Type of “Storm Administration” to proceed to the Administration window.
Administration Menus

There are two menus on the Storm Administration menu bar:

- Administration System Menu
- Administration Help Menu

Administration System Menu

The options in the System menu are available at all times. The following table describes the System Menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revert Changes</td>
<td>Reloads the most recently saved records from the database.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves any changes made to the table.</td>
</tr>
<tr>
<td>Print…</td>
<td>Opens the Print Preview dialog, which allows you to print out the contents of the Storm Administration table.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Storm Administration window.</td>
</tr>
</tbody>
</table>

Administration Help Menu

The option in the Help menu is available at all times. The About Storm Management option opens a dialog that displays information regarding what version of the application is presently running, as well as version and other information about the Web Gateway that the application is using.

If you try to exit the window while there are unsaved changes in the table, a dialog prompts you to save changes. Click Yes to save the changes in the table and exits the window. Click No to discard the changes in the table and exits the window. The Cancel button closes the dialog without altering the changes in the table or exiting the window.

Administration Toolbar

The Storm Management toolbar provides a shortcut to many of the options available from the Storm Management menus. The following table describes the buttons on the Storm Administration Toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Revert Changes icon" /></td>
<td>Reloads the most recently saved records from the database.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves any changes made to the table.</td>
</tr>
<tr>
<td><img src="image" alt="Print Preview icon" /></td>
<td>Opens the Print Preview dialog, which allows you to print out the contents of the Storm Administration table.</td>
</tr>
</tbody>
</table>

Storm Administration Table

The Storm Administration table displays the following fields and buttons:

- The **Storm Name** column contains the name of the storm as defined in the Define Storm dialog. This field is not editable.
• The **Zone** column contains the name of the control zone affected by this storm. Unless explicitly defined elsewhere in the table, all of the children of the control zone are considered part of this storm as well.

• The **Special Condition** column contains the storm type indicating a pre-defined condition of the storm, as defined in the Define Storm dialog.

• The **Start Date** column contains the date and time when the storm began in the zone, as defined in the Define Storm dialog.

• The **End Date** column contains the date and time when the storm ended in the zone, as defined in the Define Storm dialog.

• The **Storm Level** column indicates the severity of the storm, as defined in the Define Storm dialog.

**Printing The Storm Administration Table**

To print the contents of the Storm Administration table, complete these steps:

1. Do one of the following:
   • Click the **Print Preview** button on the toolbar, or
   • Select **Print...** option from the System menu. The Print Preview dialog opens.

2. Adjust the scale, orientation, and page setup as desired.

3. Click the **Print** button to print the page(s). The Print Preview dialog disappears and the print output appears at your selected printer.

**Editing Storm Records**

The Storm Administration window has many of the same editing capabilities as Storm Management's Crew Information table. The behavior of the editable field depends on the type of data in the field. When you select a row and click the right mouse button, a pop-up menu opens. The options in the menu enable you to cut, copy, paste, and delete rows in the table.

Pop-up menu options are described below:

• The **Cut Row** option removes the selected row from the table. You can paste the removed row back into the table with the Paste option. The row stays available for pasting until a new row is copied or cut from the table.

• The **Copy Row** option copies the selected row, enabling you to paste it into the table with the Paste option. The selected row that was copied remains in the table.

• The **Paste Row** option inserts the copied or cut row into the table.

• The **Delete Row** option removes the selected row from the table. The removed row cannot be pasted back into the table. To undo a deletion, you must select the Revert Changes option from the System menu to restore the table to its last saved state.

**Example**

The steps below show an example of how you can add new data to the Storm Administration window:

1. Select the row in the table that pertains to the storm whose data you want to change.

2. Copy the row and paste it in the table using the right-click menu.

3. Click in the Zone, Start Date, or End Date column. A cursor appears and you can enter new data.

4. Click in the Special Condition or Storm Level column. A drop-down menu appears with a list of eligible choices for you to select from.
5. Click the **Save** button to keep the changes. Storm Management validates the entries. If any of the following conditions is true, an error dialog appears and changes are not saved:

- A storm has multiple entries for the same control zone.
- An invalid Start Date or End Date is entered (i.e., Start Date is later than End Date or End Date is earlier than Start Date).
- A storm has both an entry for a parent control zone and child control zone where the parent zone’s Start Date is earlier than the child zone’s Start Date. (Having both a parent and child control zone entry for the same storm with different Start Dates would indicate that the child zone was placed into storm mode within Storm Management first, and then later the parent zone was placed into storm mode within Storm Management. The parent zone entry would have to be removed and replaced with entries for each child zone if it’s desired to record that one of the children had a later Start Date than the rest of the zones within that parent.)
- A storm has both an entry for a parent control zone and child control zone where the parent zone’s End Date is earlier than the child zone’s End Date. (Having both a parent and child control zone entry with different End Dates for the same storm would indicate that the child zone was placed back into non-storm mode within Storm Management first, and then later the parent zone was placed into non-storm mode within Storm Management. The parent zone entry would have to be removed and replaced with entries for each child zone if it’s desired to record that one of the children had a later End Date than the rest of the zones within that parent.)

**Understanding Storm Management Calculations**

Storm Management enables you to analyze restoration times during high volume outage periods, such as those that occur during and following ice storms, lightning storms, hurricanes, and other widespread disturbances. It can provide estimated assessment and restoration times for every outage in the system. It calculates estimates by periodically simulating the entire restoration process, taking into account the dynamically changing outage predictions and crew resource allocation. These restoration estimates can be used to manage workloads and prioritize crew assignments.

This section provides a detailed explanation of the algorithms and data Storm Management uses to create estimates. It includes the following topics:

- **How Storm Management Works**
- **Non-Storm Mode Algorithm**
- **Storm Mode Algorithm**

**How Storm Management Works**

Storm Management has two basic modes of operation – non-storm and storm mode. The estimate calculation algorithm for each mode is fundamentally the same. For example, both modes use historical averages and simulated restoration calculation/analysis of all unrestored events in the system for the estimate calculation algorithm. However, non-storm mode does not attempt to make crew backlog calculations, making its analysis much simpler.

**Historical Averages**

The estimate calculation algorithm uses the following historical average minutes data that applies to the different parts of the restoration process:

- **Average travel time for an assessment crew**: how long it takes a crew that is going out to assess the event to arrive onsite, once en route.
- **Average assessment time**: how long it takes a crew to assess the event, once onsite.
- **Average travel time for a repair crew**: how long it takes a crew that is going out to repair the event to arrive onsite, once en route.
- **Average repair time**: how long it takes a crew to repair/restore the event, once onsite.
- **Average cleanup time**: how long it takes before a crew is ready to move on to their next assignment, once the repair/restore is complete.

The historical average minutes can be broken down by various factors for further granularity of data:

- Control zone. The area the event is in (e.g., urban vs. rural) may have an affect on how long it takes crews to arrive, and thus you may use different travel times for different control zones.
  
  **Note**: One of the top three levels in the control zone hierarchy is designated as the control zone level at which the historical average minutes data is associated. This control zone level is herein referred to as the *simulation level*. For example, if the second level in the control zone hierarchy – the Region level – was the designated simulation level, that would imply that each region would have its own, possibly unique, set of historical average minutes.

- Outage type. The type of outage (e.g., service outages vs. breaker lockouts) dictates how long it's going to take for repair/restore, and thus you may use different repair/restore times for different types of outages.

- Shift. The time of day (e.g., afternoon rush hour vs. middle of the night) may have an affect on how long it takes crews to arrive, and/or perform the assessment or repair/restore, and thus you may use different travel, assessment, and repair/restore times for different shifts.

- Day type. The type of day (weekday vs. weekend vs. holiday) may have an affect on how long it takes crews to arrive, and thus you may use different travel times for different day types.

- Season. The time of year (e.g., winter vs. summer) may have an affect on how long it takes crews to arrive, and/or perform the assessment or repair/restore, and thus you may use different travel, assessment, and repair/restore times for seasons.

- Storm type. Particular weather conditions (e.g., ice) may have an affect on how long it takes crews to arrive, and/or perform the assessment or repair/restore, and thus you may use different travel, assessment, and repair/restore times for different types of storms.

### Simulation

To generate estimates, the trouble analysis engine periodically goes through a simulated restoration calculation/analysis of all unrestored events in the system. Any events eligible to be assigned an estimated assessment and restoration time by Storm Management (*i.e.*, the events are of a type that Storm Management is configured to recognize, and they have not been given a manually-entered estimated restoration time from a crew/dispatcher) are sorted in priority order (part of the Storm Management configuration). Then, starting at the top of that list, the simulation begins. The event at the top of the list is examined. The mode of operation that the control zone in which the event resides is checked in order to determine which version of the algorithm is being applied to calculate the Estimated Restoration Time (ERT). The appropriate set of historical average minutes for the event is looked up, using the various characteristics such as control zone, outage type, storm type, and when the assessment and repair/restore is projected to begin. Those historical averages are then used by the calculation of the appropriate algorithm to generate an estimated assessment time and estimated restoration time for the event.

Once an event has been given its estimates by the Storm Management simulation, it's removed from that priority-sorted list, and then the next event on the list is analyzed the same way, and the process continues on until the last event on the list is removed. When the next simulation period occurs, the process starts all over again. And when it does, the previously calculated estimates for many events may change, due to factors such as some previously unrestored events now being restored, new events of varying priority appearing, crews arriving onsite at various events, some
events being given manually-entered estimated restoration times, no crew yet arriving onsite, or to
various parameters on the Storm Management window being modified since the last iteration.

**Storm Management Window**

Because the engine that generates the estimated assessment and restoration times for each event is
a separate process, you do not need to have a Storm Management window open in order for the
estimates to be calculated. The main purpose of the Storm Management window is to enable you
to monitor and analyze the estimates from overall control zone perspective, and to manipulate
several of the parameters that are used to generate the estimates.

Given that it’s not required to have a Storm Management window open to generate the estimates,
after each periodic calculation of the estimates, the results are not pushed out to the Storm
Management windows by the engine. Instead, each Storm Management window that’s open has its
own timer that it uses to periodically retrieve the latest information from the engine automatically.
Non-Storm Mode Algorithm

For an event that resides in a control zone that is operating under non-storm mode, the calculation of its estimated assessment and estimated restoration times is as follows:

- Look up the historical average values that pertain to an event with its characteristics.
- Verify whether or not an assessment has already been made for the event (if JOBS.ACT_ASSESS_TIME is non-null).

**If assessment has been made:**

- The repair time assessment provided (JOBS.EST_REPAIR_MINUTES) will be used in the calculation rather than the historical Repair average.
- Verify whether or not a crew is currently onsite for this event.
- If a crew is onsite:
  - Check the crew type to verify whether or not this type of crew is one that can repair this event.
  - If crew can repair:
    - It is assumed that the crew that's onsite is there to perform the repair. The historical Travel to Repair average will not be used in the calculation. The actual repair time assessment (JOBS.EST_REPAIR_MINUTES) is added to the time at which the crew arrived onsite to generate the estimated restoration time (ERT) for the event.
  - If crew cannot repair:
    - It is assumed that the onsite crew is there to perform the assessment, and another crew must be sent out to perform the repair. The historical Travel to Repair average and the actual repair time assessment are added to the time at which the repair time assessment was provided (JOBS.ACT_ASSESS_TIME) to generate the estimated restoration time (ERT) for the event.
- If a crew is not onsite:
  - The historical Travel to Repair average and the actual repair time assessment are added to the time at which the repair time assessment was provided (JOBS.ACT_ASSESS_TIME) to generate the estimated restoration time (ERT) for the event.

**If no assessment has yet been made:**

- Verify whether or not a crew is currently onsite for this event.
- If a crew is onsite:
  - Check the crew type to verify whether or not this type of crew is one that can both assess and repair this event.
  - If the crew type cannot perform both tasks:
    - Verify if the crew type can repair this event.
    - If crew can repair:
      - It is assumed that the crew that's onsite is there to perform the repair. The historical Repair average is added to the time at which the crew arrived onsite to generate the estimated restoration time (ERT) for the event.
    - If crew cannot repair:
      - It is assumed that the crew that's onsite is there to perform the assessment. The historical Assess average is added to the time at which the crew arrived onsite to generate the estimated Assessment time (EAT). The historical Travel to
Repair and historical Repair averages are added to the estimated Assessment time to generate the estimated restoration time (ERT) for the event.

- If crew type can perform both tasks:
  - Verify whether or not assessment is required for this event (if Travel to Assess and Assess averages are both 0, assessment is not required).
  - If assessment is not required:
    - It is assumed that the crew that’s onsite is there to perform the repair. The historical Travel to Repair average will not be used in the calculation. The historical Repair average is added to the time at which the crew arrived onsite to generate the estimated restoration time (ERT) for the event.
  - If assessment is required:
    - It is assumed that the crew that’s onsite is there to perform the assessment. The historical Assess average is added to the time at which the crew arrived onsite to generate the estimated assessment time (EAT). The historical Travel to Repair and historical Repair averages are added to the estimated assessment time to generate the estimated restoration time (ERT) for the event.

- If a crew is not onsite:
  - Verify whether or not assessment is required for this event (if Travel to Assess and Assess averages are both 0, assessment is not required).
  - If assessment is not required:
    - No estimated assessment time (EAT) needs to be calculated. This historical Travel to Repair and historical Repair averages are added to the simulation to generate the estimated restoration time (ERT) for the event.
  - If assessment is required:
    - The historical Travel to Assess and historical Assess averages are added to the simulation to generate the estimated assessment time (EAT) for the event. The historical Travel to Repair and historical Repair averages are added to the estimated assessment time to generate the estimated restoration time (ERT) for the event.
Non-Storm Mode Algorithm Flow Chart

Non-Storm Mode

Head of list of sorted eligible jobs

Is job assessed?

Use historical repair time

Use estimated amount of time to repair provided by assessment crew

Are any crews onsite?

Can crew both assess and repair?

Can crew repair?

Add the Travel to Repair time and the estimated repair time provided by the assessment crew to the time at which the assessment was performed

Add the Travel to Repair minutes to the crew arrival time

Add Repair minutes to the crew arrival time

Add the Travel to Assess and Assess minutes to the simulation start time

Add the Travel to Repair and Repair minutes to the EAT

Remove the job from the sorted list of eligible jobs

Set EAT to simulation start time

Add Assess minutes to the simulation start time

Add ERT

ERT

Is assessment required?

Can crew both assess and repair?

Can crew repair?

Is assessment required?

Are any crews onsite?

Can crew assess or repair?

Use the Travel to Repair time
In summary, for an event that’s in a control zone operating under non-storm mode:

- **Estimated assessment time** =
  - the time at which the simulation iteration started +
  - the historical average number of minutes it takes an assessment crew to arrive onsite +
  - the historical average number of minutes it takes a crew to perform assessment once onsite

- **Estimated restoration time** =
  - the estimated assessment time +
  - the historical average number of minutes it takes a repair crew to arrive onsite +
  - the historical average number of minutes it takes a crew to repair once onsite

**Exceptions:**

If a crew that can perform assessment is already onsite:

**Estimated assessment time** =

The time at which the assessment crew arrived onsite +

the historical average number of minutes it takes a crew to perform assessment once onsite

If an event has an actual assessment provided and no repair crew is yet onsite:

**Estimated restoration time** =

The time at which the actual assessment was provided +

the historical average number of minutes it takes a repair crew to arrive onsite +

the actual number of minutes it will take to repair, per the assessment

If an event has an actual assessment provided and a repair crew is already onsite:

**Estimated restoration time** =

The time at which the repair crew arrived onsite +

the actual number of minutes it will take to repair, per the assessment =

If an event does not require assessment and no repair crew is yet onsite:

**Estimated restoration time** =

The time at which the simulation iteration started +

the historical average number of minutes it takes a repair crew to arrive onsite +

the historical average number of minutes it takes a crew to repair once onsite

**Note:** When the historical averages are applied to the calculation, the average that applies to the conditions at the time the particular step is projected to begin is used, not the average that applies to the conditions at the time the simulation iteration began. For example, Shift A has a particular average value for repair, and Shift B has a different average value for repair. The simulation iteration is in Shift A, but the calculated estimated assessment time falls in Shift B. When calculating the estimated restoration time, the historical average value for repair that pertains to Shift B will be used, not that of Shift A, because the repair isn’t projected to begin until sometime during Shift B.
Storm Mode Algorithm

The algorithm for estimate calculation in storm mode is similar to that of non-storm mode, except that in storm mode the data entered into the Crew Information table on the Storm Management window is taken into consideration and used as the known crew resource allocation. At the start of each simulation, the algorithm assembles a crew availability list from the Crew Information table and uses that to keep track of when the next available crews are projected to be ready as the calculation progresses.

For an event that resides in a control zone that is operating under storm mode, the calculation of its estimated assessment and estimated restoration times is as follows:

- Look up the historical average values that pertain to an event with its characteristics
- Verify whether or not an assessment has already been made for the event (if JOBS.ACT_ASSESS_TIME is non-null)

**If assessment has been made:**

- The repair time assessment provided (JOBS.EST_REPAIR_MINUTES) will be used in the calculation rather than the historical Repair average
- Verify whether or not a crew is currently onsite for this event
- If a crew is onsite:
  - Check the crew type to verify whether or not this type of crew is one that can repair this event
  - If crew can repair:
    - It is assumed that the crew that's onsite is there to perform the repair. The historical Travel to Repair average will not be used in the calculation. The actual repair time assessment (JOBS.EST_REPAIR_MINUTES) is added to the time at which the crew arrived onsite to generate the estimated restoration time (ERT) for the event
  - If crew cannot repair:
    - It is assumed that the onsite crew is there to perform the assessment, and another crew must be sent out to perform the repair. The historical Travel to Repair average and the actual repair time assessment are added to the time at which the first crew that is eligible to repair this event will become available to generate the estimated restoration time (ERT) for the event
- If a crew is not onsite:
  - The historical Travel to Repair average and the actual repair time assessment are added to the time at which the first crew that is eligible to repair this event will become available to generate the estimated restoration time (ERT) for the event. The historical Clean average is added to the ERT and used as the time at which that eligible crew is available to be used for another event in the simulation.

**If no assessment has yet been made:**

- Verify whether or not a crew is currently onsite for this event
- If a crew is onsite:
  - Check the crew type to verify whether or not this type of crew is one that can both assess and repair this event
  - If the crew type cannot perform both tasks:
    - Verify if the crew type can repair this event
  - If crew can repair:
• It is assumed that the crew that's onsite is there to perform the repair. The historical Travel to Repair average will not be used in the calculation. The historical Repair average is added to the time at which the crew arrived onsite to generate the estimated restoration time (ERT) for the event

• If crew cannot repair:
  • It is assumed that the crew that's onsite is there to perform the assessment. The historical Assess average is added to the time at which the crew arrived onsite to generate the estimated assessment time (EAT). The historical Travel to Repair and historical Repair averages are added to the time at which the first crew that is eligible to repair this event will become available to generate the estimated restoration time (ERT) for the event. The historical Clean average is added to the ERT and used as the time at which that eligible crew is available to be used for another event in the simulation.

• If crew type can perform both tasks:
  • Verify whether or not assessment is required for this event (if Travel to Assess and Assess averages are both 0, assessment is not required)
  • If assessment is not required:
    • It is assumed that the crew that's onsite is there to perform the repair. The historical Travel to Repair average will not be used in the calculation. The historical Repair average is added to the time at which the crew arrived onsite to generate the estimated restoration time (ERT) for the event
  • If assessment is required:
    • It is assumed that the crew that's onsite is there to perform the assessment. The historical Assess average is added to the time at which the crew arrived onsite to generate the estimated assessment time (EAT). The historical Travel to Repair and historical Repair averages are added to time at which the first crew that is eligible to repair this event will become available to generate the estimated restoration time (ERT) for the event

• If a crew is not onsite:
  • Verify whether or not assessment is required for this event (if Travel to Assess and Assess averages are both 0, assessment is not required)
  • If assessment is not required:
    • No estimated assessment time (EAT) needs to be calculated. The historical Travel to Repair and historical Repair averages are added to the time at which the first crew that is eligible to repair this event will become available to generate the estimated restoration time (ERT) for the event. The historical Clean average is added to the ERT and used as the time at which that eligible crew is available to be used for another event in the simulation.
  • If assessment is required:
    • The historical Travel to Assess and historical Assess averages are added to the time at which the first crew that is eligible to assess this event will become available to generate the estimated assessment time (EAT) for the event. The EAT is used as the time at which that eligible assessment crew is available to be used for another event in the simulation. The historical Travel to Repair and historical Repair averages are added to the time at which the first crew that is eligible to repair this event will become available to generate the estimated restoration time (ERT) for the event. The historical Clean average is added to the ERT and used as the time at which that eligible repair crew is available to be used for another event in the simulation.
Storm Mode Algorithm Flow Chart

The yellow boxes indicate where the storm mode algorithm differs from the non-storm mode algorithm.
In summary, for an event that's in a control zone operating under storm mode:

**Estimated assessment time** =

- The time at which the first crew that's eligible to assess the event will become available +
- the historical average number of minutes it takes an assessment crew to arrive onsite +
- the historical average number of minutes it takes a crew to perform assessment once onsite

**Estimated restoration time** =

- The time at which the first crew that's eligible to repair the event will become available after the estimated assessment time +
- the historical average number of minutes it takes a repair crew to arrive onsite +
- the historical average number of minutes it takes a crew to repair once onsite =

**Exceptions:**

If a crew that can perform assessment is already onsite,

**Estimated assessment time** =

- The time at which the assessment crew arrived onsite +
- the historical average number of minutes it takes a crew to perform assessment once onsite

If an event has an actual assessment provided and no repair crew is yet onsite:

**Estimated restoration time** =

- The time at which the first crew that's eligible to repair the event will become available after the actual assessment time +
- the historical average number of minutes it takes a repair crew to arrive onsite +
- the actual number of minutes it will take to repair, per the assessment

**Estimated restoration time** =

- If an event has an actual assessment provided and a repair crew is already onsite,
- The time at which the repair crew arrived onsite +
- the actual number of minutes it will take to repair, per the assessment

If an event does not require assessment and no repair crew is yet onsite:

**Estimated restoration time** =

- The time at which the first crew that's eligible to repair the event will become available after the time at which the simulation iteration started +
- the historical average number of minutes it takes a repair crew to arrive onsite +
- the historical average number of minutes it takes a crew to repair once onsite

**Note:** When the historical averages are applied to the calculation, the average that applies to the conditions at the time the particular step is projected to begin is used, not the average that applies to the conditions at the time the simulation iteration began. For example, Shift A has a particular average value for repair, and Shift B has a different average value for repair. The simulation iteration is in Shift A, but the calculated estimated assessment time falls in Shift B. When calculating the estimated restoration time, the historical average value for repair that pertains to Shift B will be used, not that of Shift A, because the repair isn't projected to begin until sometime during Shift B.
Note: If the algorithm finds that the calculated estimated assessment time or estimated restoration time would fall beyond the end of the shift of the first eligible crew by more than 60 minutes, it will go back and recalculate the estimate using a different crew other than the one that was originally chosen.
This chapter describes the Oracle Utilities Network Management System - Service Alert application. It covers the following topics:

- Overview
- Logging In
- Managing Groups
- Managing Contacts
- Using the Parameter Manager
- Using the Utility Customers Tab
- Using the Attributes Manager
- Service Alert Notification Examples

Overview

Oracle Utilities Network Management System - Service Alert is an application that allows for sending notifications to utility personnel in the form of an e-mail, or to devices capable of receiving email messages such as an alphanumeric pager or cell phone. These notifications are triggered by “events” in Oracle Utilities Network Management System - Trouble Management. For example, a notification could be used to alert a marketing staff member that an unplanned outage affects a critical customer. This would enable the marketing person to contact the customer to provide up to date information about the status of the outage. Similarly, an operations staff member could be notified about the outage while away from the office.

As a notification engine, Service Alert provides for configurable delivery options through use of an administration tool, and dynamic message format control facilitated by XSL transformation of an XML-based message payload. This gives the administrator the ultimate power and flexibility in determining the routing and content of all notifications.
Service Alert Admin Login Window

The Login window is the first Service Alert Administration window you see. You must enter a valid user name and password, and then click the Validate button. Once your user name and password are validated, the system populates the option menu that allows you to select a user type.

The Login window displays the following fields and buttons:

- The **User ID** field allows you to enter the user name provided to you by the system administrator.
- The **Password** field allows you to enter the password provided to you by the system administrator.
- The **Validate** button verifies your login credentials. If the user name and password are not entered correctly, the system displays a warning dialog box.
- The **User Type** drop-down menu contains the list of user types within your authority.
- The **Login** button allows you to complete the login process. Once you click the Login button, the Service Alert Administration window opens, based upon the User Type selected.
- The **Quit** button exits the Login window.

Logging In

To login to Service Alert Administration, complete these steps:

1. Depending on how your system was installed, either:
   - Click the **Service Alert** icon found under the appropriate program group in your Windows Start Menu, or
   - Double click the **Service Alert** icon on your desktop, or
   - Open a web browser and type the Service Alert URL in the browser's Address field. The Service Alert Administration Tool Login window displays.

2. Enter your user name.

3. Enter your password.

4. Click the **Validate** button. The bottom portion of the Service Alert Administration Tool Login window sensitizes.

5. Select the appropriate **User Type** from the drop-down menu.

6. Click the **Login** button. The Service Alert Administration window opens.

Service Alert Administration Window

The Service Alert Administration Tool enables you to configure message delivery options. It contains the following tabs:

- **Group Manager Tab**
- **Contact Manager Tab**
- **Parameter Manager Tab**
- **Using the Utility Customers Tab**
- **Using the Attributes Manager**
Managing Groups

The Group Manager tab on the Service Alert Administration Tool window is used to add, edit or remove contact groups, as well as specify the notification format for a group based on each notification type. A group is used in defining notification parameters. A notification parameter is the definition of a rule used to trigger a notification. Every parameter requires a group of contacts to be specified. This group specifies the intended recipients of a notification.

From the Group Manager tab, you can perform the following tasks:

- **Adding a Group**
- **Removing a Group**
- **Adding a Contact to a Group**
- **Removing a Contact from a Group**
- **Modifying the Message Transformation File**

For a description of the fields and buttons on this tab, see the following topic.

**Group Manager Tab**

The Group Manager tab contains the following information:

- **Groups** panel displays a list of all groups in the system. A group does not need to contain any contacts, nor does it need to be associated with a notification parameter.
  - The **Add…** button on the Groups panel opens the Add Group dialog. This dialog allows a new, empty group to be created. Each group must have a unique name.
  - The **Remove** button on the Groups panel deletes the group from the database. This will also delete all parameters associated with the group, but contacts that are members of the group are not deleted.

- **Contacts** panel displays a list of the individual members in the selected group.
  - The **Add…** button on the Contacts panel opens the Add Contact dialog. This dialog allows contacts to be added to the selected group.
  - The **Remove** button on the Contacts panel removes the selected contact from the selected group.

- **Message Types** panel displays a list of the available notification message types that the selected group can receive.

- **Transforms** panel contains information regarding the transforms for the selected message type.
  - The **Email** field displays the transform, in the form of an XSL file, which will be applied to the notifications of the selected notification type bound for an email destination corresponding to members of the selected group.
  - The **Pager** field displays the transform, in the form of an XSL file, which will be applied to the notifications of the selected notification type bound for a pager destination corresponding to members of the selected group. A pager is considered to be any device capable of receiving email messages such as digital cellular phone or alphanumeric pager.
  - The **Printer** field displays the transform, in the form of an XSL file, which will be applied to the notifications of the selected notification type bound for a printer destination corresponding to members of the selected group.
  - The **Modify Transform** button saves the XSL file information to the database for the selected group and notification type. The user must verify that the specified XSL file is available in the designated location.
Adding a Group

To add a group, complete these steps:
1. Click the **Group Manager** tab on the Service Alert Administration Tool.
2. Click the **Add** button below the Groups list. The Add Group dialog opens.
3. Enter a group name in the Group Name text field.
4. Click **OK** to create a group, or **Cancel** to avoid creating the group.

Removing a Group

To remove a group, complete these steps:
1. Click the **Group Manager** tab on the Service Alert Administration Tool.
2. Click on a group on the **Groups** list. The highlighted group is the group to be removed.
3. Click the **Remove** button below the Groups list. A confirmation dialog opens.
4. Click **Yes** to remove the group, or **No** to avoid removing the group.

Adding a Contact to a Group

To add a contact to a group, complete these steps:
1. Click the **Group Manager** tab on the Service Alert Administration Tool.
2. Click on a group on the **Groups** list. The highlighted group is the group to which a contact will be added.
3. Click on the **Add** button below the Contacts list. The Select Contact dialog opens. The Contacts table in the Select Contact dialog displays all the contacts in the system that do not belong to the selected group.
4. Click on a row in the Contacts table. The Contacts table contains the following columns:
   - **ID** – System assigned unique id for the contact.
   - **External ID** – A unique identifier that is useful for identifying an individual, particularly when that individual has more than one contact entry. Sorting on the External ID allows for quick viewing of all an individual's contact entries, e.g., Employee ID.
   - **Name** – The contact's name.
   - **Email** – The contact's email address.
   - **Pager** – The contact's pager address.
   - **Active** – A flag to indicate whether or not the contact is enabled in the system. Disabled contacts cannot receive notifications. Note that the table row colors correspond to whether a contact is active (white) or inactive (light blue).
   - **Printer** – The contact's printer name.
5. Click **OK** to add the selected contact to the group, or **Cancel** to avoid adding the contact to the group.

Removing a Contact from a Group

To remove a contact from a group, complete these steps:
1. Click the **Group Manager** tab on the Service Alert Administration Tool.
2. Click on a group on the **Groups** list. The highlighted group is the group from which a contact will be removed. The Contacts list displays the contacts in the selected group.
Managing Contacts

3. Click on a contact on the Contacts list. This is the contact to be removed.

4. Click the Remove button below the Contacts list. The Remove Contact From Group dialog opens.

5. Click Yes to remove the contact from the group, or No to avoid removing the contact from the group.

Modifying the Message Transformation File

To modify the transform for a given group and notification type, complete these steps:

1. Click the Group Manager tab on the Service Alert Administration Tool.

2. Click on a group on the Groups list. The highlighted group is the group for which the transformation filename will be modified.

3. Click on a notification type in the Message Type list. The highlighted type will be the notification type for which the transformation filename will be modified. The Email, Pager, and Printer transformation filename fields display default values for each transformation.

4. Modify the filenames associated with each transform.

5. Click Modify Transform to save the filenames to the database.

Managing Contacts

The Contact Manager tab allows you to perform the following tasks:

• Adding a Contact
• Editing a Contact
• Selecting a Paging Provider
• Removing a Contact

For a description of the fields and buttons on this tab, see the following topic.

Contact Manager Tab

The Contact Manager tab is used to add, edit, or remove contact information. The contact information contains identification information to associate each entry with an individual, as well as details regarding contacting the individual when a notification occurs. Note that an individual may have many contact entries. All contact entries in the system are listed in the Contacts table. Disabled contacts cannot receive notifications.

The Contact Manager tab displays the following fields and buttons:

• The Contacts panel lists all contact entries in the system. Note that the table row colors correspond to whether a contact is active (white) or inactive (bluish gray). For convenience, the rows in the table can be sorted in ascending or descending order by clicking on any column header.
  • The ID column contains the system assigned unique id for the contact.
  • The External ID column contains a unique identifier that is useful for identifying an individual, particularly when that individual has more than one contact entry. Sorting on the External ID allows for quick viewing of all an individual's contact entries.
  • The Name column contains the contact's name.
  • The Email column contains the contact's email address.
  • The Pager column contains the contact's pager address.
  • The Printer column contains the contact's printer name.
• The **Add** button activates the editable fields in the Contact Information panel, which allows you to add a new contact.

• The **Edit** button allows the user to edit contact information for the contact selected in the Contacts table.

• The **Remove** button removes the currently selected contact parameter from the system.

• The **Contact Information** panel is where the details for a contact are entered and/or edited.

• The **ID** field contains the system assigned unique id for the contact. This value is not editable by the user and therefore the field is always disabled.

• The **Groups** field contains the groups to which this contact belongs. This field is not editable by the user, although group memberships can be modified on the Group Manager panel.

• The **Name** field contains the contact’s name. This field can be edited when in add/edit mode. For sorting purposes, it is recommended that names be entered in “Last name, First Name” type format.

• The **External ID** field contains a unique identifier that is useful for identifying an individual, particularly when that individual has more than one contact entry. Sorting on the External ID allows for quick viewing of all an individual’s contact entries. A work phone number (possibly concatenated with a phone extension) could be used, for example.

• The **Email** field contains the contact’s email address. This field can be edited when in add/edit mode.

• The **Printer** field contains the contact’s printer name. This field can be edited when in add/edit mode.

• The **Pager** field contains the contact’s pager address. This field can be edited when in add/edit mode. This value will be the email alias for a pager device for the contact. The button next to the field allows the user to browse for a paging provider to assist in constructing the pager address string.

• The **button opens the Select a Paging provider dialog. This dialog provides a convenient means for select a paging provider used in constructing the email alias for a pager.**

• The **Active** checkbox enables/disables the contact entry. Disabled contacts do not receive notifications.

• The **Save** button saves the contact information currently being added/edited to the database.

• The **Cancel** button cancels the current add/edit operation.

---

### Adding a Contact

To add a contact, complete these steps:

1. Click the **Contact Manager** tab on the Service Alert Administration Tool.

2. Click the **Add** button below the Contacts table. The appropriate fields in the Contact Information section become enabled.

3. Fill in the following fields: Name, External ID, Email (optional), Pager (optional), Printer (optional), and Active. The **Save** button becomes enabled.

4. If necessary, select a paging provider. See the next section for instructions regarding selecting a paging provider.

5. Click the **Save** button to save the contact information.
Managing Contacts

**Note:** Creating a contact with a blank email, pager, and printer address effectively disables notification of the contact.

**Editing a Contact**

To edit a contact, complete these steps:

1. Click the **Contact Manager** tab on the Service Alert Administration Tool.
2. Click on a row in the **Contacts** table. This row represents the contact to be edited.
3. Click the **Edit** button below the Contacts table. The appropriate fields become enabled.
4. Modify one or more of the following fields: Name, External ID, Email, Pager, Printer, and Active.
5. If necessary, select a paging provider. See **Selecting a Paging Provider** on page 11-7 for instructions regarding selecting a paging provider.
6. Click the **Save** button to save the contact information.

**Note:** Editing a contact to have a blank email, pager, and printer address effectively disables notification of the contact.

**Selecting a Paging Provider**

To select a paging provider, complete these steps:

1. Click on the **Search** icon next to the Pager field. The Select a Paging Provider dialog appears.
2. Click on a row in the **Paging Providers** table. This row represents the paging provider to be chosen. The Paging Providers table contains the following columns:
   - **Provider** – The name of the paging provider company.
   - **Prefix** – A description of how an email alias for the pager is constructed. Typically, a sample prefix will be concatenated with the domain name.
   - **Domain Name** – The domain name used to construct the email alias for the pager device.
3. Click **OK** to choose the selected paging provider, or **Cancel** to dismiss the dialog without selecting a provider. The Select Paging Provider dialog closes.
4. Edit the **Pager** text field as appropriate.

**Note:** The paging provider table is populated during the system installation. If you need to add, edit or modify paging provider information then please contact your system administrator.

**Removing a Contact**

To remove a contact, complete these steps:

1. Click the **Contact Manager** tab on the Service Alert Administration Tool.
2. Click on a row in the **Contacts** table. This row represents the contact to be removed.
3. Click the **Remove** button below the Contacts table. The Remove Contact dialog opens.
4. Click **Yes** to remove the contact from the system, or **No** to avoid removing the contact from the system.
Using the Parameter Manager

The Parameter Manager tab is used to add, edit, or remove notification triggering parameter information. A notification triggering parameter is the rule for defining a notification trigger within Service Alert. A parameter consists of a name, a threshold value, a group to notify when a violation occurs, and an associated control zone, device, or customer. Inactive parameters cannot be violated, and therefore will never trigger a notification.

The Parameter Manager tab allows you to perform the following tasks:

- Adding a Customer Count Parameter
- Adding a Specific Customer Parameter
- Adding a Frequency of Outages Parameter
- Adding a Storm Affecting Control Zone Parameter
- Editing a Parameter
- Removing a Parameter

For a description of the fields and buttons on this tab, see the following topic.

Parameter Manager Tab

The Parameter Manager tab is contains two panels:

- Parameters Panel
- Parameter Information Panel

Parameters Panel

The Parameters Panel displays the following fields and buttons:

- The Parameters panel lists all parameters in the system. Note that the table row colors correspond to whether a parameter is active (white) or inactive (bluish gray). For convenience, the rows in the table can be sorted in ascending or descending order by clicking on any column header.
- The ID column contains the system assigned internal id for the parameter.
- The Name column contains a descriptive name given to the parameter.
- The Type column contains the notification type on which the parameter is based.
- The Group column contains the group of contacts to be notified when a parameter violation occurs.
- The Value column contains the threshold value used in determining if a parameter violation has occurred. The units for this value are based on the notification type. For example, the parameter value unit of for the "Outage" notification type is “number of customers out.” The “Outage affecting critical customer(s)” notification parameter value unit is “number of critical customers out.”
- The Event Type column contains the name(s) of the specific event type(s) this notification will be triggered for.
- The Event State column contains the name(s) of the specific event state(s) this notification will be triggered for. (Currently only used for Specific customer affected by unplanned outage notification.)
- The Use Event States column contains a flag to indicate whether the Event State trigger is active for the parameter.
- The Time Interval column contains the time interval associated with the parameter, if applicable.
- The **Disable During Storm** column contains a flag to indicate whether parameter violation should be suppressed when the associated control zone is in storm mode or the associated device resides in a control zone that is in storm mode. Storm modes are defined as part of Oracle Utilities Network Management System – Trouble Management configuration (rule sets applied to a control zone in the Authority tool).

- The **Account** column contains the account number of the customer associated with the parameter, if applicable.

- The **Device** column contains the device to which the parameter applies.

- The **Device Class** column contains the type of device to which the parameter applies, if applicable.

- The **Control Zone** column contains the control zone to which the parameter applies.

  **Note:** A parameter must specify either a control zone or a device (but not both).

- The **Customer Types** column contains the critical customer types used in calculations for the associated notification.

- The **Planned** column displays Y if notification should only be triggered for planned events.

- The **Add** button activates the editable fields in the Parameter Information panel, which allows you to add a new parameter.

- The **Edit** button allows you to edit the currently selected parameter.

- The **Remove** button removes the currently selected parameter from the system.

### Parameter Information Panel

The Parameter Information Panel is where the details for a parameter are entered and/or edited. The Parameter Information Panel displays the following fields and buttons:

  **Note:** The fields and buttons on this panel vary depending on the type of notification.

- The **Name** field displays the descriptive name given to the parameter. This value can be modified be when in add/edit mode.

- The **Select Contact Groups** button brings up the Select Contact Groups dialog for selecting one or more groups to be notified when the parameter is violated. You can use the `<Ctrl>` key in conjunction with the left mouse button to make multiple selections or deselect a group in the Select Contact Groups dialog. This button is enabled when in add/edit mode.

- The **Type** field displays a list of enumerated notification types to which this parameter applies. This value can be selected be when in add/edit mode.

  - Outage
  - Outage Affecting Critical Customer(s)
  - Outage Affecting Specific Customer
  - Frequency of Outages on a Device
  - Storm Affecting Control Zone

- The **Value** field displays the parameter threshold value. This value can be modified when in add/edit mode.

- The **Event Type** radio group allows you to select whether notification should be triggered by Planned or Unplanned events. This is only displayed for outage-type notifications.

  - The **Select Event Types** button brings up the Select Event Types dialog for selecting one or more event types that will trigger the notification when the parameter is violated. You can use the `<Ctrl>` key in conjunction with the left mouse button to make multiple
selections or deselect a group in the Select Event Types dialog. This button is enabled
when in add/edit mode only when Unplanned Event Type is selected.

- The **Trigger** group allows you to select the event status that will trigger the notification. This
group may contain one or more of the following options:
  
  - **Scheduled** - This checkbox is enabled only for outage notifications where the Event
    Type is Planned. If this is checked, the system will generate a notification when a
    switching sheet reaches the scheduled state, provided that other notification conditions
    are met.
  
  - **Started/In-Progress** - This checkbox is enabled only for outage notifications. If this is
    checked, the system will generate a notification when a planned or unplanned outage is
    started, provided that other notification conditions are met.
  
  - **Restored** - This checkbox is enabled only for outage notifications. If this is checked,
    the system will generate a notification when a planned or unplanned outage is restored,
    provided that other notification conditions are met.
  
  - **Cancelled** - This checkbox is enabled only for outage notifications. If this is checked,
    the system will generate a notification when a switching sheet reaches cancelled state or
    when an unplanned outage is cancelled, provided that other notification conditions are
    met.
  
  - **ERT Updated** - This checkbox is enabled only for outage notifications where the Event
    Type is Unplanned. If this is checked, the system will generate a notification when an
    ERT is manually updated for an unplanned outage, provided that other notification
    conditions are met.
  
  - **Storm Started / Storm Ended** - These checkbox is enabled only if the notification type
    is Storm Affecting Control Zone. Check the box indicating when the notification should
    be generated, either when the storm starts or ends.
  
- The **Device** field displays the alias of the device to which the parameter applies. A parameter
  may specify either a control zone or a device (but not both). This value can be modified when
  in add/edit mode, depending upon the type of notification selected.
  
  - The **Device Search** button displays the Device Search dialog, allowing you to search for
    a device to associate with the parameter, if applicable.
  
  - The **Clear** button to the right of the Device Search button clears the Device field when
    pressed.
  
- The **Device Class** field displays the class or type of device to which the parameter applies.
  This value can be modified be when in add/edit mode, depending upon the type of
  notification selected.
  
  - The **Select Device Class** button displays the Select Class dialog, allowing you to select a
    type of device to associate with the parameter, if applicable.
  
  - The **Clear** button to the right of the Select Device Class button clears the Device Class
    field when pressed.
  
- The **Control Zone** field displays the control zone of the device to which the parameter
  applies. A parameter must specify either a control zone or a device (but not both). This value
  can be modified when in add/edit mode.
  
  - The **Select Zone** button displays the Select Control Zone dialog, allowing you to
    associate the parameter with a control zone, if applicable.
  
  - The **Clear** button to the right of the Control Zone field clears the Control Zone field
    when pressed.
• Click the **Use Event States** checkbox if you want to select specific event states that will trigger the notification when the parameter is violated. If checked, the **Select Event States** button is enabled.

• The **Select Event States** button brings up the Select Event States dialog for selecting one or more event states. You can use the `<Ctrl>` key in conjunction with the left mouse button to make multiple selections or deselect a group in the Select Event Types dialog. This button is enabled when in add/edit mode.

• The **Time Interval** field displays the time interval value associated with the parameter. This value can be modified when in add/edit mode, depending upon the type of notification selected.

• The **Specify Time Interval** button displays the Specify Time Interval dialog, allowing you to specify what time interval should be used for the parameter, if applicable.

• The **Clear** button to the right of the Specify Time Interval button clears the Time Interval field when pressed.

• The **Customer Account** field displays the account number of the customer associated with the parameter, if applicable.

• The **Account Search** button displays the Select Account dialog, allowing you to search for a particular customer account to associate with the parameter, if applicable.

• The **Clear** button to the right of the Customer Account field clears the Customer Account field when pressed.

• The **Disable During Storm** checkbox allows you to enable/disable the parameter during storm mode.

• The **Active** checkbox allows you to enable/disable the parameter.

• The **Select Customer Types** button allows you to select one or more customer types to be considered in the calculations for the notification. This button is displayed only for notifications that involve critical customers.

When you click this button, the Select Customer Type dialog opens. Select the customer types to include, then click **OK**.

**Note:** If a customer belongs to more than one of the selected customer types, the customer is only counted once in the calculation.

• The **Save** button saves the parameter information.

• The **Cancel** button cancels an add/edit parameter operation.
### About Parameter Values

A parameter must have certain required data specified before it may be saved. A parameter consists of a name, a threshold value, a group to notify when a violation occurs, and an associated control zone, device, or customer. The parameter value has a different meaning in the context of each of the various notification types. The following table gives the units for each notification type.

<table>
<thead>
<tr>
<th>Notification Type</th>
<th>Parameter Value Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outage</td>
<td>Number of customers affected</td>
</tr>
<tr>
<td>Outage affecting critical customers</td>
<td>Number of critical customers affected</td>
</tr>
<tr>
<td>Outage affecting specific customer</td>
<td>N/A</td>
</tr>
<tr>
<td>Frequency of outages on a device</td>
<td>Number of outages</td>
</tr>
<tr>
<td>Storm affecting control zone</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Note:** A group must exist to save the parameter. Use the Group Manager tab to create a group if one does not already exist.

Different notification types have different additional data required. The following table lists the other required values for each notification type.

<table>
<thead>
<tr>
<th>Notification Type</th>
<th>Other Required Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outage</td>
<td>Event Type, Trigger, Device or Control Zone or Device Class and Control Zone</td>
</tr>
<tr>
<td>Outage affecting critical customers</td>
<td>Event Type, Trigger, Device or Control Zone or Device Class and Control Zone</td>
</tr>
<tr>
<td>Outage affecting specific customer</td>
<td>Event Type, Trigger, Customer Account</td>
</tr>
<tr>
<td>Frequency of outages on a device</td>
<td>Time Interval, Device or Device Class or Control Zone</td>
</tr>
<tr>
<td>Storm affecting control zone</td>
<td>Trigger, Control Zone</td>
</tr>
</tbody>
</table>

### Adding a Customer Count Parameter

To add either an Outage notification parameter or an Outage affecting critical customer(s) notification parameter, complete these steps:

1. Click the **Parameter Manager** tab on the Service Alert Administration Tool.
2. Click the **Add** button beneath the Parameters table. The appropriate fields on the Parameter Information panel become enabled.
3. Enter a descriptive name for the parameter into the **Name** field.
4. Click the **Select Contact Groups** button. The Select Contact Groups dialog appears.
5. Select one or more groups to be notified when the parameter is violated from the Select Contact Groups dialog.
6. Click the OK button on the Select Contact Groups dialog. The Select Contact Groups dialog disappears.

7. Select either “1. Outage” or “2. Outage affecting critical customer(s)” from the Type dropdown menu.

8. Enter a number in the Value field that represents the number of customers (for an Outage notification) or the number of critical customers (for an Outage affecting critical customer(s) notification) that must be out in order to trigger the notification.

9. Select either Unplanned or Planned from the Event Type radio group.

10. To limit the types of events that can trigger the notification, click the Select Event Types button, then make your selection(s) on the Select Event Types dialog. If no selection is made, then the notification is triggered by all event types.

11. Select one or more check boxes in the Trigger section to specify when this notification should be triggered.

12. Either specify a device or a control zone for the parameter. This is used in conjunction with the Value in order to trigger the notification.

13. To specify a device, either type a device name into the Device field, or do the following:
   - Click the Device Search button. The Device Search dialog opens.
   - Enter your search criteria into the Search Text field. You may use an asterisk (*) as a wildcard.
   - Click the Search button. The search results are displayed in the table.
   - Select the desired device from the table, and then click the OK button. The Device Search dialog disappears, and the Device field is populated with the name of the selected device.

14. To specify a control zone, do the following:
   - Click the Select Zone button. The Select Control Zone dialog opens.
   - Select the desired control zone from the tree, and then click the OK button. The Select Control Zone Dialog disappears, and the Control Zone field is populated with the name of the selected control zone.

15. Select/deselect the Use Event States, Disable During Storm, and Active checkboxes as desired.

16. Click the Save button to save the parameter.

Adding a Specific Customer Parameter

To add an Outage affecting a specific customer parameter, complete these steps:

1. Click the Parameter Manager tab on the Service Alert Administration Tool.

2. Click the Add button beneath the Parameters table. The appropriate fields on the Parameter Information panel become enabled.

3. Enter a descriptive name for the parameter into the Name field.

4. Click the Select Contract Groups button. The Select Contract Groups dialog appears.

5. Select one or more groups to be notified when the parameter is violated from the Select Contract Groups dialog.

6. Click the OK button on the Select Contract Groups dialog. The Select Contract Groups dialog disappears.
7. Select either “3. Outage affecting specific customer notification” from the Type drop-down menu.

8. Select either Unplanned or Planned from the Event Type radio group.

9. To limit the types of events that can trigger the notification, click the Select Event Types button, then make your selection(s) on the Select Event Types dialog. If no selection is made, then the notification is triggered by all event types.

10. Select one or more check boxes in the Trigger section to specify when this notification should be triggered.

11. Click the Account Search button to bring up the Account Search dialog.

12. Select a search criterion on the Search Parameter drop-down menu.

13. Enter text into the Search Text field according to the search criterion selected in the previous step. Note that an asterisk (“*”) serves as a wildcard.

14. Click the Search button. The search results are displayed in the table.

15. Select the desired account from the table, and then click the OK button. The Account Search dialog disappears, and the Customer Account field is populated with the account number of the selected customer account.

16. Select/deselect the Use Event States, Disable During Storm, and Active checkboxes as desired.

17. Click the Save button to save the parameter.

Adding a Frequency of Outages Parameter

To add a Frequency of Outages on a Device Notification parameter, complete these steps:

1. Click the Parameter Manager tab on the Service Alert Administration Tool.

2. Click the Add button beneath the Parameters table. The appropriate fields on the Parameter Information panel become enabled.

3. Enter a descriptive name for the parameter into the Name field.

4. Click the Select Contract Groups button. The Select Contact Groups dialog appears.

5. Select one or more groups to be notified when the parameter is violated from the Select Contract Groups dialog.

6. Click the OK button on the Select Contract Groups dialog. The Select Contact Groups dialog disappears.

7. Select “5. Frequency of outages on a device notification” from the Type drop-down menu.

8. Enter a number in the Value field that represents the number of outages there must be in order to trigger the notification.

9. If desired, click the Select Event Types button to bring up the Select Event Types dialog to limit the types of events that can trigger the notification. If no selection is made, then the default is all event types.

10. Click the Specify Time Interval button to bring up the Specify Time Interval dialog. Specify a time interval either as a certain number of hours/days/weeks/years.

To specify the time interval as having a specific begin date, complete these steps:

• Select the Begin Date radio button on the Specify Time Interval dialog. The Calendar button becomes enabled.

• Click on the Calendar button. The Calendar dialog appears.
• Specify the desired begin date and time in the Calendar dialog, then press the **OK** button. The Calendar dialog disappears, and the selected date/time now appears in the field next to the Begin Date radio button.

To specify the time interval as a certain number of hours/days/weeks/years, complete these steps:

• Select the **Time Window** radio button. The text field and drop-down button to the right of it become enabled.

• Select the desired unit of time from the drop-down menu and enter the desired number of units into the text field.

• Click the **OK** button on the Specify Time Interval dialog. The Specify Time Interval dialog disappears, and the Time Interval field is populated with the interval that was specified.

11. Either specify a device or a device class and control zone for the parameter. These are used in conjunction with the Value and Time Interval in order to trigger the notification.

To specify a device, either type a device name into the **Device** field, or do the following:

• Click the **Device Search** button to bring up the Device Search dialog.

• Enter your search criteria into the **Search Text** field. You may use an asterisk ('*') as a wildcard.

• Click the **Search** button. The search results are displayed in the table.

• Select the desired device from the table, and then click the **OK** button. The Device Search dialog disappears, and the Device field is populated with the name of the selected device.

To specify a device class and control zone combination, complete these steps:

• Click the **Select Device Class** button. The Select Class dialog appears.

• Select the desired device class from the tree, and then click the **OK** button. The Select Class dialog disappears, and the Device Class field is populated with the name of the device class.

• To specify a control zone, click the **Select Zone** button. The Select Control Zone dialog appears.

• Select the desired control zone from the tree, and then click the **OK** button. The Select Control Zone Dialog disappears, and the Control Zone field is populated with the name of the selected control zone.

12. Select/deselect the **Use Event States**, **Disable During Storm**, and **Active** checkboxes as desired.

13. Click the **Save** button to save the parameter.

### Adding a Storm Affecting Control Zone Parameter

To add a Storm Affecting Control Zone parameter, complete these steps:

1. Click the **Parameter Manager** tab on the Service Alert Administration Tool.

2. Click the **Add** button beneath the Parameters table. The appropriate fields on the Parameter Information panel become enabled.

3. Enter a descriptive name for the parameter into the **Name** field.

4. Click the **Select Contract Groups** button. The Select Contact Groups dialog appears.

5. Select one or more groups to be notified when the parameter is violated from the **Select Contract Groups** dialog.
6. Click the OK button on the Select Contact Groups dialog. The Select Contact Groups dialog disappears.

7. Select “6. Storm affecting control zone” from the Type drop-down menu.

8. Check Storm Started and/or Storm Ended in the Trigger.

9. Click the Select Zone button. The Select Control Zone dialog appears.

10. Choose the desired control zone for the alert and click OK. The Control Zone field will be populated with your choice.

11. Click the Save button to save the parameter.

**Editing a Parameter**

To edit a parameter, complete these steps:

1. Click the Parameter Manager tab on the Service Alert Administration Tool.

2. Click on one of the existing parameters in the Parameters table. The Edit button becomes enabled.

3. Click on the Edit button. The appropriate fields will become enabled.

4. Edit each field as desired.

5. Click Save to save the edited information, or click Cancel to avoid saving the edited information.

**Removing a Parameter**

To remove a parameter, complete these steps:

1. Click the Parameter Manager tab on the Service Alert Administration Tool.

2. Click on one of the existing parameters in the Parameters table. The Remove button becomes enabled.

3. Click the Remove button. The Remove Parameter dialog opens.

4. Click Yes to remove the parameter or No to avoid removing the parameter.

**Using the Utility Customers Tab**

The Utility Customers tab is used for designating customers as being “critical” within Service Alert and entering contact information for each critical customer. This information will display in the “Outage affecting critical customer(s)” notification. To “import” a customer into Service Alert, an “add” operation must be performed. Once the customer has been added, customer contacts can be associated with the account. Each customer contact can also have one or more phone entries, which indicate how the customer contact can be reached. To bring up contact information for an existing Service Alert Critical account, a “search” must be performed.

The Utility Customers tab allows you to perform the following tasks:

- Adding an Account to Service Alert
- Searching for an Account
- Editing an Account
- Removing an Account
- Editing Customer Device Information
• Adding Customer Contact Information
• Searching for a Customer Contact
• Editing Customer Contact Information
• Removing Customer Contact Information
• Adding Customer Contact Phone Information
• Editing Customer Contact Phone Information
• Removing Customer Contact Phone Information

For a description of the fields and buttons on this tab, see the following topic.

Utility Customers Tab

The Utility Customers tab displays the following fields and buttons:

• The header section contains details regarding a specific customer account.
• The Account Number field displays the account number of the critical customer.
• The Name field displays the name of the critical customer.
• The Address field displays the address of the critical customer.
• The Client Type menu allows you to specify a client type value for the critical customer. The available options are Undetermined, Office, Computer Data Center, Communications, Shelter, Command Center, Company Executives, and Business Leaders.
• The Add button displays the Add Account dialog. This dialog allows you to add a critical customer into Service Alert. The main reason for doing this is to associate contact and contact phone information with the critical customer.
• The Edit button places the header section into edit mode, allowing you to modify both the customer account name and the client type value.
• The Remove button removes an account from Service Alert. This does not affect the customer's entries in the Oracle Utilities Network Management System tables.
• The Search button displays the Search Account dialog. This dialog allows you to search for a critical customer that was previously added to Service Alert.
• The Save button allows you to save any changes you made while the header section was in edit mode, and returns the section to non-editable mode.
• The Cancel button returns the section to non-editable mode without saving any changes.
• The Customer Devices panel displays a list of devices that are associated with the currently selected account. For convenience, the rows in the table can be sorted in ascending or descending order by clicking on any column header.
• The Service Location ID column contains the service location identification value for the device.
• The Device ID column contains the identification value for the device.
• The Load Transfer column contains the load transfer value for the device. The available options are NONE, AUTOMATIC, and MANUAL.
• The Load Shed column contains the load shed value for the device. The available options are NO and YES.
• The Edit... button brings up the Device Information dialog, allowing you to modify the Load Transfer and Load Shed values of the selected device.
• The **Customer Contacts** panel contains the list of contacts for the currently selected account. For convenience, the rows in the table can be sorted in ascending or descending order by clicking on any column header.

• The **ID** column contains the system assigned unique id for the customer contact entry.

• The **Name** column contains the customer contact name.

• The **Title** column contains the customer contact title, if applicable.

• The **Instructions** column contains general instructions for contacting this individual.

• The **Add** button displays the Add/Edit Customer Contact dialog. This dialog allows you to add a customer contact.

• The **Edit** button displays the Add/Edit Customer Contact dialog. This dialog allows you to edit a customer contact.

• The **Remove** button removes the contact from the critical customer contact listing.

• The **Search…** button displays the Search Customer Contacts dialog. This dialog allows you to search for a customer contact that was previously added to Service Alert.

• The **Customer Contact Phones** panel displays phone information for the currently selected contact in the Customer Contacts table. For convenience, the rows in the table can be sorted in ascending or descending order by clicking on any column header.

• The **ID** column contains the system assigned unique id for the customer contact phone entry.

• The **Type** column contains the type of phone (Office, Home, Cell, etc.).

• The **Number** column contains the phone number.

• The **Ext** column contains the phone extension, if applicable.

• The **Call Time** column contains the time of day to call the individual using this phone number (Anytime, Daytime, Nighttime, etc.).

• The **Sequence** column contains the preferred calling order for reaching the customer contact.

• The **Add** button displays the Add/Edit Customer Contact Phone dialog. This dialog allows you to add a customer contact phone entry.

• The **Edit** button displays the Add/Edit Customer Contact Phone dialog. This dialog allows you to edit a customer contact phone entry.

• The **Remove** button removes the contact phone entry from the selected contact’s list of phone contact information.

### Adding Accounts

The Add Account dialog opens once you press the **Add** button on the header section of the Utility Customers tab in the Service Alert Administration Tool. This dialog allows you to add a critical customer into Service Alert.

The Add Account dialog displays the following fields and buttons:

• The **Search Text** field displays the text used to search for a critical customer account. The text varies based on the search parameter. The asterisk character (‘*’) serves as a wildcard.

• The **Search Parameter** field displays the current search parameter. The available parameters are Account Number, Account Name, Phone Number, Address, City State, and Zip Code.

• The **Search** button performs a critical customer search within the Oracle Utilities Network Management System database based upon the Search Text and Search Parameter.

• The **Clear** button clears the Search Text field and the search results table.
• The **Account Number** column displays the account number of the critical customer.
• The **Account Name** column displays the account name of the critical customer.
• The **Phone Number** column displays the phone number of the critical customer.
• The **Address** column displays the address of the critical customer.
• The **City State** column displays the city and state portion of the critical customer's address.
• The **Zip Code** column displays the zip code of the critical customer.
• The **Emergency** column is a flag to indicate that this is an Emergency customer.
• The **Key** column is a flag to indicate that this is a Key customer.
• The **Medical** column is a flag to indicate that this is a Medical customer.
• The **OK** button adds the customer to Service Alert and closes the Add Account dialog.
• The **Cancel** button closes the Add Account dialog without adding the customer to Service Alert.

**Adding an Account to Service Alert**

To add an account to Service Alert, complete these steps:

1. Click the **Utility Customers** tab on the Service Alert Administration Tool.
2. Click the **Add** button just below the Account Number / Name / Address fields. The Add Account dialog opens.
3. Select a search criterion on the **Search Parameter** drop menu.
4. Enter text into the **Search Text** field according to the search criterion selected in the previous step. Note that an asterisk (**) serves as a wildcard.
5. Click the **Search** button to perform a search for critical customers in the Oracle Utilities Network Management System database. The search result table populates with a set of customer data.
6. Select a customer by clicking on a row in the table. The **OK** button becomes enabled.
7. Click **OK** to add the customer to Service Alert, or **Cancel** to avoid adding the account.

**Searching for an Account**

The Search Account dialog opens once you press the **Search** button on the header section of the Utility Customers tab in the Service Alert Administration Tool. This dialog allows you to search for a critical customer that was previously added to Service Alert.

The Search Account dialog contains the following information:

• The **Search Text** field displays the text used to search for a critical customer account within the Service Alert tables. The text varies based on the search parameter. The asterisk character (**) serves as a wildcard.
• The **Search Parameter** field displays the current search parameter. The available parameters are Account Number, Account Name, Phone Number, Address, City State, and Zip Code.
• The **Search** button performs a critical customer search within the Service Alert database based on the search text and search parameter. The search is executed against customers previously added to Service Alert by means of **Adding Accounts** functionality.
• The **Clear** button clears the Search Text field and the search results table.
• The **Account Number** column displays the account number of the critical customer.
• The **Account Name** column displays the account name of the critical customer.
Using the Utility Customers Tab

- The **Phone Number** column displays the phone number of the critical customer.
- The **Address** column displays the address of the critical customer.
- The **City State** column displays the city and state portion of the critical customer’s address.
- The **Zip Code** column displays the zip code of the critical customer.
- The **Emergency** column is a flag to indicate that this is an Emergency customer.
- The **Key** column is a flag to indicate that this is a Key customer.
- The **Medical** column is a flag to indicate that this is a Medical customer.
- The **OK** button populates the Utility Customer panel with customer information, including contacts and contact phone entries, and closes the Search Account dialog.
- The **Cancel** button closes the Search Account dialog.

**Searching for an Account in Service Alert**

To search for an account, complete these steps:

1. Click the **Utility Customers** tab on the Service Alert Administration Tool.
2. Click the **Search** button just below the Account Number / Name / Address fields. The Search Account dialog opens.
3. Select a search criterion on the **Search Parameter** drop menu.
4. Enter text into the **Search Text** field according to the search criterion selected in the previous step. Note that an asterisk (‘*’) serves as a wildcard.
5. Click the **Search** button to perform a search for critical customers within Service Alert. The search result table populates with a set of customer data.
6. Select a customer by clicking on a row in the table. The **OK** button becomes enabled.
7. Click **OK** to display the customer data and contact information on the Utility Customer panel, or **Cancel** to avoid selecting the account.

**Editing an Account**

To edit an account, complete these steps:

1. Search for an Account. (Refer to the previous topic for instructions). The customer account information loads into the header section.
2. Click the **Edit** button. The Name and Client Type fields become editable.
3. Edit the **Name** field and change the selected **Client Type** as desired.
4. Click the **Save** button. The changes are saved and the header section returns to non-edit mode. In order exit from edit mode without saving changes, click the **Cancel** button instead.

**Removing an Account**

To remove an account, complete these steps:

1. Search for an Account. (Refer to the previous topic for instructions). The **Remove** button becomes enabled.
2. Click the **Remove** button. The Remove Customer Account dialog opens.
3. Click **Yes** to remove the account from the system, or **No** to avoid removing the account from the system.
Editing Customer Device Information

To edit the load transfer or load shed information for a customer device, complete these steps:

1. Add an account or search for an account, as described in the previous topics.
2. Select a row in the Customer Devices table on the Utilities Customer tab and click the Edit button. The Device Information dialog opens.
3. Change the Load Transfer or Load Shed values as desired.
4. Click the OK button to close the dialog and save the changes, or click the Cancel button to exit from dialog without saving the changes.

Adding Customer Contact Information

To add customer contact information, complete these steps:

1. Add an account or search for an account, as described in the previous topics.
2. Click the Add button below the Customer Contacts table. The Add/Edit Contact dialog opens.
3. Enter in a Name and Title for the customer contact. If applicable, enter in general instructions, or any other relevant information, regarding the contacting of the individual. The OK button becomes enabled.
4. Click OK to add the customer contact information to the database or Cancel to avoid adding the information.

Searching for a Customer Contact

The Search Customer Contacts dialog opens once you press the Search button on the Customer Contacts section of the Utility Customers tab. This dialog allows you to search for a customer contact that was previously added to Service Alert.

The Search Customer Contacts dialog displays the following fields and buttons:

- The Search Text field displays the text used to search for a critical customer account within the Service Alert tables. The text varies based on the search parameter. The asterisk character (‘*’) serves as a wildcard.
- The Search Parameter field displays the current search parameter. The available parameters are Contact Name, Contact ID, Contact Title, Account Name, and Account Number.
- The Search button performs a customer contact search within the Service Alert database based on the search text and search parameter. The search is executed against customer contacts previously added to Service Alert by means of the Adding Customer Contact Information on page 11-21 functionality.
- The Clear button clears the Search Text field and the search results table.
- The Contact ID field contains the system assigned unique id for the customer contact entry.
- The Contact Name column contains the customer contact name.
- The Contact Title column contains the customer contact title, if applicable.
- The Account Name column displays the account name of the critical customer the contact is already associated with.
- The Account Number column displays the account number of the critical customer the contact is already associated with.

Service Alert Administration 11-21
• The **Add** button associates the selected contact with the currently displayed critical customer, including contacts and contact phone entries, adds a row for this contact to the Customer Contacts table, and closes the Search Customer Contacts dialog.

• The **Cancel** button closes the Search Customer Contacts dialog.

**Searching for a Customer Contact in Service Alert**

To search for a customer contact, complete these steps:

1. Add an account or search for an account.
2. Click the **Search** button just below the Customer Contacts table. The Search Customer Contacts dialog opens.
3. Select a search criterion on the **Search Parameter** drop menu.
4. Enter text into the **Search Text** field according to the search criterion selected in the previous step. Note that an asterisk (**) serves as a wildcard.
5. Click the **Search** button to perform a search for customer contacts within Service Alert. The search result table populates with a set of customer data.
6. Select a customer contact by clicking on a row in the table.
7. Click **Add** to associate the customer contact with the critical customer currently displayed on the Utility Customer panel, or **Cancel** to avoid adding a contact.

**Editing Customer Contact Information**

To edit customer contact information, complete these steps:

1. Search for an account that has customer contacts associated with it.
2. Click the **Edit** button below the Customer Contacts table. The Add/Edit Contact dialog opens.
3. Edit the **Name**, **Title**, and **Instructions** associated with the customer contact. The OK button becomes enabled.
4. Click **OK** to save the edited customer contact information to the database or **Cancel** to avoid saving the information.

**Removing Customer Contact Information**

To remove customer contact information, complete these steps:

1. Search for an account that has customer contacts associated with it.
2. Click on one of the existing contacts in the **Customer Contacts** table. The **Remove** button becomes enabled.
3. Click the **Remove** button below the Customer Contacts table. The Remove Contact dialog opens.
4. Click **Yes** to remove the contact's association with this account, or **No** to avoid removing the contact association.

**Adding Customer Contact Phone Information**

To add customer contact phone information, complete these steps:

1. Add an account or search for an account.
2. If the account does not have any associated contacts, add a customer contact.
3. Click on one of the existing contacts in the **Customer Contacts** table. The **Add** button below the Customer Contact Phones table becomes enabled.

4. Click the **Add** button below the Customer Contact Phones table. The Add/Edit Customer Contact Phone dialog opens.

5. Select the type of phone and call time from the drop menu **Type** and **Call Time** drop menus.

6. Enter a phone number in the **Number** field. If applicable, a phone extension can be entered in the text field to the right of the Number field.

7. Enter a non-negative value in the **Sequence** field. This number is used to indicate the priority of this phone entry relative to all other phone entries associated with the selected customer contact. The **OK** button becomes enabled.

8. Click **OK** to save the customer contact phone information to the database, or **Cancel** to avoid saving the phone information.

---

**Editing Customer Contact Phone Information**

To edit customer contact phone information, complete these steps:

1. Search for an account that has customer contacts associated with it.

2. Click on one of the existing contacts in the **Customer Contacts** table. The **Edit** button below the Customer Contact Phones table becomes enabled.

3. Click the **Edit** button below the Customer Contact Phones table. The Add/Edit Customer Contact Phone dialog opens.

4. Modify the selection the type of phone and call time from the drop menu **Type** and **Call Time** drop menus.

5. Edit a phone number in the **Number** field. Edit the phone extension in the text field to the right of the Number field.

6. Edit value in the **Sequence** field.

7. Click **OK** to save the customer contact phone information to the database, or **Cancel** to avoid saving the phone information.

---

**Removing Customer Contact Phone Information**

To remove customer contact phone information, complete these steps:

1. Search for an account that has customer contacts associated with it.

2. Click on one of the existing contacts in the **Customer Contacts** table.

3. Click on one of the contact phone entries in the **Customer Contact Phones** table. The **Remove** button below the Customer Contact Phones table becomes enabled.

4. Click the **Remove** button below the Customer Contact Phones table. The Remove Phone dialog opens.

5. Click **Yes** to remove the contact’s selected phone entry, or **No** to avoid removing the entry.
Using the Attributes Manager

The Attributes Manager tab is used to add, edit, or remove attribute information associated with specific devices. Attribute Information can be displayed on notifications trigger by the associated device. An attribute consists of a Device ID, Attribute ID, a name and a value. Inactive attributes cannot be violated, and therefore will never trigger a notification.

The Attributes Manager tab allows you to perform the following tasks:

• Adding Attributes
• Editing a Attribute
• Removing a Attribute

For a description of the fields and buttons on this tab, see the following topic.

Attributes Manager Tab

The Attributes Manager tab displays the following fields and buttons:

The Attributes panel lists all attributes known to Service Alert. Note that the table row colors correspond to whether a attribute is active (white) or inactive (bluish gray). For convenience, the rows in the table can be sorted in ascending or descending order by clicking on any column header.

• The Device ID column contains the device to which the attribute applies.
• The Attribute ID column contains the system assigned internal id for the attribute.
• The Attribute Name column contains a descriptive name given to the attribute.
• The Attribute Value column contains a value given to the attribute.
• The Add button displays the Device Search dialog, allowing you to search for a device to associate with the attribute.
• The Edit button allows you to edit the currently selected attribute.
• The Remove button removes the currently selected attribute from the Service Alert.

The Attribute Information panel is where the details for an attribute are entered and/or edited.

• The Device ID field displays the alias of the device to which the attribute applies.
• The Attribute ID field displays the system assigned internal id for the attribute.
• The Attribute Name field displays the descriptive name given to the attribute. This value can be modified be when in add/edit mode.
• The Attribute Value field displays the value given to the attribute. This value can be modified be when in add/edit mode.
• The Active checkbox allows you to enable/disable the attribute.
• The Save button saves the attribute information.
• The Cancel button cancels an add/edit attribute operation.
Adding Attributes

An attribute consists of a name and a value associated to a device or customer. The attribute information can be displayed on notifications triggered by the associated device.

1. Click the Attribute Manager tab on the Service Alert Administration Tool.
2. Click the Add button beneath the Attributes table to bring up the Device Search dialog.
3. Enter into the Search Text field your search criteria. You may use an asterisk (‘*’) as a wildcard.
4. Click the Search button. The search results are displayed in the table.
5. Select the desired device from the table, and then click the OK button. The Device Search dialog disappears, and the Device ID field is populated with the name of the selected device.
6. Enter a descriptive name for the attribute into the Attribute Name field.
7. Enter a value for the attribute into the Attribute Value field.
8. Select/deselect the Active checkbox as desired.
9. Click the Save button to save the attribute.

Editing a Attribute

To edit an attribute, complete these steps:

1. Click the Attribute Manager tab on the Service Alert Administration Tool.
2. Click on one of the existing attributes in the Attributes table. The Edit button becomes enabled.
3. Click on the Edit button. The appropriate fields will become enabled.
4. Edit each field as desired.
5. Click Save to save the edited information, or click Cancel to avoid saving the edited information.

Removing a Attribute

To remove an attribute, complete these steps:

1. Click the Attribute Manager tab on the Service Alert Administration Tool.
2. Click on one of the existing attributes in the Attributes table. The Remove button becomes enabled.
3. Click the Remove button. The Remove Attribute dialog opens.
4. Click Yes to remove the attribute or No to avoid removing the attribute.
Service Alert Notification Examples

Oracle Utilities Network Management System Service Alert sends the following types of notifications:

- Unplanned Outage Affecting Critical Customers
- Unplanned Outage Affecting a Specific Customer
- Planned Outage Affecting Many Customers
- Storm Ended
- Frequency of Device Operations
### Critical Customer(s) Affected By Unplanned Outage Notification

Generated by Oracle Utilities NMS Service Alert on **06-04-2010 11:15:29**

A Real Device Outage has been detected on device F1111 in the following location:

- **Company:** OPAL
- **Region:** Stark
- **Branch:** Lake
- **Substation:** Lake Sub
- **Feeder:** 2414

The following summary information was provided for this event:

<table>
<thead>
<tr>
<th>Event Number</th>
<th>1002</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outage Type</td>
<td>Real Device Outage</td>
</tr>
<tr>
<td>Outage Begin Time</td>
<td>06/04/10 11:15</td>
</tr>
<tr>
<td>Number of Calls Received</td>
<td>0</td>
</tr>
<tr>
<td>Total Number of Customers Affected</td>
<td>113</td>
</tr>
<tr>
<td>Emergency Customers Affected</td>
<td>3</td>
</tr>
<tr>
<td>Key Customers Affected</td>
<td>5</td>
</tr>
<tr>
<td>Medical Customers Affected</td>
<td>0</td>
</tr>
</tbody>
</table>

#### Critical Customer(s) Affected

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Client Type</th>
<th>Name</th>
<th>Address</th>
<th>Meter ID</th>
<th>EMR</th>
<th>KEY</th>
<th>MED</th>
<th>Contacts</th>
</tr>
</thead>
<tbody>
<tr>
<td>2313150</td>
<td></td>
<td>ENTERPRISES INC PAVLAK</td>
<td>13000 CLEVELAND AVE NW, Lake Twp., OH 44685</td>
<td>2200809</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2204952</td>
<td></td>
<td>MELLION LLC DRS</td>
<td>3451 EDISON ST NW, Lake Twp., OH 44685</td>
<td>2204952</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>9208904</td>
<td></td>
<td>OHIO LLC GIANT</td>
<td>13066 CLEVELAND AVE NW, Lake Twp., OH 44685</td>
<td>2201212</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2201200</td>
<td></td>
<td>PROPERTIES LLC CLEARVIEW</td>
<td>3407 EDISON ST NW, Lake Twp., OH 44685</td>
<td>2200179</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>9208407</td>
<td></td>
<td>TRUST COMPANY OF NORTHEASTERN OHIO CENTRAL</td>
<td>13100 CLEVELAND AVE NW, Lake Twp., OH 44685</td>
<td>2202401</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2280020</td>
<td></td>
<td>VOLUNTEER FIRE DEPT UNIONTOWN</td>
<td>EDISON ST NW, Lake Twp., OH 44685</td>
<td>2280018</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2280020</td>
<td></td>
<td>VOLUNTEER FIRE DEPT UNIONTOWN</td>
<td>NORTHDALE ST NW, Lake Twp., OH 44685</td>
<td>2280019</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2280020</td>
<td></td>
<td>VOLUNTEER FIRE DEPT UNIONTOWN</td>
<td>13055 OAKWOOD AVE NW, Lake Twp., OH 44685</td>
<td>2280020</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
</tbody>
</table>

#### Violated Parameter(s)

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Threshold Value (Number of customers affected)</th>
<th>Parameter Device Alias</th>
<th>Parameter Control Zone</th>
<th>Disabled During Storm</th>
<th>Associated Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Unplanned outage affecting 5 critical customers</td>
<td>5</td>
<td>OPAL</td>
<td>N</td>
<td>doc</td>
<td></td>
</tr>
</tbody>
</table>

#### Group(s) Notified

- doc

#### Individual(s) Notified

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Type</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Jan Somers</td>
<td>Email</td>
<td><a href="mailto:jan.somers@oracle.com">jan.somers@oracle.com</a></td>
</tr>
<tr>
<td>3</td>
<td>Andrei Berezin</td>
<td>Email</td>
<td><a href="mailto:andrej.berezin@oracle.com">andrej.berezin@oracle.com</a></td>
</tr>
<tr>
<td>2</td>
<td>Jan Somers</td>
<td>Pager</td>
<td><a href="mailto:jan.somers@oracle.com">jan.somers@oracle.com</a></td>
</tr>
<tr>
<td>3</td>
<td>Andrei Berezin</td>
<td>Pager</td>
<td><a href="mailto:andrej.berezin@oracle.com">andrej.berezin@oracle.com</a></td>
</tr>
</tbody>
</table>
Unplanned Outage Affecting a Specific Customer

Below is a sample email message for an unplanned outage affecting a specific customer with ERT updated. Details include: ERT Updated to 06/04/10 14:28, job# [1003], device [T14467], and account(s)[2201130]; message generated at 06-04-2010 11:28:06.

ERT Updated for Unplanned Outage affecting Specific Customer(s) Notification

Generated by Oracle Utilities NMS Service Alert on 06-04-2010 11:28:06

The Estimated Restoration Time has been updated for the Probable Service Outage on device T14467 in the following location:

Company: OPAL
Region: Stark
Branch: Lake
Substation: Lake Sub
Feeder: 2414

The following summary information was provided for this event:

Event Number: 1003
Outage Type: Probable Service Outage
Outage Begin Time: 06/04/10 11:27
Updated Estimated Restoration Time: 06/04/10 14:28
Previous Estimated Restoration Time: 06/04/10 13:27
Number of Calls Received: 1
Total Number of Customers Affected: 1
Emergency Customers Affected: 0
Key Customers Affected: 0
Medical Customers Affected: 0

Customer(s) Affected

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Client Type</th>
<th>Name</th>
<th>Address</th>
<th>EMR</th>
<th>KEY</th>
<th>MED</th>
<th>Contacts</th>
</tr>
</thead>
<tbody>
<tr>
<td>2201130</td>
<td></td>
<td>KENNETH RINEHART</td>
<td>3850 BROAD VISTA ST NW, Lake Twp., OH, 44085</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Violated Parameter(s)

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Account Number</th>
<th>Disabled During Storm</th>
<th>Associated Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>ERT updated for a specific customer</td>
<td>2201130</td>
<td>N</td>
<td>doc</td>
</tr>
</tbody>
</table>

Device Attribute(s)

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Attribute Name</th>
<th>Attribute Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Group(s) Notified

doc

Individual(s) Notified

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Type</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Jon Somers</td>
<td>E-Mail</td>
<td><a href="mailto:jon.somers@oracle.com">jon.somers@oracle.com</a></td>
</tr>
<tr>
<td>3</td>
<td>Andrei Berezin</td>
<td>E-Mail</td>
<td><a href="mailto:andrei.berezin@oracle.com">andrei.berezin@oracle.com</a></td>
</tr>
<tr>
<td>2</td>
<td>Jon Somers</td>
<td>Pager</td>
<td><a href="mailto:jon.somers@oracle.com">jon.somers@oracle.com</a></td>
</tr>
<tr>
<td>3</td>
<td>Andrei Berezin</td>
<td>Pager</td>
<td><a href="mailto:andrei.berezin@oracle.com">andrei.berezin@oracle.com</a></td>
</tr>
</tbody>
</table>
Planned Outage Affecting Many Customers

Below is a sample email message for a planned outage affecting many customers (customer scheduled). Details include: job# [1004] and device [F1236]; message generated at 06-04-2010 11:40:32.

Scheduled Planned Outage Notification

Generated by Oracle Utilities NMS Service Alert on 06-04-2010 11:40:32

A Switching Job, with associated device F1236, has been scheduled in the following location.

Company: OPAL
Region: Stark
Branch: Lake
Substation: Lake Sub
Feeder: 2414

The following summary information was provided for this event:
Event Number: 1004
Outage Type: Switching Job
Switch Plan Number: 1011
Switch Plan Scheduled Begin Time: 06/02/10 11:38
Switch Plan Scheduled End Time: 06/06/10 11:38
Total Number of Customers Affected: 83
Emergency Customers Affected: 0
Key Customers Affected: 0
Medical Customers Affected: 0

Customer(s) Affected

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Client Type</th>
<th>Name</th>
<th>Address</th>
<th>EMR</th>
<th>KEY</th>
<th>MED</th>
<th>Contacts</th>
</tr>
</thead>
<tbody>
<tr>
<td>2201135</td>
<td></td>
<td>ALFRED D + PAULINE A LAYFIELD</td>
<td>13233 PARKVIEW AVE NW, Lake Twp., OH, 44685</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2204050</td>
<td></td>
<td>ANDREW M BROWN</td>
<td>3871 EDISON ST NW, Lake Twp., OH, 44665</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2201313</td>
<td></td>
<td>ANNE M NUDO</td>
<td>3880 HUGH ST NW, Lake Twp., OH, 44665</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2200748</td>
<td></td>
<td>ANTHONY P + WAITLEY MELISSA N PALMERI</td>
<td>3802 EDISON ST NW, Lake Twp., OH, 44665</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2204682</td>
<td></td>
<td>BARRY A + DEBRA L BODINE</td>
<td>EDISON ST NW, Lake Twp., OH, 44665</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td>2201314</td>
<td></td>
<td>BARRY J + KELLY A CARLSON</td>
<td>13358 JAYNEVIEW AVE NW, Lake Twp., OH, 44665</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WILLIAM HOMA</td>
<td>13124 PARKVIEW AVE NW, Lake Twp., OH, 44665</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Violated Parameter(s)

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Threshold Value (Number of customers affected)</th>
<th>Parameter Device Alias</th>
<th>Parameter Control Zone</th>
<th>Disabled During Storm</th>
<th>Associated Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Planned outage affecting 50 customers is scheduled</td>
<td>50</td>
<td>OPAL</td>
<td>N</td>
<td>doc</td>
<td></td>
</tr>
</tbody>
</table>

Device Attribute(s)

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Attribute Name</th>
<th>Attribute Value</th>
</tr>
</thead>
</table>

Group(s) Notified
doc

Individual(s) Notified

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Type</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Jim Somers</td>
<td>E-Mail</td>
<td><a href="mailto:jim.somers@oracle.com">jim.somers@oracle.com</a></td>
</tr>
</tbody>
</table>
Storm Ended

Below is a sample Storm Ended email message. Details include: Storm Hurricane Bob - 06/04/10 Ended in OPAL/Stark/Canton; message generated at 06-04-2010 11:45:55.

Storm "Hurricane Bob - 06/04/10" Ended

Generated by Oracle Utilities NMS Service Alert on 06-04-2010 11:45:55

Storm Details

Category: Hurricane - Major Storm
Zone: OPAL/Stark/Canton
Begin Time: 06:04:10 11:43
End Time: 06:04:10 11:45

Violated Parameter(s)

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Parameter Control Zone</th>
<th>Associated Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Storm Ended in Canton</td>
<td>OPAL/Stark/Canton</td>
<td>doc</td>
</tr>
</tbody>
</table>

Group(s) Notified
doc

Individual(s) Notified

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Type</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Jan Somers</td>
<td>E-Mail</td>
<td><a href="mailto:jan.somers@oracle.com">jan.somers@oracle.com</a></td>
</tr>
<tr>
<td>3</td>
<td>Andrei Berezin</td>
<td>E-Mail</td>
<td><a href="mailto:andrei.berezin@oracle.com">andrei.berezin@oracle.com</a></td>
</tr>
<tr>
<td>2</td>
<td>Jan Somers</td>
<td>Pager</td>
<td><a href="mailto:jan.somers@oracle.com">jan.somers@oracle.com</a></td>
</tr>
<tr>
<td>3</td>
<td>Andrei Berezin</td>
<td>Pager</td>
<td><a href="mailto:andrei.berezin@oracle.com">andrei.berezin@oracle.com</a></td>
</tr>
</tbody>
</table>
Frequency of Device Operations

Below is a sample email message for a Frequency of outages on a device notification. Details include: Violation parameter ID = 6; message generated on 06-04-2010 11:50:29.

**Frequency of Outages on a Device Notification (Real-time)**

Generated by Oracle Utilities NMS Service Alert on 06-04-2010 11:50:29

An outage, surpassing a parameter value, has been detected on device T11430 in the following location:
- **Company:** OPAL
- **Region:** Stark
- **Branch:** Lake
- **Substation:** Lake Sub
- **Feeder:** 2414

**Violated Parameter(s)**

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Threshold Value (Number of service interruptions)</th>
<th>Parameter Time Interval</th>
<th>Parameter Device</th>
<th>Parameter Device Class</th>
<th>Parameter Control Zone</th>
<th>Associated Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Three outages on the same transformer in one day</td>
<td>3</td>
<td>1 day(s)</td>
<td>transformer (200)</td>
<td>OPAL</td>
<td>doc</td>
<td></td>
</tr>
</tbody>
</table>

**Device Attribute(s)**

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Attribute Name</th>
<th>Attribute Value</th>
</tr>
</thead>
</table>

**Group(s) Notified**
- doc

**Individual(s) Notified**

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Type</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Jan Somers</td>
<td>E-Mail</td>
<td><a href="mailto:jan.somers@oracle.com">jan.somers@oracle.com</a></td>
</tr>
<tr>
<td>3</td>
<td>Andrei Berezin</td>
<td>E-Mail</td>
<td><a href="mailto:andrei.berezin@oracle.com">andrei.berezin@oracle.com</a></td>
</tr>
<tr>
<td>2</td>
<td>Jan Somers</td>
<td>Pager</td>
<td><a href="mailto:jan.somers@oracle.com">jan.somers@oracle.com</a></td>
</tr>
<tr>
<td>3</td>
<td>Andrei Berezin</td>
<td>Pager</td>
<td><a href="mailto:andrei.berezin@oracle.com">andrei.berezin@oracle.com</a></td>
</tr>
</tbody>
</table>
Chapter 12
Management Reporting

The management reporting modules were designed specifically to meet the challenges of measuring, monitoring, and reporting performance of electric distribution operations. Considerable design and implementation guidance from the user community was incorporated into these modules, resulting in powerful, easy-to-use measuring, monitoring, and reporting tools.

A set of standard Trouble reports are available in either Business Objects, Oracle Discoverer, or Oracle BI Publisher. These Trouble reports reflect the information that executives and regulatory agencies typically require from a utility’s operations systems.

This chapter also describes the Oracle Utilities Business Intelligence graphical portals and zones, which operators can use to view key performance indicators and other pertinent information relating to the operation of the distribution network.

This chapter includes the following topics:

• Overview of Management Reporting
• Using Business Objects
• Using Oracle Discoverer
• Using Oracle BI Publisher
• Trouble Reporting Reports
• Using the Oracle Utilities Business Intelligence Graphical Portals and Zones

Overview of Management Reporting

Oracle Utilities Business Intelligence (OUBI) is the base Oracle Utilities Network Management System reporting module, a specially tuned data warehouse with Extraction, Transformation, and Load (ETL) capabilities for capturing information common to all of the Oracle Utilities applications.

The Oracle Utilities Network Management System Trouble Reporting module provides multiple Business Intelligence (BI) reporting tools (Business Objects, Oracle Discoverer, and Oracle BI Publisher) to display trouble information from OUBI. These reports are a starter kit of historical trouble information and performance measures based upon reliability indices, used with widely accepted third party Business Intelligence tools, as well as support for related ad hoc analysis and reporting.

The reporting tools are used as a means for generating reports and performing analysis on the information. As a result, you can easily interact with a variety of data sources by using a simple graphical interface, thus avoiding the technical complexity of relational databases.
Using Business Objects

This section covers Business Objects. For information about Oracle Discoverer, please refer to the Defining Reports on page 12-4.

This section includes the following topics:

- Defining Reports
- Running a Report
- Sorting a Report

Defining Reports

To generate a standard report in Business Objects, follow these steps:

2. Select the Generate a standard report radio button.
3. Click the Begin button to begin creating a new report. The Specify Data Access window appears, which displays the database options.
4. Select the Universe radio button to use Business Objects universe from which to choose the data to display in a report.
5. Click the Next button to move on to the next screen in the wizard. The Select a Universe window appears, requesting that you select a universe. The available universes are the NRT Universe, Service Alert Reporting, Storm Reporting, Switching Reporting, and Trouble Reporting.
6. Select a universe from the Available Universes list. You have the option of setting a default universe by toggling on the Set as My Default Universe radio button. The field at the bottom of the window offers Help on the universe.
7. Click the Finish button. The Query Panel opens for the universe you selected. To build a query, you choose objects for the results and conditions, apply sorts, and then run the query. The object model has a number of classes for this, all of which are accessed via the Queries object. The Class folders contain the objects for creating a report. Classes are described as a logical grouping of objects, and an object folder is grouped into the classes. Please see Business Objects documentation for more detailed information about Business Objects functionality.
8. In the Query Panel, insert an object into the Result Objects field (top), by double-clicking it or dragging the object from the Classes and Objects field.
9. To apply a condition into the Conditions field (bottom):
   - Drag one or more fields from the Classes and Objects field into the Conditions field to create a new condition.
   OR
   - Select the Predefined Conditions radio button (button on the right, above the Options… button on the bottom-left portion of the window). The Classes and Objects field is replaced with the Predefined Conditions field.
   - Drag a predefined condition into the Conditions field.
   - Select the Classes and Objects radio button (button on the left, above the Options… button on the bottom-left portion of the window) to return to the Classes and Objects field.
10. To edit the content of a report, open the report and select the Edit Data Provider option from the Data menu. When the Query Panel opens, follow the steps listed above.
11. Press the Run button. The query for the report you have built is executed, and then a window containing the ad hoc report results appears.

Once you've defined a new report, you can run the report to see updated information. You can also sort this data for more efficient analysis.

Running a Report

To run a previously defined report in Business Objects, complete these steps:
1. Select Open from the File menu. The Open dialog appears.
2. Double-click on the name of the report in the appropriate directory to access the report.
3. Select the Refresh Data option from the Data menu. The Parameters dialog displays.
4. Enter the parameter values for the report.
5. Click the OK button. The refreshed report displays.

Sorting a Report

To sort the content in a report, complete these steps:
1. Select the column containing the data you want to sort.
2. Select the Sorts option from the Insert menu.
3. Select the Ascending, Descending, or Custom sub-menu option. The data will then sort accordingly.

Viewing Existing Sorts

Existing sorts may take priority over the sort you want to use. If it looks like your data is not sorting, check if a sort has already been used for the data. To see what sorts are currently being applied to the data, complete these steps:
1. Select the entire report.
2. Select the Sorts option from the Format menu. The Sorts dialog displays.
3. Turn the sort off by selecting the sort in the Current Sorts field and clicking the Remove… button. The Remove a Sort dialog displays to confirm that you want to remove the sort.
4. Click the Yes button. The Sort dialog displays again.
5. Click the OK or Apply button on the Sort dialog. The report displays with the data sorted.
Using Oracle Discoverer

This section covers Oracle Discoverer. For information about Business Objects, please refer to the Defining Reports on page 12-2.

This section includes the following topics:

• Defining Reports
• Running Reports
• Editing and Drilling Down in Reports with Oracle Discoverer

Defining Reports

To define a new report with Oracle Discoverer, complete the following steps:

1. Start up Oracle Discoverer. The Connect to Oracle Discoverer dialog appears.
2. Enter the RDBMS username in the Username field.
3. Enter the RDBMS password in the Password field.
4. Enter the Oracle instance name in the Connect field.
5. Press the Connect button. The Workbook Wizard opens.
6. Complete the Workbook Wizard: Step 1 Dialog:
   • Click the Create a new workbook button to define a report. The ‘How do you want to display the results?’ section now appears on the dialog.
   • Click one of the following four buttons: Table, Crosstab, Page-detail Table, or Page-detail Crosstab.
     Note: Please refer to the Oracle Discoverer documentation for information about these buttons.
   • Click the Next button.
7. Complete the Workbook Wizard: Step 2 dialog to select the content for your report:
   • Select specific information from the Available list.
   • Click the button with the arrow pointing to the right. The selected item moves to the Selected field. Repeat this process until you have all of the desired information.
   • Click the Next button.
8. Complete the Workbook Wizard: Step 3 dialog appears to arrange how the items are displayed in your report.
   • Click on the column item and drag it to the desired location.
   • Click the Next button.
9. Complete the Workbook Wizard: Step 4 dialog to limit the amount of data in your report by applying a filter. For additional information on Conditions, please refer to the Oracle Discoverer documentation.
   • To create a new condition, click the New… button. The New Condition dialog displays.
   • Enter a name for the condition in the Name field, or select the Generate name automatically checkbox to let Oracle Discoverer name it.
   • Enter a description of the condition in the Description field.
   • Select the type of condition in the Condition drop-down menu.
   • Select the value(s) in the Value(s) drop-down menu.
• Optionally, you can view, edit, and delete existing conditions.
• Click the OK button. The Workbook Wizard: Step 4 dialog displays again.
• Click the Next button.

10. Complete Workbook Wizard: Step 5 dialog to define a sort to arrange the data in your report in a particular order.
• Select your sort order from the Add drop-down menu. The selected sort criteria displays in the field above.
• In the Direction column, select how the data should be sorted, such as ascending or descending order.
• Click the Next button.

11. Complete the Workbook Wizard: Step 6 dialog to view, edit, delete, and create new calculations for individual items in your report. Please refer to the Oracle Discoverer documentation for more information about calculations.
• To create a new calculation, click the New… button. The Edit Calculation dialog displays.
• Select the corresponding radio button to show Items or Functions in the field below.
• Select the item or function to be used in the calculation.
• Click the Paste button. The item or function will display in the Calculation field.
• Use the buttons below the Calculation field to define the mathematical operation to be performed on the function or item. Mathematical operations include multiplication, addition, and division.
• Repeat the previous 3 steps until you have completed defining the new calculation.
• Enter the name of the calculation in the Name field.
• Click the OK button. The Workbook Wizard: Step 6 dialog displays again.

12. Click the Finish button. The report displays.

Running Reports

To run a report with Oracle Discoverer, complete these steps:
1. Start up Oracle Discoverer. The Connect to Oracle Discoverer dialog appears.
2. Enter the RDBMS username in the Username field.
3. Enter the RDBMS password in the Password field.
4. Enter the Oracle instance name in the Connect field.
5. Press the Connect button. The Workbook Wizard opens.
6. Click the Open an existing workbook button. The ‘Where is the workbook you want to open?’ section now appears on the dialog.
7. Click one of the following four buttons: My Computer, Database, Scheduling Manager, Recently Used List. Please refer to the Oracle Discoverer documentation for information about these buttons.
8. Click the Next button. The Open dialog appears. The Open dialog is used to access the particular report you want to see.
9. Select the folder in the Look in field. The files within the selected folder display in the field below.
10. Select the report by double-clicking it. Whether or not the Workbook in Other Database Account dialog displays depends on your system configuration.

11. If the dialog does display, select the **Open the workbook in the current database account** radio button. This option accesses the workbook with your username and the Oracle instance you’re connected to.

12. Click the **OK** button. The Oracle Discoverer window below displays.

13. Click the **Yes** button to run the query. The Parameter Wizard opens. The Parameter Wizard is used to define the beginning and ending date for the data in your report. The Description field displays a description of the parameters when you click in its field. To enter the parameters for a report, follow these steps.
   - Enter the start date in the **Enter Start date** field.
   - Enter the end date in the **Enter End date** field.
   - Click the **Finish** button. The report opens.

### Editing and Drilling Down in Reports with Oracle Discoverer

Oracle Discoverer gives you the capability to change some aspects within the reports. For example, you can edit the column headings in a report. To change the column headings, follow these steps.

#### Editing Column Headings

To edit column headings:

1. Right-click in the column heading you want to change. A menu displays.
2. Select the **Item Properties...** menu option. The Item Properties dialog displays.
3. In the **Heading** field, enter the desired name of the column heading.
4. Click the **OK** button.
5. Select **Save** from the File menu to save the new column headings.

Please refer to the Oracle Discoverer documentation for more information on Oracle Discoverer editing features.

#### Drilling Down or Up in Reports

“Drilling down” refers to viewing more detailed information within a report, and “drilling up” refers to viewing more general information. To drill down or up, complete these steps:

1. Select **Drill...** from the Sheet menu. The Drill dialog displays.
2. Select the **Drill Up/Down** radio button. The **Where do you want to drill from?** field auto-fills with the currently selected column name.
3. Select the column or level of detail you want to drill down to in the **Where do you want to drill to?** field.
4. Click the **OK** button.

Please refer to the Oracle Discoverer documentation for more information about drilling features.
Using Oracle BI Publisher

This section covers Oracle BI Publisher. For information about Oracle Discoverer or Business Objects, please refer to Using Oracle Discoverer on page 12-4 or Using Business Objects on page 12-2.

This section includes the following topics:

- Defining Reports
- Running a Report

Defining Reports

To generate a standard report in Oracle BI Publisher, follow these steps:

1. Make sure the Oracle BI Publisher Server has been started. If not yet started, go to the Oracle BI Publisher site and login.
2. Click the Reports tab.
   
   Note: Before you create a new report, you may want to create a new folder to contain the reports to be created. Click the Create a new folder link to create a new folder.
3. Click the Create a new report link.
4. Specify the report name. A new report icon with the specified name appears on the webpage.
5. Click the Edit link of the newly created report.
6. Add a Description of the report and define a Default Data Source.
   
   Note: Users with Administrator role access can add Data Source values. Make sure that the Oracle BI Publisher administrator has already set up the correct Data Sources.
7. Click the Data Model link on the tree structure. A drop-down opens, displaying all the data sets that have been created.
8. Click the New icon to create a new Data Set to be used for the report.
9. Provide the following information:
   
   - Name – Select a value from the drop-down.
   - Type – Select the mode type, such as SQL Query, Data Template, Web Service, or XML Feed. Oracle Utilities Network Management reports are defined as Data Templates.
   - Depending on the Type selected, more attributes need to be set up to define where the data will come from. For example, a Data Template data set includes the SQL query used to retrieve the columns and also the output XML structure.

Defining the List of Values

10. Click the List of Values link to define a List of Values. This is only necessary if you have a predefined set of values that need to be supplied to a report.

Defining Report Parameters

11. Click the Parameters link to define report parameters.
12. Click the New icon to create a new report parameter.
13. Provide the following information:
• **Identifier** – This is the name of the parameter. Parameters are referenced in the SQL Query statements, Data Templates etc. through this Identifier.

• **Data Type** – A parameter can only be a String, Integer, Boolean, Date or Float data type.

• **Default Value** - The default value for this parameter.

• **Parameter Type** – A parameter can be any of the following:
  • **Text** – Use this if you need a text box to input the parameter values.
  • **Menu** – Use this if there is a pre-defined list of values that can be supplied to the report. A drop-down menu will be available to input values.
  • **Date** – Use this if the parameter is a date. A calendar will be available to input values. This ensures that only valid dates can be entered.
  • **Hidden** – Use this if the user does not need to see the actual value of the parameter.

• **Display Label** - The label to display for this parameter.

• Other attributes may need to be setup depending on the Parameter Type selected.

**Defining Layouts**

14. Click the **Layouts** link to define the templates that can be used on the report.

15. Click the **New** icon to create a new layout.

16. Provide the following information:

  • **Name** - Enter a name for the layout.
  • **Template** - Select a template from the drop-down list of available template files for this report.

  **Note:** To add a new template, click the Layouts link and upload templates from the directory folder using the Browse and Upload buttons.

  • **Template Type** - The example reports provided have corresponding RTF templates. However, there are other template types that are available (e.g., PDF, Excel, XML, etc.).

  • **Output Format** - The output format to use.

**Save**

17. Click **Save** to commit your changes.

Once you've defined a new report, you can run the report to see the output.

**Running a Report**

To run a previously defined report in Oracle BI Publisher, complete these steps:

1. Click the **Reports** tab. Go to the reports folder of the report you want to run.

2. Click the **View** link to run the report. The output is always based on the following:

  • **Parameters** – There is a section on the page where the user can input parameter values. It is always populated with the default values (if defined).

  • **Template** – There is a drop-down list of the available templates for the report. The report is always presented in the template currently selected by the user.

  **Note:** You can click the **View** button again at any time to rerun the report again.
3. When the page has completely loaded in the web browser, click the Export button to save the output. Depending on the selected template, a related application will be launched (e.g., MS Word will be launched for an RTF template).

**Trouble Reporting Reports**

The Oracle Utilities Network Management System – Trouble Reporting module gathers pertinent information about completed outages from the Oracle Utilities Business Intelligence Data Warehouse and calculates performance measures of the distribution system. The information gathered consists of historical data from various areas such as causes, devices, outage times, call details, crew details, and customer details. In addition to reports of trouble-related information, Trouble Reporting includes reports of performance measures based on reliability indices.

This section describes the following reports:

- **Outage Summary**
- **Critical Customers Outages**
- **Daily Trouble Report**
- **Device Outage History**
- **Sustained Outage Summary**
- **Recurring Device Outages**
- **Reliability Indices Reports**

**Outage Summary**

The Outage Summary reflects outage causes while displaying the number of customer interruptions and customer minutes of duration. You can organize it by company or region. Each row displays a cause, while the columns display the report categories.

The Outage Summary displays the following columns:

- The **Company** column contains the name of the company that serves the customer.
- The **Outage Cause** column contains the primary cause of the outage as determined from the drop-down selections in the Oracle Utilities Network Management System – Trouble Management or Oracle Utilities Network Management System – Web Trouble Event Details window. This is useful for filtering, sorting, and analyzing outage causes. The logic used in determining the primary cause is the same as what is used for the Daily Trouble Report.
  - The **Outages** column contains the total number of outages during the specified period for the cause in the specified area.
- The **Cust Out** column contains the total number of customers experiencing outages during the specified period for the cause in the specified area.
- The **Customer Minutes Interrupted** column contains the sum of the customers affected multiplied by the outage duration for each outage during the specified period for the cause in the specified area.

**Critical Customers Outages**

The Critical Customers Outages report displays the duration (in minutes) of the outage for the critical customer. It contains the following columns:

- The **Company** column contains the name of the company that serves the customer.
- The **Region** column contains the name of the region that serves the customer.
- The **Branch** column contains the name of the branch that serves the customer.
• The **Substation** column contains the name of the substation that serves the customer.
• The **Feeder** column contains the name of the feeder that serves the customer.
• The **Per Name** column contains the name of the customer who experienced an outage during the specified period for the specified area.
• The **Customer Minutes Interrupted** column contains the sum of each outage duration (in minutes) during the specified period for the customer.
• The **Medical** column indicates whether the customer is a medical customer.
• The **Key** column indicates whether the customer is a key customer.
• The **Critical** column indicates whether the customer is an emergency customer.

### Daily Trouble Report

The Daily Trouble Report displays events on a daily basis. It identifies the crew, hours worked, resolution and primary cause. Each column is organized by the report categories.

This report contains the following columns:

• The **Region** column contains the name of the region where the outage is located.
• The **Branch** column contains the name of the branch where the outage is located.
• The **Substation** column contains the name of the substation where the outage is located.
• The **Feeder** column contains the name of the feeder where the outage is located.
• The **Exclude?** column indicates whether the outage is excluded from the reliability indices calculations (Y = excluded; N = not excluded).
• The **Event #** column contains the system identification number for the outage.
• The **Location of First Call** column contains the address of the first call received for the outage.
• The **Outage Trouble Code** column contains the clues associated with the outage.
• The **Device Name** column contains the name of the interrupting device associated with the outage.
• The **Outage Began Date** column contains the date and time the outage began.
• The **Outage Restored Date** column contains the date and time the outage was restored.
• The **Outage Duration (Minutes)** column contains the duration of the outage (in minutes).
• The **Cust Out** column contains the number of customers affected by the outage.
• The **Remedy** column contains the action taken to resolve the outage, as entered in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window.
• The **Event Note** column contains the operations event note associated with the outage.
• The **Crew Contact** column contains the name of the crew leader for the crew associated with the outage, if any.
• The **Crew Dur** column contains the duration between the time the crew accepted the assignment and the time the crew arrived at the outage location (in minutes).
• The **Cause of Outage** column contains the primary cause of the outage as determined from the drop-down selections in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window. This is useful for filtering, sorting, and analyzing outage causes.
The logic used in determining the primary cause is shown in the following table:

<table>
<thead>
<tr>
<th>Weather</th>
<th>Environment</th>
<th>Vegetation</th>
<th>Foreign Interference</th>
<th>Defective Equipment</th>
<th>Scheduled</th>
<th>Utility Error</th>
<th>Other</th>
<th>Use as Cause of Outage</th>
</tr>
</thead>
<tbody>
<tr>
<td>any</td>
<td>any</td>
<td>any</td>
<td>any</td>
<td>any</td>
<td>selected</td>
<td>any</td>
<td>any</td>
<td>Scheduled</td>
</tr>
<tr>
<td>any</td>
<td>any</td>
<td>any</td>
<td>any</td>
<td>any</td>
<td>unselected</td>
<td>selected</td>
<td>any</td>
<td>Utility Error</td>
</tr>
<tr>
<td>any</td>
<td>any</td>
<td>any</td>
<td>any</td>
<td>any</td>
<td>unselected</td>
<td>unselected</td>
<td>selected</td>
<td>Other</td>
</tr>
<tr>
<td>any</td>
<td>any</td>
<td>selected</td>
<td>any</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>Foreign Interference</td>
</tr>
<tr>
<td>any</td>
<td>selected</td>
<td>unselected</td>
<td>selected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>Vegetation</td>
</tr>
<tr>
<td>any</td>
<td>unselected</td>
<td>unselected</td>
<td>selected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>Defective Equipment</td>
</tr>
<tr>
<td>selected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>Environment</td>
</tr>
<tr>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>unselected</td>
<td>Weather</td>
</tr>
</tbody>
</table>

- The **Scheduled** column contains the value selected from the Scheduled drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating whether the outage was scheduled or not.
- The **Utility Error** column contains the value selected from the Utility Error drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any utility error associated with the outage.
- The **Other** column contains the value selected from the Other drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any other characteristics associated with the outage.
- The **Foreign Interference** column contains the value selected from the Foreign Interference drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any foreign interference associated with the outage.
- The **Vegetation** column contains the value selected from the Vegetation drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any vegetation conditions associated with the outage.
- The **Defective Equipment** column contains the value selected from the Defective Equipment drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any defective equipment associated with the outage.
- The **Environment** column contains the value selected from the Environment drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any environmental conditions associated with the outage.
- The **Weather** column contains the value selected from the Weather drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any weather conditions associated with the outage.
Device Outage History

The Device Outage History displays the history of outages for a selected device during a selected period. A summarization of the customer interruptions, customer minutes interrupted and number of events for each distinct interrupting device and each distinct interrupting device type is also displayed.

This report contains the following columns:

- **Device Name** column contains the name of the interrupting device.
- **Exclude?** column indicates whether the outage is excluded from the reliability indices calculations (Y = excluded; N = not excluded).
- **Location of First Call** column contains the address of the first call received for the outage.
- **Outage Began Date** column contains the date and time the outage began.
- **Outage Restored Date** column contains the date and time the outage was restored.
- **Customer Interruptions** column contains the total number of customers affected by the outage.
- **Customer Minutes Interrupted** column contains the sum of the customers affected by the outage multiplied by the outage duration.
- **Event #** column contains the system identification number for the outage.
- **Remedy** column contains the action taken to resolve the outage, as entered in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window.
- **Event Note** column contains the operations event note associated with the outage.
- **Cause of Outage** column contains the primary cause of the outage as determined from the drop-down selections in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window. This is useful for filtering, sorting, and analyzing outage causes. The logic used in determining the primary cause is the same as what is used for the Daily Trouble Report on page 12-10.
- **Scheduled** column contains the value selected from the Scheduled drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating whether the outage was scheduled or not.
- **Utility Error** column contains the value selected from the Utility Error drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any utility error associated with the outage.
- **Other** column contains the value selected from the Other drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any other characteristics associated with the outage.
- **Foreign Interference** column contains the value selected from the Foreign Interference drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any foreign interference associated with the outage.
- **Vegetation** column contains the value selected from the Vegetation drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any vegetation conditions associated with the outage.
- **Defective Equipment** column contains the value selected from the Defective Equipment drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any defective equipment associated with the outage.
• The Environment column contains the value selected from the Environment drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any environmental conditions associated with the outage.

• The Weather column contains the value selected from the Weather drop-down in the Oracle Utilities Network Management System Trouble Management or Web Trouble Event Details window, indicating any weather conditions associated with the outage.

Sustained Outage Summary

The Sustained Outage Summary displays the total sustained outages and the customers interrupted for a specified period, organized by region.

• This report displays the following columns:
  • The Company column contains the name of the company where the outages are located.
  • The Region column contains the name of the region where the outages are located.
  • The Branch column contains the name of the branch where the outages are located.
  • The Substation column contains the name of the substation where the outages are located.
  • The Feeder column contains the name of the feeder where the outages are located.
  • The Outages column contains the total number of outages in the specified area during the specified period.
  • The Cust Out column contains the total number of customers experiencing outages during the specified period in the specified area.
  • The Customer Minutes Interrupted column contains the sum of the customers affected multiplied by the outage duration for each outage during the specified period in the specified area.

Recurring Device Outages

The Recurring Device Outages report identifies interrupting devices that have been associated with a specified number or more sustained and momentary outages. This report displays all device outages for the period requested and is organized by the report categories. A summarization of the information for all of the devices on each distinct feeder is also displayed.

This report displays the following columns:

• The Company column contains the name of the company where the outages are located.
• The Region column contains the name of the region where the outages are located.
• The Branch column contains the name of the branch where the outages are located.
• The Substation column contains the name of the substation where the outages are located.
• The Feeder column contains the name of the feeder where the outages are located.
• The Device Type column contains the device type of the interrupting device on which the outages are located.
• The Total Outages column contains the total number of outages on the device during the specified period.
• The Total Duration column contains the total duration of outages on the device experiencing outages during the specified period.
• The Customer Minutes Interrupted column contains the sum of the customers affected multiplied by the outage duration for each outage on the device during the specified period.
Reliability Indices Reports

The reliability indices (SAIDI, SAIFI, CAIDI, etc.) are calculated values that provide a measure of the reliability of the distribution system. These reports contain three main categories of reports: Sustained Interruptions, Momentary Interruptions, and Sustained and Momentary Interruptions. In each report, each column is organized by report categories.

For more information about reliability indices, refer to the IEEE Std 1366-2003.

Feeder Reports

There are two types of sustained interruptions reports:

- Customers Experiencing Multiple Interruptions (CEMI)
- Average Service Availability Index (ASAI), System Average Interruption Frequency Index (SAIFI), System Average Interruption Duration Index (SAIDI), Customer Average Interruption Duration Index (CAIDI), Customer Average Interruption Frequency Index (CAIFI)

Indice Report

The Indice report displays the ASAI, SAIFI, SAIDI, CAIDI, MAIFI, MAIFIe, ACI, MSAIFI, CEMI and CEMSMI calculations for a specified period by feeder. (See descriptions of each calculation in the following paragraphs.)

The Indice Report displays the following columns:

- The Company column contains the name of the company where the outages are located.
- The Region column contains the name of the region where the outages are located.
- The Branch column contains the name of the branch where the outages are located.
- The Substation column contains the name of the substation where the outages are located.
- The Feeder column contains the name of the feeder where the outages are located.
- The ASAI column contains the Average Service Availability Index value for the feeder. This is the fraction of time that a customer has received power during the specified period.
- The SAIFI column contains the System Average Interruption Frequency Index value for the feeder. This indicates how often the average customer experienced a sustained interruption during the specified period.
- The SAIDI column contains the System Average Interruption Duration Index value for the feeder. This indicates the total duration of interruption, in minutes, for the average customer during the specified period.
- The CAIDI column contains the Customer Average Interruption Duration Index value for the feeder. This represents the average time required to restore service to those customers experiencing sustained interruptions during the specified period.
- The CAIFI column contains the Customer Average Interruption Frequency Index value for the feeder. This gives the average frequency of sustained interruptions for those customers experiencing sustained interruptions during the specified period for the specified area. The customer is counted once regardless of the number of times interrupted for this calculation.
- The MAIFI column contains the Momentary Average Interruption Frequency Index value for the feeder. MAIFI indicates how often the average customer experienced a momentary interruption during the specified period.
- The MAIFIe column contains the Momentary Average Interruption Event Frequency Index value for the feeder. This indicates how often the average customer experienced a momentary interruption event during the specified period. It does not include momentary interruptions immediately preceding a lockout.
• The **ACI** column contains the Average Number of Customers per Interruption value for the feeder. This indicates the average number of customers interrupted for each interruption (sustained or momentary) during the specified period for the specified area.

• The **MSAIFI** column contains the Momentary and Sustained Average Interruption Frequency Index value for the feeder. This indicates how often the average customer experienced a momentary and sustained interruption during the specified period.

• The **CEMI** column contains the Customers Experiencing Multiple Interruptions value for the feeder. This indicates the ratio of individual customers experiencing more than 3 sustained interruptions to the total number of customers served.

• The **CEMSMI** column contains the Customers Experiencing Multiple Sustained and Momentary Interruption Events value for the feeder. This is the ratio of individual customers experiencing more than 3 of both sustained and momentary interruption events to the total customers served. Its purpose is to help identify customer issues that cannot be seen using averages.

### Indices by City

There is also a report that displays all of the Indices calculations for a specified period by city, state and country rather than by feeder.

This report displays the following columns:

• The **City** column contains the name of the city where the outages are located.

• The **CEMI** column contains the Customers Experiencing Multiple Interruptions value for the city.

• The **ASAI** column contains the Average Service Availability Index value for the city.

• The **SAIFI** column contains the System Average Interruption Frequency Index value for the city.

• The **SAIDI** column contains the System Average Interruption Duration Index value for the city.

• The **CAIDI** column contains the Customer Average Interruption Duration Index value for the city.

• The **CAIFI** column contains the Customer Average Interruption Frequency Index value for the city.

• The **MAIFI** column contains the Momentary Average Interruption Frequency Index value for the city.

• The **MAIFIe** column contains the Momentary Average Interruption Event Frequency Index value for the city.

• The **ACI** column contains the Average Number of Customers per Interruption value for the city.

• The **MSAIFI** column contains the Momentary and Sustained Average Interruption Frequency Index value for the city.

• The **CEMI** column contains the Customers Experiencing Multiple Interruptions value for the city.

• The **CEMSMI** column contains the Customers Experiencing Multiple Sustained and Momentary Interruption Events value for the city.
Using the Oracle Utilities Business Intelligence Graphical Portals and Zones

Oracle Utilities Business Intelligence provides a robust tool for remote, near-real-time monitoring of critical distribution operations processes and decision support for day-to-day operations and major events. Presentation, navigation, and control of information are managed in a way that makes sense to the business user. Access buttons permit navigation to different portals containing information zones about events, crews, calls, devices, and customers. User-driven data slicing and drill-down is provided for most information zones. Other access buttons provide a mechanism for the user to drill down to different levels of control zone hierarchy or select geographical/regional display of the data.

General installation, configuration, and use of Oracle Utilities Business Intelligence are covered in the Oracle Utilities Business Intelligence documentation. As an addendum to that guide, we are documenting here the sample Oracle Utilities Network Management System Business Intelligence portals and zones which are provided. Users can configure new zones and edit zones as described in the Oracle Utilities Business Intelligence documentation.

Business Intelligence Login Screen

Access the Oracle Utilities Business Intelligence login window by entering the appropriate URL web address. The Oracle Utilities Business Intelligence intro screen opens.

To login to Business Intelligence, complete these steps:
1. Enter your user name in the User Id field.
2. Enter your password name in the Password field.
3. Click the Login button. After you log in, the default window opens.

Navigating in Business Intelligence

A menu bar appears on the left-hand side of the window. Click the menu bar to open the menu.

Move the mouse pointer over the NMS Analytics menu item to display the sample Oracle Utilities Network Management System portals that are available.

Each of the items in the sub-menu is a portal containing information related to that topic. Each portal contains one or more zones that present specific data for that topic. Different zones may display the same data, but the data may appear in a different format.

The remainder of this document describes each of the available portals and the zones contained in each portal. Available portals are:

• OMS Executive Overview Portal
• Current Outages By Operating Region Portal
• Customer Restoration Portal
• Outage Analysis Portal
• Outages By Political Boundary Portal
• Feeder Performance Portal
• Sustained Reliability Limits Portal
• Monthly Reliability Limit Portal
• Current Feeder Lockouts Portal
• Current Feeder Lockouts Portal
• Momentary Reliability Limit Portal
• Wire Down Event Portal
• Feeder Delivered Load Portal
• Historical Storms Portal

OMS Executive Overview Portal

The Executive Overview Portal provides the following zones:

• Critical Customer Overview Zone
• Current Customers Out Zone
• Current City Outage Summary Zone
• Current OMS Overview Zone
• Recent Call Volume Zone

Critical Customer Overview Zone

This zone lists each type of critical customer configured in the model, along with a counter and a red/yellow/green stoplight indicator for the number currently out of service.

Current Customers Out Zone

This zone displays a pie chart of current outages by control zone branch (the third highest grouping in the control zone hierarchy).

Current City Outage Summary Zone

This zone shows a pie chart of current outages by city.

Current OMS Overview Zone

This zone shows a red/yellow/green stoplight and a counter of the total number of customers out of service, the number of events, and the current SAIDI minutes.

Recent Call Volume Zone

This zone shows a graph of the recent hourly call volume.

Current Outages By Operating Region Portal

The Current Outage by Operating Portal provides the following zones:

• Call List Zone
• Completed Event List Zone
• Customer List Zone
• Customer Summary Zone
• Event List Zone
• Event Summary Zone
• Outage Summary Zone

Call List Zone

This zone shows a list of all callers, phone numbers, and call dates/times for a selected event.
Completed Event List Zone
This zone shows a list of completed events, including:

- event number
- event state
- control zone branch
- substation
- feeder
- duration
- number of customers affected
- outage device

Customer List Zone
This zone displays a list of customers affected for a selected event.

Customer Summary Zone
This zone displays a pie chart of current events by control zone branch (the third highest grouping in the control zone hierarchy).

Event List Zone
This zone shows a list of current events, including:

- event number
- event state
- control zone branch
- substation
- feeder
- number of customers affected
- duration
- outage device

Event Summary Zone
This zone displays a pie chart of current customers out by control zone branch (the third highest grouping in the control zone hierarchy).

Outage Summary Zone
This zone displays a list of outage summaries by control zone, including:

- control zone company
- control zone region
- control zone branch
- number of current customers interrupted
- number of current events
- number of current calls
Customer Restoration Portal

The Customer Restoration Portal provides the following zones:

- Estimated Restoration Zone
- Historical Call List Zone
- Historical Customer List Zone
- Historical Event List Zone
- Storm Progress and Estimated Restoration Zone
- Summation of Customers Restored and Still Out Zone

Estimated Restoration Zone

This zone shows a graph of hourly estimated restoration performance.

Historical Call List Zone

This zone shows a list of calls for a selected event.

Historical Customer List Zone

This zone shows a list of customers affected by a selected event.

Historical Event List Zone

This zone shows a list of events for a selected calendar month, including:

- event state
- control zone branch
- substation
- feeder
- outage device type
- event number
- duration
- number of affected customers
- CMI
- user-defined fields

Storm Progress and Estimated Restoration Zone

This zone displays an hourly graph of total customers out and interrupted.

Summation of Customers Restored and Still Out Zone

This zone shows an hourly graph of customers restored vs. customers still out.
Outage Analysis Portal

The Outage Analysis Portal provides the following zones:

- **Average Device Restoration Zone**
- **CMI Summary by Outage Cause**
- **Customers by Device Type**
- **Customers out over 8 hours Zone**
- **Outages by Device Type Zone**

**Average Device Restoration Zone**
This zone shows a pie chart of average restoration times by outage device type.

**CMI Summary by Outage Cause**
This zone shows a pie chart of CMI by outage cause.

**Customers by Device Type**
This zone shows a pie chart of customers out by outage device type.

**Customers out over 8 hours Zone**
This zone shows a graph of customer outage durations by hour.

**Outages by Device Type Zone**
This zone is a pie chart of the number of outages by device type.

Outages By Political Boundary Portal

The Outage by Political Boundary Portal provides the following zones:

- **City Estimated Restoration Performance Zone**
- **Current City Outage Summary**

**City Estimated Restoration Performance Zone**
This zone displays a graph of hourly outage restoration performance by city.

**Current City Outage Summary**
This zone shows a pie chart of current outages by city.

Feeder Performance Portal

The Feeder Performance Portal provides the following zones:

- **Feeder Performance Zone**
- **Worst Performing Feeder Pie Chart Zone**

**Feeder Performance Zone**
This zone lists each feeder, including:

- **SAIDI**
- **Company**
• Region
• Branch
• Substation
• feeder name

**Worst Performing Feeder Pie Chart Zone**
This zone displays a pie chart of the worst performing feeders.

**Worst Performing Feeders Zone**
This zone lists the 10 worst performing feeders, including:
• feeder name
• SAIDI minutes
• percentage of the total SAIDI minutes
• rank

**Sustained Reliability Limits Portal**
The Sustained Reliability Portal provides the following zones:
• ASAI Zone
• Accumulating SAIDI Minutes Zone
• Accumulating SAIFI Outages Zone
• CAIDI Zone
• SAIDI Zone
• SAIFI Zone

**ASAI Zone**
This zone displays a green/yellow/red stoplight indicator with the ASAI calculation and the CMI for the month.

**Accumulating SAIDI Minutes Zone**
This zone displays a graph of the SAIDI, SAIDI limit, YTD SAIDI, and YTD SAIDI limit by month.

**Accumulating SAIFI Outages Zone**
This zone displays a graph of the SAIFI, SAIFI limit, YTD SAIFI and YTD SAIFI limit by month.

**CAIDI Zone**
This zone displays a graph of the CAIDI by month.

**SAIDI Zone**
This zone displays a green/yellow/red stoplight, along with the SAIDI minutes and SAIDI limit for the year.

**SAIDI** stands for system average interruption duration index. This index is commonly referred to as Customer Minutes of Interruption or Customer Hours, and is designed to provide information about the average time the customers are interrupted.
In words, the definition is:

\[
\text{SAIDI} = \frac{\sum \text{Customer Interruption Durations}}{\text{Total Number of Customers Served}} \tag{A BIC 3}
\]

To calculate the index, use the following equation:

\[
\text{SAIDI} = \frac{\sum_{i=1}^{N_i} N_i}{N_T} \tag{A BIC 4}
\]

**SAIFI Zone**

This zone displays a green/yellow/red stoplight, along with the SAIFI outages and SAIFI limit for the year.

**SAIFI** stands for system average interruption frequency index (sustained interruptions). The system average interruption frequency index is designed to give information about the average frequency of sustained interruptions per customer over a predefined area. In words, the definition is:

\[
\text{SAIFI} = \frac{\text{Total Number of Customer Interruptions}}{\text{Total Number of Customers Served}}
\]

The index is calculated using following equation:

\[
\text{SAIFI} = \frac{\sum_{i=1}^{N_i} N_i}{N_T}
\]

**Monthly Reliability Limit Portal**

The Monthly Reliability Portal provides the following zones:

- Monthly ASAI Zone
- Monthly CAIDI Zone
- Monthly SAIDI Zone
- Monthly SAIFI Zone

**Monthly ASAI Zone**

This zone displays a green/yellow/red stoplight, along with the ASAI and ASAI limit for the month.

**Monthly CAIDI Zone**

This zone displays a green/yellow/red stoplight, along with the CAIDI and CAIDI limit for the month.

**Monthly SAIDI Zone**

This zone displays a green/yellow/red stoplight, along with the SAIDI and SAIDI limit for the month.
Monthly SAIFI Zone
This zone displays a green/yellow/red stoplight, along with the SAIFI outages and SAIFI limit for the month.

Current Feeder Lockouts Portal
The Current Feeder Lockouts Portal provides the following zones:
• Current Feeder Lockout by Region Zone
• Current Feeder Lockout by Region Pie Chart Zone

Current Feeder Lockout by Region Zone
This zone displays a list of feeder lockouts, including:
• company
• region
• branch, substation
• feeder name
• event state
• duration
• user-defined measure
• begin date/time

Current Feeder Lockout by Region Pie Chart Zone
This zone displays a pie chart of the number of feeder lockouts by region.

Momentary Reliability Limit Portal
This portal provides the following zones:
• MAIFI Zone
• MAIFLe Zone

MAIFI Zone
This zone shows a graph of the MAIFI by month.

MAIFLe Zone
This zone shows a graph of the MAIFLe by month.

Wire Down Event Portal
The Wire Down Event Portal provides the following zones:
• Active Wire Down Call List Zone
• Current Events with Wires Down Calls List Zone
• Events with Wire Down Calls Zone

Active Wire Down Call List Zone
This zone shows the wire down calls for a selected event.
**Current Events with Wires Down Calls List Zone**

This zone shows a list of current events with wires down, including:

- event state
- branch
- substation
- feeder
- device type
- event number
- duration
- number of customers
- CMI
- user-defined field

**Events with Wire Down Calls Zone**

This zone displays a graph of events with wire down calls by hour.

**Feeder Delivered Load Portal**

The Feeder Delivered Load Portal provides the following zones.

- Smallest Feeder Capacity Margin
- Greatest Feeder Peak Delivered Load
- Feeder Load Detail
- Feeder Delivered Load

**Smallest Feeder Capacity Margin Zone**

When you expand the Smallest Feeder Capacity Margin zone, the following columns are displayed:

- Calculated Capacity Margin
- Feeder Name
- 3 Phase Amp (maximum 3 Phase AMPERE load)
- Breaker Limit

**Greatest Feeder Peak Delivered Load Zone**

This zone displays the top 20 Feeders with corresponding Peak Load KVA.

**Feeder Load Detail Zone**

When you expand the Feeder Load Detail zone, the maximum values for KVA, KW, KVAR, AMP, Feeder Voltage are displayed.

**Feeder Delivered Load Zone**

When you expand the Feeder Delivered Load zone, the average KVA, KW, KVAR, and AMP for each hour are plotted in the zone.
Historical Storms Portal

The Historical Storms Portal provides the following zones:

- Historical Storms Summary
- Historical Storm – Outages By Type
- Historical Storm – Outages By Operating Region
- Storm Outages List

Historical Storms Summary Zone

This zone displays the list of historical storms. Other zones in this portal display information for the storm selected in this zone. Following columns are displayed:

- Storm Name
- Start Date
- End Date
- Storm Type
- Storm Level
- # of Outages

Historical Storm – Outages by Operating Region

This zone displays a count of outages that are part of the selected storm, sliced by geographic region.

Historical Storm - Outages By Type

This zone displays a count of outages that are part of the selected storm, sliced by outage type.

Storm Outages List

This zone displays a list of outages that are part of the selected storm. Following columns are displayed:

- Event Number
- Branch
- Substation
- Feeder
- Start Date
- Est. Restore Date
- Est. Restore Time
- Actual Restore Date
- Actual Restore Time
This chapter covers Oracle Utilities Network Management System – SCADA Extensions, including the following topics:

• Overview
• SCADA Measurements
• Using SCADA Features
• Using the SCADA Summary
• Understanding SCADA Information in the Viewer
• Using the SCADA Alarms List
• Using SCADA Control Tool Features
• Switching Management SCADA Integration

Overview

SCADA Extensions offers extended functions that enhance the capabilities of the Work Agenda, Viewer, Control Tool, and Oracle Utilities Network Management System – Switching Management applications. It also provides SCADA Summary, a window to display information about mapped SCADA measurements. These extended functions incorporate real-time data from a Supervisory Control and Data Acquisition (SCADA) system.

Oracle Utilities Network Management System SCADA Extensions is required in order to display any SCADA data in Oracle Utilities Network Management System, whether it is through the Oracle Utilities Network Management System – SCADA ICCP Block 1, 2, and 5 Adapter interface or a custom interface. The interface itself is a separate component from the Oracle Utilities Network Management System and Oracle Utilities Network Management System SCADA Extensions.

There are two basic types of SCADA interfaces employed. A one-way interface provides Oracle Utilities Network Management System with real-time values for SCADA digital and analog measurements as well as quality codes, tags, and alarms. A two-way interface also allows the remote control of SCADA devices from within Oracle Utilities Network Management System.
SCADA Measurements

There are three possible types of SCADA measurements that Oracle Utilities Network Management System SCADA Extensions can display:

- **Analog** - Numeric measurements of the distribution system operating conditions at SCADA devices, such as amps, kVar, and volts.

- **Status** - Binary values, such as OPEN/CLOSE and ON/OFF. Status values related to switches are mapped into the topological status of switchable devices that affect the energization of the distribution model. Other status values, such as reclose, enabled, loop scheme indication, lightning mode, and fault indicators, are displayed as text pairs of symbols.

- **Digital** - Whole-integer value measurements indicating the state of the device such as tap positions or counters. The Oracle Utilities Network Management System SCADA ICCP Block 1, 2, and 5 Adapter does not currently support digital whole-integer measurements. However, these values can be available if converted through a custom adapter into engineering values.

Quality Codes

Quality codes provide information about the quality of the measurement coming from the SCADA system. Examples may include held, suspect, not valid, telemetered, calculated, entered, estimated, abnormal, “off scan”, “SCADA error”, and “tag on”. Additionally there are quality codes that may be applied to a SCADA measurement from the Oracle Utilities Network Management System applications. These include alarm inhibited and manually overridden.

Quality codes that may be configured to be supplied by the Oracle Utilities Network Management System SCADA ICCP Block 1, 2, and 5 Adapter include held, suspect, not valid, telemetered, calculated, entered, estimated, and abnormal.

Using SCADA Features

There are six primary locations where SCADA information can be accessed in Oracle Utilities Network Management System:

- SCADA device operations that result in customers out appear as real outage events on the trouble related views of the Work Agenda in the same manner as outages that were generated by call information except that they are automatically confirmed and appear immediately as real outages. These operations are also included on the Device Operations List on the Work Agenda.

- The SCADA Summary provides the current values and qualities of all mapped SCADA measurements in Oracle Utilities Network Management System, including both analog and digital measurements. You can filter, sort, modify, and comment on the measurements in the SCADA Summary.

- The Viewer displays dynamically updated SCADA information at or near the corresponding device on the electrical map. The data may be displayed via text annotation or, in the case of status and digital values, symbol changes. SCADA information that may be displayed on the Viewer includes switch status and other status values, digital values, and analog values, all with quality codes.

- The Web Workspace Viewer also shows all SCADA analog and digital values in the balloon dialog.

- The SCADA Alarms list is an extension of the Work Agenda window and may display various alarm messages that are sent from the SCADA system. You can modify, acknowledge, and comment on measurements on the SCADA Alarms list.

- Any SCADA status values that result in a switch being in its off-nominal state will cause the device to appear in the Abnormal Device Summary.
• Systems with a two-way interface let you perform remote operations (e.g., open/close and tagging) on SCADA devices through an enhanced version of the Control Tool.

Using the SCADA Summary

The SCADA Summary provides the current values and qualities of all mapped SCADA measurements in Oracle Utilities Network Management System. Each row of this summary represents one measurement. There may be multiple unique measurements on one SCADA device. SCADA information includes digital and analog measurement values, along with the quality codes and any user comments for each measurement. You can use the summary to view measurement information, manually replace current SCADA values, and inhibit updates.

For information about using the SCADA Summary in the Operator’s Workspace, see Using the SCADA Summary on page 1-57.

For information about using the SCADA Summary in the Web Workspace, see SCADA Summary on page 6-75.

Understanding SCADA Information in the Viewer

Oracle Utilities Network Management System SCADA Extensions provides SCADA information in the Viewer in several different ways.
The following table describes how SCADA information may appear in the Viewer window.

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Status</td>
<td>Switch status information (i.e., open or closed) received from SCADA is</td>
<td>The green, circled device in the previous figure is the symbol for a device open for this device type.</td>
</tr>
<tr>
<td></td>
<td>dynamically updated in the Viewer. Status symbology is no different than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>that for typical devices, except that it is based on data received</td>
<td></td>
</tr>
<tr>
<td></td>
<td>automatically from a SCADA measurement rather than user input.</td>
<td></td>
</tr>
<tr>
<td>Digital Measurements</td>
<td>Digital measurements (e.g., tap position, auto reclose suppression, ground</td>
<td>In the previous figure, the SCADA measurement is indicated as being in auto reclose suppression (ARS).</td>
</tr>
<tr>
<td></td>
<td>fault) received from SCADA are dynamically updated. These measurements are displayed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>as a letter code or symbol next to the SCADA device. There can be several</td>
<td></td>
</tr>
<tr>
<td></td>
<td>digital measurement indicators listed.</td>
<td></td>
</tr>
<tr>
<td>Analog Measurements</td>
<td>Analog measurements received from SCADA are dynamically updated. These</td>
<td>In the previous figure, three analog measurements are received for A phase, B phase, and C phase - 220 amps, 200 amps, and 240 amps, respectively.</td>
</tr>
<tr>
<td></td>
<td>measurements are displayed in the Viewer next to the associated SCADA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>device. Several unique measurements can be listed. When a new measurement is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>replaced the current measurement.</td>
<td></td>
</tr>
<tr>
<td>Quality Codes</td>
<td>Quality codes can be attached to the status, digital, and analog</td>
<td>In the previous figure, quality codes are attached to the device status (“I” for inhibited and “M” for manually entered, which means manually overridden) and analog measurements (“H” and “L” for high and low limit violations).</td>
</tr>
<tr>
<td></td>
<td>measurements. Quality codes provide additional information about the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>quality of the measurement coming from the SCADA device (e.g., out of scan,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>inhibited, manual override). A quality code is displayed as a letter code,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and more than one can be listed. Quality codes attached to a measurement will</td>
<td></td>
</tr>
<tr>
<td></td>
<td>display at the end of the measurement. Those attached to a status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>measurement will display attached to the device itself by a leader line.</td>
<td></td>
</tr>
</tbody>
</table>
Enabling/Disabling SCADA Measurements in the Viewer

You can enable or disable SCADA measurements in the Viewer using the Hide / Display dialog.

**Note:** to access the Hide/Display dialog in the Operator's Workspace Viewer, see *Hiding and Displaying Viewer Objects* on page 1-30; to access the Hide/Display dialog in the Web Workspace Viewer, see *Hiding and Displaying Viewer Objects* on page 6-45.

The system displays a cyan S to indicate that a device has SCADA measurements available for it.

Displaying SCADA Measurements with Device Details

If you select a SCADA device in the Viewer, the Device Details balloon displays a SCADA tab that lists the SCADA measurements for the selected device:

![SCADA Device Details](image)

**SCADA Device Details** (see also *Displaying Device Details* on page 6-32)

- The **Attribute** column contains a description of the measurement type, as configured in the ATTRIBUTES.description column in the Oracle Utilities Network Management System database for the matching attribute.
- The **Value** column contains the last reported measurement value. The value can be status, digital, or analog. For status measurements, the values are displayed as a test pair, such as open/close, on/off, etc. Analog and digital values are shown as floating point and integer values.
- The **Quality** column contains the Quality codes for the measurement that indicates the quality of the SCADA measurement (*e.g.*, out of scan, inhibited, manual override). Several quality codes can be listed.
- The **Source** column contains the source for the measurement, as configured in the ANALOG_MEASUREMENTS.source or DIGITAL_MEASUREMENTS.source column in the Oracle Utilities Network Management System database.
Remote SCADA Operation Warnings

When you perform a remote SCADA device operation in a two-way system, Oracle Utilities Network Management System SCADA Extensions will run certain checks. There are three warnings that you might receive as a result of these checks.

**Note:** The Oracle Utilities Network Management System SCADA ICCP Block 1, 2, and 5 Adapter controls are limited to switch status direct operate request.

The following table describes the possible remote SCADA operations warnings.

<table>
<thead>
<tr>
<th>Warning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCADA Confirmation</td>
<td>When you open or close a SCADA-controlled device, the Look Ahead window opens providing information about the potential results of the operation (see <a href="#">Using the Look Ahead Window</a> on page 1-49). After you view all the required information and choose to proceed, another message box opens, reminding you that a remote operation will take place and asking you to confirm the SCADA-controlled operation.</td>
</tr>
<tr>
<td>SCADA Control Action Time-Out</td>
<td>Once you have confirmed that you want to perform a SCADA-controlled device operation, Oracle Utilities Network Management System SCADA Extensions starts a timer. This timer monitors the response to the operation, expecting a “change-of-state” of the device (e.g., open to close). If a change-of-state is not detected from the device before a time-out occurs, Oracle Utilities Network Management System SCADA Extensions generates an alarm displayed in the SCADA Alarms List.</td>
</tr>
<tr>
<td>SCADA Error</td>
<td>If errors are detected between Oracle Utilities Network Management System and the SCADA interface, a message box opens informing you of the failed operation. You should report these errors to the system administrator or support personnel.</td>
</tr>
</tbody>
</table>

**Note:** If you click **Cancel** in the Look Ahead window, Oracle Utilities Network Management System SCADA Extensions will not initiate the remote SCADA operation.
Using the SCADA Alarms List

Note: This section describes the SCADA Alarms List available from the Operator's Workspace Work Agenda. For information on viewing SCADA alarms in the Web Workspace, see SCADA Alarms List on page 6-79.

If your system is configured with Oracle Utilities Network Management System SCADA Extensions, the Operator's Workspace Work Agenda will also include a SCADA Alarms list. The SCADA Alarms list displays information about all current alarms and is dynamically updated as alarms are reported. Alarms may include events such as status change, limit violations, and physical problems with the SCADA device. These alarms are associated with a specific device. Through the Oracle Utilities Network Management System SCADA ICCP Block 1, 2, and 5 Adapter, only status change events will appear in the SCADA Alarms list.

This section includes the following topics:

• Displaying the SCADA Alarms List
• Viewing a SCADA Alarm in the Viewer
• Acknowledging SCADA Alarms
• Silencing SCADA Alarms
• Removing SCADA Alarms from the List
• Turning Audio Notification On and Off
• Preventing a Device from Reporting SCADA Alarms
• Canceling an Inhibit

Displaying the SCADA Alarms List

To access the SCADA Alarms list, select SCADA Alarms List from the File menu of the Work Agenda window.

The SCADA Alarms List displays the following fields and buttons:

• The Date column contains the date and time the alarm was generated.
• The Feeder Zone column contains the name of the feeder zone of the device associated with the alarm.
• The Feeder column contains the feeder on which the device in alarm is located.
• The Device column contains the identification of the device associated with the alarm.
• The Description column contains a description of the alarm.
• The Attribute column contains the type of SCADA measurement (e.g., current, voltage).
• The Value column contains the last reported measurement value. The value can be status, digital, or analog. For status measurements, typically a value of “0” indicates open and a value of “1” indicates closed. Any special tags placed on the device would be indicated by a digital value.
• The Quality column contains the quality codes for the measurement. This is information about the quality of the measurement coming from the SCADA device (e.g., out of scan, inhibited, manual override). Several can be listed.
• The Unit column contains the measurement units, if any.
• The Phase column contains the phase of the measurement, described as A, B, C, or a combination of phases.
• The Nominal column contains the nominal value of the measurement that is in alarm (only for digital).
• The **Limit** column contains the limit an analog measurement violated to generate the alarm.

• The **Point Name** column contains the name of the measurement, as configured in the ANALOG_MEASUREMENTS.source or DIGITAL_MEASUREMENTS.source column in the Oracle Utilities Network Management System database.

• The **Acknowledge** button stops the audio notification for an alarm and acknowledges it.

• The **Silence** button stops the audio notification for an alarm without acknowledging it. Subsequent new alarms will still cause audio notification.

• The **Inhibit Alarm** button prevents updates from SCADA for the particular measurement.

• The **Cancel Inhibit** button removes the “inhibit” quality code from the selected SCADA measurement. This allows updates from SCADA that may generate alarms.

• The **Switch Plan** button will open the switching plan if an alarm is associated with one. If there is no associated switching plan, it will open the last viewed switching plan (see **Managing Switching Plans** on page 14-1).

• The **Clear** button removes the alarm from the SCADA Alarms List.

The **Exit** button closes the SCADA Alarms List window.

### Viewing a SCADA Alarm in the Viewer

To view a SCADA alarm in the Viewer window, complete these steps:

1. In the SCADA Alarms List, select the row of the alarm you want to view.
2. Open a Viewer window. For information on opening a Viewer window, see Using the **Operator’s Workspace Viewer** on page 1-15.
3. Click on the **Object Focus** button (target icon) on the Viewer toolbar. Alarms are indicated in the Viewer in several ways. (See **Understanding SCADA Information in the Viewer** on page 13-3.)

### Acknowledging SCADA Alarms

To acknowledge a SCADA alarm, complete these steps:

1. In the SCADA Alarms List, select the row of the alarm you want to acknowledge.
2. Click the **Acknowledge** button. The following occurs:
   • The alarm becomes acknowledged.
   • Its audible alarm is silenced.
   • Your user name appears in the Who Ack field.
   • The current date and time appears in the Date Ack field.

### Silencing SCADA Alarms

To silence a SCADA alarm, complete these steps:

1. In the SCADA Alarms List, select the row of the alarm you want to silence.
2. Click the **Silence** button. The following occurs:
   • The audio notification for the alarm becomes silent.
   • The alarm is still not acknowledged.
   • Subsequent new alarms will cause the audio notification to sound.
Removing SCADA Alarms from the List

To remove a SCADA alarm from the list, complete these steps:

- Select the row of the alarm you want to silence.
- Click the **Clear** button. The alarm disappears from the list.

**Note.** You can remove multiple alarms by selecting multiple rows before you click the **Clear** button. Select multiple rows by clicking a row, holding the mouse button, and dragging the pointer over the additional rows.

Turning Audio Notification On and Off

To turn audio notification on or off, click on the Audio Enabled radio button at the top of the Work Agenda window. The audio for the entire system (all alarms) will toggle on or off.

Preventing a Device from Reporting SCADA Alarms

To prevent a device from reporting SCADA Alarms, complete these steps:

1. Select the row of an alarm that belongs to the device you want to inhibit.
2. Click the **Inhibit Alarm** button.

- The device will not report SCADA alarms until the inhibit is cancelled.
- An “I” appears next to the device in the Viewer indicating the device is inhibited.
- An “I” appears in the Quality columns of the SCADA Alarms List and the SCADA Summary.

**Note.** Inhibiting alarms does not affect the physical SCADA device; it only prevents Oracle Utilities Network Management System SCADA Extensions from reporting an incoming alarm.

Canceling an Inhibit

To cancel an inhibit, complete these steps:

1. Select the row for the alarm.
2. Click the **Cancel Inhibit** button. The device will no longer be prevented from reporting SCADA alarms.

Using SCADA Control Tool Features

If your system has a one-way SCADA interface, you can only receive information about SCADA measurements. If it has a two-way SCADA interface, however, not only can you receive information, but you can also remotely control SCADA devices. The Oracle Utilities Network Management System SCADA ICCP Block 1, 2, and 5 Adapter remote control is limited to direct operate request of switch status.

Use the Control Tool to perform operations on SCADA devices in the exact same manner as you would on non-SCADA devices (see **Performing Device Operations** on page 1-38). However, the buttons on the Control Tool for opening and closing SCADA devices will read **Open SCADA** and **Close SCADA** (instead of simply **Open** and **Close**).
Switching Management SCADA Integration

If you have a two-way SCADA system, you can operate devices as a step when completing a switching plan. Just like a typical switching plan, you can open or close devices by selecting the switching step and clicking the **Complete** button. (For Switching Management in the Operator's Workspace see Instructing and Completing Switching Steps on page 14-29. For Web Switching Management, see Issuing a Switching Sheet on page 15-36.) With a two-way SCADA system, however, the actual device will be remotely operated. The Oracle Utilities Network Management System SCADA Extensions generates an alarm displayed in the SCADA Alarms List.
This chapter describes the Switching Management functionality. It includes the following topics:

- Managing Switching Plans
- Maintaining Safety Documents

Managing Switching Plans

Oracle Utilities Network Management System - Switching Management allows you to create and implement switching plans as well as maintain safety documents. Switching plans allow you to track proposed switching actions, analyze the results, and implement the plan. You can prepare switching plans, including device-tagging operations, using the Switch Sheet Editor. You can also copy frequently used switching step sequences using switching templates. In cases of an emergency, you can create a record of the operations performed as you go in an emergency switching plan.

Switching plans, switching templates, and safety documents are organized separately in the Work Agenda window. You can access these records to edit the information and perform the switching operations. See Maintaining Safety Documents for more information on safety documents.

This section includes the following topics:

- Understanding Switching Plans
- Using the Switch Sheet Editor
- Using Web Request
- Planned Switching
- Emergency Switching
- Event Associations
- Working with Switching Templates
- Using the Miscellaneous Log
- Viewing Switching Lists
Understanding Switching Plans

Planned switching refers to switching sequences that are prepared ahead of time. Emergency switching refers to switching sequences that are prepared and implemented when overloads or unplanned outages occur. In planned switching, switching steps are created and reviewed in a Viewer in study mode prior to being completed in real-time.

This section includes the following topics:

- Switching Plan States
- Switching Plan Modes

Switching Plan States

A switching plan passes through different phases during the creation and completion of the plan. These phases are represented by “states” which follow a logical sequence and determine what you can do with a switching plan. The state of the switching plan should not be confused with the state of individual switching steps within the switching plan.

You can view the state of a switching plan in the Status column on the Switching Plan List (in the Work Agenda window) or in the Status field at the top of the Switch Sheet Editor. The following table describes the different switching plan states and their equivalent short form versions, which are displayed within the Status column of the Switching Plan List.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New (New)</td>
<td>A user started a new Switching Plan from the Environment Manager's New Switching Plan button, the Switch Sheet Editor File menu, or the Web Request form. The switching plan is in the process of being created but has not yet been requested.</td>
</tr>
<tr>
<td>Requested (Req)</td>
<td>This state is achieved after clicking the Submit Request button from the Switch Sheet Editor or from the Web Request form. The name of the individual who requested the switching operation and their phone number are required in order to transition to this state. The Requested By and Phone Number fields in the Request section of the Switch Sheet Editor and Web Request form are used to enter this information. The Date field next to the Requested By field on the Switch Sheet Editor indicates when the initial request was made.</td>
</tr>
<tr>
<td>Request Rejected (RRej)</td>
<td>A user clicked the Request Rejected checkbox within the Tracking section of the Switch Sheet Editor. The Request Rejection Reason field displays the reason why the request was rejected. At this point, the switching plan can either be deleted or altered and requested again. The resubmission of the request can either be done from the Switch Sheet Editor or the Web Request form.</td>
</tr>
<tr>
<td>Prepared (Pre)</td>
<td>A user clicked the Prepared checkbox within the Tracking section of the Switch Sheet Editor. Although not required, all information for the switching plan can be entered prior to clicking the Prepared checkbox.</td>
</tr>
<tr>
<td>Checked (Che)</td>
<td>A user clicked the Checked checkbox within the Tracking section of the Switch Sheet Editor. All information for the switching plan should be entered prior to indicating that the plan was checked.</td>
</tr>
<tr>
<td>Approved (App)</td>
<td>A user clicked the Approved checkbox within the Tracking section of the Switch Sheet Editor. All information for the switching plan should be entered prior to a user approving the plan.</td>
</tr>
</tbody>
</table>
Switching Plan Modes

There are two types of modes that apply to switching plans: operating modes and editing modes.

The operating mode establishes whether changes made in the Switch Sheet Editor affect the real-time or study model. Real-Time and Study are the switching plan operating modes. Real-Time sets the session to real-time mode, which allows you to make real-time changes to the state of devices in the system. Study sets the session to study mode, which allows you to make changes without affecting real-time data. You can apply the actions to the steps, but the actions are not applied to the real-time data.

The editing mode establishes which information you can edit and whether it is saved as a switching plan or a template. View Only, Plan Editor, Template Editor and Misc Log are the switching plan editing modes. View Only sets the Switch Sheet Editor window to view-only mode, which allows you to view the switching plan with certain buttons and fields disabled. If another user is already editing a switching plan, the Switch Sheet Editor is automatically set to view-only.
mode. Plan Editor sets the window to editing mode for the switching plans of type Planned and Emergency. Template Editor sets the window to switching template editing mode. Misc Log sets the window to miscellaneous recording mode.

Using the Switch Sheet Editor

The Switch Sheet Editor allows you to create and edit switching plans.

Opening the Switch Sheet Editor

To access the Switch Sheet Editor, click the New Switching Plan button on the Environment Manager or load a switching plan from the Work Agenda Switching Plan List.

A switching plan has six sections:

- Header Section
- Request Section
- Contact Section
- Tracking Section
- Audit Log Section
- Steps Section

The Header section is always visible. The remaining five sections can only be viewed one at a time. You can view specific sections of the Switch Sheet Editor in the following ways:

- Click the tab button under the Header section (e.g., Request) that corresponds to the section you want to view.
- Click the button for the section you want to view from the Switching Plan List in the Work Agenda window.

Switch Sheet Editor Menus

The following table describes the Switch Sheet Editor menu options.

- File Menu
  - New - allows you to create a template, planned or emergency switching plan.
  - Copy - copies the steps from the current plan into a newly created plan. The new plan can be one of the following types: Planned, Emergency or Template. You are asked to select the type of plan on the Sheet Type popup dialog. For Planned and Emergency types, all of the text entry fields are copied except for the date, time and approval fields, which are cleared. For Templates, all text entry fields are cleared except for the Description of Work field.
  - Save - saves the changes made to the switching plan.
  - Save as Template - saves a copy of the current switching plan as a template that can be used again later. You are asked if you want to formalize the device names in the switching plan steps.
  - Print - opens the Print dialog for printing out hard copies of the switching plan.
  - Delete Job - deletes the current switching plan. A switch plan can be deleted until it has been approved or scheduled.
  - Exit - closes the Switch Sheet Editor window.
  - [plan #] - lists the ten most recently loaded switching plans. Selecting one causes the Switch Sheet Editor to load up that plan. The description of each of the options is built...
from the switch sheet number, switch sheet type, and the text entered in the Feeders field. Example: “1001 (Planned) FDR_10003”

• **Edit Steps Menu**
  
  • **Add** - adds a step below the last step.
  
  • **Insert** - inserts a step above the selected step.
  
  • **Delete** - deletes the selected step(s).
  
  • **Move Up** - moves the selected step(s) up one row.
  
  • **Move Down** - moves the selected step(s) down one row.
  
  • **Undo** - removes the last change (Delete, Cut or Paste) made to the step(s).
  
  • **Cut** - marks the selected step(s) within the table as being cut. When not selected, the step will be colored yellow. When cut steps are pasted, they will either be redlined and copied or moved to their newly pasted location.
  
  • **Copy** - copies the selected step(s).
  
  • **Paste** - pastes the cut or copied step(s) below the currently selected step. This can be within a different plan from where the steps were cut or copied.
  
  • **Find Device** - opens a search dialog box that allows you to enter the device you want to search for in the plan steps. You can then choose to replace the found device alias with a new device alias.
  
  • **Find Text** - opens a search dialog box that allows you to enter the text you want to search for in the plan steps Description column. You can then choose to replace the found text with new text.

• **Actions Menu**
  
  • **Instruct** - Changes the status of steps from blank to “Instructed” and populates the Instructed By and Instructed Date columns.
  
  • **Complete** - Changes the status of steps from blank or “Instructed” to “Completed” and populates the Completed Date column.
  
  • **Abort** - Changes the status of a step from blank or “Instructed” to “Aborted” and populates the Completed Date column without actually performing the switching actions. Use this if a step was never attempted.
  
  • **Action Failed** - Changes the status of a step from blank or “Instructed” to “Action Failed” without actually performing the step and populates the Completed Date column. Use this if a step was attempted but failed.
  
  • **Create Gobacks** - Creates a sequence of reversal steps from the selected steps in inverse order. You are asked to either insert the newly created steps or append them to the end of the steps list.
  
  • **Create Gobacks for All** - Creates a sequence of reversal steps from all steps in inverse order. The new steps are added to the end of the steps list.
  
  • **E-Mail Plan**… - Opens an email dialog allowing you to send an HTML version of the switching plan to the list of entered recipients.
  
  • **Reset Study Session** - Allows you to reset the study time Viewer to either a copy of real-time or what it was when the study session was initiated. It also resets the study-executed steps. Only available in study mode.
  
  • **View Device** - Focuses the Viewer window on the device for the selected step.
• **Save Area** - Saves the coordinates of the VIEW1 Viewer current viewing area with the switching plan. Only one set of coordinates can be saved with a switch plan at any one time.

• **View Area** - Focuses the VIEW1 Viewer on the coordinates that were saved with the switching plan. This button is only enabled after a viewing area has been saved with a switching plan.

• **Tools Menu**

  • **Switching List** - opens the Work Agenda window displaying switching plans in the Switching Plan List.

  • **Template List** - opens the Work Agenda window displaying the switching plan templates in the Switching Templates List.

  • **Create New Safety** - creates a new safety document and associates the safety document with the switching plan. A sub-menu allows you to choose the type of safety document you want to create. Types of safety documents include: Information Note, Warning, Clearance, Hold, Hot Line

  • **Customers Impacted** - generates or loads the saved list of customers impacted by the prerecorded switching plan steps.

  • **Switching Overlaps** - displays any overlaps the switching plan has with other existing switching plans based on the start date, end date, devices and control zones devices are a part of.

• **Mode Menu**

  • **Real Time** - changes to real-time mode, which applies the actions you take to the real-time system.

  • **Study** - changes to study mode, which applies the actions you take to the study system, not the real-time system.

  • **View Only** - changes the window to view only mode. You cannot create or edit switching plans in view only mode. This mode is automatically selected when you try to load a switching plan that is being edited by another user. When this happens, a dialog will be issued indicating that the plan is being placed into the View Only mode.

  • **Plan Editor** - changes to the Switch Sheet Editor, which allows you to create and edit Planned and Emergency switching plans.

  • **Template Editor** - changes to the Switch Template Editor, which allows you to create and edit switching templates.

  • **Misc Log** - changes to the Switch Miscellaneous Log, which is a log that records all real-time actions that have not been recorded in another switching plan.

**Header Section**

The header section of the Switch Sheet Editor displays general information about the switching plan. The header section displays the following fields and buttons:

• **Plan #** displays a unique number assigned to the switching plan. You can enter a number into this field to open an existing switching plan.

• **Rev** displays the revision number of the switching plan.

• **Type** displays the type of switching plan - Template, Planned or Emergency.

• **Status** displays the state of the switching plan. See **Switching Plan States** on page 14-2.

• **Feeders** displays the list of feeders that are relevant to the switching plan. This is a text entry field and is not auto-populated.
• **Safety Docs** lists the safety documents associated to the switching plan. Each associated safety document number displays in this field. You can double-click on a safety document number to open the Record Safety Dialog. From this dialog, you can open the safety document, disassociate it from the switch plan, or record safety steps into the switching plan.

• **Events** lists the events associated to the switching plan. The event numbers are displayed in this field. The list can have the following types of associations and will be listed in the order of Master, Planned, Forced, Manual and Canceled. See Event Associations on page 14-32 for more information.

• The **Revision Status** button is the status button found to the right of the Rev field. You can use this button to increment the revision number of the switch plan. The icon on this button is also used to inform you of when changes are being made to the current revision or whether it is up-to-date. This button cannot be selected or the revision changed in the new, requested and completed states. While in these states, the button's icon will be colored grey.

  Note: automatic red-lining and automatic revision incrementing will not be initiated unless the sheet is in the Issued, In Progress, or Hold/Pending states. If the revision has been manually locked down prior to reaching these states, it is up to the user to manually initiate revision changes prior to editing steps.

• The **Add Event** button opens a dialog box that allows you to enter an event number to associate with the switching plan. These events will show up as “Manual” associated events within the Events list.

• The **Rem. Event** button removes the selected event association from the switching plan. This button will only be selectable when “Manual” associated events are selected within the Events list.

• The **Switching Crew List** is used to automate the population of the Instructed To column as steps are instructed and completed. To populate the Instructed To column for an uninstructed step, select the step, then select the crew(s) from the Switching Crew List. As long as event updates are not made to the plan, the crew will remain selected as steps are instructed and completed. As each step is instructed, the Instructed To column for that step will be auto populated. Only when crews are assigned or en route to events associated to the switching plan will they be displayed in this list.

• The **Crew ID** column contains the crew ID of the crew.

• The **Event #** column contains the event number the crew is assigned or en route to.

• The **Contact** column contains the contact name for the crew.

• The **Mobile #** column contains the contact's mobile phone number.

• The **Pager #** column contains the contact's pager number.

• The **ASN/ENR Date** column contains the date and time of when the crew was assigned or placed en route to the event shown in the Event # column.

• The **Status** column indicates whether the crew is assigned or en route to the event shown in the Event # column.

• The **Type** column contains the crew's type (e.g., Trouble).

• The **Refresh Crew List** button refreshes the Switching Crew List. This will also clear the selections made to this list. If crews were selected, then they will have to be reselected.

Just below the Refresh Crew List button of the Header section is a **Hide Crew List/Show Crew List** button. Pressing this button toggles the display of the crew list table in the Header section.

### Request Section

The Request section of the Switch Sheet Editor contains information about the person or department requesting the work. Logic is built into these fields (e.g., start date must be before the finish date). The Request section displays the following fields and buttons:

Switching Management 14-7
Managing Switching Plans

- **Requested By** displays the person requesting the switching order. This field is required prior to submitting the request.

- **Requested Date** displays the date and time of when the user selected the **Submit Request** button for the first time. This date will not be changed if the plan is rejected and re-requested.

- The **Submit Request** button changes the status of the switching plan from New to Requested and populates the Requested Date field.

- **Phone Number** displays the phone number of the person requesting the switching order. This field is required prior to submitting the request.

- **Office** displays the office responsible for the switching plan. Required prior to completing a switching plan.

- **Location of Work** displays the street address or specific location for the switching operation. Required prior to completing a switching plan.

- **Start Date** displays the date and time the switching work is scheduled to begin. This date will be the Start Date given to the master event associated to the switching plan after it has been scheduled. Required when scheduling a switching plan. Enter the time in military time format (e.g., 13:00 = 1 P.M.).

- **Finish Date (ERT)** displays the date and time the switching work is scheduled to end. Required when scheduling a switching plan. This date will be the Est Restore Time given to the master event associated to the switching plan after it has been scheduled. The finish date must be later than the start date, and you must enter the finish time for the date to be valid. Enter the time in military time format (e.g., 13:00 = 1 P.M.).

- The **Update ERT** button is used to update the ERT for the master event associated to the switching plan. This option is available after the plan has been scheduled.

- **Alt. Start Date** displays the alternate date and time the switching work could begin. Enter the time in military time format (e.g., 13:00 = 1 P.M.). The alternate start date must be later than the start date.

- **Alt. Finish Date** displays the alternate date and time the switching work could end. The alternate finish date must be later than the alternate start date. Enter the time in military time format (e.g., 13:00 = 1 P.M.).

- **Substation** displays the substation where the switching operation takes place.

- **Device** displays the device being worked on (not necessarily the device being switched). This device will be given to the master event associated to the switching plan after the plan has been scheduled.

- The **Get Selected** button can be used to populate the Device text field with a device alias selected from the Viewer.

- **Voltage** displays a drop-down menu that lists the nominal device voltage of the device(s) involved in the switching plan.

- **Description of Work** displays a general description about what the switching plan should try to accomplish.

- The **Exit** button closes the Switch Sheet Editor window.

**Contact Section**

The contact section of the Switch Sheet Editor contains information relating to the crew, a requesting customer and the planned events that the switching plan may create. The Contact section displays the following fields and buttons:
• **Planned Operations Event Note** displays the operations event note related to the planned event(s), which is used to pass information from operations staff to call takers and other people outside of the control room.

• **Event Note Last Updated** displays the date and time the planned operations event note was updated. Use the **Send/Update Event Note** button to update the date and time and send the note to the external system(s) that may be using the operations event note.

• The **Send/Update Event Note** button saves or updates the operations event note for the switching plan. The date and time in the Planned Operations Event Note - Last Updated field is updated with the current date and time. The note is sent to external system(s) such as the customer information and call taking system that may be using the operations event note.

• The **Delete Event Note** button clears the **Planned Operations Event Note** field and updates the Event Note Last Updated field. The note is permanently deleted from the system.

• **Crew Will Switch** is a toggle that allows you to indicate whether the requesting crew will perform the switching activities.

• **Crew Will Restore** is a toggle that allows you to indicate whether the requesting crew will restore the outage associated with the switching activities.

• **Grounds Required** is a toggle that allows you to indicate whether the crew is required to place grounds on the appropriate devices or not.

• **Contact** displays the lead crew contact for this switching order.

• **Phone** displays the telephone number for the lead crew contact.

• **Pager** displays the pager number for the lead crew contact.

• **Fax** displays the fax number for the lead crew contact.

• **Customer Requested** is a toggle that allows you to indicate whether a customer requested the switching sequence. The toggle is for informational purposes. Once selected, the **Customer Name** and **Customer #** fields become editable.

• **Customer Name** displays the name of the customer requesting the interruption.

• **Customer #** displays the telephone number of the customer requesting the interruption.

• **Customer Interrupted** is a toggle that allows you to indicate that a customer has been interrupted. This toggle button is automatically set when there are steps that cause customers to be impacted. This is determined when you select the **Customers Impacted** option from the Tools pull-down menu. This toggle button is automatically unselected if the **Customers Impacted** option has been selected and it was determined that no customers will be impacted by the switching plan.

• The **Exit** button closes the Switch Sheet Editor window.

**Tracking Section**

The tracking section of the Switch Sheet Editor contains information about who approved or rejected the switching plan and the status of the plan. The Tracking section displays the following fields and buttons:

• **Prepared By** displays the user name of who prepared the switching plan. Click the check box to populate the Prepared By field. The current date and time are also recorded in the Prepared Date field. The switching plan transitions to the state of Prepared.

• **Checked By** displays the user name of who checked the switching plan. Click the check box to populate the Checked By field. The current date and time are also recorded in the Checked Date field. The switching plan transitions to the state of Checked.
Managing Switching Plans

- **Approved By** displays the user name of who approved the switching plan. Click the check box to populate the Approved By field. The current date and time are also recorded in the Approved Date field. The switching plan transitions to the optional state of Approved.

- **Scheduled By** displays the user name of who scheduled the switching plan. Click the check box to populate the Scheduled By field. The current date and time are also recorded in the Scheduled Date field. The switching plan transitions to the state of Scheduled. At this point, the Master planned switching event is created as well.

- **Issued By** displays the user name of who issued the switching plan. Click the check box to populate the Issued By field. The current date and time are also recorded in the Issued Date field. The switching plan transitions to the state of Issued.

- **Hold/Pending By** displays the user name of who placed a hold on the switching plan. Click the check box to populate the Hold/Pending By field. The current date and time are also recorded in the Hold/Pending Date field. The switching plan transitions to the state of Hold/Pending.

- **Completed By** displays the user name of who determined the switching plan as being complete. Click the check box to populate the Completed By field. The current date and time are also recorded in the Completed Date field. The switching plan transitions to the state of Completed.

- **Request Rejected By** displays the user name of who rejected the requested switching plan. Click the check box to populate the Request Rejected By field. The current date and time are also recorded in the Request Rejected Date field. The switching plan transitions to the state of Request Rejected. Rejecting a requested switching plan requires the plan to be requested again.

- **Check Rejected By** displays the user name of who rejected the checked switching plan. Click the check box to populate the Check Rejected By field. The current date and time are also recorded in the Check Rejected Date field. The switching plan transitions to the state of Check Rejected. Rejecting a checked switching plan requires the plan to be prepared and checked again.

- **Canceled By** displays the user name of who canceled the Scheduled switching plan. Click the check box to populate the Canceled By field. The current date and time are also recorded in the Canceled Date field. The switching plan transitions to the state of Canceled. Canceling a scheduled switching plan requires the plan to be scheduled again.

- **Cancel Reason** displays the description of why the switching plan was canceled. A reason is required before the switching plan can be canceled. This reason is also recorded in the Post-Completion Edit Log for the canceled Master event in the Event Details display.

- The **Exit** button closes the Switch Sheet Editor window.

**Audit Log Section**

The audit log section contains a list of status changes the plan has gone through since it was created. An entry will be added to the log when the revision of the plan has changed and also when the customer impacted list has been modified and saved to the database. The text “Customers Impacted List saved” will be displayed in the **Comment** column for any entry relating to saving a modified customers impacted list. The list of status and revision changes is in chronological order.

The Audit Log section displays the following fields and buttons:

- The **Date** column contains the Date and Time of when the Status or Revision change was made.
• The **Status** column contains the status of the switching plan after a status or revision change.
• The **Rev** column contains the revision of the switch plan when the status or revision changed.
• The **User ID** column contains the user that initiated the status or revision change.
• The **Comment** column contains the text entered for any of the rejection reason fields on the Tracking section or you can manually enter a value into this column as well.
• The **Exit** button closes the Switch Sheet Editor window.

**Steps Section**

The steps section of the Switch Sheet Editor contains the steps included in the switching plan. This section allows you to order and review the steps in study mode, as well as determine the status of the step.

The Steps section displays the following fields and buttons:

• The **Step** column contains the sequential number of the step in the switching plan.
• The **Subnum** column contains the step’s sub-number. Sub-numbering distinguishes between previously issued steps and newly added steps. This allows you to add more steps to a switching plan (even though the previous version has already been issued to a crew), without changing the numbering on the previously issued steps.
• The **Rev** column contains the revision number of the switching plan when the step was added.
• The **Description** column contains the description of the switching action.
• The **Details** column contains a one-line description of the type of impact the device operation will have on the model. This is auto populated when the step is first recorded into the switch steps list. Either Deenergize a section of the network, Energize a section of the network, Create a loop, Break a loop, Create a parallel on feeders […], or Break a parallel on feeders […] will show up in this column for Open and Close device actions.
• The **Status** column contains the state of the switching plan step. Possible states are Instructed, Completed, Aborted, Action Failed or Deleted.
• The **Instructed By** column contains the name of the user who instructed the step.
• The **Instructed Date** column contains the date and time the step was instructed.
• The **Instructed To** column contains the person the step was instructed to (e.g., name of the crew member). If a crew or multiple crews are selected in the Switching Crew List, then those crew IDs will be auto populated into this column when the step is selected.
• The **Completed Date** column contains the date and time the step was completed, aborted or action failed.
• The **Additional Comments** column is a text entry field that you can use to supply additional information about the step.
• The **Record** button toggles the record function on and off. When the record function is on, you can record new switching steps for the switching plan from the Control Tool. In order to record switching steps, the Viewer window mode must match that of the switching plan.
• The **Add** button adds a blank step (row) below the last step.
• The **Insert** button inserts a step (row) above the currently selected step.
• The **Delete** button deletes the selected step(s).
• The **Move** button moves the selected step(s) up or down one row. Use the up or down arrows to move the step(s).
• The **Show Address Rows** button toggles the display of an additional row below each step to display the address of the device.

• The **Instruct** button changes the status of the step(s) from blank to “Instructed” and populates the Instructed By and Instructed Date columns. Steps are not required to be Instructed before being Completed, Aborted or Action Failed. It is up to you to decide if the step should be Instructed first.

• The **Complete** button changes the status of the step(s) from blank or “Instructed” to “Completed” and populates the Completed Date column.

• The **Abort** button changes the status of the step from blank or “Instructed” to “Aborted” and populates the Completed Date column without actually performing the switching action. Use this action if a step was never attempted.

• The **Action Failed** button changes the status of the step from blank or “Instructed” to “Action Failed” without actually performing the step and populates the Completed Date column. Use this if a step was attempted but failed.

• The **Exit** button closes the Switch Sheet Editor window.

---

**Using Web Request**

The Switching Management - Web Request window is used to create switching requests without having to log into a full Oracle Utilities Network Management System environment. The Web Request window has two main tabs - the Request tab and the Request List tab.

You will initially access the Web Request window from a web browser, which will download the application to your computer. Subsequently, you may start it through a desktop shortcut, from your browser Favorites, or from your computer's Start menu.

This section includes the following topics:

• **Logging On to Web Request**

• **Web Request Menus**

• **Using the Request Tab**

• **Using the Request List Tab**

• **Creating A New Request Via the Web Request Form**

**Logging On to Web Request**

The Login window is the first Web Request window you will see. You must enter a valid user name and password, and then click the **Validate** button. Once your user name and password are validated, the system populates the option menu that allows you to select a user type. You will see different initial windows and options depending upon the user type specified.

To start the Web Request form, complete these steps:

1. Depending on how your system was installed, either:
   • Click the **Web Request** icon found under the appropriate program group in your Windows Start Menu, or
   • Double click the **Web Request** icon on your desktop, or
   • Open a web browser and type the Web Request URL in the browser's Address field.

   The Web Request Login window displays.

2. In the **User ID** field, enter the user name provided to you by the system administrator.

3. In the **Password** field, enter the password provided to you by the system administrator.
4. Click the **Validate** button. The system verifies your login credentials. If the user name and password are not entered correctly, the system displays a warning dialog box. If the login is validated, the bottom portion of the Web Request Login window sensitizes.

5. Select the appropriate **User Type** from the drop-down menu. This contains the list of user types within your authority.

6. Click the **Login** button. The appropriate Web Request window opens, based upon the User Type selected.

**Web Request Menus**

- **File Menu** - The options in the File menu are available in both the Request tab and the Request List tab. The following table describes the File Menu option.
  - **New Request** - Start a new request and initialize the fields on the Request form.
  - **Print** - Opens the Print Preview dialog, which allows you to print the current contents of the selected tab.
  - **Exit** - Closes the Web Request window.

- **Filter Menu** - The Filter menu has standard options that allow the Request List to be filtered either by the current users login user name or to show all the requests created by all the users. The Filter menu also has the standard Dialog option for creating your own filters. See **Filtering** on page 1-5 for more information.
  - **Dialog** - Opens the Filter Dialog, which is used to add and delete user-defined filters.
  - **Current User** - Filters the Request List to show only list requests created by the User Name you typed in when logging in.
  - **All** - Displays the Request List with no filters (all requests created by all users are included).

- **Actions Menu** - The Actions menu is context sensitive and will change based on which main form is selected. When the Request tab is selected, then actions pertaining to saving, submitting and editing of a request are enabled. If the Request List is selected, then the actions pertain to viewing a selected request and refreshing the list.
  - **Submit Request** - Submits the request and places the request into the Requested state.
  - **Copy** - This option will become enabled when viewing a request in a non-edit mode. When this option is selected, the currently displayed request's values will be copied into a new request.
  - **Edit** - This option will become enabled when viewing a request in a non-edit mode. Selecting this option will place the request into an edit mode.
  - **Cancel Edit** - This option will become enabled when in an edit mode. If for any reason you wish to cancel any changes you have made, then select this option. A dialog will appear asking you to confirm your action.
  - **Save** - This option will become enabled when in an edit mode. You may save a request at any time, even prior to submitting it. Saving a pre-submitted request will place the request into the New state.

- **Actions Menu** - The following table describes the Actions Menu option for the Request List tab.
  - **View** - This option will become enabled when a request is selected within the list. Selecting this option will load the request into a view mode within the Request form.
  - **Refresh** - This option will refresh the Request List with the latest list of requests for the currently active filter.
• **Help Menu** - The option on the Help menu is available at all times.
• **About Web Request** - Opens a dialog that displays information regarding what version of the application is presently running, as well as version and other information about the Oracle Utilities Network Management System Web Gateway that the application is using.

**Using the Request Tab**

The Request tab lets you create, submit, and edit switching plan requests.

The Request tab contains the following sections:

• **Header**
• **Request Tab Request Section**
• **Request Tab Contact Section**
• **Request Buttons**

Related Topics:

• **Creating A New Request Via the Web Request Form**

**Header**

The header section of the Request tab contains the request (Plan) number and the status of the request.

The Header section displays the following fields:

• **Plan** displays the switching plan's request number.
• **Status** displays the status of the request.

**Request Tab Request Section**

The Request tab also has a sub section with two separate tabs - Request and Contact. The Request section contains information about the person or department requesting the work. Logic is built into these fields (e.g., start date must be before the finish date).

The Request section of the Request tab displays the following fields:

• **Requested By** displays the person requesting the switching order. This field is required prior to submitting the request.
• **Phone Number** displays the phone number of the person requesting the switching order. This field is required prior to submitting the request.
• **Charge Number** fields are used to enter charge numbers that can then be used by the switching plan preparer and/or executer.
• **Office** displays the office responsible for the switching plan. Required prior to completing a switching plan.
• **Location** displays the street address or specific location for the switching operation.
• **Start Date** displays the date and time the switching work should be scheduled to begin. Use the calendar dialog to enter a date and time. The dialog will be shown when the calendar button is selected.
• **Finish Date** displays the date and time the switching work should be scheduled to end. The finish date must be later than the start date, and you must enter the finish time for the date to be valid. Use the calendar dialog to enter a date and time. The dialog will be shown when the calendar button is selected.
• **Alt. Start Date** displays the alternate date and time the switching work could begin. The alternate start date must be later than the start date. Use the calendar dialog to enter a date and time. The dialog will be shown when the calendar button is selected.

• **Alt. Finish Date** displays the alternate date and time the switching work could end. The alternate finish date must be later than the alternate start date. Use the calendar dialog to enter a date and time. The dialog will be shown when the calendar button is selected.

• **Substation** displays the substation where the switching operation takes place.

• **Feeder** displays the feeder where the switching operation takes place.

• **Device** displays the device being worked on (not necessarily the device being switched).

• **Voltage** displays a drop-down menu that lists the nominal device voltage of the device(s) involved in the switching plan.

• **Description of Work** displays a general description about what the switching plan should try to accomplish.

**Request Tab Contact Section**

The Contact section of the Request tab contains information relating to the crew and a requesting customer.

The Contact section of the Request tab displays the following fields:

• **Crew Will Switch** is a toggle that allows you to indicate whether the requesting crew will perform the switching activities.

• **Crew Will Restore** is a toggle that allows you to indicate whether the requesting crew will restore the outage associated with the switching activities.

• **Grounds Required** is a toggle that allows you to indicate whether or not the crew is required to place grounds on the appropriate devices.

• **Contact** displays the lead crew contact for this switching order.

• **Phone** displays the telephone number for the lead crew contact.

• **Pager** displays the pager number for the lead crew contact.

• **Fax** displays the fax number for the lead crew contact.

• **Customer Requested** is a toggle that allows you to indicate whether a customer requested the switching sequence. The toggle is for informational purposes.

• **Customer Interrupted** is a toggle that allows you to indicate that a customer has been interrupted.

• **Customer Name** displays the name of the customer requesting the interruption.

• **Customer #** displays the telephone number of the customer requesting the interruption.

**Request Buttons**

The buttons on the bottom of the Request tab window comprise commonly used functions.

The Request tab displays the following buttons:

• The **Submit Request** button submits the request and sets the status of the request to Requested.

• The **Copy** button, when enabled, allows you to copy the currently loaded request into a new request. This button is only enabled when the currently loaded request is in a non-edit mode.

• The **Edit** button, when enabled, allows you to edit the currently loaded request. This button is only enabled when the currently loaded request is in a non-edit mode.
Managing Switching Plans

- The **Cancel Edit** button is used to cancel any changes that were made while the request was in edit mode. Upon selecting this button, a dialog will be issued to you asking you to confirm your action.

- The **Save** button, when enabled, allows you to save your changes to the database. This button is only enabled when the currently loaded request is in edit mode. If the request is saved prior to submitting it, then the request will be saved with a status of New.

- The **Exit** button closes the Web Request window.

Using the Request List Tab

The Request List tab contains a table listing all of the switching requests that are present. See Filter Menu on page 14-13 for the filtering options available on this table.

The Request List tab displays the following fields and buttons:

- The **Status** column contains the status of the switching plan. See Switching Plan States on page 14-2 for more information.

- The **Plan #** column contains the unique number associated with the switching plan.

- The **Feeder** column contains the feeder where the switching operation takes place.

- The **Start Date** column contains the date and time the switching plan is scheduled to begin.

- The **Alt Start Date** column contains the date and time the switching plan will begin if the plan cannot be scheduled for the original Start Date.

- The **Office** column contains the name of the office managing the switching work.

- The **Work Location** column contains the name or description of the area where the switching work is being performed.

- The **Substation** column contains the substation where the switching operation takes place.

- The **Device** column contains the device being worked on (not necessarily the device being switched).

- The **Voltage** column contains the highest voltage of the devices involved in the switching plan.

- The **Requested By** column contains the name of the individual or department that requested the switching plan.

- The **Requested Date** column contains the date on which the switching plan was requested.

- The **Cust Interrupt** column indicates whether or not customers will be interrupted by this switching plan.

- The **Customer Name** column contains the customer's name that requested the interruption.

- The **Completion Date** column contains the date and time at which the switching plan was completed.

- The **View** button populates the Request tab of the Web Request window with information from the selected switching request.

- The **Refresh** button refreshes the view to display any new or updated switching requests.

- The **Exit** button closes the Web Request window.
Planned Switching

Planned switching plans are created, studied, and approved prior to the switching operations taking place. Planned switching plans require information that is not needed for emergency switching plans, such as a start and end date.

Planned switching topics include:

• Creating a New Switching Plan Request
• Opening a Switching Plan
• Creating Switching Plan Steps
• Editing Switching Plans
• Finding and Replacing a Device
• Reviewing a Switching Plan in Study Mode
• Replaying Steps
• Viewing the Device Addresses
• Viewing Impacted Customers
• Emailing Switching Plan Data
• Focusing on a Device
• Using Viewing Areas
• Checking for Overlapping Switching Plans
• Implementing a Switching Plan
• Implementing a Switching Plan
• Working with Switching Plan Revisions

Creating a New Switching Plan Request

The following sections describe the ways in which a new switching plan request may be initiated.

Creating A New Request Via the Environment Manager

The request information for the switching operation should be completed before you add, review, and complete the switching steps. To create a new switching plan request, complete these steps:

1. Click the New Switching Plan button on the Environment Manager to open the Switch Sheet Editor. If the Switch Sheet Editor is already open, choose New from the File menu. A dialog box opens.
2. In the dialog box, select “Planned,” then click OK. The dialog box closes and a unique number appears in the Plan # field on the Switch Sheet Editor. The Request section is displayed.
3. Enter information in the appropriate fields. Required fields (labels are shaded in red) are Requested By and Phone Number.
4. Click on the Contact tab to view the contact section.
5. Enter information in the appropriate fields.
6. Click the Request tab to view the request section.
7. Click the Submit Request button.

Note: Someone other than the person who prepares the switching plan usually completes switching plan requests. The requestor may be someone in the
Managing Switching Plans

construction/maintenance department, while the preparer is an operations user assigned to look for and prepare new requests.

Creating A New Request Via the Web Request Form

To create a new switching plan request from the Web Request form, complete these steps:

1. Log into the Web Request form. For login help, see Logging On to Web Request on page 14-12.
2. Enter information in the appropriate fields. Required fields (labels are shaded in red) are Requested By and Phone Number.
3. Click on the Contact tab to view the contact section.
4. Enter information in the appropriate fields.
5. Click the Request tab to view the request section.
6. Click the Submit Request button.
7. After selecting the Submit Request button, a new job request number will be displayed in the Plan: text field on the Request section. The new request will also show up within your Request List after selecting the Refresh button.

Note: Someone other than the person who prepares the switching plan usually completes switching plan requests. The requestor may be someone in the construction/maintenance department, while the preparer is an operations user assigned to look for and prepare new requests.

Opening a Switching Plan

Depending on how a switching plan is being worked, there are a number of ways for you to load a switching plan. The following sections describe the different ways to open a switching plan:

From the Switch Sheet Editor (Plan # field)

• Within the Plan # field found on the Header section of the Switch Sheet Editor, enter in the switching plan number that you wish to load and hit Enter.

From the Switch Sheet Editor (Quick Load List)

• From the File pull-down menu, the last ten loaded switching plans will be listed at the bottom of the pull-down. Selecting any of these will load its associated plan. This list is reset each time you log in.

From the Work Agenda Switching Plan List

• Select a switching plan from the Switching Plan List. The appropriate filter and the Refresh button should be selected prior to looking for the switching plan in question.

• Select the Open Plan Request button to open the switching plans' Request section or select the Open Steps button to open the switching plans' Steps section. The Header section will always be displayed no matter which option is selected.

From the Work Agenda Safety Doc List

• Select a safety document that is associated with a switching plan. You will be able to determine this by an entry in the Plan # column.

• Select the Open Plan button to open the switching plans Header and Steps sections.
Managing Switching Plans

From the Safety Document
- Load a safety document that is associated to a switching plan. This can be determined by checking to see whether a switching plan number is displayed within the Plan # column of the Work Agenda Safety Doc List.
- From the safety document’s Action pull-down, select the Switching… button to open the switching plan’s Header and Steps sections.

From any of the Work Agenda Jobs Lists
- Select an event from one of the Jobs Lists that has a switching plan associated to it. This can be determined by checking to see whether a switching plan number is displayed within the Plan # column for the selected event.
- Select the Switching… button to open the switching plans Header and Steps sections.

From the Event Details
- If the Switching Plan # field on the Event Details display is not blank, then select the Switching… button to open the switching plan’s Header and Steps sections.

From the Crew List
- If a crew has been placed en route to a Master switching plan event, then select the crew from the list.
- Select the Switching… button to open the switching plan’s Header and Steps sections.

From the Crew Icons
- If a crew has been placed en route to a Master switching plan event, then select the crews’ icon on the display.
- Select the Switching… button to open the switching plan’s Header and Steps sections.

From the Control Tool
- From a Viewer, double click on a device that is involved in a switching plan. The Control Tool is displayed.
- Select the Switching Plan(s)… button. If only one switching plan is actively open on that device, then that plan will be loaded. If the device is involved in multiple active switching plans, then a list of plans and their Description of Work will be displayed. Select the switching plan you wish to load and then select the OK button.

From Web Request
- From the Request List form, select the request your wish to load. You may have to select the Refresh button before the request will show up within the list.
- Select the View button found at the bottom of the display.

Creating Switching Plan Steps
Sometime prior to issuing the switching plan, you can create the sequence of switching steps for the operation. Normally steps added prior to the switching plan having a status of “Prepared.” The Switch Sheet Editor and Viewer must be in the same mode to add steps.

Adding Steps to a Switching Plan
To add steps to a switching plan, complete these steps:
1. Open the switching plan you want to add steps to.
2. Click on the Steps tab to access the steps section.
3. From the Mode menu, verify that you are working in Study mode.

4. Add steps to the switching plan in one of the following ways:
   - If you want to add new blank steps, click the Add or Insert buttons to insert a blank step. The blank step can be used as a comment step that is not related to a specific device. You must enter text in the Description, Details, Instructed To or Additional Comments field. The other fields for the step are populated when you instruct and complete the step. Only one blank step can be present within the switching steps list. Once one of the four step entry fields have been filled out, then another blank step can be added.
   - If you want to use the Viewer window and Control tool to add steps, open a Viewer window and change it to study mode. Then toggle on the Record function on the Switch Sheet Editor. Perform the switching actions using the Viewer and the Control Tool. The switching actions are added to the switching plan.

5. Verify that the switching steps are correct.

6. Save the switching plan by selecting Save from the File menu.

Creating Go-Back Steps

When you are creating a switching plan in study mode, you can automatically generate a sequence of switching steps to “go-back” to a normal state. Go-back creates a new sequence of steps that reverses the existing sequence.

To create go-back steps for a range of existing steps, complete these steps:

1. Select the step or the range of steps you want to reverse.

2. Do one of the following:
   - Select Create Gobacks from the Actions menu. If the Goback Insertion Position dialog box displays, you must indicate whether you want to place the goback step(s) at the end of the list (Append) or insert the step(s) below the currently selected step(s) (Insert). Click the appropriate button.
   - If you want to create go-back steps for all existing steps, select Create Gobacks for All from the Actions menu. The go-back steps are added to the end of the steps list.

Adding Safety Document Transition Steps

You can add the issuance and release of safety documents as steps to a switching plan. In order to add these safety document transition steps, the proper safety document must be created and associated with a switching plan. To add a safety document transition step, complete these steps:

1. From the switching plan’s Steps list, select a step just above where you would like a safety state transition step added.

2. Double click on the desired document in the Safety Docs list found in the Header section of the switching plan. The Record Safety Dialog is displayed.

3. Click the Record Issue, Record Unissue, Record Release, or the Record Complete button to add the appropriate safety document step to the steps list.
   - Once the step is added to the steps list, instructing or executing the safety document transition step causes the safety document to display.
   - The Switch Sheet Editor will be locked from further input during the time that the safety document is displayed.

4. If the safety document is filled out properly, then select the appropriate state transition button on the safety document.
   - The safety document transitions to the state you selected.
Managing Switching Plans

- The safety document closes.
- The switching step you originally instructed or executed is completed within the steps section of the Switch Sheet Editor.

You can click the Exit button from the safety document to cancel the execution of the safety document transition step.

**Record Safety Dialog**

The following table describes the Record Safety dialog box buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Type] [Number]</td>
<td>Opens the safety document for viewing and editing.</td>
</tr>
<tr>
<td>Record Issue</td>
<td>Adds a step for issuing the selected safety document. The step is added after the currently selected step.</td>
</tr>
<tr>
<td>Record Unissue</td>
<td>Adds a step for releasing the selected safety document and allowing the devices associated to the safety document to be changed. The step is added after the currently selected step.</td>
</tr>
<tr>
<td>Record Release</td>
<td>Adds a step for releasing the selected safety document. The step is added after the currently selected step.</td>
</tr>
<tr>
<td>Record Complete</td>
<td>Adds a step for completing the selected safety document. The step is added after the currently selected step.</td>
</tr>
<tr>
<td>Disassociate</td>
<td>Removes the association of the selected safety document from the switching plan, deleting it from that switching plan's Safety Docs list. If the safety document has an active safety step within the steps list, then the document cannot be disassociated from the switching plan. If the user attempts to do this they will be issued an error message.</td>
</tr>
</tbody>
</table>

Note: This does not delete the safety document itself.

| Cancel         | Closes the dialog box.                                                                           |

**Editing Switching Plans**

You can open an existing switching plan from multiple locations. Certain fields on the switching plan are not editable after a plan has transitioned to a certain set of states.

**Editing a Switching Plan**

To edit a switching plan, complete these steps:

1. See Opening a Switching Plan on page 14-18 for options on loading a switching plan for editing.
2. Select the section you wish to edit by clicking on the appropriate tab button.
3. Edit the field(s).
4. Save the switching plan by selecting Save from the File menu.
Managing Switching Plans

Editing Switching Steps

You can rearrange, add, and delete switching steps using options in the Edit Steps menu in the Switch Sheet Editor window. To edit switching steps, complete these steps:

1. Open the switching plan.
2. Click on the Steps tab to access the steps section.
3. Edit steps as follows:
   - If you want to edit the description, click the cursor in the Description, Instructed Date, Instructed To, Completed Date, Additional Comments or Address field and change the text. This option is not available after the switching plan has been completed.
   - If you want to insert a step, place your cursor in the row where you want to insert the step and click the Insert button.
   - If you want to add a step, click the Add button to add a blank step to the end of the steps list.
   - If you want to delete a step, select the row for the step you want to delete and click the Delete button. This option is not available after a step has been instructed or completed.
   - If you want to rearrange steps, select the row for the step you want to move and click the up or down arrow button. You can only move steps that have not been instructed or executed.
   - You can also move steps by selecting the Cut option from the Edit Steps pull-down. Cutting steps will mark the steps as being cut. Only after the steps have been pasted will they be redlined and copied or moved to their new location based on the step that is selected when the Paste option is initiated. Pasted steps will be added after the currently selected step position.
   - Switching step cut, copy and paste operations can be made from one plan to another. The ability to cut, copy or paste is governed by the select ability of the options within the Edit Steps pull-down.
4. Verify that the switching steps are correct.
5. Save the switching plan by selecting Save from the File menu.

Finding and Replacing a Device

The Find or Replace Device dialog box allows you to find and replace all occurrences of a device in the switching steps. This is helpful for finding a device in a switching plan that has many steps or that was created from a formalized switching plan template. Formalized templates provide generic device names that you must replace with actual devices.

You can also use this function if you are reviewing a switching plan and find that the wrong device was entered in a number of places. To find and replace a device, complete these steps:

1. Open the switching plan in the Switch Sheet Editor.
2. Click on the Steps tab to access the steps section.
3. Select Find Device from the Edit Steps menu. A Find or Replace Device dialog box opens, allowing you to find and replace a device in the steps section.
4. Enter a valid device name in the Find field and click the Find Next button. The step row that contains the device is highlighted.
5. If you want to replace the device with another device, do one of the following:
   - Enter the new device name in the Replace field in the dialog box, or
   - Select the Replace field in the dialog box and then select a device from the Viewer.
The Phases column indicates which phases were selected for the current steps operation and allows you to select a new set of phases with the replacement device. When obtaining a device through a Viewer device selection, all the phases will be selected by default.

6. If the device you are replacing is used in a grounding operation, then after populating the Replace field:
   • Select the Grounding Object field and select the secondary device from the Viewer. You may also type in the grounding object device alias name.
   • Click the **Replace** or **Replace All** button.

### Reviewing a Switching Plan in Study Mode

You can review the actions of a switching plan in a Viewer window. With the Viewer and Switch Sheet Editor both in study mode, you can complete steps by selecting a step and clicking the **Complete** button at the bottom of the steps section. As the steps are completed, each one takes effect in the Viewer window and the word “Study Completed” appears in the Completed Date/Time column in the steps section. Steps are completed starting with the first step and continuing sequentially; however, it is possible to execute steps out of order if it is deemed reasonable to do so.

The **Look Ahead** window informs you of the results of the operation, including the creation of parallels and loops, the number of critical customers affected, and related abnormal devices and conditions.

### Replaying Steps

You can replay steps in the Viewer window, allowing you to experiment with and make changes to a switching plan. You can then add and delete switching steps and then select one of the two Reset Study Session options from the Actions menu in the Switch Sheet Editor window. After resetting your study session, you will be able to go through the steps again using the **Complete** button.

### Viewing the Device Addresses

You can view the physical address of all the devices used to record switching steps. To view the addresses for all the devices in the switching steps section, click the **Show Address Rows** button. A new row displays below each recorded step containing the address of the device in that step. Click the **Hide Address Rows** button to hide the address rows.

### Viewing Impacted Customers

If a switching plan is in “Prepared” or further status, then you can generate a list of all customers affected by the switching steps. The steps do not need to be completed to produce the list, but must simply be entered in the steps section.

This section displays the following topics:

- Displaying the Impacted Customers List
- Saving an Impacted Customers List
- Removing Customers
- Moving Customers
- Reloading an Impacted Customers List
Displaying the Impacted Customers List

Select Customers Impacted from the Tools menu in the Switch Sheet Editor window to view a list of impacted customers. The Customer Impacted List displays the following fields and buttons:

- The **Name** column contains the customer's name.
- The **Address** column contains the customer's address.
- The **City/State** column contains the customer's city and state.
- The **Zip** column contains the customer's zip code.
- The **Account** column contains the customer's account number.
- The **Group** column displays a value associated with a particular step within the Steps list. This column can then be used to filter out a list of customers pertaining to a particular step action.
- The **Cust ID** column displays the customer's ID number.
- The **Serv Loc ID** column displays the customer's service location ID number.
- The **Meter ID** column displays the customer's meter ID number.
- The **Filename** field allows you to enter a filename that will be used to store the list in a txt or xml formatted file.
- The **Publish** button allows you to save the list as a file that can be used in a mail merge application to generate notifications (e.g., letters, post cards, IVR calls) of planned outages.
- The **As** option menu allows you to specify the type of output file that should be published. Options are Text or XML.
- The **Save List** button allows you to save the complete list of customers to the database table IMPACTED_CUSTOMERS. The complete unfiltered list of customers will always be saved to the database table no matter what is actually shown in the list on the display. If a customer has been moved or removed from the list and not just filtered from the list, then they will not be included in the saved list.
- The **Regenerate List** button allows you to regenerate the list, which will bring back removed customers and will also regenerate the list based on switching step changes.
- The **Remove Selected** button allows you to delete the customer from the list of impacted customers. This deletes the selected customers from the list only. Customers are not deleted from the model.
- The **Move Customer** button allows you to move the customer from one device to another. This also removes the customer from the list if the new device is not also impacted by the current switching plan.
- The **Auto Filter** button allows you to filter the list of customers based on the value selected within the list. Only the customers with the selected value in that column will be shown in the list.
- The **Auto Filter Off** button is used to turn auto filtering off.
- The **Exit** button closes the Customers Impacted window.

Customers Impacted List Menu

- **File Menu**
  - **Print** - not implemented.
  - **Exit** - closes the Customers Impacted dialog.

- **Sort Menu**
  - **Ascending** - sorts the selected column in ascending order.
• **Descending** - sorts the selected column in descending order.
• **Dialog** - brings up the sorting dialog.
• **Default** - sorts on Name column in ascending order.

**File Menu**
• **Dialog** - brings up the filter dialog.
• **All** - no filter is applied. All customers are shown.
• **[Dynamic Filters]** - for each unique value that appears in the list Group column, there will be an additional filter added to the Filter pull-down.

**Actions Menu**
• **Save List** - saves the complete list of customers to the database table IMPACTED_CUSTOMERS. The complete unfiltered list of customers will always be saved to the database table no matter what is actually shown in the list on the display. If a customer has been moved or removed from the list and not just filtered from the list, then they will not be included in the saved list.
• **Regenerate List** - regenerates the list, which will bring back removed customers and will also regenerate the list based on switching step changes.
• **Publish** - saves the list as a file that can be used in a mail merge application to generate notifications (e.g., letters, post cards, IVR calls) of planned outages.
• **Remove Selected** - deletes the customer from the list of impacted customers. This deletes the selected customers from the list only. Customers are not deleted from the model.
• **Move Customer** - moves the customer from one device to another. This also removes the customer from the list if the new device is not also impacted by the current switching plan.
• **Auto Filter** - filters the list of customers based on the value selected within the list. Only the customers with the selected value in that column will be shown in the list.
• **Auto Filter Off** - turn auto filtering off.
• **Exit** - closes the Customers Impacted window.

**Saving an Impacted Customers List**

When you generate a list of impacted customers and select **Customers Impacted** from the Actions menu, a table opens displaying the customers' names, addresses, and account numbers. Click the **Publish** button and the desired output type to save the list as a text or xml file with a default or entered name and in a preset location. You can use this output file with third party mail merge software to produce notification mailings. The list of customers currently displayed in the dialog list is saved to the file.

Alternatively, the list can be saved to the database by clicking on the **Save List** button. All customers not moved or removed from the list will be saved to the database. Even if the list is being filtered, all the customers not moved or removed will be saved to the database list.

**Removing Customers**

You can remove customers from the Impacted Customers list by selecting the customer row and clicking the **Remove Selected** button. You can remove multiple customers at one time by selecting multiple rows. Removing a customer from the list will not remove the customer from the model. The next time the list is generated, the customer will again appear in the list.
Moving Customers

If you realize that a customer has been incorrectly associated with a device, you may need to move a customer from a device that will be impacted to a device that will not be impacted. To move customers from their current device to another device, complete these steps:

1. Select the row of the customer and click the Move Customer button. The Move Customer dialog box opens populated with the customer name and their current device.
2. Either type the name of the new device in the New Device field or click on the New Device text entry field and then the new device in the Viewer.
3. Click OK. The system verifies that the device is not also an impacted device.
   • If it is an impacted device, a dialog box opens asking if you want to continue the move.
   • If it is not an impacted device, the move automatically takes place and the customer is removed from the impacted customer list.

Note: You can only move one customer at a time.

Reloading an Impacted Customers List

You can reload a previously saved impacted customers list from the database when selecting the Customers Impacted option from the Tools pull-down on the Switch Sheet Editor. You can only reload a list from the database. This option does not apply to reloading a list from a flat file.

A dialog will be shown if a customer impacted list has been previously saved to the database for the switching plan you initiate the request from. The dialog gives you the option to reload the previously saved list or regenerate the list. Normally, you would regenerate the list if you made any switching step changes that might affect the number of customers being impacted.

• From a switching plan that has a previously generated and saved impacted customer list, select the Customers Impacted option from the Tools pull-down.
• Select the Load button to load the previously saved impacted customers list into the Customers Impacted dialog.
• Select the Regenerate button to regenerate the list based on the switching step actions recorded on the Steps pane. The regenerated list will be displayed in the Customers Impacted dialog.
• Select the Cancel button to cancel the operation.
• Upon exiting from a regenerated customers impacted list, you will be asked if you want to save the list to the database if you have not explicitly selected the Save List button prior to exiting from the Impacted Customers dialog.
• From the Customers Impacted dialog with a regenerated list of customers, select the Exit button. When the confirmation dialog appears, do one of the following:
  • Select the Yes button to save the newly generated list to the database.
  • Select the No button to retain the previously saved list in the database.
  • Select the Cancel button to cancel the exit action.

Emailing Switching Plan Data

At any time during the process of editing or viewing a switching plan, the plan’s data may be emailed to a single or multiple recipients. To email the data, select the E-Mail Plan… option from the Actions menu of the Switch Sheet Editor. The E-Mail dialog will appear.

The E-Mail dialog displays the following fields and buttons:
• The To field contains the list of email addresses that the plan should be sent to.
Managing Switching Plans

- The **Cc** field contains the list of additional addresses that the plan should be sent to.
- The **Subject** field contains the subject of the email.
- The email message text field contains additional information that will be sent to the recipients. Even if the email message is blank, the switching plan attachment will be sent to the recipients.
- The **Cancel** button allows you to cancel the email prior to sending it.
- The **Send** button will send the email as long as an address has been specified within the To field and a Subject has been given. If either or both of these are blank, the email will not be sent and an error message will appear within the blank section between the email message body and the button section of the dialog.

**Emailing a Switching Plan**

After selecting the **E-Mail Plan...** button from the Actions menu of the Switch Sheet Editor, a dialog will be presented to you. Within this dialog a standard set of email fields will be shown. Within the dialog, a value is required to be entered into the To and Subject fields. The switching plan data will not appear within the E-Mail dialog, but will be sent to the recipients as an HTML attachment. When the recipients receive the email, they will have to open the attachment in order to view the switching plan data.

**Focusing on a Device**

When reviewing a switching plan, you can focus on a device in the Viewer window to better understand the conditions present in the area of the device. To focus the Viewer window on the device in a switching step, select a step in the steps section and then select View Device from the Actions menu in the Switch Sheet Editor window. The Viewer loads the appropriate map and focuses on the device in the switching step. Another option after selecting the step is to select the target button on the Viewer. This will give you the same results as selecting the View Device button from the Switch Sheet Editor.

**Using Viewing Areas**

While creating a switching plan, you can view a device in a switching step in a Viewer window, save a viewing area, and view a saved area.

**Note:** These options only work with the VIEW1 Viewer on the first screen.

**Saving a Viewing Area**

When working with a switching plan, you may often need to return to the same area of the map. In order to save time, you can save areas of the map as a viewing area. To save a viewing area, complete these steps:

- In the Viewer window, navigate to the area of the map that you want to save as a viewing area. If it is also being used, the camera view for a Viewer is also saved.
- In the Switch Sheet Editor window, select Save Area from the Actions menu. The View Area button becomes enabled.

**Note:** You can only save one viewing area per switching plan.

**Loading a Saved Viewing Area**

After a viewing area has been created for a switching plan, you can quickly load the viewing area into the Viewer window. To load a saved viewing area, select the View Area option from the Actions menu in the Switch Sheet Editor. The saved viewing area displays in the Viewer.
Checking for Overlapping Switching Plans

You can crosscheck switching plans for overlap of affected devices during the same time period. This allows planners to create a single planned event instead of two separate events to avoid visiting the same location twice or impacting the same customers twice. Planners can identify whether to change the current switching plan in order to avoid affecting the same customers or same area multiple times in a certain time period.

Using the Switching Overlaps Window

Once you have created steps for a planned event and saved the switching plan, you can crosscheck the plan using the Switching Overlaps window. Open the Switching Overlaps window by selecting the Switching Overlaps option from the Switch Sheet Editor Tools menu. The Switching Overlaps window displays information about the overlapping plans including switching plan number, start date, end date, control zone overlaps, and device overlaps.

Note: When an overlap occurs, the system does not prevent you from completing planned switching operations, but it does provide a warning indicating the overlap.

The Switching Overlap window displays the following fields and buttons:

- The header area of the Switching Overlaps window provides (view only) information about the switching plan, including the switch plan number, start date, and end date.
- The Plan # column contains the identification number of the overlapping switching plan.
- The Start Date column contains the date that the overlapping switching plan begins.
- The End Date column contains the date that the overlapping switching plan ends.
- The Control Zone Overlaps column indicates whether there is a control zone overlap. Control zone overlaps are overlaps that affect the same control zone but do not affect the same device. This warns the user that there may be overlapping work that could be combined or could not be done at the same time.
- The Device Overlap column indicates whether the same device is operated on more than one switching plan.

Buttons

- The Open Switching Plan button opens the overlapping switching plan in the Switch Sheet Editor window for the selected switching plan.
- The Cancel button closes the Switching Overlaps window.

Viewing an Overlapping Switching Plan

If the Control Zone Overlaps or Device Overlaps columns indicate that an overlap exists, you can quickly view the switching plan that contains the overlaps.

To view an overlapping switching plan, complete these steps:

1. Open the Switching Overlaps window by clicking the Switching Overlaps option from the Switch Sheet Editor Tools menu.
2. Select the row for an overlapping plan.
3. Click the Open Switching Plan button to open the overlapping switching plan in the Switch Sheet Editor window.
Implementing a Switching Plan

Once you have created, studied, and approved a switching plan, you can then instruct and complete the switching plan. To complete a switching plan, the Switch Sheet Editor must be in real-time mode. Although a Viewer window does not need to be open to complete switching steps, you can view the steps in a Viewer window. The Viewer must be in real-time mode as well.

You can complete steps in study mode, but these “completions” do not affect the real-time data.

For steps involving device operations, you must have authority over the zone where switching operations will take place or the system will not allow you to complete the switching steps.

Scheduling a Planned Event

In order to schedule planned switching, you must have entries within the Start Date and Finish Date (ERT) fields on the Request section of the switching plan. An optional device alias can also be specified within the Device field on this same section. Specifying a device will cause the planned Master event to conform to the regular zone authority rules. If you do not have authority over the zone that device resides in, then you will not see the planned Master event that will be created when the switching plan is scheduled.

To schedule a planned Master event, complete these steps:

1. Fill in future dates and times within the Start Date and Finish Date (ERT) entry fields.
2. If you would like to have the plan associated to a particular device and control zone, then select the device within the Viewer. Make sure the Switch Sheet Editor and the Viewer are in the same mode. If a device is not specified, then the Master event will fall into the FUZZY control zone.
3. From the Tracking section, make sure the Prepared and Checked approvals have been made.
4. Select the Scheduled checkbox.

At this point, a new planned Master event has been created and associated to the switching plan. This new event will show up in the Events list as a Master event.

Selecting the event within the Events list will cause the Work Agenda Jobs List to focus on that event as long as it is found within the currently displayed list (e.g., Work Agenda All List). From the Work Agenda Jobs List, you can bring up the Event Details for that event. The Event Details display is different for planned events than for spontaneous outage events. For instance, you cannot update the ERT for a planned event from Event Details. That has to be done from the associated switching plan.

Updating the ERT

To update the ERT for the planned event from Event Details, complete these steps:

- Select the Switching… button followed by the Exit button found at the bottom of the display. The associated switching plan will be loaded and the steps displayed.
- Select the Request tab and enter in a new Finish Date (ERT) date and time.
- Select the Update ERT button found next to the date and time entry fields. The Est Restore Time (ERT) will be changed for the associated Master event within the Work Agenda Jobs List. The new date will also show up in Event Details the next time it is loaded for that event.

Instructing and Completing Switching Steps

In order to begin instructing a switching plan, it has to be Issued first. The Instruct and Complete buttons, at the bottom of the Switch Sheet Editor, become enabled in real-time when the plan reaches the Issued state. Sometime around the time of the switching plan being issued, crews should be assigned to the planned Master event. This will cause the crews to show up on the...
Switching Crew List within the Header section of the Switch Sheet Editor. The plan is now ready for the crews to execute its steps.

To instruct and complete a step, do the following:

1. Verify that the Switch Sheet Editor and the Viewer are in real-time mode.
2. Verify that the Issued checkbox has been selected within the tracking section of the Switch Sheet Editor window.
3. Select the crew from the Switching Crew List that should receive the first instruction.
4. In the steps section of the Switch Sheet Editor window, select the first step. The Instructed To column for that step will be automatically populated with the selected crew's Contact information.
5. When you give the instruction to the crew performing the operation, click the Instruct button.
6. If the step involves a device operation, the Look Ahead window opens. Click Open or Close in the Look Ahead window to continue with the step. The status of the step changes to "Instructed," the Instructed By and Instructed Date columns are populated and an "Instructed" flag will display on the device in the Viewer.
7. If the step involves issuing a safety document to a crew, then the value in that steps Instructed To field will be copied to the safety document Crew Name field when the step is instructed or completed.
8. After the crew reports that the step is complete, select the step and click the Complete button. The Completed Date column is populated, the "Instructed" flag is removed and the device status is updated in the Viewer window. If customers are impacted, then a new planned outage event will be placed upon the device as well. This event will also show up within the Events list on the Switch Sheet Editor.
9. Select the next switching step and repeat this process all the way through to the last step.
10. After all steps are complete, click on the Tracking button to access the tracking section.
11. Load each of the associated safety documents and transition them to the Completed state. Switching Management requires that all safety documents be completed prior to allowing the switching plan to be completed.
12. Select the Completed By checkbox. A message box opens asking, “Complete this Switch Job?” Click Yes to complete the switching plan. The request to complete the switching plan will fail and an error dialog will be displayed if any associated event has not been restored or if any safety document has not been completed.
13. At this time any planned outage events will be completed along with the planned master event. Any crews assigned or en route to the events will be released as well.

Once all the steps in a switching plan are complete, the plan itself is considered complete. Selecting the Completed By checkbox in the tracking section “locks” the switching plan and no further operations may take place for the switching plan. Selecting the Completed By checkbox should be the very last action you perform in a switching plan.

**Working with Switching Plan Revisions**

Switching plans use a revision control mechanism in order to keep operators and crews consistent with regards to which switching plan they are viewing. The switching plan as a whole has a revision number that can be incremented manually. The revision will also be incremented automatically when new steps are recorded in the plan after a revision is locked down. A switching plan's revision is locked down when the Revision Status indicator displays [X] and after the plan has been issued.
Steps also have revision numbers associated to them. The step revision number is just a copy of the switching plan's revision number when the step was added. Once a plan is issued and the revision is locked down or the revision number is manually incremented, then any steps added after the revision change/lock-down are shaded green.

When you attempt to delete a step when the switching plan revision is locked down or when the step has an older revision number than the switching plan, then the step is shaded red and will not be removed. Green steps can be removed until the switching plan revision has been locked down. This can either be done manually by selecting the Revision Status indicator or by simply executing a step in real-time mode.

If a locked-down step is moved, then the original step is redlined, marked as deleted, and a new duplicate step is created. The new step is then shaded green and takes on the revision number of the switching plan. This step can then be freely moved up or down within the steps list.

Adding steps to an already locked down switching plan automatically causes the revision of the plan to be incremented. The newly added steps are then associated to this new revision number.

**Emergency Switching**

Emergency Switching includes any unplanned switching operations that occur due to events during storms, equipment failures, or even planned switching actions that fail or are incorrect. Unlike in planned switching, where the switching plan is created and studied before it is issued, in emergency switching the switching plan is created as the operations take place in real-time mode. Essentially, a switching plan is created and implemented simultaneously. Steps are recorded in the steps section of the switching plan as the Control Tool actions are being performed, and each step is considered complete as it is being recorded.

Emergency switching operates just like planned switching except the Switch Sheet Editor and Viewer must be in real-time mode. Whenever switching steps are recorded in a switching plan using the real-time Control Tool, the operation is considered emergency switching. The switching plan provides a record of the switching operation.

The request section of the a switching plan is not required when performing emergency switching, since the switching plan is created at that moment and not in response to a standing request.

**Recording Emergency Switching Operations**

To record emergency switching operations, complete these steps:

1. Click the **New Switching Plan** button on the Environment Manager. A dialog box opens.
2. Select Emergency, then click **OK**.
   - A new switching plan is created.
   - The steps section displays.
   - The Record function turns on.
3. If the VIEW1 Viewer is displayed, then it will transition to the same mode that the Switch Sheet Editor is in. In this case it will go into the real-time mode.
4. You can now create and complete switching steps by selecting devices in the Viewer window and using the Control Tool. As each step is instructed and completed, the Instructed and Completed Date/Time field is populated with the date and time value shown on the Control Tool. Any crew ID selected and date/time specified from the Control Tool will also be used to populate the Instructed To and Instructed/Completed Date fields of the switching step when it is recorded. Any outages created by completing steps from the Control Tool or from Switching Management will be classified as Real Outages and not Planned Outages.
You can also access emergency switching using the **Switching...** button at the bottom of the Event Details window. When you click this button, a new switching plan opens automatically displaying the event number in the Events list.

**Event Associations**

Event associations are used to associate events to switching plans. Associated events are displayed in the Events list, which is found in the Header section of the Switch Sheet Editor. Event associations do not occur when the event causing the action is recorded into the Miscellaneous Log. Events can be associated to switching plans in two ways:

- **Hard associations** are automatic associations that are normally made as you perform actions within the Switch Sheet Editor or perform actions from the Control Tool that are recorded into the switching plan. An event can only have one hard association to a switching plan. Hard associations cannot be broken once the association has been established.

- **Soft associations** are associations that are normally added manually through the Event Association dialog. An event can be softly associated to an unlimited number of switching plans. This type of association can be manually removed at any time.

Hard associations can also be further classified by type. There are four types of hard association relation types:

- **Master** is the relationship type made between a Planned switching plan and its active master switching job. There can only be one Master event associated to any single switching plan.

- **Canceled** is the relationship type made between a Planned switching plan and a canceled master switching job. There can be any number of Canceled event associations to a single switching plan. These Canceled events were originally classified as Master events for the plan.

- **Planned** is the relationship type made between a Planned switching plan and a planned outage. A planned outage is an outage that was generated from a planned switching plan after the completion of an action recorded in the Steps section of the plan.

- **Forced** is the relationship type made between an Emergency switching plan and an unplanned outage or non-outage event. A Forced relationship will be made when recording real-time actions into an Emergency switching plan. The relationship can also be made when creating an Emergency plan for an event from the Work Agenda Jobs List or the Event Details display.

Soft associations only have one classification type:

- **Manual** is the relationship type made between a switching plan and a manually associated event. Manual associations are also made between plans if an outage is hard-associated to one plan and the outage is restored with another switching plan. The plan that recorded the restoration step will have the event automatically associated to it with a classification type of Manual. Grouped events can also cause switching plans to be manually associated. Partially restoring an outage or adding customers to an outage will create a manual association between the switching sheet and the job if no association (hard or soft) already exists.

**Grouping Event Associations**

When resolving outages in the network, it is common for events to be grouped together. When events are grouped, the associations will adhere to the following set of rules:

- If an event with no hard association consumes an event with no hard association, then the resulting event will have no hard association and its manual associations will be a combined list of both events’ manual associations.

- If an event with a hard association consumes an event with no hard association, then the resulting event will have the surviving event’s hard association and a combined list of both events’ manual associations.
• If an event with no hard association consumes an event with a hard association, then the resulting event will have the consumed event's hard association and a combined list of both events' manual associations.

• If an event with a hard association consumes an event with a hard association, then the resulting event will have the surviving event's hard association and the consumed event's hard association will be listed as a manual association along with the combined list of both events' manual associations.

• If an event consumes another event with an association to the same switching plan, then the above rules will apply, but the plan will only be listed once in the event's association list. An event can only have one association to a specific switching plan.

Working with Switching Templates

Switching templates help you create switching plans when working with frequently performed switching sequences. You create switching templates in the Template Editor mode of the switching management display. Although templates look like standard switching plans, they are used for creating and saving “pre-built” step sequences.

Opening the Switching Templates List

The Switching Template list in the Work Agenda window contains a list of available switching templates. You can access the Switching Templates list in the following two ways:

• In the Work Agenda window, select Switching Templates List from the File menu.
• In the Switch Sheet Editor window, select Template List from the Tools menu.

Creating a Switching Template

Switching Templates can be created from the Switch Sheet Editor by following one of these sets of steps:

Option 1:
1. Load or create a switching plan within the Switch Sheet Editor.
2. Click on the Save as Template option from the File menu. A dialog opens asking you if you want to formalize the devices or not.
3. Click OK to save the sequence of steps with generic device names (e.g., OPEN device_0). This allows you to apply the exact steps to another relevant set of devices.
4. When you choose to formalize devices, you must use the Find/Replace Device dialog box to replace the generic device name with an actual device name. You cannot just edit the Description column of the switching step and type in a new device alias.
5. Click No to save the sequence of steps with the actual device names (e.g., OPEN TO_JO-12459).

Option 2:
1. Load or create a switching plan within the Switch Sheet Editor.
2. Select the Copy option from the File menu.
3. From the Sheet Type popup dialog, select Template.

Option 3:
• From the Switch Sheet Editor, select New and then Template from the File menu.

After a switching template has been created, you can turn the Record function on in Study mode and record any additional steps into the template.


Managing Switching Plans

**Editing a Switching Template**

You can edit templates in the Switch Template Editor, which is much like the Switch Sheet Editor, but only the Request and Steps sections are available for selection. Also, only the Description of Work field is editable on the Request section. Only switching templates may be loaded and altered within Study mode. It is not possible to record or execute steps from a template in real-time.

To edit a switching template, complete these steps:

1. In the Work Agenda window, select **Switching Templates List** from the File menu.
2. Select the template from the list and click the **Open Steps** button.
3. Edit information in the switching template as necessary.
4. Save the switching template by selecting **Save** from the **File** menu.

**Copying Steps from a Template**

A template is used to copy switching steps contained in a template to a standard switching plan. The steps section is the only section that will be copied. To copy steps from a template into a switching plan, complete these steps:

- From the Work Agenda Switching Templates list,
  1. Open the **Switching Templates List** in the Work Agenda window.
  2. Create a new switching plan of the Planned type or load an existing switching plan.
  3. Highlight the row for the desired template within the Switching Templates List.
  4. Click the **Append Steps** button on Switching Templates List. The template steps are copied into the switching plan and are appended to the end of the list.

  **Note:** You can repeat this process to insert steps from multiple templates into the same switching plan.

- Or, from the Template Editor,
  1. If a template is open in the Switch Template Editor, choose **Copy** from the **File** menu. The Sheet Type popup dialog opens.
  2. Select the type of switching plan you wish the steps to be copied into. A new switching plan is created with a new plan number and the same steps.

**Using the Miscellaneous Log**

The Miscellaneous Log automatically records all real-time switching actions that are not recorded in another switching plan. The miscellaneous log does not need to be open for steps to be recorded; the system automatically detects when a step is performed that is not going to be recorded in any other switching plan. You can use the switching log as an alternative to emergency switching by recording switching steps without having to separate steps into different plans.

The system creates the log when you log in, and automatically saves the log when you log out. A log is created for each login session with a log number, date and time, and the user name for the user who is logged in.

**Accessing the Miscellaneous Log**

You can access Miscellaneous Logs in two ways:

- In the Work Agenda window, select the Misc List option from the File menu. From the Actions menu, select the Refresh option. Then select a miscellaneous log and click the **Open Misc Log** button.
• In the Switch Sheet Editor window, select Misc Log from the Mode menu. Enter the number of an existing log in the No field on the Miscellaneous Log window.

Miscellaneous switching logs have some of the same switching step features as the standard Switch Sheet Editor. You can edit, issue, and complete steps just as you would in a regular switching plan. It is also possible to cut steps from the Miscellaneous Log and paste them into another switching plan. This can be done through the standard Cut, Copy and Paste options found under the Edit Steps menu.

Viewing Switching Lists

The Work Agenda window allows you to view lists that contain switching information. The lists allow you to view various information including miscellaneous logs, switching plans, switching templates, and safety documents.

The lists that are important to performing switching operations include the following:

• Switching Plan List
• Switching Templates List
• Misc List

Switching Plan List

The Switching Plan List in the Work Agenda window displays a set of switching plans based on the selected filter and sort criteria. The Switching Plan List displays the following fields and buttons:

• The Status column contains the status of the switching plan. See Switching Plan States on page 14-2 for more information.
• The Type column contains the type of switching plan: Planned (Plan) or Emergency (Emer).
• The Plan # column contains the unique number associated with the switching plan.
• The Feeder column contains the feeder where the switching operation takes place.
• The Start Date column contains the date and time the switching plan is scheduled to begin.
• The Alt Start Date column contains the date and time the switching plan can begin if the plan cannot be scheduled for the original Start Date.
• The Office column contains the name of the office managing the switching work.
• The Work Location column contains the name or description of the area where the switching work is being performed.
• The Substation column contains the substation where the switching operation takes place.
• The Device column contains the device being worked on (not necessarily the device being switched).
• The Voltage column contains the highest voltage of the devices involved in the switching plan.
• The Requested By column contains the name of the individual or department that requested the switching plan.
• The Requested Date column contains the date on which the switching plan was requested.
• The Associated Events column contains the event numbers associated with the switching plan.
• The Cust Interrupt column indicates whether or not customers will be interrupted by this switching plan.
Managing Switching Plans

- The **Customer Name** column contains the customer's name that requested the interruption.
- The **Completion Date** column contains the date and time at which the switching plan was completed.
- The **Steps** column contains the number of steps the switching plan contains.
- The **Open Plan Request** button opens the selected switching plan into the Switch Sheet Editor and displays the Request section.
- The **Open Steps** button opens the selected switching plan into the Switch Sheet Editor and displays the Steps section.
- The **Refresh** button refreshes the view to display any new or updated switching plans. This button turns red when you make any state changes to any of the switching plans listed in this list. This button will not turn red when other users make changes. This is only relevant to your current session.
- The **Exit** button closes the Switching Plan List.

Filtering the Switching Plan List

The following table describes the Filter menu options of the Switching Plan List.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Displays switching plans that are the Plan (Planned) type and have a status of Inp (In Progress), Sch (Scheduled) or Iss (Issued).</td>
</tr>
<tr>
<td>In Progress</td>
<td>Displays switching plans that have an Inp (In Progress) status.</td>
</tr>
<tr>
<td>Completed</td>
<td>Displays switching plans that have a Comp (Completed) status.</td>
</tr>
<tr>
<td>New Work</td>
<td>Displays switching plans that are of the Plan (Planned) type and have a status of New, Req (Requested), Pre (Prepared), Che (Checked), App (Approved), or Sch (Scheduled).</td>
</tr>
<tr>
<td>Active</td>
<td>Displays switching plans that have a status of New, Inp (In Progress), Pre (Prepared), Sch (Scheduled), Req (Requested), Iss (Issued), App (Approved), Che (Checked), CRej (Check Rejected), or Hold.</td>
</tr>
<tr>
<td>All</td>
<td>Displays switching plans that have a status of New, Inp (In Progress), Pre (Prepared), Sch (Scheduled), Req (Requested), Iss (Issued), App (Approved), Che (Checked), RRej (Request Rejected), CRej (Check Rejected), Completed, or Hold.</td>
</tr>
</tbody>
</table>

Switching Templates List

The Switching Templates List in the Work Agenda window displays a list of existing switching templates. Switching templates are created using the Switch Template Editor. You can use the Switching Templates List to locate a switching template and incorporate the steps from the template into a new switching plan. This list is not initially populated when it is displayed for the first time. The Refresh button will need to be selected to initially populate the list.

The Switching Templates List displays the following fields and buttons:

- The **Template #** column contains the unique number associated with the switching plan template.
- The **Steps** column contains the number of steps the switching plan template contains.
- The **Description** column contains the description of the switching plan template that was entered into the Description of Work field on the Switch Template Editor.
• The **Open Steps** button opens the Switch Template Editor, which allows you to view and edit the switching plan template.

• The **Append Steps** button appends the steps of the selected switching template into an open switching plan. This button appends the steps to the end of the steps list in the Switch Sheet Editor.

• The **Refresh** button is used to initially populate the list and can be subsequently used to refresh the view to display any new templates.

• The **Exit** button exits the Switching Templates List.

**Misc List**

The Misc List displays a list of all of the miscellaneous switching logs recorded in the system. Access this list by selecting Misc List from the File menu on the Work Agenda window. By default only logs with one or more steps will be listed. All the logs can be displayed by selecting the All option from the Filter menu. This list is not initially populated when it is displayed for the first time. The Refresh button will need to be selected to initially populate the list.

The Misc List displays the following fields and buttons:

• The **Log #** column displays the number of the miscellaneous switching log.

• The **Operator** column displays the user name of the person who created the miscellaneous switching log.

• The **Start Date** displays the date and time the miscellaneous switching log was created.

• The **Steps** column contains the number of steps the miscellaneous log contains.

• The **Open Misc Log** button opens the Switch Miscellaneous Log window, which displays the log.

• The **Refresh** button is used to initially populate the list and can be subsequently used to refresh the view to display any new miscellaneous switching logs.

• The **Exit** button exits the Misc List.
Maintaining Safety Documents

Safety Documents in the Oracle Utilities Network Management System are an electronic representation of the paper safety documents used for switching operations. Safety documents provide information about a particular operation and record the issuance and release of tags on devices. For switching operations, safety flags are first physically placed on devices, and then the safety document is issued. This effectively gives the crew permission to begin work. When the work is completed, the safety document is released, warning the crew that they must stay clear. Once the safety document is released, safety flags may be removed from the devices and the switches may then be closed.

Safety documents are a component of Oracle Utilities Network Management System - Switching Management. You can associate safety documents to switching plans and you can print a hard copy of a safety document for your records.

This section includes the following topics:

• Understanding Safety Documents
• Creating and Editing Safety Documents
• Associating Safety Documents with Switching Plans
• Searching for Safety Documents
• Viewing the Safety Document List

Understanding Safety Documents

A utility often has pre-defined safety documents established in their safety policy. While utilities often have specific names for these safety documents, Oracle Utilities Network Management System Switching Management has five types of safety documents that a utility can use to represent their established safety documents. This section describes five common safety document types:

• Clearance - indicates that clearance for work on a device or in an area has been obtained from the proper authority.
• Hold - indicates that the tagged device(s) should not be operated (e.g., if the device is open, it should remain open).
• Hot Line - indicates that hot line work is being performed, and if the tagged device(s) is opened, it should not be closed again until the safety document is released.
• Information Note - provides some pertinent information about the tagged device(s).
• Warning Tag - is like an Information Note and provides some pertinent information about the tagged device(s).

While safety document names and features may vary, understanding these five types will help you understand the general use of most safety documents. Crews typically “own” safety documents and must authorize their release when they are finished working in an area or on a device.

Clearance Safety Documents

Clearance safety documents indicate that clearance for work has been obtained from the proper authority. The proper authority might be a control center supervisor or a regional dispatcher. Clearance documents imply that the device or area that requires work has been made safe to work on or in.

Hold Safety Documents

Hold safety documents are used when the device is to be “held open” or “held closed” in order to complete work in an area of the distribution system. The purpose of the Hold safety document is
Maintaining Safety Documents

Switching Management

To protect crew members and prevent injury to human life. Hold safety documents are placed and removed by individuals who have authority over a specific area or operation and serve to restrict the operation of a device.

Hot Line Safety Documents

Hot Line safety documents indicate that a crew is performing hot line work in the area (e.g., live wires). When Hot Line safety documents are present, device operations in the area should be performed with caution.

Information Note Safety Documents

Information Note safety documents are for informational purposes only. These safety documents do not restrict operation of the device, but provide information that a crew member or utility employee should be aware of when working on the device(s).

Warning Tag Safety Documents

Like Information Note safety documents, Warning Tags are for informational purposes only. These safety documents do not restrict operation of the device(s) and provide information that a crew member or utility employee should be aware of when working on the tagged device(s).

Creating and Editing Safety Documents

The Safety Document window allows you to create and edit safety documents. This window also allows you to associate safety documents with switching plans. The menu options, fields, and buttons are the same for all safety documents except for the Information Note and Warning Tag Safety Documents. These documents do not have the Ground Locations or Feeder fields.

This section includes the following topics:

• Preparing New Safety Documents
• Opening an Existing Safety Document
• Editing the Device List
• Copying Safety Documents
• Saving Safety Documents
• Issuing Safety Documents
• Releasing Safety Documents
• Associating Safety Documents with Switching Plans
• Disassociating a Safety Document
• Searching for Safety Documents
• Viewing the Safety Document List

Preparing New Safety Documents

You can prepare new safety documents in two ways:

• In an open safety document, select New from the File menu. The Create New Document dialog box opens. To open a blank safety document, double click the document type or single click the document type and click OK.

• In the Switch Sheet Editor window, select Create New Safety from the Tools menu. A submenu appears allowing you to select the document type. When you create a new safety document from a switching plan, the device list will be automatically populated with a list of devices that were used to build the switching steps in the switching plan. Typically, not all
devices are required in the safety document, but it is easy to delete the unneeded devices. All fields remain editable.

- See Safety Document Window on page 14-40 for field descriptions.

Opening an Existing Safety Document

You can open existing safety documents from multiple windows.

- From the Safety Document window:
  - Select Open from the File menu. A dialog box opens listing the safety document types.
  - In the Document Types list, select a document type.
  - In the Existing Document Number field, enter the number of an existing safety document.
  - Click OK.

- From the Work Agenda window:
  - Select Safety Doc List from the File menu.
  - From the list, select the safety document that you wish to open and click the Open button. It may be necessary to select the Refresh button in order to see the latest list of safety documents.

- From the Switch Sheet Editor:
  - If a safety document is associated with the switching plan, double-click on the safety document number in the header section.
  - From the Record Safety dialog, select the top button, which will have the safety document type and number on it.

- From the Control Tool:
  - For active safety documents, double click on a device within the Viewer window.
  - From the Control Tool, select the Safety Document(s)… button.
  - If multiple safety documents are currently active on this device, then a list will be displayed. You then have the option to select which safety document you want to load. If only a single safety document is active on this device, then the safety document will display.

See the next section for more information about the Safety Documents window.

Safety Document Window

The Safety Document window displays the following fields and buttons:

- The [Safety Document Type] # field indicates the type of safety document and lists the safety document number. This field is color-coded based on the safety document type.
- Devices and Phases display the device(s) and their phases that the safety document is associated with. A safety document must include at least one device or have an entry in the Other Equipment field.
- Other Equipment is a text field that allows you to enter any additional equipment (not included in the model) that the safety document applies to. An entry in this field or the Devices field is required.
- Description is a text field that allows you to enter notes for the safety document.
- Ground Locations is a text field that allows you to enter a list of grounding locations.
- Feeder is a text field that allows you to enter in a feeder name.
• **Name** displays the name of the crew that is responsible for the safety document. This field is required when issuing a safety document. This field is also auto-populated from Switching Management when a safety state transition switching step is initiated. The value within the switching step's Instructed To field will be populated into this field.

• **Phone** displays the telephone number for the crew responsible for the safety document.

• **ID** displays the Identification name or number for the crew.

• **Pager** displays the pager number for the crew.

• **Audit Log** lists the date and time of each state change. It also lists the user name for the person that caused the state change and which crew was being issued or released during the change.

**Buttons**

• The **Record On/Off** button ([X], [X]) allows you to toggle the record function on and off. When the record function is on, you can select devices in the Viewer to add to the safety document device list.

• The **Add Device** button opens a dialog box, which allows you to manually enter a device to add to the device list for the safety document. Only modeled devices may be entered and added to the device list.

• The **Delete Device** button deletes the selected device(s) from the device list.

• The **Change Phases** button opens a dialog box, which allows you to change the phases recorded with the device alias.

• The **Issue** button issues the safety document. A safety document symbol displays next to the device(s) in the Viewer window.

• The **Unissue** button undoes the Issuing of the safety document. This action will be logged and should be used as a means of altering the device list within the safety document. This allows the area the safety document encompasses to be altered after the document has been issued.

• The **Release** button releases the safety document. The safety document symbol is removed from the device(s) in the Viewer window.

• The **Complete** button completes the safety document and locks the document from further editing.

• The **Copy** button creates a new safety document and copies the contents of the currently opened safety document into the newly created document. The Audit Log is not copied.

• The **Delete** button sets the state of the document to Deleted. This option is only available prior to the document being issued for the first time.

• The **Exit** button closes the Safety Document window.

**Safety Document Window Menus**

The following table describes the menus of the Safety Document window.

**File Menu**

• **New** - Opens the Create New Document dialog box, allowing you to select which type of safety document you would like to create.

• **Open** - Opens an existing safety document. A dialog box opens, allowing you to select the type of safety document and enter the safety document number.

• **Save** - Saves the safety document.

• **Copy** - Creates a new safety document and copies the contents of the currently opened safety document into the newly created document. The Audit Log is not copied.
• **Find…** - Opens a Find Safety Document dialog. The dialog can be used to search for safety documents based on their type and/or number.

• **Print** - Opens the Print dialog box, allowing you to print a snapshot or a PostScript version of the safety document to a printer.

• **Exit** - Closes the Safety Document window.

**Action Menu**

• **Record** - Toggles the record function on, which allows you to select devices in the Viewer to add to the safety document device list.

• **Issue** - Issues the safety document. A safety document symbol appears next to the device(s) in the Viewer.

• **Unissue** - Undoes the Issuing of the safety document. This action will be logged and should be used as a means of altering the device list within the safety document. This allows the area the safety document encompasses to be altered after the document has been issued.

• **Release** - Releases the safety document and removes the safety document symbols from the device(s) in the Viewer.

• **Complete** - Completes the safety document and locks the document from further editing.

• **Delete** - Sets the state of the document to Deleted. This option is only available prior to the document being issued for the first time.

• **Associate** - Associates the safety document with a switching plan.

• **Disassociate** - Disassociates the safety document from the switching plan.

• **Switching…** - Selecting this button will load the associated switching plan.

**Mode:**

• **Real Time** - Changes to real-time mode, which applies the safety document symbols to the devices in real-time mode.

• **Study** - Changes to study mode, which applies the safety document symbols to the devices in study mode.

• **View Only** - Changes the window to view only mode. You cannot edit a safety document while it is in the view only mode. This option will be auto selected when the Safety Document is locked and being edited by another user. A dialog will be issued to you indicating that another user is editing the document. If the Safety Document is loaded from a view only switching plan, then this option will be auto-selected again.

**Editing the Device List**

You can add or delete devices from the safety document device list in two ways:

• Click the **Add Device** button on the safety document and enter the appropriate device identification. To delete a device from the device list, select the device and click the **Delete Device** button.

• With “Record” toggled on in the safety document, select a device in the Viewer window. If the Viewer and Safety Document are both in the same mode (real-time or study), the device is added to the device list. Clicking the device again, from the Viewer, deletes it from the device list.

You can alter the devices’ recorded phases as well.
• Click the **Change Phases** button on the safety document. A dialog will be presented to you allowing you to select a new set of phases. Only valid phases for the device shown will be selectable.

### Copying Safety Documents
You can copy safety documents by clicking the **Copy** button on the safety document itself, or by selecting the safety document in the Work Agenda Safety Documents list and clicking the **Copy** button. Copying creates a new safety document of the same type and same device list, with a new document number. All of the text fields are copied as well, except for the Audit Log, which is cleared.

### Saving Safety Documents
You can save a safety document by choosing Save from the File menu. When you close a document after making changes, the system prompts you to save. Certain fields, such as the Devices list or the Other Equipment field, are required in order to save.

### Issuing Safety Documents
To issue a safety document, the document must be open and all required fields must be completed. Each device affected by the safety document requires a Safety Flag (SF) placed upon it prior to the safety document being issued. A Safety Flag is a flag that is placed upon the device from the Control Tool. Click the **Place Safety Flag** button from the **Control Tool Tag / Flag** option menu.

Alternatively, safety documents are issued when switching steps that involve safety documents are instructed or completed. Once a safety document is issued, you cannot complete, delete, or reissue the safety document. The Description and Ground Locations text fields remain editable. The only button options available are Unissue and Release. A symbol appears on all devices in the Viewer that are specified in the safety document to indicate that the safety document has been issued. For example, the Clearances symbol (below) appears next to the device to indicate that the device, listed on a Clearance safety document, has been issued.

### Releasing Safety Documents
To release a safety document, the document must already be issued. You can release a safety document by clicking the **Release** button in the open safety document. The symbol for the safety document disappears from the device and the Safety Flag is placed back onto the device.

Alternatively, safety documents are released when switching steps that involve releasing safety documents are instructed or completed.

The Description and Ground Locations text fields remain editable, and now the Crew Info fields have become editable again. At this point the Safety Document can either be reissued to a different crew or it can be completed.

### Associating Safety Documents with Switching Plans
Safety documents can be associated with switching plans. You can enter the issuance or release of a safety document as steps in the steps section of the switching plan. All safety documents associated with a switching plan are listed in the header on the Switch Sheet Editor. You can open a safety document by double-clicking on the safety document number.

Safety documents can be associated to only one switching plan at a time. A safety document cannot be disassociated or its association changed if it has any actively recorded switching steps.

There are three ways to associate a safety document with a switching plan:

• Any time you create a safety document from the Switch Sheet Editor, the newly created safety document is automatically associated to the currently opened switch plan.
• In the Safety Documents list in the Work Agenda window, click the **Associate** button. A dialog box opens, allowing you to associate the safety document with a switching plan.

• From the safety document, you can select the **Associate** option from the Action menu. A dialog box opens, allowing you to associate the safety document with a switching plan.

**Disassociating a Safety Document**

There are two ways to disassociated a safety document from a switching plan:

• From the switching plan, double-click the safety document name in the header panel on the Switch Sheet Editor. Click the **Disassociate** button in the Record Safety dialog box to remove the safety document from the list and remove its association with the switching plan.

• From the safety document, you can select the **Disassociate** option from the Action menu.

**Searching for Safety Documents**

Since safety documents are associated to physical tags in the field, it is sometimes necessary to look up a safety document number called in by a crew member. The Find Safety Document dialog can help with this task.

**Searching for a Document Number**

You can initiate the Find Safety Document dialog from either the Safety Document List or from any of the five safety document types.

• Initiating find from Safety Document List
  • Select the **Find**… option from the Actions menu.

• Initiating find from Safety Document display.
  • Select the **Find**… option from the File menu.

Once the Find Safety Document dialog is displayed, you have the option of entering a value within the Document Type and/or the Document # field. Once your search criteria have been specified, select the **Search** button.

The results of the search are displayed in the list found just below the search criteria fields. The number of documents found is also be specified. From the list, find your specific document and select it. After it has been selected, select the **Load** button to load the document into the Safety Document display.

Use the **Clear** button to clear the list or select Cancel to cancel the search.

**Viewing the Safety Document List**

A Safety Document List is available in the Work Agenda window. To access the list, click the Safety Doc List button on the Environment Manager. (This button is only available for certain user types.) You can perform a number of actions for a safety document in the Safety Documents List, such as opening or releasing a safety document.

The Safety Document List contains the following information:

• The **Color Enable / Disable** toggle button turns coloring of the rows on and off within the list. The color coincides with the Safety Document type. Coloring within this list is not state driven.

• The **Type** column contains the type of safety document.

• The **Doc #** column contains the unique number associated with the safety document.

• The **Status** column contains the current state of the safety document (e.g., Issued).
• The Plan # column contains the number of the switching plan that the safety document is associated with. A value of '0' indicates no association.
• The Issued By column contains the user name of the user that issued the safety document.
• The Issued Date column contains the date and time the safety document was issued.
• The Crew Name column contains the name of the crew member responsible for the safety document.
• The Crew ID column contains the unique identification name or number for the crew.
• The Crew Phone column contains the telephone number for the crew.
• The Crew Pager column contains the pager number for the crew.
• The Released By column contains the user name of the user that released the safety document.
• The Released Date column contains the date and time the safety document was released.
• The Completed By column contains the user name of the user that completed the safety document.
• The Completed Date column contains the date and time the safety document was completed.
• The Open button opens the selected safety document.
• The Release button releases the selected safety document.
• The Copy button creates a new safety document and copies the contents of the currently selected safety document into the newly created document and displays the newly created safety document.
• The Print button opens the Print dialog box, allowing you to print a snapshot or a PostScript version of the safety document to a printer.
• The Associate button opens a dialog box, which allows you to enter the number of the switching plan to associate the safety document with. If the safety document is already associated with a switching plan, the switching plan number displays in the dialog box.
• The Open Plan button opens the Switch Sheet Editor for the switching plan associated with the safety document, if any.
• The Refresh button refreshes the list of safety documents. The Safety Doc List is not dynamically updated, so it is necessary to click the Refresh button to view the latest list of safety documents.
• The Exit button closes the Safety Doc List.

Filtering the Safety Document List
Use the Filter menu options to control which documents are displayed in the list. The options are:
• Issued displays safety documents that are in the issued state.
• Released displays safety documents that are in the released state.
• Completed displays safety documents that are in the completed state.
• Deleted displays safety documents that are in the deleted state.
• Planned displays safety documents that are in the initial, unissued and released states.
• Active displays safety documents that are in the initial, issued, unissued and released states.
• All displays safety documents that are in the initial, issued, unissued, released and completed states.
This chapter describes the Oracle Utilities Network Management System - Web Switching Management application. It includes the following topics:

- Overview
- Starting Web Switching Management
- Planned Switching
- Emergency Switching
- Event Associations
- Working with Safety Documents
- Outage Correction
- Using the Miscellaneous Log
- Viewing Global Overlaps

Overview

Web Switching Management allows you to create and implement switching sheets and safety documents. Switching sheets allow you to track proposed switching actions, analyze the results, and implement the plan. You can record switching actions, such as device-tagging operations, from the Control Tool into a switching sheet as steps. For planned switching, you can play back steps repeatedly in Study mode, then complete them once in real-time mode. For emergency switching, you can create a record of operations as you perform them. You can also copy frequently used switching step sequences using switching templates.

Web Switching Management also allows you to create and load safety documents. At least one safety tag step must be present in a switching sheet before a safety document can be created. Safety documents must be associated to switching steps. Web Switching Management ensures that all of the associated safety documents have been released before allowing a switching plan to be completed.

This section contains the following topics:

- Switching Sheet Types
- Switching Sheet States
- Operating Modes
Switching Sheet Types

Web Switching Management supports the following types of switching sheets.

- **Planned** - Used for switching sequences that are prepared ahead of time. In scheduled or planned switching, you can create, study, and approve switching steps in a Viewer in study mode prior to completing them in real-time. Planned switching sheets require information that is not needed for emergency switching sheets, such as a start and end date.
  
  **Note:** when creating a switching sheet from an event in the Work Agenda or Event Details, the Planned switching sheet type is not available.

- **Emergency** - Used for switching sequences that are prepared and implemented in real-time when overloads or unplanned outages occur.
  
  **Note:** FLISR sheet types are created by the FLISR tool and are another form of an Emergency switching sheet. Users cannot create FLISR switching sheets from scratch. In automatic mode, FLISR can create and execute a switch plan without operator intervention. See Executing FLISR in Automatic Mode on page 18-7. In manual mode, you generate and then execute the switch plan manually. See Generating a Switch Plan (Manual Mode) on page 18-8.

- **Template** - Used to record and store frequently performed switching step sequences that can be copied into a switching plan. A template is not used to perform actions, but rather to create and save “pre-built” step sequences. You can create a template from scratch or by copying an existing planned or emergency switching sheet.
  
  **Note:** when creating a switching sheet from an event in the Work Agenda or Event Details, the Template switching sheet type is not available.

- **Outage Correction** - Used to correct outage information. Outage events are associated to this switching sheet type and then steps are recorded to reflect the actual events leading up to the outage. An option on the sheet then allows you to update the associated events, including customer counts associated to the outage.

Additional or alternative sheet types can be created by the customer.

Switching Sheet States

A switching sheet passes through different phases during the creation and completion of the sheet. These phases are represented by “states” that follow a logical sequence and determine what you can do with a switching sheet at any time. Each sheet type has a unique set of state transitions. For example, planned switching sheets have more state transitions than emergency sheets.

<table>
<thead>
<tr>
<th>Normal Progression of Planned Sheet</th>
<th>Normal Progression of Emergency Sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. New</td>
<td>1. New</td>
</tr>
<tr>
<td>2. Requested</td>
<td>2. In Progress</td>
</tr>
<tr>
<td>4. Checked</td>
<td></td>
</tr>
<tr>
<td>5. Approved (optional)</td>
<td></td>
</tr>
<tr>
<td>6. Scheduled</td>
<td></td>
</tr>
<tr>
<td>7. Issued</td>
<td></td>
</tr>
<tr>
<td>8. In Progress</td>
<td></td>
</tr>
<tr>
<td>9. Completed</td>
<td></td>
</tr>
</tbody>
</table>
Starting Web Switching Management

See Changing the Switching Sheet State on page 15-16 for a complete description of each possible state and instructions for changing the sheet state.

Note: The state of the switching plan should not be confused with the state of individual switching steps within the switching plan, which may also progress through a series of states. See Switching Sheet Step States on page 15-27.

Operating Modes

Web Switching Management supports two operating modes:

- **Real-Time Mode** - Allows you to make real-time changes to the state of devices in the system. When you create an emergency switching sheet, the system automatically enables real-time mode. For planned sheets, you can switch to this mode when the sheet is ready to be worked (i.e., in the Issued state).

- **Study Mode** - Allows you to make changes without affecting real-time data. You can apply the actions to the steps, but the actions are not applied to the real-time data. This mode is valid for all types of sheets. Study mode is the only valid mode for template and outage correction switching sheets.

Starting Web Switching Management

You can run Web Switching Management in the following ways:

- **Web Workspace with Web Switching Management** – This method integrates both products into one environment so that only one login is required.

- **Web Switching Management (standalone)** - This method excludes many of the tools available in Web Workspace with Web Switching Management and provides only functionality for modifying switching sheets. This is designed for users whose authority is limited to filling out switching requests.

- **Web Switching Management with Operator's Workspace** – To use this method, you must log in to both Operator's Workspace and Web Switching Management using the same user ID.

The system supports the capability for some users on a site to use the Web Switching Management with Operator's Workspace environment and others to use the Web Workspace with Web Switching Management environment. However, a single user cannot be logged in to the both environments under the same user ID.

Check with your system administrator to verify that your system has been configured to support Web Switching Management and to obtain any special login instructions.
Starting Web Switching Management

Logging in to Web Switching Management with Operator's Workspace

When using Web Switching Management with Operator's Workspace, you must log in to both environments, but it does not matter which one you start first. For instructions on logging in to Operator's Workspace, see Logging In on page 1-7.

To log in to Web Switching Management so as to connect to your Operator's Workspace, follow these steps:

1. Depending on how your system was installed, do one of the following:
   • Click the Web Switching Management icon found under the appropriate program group in your Windows Start Menu.
   • Double-click the Web Switching Management icon on your desktop.
   • Open a web browser and type the Web Switching Management URL in the browser's Address field.

   The Web Switching Management Login window displays.

2. Enter the user name you used to log into the Operator's Workspace application.

3. Enter the password.

4. Click the Validate button. The bottom portion of the Web Switching Management Login window sensitizes.

5. Select the Web Switching User Type from the drop-down menu.

6. Click the Login button. Once you have successfully logged on, the Web Switching Management window is displayed, and the Welcome tab is active.

Logging in to Web Workspace with Web Switching Management

To log in to Web Workspace with Web Switching Management, follow these steps:

1. Depending on how your system was installed, do one of the following:
   • Click the Web Workspace with Web Switching Management icon found under the appropriate program group in your Windows Start Menu.
   • Double-click the Web Workspace with Web Switching Management icon on your desktop.
   • Open a web browser and type the Web Workspace with Web Switching Management URL in the browser's Address field.

   The Web Workspace with Web Switching Login window displays.

2. Enter your user ID.

3. Enter the password.

4. Click the Validate button. The bottom portion of the Web Switching Login window sensitizes.

5. Select the appropriate User Type from the drop-down menu.

6. Click the Login button. Once you have successfully logged on, the Web Workspace with Web Switching Management window displays the Work Agenda, Authority, and Web Switching Management tools.
Logging in to Web Switching Management in Standalone mode

To log in to Web Switching Management in standalone mode, follow the steps described in the previous procedure but select **Web Switching Management**, rather than Web Workspace with Web Switching Management, in step 1. Once you have successfully logged on, the Web Switching Management window is displayed.

Understanding the Web Switching Management Window

This section provides an overview of the Web Switching Management window. It includes the following topics:

- **Menu Options and Toolbar Buttons**
- **Web Switching Management Tabs**
- **Status Bar**

Related Topics:

- **Planned Switching**
- **Emergency Switching**
- **Working with Safety Documents**

**Menu Options and Toolbar Buttons**

The title bar of your Oracle Utilities Network Management System application window reflects the environment in which you are running Web Switching Management:

- If you are running Web Switching Management in standalone mode or with Operator's Workspace, the Oracle Utilities Network Management System Web Switching Management window is displayed. Its main menu and toolbar provide access to Web Switching Management tools, such as Miscellaneous Log and Switching Overlaps, as well as general application tools, such as User Preferences.

- If you are running Web Workspace with Web Switching Management, the Oracle Utilities Network Management System Web Workspace with Web Switching Management window is displayed. Its main menu and toolbar provide access to all Web Workspace tools, such as the Work Agenda and Authority, as well as Web Switching Management tools and general application tools.

When you create or open a switching sheet, a new tab opens, displaying the name of the switching sheet, prefaced by its sheet type (such as Planned or Emergency). Each sheet-specific tab has its own toolbar and menu, and displays a set of tabs below the toolbar that are used to manage the sheet. Some tabs, such as the Steps and External Documents tabs, contain toolbars as well. These toolbars are discussed in the appropriate sections later in this document.

**Note:** When using Web Workspace with Web Switching Management, you can double-click on a sheet tab to maximize the Web Switching Management frame. Double-click again to restore to the original size.

The following tables list and describe the menu and toolbar options available in the Web Switching Management environments. Note that options may vary depending on your system's configuration and the way in which you are running Web Switching Management.
### General Menu and Toolbar

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>New&gt;Switching Sheet...</td>
<td>Allows you to create a new switching sheet.</td>
<td>![Folder]</td>
</tr>
<tr>
<td>File</td>
<td>Open&gt;Switching Sheet...</td>
<td>Allows you to open a new switching sheet.</td>
<td>![File]</td>
</tr>
<tr>
<td>File</td>
<td>Open&gt;Safety Document...</td>
<td>Allows you to open a new safety document.</td>
<td>![File]</td>
</tr>
<tr>
<td>File</td>
<td>Exit</td>
<td>Closes the standalone Web Switching Management application.</td>
<td>![Close]</td>
</tr>
<tr>
<td>Tools</td>
<td>Switching Overlaps...</td>
<td>Opens the Global Overlaps Tool. See <a href="#">Viewing Global Overlaps</a> on page 15-72.</td>
<td>![Folder]</td>
</tr>
<tr>
<td>Tools</td>
<td>Miscellaneous Log...</td>
<td>Opens the Miscellaneous Log. See <a href="#">Using the Miscellaneous Log</a> on page 15-71.</td>
<td>![Cogs]</td>
</tr>
<tr>
<td>Tools</td>
<td>User Preferences...</td>
<td>Saves the current user preferences after prompting for confirmation.</td>
<td>![Settings]</td>
</tr>
<tr>
<td>Help</td>
<td>Web Workspace Help</td>
<td>Displays a help window for Web Workspace.</td>
<td>![Help]</td>
</tr>
<tr>
<td>Help</td>
<td>About Web Workspace</td>
<td>Displays the About window for Web Workspace.</td>
<td>![Info]</td>
</tr>
</tbody>
</table>

If you are running Web Workspace with Web Switching Management, the general menu will provide access to additional tools. See [Web Workspace Menu and Toolbar](#) on page 6-3 for a list and description of each option.

### Web Switching Sheet-Specific Menu and Toolbar

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Save Sheet</td>
<td>Saves the active switching sheet.</td>
<td>![Folder]</td>
</tr>
<tr>
<td>File</td>
<td>Copy As...</td>
<td>Opens the Copy Switching Sheet As dialog that allows you to copy the steps from the current plan into a newly created plan. The new plan can be one of the following types: Planned, Emergency, Template, or Outage Correction. See <a href="#">Copying a Switching Sheet</a> on page 15-57 for details.</td>
<td>--</td>
</tr>
<tr>
<td>File</td>
<td>Print Preview...</td>
<td>Allows you to preview the switching sheet printout. You can select which components of the sheet you want to print and specify the output format.</td>
<td>![Preview]</td>
</tr>
<tr>
<td>File</td>
<td>Print...</td>
<td>Allows you to preview the switching sheet printout. You can select which components of the sheet you want to print and specify the output format.</td>
<td>![Print]</td>
</tr>
</tbody>
</table>
Web Switching Management Tabs

When you start Web Switching Management, the Welcome tab appears. Each time you create or open a new switching sheet, the sheet is displayed in a separate tab. The label on the tab displays the type of sheet (Planned, Emergency, or Template), the sheet ID, and the status of the sheet (in parentheses), and the value of the Feeder field on the Request tab. The active tab displays in blue. Click a tab to make it the active tab. Double-click a tab to maximize the Web Switching Management frame. (Double-click again to restore to the original size.)

Each switching sheet tab displays a row of tabs that you can use to view and edit all of the information associated with the sheet. Some tabs have their own toolbar with shortcuts for supported actions.

The following table describes the tabs displayed for each switching sheet.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td>Use this to view and enter information about the user who requested the switching sheet, including phone number and contact, the sheet’s owner, charge number, start and finish dates, feeder and voltage information. See Completing the Request Tab on page 15-14.</td>
</tr>
<tr>
<td>Steps</td>
<td>Use this to view, add, and edit switching steps. See Adding and Editing Steps on page 15-18.</td>
</tr>
<tr>
<td>Impacted Customers</td>
<td>Use this to view, print, and maintain the list of impacted customers. See Viewing Impacted Customers on page 15-43.</td>
</tr>
<tr>
<td>Overlaps</td>
<td>Use this to identify any overlap of date/time, control zone, or affected devices within a specific time period. See Checking for Overlaps on page 15-47.</td>
</tr>
<tr>
<td>External Documents</td>
<td>Use this to attach external documents to the switching sheet. See Adding External Documents to a Switching Sheet on page 15-52.</td>
</tr>
<tr>
<td>View Areas</td>
<td>Use this to save and reload viewing areas from a Viewer window. See Saving and Loading View Areas on page 15-49.</td>
</tr>
</tbody>
</table>
Understanding the Web Switching Management Window

### Status Bar

A status bar appears at the bottom of each switching sheet. The items on the status bar are described in the following table.

<table>
<thead>
<tr>
<th>Status Bar Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Safety Documents</strong></td>
<td>Use this to view, load, and delete safety documents that have been defined for this sheet. See Working with Safety Documents on page 15-61.</td>
</tr>
<tr>
<td><strong>Tracking/Audit Log</strong></td>
<td>Use this to view audit log entries associated with this sheet. See Viewing the Audit Log on page 15-51. You can also use this to view the current sheet state or transition to another state. See Changing the Switching Sheet State on page 15-16.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status Bar Indicator</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Study Mode**       | Indicates the current operating mode:  
  • **Study Mode** - Allows you to complete switching operations without affecting the real-time data model. You can apply the actions to the steps, but the actions are not applied to the real-time data.  
  • **Real-Time Mode** - Allows you to apply real-time changes to the state of devices in the data model. |
| **Overlap Indicator** | Indicates whether the switching sheet will result in overlap of affected devices or control zones during the same time period. This icon is dynamically updated to reflect the results of overlap checking. If this indicator is grayed, then there are no overlaps. |
| **Impacted Customer Indicator** | Indicates whether or not switching operations will impact customers. This icon is dynamically updated to reflect the results of generating the impacted customer list. If this indicator is grayed, then no customers are affected by the switching sheet operations. |
| **Recording Currently On/Off** | Indicates whether recording is turned on or off. When recording is on, you can add steps by taking actions in the Viewer and Control Tool. |
| **Version: 1 (Editing)/2 (Checked In)** | Indicates the switching sheet version and whether or not your latest changes have been checked in. See Working with Switching Sheet Versions on page 15-41 for more information. |
| **Check In / Create New Version** | The Check In button allows you to check in and save a copy of the switching sheet. This is used for auditing purposes to determine differences between steps in two versions of a switching sheet.  
When you check in a sheet, this button changes to Create New Version, which manually increments the sheet's version number and sets the sheet to Editing mode. See Working with Switching Sheet Versions on page 15-41 for more information. |
### Status Bar Indicator

<table>
<thead>
<tr>
<th>Status Bar Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Version</td>
<td>Indicates the version currently displayed and allows you to select a previous version to compare against the current version. See <strong>Working with Switching Sheet Versions</strong> on page 15-41 for more information.</td>
</tr>
</tbody>
</table>

### Locking and Unlocking a Switching Sheet

- **Allowing you to lock the switching sheet so that no other user can make changes to it.**
- When the sheet is locked, you are the only user who can edit it. When it is unlocked, you are in view-only mode and the sheet is available for editing by other users. This button toggles the sheet between its locked and unlocked states.
- When you open a sheet for editing, the sheet is automatically locked to other users. If you open a sheet that is currently being editing by another user, you are not allowed to make any changes.
Planned Switching

The sections that follow describe how to create and manage planned switching sheets. Planned switching sheets are used for switching sequences that are prepared ahead of time. In scheduled or planned switching, you can create, study, and approve switching steps in a Viewer in study mode prior to completing them in real-time mode.

This section contains the following topics:

- Creating a Planned Switching Sheet
- Requesting Switching Sheets
- Changing the Switching Sheet State
- Adding and Editing Steps
- Reviewing a Switching Sheet in Study Mode
- Replaying Steps
- Implementing a Planned Switching Sheet
- Working with Switching Sheet Versions
- Viewing Impacted Customers
- Checking for Overlaps
- Saving and Loading View Areas
- Emailing Switching Sheet Data
- Adding External Documents to a Switching Sheet
- Viewing the Audit Log
- Working with Switching Sheet Versions
- Copying a Switching Sheet
- Deleting a Switching Sheet

For information about emergency switching sheets, see Emergency Switching on page 15-58.
Creating a Planned Switching Sheet

You can create a new planned switching sheet directly from the Web Switching Management window or the Web Workspace with Web Switching Management window. From the Web Workspace with Web Switching Management’s File menu, New, and then select Switching Sheet.... The New Switching Sheet window is displayed.

If you are running Web Switching Management with Operator's Workspace, you can also create a new plan from the Oracle Utilities Network Management System Environment Manager. From the Environment Manager, click the New Switching Sheet button. The New Switching Sheet window is displayed.

Note: The Web Switching Management application must have already been started in order to initiate a switching sheet from the Environment Manager. (See Starting Web Switching Management on page 15-3.)

New Switching Sheet Window

Use the New Switching Sheet window to create switching sheets. This window contains the following fields:

The Switching Sheet Types section allows you to select a pre-defined switching sheet.

- The Type column displays the types of switching sheets you can create. Planned, Emergency, and Template are the base types.
- The Description column displays a description of the sheet type.

The Pre-Created Switching Sheets section is empty the first time the dialog is called (after logging in). To load a list of pre-created switching sheets, click the Refresh button. The product environment is configured to load 60 days worth of completed switching sheets, but projects may change that value; Oracle recommends that projects keep the number of switching sheets in this list to a minimum for performance reasons. The latest queried list will remain in the Pre-Created Switching Sheets list for the duration of your login. It displays the following columns:

- Status displays the switching sheet state.
- Type displays the sheet type, such as Planned, Emergency, or Template.
- Sheet # is the number of the switching sheet. This number is automatically assigned by the system when the sheet is created.
- User is the ID of the user who created the sheet.
- Feeder is the feeder associated with the sheet (as displayed on the Request tab).
- Device is the device associated with the sheet (as displayed on the Request tab).
- Substation is the substation associated with the sheet (as displayed on the Request tab).
- Completed Date is the completion date for the sheet.
- Description is the description of the sheet (as displayed on the Request tab).

Action Buttons:

- The Create button creates a new switching sheet of the selected type.
- The Help... button opens the online help for this topic.
- The Cancel button closes the dialog without taking any action.
Creating a Planned Switching Sheet

Follow these steps to create a planned switching sheet from the New Switching Sheet window:

- To create a new switching sheet from scratch, select Planned from the Switching Sheet Types section, and then click Create.

- To select a Pre-Created Switching Sheet, do the following:
  1. Click the Refresh button to load the data; first time only.
  2. Select the sheet you want to use from the Pre-Created Switching Sheets list.
  3. Select Planned from the Switching Sheet Types list.
  4. Click Create. (To search for a particular sheet, see Filtering the Switching Sheet List on page 15-12.)

Notes:
You can create a new sheet based on a sheet of a different type. For example, you can create a planned sheet based on an emergency sheet or create a template based on a planned sheet.

Although most fields are copied to the new sheet, some fields (such as Audit Log entries and step completion information) are cleared in the new sheet. If you copy a switching sheet that has one or more safety documents, copies of the safety documents are included with the new sheet.

Filtering the Switching Sheet List

Use the edit boxes at the top of each column to filter the list. Type all or part of the text you want to filter by. For example, to see only Planned sheets, type “Plan” in the Type edit box. The list is filtered to display only sheets where the Type column contains the characters “Plan.” You can combine filter criteria by typing values in more than one column. As you type in each edit box, the list is filtered immediately based on entries in all boxes.

Sorting the Switching Sheet List

You can resort the list by clicking on a column header. Click once to sort in ascending order; click again to sort in descending order. The ▲ or ▼ icons indicates the current sort column and sort direction where ▲ indicates ascending order and ▼ indicates descending order.
Creating a Switching Sheet Template

Switching templates look like standard switching sheets, but they are used for creating and saving “pre-built” step sequences. Once you save the template, you can create a copy of it, and then edit the copy as needed. You can also copy individual steps from a template and paste them into another switching sheet. Templates can save you considerable time and effort when you are working with frequently performed switching sequences.

To create a template:
1. From your environment’s general menu, select File>New>Switching Sheet... The New Switching Sheet window is displayed.
2. From the Switching Sheet Types section at the top of the window, select Template.
3. Do one of the following:
   • To create a new, blank template, click Create.
   • To create a template based on an existing sheet, select the sheet you want to copy from the Pre-Created Switching Sheets list, and then click Create a Copy. To search for a particular sheet, see Filtering the Switching Sheet List on page 15-12.

Note: Although most fields are copied to the new sheet, some fields (such as Audit Log entries and step completion information) are cleared in the new sheet.

Creating a Switching Sheet from a Template

After a switching template has been created and saved, you can use the template as the basis for another switching sheet.

To create a new planned sheet from a template:
1. From your environment’s general menu, select File>New>Switching Sheet... The New Switching Sheet window is displayed.
2. From the Switching Sheet Types section at the top of the window, select Planned.
3. From the Pre-Created Switching Sheets list, select the template to use.
4. Click Create.
5. Edit the sheet as needed (see the instructions in the remainder of this guide) and save when you are done.

Requesting Switching Sheets

Someone other than the person who prepares the switching sheet usually initiates switching sheet requests. The requestor may be someone in the construction/maintenance department, while the preparer is typically an operations user assigned to look for and prepare new requests. Typically, the requestor is a Switching Entry user type.

Capabilities of the Switching Entry User Type

Switching Entry users do not have full access to all switching sheet information and operations. Specifically, Switching Entry users are limited to the following capabilities:

• Creating and viewing “Planned” switching sheets only. All other types of switching sheets are not available to Switching Entry users.
• Creating copies of existing switching sheets. Note that the steps list will be cleared in the copy.
• Loading, printing, and emailing existing sheets. Only the information contained in the Request, Steps, Tracking/Audit Log, and External Documents tabs can be viewed, printed, or emailed.
Performing the following operations on switching sheets that are in the New or Request Rejected state only:

- Completing the fields on the Request tab.
- Adding, removing, modifying, cutting, copying and pasting comment steps within the current sheet's Steps list. Note that cut, copy and paste operations are only supported for sheets that are in the New or Request Rejected states.
- Adding, removing, and viewing attachments on the External Documents tab.
- Adding comment entries to the audit log on the Tracking/Audit Log tab.
- Incrementing and checking in versions of a switching sheet. This is done by selecting the Check-in button on the status bar of the switching sheet.

Once a sheet has transitioned to (or beyond) the Prepared state, Switching Entry users are limited to view-only mode.

**Completing the Request Tab**

Follow the steps in the previous sections to start a new planned switching sheet. Then use the Request tab to enter basic information about the switching sheet before you begin adding steps. When a new sheet is created, the user ID of the person who created it is automatically displayed in the Requested By field. You should complete as much of the information on this tab as possible.

When you have completed the information on the Request tab (fields described below), update the sheet state to **Requested** on the Tracking/Audit Log tab. See **Changing the Switching Sheet State** on page 15-16 for more information.

*Note:* The switching sheet is automatically saved after a state change, and an entry is added to the audit log.

The Request tab contains the following fields:

- **Owner** displays the current owner of the switching sheet. See **Taking Ownership** on page 15-15 for more information.
- **Requested By** displays the person who requested the switching order. This field is initially populated with the ID of the user who created the switching sheet and can be updated. A value is required prior to submitting the request.
- **Phone Number** displays the phone number of the person requesting the switching order.
- **Email Address** displays the email address of the requestor.
- **Customer Name** displays the name of the customer requesting the interruption.
- **Phone Number** displays the phone number of the customer requesting the interruption.
- **Email Address** displays the email address of the customer requesting the interruption.
- **Charge Number** allows you to enter charge numbers that can then be executed and/or used by the switching sheet preparer.
- **Office** displays the office responsible for the switching sheet.
- **Location** displays the street address or specific location for the switching operation.
- **Substation** displays the substation where the switching operation takes place.
- **Device** displays the device being worked on (not necessarily the device being switched). This device address is given to the master event associated to the switching sheet after the switching sheet has been scheduled. The following buttons are displayed to the right of the Device field:
- Use the **Link Device** button to link a device selected from the Viewer to this switching sheet. First, click on the device in the Viewer, then click this button. The Device field is populated with the selected device’s name.

- Once a device has been linked, you can use the **Unlink Device** button to clear the device field.

- Use the **Focus** button to locate this device in the Viewer.

- **Description of Work** displays a general description about what the switching sheet should try to accomplish.

- **Start Date** displays the date and time the switching work is scheduled to begin. This is required when scheduling a switching sheet. This is the Start Date given to the master event associated to the switching sheet after it has been scheduled. This is also used to generate the Impacted Customers list if no Planned Date is specified for a step. Enter the time in military time format (e.g., 13:00 = 1 P.M.).

- **Alt. Start Date** displays the alternate date and time the switching work could begin. Enter the time in military time format (e.g., 13:00 = 1 P.M.). The alternate start date must be later than the start date.

- **Finish Date** displays the date and time the switching work is scheduled to end. This field is required when scheduling a switching sheet. This date is the Estimated Restore Time (ERT) given to the master event associated to the switching sheet after it has been scheduled. The finish date must be later than the start date, and you must enter the finish time for the date to be valid. Enter the time in military time format (e.g., 13:00 = 1 P.M.).

- Use the **Update ERT** button to update the ERT for the master event associated to the switching sheet. This option is only available after the sheet has been scheduled. This button is displayed next to both the Finish Date and Alt. Finish Date fields. The button is grayed if no date has been entered yet for the field.

- **Alt. Finish Date** displays the alternate date and time the switching work could end. The alternate finish date must be later than the alternate start date. Enter the time in military time format (e.g., 13:00 = 1 P.M.).

- **Feeder** displays the feeder that is relevant to the switching sheet. This is a text entry field and is not auto-populated.

- **Voltage** displays a drop-down menu that lists the nominal device voltages. This list is configured and is not dynamically generated.

- The **Crew Will Switch** checkbox allows you to indicate whether the requesting crew will perform the switching activities.

- The **Crew Will Restore** checkbox allows you to indicate whether the requesting crew will restore the outage associated with the switching activities.

- The **Grounds Required** checkbox allows you to indicate whether the crew is required to place grounds on the appropriate devices or not.

### Taking Ownership

You can take ownership of a switching sheet to indicate that you are currently working the sheet. Once you take ownership, no other user is allowed to execute steps for the sheet or edit restricted fields. Other users can still view, lock, and edit certain fields on the sheet.
To take ownership of a plan, click the **Take Ownership** button next to the Owner field on the Request tab. Your user ID is displayed in the Owner field. You can also use this button to take over ownership of a switching sheet that is currently owned by another user. This is useful if there is a shift change and the original user does not relinquish ownership before logging off.

To relinquish ownership, click the **Relinquish Ownership** button.

An entry is recorded in the audit log whenever ownership of a sheet changes.

### Changing the Switching Sheet State

A switching sheet passes through different phases during the creation and completion of the plan. These phases are represented by “states” that follow a logical sequence and determine what you can do with a switching sheet.

**Note:** The state of the switching sheet should not be confused with the status of individual switching steps within the switching sheet.

A switching sheet’s current state is displayed on the Tracking/Audit Log tab. This tab also displays a button for each valid state to which the sheet can transition and allows you to enter a comment associated with the state transition. To change the state of a switching sheet, click the appropriate state change button on the Tracking/Audit Log tab. It is helpful to provide comments or a reason for the state change.

The Audit Log table on the Tracking/Audit Log tab shows a history of all state transitions for the sheet, including the ID of the user who updated the state and the timestamp of the change. See [Viewing the Audit Log](#) on page 15-51 for details.

### Switching Sheet States

The following table describes the switching sheet states.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Indicates that the switching sheet is in the process of being created but has not yet been requested. When you create a switching sheet, its initial state is New.</td>
</tr>
<tr>
<td>Requested</td>
<td>Indicates that the sheet has been requested. A sheet transitions to this state when a user clicks the <strong>Submit Request</strong> button on the Tracking/Audit Log tab. This state is valid for planned switching sheets only. From this state, a sheet can progress to either the Rejected or Prepared state.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Indicates that the request was rejected. A sheet transitions to this state when a user clicks the <strong>Reject</strong> button on the Tracking/Audit Log tab. The Reject button is grayed until you select a Reason. This state is valid for planned switching sheets only. From this state, a sheet can be requested again by clicking the <strong>Submit Request</strong> button on the Tracking/Audit Log tab.</td>
</tr>
<tr>
<td>Prepared</td>
<td>Indicates that the sheet has been prepared. A sheet transitions to this state when a user clicks the <strong>Prepare</strong> button on the Tracking/Audit Log tab. Although not required, all information for the switching sheet should be entered before you transition to this state. This state is valid for planned switching sheets only. From this state, a sheet can transition to the Checked state.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Checked</td>
<td>Indicates that the sheet has been checked. A sheet transitions to this state when a user clicks the <strong>Check</strong> button on the Tracking/Audit Log tab. All information for the switching sheet should be entered before you check the sheet. This state is valid for planned switching sheets only. From this state, a sheet can be approved, rejected, or scheduled.</td>
</tr>
<tr>
<td>Approved</td>
<td>Indicates that the sheet has been approved. A sheet transitions to this state when a user clicks the <strong>Approve</strong> button on the Tracking/Audit Log tab. All information for the switching sheet should be entered before you approve the sheet. This state is valid for planned switching sheets only. From this state, a sheet can be scheduled.</td>
</tr>
<tr>
<td>Check Rejected</td>
<td>Indicates that the sheet was rejected after being checked. A sheet transitions to this state when a user clicks the <strong>Reject</strong> button on the Tracking/Audit Log tab. The Reject button is grayed until you select a Reason. This state is valid for planned switching sheets only. From this state, the sheet can be prepared again.</td>
</tr>
<tr>
<td>Scheduled</td>
<td>Indicates that the sheet has been scheduled. A sheet transitions to this state when a user clicks the <strong>Schedule</strong> button on the Tracking/Audit Log tab. All information for the switching sheet should be entered prior to scheduling the sheet. This state is valid for planned switching sheets only. From this state, a sheet can be cancelled or issued.</td>
</tr>
<tr>
<td>Canceled</td>
<td>Indicates that the sheet was cancelled. A sheet transitions to this state when a user clicks the <strong>Cancel</strong> button on the Tracking/Audit Log tab. The Cancel button is grayed until you select a Reason. This state is valid for planned switching sheets only. From this state, a sheet can be scheduled again.</td>
</tr>
<tr>
<td>Issued</td>
<td>Indicates that the sheet has been issued. A sheet transitions to this state when a user clicks the <strong>Issue</strong> button on the Tracking/Audit Log tab. All information for the switching sheet should be entered before issuing a sheet. This state is valid for planned switching sheets only. From this state, a sheet can transition to the Hold/Pending, In Progress (automatically), or Completed state.</td>
</tr>
<tr>
<td>In Progress</td>
<td>Indicates that at least one switching step in a planned or emergency switching sheet has been completed in real-time mode. This state is set automatically by the system and is valid for planned switching sheets only. From this state, a sheet can transition to the Hold/Pending or Complete state.</td>
</tr>
<tr>
<td>Hold/Pending</td>
<td>Indicates that the sheet is on hold. A sheet transitions to this state when a user clicks the <strong>Hold/Pending</strong> button on the Tracking/Audit Log tab. From this state, a sheet can progress to the In Progress (automatically) or Complete state.</td>
</tr>
</tbody>
</table>
Adding and Editing Steps

This section describes how to add and edit steps in a switching sheet. It includes the following topics:

- Steps Tab
- Switching Sheet Step States
- Adding Recorded Steps to a Switching Sheet
- Adding Comment Steps
- Copying and Pasting Steps
- Creating Go-Back Steps
- Working with Blocks
- Grouping and Ungrouping Steps
- Editing Existing Steps
- Finding and Replacing a Device in the Steps
- Focusing on a Device in a Step
- Moving a Crew

Steps Tab

Use the Steps tab to add, edit, record, instruct, and execute steps in a switching sheet.
Steps tab topics include:

- **Steps Tab Fields**
- **Steps Tab Toolbar and Pop-Up Menus**
- **Steps Tab Header - Events and Crews**

**Steps Tab Fields**

The steps table on the Steps tab displays the following fields:

- **Step#** displays the number of the step.
  - For a block header row, this column displays the block name.
  - For a step row, this column displays the step number (1 through n).
  - For a sub-step within an aggregate step, such as Open & Tag, this column displays the sub-step number (a-z). Blocks and aggregate steps can be expanded or collapsed by clicking the + or - sign.
  - If you are viewing the differences between this version and another version, this column uses outline numbering (1.1, 1.2, etc.) to identify steps that were added since the previous version. See Working with Switching Sheet Versions on page 15-41 for more information.

- **Version** displays the version number of the switching sheet when the step was added. See Working with Switching Sheet Versions on page 15-41 for more information.

- **Operation** displays the description of the switching action. When the switching action is associated to a safety document, then the safety document type and number will be displayed in this field after the switching description.

- **Device** displays the device alias referenced in the step.

- **Phases** displays the phase that was selected for the step. When obtaining a device through a Viewer device selection, all the phases are selected by default.

- **Details** displays information about the outcome of the switching step, such as:
  - Deenergize a section of the network.
  - Energize a section of the network.
  - Make a loop.
  - Break a loop.
  - Make a parallel.
  - Break a parallel.

This information is recorded into the step when the step is initially added to the switching sheet, but is not dynamically updated as changes are made to the sheet. You can enter text into this field to replace the text that is automatically inserted.

- **Status** displays the state of the switching sheet step. Possible states are Instructed, SCADA Pending, Completed, Partially Completed, Aborted, Failed, and Deleted (for red-lined steps only). See Switching Sheet Step States on page 15-27 for descriptions of these states.

- **Planned Date** displays the proposed date/time when this step will be performed. The Planned Date is used to generate more accurate and detailed Impacted Customer lists and to specify the ERT for the generated Planned Events. This date must be within the Start and Finish Dates specified on the Request tab. This date is automatically updated when the switching sheet's Start and Finish Dates are updated. Thus, if the work is rescheduled, the planned date values do not have to be manually updated as well.
• **Executed By** displays the user ID of the person who completed the step in real-time mode. This field is automatically populated by the system.

• **Completed Date** displays the date the step was completed. If this field is blank when a step is completed, failed, or aborted in real-time mode, then the system populates this field automatically. If you enter a date in this field before executing a step, that date is used instead. This allows you to specify when an action actually occurred. (This field is similar to the date field on the Control Tool.) If you attempt to edit this date after the step has been completed in real-time, the system checks to see if the step affects any jobs. If it does, the system prompts you to confirm that you want to change the affected start date or restoration date, as applicable, based on the event association.

• **Instructed By** displays the user ID of the person who instructed the step in real-time mode. This field is automatically populated by the system.

• **Instructed To** displays the ID of the crew to which the step was instructed. This field is automatically populated if a crew is selected in the Crew List on the Steps tab header when you instruct a step. This field cannot be edited manually.

• **Instructed Date** displays the date and time the step was instructed. If this field is blank when the step is instructed, then the system populates this field automatically. If you enter a date in this field before instructing a step, that date is used instead. This field cannot be edited after the step is in a terminal state (completed, aborted, or failed).

• **Address** displays the address of the device referenced in this step. This field is automatically populated if you record the step by initiating an action within the Viewer.

• **Comments** displays any additional information associated with this step. You can enter free-form text in this field.

### Steps Tab Toolbar and Pop-Up Menus

A toolbar is displayed at the top of the Steps tab. The toolbar displays a button for each action that you can perform. If a button is grayed, then that action is not currently permitted. For example, if you are currently in Study Mode, then the Start Study Session button is grayed. Some toolbar buttons, such as Cut and Paste options, are also available on the pop-up menu that is displayed when you right-click on a step. The pop-up menu contains some options that do not appear on the toolbar.

The following table describes all actions that can be performed on the Steps tab either from the toolbar or pop-up menu.

<table>
<thead>
<tr>
<th>To perform this action:</th>
<th>Do this:</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn record mode on or off</td>
<td>Click <img src="image" alt="Record On" />, <img src="image" alt="Record Off" /></td>
<td>Record mode must be on in order to record operations using the Viewer and Control tool.</td>
</tr>
<tr>
<td>Save all device addresses to the database</td>
<td>Click <img src="image" alt="Device Addresses" /></td>
<td>If you change one or more device addresses in a switching sheet, this action updates the devices’ addresses throughout the switching sheet and also updates the device attribute table so that any new switching sheets referencing these devices will use the new addresses.</td>
</tr>
<tr>
<td>Focus Viewer 1 on the object referenced in the currently selected step</td>
<td>Click <img src="image" alt="Focus Viewer" /></td>
<td>By default, the master viewer is the VIEW1 Viewer.</td>
</tr>
<tr>
<td>To perform this action</td>
<td>Do this:</td>
<td>Comments</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>Instruct the selected steps</td>
<td>Click</td>
<td>This action is only permitted in real-time mode when the plan reaches Issued state. Note that steps cannot be instructed out of order. (You cannot instruct step 2 before you instruct step 1.) When you select this button, the Instructed By and Instructed Date columns are populated.</td>
</tr>
<tr>
<td>Complete the selected steps</td>
<td>Click</td>
<td>Once the action is complete, the status of the step changes to Completed. If you are in real-time mode, the Completed Date column is also updated with the current date. Note that steps cannot be completed out of order. (You cannot complete step 2 before step 1 has been completed, aborted, or failed.) The Complete button is enabled in real-time mode when the plan reaches the Issued state. <strong>Note:</strong> To complete a step in real-time mode, you must have authority over the device.</td>
</tr>
<tr>
<td>Abort the selected steps</td>
<td>Click</td>
<td>Use this action if a step was never attempted. When you click this button, the status of the step changes to “Aborted.” If you are in real-time mode, the Completed Date column is updated with the current date. However, the switching action is not actually performed. This action is only permitted in real-time mode and only for the next actionable step. (You cannot abort step 2 before step 1 has been completed, aborted, or failed.)</td>
</tr>
<tr>
<td>Mark the selected steps as failed</td>
<td>Click</td>
<td>Use this if a step was attempted but failed. When you click this button, the status of the step changes to Action Failed and the Completed Date column is updated with the current date. However, the action is not actually performed against the real-time data model. This action is only permitted in real-time mode and only for the next actionable step. (You cannot fail step 2 before step 1 has been completed, aborted, or failed.)</td>
</tr>
<tr>
<td>To perform this action</td>
<td>Do this:</td>
<td>Comments</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Verify steps after a model edit</td>
<td>Click ✔️ or right-click a highlighted row and select <strong>Model Verify</strong> from the context menu.</td>
<td>This action is available if model changes have occurred that impact one or more devices in the switching sheet. Outage Correction sheets are not part of this processing. The Web Switching service checks all the opened switching sheet steps after a model edit has occurred. If a step has a device that matches a device that was directly impacted by a model change, that step will be marked as needing verification. When the sheet is displayed, these steps will be highlighted in yellow. You can either check off each step in the sheet as they are verified or check off the entire sheet. <strong>Note:</strong> While the sheet has verifications pending, step executions cannot be performed within the sheet.</td>
</tr>
<tr>
<td>Reset study session and clear the status of the steps</td>
<td>Click ** ![ ]**</td>
<td>This action is only available in Study Mode. When you click this button, you are prompted to select either Nominal or Real Time. • Choose Real Time to replicate the real-time device states, which might include outages during a storm. • Choose Nominal to reset all devices to their predefined normal state.</td>
</tr>
<tr>
<td>Switch to current Real-Time Mode</td>
<td>Click ** ![ ]**</td>
<td>This action is only available when you are in Study Mode. When you click this button, the status bar displays real-time mode in red and Viewer 1 changes to real-time mode.</td>
</tr>
<tr>
<td>Switch to Study Mode</td>
<td>Click ** ![ ]**</td>
<td>This action is only available when you are in real-time mode. When you click this button, the status bar displays study mode in gray and Viewer 1 changes to study mode.</td>
</tr>
<tr>
<td>Find and Replace a device or text</td>
<td>Click ** ![ ]**</td>
<td>Use this to find and replace all occurrences of a device (see Finding and Replacing a Device in the Steps on page 15-33) or text (see Finding and Replacing Text in the Steps on page 15-34) in the switching steps.</td>
</tr>
<tr>
<td>To perform this action:</td>
<td>Do this:</td>
<td>Comments</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cut steps to the clipboard</td>
<td>Click <img src="image" alt="Cut" /> or choose Cut from the pop-up menu</td>
<td>You can select one or more steps. The selected steps are marked as being cut and are placed on the clipboard. The steps will only be moved after they have been pasted to their new location. Use the Paste option to paste the steps. This option is disabled if the sheet is not locked or the sheet state is Completed.</td>
</tr>
<tr>
<td>Copy steps to the clipboard</td>
<td>Click <img src="image" alt="Copy" /> or choose Copy from the pop-up menu</td>
<td>You can select one or more steps. The selected steps are copied to the clipboard. Use the Paste option to paste the steps.</td>
</tr>
<tr>
<td>Copy steps as go-back steps</td>
<td>Click <img src="image" alt="Copy" /> or choose Copy as Go-Backs from the pop-up menu</td>
<td>You can select one or more steps. Reverse steps are created for each selected step and copied to the clipboard. Use the Paste option to paste the steps.</td>
</tr>
<tr>
<td>Paste steps from clipboard</td>
<td>Click <img src="image" alt="Paste" /> or choose Paste from the pop-up menu</td>
<td>Steps are pasted after the currently selected step. The operation pastes the steps that were placed in the clipboard during the last Cut, Copy, or Copy as Go-Backs operation. Once the step(s) have been pasted, the Paste button is no longer available and the contents of the clipboard are cleared. This option is disabled if the sheet is not locked or the sheet state is Completed.</td>
</tr>
<tr>
<td>Clear the clipboard</td>
<td>Choose <img src="image" alt="Clear Clipboard" /> from the pop-up menu</td>
<td>Clears the contents of the clipboard.</td>
</tr>
<tr>
<td>Delete steps</td>
<td>Click <img src="image" alt="Delete" /> or choose Delete from the pop-up menu</td>
<td>Deletes the selected steps from the plan. This button is disabled if the sheet is not locked or if the step has transitioned beyond its initial state (No State).</td>
</tr>
<tr>
<td>Undo Step Action</td>
<td>Click <img src="image" alt="Undo" /> or choose Undo from the pop-up menu.</td>
<td>Allows you to undo the last action (Cut/Paste, Copy/Paste, Delete, Add Step). The Undo Step Action does not work if the steps were cut from a different sheet to the current one or if the current sheet is not the sheet affected by the action.</td>
</tr>
<tr>
<td>Add Safety Document</td>
<td>Click <img src="image" alt="Add Safety Document" /></td>
<td>Depending on the type of step selected, the Select Safety Type dialog may prompt you to select the type of safety document (if the type cannot be determined automatically). Once a safety document type has been determined or selected, the safety document dialog opens. This option is disabled if the sheet is not locked or the sheet state is Completed. See Working with Safety Documents on page 15-61.</td>
</tr>
<tr>
<td>Unlink from Safety</td>
<td>Click <img src="image" alt="Unlink from Safety" /></td>
<td>Unlinks (removes the association to) a device from a safety document's device list. First, select the step with the device operation you want removed from the safety document, then click this button. See Removing Devices on page 15-66.</td>
</tr>
<tr>
<td>Complete all steps up to the selected step in 'silent' mode</td>
<td>Click <img src="image" alt="Complete to Here" /> or choose Complete to Here from the pop-up menu</td>
<td>Use this action to complete all steps up to and including the selected step in 'silent' mode, which means that the system will auto-complete the operations without displaying the Look Ahead window. This option is only available in Study mode if you select a single row that has not already been completed. This is useful if you need to get a study session back to a point where you previously left off.</td>
</tr>
<tr>
<td>To perform this action:</td>
<td>Do this:</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>----------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Execute FLISR plan</td>
<td>Click</td>
<td>Executes the entire FLISR plan. Applies only to FLISR switching sheets.</td>
</tr>
<tr>
<td>Clear all FLISR actions</td>
<td>Click</td>
<td>Clears all FLISR action conditions. Applies only to FLISR switching sheets.</td>
</tr>
<tr>
<td>Show or hide header</td>
<td>Click ![arrow_up <img src="image" alt="to show or to hide the header" /></td>
<td>Shows or hides the Steps tab header, which displays crew and event associations. See Steps Tab Header - Events and Crews on page 15-25.</td>
</tr>
<tr>
<td>Add a new block header</td>
<td>Choose Add New Block Header from the pop-up menu, then select the block type</td>
<td>Inserts a new block header of the selected type: Isolate, Fault Location, Maintenance, Restore, or Custom. If you choose Custom, you are prompted to enter the block header name. See Adding a New Block Header for more information. This option is disabled if the sheet is not locked or the sheet state is Completed.</td>
</tr>
<tr>
<td>Clear the Planned Date field for this step</td>
<td>Choose Clear Planned Date from the pop-up menu</td>
<td>This action is only available if the step has a value in the Planned Date column. Clicking this button removes the date and leaves the Planned Date column blank. This option is disabled if the sheet is not locked or the sheet state is Completed.</td>
</tr>
<tr>
<td>Group steps</td>
<td>Choose Group Steps from the pop-up menu</td>
<td>Groups the selected steps and draws a bracket around them in the Steps list. This allows steps to be completed out of order within the grouping. See Grouping Steps on page 15-32. This option is disabled if the sheet is not locked or the sheet state is Completed.</td>
</tr>
<tr>
<td>Ungroup steps</td>
<td>Choose Ungroup Steps from the pop-up menu</td>
<td>Ungroups the selected steps and revises or removes the group bracket. (If you ungroup the third of three steps, the first 2 remain grouped.) See Ungrouping Steps on page 15-32. This option is disabled if the sheet is not locked or the sheet state is Completed.</td>
</tr>
<tr>
<td>Insert a blank step</td>
<td>Choose Insert Blank Step from the pop-up menu</td>
<td>Inserts a new blank step after the currently selected step. This is useful for adding comment steps. See Adding Comment Steps on page 15-28 for more information. This option is disabled if the sheet is not locked or the sheet state is Completed.</td>
</tr>
<tr>
<td>Mark the location where steps should be inserted</td>
<td>Choose Place Step Insertion Indicator from the pop-up menu</td>
<td>Designates where newly recorded steps should be added. When you choose this option, a visible marker appears. The next recorded step is inserted after the marker. Each time you add a recorded step, the marker moves down to the newly recorded step, so that steps are added in the order in which they were recorded. This option is disabled if the sheet is not locked or the sheet state is Completed.</td>
</tr>
<tr>
<td>Remove step insertion indicator</td>
<td>Choose Remove Step Insertion Indicator from the pop-up menu</td>
<td>When you click this option, the indicator is removed and any newly recorded steps are added to the end of the steps list. This action is only available when the step insertion indicator is showing.</td>
</tr>
<tr>
<td>Load the associated safety documents</td>
<td>Choose Load Safety Document(s)... from the pop-up menu</td>
<td>If any of the selected steps are associated to a safety document, then that document will be loaded for each step. The document type and number appear in the Operation column of the step when there is an association.</td>
</tr>
</tbody>
</table>
To perform this action: |
---|
Move the crew symbol to a new device in the Viewer |
Move a column in the Steps list |

Do this: |
Choose Move Crew from the pop-up menu |
Click the column heading and drag it to the desired position |

Comments |
When this option is selected for a step with a crew instruction, the crew symbol within the Viewer is moved to the device specified in that step. This feature is only used to move the crew symbol within the viewer. |
This allows you to rearrange the order in which columns are displayed. For example, if you want each step's status to display in the first column, click the Status column header and drag it to the left of the Step # column. |

---

**Steps Tab Header - Events and Crews**

The Steps tab header is displayed above the list of steps. The header shows the crews and events associated with the sheet.

Use the **Show Header** and **Hide Header** buttons on the Steps tab toolbar to display or hide the header.

---

**Events List**

The **Events List** lists all events associated with the switching sheet. If you created a switching sheet from the Work Agenda Event List, the associated event is automatically displayed in the Events list. Use this list to view, add, and remove event associations and to view more information about the events. (For more information about associating events to switching sheets, see **Event Associations** on page 15-59.)

The Events List displays the following fields and buttons:

- **Event** column displays the number of the associated event.
- **Association** column displays the type of association. The list can have the following types of associations and will be listed in the order of Master, Planned, Forced, Manual and Canceled. Manual event associations are event associations that are added using the Add Event Association button on this window.
- **# Out** column displays the number of customers outaged by this event.
- **Status** column displays the status of the event, such as NEW, P-NEW (New Planned Event), or W-ASN (Master Switching Event).
- **Device** column displays the name of the device.
- **Add Event Association** button opens a dialog box that allows you to enter an event number to associate with the switching plan. The event number can also be populated by selecting an event in the Work Agenda Event List. These events will show up as “Manual” associated events within the Events list. See **Event Associations** on page 15-59 for more information.
• The **Remove Event Association** button removes the selected event association from
the switching plan. This button is enabled only for Manual associated events. This option is
disabled if the sheet is not locked or the sheet state is Completed.

• The **Event Details...** button displays the Event Details window for the selected event.

• The **Call...** button displays the Trouble Info window for the selected event.

• The **Highlight in Work Agenda** button selects the event within the Work Agenda
Event List.

• The **Show in Viewer 1** button focuses Viewer 1 on the associated device.

**Crews List**

The Crews List displays crews that are assigned or en route to events associated to the switching
sheet. If you created a switching sheet from the Work Agenda Event List, any crew associations
are automatically displayed in the Crews list on the Steps tab header.

The Crews List displays the following information:

• The **Crew ID** column contains the crew ID of the crew.
• The **Event** column contains the event number the crew is assigned or en route to.
• The **Contact** column contains the contact name for the crew.
• The **Mobile #** column contains the contact's mobile phone number.
• The **Pager #** column contains the contact's pager number.
• The **ASN/ENR Date** column contains the date and time of when the crew w as assigned or
placed en route to the event shown in the Event # column.
• The **Status** column indicates whether the crew is assigned or en route to the event shown in
the Event # column.
• The **Type** column contains the crews' type (e.g., Trouble).

• The **Crew Info** button displays the Crew Information window for the selected crew. This button is enabled only if a crew is selected from the list. For more information, see **Associating Crews** on page 15-36.

• The **Update ‘Instructed To’ in Steps** button updates the Instructed To column for
the selected steps with this crew's ID. This option is disabled if the sheet is not locked or the
sheet state is Completed.

• The **Move Crew** button allows you to move a crew to the device associated with the
selected step. This button is enabled only when the selected crew is en-route or on-site to the
associated event.
Switching Sheet Step States
Switching sheet steps go through stages or states, just like switching sheets. Step states are described below:

- **No state** - No action is associated with the step.
- **Instructed** - The step was instructed.
- **Completed** - The step was successfully completed.
- **Partially Completed** - This state applies only to parent aggregate steps and indicates that some but not all child steps were completed.
- **SCADA Pending** - This state applies only to actions that the system identifies as SCADA actions (i.e., actions on telemetry-controlled devices). It indicates that a SCADA action was instructed.
  
  **Note**: If the system detects that the device was operated as instructed, the step state is then changed from SCADA Pending to Completed. If an error or timeout occurs, the step remains in SCADA Pending state.
- **Deleted** - The step was deleted from the sheet.
- **Aborted** - The step was marked as aborted by the user. (A step transitions to this state when the user selects the **Abort** option on the Steps toolbar.)
- **Failed** - The step was marked as failed by the user. (A step transitions to this state when the user selects the **Fail** option on the Steps toolbar.)

Note that a terminal action (Complete, Delete, Abort or Fail) must have been taken for each of the switching steps before a sheet can be completed.

Adding Recorded Steps to a Switching Sheet
Follow these steps to add recorded steps to a switching sheet using the Viewer and the Control Tool.

**Notes**:
For information about adding steps to an emergency switching sheet, see **Emergency Switching** on page 15-58.

To record safety state transition steps (i.e., steps that are associated to safety documents), see **Adding Safety State Transition Steps** on page 15-63.

1. Create or open a switching sheet (as described earlier) and display the **Steps** tab.
2. Select the step after which you want the recorded steps inserted. Right-click this step, then choose **Place Step Insertion Indicator** from the pop-up menu. By default, steps are added to the end of the list.
3. If the Viewer is not displayed, open a Viewer by clicking the **Viewer 1** button on the Web Workspace toolbar or selecting **Viewer 1** from the Tools menu.
4. Verify that Web Switching Management is in Study Mode.
   - To enable Study Mode, click the **Switch to Study Mode** button on the Steps tab toolbar. The status bar should display “Study Mode.”
5. Verify that Viewer is in Study Mode.
   - To enable Study Mode, select **Study** from the Options menu.
6. Verify that recording is enabled.
   - To turn recording on, click the Record Off button on the toolbar. When recording is enabled, the toolbar displays Record On in red.

7. In the Viewer, search for the device on which you want to perform an operation.

8. Double-click the device. The Control Tool opens.

9. Select the action you want to perform. For example, to open a device, click Operate and then select Open from the list of operations. To place a tag on a device, click Tag and then select Place Tag.

10. If the step involves a device operation, the Look Ahead window opens. Click Open or Close in the Look Ahead window to continue.

   Note: The Look Ahead window informs you of the results of the operation, including the creation of parallels and loops, the number of critical customers affected, and related abnormal devices and conditions. You may be required to view additional tabs, such as View Conditions, before you can close the Look Ahead window.

11. Click Cancel on the Control Tool dialog. The device is updated in the Viewer and a step is added to the steps list. The new step is automatically selected.

Adding Comment Steps

You can add comment steps that are not related to a specific device or operation. To add a comment step, select the step after which you want the comment step inserted. Right-click this step, then choose Insert Blank Step from the pop-up menu. Double-click in the Operation column to enable adding a description of this step; the Details column is also available for descriptive text.

   Note: You may enter text in the Operation, Details, Address, and/or Comments fields. You can also specify Date fields for the step. The other fields are populated automatically when you instruct and complete the step.

Resetting Operation Text

Operation text that has been manually entered may be reset to its original value by following the following steps:

   - Right-click to select the row and open the option menu.
   - Select Reset Operation Text. The Reset Operation Text dialog will open to confirm that you want to change the Operation text back to its original value.
   - Click Yes to reset the value.

   Note: click No to close the dialog and leave the Operation text unchanged.

Copying and Pasting Steps

You can copy or cut steps and then paste them to another location within the step list or into another switching sheet. When you cut steps, they are marked as ‘cut’ in the steps list and are copied into the clipboard. When you copy steps, they are copied to the clipboard, but the original steps are not marked or removed from the list.

   Note: The in-order step execution rules are not enforced when cutting and pasting steps. Switching steps that were previously completed can later be cut and pasted into any location within the step list. This also pertains to cutting and pasting steps from one sheet to another.

   If you cut and paste steps from one sheet to another, the system determines which events have associations with these steps and automatically moves the
corresponding event/sheet associations from the old sheet to the new sheet. If you attempt to move some but not all of the steps for an event, the system displays a confirmation dialog indicating the affected events. If you confirm the action, then both the old sheet and the new sheet will have an association to the affected events. Any step moves that affect event associations are recorded in the audit log for tracking purposes.

Follow these steps to use the cut, copy, and paste functions:

1. Select the steps you want to cut or copy.
2. Click the **Copy Steps** or **Cut Steps** button (or right-click the selected steps and choose **Copy** or **Cut** from the pop-up menu).
3. Select the step after which you want the steps inserted and click the **Paste Steps** button (or right-click the step and choose **Paste** from the pop-up menu). Any cut steps are moved, and copied steps are duplicated.

   **Note:** Once the step has been pasted, the Paste button is no longer available and the contents of the clipboard are cleared.

### Creating Go-Back Steps

When you are creating a switching sheet in Study Mode, you can automatically generate a sequence of switching steps to “go-back” to a normal state. The Go-back feature creates a new sequence of steps that reverses the existing sequence. For example, assume that Step 1 involves opening a device. If you select this step and choose Copy as Go-backs, the system creates a step to close that device and copies the step to the clipboard. You can then paste the step in the appropriate location in the step list.

To create go-back steps for one or more steps, do the following:

1. Select the step or the range of steps you want to create reverse actions for.
2. Click the **Copy As Go-Backs** button (or choose **Copy as Go-Backs** from the pop-up menu). Go-Back versions of the selected steps are copied to the clipboard.

   **Note:** If you selected one or more steps that are part of an aggregate step, all steps within the aggregate are automatically selected and copied as go-back steps. (An aggregate step is an operation, such as Open and Tag, that comprises two or more sub-steps, numbered a through z.)
3. Select the step after which you want the go-back steps inserted and click the **Paste Steps** toolbar button (or choose **Paste** from the pop-up menu). The steps are pasted after the selected step.

### Working with Blocks

Blocks are used to organize steps based on stages of execution. A block is a series of contiguous steps that can include both single (ungrouped) steps and groups of steps. The figure below shows
an “Isolate” block that is expanded to display 5 steps, and a “Restore” block that is collapsed so that its steps are hidden.

<table>
<thead>
<tr>
<th>Step #</th>
<th>Ver</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isolate</td>
<td>1</td>
<td>Open and Tag</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Place Tag</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Open and Tag</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Place Tag</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Open</td>
</tr>
</tbody>
</table>

Note the following when working with blocks:

• When you create a new sheet, the system creates an empty block named “Default.” When you add steps, they are added to this block by default. You can delete this block and create a new top-level block if you wish.

• The system provides several pre-configured block headers – Isolate, Fault Location, Maintenance, and Restore – or you can create your own custom header. The header is simply the block name that is displayed in the Steps list.

• To expand a block and display its steps, click the + symbol to the left of the block name. To collapse a block and hide its steps, click the - symbol.

• All steps within a block must be completed before a step within another block can be completed, unless the block names are the same and the blocks are adjacent (not separated by any blocks of different names). See the Parallel Step Execution on page 15-30 for more information about parallel execution of block steps.

Adding a New Block Header
To add a new block header to the steps list:

1. From the Steps tab, right-click the step after which you want to insert a block. A pop-up menu appears.

2. Select Add New Block Header, then select a block header type: Isolate, Fault Location, Maintenance, Restore, or Custom.

   Note: If you choose Custom, you are prompted to enter the block header name.

   A new block header row is added to the steps list.

Parallel Step Execution
Parallel execution allows an operator to direct one crew through a set of steps in one block and another crew through a set of steps in another block. This provides the operator more flexibility when executing switching steps and more closely correlates with their actual business process.

Blocks of steps with the same block names can be executed in parallel. The blocks must be sequentially listed and cannot be separated by different blocks of steps. For example, parallel execution is allowed when blocks are ordered as shown below (Isolate, Isolate, Restore, Restore).
Parallel execution is not allowed if blocks are separated by different block names, such as Isolate, Restore, Isolate, Restore.

When you execute a block step, the system checks to see if the previous block has the same name. If it does, the system ignores any incomplete steps within these blocks, but requires that you complete the steps within each block in order. If steps are grouped within a block, normal grouping rules apply. (See **Grouping and Ungrouping Steps** on page 15-31).

Below is an example of how you might create and execute a plan using parallel step execution:

1. Create a Planned switching sheet.
2. From the Steps list, right-click on the Default block step. Select **Add New Block Header** and then select the Isolate option.
3. Record one or more steps into the Isolate block for a single feeder.
4. Add another Isolate block at the end of the first block.
5. Record one or more steps into the second Isolate block for a different feeder.
6. Create two Restore blocks after the second Isolate block.
7. Create go-back steps for the first of the Isolate blocks. Paste the go-back steps into the first Restore block.
8. Repeat the previous steps to create and paste go-back steps into the second Restore block.
9. In Study mode, complete the first step in the first Isolate block. The step is completed.
10. Complete the first step in the second Isolate block. The step is completed.
11. Continue executing steps in parallel for both Isolate blocks and then both Restore blocks.

**Note:** Parallel execution is not required in this situation; it is simply available as an option.

**Grouping and Ungrouping Steps**

Normally, each step in a switching sheet must be completed in order — you cannot complete step 2 until step 1 has been completed. However, you can group two or more steps together so that the steps within the group can be completed in any order.

The following rules apply when grouping and ungrouping steps:

- All steps preceding a group must have been completed before you can complete any steps within the group.
- Steps within a group can be completed in any order.
- All steps within a group must be completed before the next step or next group of steps can be completed.
- Step groupings cannot cross over Block boundaries.
- Step groupings can be removed and altered (ungrouping and regrouping) at any time. Note that this may impact which steps can be completed next based on step completion rules.
This section includes the following topics:

- **Grouping Steps**
- **Ungrouping Steps**
- **Adding Steps to an Existing Group**
- **Grouping Aggregate Steps**

**Grouping Steps**

To group steps:

1. Select two or more contiguous steps. Remember that the grouping cannot cross Block boundaries.

2. Right-click and select **Group Steps** from the pop-up menu. A blue bracket appears in the step number column to visually indicate the newly formed grouping, as shown in the following figure:

   ![Grouping Steps Figure]

   **Note:** Groups cannot span more than one block. If you attempt to group steps that span two or more blocks, the system will create separate groups within each block.

**Ungrouping Steps**

You can ungroup some or all steps in a group. To ungroup steps:

1. Select one or more steps that are currently part of a group.

2. Click the right mouse button and select **Ungroup Steps** from the pop-up menu.

   The bracket is removed (if all steps were ungrouped) or redrawn to indicate the steps that remain grouped. If the selected steps were in the middle of a grouping, then two new groups are created, and the middle steps are no longer grouped.

**Adding Steps to an Existing Group**

You can add one or more steps to an existing group as follows:

1. Select the steps you want to add and include at least one step from the existing group.

2. Click the right mouse button and select **Group Steps**.

   The selected steps that were previously ungrouped are added to the existing group.

**Grouping Aggregate Steps**

An aggregate step is an operation, such as Open and Tag, that comprises two or more sub-steps (numbered a through z). An aggregate step is treated as a single step when grouping and ungrouping steps:

- If you add any sub-step of an aggregate step to a group, then all sub-steps are added to the group.
- If you ungroup any sub-step, then all sub-steps are removed from the group.
Editing Existing Steps

You can rearrange, add, and delete switching steps using options found on the Steps toolbar or from the Steps pop-up menu.

Notes on editing steps:

- You cannot edit steps after the switching sheet has been completed.
- Some fields on the switching sheet are not editable after a plan has transitioned to a certain set of states. For example, the Instructed Date and Completed Date fields cannot be updated after the step has reached a terminal state (completed, aborted, or failed).
- The Operation field is only editable for steps that do not change the network model, such as comments.
- Tabbing out of a cell can only be accomplished if the cell is not set up for word wrapping.
- The Details and Comments columns are the only columns configured for word wrapping. Word wrapping means the cell height will grow if the text in the field is too long to be displayed within the confines of the cell width.

To edit switching steps, complete these steps:

1. Open the switching sheet and check the status bar to make sure that the switching sheet is locked.
2. Click on the Steps tab.
3. Edit steps as follows:
   - To edit the fields in a step, double-click in the Details, Planned Date, Instructed Date, Completed Date, Comments or Address field and change the text.
   - To insert a blank step, place your cursor in the row after which you want to insert the step and select the right-click Insert Blank Step option.
   - To insert a recorded step, select the right-click Place Step Insertion Indicator option and then perform the action in the Viewer. Steps are inserted after the step that currently has the indicator. To record steps at the end of the steps list, remove the step insertion indicator first.
   - To delete a step, select the row for the step you want to delete and click the Delete button. This button is disabled if the step has transitioned beyond its initial state (No state).
   - To rearrange steps, cut and paste the steps to the desired location.
   - You can cut, copy and paste steps from one plan to another. The ability to cut, copy or paste is governed by the sensitivity of the edit options. (The options are disabled if the edit operation is not allowed.)
4. Save the switching sheet by selecting Save Sheet from the File menu.

Finding and Replacing a Device in the Steps

The Device tab of the Find and Replace dialog allows you to find and replace occurrences of a device in the switching steps. This is helpful for finding a device in a switching sheet that has many steps. You can also use this function if you are reviewing a switching sheet and find that the wrong device was entered in a number of places.

To find occurrences of a device within the Steps list, complete these steps:

1. Open the switching sheet in the Web Switching Management window.
2. Click on the Steps tab.
3. *(Optional) Select a step with a valid device name within the Steps list.

4. Click the **Find and Replace...** button on the Steps tab toolbar. The **Find and Replace** dialog box opens.

5. Click the Device tab, if not already selected. The Find field displays the selected step's device alias, if selected the optional step above. Otherwise, enter a device ID in the Find field.

6. Click the **Find Next** button to navigate through the list of steps, highlighting each occurrence of that device.

To replace a device, complete these steps:

1. Open the switching sheet in the Web Switching Management window.

2. Click on the Steps tab.

3. *(Optional) Select a step with a device that you wish to replace.

4. Click the **Find and Replace...** button on the Steps tab toolbar. The Find and Replace dialog opens. If a device ID was not preselected above, enter a device ID in the Find field.

5. Select a device from the Viewer. The Replace With field is populated with that device's alias. The New Phases column indicates the phase options of the newly selected device. By default, the ALL Phases option is selected.

6. If the device you are replacing is used in a grounding operation, click the **Ground Node** option menu and select the secondary device from the list.

7. Click **Replace**.

   **Note:** if you are replacing a device association on a step that has had its Operation text modified, a **Reset Operation Text** dialog will open asking you if you want to reset the operation text. You will have three options:

   - Click **Reset** to reset the text;
   - Click **Continue** to keep the manually entered Operation text.
   - Click **Cancel** to cancel the device replace.

   For more information, see **Resetting Operation Text** on page 15-28.

**Finding and Replacing Text in the Steps**

The **Text** tab of the Find and Replace dialog allows you to find and replace occurrences of text in editable fields within the switching steps.

**Note:** Not all editable fields allow Find and Replace; the project configuration determines what fields are editable.

To find occurrences of a device within the Steps list, complete these steps:

1. Open the switching sheet in the Web Switching Management window.

2. Click on the **Steps** tab.

3. Click the **Find and Replace...** button on the Steps tab toolbar. The Find and Replace dialog opens.

4. Click the Text tab, if not already selected.

5. Enter the search term in the **Find** field.

6. Click the **Find Next** button to navigate through the list of steps, highlighting each occurrence of that device.

7. To replace an instance of the search term, enter the replacement text in the **Replace with** field and click **Replace**. Repeat as necessary.
**Focusing on a Device in a Step**
When reviewing a switching sheet, you can focus on a device in the Viewer 1 window to better understand the conditions present in the area of the device. To focus the Viewer window on the device in a switching step, select a step on the Steps tab and then select the **Object Focus** button on the Steps tab toolbar. The Viewer loads the appropriate map and focuses on the device.

**Reviewing a Switching Sheet in Study Mode**
You can review the actions of a switching sheet in a Viewer window. With the Viewer and Web Switching Management both in Study Mode, you can complete steps by selecting a step and clicking the **Complete** button on the Steps tab toolbar.

As the steps are completed, each one takes effect in the Viewer window and the words “Study Completed” appear in the Status column in the steps section. Steps are completed starting with the first step and continuing sequentially, however it is possible to complete steps out of order if the steps are part of a step grouping. (See **Grouping Steps** on page 15-32.)

The Look Ahead window informs you of the results of the operation, including the creation of parallels and loops, the number of critical customers affected, and related abnormal devices and conditions.

**Replaying Steps**
You can replay steps in the Viewer window, allowing you to experiment with and make changes to a switching sheet. You can then add and delete switching steps and then select one of the two **Reset Study Session** options. After resetting your study session, you will be able to go through the steps again using the **Complete** button.

**Implementing a Planned Switching Sheet**
Once you have created, studied, and approved a switching sheet, you can implement the plan. Implementing involves the following steps:

- **Scheduling a Planned Master Event**
- **Issuing a Switching Sheet** (includes associating a crew and printing the sheet)
- **Instructing and Completing Switching Sheet Steps**

**Scheduling a Planned Master Event**
In order to schedule planned switching, you must have entries within the Start Date and Finish Date (ERT) fields on the Request tab. Note that if a Planned Event is partially restored, then the ERT is determined by taking the latest date from the restoration steps **Planned Date** values (see **Planned Date** on page 15-19). If only one of the restoration steps has a Planned Date value, then that value is used even if it is the first step to restore customers. The ERT of the Master event is only used when none of the restoration steps have Planned Date values.

**Note:** the calculated ERT is determined by using the Impacted Customer list, which must be generated for the functionality to work. If the list is not generated, then the ERT of the Master Event is used.

An optional device alias can also be specified within the Device field on this tab. Specifying a device will cause the planned Master Event to conform to the regular zone authority rules. If you do not have authority over the zone that the device resides in, then you will not see the planned Master Event that will be created when the switching sheet is scheduled.

To schedule a planned Master Event, complete these steps:

1. On the Request tab, fill in future dates and times within the Start Date and Finish Date entry fields.
2. To associate a particular device and control zone, select the device within the Viewer and click the **Link Device** button on the Request tab. If a device is not specified, then the Master Event will fall into the FUZZY control zone.

3. On the Tracking/Audit Log tab, click the button for the **Schedule** state. (If the Schedule button is not displayed, click through the available sheet state buttons until the Schedule button appears.) You can add a comment to each state transition if you wish.

   At this point, a new planned Master Event has been created and associated to the switching sheet. This new event appears in the Events list as a Master Event. You can display the Event Details for the event from either the Work Agenda Jobs List or the Events list on the Steps tab.

   **Note**
   - The **Event Details** display is different for planned events than for spontaneous outage events. For instance, you cannot update the ERT for a planned event from Event Details. That has to be done from the associated switching sheet.

**Updating the ERT in Event Details**

You can update the ERT for an event to match the date and time specified in the Finish Date field on the Request tab. The new date will be visible in Event Details the next time you load the event. To update the ERT, complete these steps:

1. Select **Switching**… from the Actions menu in the Event Details window. The associated switching sheet is loaded and the steps are displayed.
2. Select the **Request** tab and enter in a new Finish Date (ERT) date and time.
3. Select the **Update ERT** button, which is displayed next to the date and time entry fields. The Estimated Restoration Time (ERT) is changed for the associated Master Event within the Work Agenda Jobs List. The new date is displayed in the Event Details the next time it is loaded for that event.

   **Note:** This option is only available after the sheet has been scheduled. This button is displayed next to both the Finish Date and Alt. Finish Date fields. The button is grayed if no date has been entered yet for the field.

**Issuing a Switching Sheet**

Once you have scheduled the plan, you should associate crews to the planned Master Event and then issue the switching sheet to the crew.

**Associating Crews**

1. On the Tracking/Audit Log tab, verify that the switching sheet is in Scheduled state.
2. Find the Master Event for a planned switching sheet. (Right-click on the Master Event within the Steps tab Events list and click the **Highlight in Work Agenda** toolbar button.)
3. From the **Work Agenda Events List**, select the event. (Even though the event is highlighted, you must click on the event in the Work Agenda Events List in order to assign and dispatch crews to events.)
4. From the **Crew Actions** list, select the crew and then click the appropriate option on the Action menu: **Assign** or **En Route**. The Crew is listed in the Crew List on the Steps tab header, and the selected status is shown.

**Releasing Crews from an Event**

To release one or more crews from an event, select the master event in the **Work Agenda** and select **Release Crew(s)**… from the Actions menu. The **Release Crew(s)** window opens with a list of all crews assigned to the selected event. One or more crews may be selected:

- Click on a crew name to select one crew.
• Click, hold, and drag to select multiple adjacent crews.
• Control-click to select multiple non-adjacent crews.

Once the crew(s) have been selected, click **Release** to release the crews from the event.

The Release Crew(s) window will close, the crew will no longer be associated with the event, and the crew symbology will disappear from the Viewer.

**Pre-Assigning Steps to Crews (Optional)**

You can pre-assign steps to crews before issuing the switching sheet. With pre-assigned switching steps, the crew is automatically highlighted in the Crew List as the steps are instructed and/or completed. To pre-assign steps to a crew, select the appropriate steps and then select the crew from the Crew List found on the Steps tab. (To select all the steps, select a single step and then press <Ctrl>-A.) The Instructed To field for the selected steps is updated with the crew's ID.

**Note:** To clear (deselect) crew step assignments, select all the steps again, then press the <Ctrl> key and click the crew in the Crew List. The Instructed To column is cleared for all steps that have not been instructed, aborted, failed or completed.

The plan is now ready for the crews to work the steps.

**Changing the Sheet State to Issued**

When the plan is issued to the crew, change the sheet state to **Issued** on the Tracking/Audit Log tab. The sheet can now be printed (see the following section) and handed to the crew or sent via email, depending on how your crew assignments are handled.

**Adding and Removing Event Associations**

Use the **Add Event Association** button in the Steps tab header to associate an event with the switching plan. You can enter the event number or select an event in the Work Agenda Event List. The event will show up as a “Manual” associated event within the Events list.

Use the **Remove Event Association** button to remove a manual event association from the switching plan. This button is enabled only for Manual associated events.

See **Event Associations** on page 15-59 for more information.

**Printing the Switching Sheet**

To print the switching sheet:

1. Choose **File>Print** from the Web Switching Management window or click the **Print** button on the main toolbar.

2. Select each section of the switching sheet you want to print:
Planned Switching

3. Select the format for the print-out:
   - PDF
   - HTML
   - RTF
   - XML

4. Click OK. The Print dialog appears.

5. Verify that your printer is selected and click Print.

Instructing and Completing Switching Sheet Steps

Once you have scheduled and issued a switching sheet, you are ready to instruct and complete the switching sheet steps. Instructing a step indicates that you have provided the step information to the individual performing the switching actions in the field.

Overview

Note the following key information about instructing and completing steps:

- Instructing steps is only permitted in real-time mode.
- In order to begin instructing switching sheet steps, the sheet has to be Issued first. The Instruct and Complete buttons become enabled in real-time mode when the plan reaches the Issued state.
- Steps cannot be instructed out of order. (You cannot instruct step 2 before you instruct step 1.)
- Steps are not required to be instructed before being completed. It is up to you to decide if the step should be instructed first.
- To complete a switching sheet, the Web Switching Management window must be in real-time mode. (You can complete steps in Study Mode, but these actions do not affect the real-time data model.)
- Although a Viewer window does not need to be open to complete switching steps, it is helpful to view the steps in a Viewer window. The Viewer must be in real-time mode as well.
- For steps involving device operations, you must have authority over the zone where switching operations will take place, or the system will not allow you to complete the switching steps.
- If you attempt to operate a device to its current state, such as closing a device that is already closed, a dialog informs you that the device is already in its desired state. You can continue or cancel the operation. If you continue, the system marks the step as completed or instructed (depending on your action). If you cancel, no action is taken.

Note: This behavior applies only if the Control Tool operation (such as Close) is configured to be sensitized in the current situation. If the Control Tool does not support a Close operation when the device is already closed, then Web Switching Management will display an error indicating that the action is not
valid. Switching step actions use the sensitivity rules configured on the Control Tool to determine what actions can be instructed or completed from Web Switching Management.

**Instructing and Completing Steps**

To instruct and complete steps:

1. Verify that the Web Switching Management window and the Viewer are in real-time mode.
2. On the Tracking/Audit Log tab, verify that the status of the sheet is Issued.

**Instructing the Step**

3. Select the step you want to instruct.
4. If a crew was assigned to the switching plan and was not pre-assigned to any steps, then select the crew from the Crew List in the Steps tab header. (See the previous sections for instructions on associating crews to switching sheets and pre-assigning steps.)

   **Note:** Automatic Crew List selection is based on the crew specified in the Instructed To field of the selected step. If the step does not display a crew in this field, then no crew will be selected in the Crews List.

5. When you give the instruction to the crew, click the **Instruct** button on the Steps tab toolbar.
6. If the step involves a device operation, the Look Ahead window opens. Click **Open** or **Close** in the Look Ahead window to continue with the step. (You may be required to view conditions associated with the operation before you can perform the operation.)

   The status of the step changes to Instructed. The Instructed To column is populated with the assigned crew's ID, and the Instructed Date column is populated with the current date/time. An Instructed symbol appears on the device in the Viewer.

   If the step involves issuing a safety document to a crew, then the value in the step's Instructed To field is copied to the safety document Crew ID field when the step is completed.

**Notes on SCADA Actions:**

If the step involves actions on a SCADA control and no crew has been selected, a confirmation dialog displays the following text: “Do you wish to send this request to SCADA?” If you click **Yes**, the step is instructed to SCADA, the request is sent to SCADA, and the status of the step is set to SCADA Pending. If you click **No**, the request is not sent to SCADA and the step is set to SCADA Pending (it will wait for telemetry in order to complete the step). This may be the case if a crew were instructed to perform the operation instead of a SCADA system. If you click **Cancel Action**, the operation is cancelled.

If the SCADA interface reports that the device was indeed opened, the step status is then updated to Complete. The switch opens in the Viewer and the instruct condition disappears.

If you select the Complete button before receiving information from SCADA, a confirmation dialog displays the following text: “SCADA telemetry only for selected device. Submit a manual entry?” If you click **Yes**, the status of the steps is set to Completed, and the switch opens with status of M (for MANUAL entry) in the Viewer. If the SCADA interface reports that the device was indeed opened, the MANUAL indicator disappears. If you click **No**, the action is cancelled.

For more information about SCADA, see **SCADA Extensions** on page 13-1.

**Completing the Step**

7. After the crew reports that the step is complete, select the step and click the **Complete** button.
8. If the step is a safety state transition step, then selecting the Complete button will cause the safety document dialog to be displayed. Verify that the information on the safety document is correct and click the Execute button at the bottom of the display to complete the action. (For more information, see Executing Safety State Transition Steps.

    Note: All safety documents must be completed before you can complete the switching sheet. Also, in order to complete an Issue Safety State transition step, a crew must be specified in the Assigned Crew field. You can specify a crew by doing one of the following:
    • Select a crew within the Crew List on the Steps tab.
    • Select the Crew List button next to the Assigned Crew field on the safety document, then select a crew from the Select Safety Crew dialog.

9. Repeat steps 3-8 for each switching step you want to instruct and complete.

Recording Additional Steps in Real Time

10. Additional steps may be added to the switching sheet in real time when it is in the ‘Issued’ state. Click the record button and proceed to record the actions as issued.

Completing the Switching Sheet

11. When all steps have been completed, click the Tracking/Audit Log tab and set the sheet state to Completed by clicking the Complete button. The Confirm State Transition dialog will open; click Yes to confirm the completion or click No to close the dialog without completing the sheet. The Finish Date may be updated, if necessary.

12. Optional: add a comment in the text field to the right of the Complete button.

    If any associated event has not been restored or if any safety document has not been completed, an error message is displayed indicating that the sheet cannot be completed.

    Once the sheet is in the Completed state, any planned outage events are completed along with the planned master event. Any crews assigned or en route to the events are released as well.

    Note: Once all the steps in a switching sheet are complete, the plan itself is considered complete. Setting the sheet state to Completed “locks” the switching sheet so that no further modifications may take place for this sheet. A Completed sheet cannot be transitioned to any other state.

Moving a Crew

Crews are automatically relocated as steps are instructed to them. As steps are completed, crews are moved to the appropriate device based on the remaining instructed and non-complete switching steps. If all steps have been completed, the crew is moved back to the master device or the previously operated device, depending on the configuration. (If configured to go back to the master device and one is not given, then the crew disappears from the Viewer.)

You can manually move a crew to the device associated to the selected switching step. This option is available only if the step is instructed and has been instructed to a crew. This option allows you to move a crew to a different device when multiple steps have been instructed to a crew.

To move a crew to a device, follow these steps:

1. Associate the crew to the planned switching sheet as described in Associating Crews.
2. Transition the sheet to the Issued state, if it is not already.
3. Select the crew within the Crew List on the Steps tab header.
4. Instruct all steps in the sheet. Note that within the viewer, the crew initially moves from master device to the first instructed device and then to the next.

5. From the Steps list, right-click on an instructed step and select **Move Crew** from the pop-up menu. The crew moves to the device associated to the selected step.

### Working with Switching Sheet Versions

Switching sheets use a version control mechanism in order to keep operators and crews consistent with regards to which switching sheet they are viewing. The switching sheet as a whole has a version number, and steps can also have version numbers.

The following describes how sheet version control works and presents examples of how the version and editing mode change as actions are taken on a switching sheet.

- When you first start a sheet, the sheet version is 1. The sheet’s version number and editing mode are displayed in the **Status Bar** at the bottom of the switching sheet. The new sheet is considered to be in Editing mode until it is checked in.

<table>
<thead>
<tr>
<th>Action</th>
<th>Resulting Version and Editing Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial sheet is created</td>
<td>Version: 1 (Editing)</td>
</tr>
</tbody>
</table>

- When the sheet transitions to Issued state or whenever a switching step is instructed or completed in real-time mode, the system automatically checks in the current version of the switching sheeting, but the version number is not incremented until you make changes, which will create a new version.

<table>
<thead>
<tr>
<th>Action</th>
<th>Resulting Version and Editing Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheet transitions to Issued State, triggering automatic check-in</td>
<td>Version: 1 (Checked In)</td>
</tr>
</tbody>
</table>

- If you make switching step changes after the sheet has been checked in or change any field in the sheet, the system automatically creates a new version and increments the sheet’s version number.

  **Note:** Your system’s configuration determines which fields trigger a version change when edited. By default, a new version is created when any field is changed.

<table>
<thead>
<tr>
<th>Action</th>
<th>Resulting Version and Editing Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steps are added, triggering version update</td>
<td>Version: 2 (Editing)</td>
</tr>
</tbody>
</table>

- You can manually check in changes at any time. This creates a saved version of the sheet that you can refer back to later. It also makes the checked-in version available to other users who view the sheet. The Check In button is displayed in the **Status Bar** at the bottom of the switching sheet when the sheet is in Editing mode. When you click the Check In button, the current version is checked in, and the Check In button changes to Create New Version.

<table>
<thead>
<tr>
<th>Action</th>
<th>Resulting Version and Editing Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>User manually checks in version, using Check In Version option</td>
<td>Version: 2 (Checked In)</td>
</tr>
</tbody>
</table>
You can manually increment a sheet's version after the sheet has been checked in using the Create New Version button. When you manually increment the version, the system creates a new version of the sheet in Editing mode.

<table>
<thead>
<tr>
<th>Action</th>
<th>Resulting Version and Editing Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>User manually increments version</td>
<td></td>
</tr>
<tr>
<td>using the Create New Version option</td>
<td>Version: 3 (Editing)</td>
</tr>
</tbody>
</table>

You cannot make changes to a switching sheet after it has been completed. Once a sheet is completed, it is locked and cannot be edited any further.

**Step Versioning**

Steps also have version numbers. The step version number is the version number of the sheet when the step was added. A step's version number is displayed on the Steps tab to the right of the step number.

If you add steps to a checked-in switching sheet, the sheet version is automatically incremented and the newly added steps are associated with this new sheet version number. This allows you to easily distinguish between steps that were previously issued to a crew and newly added steps.

To see the differences between the current version and a previous version, open the version drop-down on the status bar, then select the version to compare against.

When you select a version, the Step # column uses outline numbering (1.1, 1.2) to identify steps that were added since the previous version.

If you delete a step when the switching sheet version is checked-in or when an earlier version of the step exists, then the step is removed from the current version. If you view a previous version in which the step existed, the deleted step is shaded red.
Viewing Impacted Customers

Important Note: Service Alerts for planned events are triggered by the Impacted Customers List. Alerts will not be sent if the Impacted Customers List is not generated.

The Impacted Customers tab displays a list of all customers affected by the switching step operations. It also shows the total number of customers in the interrupted, isolated, and restored states:

- **Interrupted**: customer had power at the start of the switching operation, lost power (at some point) during the operation, and had power again at the end of the operation.
- **Isolated**: customer had power at the beginning of the operation and had no power at the end of the operation.
- **Restored**: customers who were without power at the start of the operation and had power at the end of the operation.

The following rules apply to the Impacted Customer list:

- The list can only be generated after a switching sheet has transitioned to Prepared status (or further).
- Whenever the system determines that a plan will impact customers, the Impacted Customers indicator is displayed on the status bar. If the sheet is later changed and customers are no longer impacted, then the indicator is removed.
- If a customer will be impacted multiple times during a sheet's execution, the customer is listed multiple times in the list.
- If no Planned Dates are specified for the device operations relating to an item in the list, then the dates will come from the sheet's Start and Finish Dates.
- The list can only be regenerated in study mode, since it displays the list of customers that will be impacted when the plan is executed and it uses your study session to calculate that list. See Generating the List on page 15-45 for more details.
- The list is not affected by the Real-Time execution status of the steps. The Work Agenda, Event Details, and Event Log are the source for Real-Time outage data.

This section includes the following topics:

- Using the Impacted Customers Tab
- Color Coding
- Generating the List
- Deleting and Restoring Customers from the List
Using the Impacted Customers Tab

The Impacted Customers tab displays a list of impacted customers in a hierarchical, or tree, format, similar to Microsoft Windows Explorer. The top level of the hierarchy is date/time the customer is impacted. Within date/time, the list displays each supply node along with the restore date/time. Within each supply node is a list of customers. You can expand or collapse any level of the hierarchy by clicking the + or - icon.

The Impacted Customer list displays the following fields and buttons:

- **# Interrupted** displays the number of customers who will be interrupted (Isolated and Restored) by the operations performed in this switching sheet.
- **# Isolated** displays the number of customers who will be isolated by the operations performed in this switching sheet.
- **# Restored** displays number of customers who will be restored by the operations performed in this switching sheet.
- **Name** displays different values depending on the type of row being displayed. There are three levels of information in the list:
  - **Impact Date** (level 1) displays the date the customers were impacted. If the customers were not impacted by the switching steps in this switching sheet, but are being restored, then this date will be the start date of the switching sheet.
  - **Supply Node/Transformer and Restore Date** (level 2) displays the transformer alias the customer is found on within the model, followed by the Restore Date. The Restore Date is based on the Planned Date for the device or, if no Planned Date was specified, the Finish Date of the switching sheet. Isolated transformers display “No Restore Date”.
  - **Customer Name** (level 3) displays the customer’s name.
- **Account Number** displays the customer's account number.
- **Meter Number** displays the customer's meter number.
- **Critical** displays whether the customer is a critical customer or not.
- **Address** displays the customer's street address.
- **City** displays the customer’s city.
- **Zip** displays the customer’s zip code.
- **Phone** displays the customer's phone number.
- **Result** displays the result of the impact, such as Restored or Interrupted.
Buttons

- The **Rebuild the Impacted Customer List** button regenerates the list based on the most current information in the switching sheet. Each time you rebuild the list, it is saved to the database. The application uses your Study model to determine the Impacted Customers. Your study model should be set up or reset appropriately before generating the list.

- The **Reset all Deleted Impacted Customers** button resets all impacted customers that were previously deleted from the list.

- The **Print Preview** button opens the Report Format dialog, from which the output format can be selected. The output will include the switching sheet header information and the Impacted Customer list.

- The **Print** button opens the Report Format dialog, from which the output format can be selected. A hard copy of the switching sheet header information and the Impacted Customer list will be generated on the printer you select.

- The **Focus** button focuses the primary Viewer on the selected device.

Color Coding

Rows (customers) on the list are color-coded to show the status:

- Green - Restored
- Yellow - Isolated
- Red - Deleted
- No background - Interrupted

Generating the List

To generate the Impacted Customer list, follow these steps:

1. On the Request tab, verify that a Start Date and Finish Date have been entered for the sheet. The system uses these fields to generate the Impacted Customer list and the estimated restoration time for each customer. The start of outage is the Start Date of the switching sheet, and the restoration time is the Finish Date.

   **Note:** If a Planned Date is specified for a particular operation on the Steps tab, then the Planned Date, rather than the sheet's Start and Finish Date, is used to generate the impacted customer list for that operation.

2. Make sure that you have added all necessary steps to the switching sheet, and that the sheet is ready to be worked. The steps do not need to be completed to produce the list.

3. On the Steps tab, click the **Reset Study Session** button on the toolbar, then select **Real-Time** or **Nominal**. At this point, you can update your study session within the Study Viewer to depict what the model will be like when the work is carried out.

4. On the Impacted Customers tab, click the **Rebuild Impacted Customer List** button on the toolbar. The list is generated and displayed.
Deleting and Restoring Customers from the List

To remove a customer from the list, right-click the customer and select **Delete** from the pop-up menu. The row is highlighted in red.

**Note:** Removing the customer from the list does not remove the customer from the model; it simply marks the customer as deleted from the list. If you regenerate the list, the customer will still be marked as deleted. If the customer is impacted multiple times, then that customer will be marked as deleted in each of the lists.

To restore (un-delete) a customer, right-click the customer and select **Undelete** from the pop-up menu.

To restore all previously deleted customers, click the **Reset all Deleted Impacted Customers** button. All red highlighting is removed.

Moving Customers

If you realize that a customer has been incorrectly associated with a device, you may need to move a customer from a device that will be impacted to a device that will not be impacted. To move customers from their current device to another device, complete these steps:

1. On the Impacted Customers tab, select the row for the customer you want to move.
   
   **Note:** You can only move one customer at a time.

2. Right-click and select **Move Customer...** from the pop-up menu. The Move Customer dialog box opens, displaying the customer name, address, and their original device.

3. Click on the new device in the Viewer. The New Device field on the Move Customer dialog is populated with the selected device.

4. Click **OK**. The system determines whether or not the new device is also an impacted device.
   
   If the new device is not an impacted device, the customer is moved to the new device and is removed from the impacted customer list.

   If the new device is an impacted device, a confirmation dialog box is displayed. Do one of the following:

   • Click **Yes** to continue with the move. The customer is moved to the new device within the Impacted Customers list. If the selected customer was previously moved to a new device, another confirmation dialog is displayed. Do one of the following:

     • Click **Yes** to continue with the move. The existing customer move record is overwritten.

     • Click **Cancel** to return to the Move Customer dialog so you can select a different device.

     • Click **No** to cancel the move and close both the confirmation dialog and the Move Customer dialog.

   • Click **No** to return to the Move Customer dialog so you can select a different device.

   • Click **Cancel** to cancel the move and close both the confirmation dialog and the Move Customer dialog.
Checking for Overlaps

Once you have created steps for a planned event, generated the Impacted Customers list, and saved the switching sheet, you can cross-check switching sheets for overlap of date/time, control zone and affected devices within a specific time period. This allows planners to create a single planned event instead of two separate events and avoid visiting the same location twice or impacting the same customers twice within a short time frame. Planners can identify whether to change the current switching sheet in order to avoid affecting the same customers or same area multiple times in a certain time period.

**Note:** When an overlap occurs, the system does not prevent you from completing planned switching operations, but it does provide a warning indicating the overlap.

Overlap checking is performed automatically when a sheet changes state. If the current plan has a time, control zone, or device overlap with another plan, then the Overlap indicator is displayed on the switching sheet **Status Bar**. Use the Overlaps tab to view details about the overlaps.

This section includes the following topics:

- Using the Overlaps Tab
- Color Coding
- Updating the Overlaps List
- Viewing an Overlapping Switching Sheet

Using the Overlaps Tab

The Overlaps tab displays the following fields and buttons:

- The **button updates the Overlaps list based on the current settings.
- The **Range** drop-down allows you to specify how to use the From and To dates. Options are:
  - Sheet Start and Finish Dates
  - +/- 1 day
  - +/- 1 week
  - +/- 1 month
  - +/- 1 year
  
  For example, if you select Sheet Start and Finish Dates, the system updates the From and To dates to match the sheet's Start and Finish dates entered on the Request tab. If you select +/- 1 week, the system displays overlaps that are within one week of the sheet's Start and Finish dates (up to one week prior to or one week after).

- The **From and To** fields specify the range of dates for which you want to view overlaps. These fields are automatically populated based on your selections in the Range field. If you manually enter values in the From and To fields, those values will override what was selected in the Range field.

- The **Filter By** drop-down allows you to specify the type of overlaps you want to view: Devices, Control Zones, or Time. See **Updating the Overlaps List** on page 15-48 for details.

- The **Overlaps** table displays a row for each switching sheet that has an overlap with the active switching sheet (and meets the criteria specified above). The blank edit boxes at the top of each column allow you to filter the Overlaps list. See **Viewing an Overlapping Switching Sheet** on page 15-48 for details.
  - The **Sheet #** displays the switching sheet number that contains the overlaps.
- The **Type** column displays the type of switching sheet.
- The **# Devices** column displays the number of device overlaps.
- The **# Zones** column displays the number of overlapping control zones.
- The **# Hours** column displays the number of hours the sheet overlaps with the current sheet. This value is based on the dates specified in the Start and Finish date fields on each of the switching sheets.
- The **# Supply Nodes** column displays the number of impacted nodes shared by the two switching sheets.
- The **# Customers** column displays the number of impacted customers shared by the two switching sheets.
- The **User** column displays the user ID of the requestor of the switching sheet.
- The **Start Date** column displays the start date of the switching sheet.
- The **Finish Date** column displays the finish date of the switching sheet.

The list on the Overlaps tab supports **Quick Sorting** and **Dynamic Filtering**.

**Color Coding**

Rows on the Overlaps tab are color coded to indicate the type of overlap:

- **Gray**: the switching sheets have an overlap, but the overlapping times on the sheets are in the past.
- **Red**: The switching sheets have device overlaps.
- **Orange**: The switching sheets have control zone overlaps.
- **White**: The switching sheets overlap in time only.

**Updating the Overlaps List**

Use the fields at the top of the Overlaps tab to re-generate the Overlaps list for a different time period or to show different types of overlaps.

To update the Overlaps List:

1. Use the **Range** and **From/To** dates to specify the time period for which to display overlaps.
2. From the **Filter By** drop-down, select the type of overlaps you want to list. For example, if you want to show only switching sheets that have device overlaps within a specified date range, select **Devices** from the drop-down.

3. Click the **Update** button to refresh the list based on your selections.

4. Standard filtering and sorting options are available for the results list. See

**Viewing an Overlapping Switching Sheet**

To view an overlapping switching sheet, double-click on the entry within the Overlaps List. The switching sheet opens in a new tab. Alternatively, you can right-click on the entry and select **Open Switching Sheet** from the pop-up menu.
Saving and Loading View Areas

While working with a switching sheet, you may often want to return to the same area of the map. Web Switching Management allows you to save an area of the map, called a view area, so that it can be loaded again later. This allows you to quickly focus the Viewer on a particular section of the model.

You can save multiple view areas for each Viewer. You can assign a description to each view area that identifies its contents and purpose. You can also select a saved view area to be loaded automatically into a Viewer when the switching sheet is opened.

This section includes the following topics:

- Using the View Areas Tab
- Saving a Viewing Area
- Loading a Saved Viewing Area
- Reloading all Auto-Load Viewing Areas
- Deleting a Saved Viewing Area

Using the View Areas Tab

Use the View Areas tab to save and load view areas. This tab displays the following fields and buttons:

- The Auto-Load in Viewer drop-down allows you to select the Viewer into which this viewing area will be loaded when the switching sheet is opened or focused upon. For example, if you shift your focus from one sheet to another, then the sheet that regains focus will reload its auto-loaded view areas.

- Description is the description of the saved viewing area. The default description is “View Area #,” where “#” is a uniquely generated ID number. You can change this description up until the associated switching sheet has reached the Completed state.

- The toolbar button allows you to save the map area that is currently displayed in Viewer 1.

- The toolbar button allows you to save the map area that is currently displayed in Viewer 2.

- The toolbar button allows you to load the selected viewing area to Viewer 1.

- The toolbar button allows you to load the selected viewing area to Viewer 2.

- The toolbar button allows you to delete the selected viewing area.

- The toolbar button allows you to reload all viewing areas marked for auto-loading.

Saving a Viewing Area

To save a viewing area, complete these steps:

1. In the Viewer window, navigate to the area of the map that you want to save as a viewing area.

2. On the View Areas tab in the Web Switching Management window, click one of the Save Map buttons on the toolbar.
• Click [1] to save the map area that is currently displayed in Viewer 1.

• Click [2] to save the map area that is currently displayed in Viewer 2.

The new view area is added to the bottom of the list of saved views on the View Areas tab.

3. In the Description field, enter a meaningful name that describes the viewing area.

4. If you would like this viewing area to be loaded automatically the next time this switching sheet is opened, select the Viewer from the Auto Load in Viewer drop-down.

   Note: The application will only allow you to select one saved viewing area to be auto-loaded for each Viewer.

Loading a Saved Viewing Area

After a viewing area has been saved for a switching sheet, you can quickly load the viewing area into the Viewer window.

To load a saved viewing area, complete these steps:

1. On the View Areas tab, select the viewing area you want to load.

2. Click the appropriate button to load the viewing area into the desired Viewer (or use the right-click pop-up menu options):

   • Click [1] to load the selected viewing area to Viewer 1.

   • Click [2] to load the selected viewing area to Viewer 2.

   The selected viewing area is displayed.

   Note: If the Viewer you selected is not running, a message is displayed.

Reloading all Auto-Load Viewing Areas

Use the Reload button on the View Areas tab to re-load all viewing areas marked for auto-loading. (The Auto Load in Viewer column indicates which viewing areas are specified for auto-loading in each Viewer.)

   Note: If no Viewers are running, a message is displayed.

Deleting a Saved Viewing Area

To delete a saved viewing area that you no longer need, complete these steps:

1. On the View Areas tab, select the viewing area you want to delete.

2. Click the Delete button (or right-click and select Delete View Area from the pop-up menu).

   The viewing area is removed from the list.
Viewing the Audit Log

The Tracking/Audit Log tab displays the current state of the switching sheet and allows you to transition to a different state. You can provide comments to explain the reason or circumstances around the transition. See Changing the Switching Sheet State on page 15-16 for more information, including valid switching states.

The Audit Log table contains a list of status changes the sheet has gone through since it was created. An entry is added to the log whenever changes occur to the sheet state, including (but not limited to) status changes, sheet ownership changes, generation of the impacted customer list, and sheet version check-ins.

The Audit Log table contains the following fields and buttons:

- **Entry Date** displays the Date and Time when the change was made.
- **Sheet Version** displays the version of the sheet when the change was made.
- **Sheet State** displays the state of the sheet when the change was made. (See Switching Sheet States on page 15-16 for state descriptions.)
- **Entry By** displays the user who initiated the change.
- **Details** displays a brief description of the audit entry.

**Note:** You cannot change any information for existing entries in the audit log table.

As with other list displays, you can click and drag column headers to rearrange the order of columns. You can also resort the list by clicking on the Entry Date column header. By default, log entries are displayed in ascending chronological order.

Emailing Switching Sheet Data

At any time during the process of editing or viewing a switching sheet, you can email the switching sheet data to one or more recipients. The switching sheet data will be sent as an email attachment in a chosen file format.

**Note:** Your email client will be used for sending the email. Depending on your email client, some attachment behavior may be different than described. If you do not have an email client installed and set up on the PC from which you are running Web Switching Management, you will not be able to email switching sheet data.

1. Click the **Send Email** button on the toolbar.
2. From the pop-up dialog, check the box for each section you want included in the email data:
   - Request
   - Events and Crews
   - Switching Steps
   - Impacted Customer List
   - External Documents
   - Safety Documents
   - Audit Log
3. Choose the email format: PDF, RTF, HTML, or XML.
4. Click **OK**.
   - The Subject field is automatically populated; you can edit this field if you wish.
   - The selected data is attached to the email.

   **Note:** depending on your configuration, you may be given the option to name the switching sheet data attachment prior to the file’s attachment; the standard configuration will always name the file according to the sheet type and number (e.g., Planned_1003.pdf).

5. (Optional) Enter any text you want to include with the message.

6. **Send** the message according to your email client’s functionality.

**Automatic Emails**

Based on your system’s configuration, emails can be automatically sent to an individual recipient or group and to the requesting user. Automatic emails are normally initiated after a switching sheet state change. For example, if a plan is rejected, the requesting user will be sent an email message indicating that the request was rejected and the reason for the rejection.

**Adding External Documents to a Switching Sheet**

Use the External Documents tab to attach documents to the switching sheet. These documents may be images, such as JPEG or BMP files, Word documents, Excel spreadsheets, or any other supplemental documents. These documents are stored in the database, so shared file systems are not needed.

This section includes the following topics:

- Using the External Documents Tab
- Adding an External Document
- Removing an External Document
- Saving an External Document to Another Location
- Opening and Editing an External Document
- Troubleshooting Issues with External Documents

**Using the External Documents Tab**

The External Documents tab displays the following fields and buttons:

- **Name** is the name of the external file. This field cannot be changed.
- **Length** is the number of bytes in the file. This field cannot be changed.
- **Modified Date** is the date the file was last modified or saved. This field cannot be changed.
- **Description** is a user-defined description. You can enter up to 4000 characters in this field.
- **Status** is the status of the document. When you initially add an external document, its status is New; when you save the sheet, its status is cleared. If you delete an external document, its status is set to Deleted until you save the sheet. If you load and modify the document from this tab, then its status is set to Modified.

   - The **Add** button allows you to add an external document. See **Adding an External Document** on page 15-53. (See the next section for details.)

   - The **Delete** button deletes the selected external document(s). See **Removing an External Document** on page 15-53.
• The **Open** button allows you to open the selected document. See *Opening and Editing an External Document* on page 15-53.

• The **Save a copy to a directory...** button allows you to save a copy of the selected document to a directory of your choice. See *Saving an External Document to Another Location* on page 15-53.

**Adding an External Document**

To add an external document to the active switching sheet:

1. Click the **External Documents** tab.
2. Click **Add** button on the toolbar.
3. From the Select Files window, select the files you want to add to the sheet and click **Select Files**. The External Documents tab displays the selected files in green. This indicates that the files have been selected, but have not yet been saved.
4. In the **Description** field, type a description of each file that will convey its contents and purpose.
5. Click the **Save Sheet** button to save the selected documents to the database. The documents are no longer displayed in green, indicating that the documents have been saved.

**Removing an External Document**

To remove an external document from a switching sheet, do one of the following:

1. Click the **External Documents** tab.
2. Select the document you want to delete and click the **Delete** button (or right-click the document and choose **Delete** from the pop-up menu). The status of the selected document is set to Deleted, and the file is displayed in red.
3. Click the **Save Sheet** button to save your changes. The document list is updated and the file is removed from the database.

   **Note:** The file is deleted from the database, but the local copy of the file on your PC is not removed.

**Saving an External Document to Another Location**

When you add a document to the external documents list, the system saves the document to the database. If you want to save a copy of the current version of the document on your PC, follow these steps:

1. From the **External Documents** tab, select the document and click the **Save a copy to a directory...** button (or right-click and select **Save As**). The **Save to** dialog is displayed.
2. Browse to the directory where you wish to save the copy.

   **Note:** Do not specify a file name. The file is saved to the specified directory using the original file name.
3. Click **Save to**. A copy of the current database version of the document is saved to the specified directory.

**Opening and Editing an External Document**

External Documents may be opened for inspection or to edit depending on the state of the switching plan. If the plan is unlocked (see *Locking and Unlocking a Switching Sheet* on page 15-9), the document will be opened in Read Only mode; if the plan is locked, the document will be opened with Write permissions.
**Opening an External Document**

To open an external document:

1. Click the **External Documents** tab.

2. Select the document you want to open and click the **Open** button (or right-click the document and select **Open**). The file is extracted to a local temporary directory and opened in the application associated with the file extension.

   **Notes:** If the file extension, or type, is unknown or the application is not available, a message will be displayed indicating that the application is unknown.

**Editing an External Document**

If the file was opened from a locked sheet, it will be available to edit.

1. Make changes to the document as necessary.

2. Save and **close** the document; the database will be updated with the changes made in the extracted (temporary) document.

**Troubleshooting Issues with External Documents**

It is best to close the document after it has been edited and saved due to conflicts that can occur if the local file is saved outside of the control of Switching Management.

When the switching sheet opens, the database attempts to extract the external document to the temporary folder and compares the date stamp of its version to the local copy. If the file in the temp directory is newer than the database version, it gives a warning that changes to the local file will not be saved (because the plan was unlocked):

Once you click **OK**, the database will overwrite the local changes with the saved version of the external document, which is stored in the database.

If the extracted document is still open when the database attempts to restore the saved version, a file lock conflict will result in another warning to inform you that the system cannot extract the database version of the document to the temporary folder and request that you take action to remove the conflict:
To remove the conflict, perform the following steps:

- On the warning dialog, click **OK**.
- Close the external document.
- In the switching plan window, click any tab other than External Documents (*e.g.*, Steps), and then click the External Document tab again. The system will extract the database version of the external document to the temporary directory.

### Opening an Existing Switching Sheet

Depending on how a switching sheet is being worked, there are a number of ways for you to load an existing switching sheet.

- **Open a Switching Sheet from Web Switching Management**
- **From any of the Work Agenda Jobs Lists**
- **From the Event Details**
- **From Crew Actions**
- **From the Control Tool**

#### Open a Switching Sheet from Web Switching Management

To open a switching sheet from the Web Workspace with Web Switching Management window:

1. From the **File** menu, select **Open**, and then select **Switching Sheet...**. The **Open Switching Sheet** window opens. Existing switching sheets are listed in the tabular view; the rows are color-coded to reflect switching sheet status:
   - **Green**: In Progress
   - **Red**: New
   - **Bright Yellow**: Scheduled, Checked, or Approved
   - **Pale Yellow**: Prepared
   - **Orange**: Requested
   - **White**: Hold/Pending

*Note*: product configuration is set up to display *Completed* sheets for 60 days. After that they will be removed from the list. This variable is configurable and can be adjusted by the project implementation team. Oracle recommends that projects should keep the number of switching sheets in this list to a minimum for performance reasons.
The available switching sheet table supports standard filtering and sorting. (See Sorting on page 6-11 and Filtering on page 6-12.)

2. Select a sheet and click Open.

**From any of the Work Agenda Jobs Lists**

1. Select an event from one of the Events Lists that has a switching sheet associated to it. This can be determined by checking to see whether a switching sheet number is displayed within the Plan # column for the selected event.

2. Select the Switching... option from the Actions menu. The Open or Create New Switch Sheet dialog is displayed.

3. Select the sheet you want to load from the Pre-Created Switching Sheets list and click Open. (You can start a new sheet by selecting a sheet type and clicking Create.)

**From the Event Details**

1. Select Switching... from the Actions menu. The Open or Create New Switch Sheet dialog is displayed.

2. Select the sheet you want to load from the Pre-Created Switching Sheets list and click Open. (You can start a new sheet by selecting a sheet type and clicking Create.)

**From Crew Actions**

1. If a crew has been placed en route to a Master switching sheet event, then select the crew in the crew list.

2. Select Switching... from the Actions menu. If only one sheet is associated with the crew, it is displayed in the Web Switching Management window. If multiple sheets are associated with the crew, the Crew to Sheet Selection List displays all associated sheets. If no sheets are associated with the crew, an error message appears.

3. Select a sheet and click Open.

**From the Control Tool**

1. From a Viewer, double-click on a device that is involved in a switching sheet. The Control Tool is displayed.

2. Click the Switching Plan(s)... button.

   • If the device is associated to one switching sheet (i.e., it is listed in the Device field on the switching sheet’s Request tab) or if it is included in one switching sheet step, that sheet will be opened in the Web Switching Management window.

   • If the device is associated with multiple switching sheets and/or included in multiple switching sheet steps, the Device to Sheet Operation List window will open. Each associated sheet and/or operation will be listed in a separate row. Select a row and click Open.

   *Note: The Device to Sheet Operation List displays steps for active switching sheets and switching sheets that have been completed within the last 30 days.*
Copying a Switching Sheet

You can create a new switch plan that includes all of the steps in the open switching sheet by using the Copy As function. To copy an open switching sheet, do the following:

1. Select Copy As... from the Switching Sheet’s File menu to open the Copy Switching Sheet As dialog.
2. Select the new switching sheet’s type:
   - Planned
   - Emergency
   - Template
   - Outage Correction
3. Click Create a Copy to create the new switching sheet.

   Note: The switching sheet type will determine how the new sheet opens (e.g., recording on or off, which tab is visible, etc.).

Deleting a Switching Sheet

You can mark a switching sheet as deleted if it is no longer being used. Deleted sheets are retained by the system and can be loaded in View-Only mode when hard-associated to a canceled event. Web Switching Management does not support full deletions of switching sheets from the database. A record of all activity for a switching sheet is always retained in the database.

Note the following rules regarding deleted switching sheets:

- The Delete option is only available for planned, template, outage correction, and emergency sheets that do not contain any real-time instructed or completed steps or any event associations other than canceled and manual events.
- You cannot delete a switching sheet once it has been scheduled. If you need to delete the sheet, you must Cancel it first.
- You cannot delete an outage correction sheet that has an event association.
- Deleted sheets do not appear in the Device to Sheet Operation List. (This list is displayed from the Control Tool.)
- Safety documents associated with a deleted sheet do not appear in the Device to Safety Document List. (This list is displayed from the Control Tool.)
- The Impacted Customer lists and External Document lists are cleared for deleted sheets.
- Deleted sheets are ignored by the Model Verify functionality.

To delete a switching sheet, follow these steps:

1. Click the Tracking/Audit Log tab.
2. Enter the reasons for the deletion in the Reason field to the right of the grayed Delete button. (The Delete button is not enabled until you enter text in the Reason field.)
3. Click the Delete button.
Emergency Switching

Emergency Switching includes any unplanned switching operations that occur due to events during storms, equipment failures, or even planned switching actions that fail or are incorrect. Unlike planned switching where the switching sheet is created and studied before it is issued, in emergency switching the switching sheet is created as the operations take place in real-time. Essentially, a switching sheet is created and implemented simultaneously. Steps are recorded on the Steps tab as the Control Tool actions are being performed, and each step is considered complete as it is being recorded.

Emergency switching operates just like planned switching, except that the Web Switching Management window and Viewer must both be in real-time mode. Whenever switching steps are recorded in a switching sheet using the real-time Control Tool, the operation is considered emergency switching. The switching sheet provides a record of the switching operation.

This section includes the following topics:

- Creating an Emergency Switching Sheet
- Recording Emergency Operations

Creating an Emergency Switching Sheet

You can create an emergency switching sheet from Web Switching Management (or from the Environment Manager if you are running Web Switching Management with Operator’s Workspace). However, typically you will create emergency switching sheets from the Work Agenda or Event Details window. When you create an emergency sheet from either of these applications, the sheet is automatically associated to the event and saved to the database. The sheet cannot be deleted and will always remain associated to the originating event.

Note: The Web Switching Management application must be started before you can initiate an emergency switching sheet from Work Agenda, Event Details, or Environment Manager.

To create an emergency switching sheet, do any of the following:

- From the Web Work Agenda, click an event in the Work Agenda list and select Switching... from the Actions menu.
- From the Event Details Window, select Switching... from the Actions menu.
- From your environment’s general menu, select Fictionalizing Sheet... to display the New Switching Sheet window. Select Emergency as the sheet type and click Create.

Note: when creating a switching sheet from an event in the Work Agenda or Event Details, the list of available switching sheet types only includes Emergency and Outage Correction types.

The new emergency sheet is automatically populated with Start and Finish dates. The Start date is the current date/time; the Finish date is defined as the Start date plus a predefined standard event duration.

Note: The duration is set to four hours in the product environment.

The sheet opens with the Steps tab active, real-time mode enabled, and recording on. If the Viewer is open, it transitions to real-time mode also. You can begin recording steps as described in the next section.
Recording Emergency Operations

To record emergency switching operations, complete these steps:

1. Start a new emergency sheet as described in the previous section.

2. Create and complete steps by selecting devices in the Viewer window and selecting operations from the Control Tool. The process of adding recorded steps for emergency sheets is the same as for planned sheets in real-time mode. See Adding Recorded Steps to a Switching Sheet on page 15-27 for details.

Once an action is completed in the Control Tool, the following occurs:

- The status of the recorded step is set to Completed.
- The Executed By field is populated with your user ID.
- The Completed Date field is populated with the date and time shown on the Control Tool.
- Instructed actions use the date/time specified from the Control Tool to populate the Instructed Date field.
- Any outages created by completing steps from the Control Tool or from Web Switching Management are classified as Real Outages and not Planned Outages.

3. When you have completed all emergency steps, click the Tracking/Audit Log tab and set the sheet state to Completed by clicking the Complete button. The Confirm State Transition dialog will open; click Yes to confirm the completion or click No to close the dialog without completing the sheet. The Finish Date may be updated, if necessary.

- Optional: add a comment in the text field to the right of the Complete button.

Note: Changes can no longer be made to a completed sheet.

Event Associations

Event associations are used to associate events to switching sheets. Associated events are displayed in the Events List on the Steps tab header. (See Events List on page 15-25.)

Events can be associated to switching sheets in two ways:

- **Hard Associations** are automatic associations that are normally made as you perform actions within Web Switching Management or perform actions from the Control Tool that are recorded into the switching sheet. An event can only have one hard association to a switching sheet. Hard associations cannot be broken once the association has been established; however, the association can be moved to a new switching sheet if the steps that created the event are moved.

- **Soft Associations** are associations that are normally added manually from the Events List in Web Switching Management. An event can be softly associated to an unlimited number of switching sheets. This type of association can be manually removed up until the associated switching sheet has reached the Completed state.

  Note: Event associations do not occur when the event causing action is recorded into the Miscellaneous Log.
Hard Associations

Hard associations can also be further classified by type. There are four types of hard association relation types:

- **Master** is the relationship type made between a Planned switching sheet and its active master switching job. There can only be one Master Event associated to any single switching sheet.

- **Canceled** is the relationship type made between a Planned switching sheet and a canceled master switching job. There can be any number of Canceled event associations to a single switching sheet. These Canceled events were originally classified as Master Events for the plan.

- **Planned** is the relationship type made between a Planned switching sheet and a planned outage. A planned outage is an outage that was generated from a planned switching sheet after the completion of an action recorded in the Steps section of the plan.

- **Forced** is the relationship type made between an Emergency switching sheet and an unplanned outage or non-outage event. A Forced relationship will be made when recording real-time actions into an Emergency switching sheet. The relationship can also be made when creating an Emergency plan for an event from the Work Agenda Jobs List or the events Event Details display.

Soft Associations

Soft associations only have one classification type:

- **Manual** is the relationship type made between a switching sheet and a manually associated event. Manual associations are also made between plans if an outage is hard associated to one plan and the outage is restored with another switching sheet. The plan that recorded the restoration step will have the event automatically associated to it with a classification type of Manual. Grouped events can also cause switching sheets to be manually associated. Partially restoring an outage or adding customers to an outage will create a manual association between the switching sheet and the job if no association (hard or soft) already exists.

Rules for Grouping Event Associations

When resolving outages in the network, it is common for events to be grouped together. When events are grouped, the associations will adhere to the following set of rules:

- If an event with no hard association consumes another event with no hard association, then the resulting event will have no hard association, and its manual associations will be a combined list of both events’ manual associations.

- If an event with a hard association consumes an event with no hard association, then the resulting event will have the surviving event's hard association and a combined list of both events’ manual associations.

- If an event with no hard association consumes an event with a hard association, then the resulting event will have the consumed event's hard association and a combined list of both events’ manual associations.

- If an event with a hard association consumes another event with a hard association, then the resulting event will have the surviving event's hard association. The consumed event's hard association will be listed as a manual association along with the combined list of both events’ manual associations.

- If an event consumes another event with an association to the same switching sheet, then the above rules will apply, but the plan will only be listed once in the event's association list. An event can only have one association to a specific switching sheet.
Working with Safety Documents

Safety Documents in the Oracle Utilities Network Management System are an electronic representation of the paper safety documents used for switching operations. Safety documents provide information about a particular operation and record the issuance and release of tags on devices. For switching operations, safety tags are first physically placed on devices, and then the safety document is issued. This effectively gives the crew permission to begin work. When the work is completed, the safety document is released, warning the crew that they must stay clear. Once the safety document is released, safety tags may be removed from the devices and the switches may then be closed.

This section includes the following topics:

- Safety Document Types
- Mapping Step Types to Safety Document Types
- Using the Safety Documents Tab
- Adding Safety State Transition Steps
- Safety Document Dialog
- Editing the Device List
- Executing Safety State Transition Steps
- Issuing Safety Documents
- Releasing Safety Documents
- Opening an Existing Safety Document
- Completing Safety Documents

Safety Document Types

A utility often has pre-defined safety documents established in its safety policy. While utilities often have specific names for these safety documents, Oracle Utilities Network Management System Web Switching Management has five types of safety documents that a utility can use to represent their established safety documents. This section describes five common safety document types:

- **Clearance** - indicates that clearance for work on a device or in an area has been obtained from the proper authority. The proper authority might be a control center supervisor or a regional dispatcher. Clearance documents imply that the device or area that requires work has been made safe to work on or in.

- **Hold** - indicates that the tagged device(s) should not be operated (e.g., if the device is open, it should remain open). Hold safety documents are used when the device is to be held open or closed in order to complete work in an area of the distribution system. The purpose of the Hold safety document is to protect crew members and prevent injury to human life. Hold safety documents are placed and removed by individuals who have authority over a specific area or operation and serve to restrict the operation of a device.

- **Hot** - indicates that hot line work is being performed (e.g., live wires), and if the tagged device(s) is opened, it should not be closed again until the safety document is released. When Hot Line safety documents are present, device operations in the area should be performed with caution.

- **Information Note** - provides some pertinent information about the device(s). Information Note safety documents are for informational purposes only. These safety documents do not restrict operation of the device, but provide information that a crew member or utility employee should be aware of when working on the device(s).
• **Warning Tag** - provides warning information about the tagged device(s). Like Information Note safety documents, Warning Tags are for informational purposes only. These safety documents do not restrict operation of the device(s), but provide information that a crew member or utility employee should be aware of when working on the tagged device(s).

While safety document names and features may vary, understanding these five types will help you understand the general use of most safety documents. Crews typically “own” safety documents and must authorize their release when they are finished working in an area or on a device.

### Mapping Step Types to Safety Document Types

Each safety document type may be associated with only certain types of steps. These step-to-safety document mappings are configurable. The following list shows what types of steps each safety document type is pre-configured to accept.

- **Clearance:**
  - Place Clearance Tag
  - Remove Clearance Tag
  - Place Ground
  - Remove Ground

- **Hold:**
  - Place Hold Tag
  - Remove Hold Tag
  - Place Ground
  - Remove Ground

- **Hot:**
  - Place HOT Tag
  - Remove HOT Tag
  - Place Ground
  - Remove Ground

- **Informational Note:**
  - Place INFO Tag
  - Remove INFO Tag

- **Warning Tag:**
  - Place WARN Tag
  - Remove WARN Tag
Using the Safety Documents Tab

The Safety Documents tab displays a list of all safety documents associated with a switching sheet. This tab displays the following fields and buttons:

- **Type** displays the type of safety document. The five types (Hold, Clearance, Hot, Information Note, and Warning tag) are described in the previous section.
- **Doc #** displays the safety document number.
- **Status** displays the status of the safety document. Valid statuses are New, Issued, Released, Unissued, and Completed.
- **Crew** displays the crew assigned to this safety document.
- **Description** displays a description of the safety document.

- The **refresh** button refreshes the safety document list.
- The **Open** button opens the selected safety document. (Alternatively, you can double-click the document in the list.)
- The **Delete** button deletes the selected safety document. Safety documents can only be deleted if there are no steps associated to the document. Deleted safety documents are not removed from the database.

Adding Safety State Transition Steps

Each safety state transition step performs a single action, such as issuing or releasing a safety document. To add safety state transition steps, do the following:

1. On the Steps tab, select the steps to which you want the safety document associated. For instance, select Hold Tag steps and Grounding steps to create Hold safety documents. These steps then define the isolation and grounding points for the safety document.

2. Click the **Create Safety Document** toolbar button. If the selected steps map to multiple types of safety documents, the Select Safety Type dialog prompts you to select the document type. For example, if you select only Grounding steps, then the Select Safety Type dialog allows you to choose Clearance, Hold, or Hot as the safety document type.

   **Note:** If the selected step is blank or is associated to an operation for which no safety document is required, the system displays a message indicating that the selected step is not valid for a safety document. Click **OK** to dismiss the dialog.

3. Select the safety document type, and click **OK**. The safety document dialog is displayed. (See the following section for field descriptions.)

4. Enter a comment within the Description field on the safety document dialog, and click **Save** to save the comment.

5. Validate that step recording is still turned on in the Steps tab.

6. Click the **Issue** button on the safety document dialog. A new safety state transition step is recorded into the switching sheet steps list. The Operation column of the step indicates the type of operation being performed.

7. Select the **Release** and **Complete** buttons on the safety document. New safety state transition steps are recorded into the Steps list for the Release and Complete operations.

Note: If you changed the Other Devices or Description field, you will be asked to save the changes. All other fields are automatically saved within the associated switching steps.

For instructions on executing safety state transition steps, see Executing Safety State Transition Steps on page 15-66.

Copying Safety State Transitions

Each safety state transition step is associated to a particular safety document. A safety state transition step cannot exist without a safety document. When copying these steps and pasting them into the same sheet, the association is kept. However, when copying these steps to another sheet, the association is broken and the steps are converted into comment steps. The comment text will be populated with the description of the source safety state transition step. Using the comment steps as references, a new safety document can be created and new safety state transition steps recorded into the sheet. The reference steps can then be deleted.

Safety Document Dialog

The safety document dialog displays the following fields and buttons:

- **Tag Points Devices** display the device(s) and their phases that the safety document is associated with.
- **Grounds Devices** displays the device(s) and their phases that the safety document will protect and validate the grounds on.
- **Other Devices** is a text field that allows you to enter a list of non-modeled devices.
  
  Note: An entry is required in at least one of these fields: Ground Devices, Tag Points, or the Other Devices.
- **Feeder** displays the value found in the Feeder field of the originating switching sheet. To alter this value, you must change the Feeder field on the switching sheet Request tab.
- **Assigned Crew Information** displays the Crew ID of the crew that the safety document has been issued to, as well as the crew’s mobile number, pager number, and crew type. The crew ID is auto-populated with the value from the Instructed To field in the safety state transition switching step. A crew is required in this field before an Issue safety state transition step can be completed.
  
  - To select a crew to assign to this safety document, click the Select Crew icon and then select the desired crew.
  
  - To delete a crew from this list, click the crew and then click the Clear Crew icon.
- **Description** is a text field that allows you to enter notes for the safety document.
- **Audit Log** lists the date and time of each state change and associated device operation. For device operation entries, the device and operated phases are displayed.

Toolbar Buttons

- The **Add Device** button allows you to add a new device to a safety document. (To enable this button, select a step on the switching sheet while the safety document is displayed.) The device from the selected step is added.
- The **Remove Device** button allows you to remove a device from the safety document.
• The **Object Focus** button focuses the Viewer 1 window on the selected device.

• The **Issue** button adds a step for issuing the selected safety document. The step is added to the end of the steps list or after the step insertion indicator (if one has been placed).

• The **Release** button adds a step for releasing the selected safety document. The step is added to the end of the steps list or after the step insertion indicator (if one has been placed). This button is only enabled if the safety document has been issued. Selecting this button will cause the Complete button to be enabled.

• The **Complete** button adds a step for completing the selected safety document. The step is added to the end of the steps list or after the step insertion indicator (if one has been placed).

• The **Abort** button allows you to set the status of the safety document to Aborted. The system prompts you to confirm the action before aborting. This button is only available in real-time mode and only for safety documents that are in the New state.

• The **Save** button saves your changes to the safety document.

• The **Print Preview** button allows you to select a report format and then preview the safety document in the selected format.

• The **Print** button allows you to select a printer and then print a hard copy of the safety document to the selected printer.

• The **Help** button displays the Safety Document Help.

• The **Close** button closes the safety document dialog.
Editing the Device List

Adding Devices
You can add additional devices to a safety document by doing the following:

1. Open a non-execute version of a safety document. (A non-execute version is loaded from the Safety Lists and the Control Tool. It displays a toolbar at the top of the dialog and no Execute button at the bottom.)

OR

From the associated switching sheet steps list, select the step with the device operation you want added to the safety document. For example, if you select an Add or Remove Tag step, the device is added to the Tag Devices list on the safety document dialog. If you select a Ground step, the device is added to the Ground Devices list.

2. Click the Add Device button on the safety document dialog. The new device is added to the appropriate device list.

Notes:
- The device lists can only be altered while the document is in the New state. Once the document has been issued for the first time in Real-Time, then the device lists cannot be altered. This rule cannot be bypassed or changed through configuration.
- If the selected step is already associated to a safety document, then an error dialog indicates which safety document the step is already associated to.

Removing Devices
Note: Devices can only be removed from a safety document device list if their associated switching step has not been instructed or completed.

You can remove devices from a device list in two ways.

Option 1:

1. Open a non-execute version of a safety document. (A non-execute version is loaded from the Safety Lists and the Control Tool. It displays a toolbar at the top of the dialog and no Execute button at the bottom.)

2. Select the device you would like to remove from the device list.

3. Click on the Remove Device button. The device is removed from the list.

Option 2:

1. From the associated switching sheet steps list, select the step with the device operation that you want removed from the safety document. For instance, if you select an Add or Remove tag step, the device will be removed from the Tag Devices list. If you select a Ground step, the device will be removed from the Ground Devices list.

2. Click the Unlink From Safety button on the Steps tab toolbar. The device is removed from the safety document’s device list.

Executing Safety State Transition Steps

Once a safety state transition step has been recorded, executing (completing) the step causes the Execute Safety Step dialog to be displayed. This dialog looks just like the original safety document dialog except that it has no toolbar and it displays two buttons: Execute and Cancel. Use this dialog to verify that the safety document information is correct, and then click the Execute button to execute the step.
When a tag step with an associated safety document is executed, the Control Tool executes placement of the appropriate tag (Hold, Hot, Clearance, etc.) on the device. The symbol on the device indicates that a condition exists on the device, that the area has not been issued to the crew, and thus it is not isolated yet. After the safety document has been issued, the symbol on the device changes to indicate that the tag is under the control of the safety document.

For example, a Hold tag may change to indicate Hold with a small lock symbol next to it. When a tag changes to a locked state, it is no longer possible for the user to remove the tag from the Control Tool. The safety document must be released before the tags can be removed from the Control Tool.

For more information, see one of the following topics:

• Issuing Safety Documents While Executing Steps
• Releasing Safety Documents While Executing Steps

Issuing Safety Documents

Safety documents are issued when an Issue safety document switching step is completed and the Execute button is selected on the safety document.

**Note:** The appropriate tag type must be placed on the device prior to the safety document being issued. For example, to issue a Hold document, you must place a Hold tag on the device before the safety document can be issued.

Once a safety document is issued:

• You cannot complete, delete, or reissue the safety document. The Description field is the only field that remains editable.
• The only button options available on the safety document dialog are Unissue and Release.
• The Viewer displays a symbol on all devices that are specified in the safety document to indicate that the safety document has been issued.

Issuing Safety Documents Manually

To issue a safety document manually:

1. Open the safety document (if it is not already open) by selecting the document on the Safety Documents tab and clicking the **Open** button.
2. Click the **Issue** button on the open safety document. A symbol appears on all devices in the Viewer that are specified in the safety document to indicate that the safety document has been issued.

**Note:** If you manually Issue a safety document in real-time mode, a safety state transition step is automatically recorded to the Steps list, regardless of whether step recording is turned on. This is the audit of the safety documents transitions.

Issuing Safety Documents While Executing Steps

To issue a safety document through step execution:

1. From the Steps List, select the Issue safety state transition step and select the **Complete** button. The Execute Safety Step dialog opens, and the Execute and Cancel buttons are enabled.

**Note:** When instructing safety state transition steps in real-time mode, the safety document dialog is not displayed. It is only displayed when the step is completed.
2. Select the **Execute** button. A symbol appears on all devices in the Viewer that are specified in the safety document to indicate that the safety document has been issued. The safety state transition step is also marked as Completed.

**Unissuing a Safety Document**
The Unissue button undoes the Issuing of the safety document. This action should be used to alter the device list within the safety document. This allows the area the safety document encompasses to be altered after the document has been issued.

**Releasing Safety Documents**
Safety documents are released when switching steps associated to a releasing safety document are completed and the Execute button is selected on the safety document. The symbol for the safety document is removed from the device in the Viewer and the original tag symbols are placed back onto the device. Once the document is released, the Description text field remains editable. At this point the Safety Document can either be reissued to a different crew or completed.

**Releasing Safety Documents Manually**
To release a safety document manually:

*Note:* The document must already be issued before it can be released.

1. Open the safety document (if it is not already open) by selecting the document on the Safety Documents tab and clicking the **Open** button.

2. Click the **Release** button on the open safety document. The symbol for the safety document is removed from the device in the Viewer and the original tag symbols are placed back onto the device.

*Note:* If you manually release a safety document in real-time mode, a safety state transition step is automatically recorded to the Steps list, regardless of whether step recording is turned on. This is the audit of the safety documents transitions.

**Releasing Safety Documents While Executing Steps**
To release a safety document through step execution:

1. From the Steps List, select the Release safety state transition step and select the **Complete** button. The Execute Safety Step dialog opens, and the Execute and Cancel buttons are enabled.

   *Note:* When instructing safety state transition steps in real-time mode, the safety document dialog is not displayed. It is only displayed when the step is completed.

2. Select the **Execute** button. The symbol for the safety document is removed from the device(s) in the Viewer and the original tag symbols are placed back onto the device(s). The safety state transition step is also marked as Completed.

**Opening an Existing Safety Document**
To open an existing safety document, complete these steps:

*From your environment’s general menu:*

1. Select **Open> Safety Documents…** from the File menu. The Open Safety Documents window appears.

2. Select the safety document you want to open and click the **Open** button or double-click on the document in the list. The **Safety Document Dialog** is displayed along with the associated switching sheet.
From an open switching sheet tab on the Web Switching Management window:

1. Click the Safety Documents tab.
2. Select the safety document you want to open and click the Open button or double-click the document in the list. The safety document dialog is displayed.

From a switching step on the Steps tab:

1. Right-click on one or more steps that have safety document associations, then select Load Safety Document(s)… from the pop-up menu. The safety document dialogs are displayed.
   
   Note: Steps with associated safety documents display the document type and number displayed in the Operation step column.

From the Control Tool:

1. For active safety documents, double-click on a device within the Viewer window.
2. From the Control Tool, click the Safety Document(s)… button.
   
   If only one safety document is currently active on this device, then the safety document dialog is displayed.

   If multiple safety documents are active, the Device to Safety Document List displays a list of safety documents for the device. The list includes only safety documents that are part of an active sheet and documents that were completed in the last 30 days. Select the safety document you want to load from this list. The safety document dialog is displayed along with the associated switching sheet.

Completing Safety Documents

When you have completed all steps in a switching sheet, you should complete all safety documents associated with the sheet.

To complete a safety document, use either of the following methods:

Option 1

1. Follow the steps described above to open the safety document.
2. Click the Complete button on the safety document dialog.
   
   Note: Once completed, the document is locked from further editing. When manually completing a safety document in real-time mode, the action is automatically recorded in the associated switching sheet's Steps list.
3. Repeat these steps for all safety documents associated with the switching sheet.

Option 2

Record a Complete safety state transition step (as described in the previous sections) and use that step to complete the safety document. Repeat for all safety documents associated with the switching sheet.

Aborting a Safety Document

If a switching sheet is aborted, you will need to abort any associated safety documents before you can complete the switching sheet.

Note: The Abort option is only available in real-time mode when the safety document is in the New state.

To abort a safety document, follow these steps:

1. Click the Safety Documents tab.
2. Double-click the safety document you want to abort.
3. Click the **Abort** button on the toolbar.
4. When prompted, confirm your action.

**Outage Correction**

You can also use Web Switching Management for outage correction. After an outage is completed, you can revise the outage restoration sequence and times by re-recording the outage restoration sequence in study mode.

This Outage Correction environment only includes the tools needed to re-record a completed outage in study mode:

- The Work Agenda contains only the Completed List.
- The Viewer cannot enter real-time mode.
- The Web Switching Management window can only display the Outage Correction switching sheet type, and cannot enter real-time mode.

**Re-Recording the Outage Restoration Sequence in Study Mode**

To re-record the correct outage restoration sequence, follow these steps:

1. From the Event Details for a completed event, press the **Switching…** button. An Outage Correction switching sheet is created for the event.
2. In the Outage Correction switching sheet, turn recording on.
3. Record the entire set of corrected outage and restoration steps in the Viewer, using the Control Tool's date/time selector to set the correct operation times.
4. Click the **Correct Outage** button on the Steps tab toolbar. A confirmation dialog appears.
5. Press **OK**. The system validates the plan and, if successful, replaces all affected customer data for the related outage and updates the new outage time, customer count, and outage device. The Event Details, when re-loaded, will reflect any partial restorations changes as well.

   **Note:** When an event is updated that results in 0 customers impacted, a warning dialog will be displayed to indicate the change. The event date will be updated to the current time.
Using the Miscellaneous Log

The Miscellaneous Log automatically records all real-time switching actions that are not recorded in any switching sheet. The miscellaneous log does not need to be open for steps to be recorded; the system automatically detects when a step is performed that is not going to be recorded in any other switching sheet.

For emergency switching, you can use the miscellaneous log rather than creating emergency switching sheets. If you record steps in real-time mode without adding them to a particular switching sheet, the steps are automatically added to the miscellaneous log.

This section includes the following topics:
• Displaying the Miscellaneous Log
• Filtering the Log

Displaying the Miscellaneous Log

To view the Miscellaneous Log, select Miscellaneous Log... from the Tools menu on your environment's general menu. The Miscellaneous Log tab opens.

The Miscellaneous Log tab displays the same columns as the Steps tab (except for the Version column, which does not appear for miscellaneous log entries). See Steps Tab on page 15-18 for column descriptions.

The following fields and buttons are displayed at the top of the Miscellaneous Log tab.
• The From date picker, Range drop-down, and Fetch button are used to filter the log. See the next section for details on using these fields.
• The Previous and Next buttons allow you to view the log entries for the previous or following period. For example, if the number of days drop-down is set to 1 week, then clicking the Previous button displays the previous week's log entries.

• The Complete button completes the selected instructed steps. The status of the step changes to Completed.

• The Abort button sets the status of an instructed step to Aborted. Use this if the step was never attempted.

• The Fail button sets the status of an instructed step to Failed. Use this if the step was attempted but failed.

• The Object Focus button focuses the Viewer on the selected device.

• The Cut button allows you cut one or more steps from the miscellaneous log. You can then paste the steps into another switching sheet.

• The Help button displays help for the Miscellaneous Log tab.
Filtering the Log

Use the fields at the top of the Miscellaneous Log tab to filter the list as follows:

1. Select a starting date from the From date picker.

2. From the drop-down, select the number of days from that starting date for which you want to see log entries.

3. Check or uncheck the All Users checkbox. When checked, the log shows steps that were executed by all users. When unchecked, the log shows only steps that were executed by you. Use the fields at the top of the tab to filter the log.

4. Click the Fetch button to refresh the list based on your entries.

Viewing Global Overlaps

The Global Overlaps list allows you to identify overlaps of date/time, control zone and affected devices within a specific time period for all active switching sheets.

To display the Global Overlaps list, choose Tools>Switching Overlaps... from your environment's general menu.

The fields, buttons, and options on this tab are nearly identical to the Overlaps tab that is displayed for individual switching sheets. See Using the Overlaps Tab on page 15-47 for more information.

Click the Help button to display help for the Global Overlaps tab.
Chapter 16

Power Flow, Suggested Switching, and Volt/VAr Optimization

This chapter covers the following topics:

• Using Power Flow
• Using Suggested Switching
• Using Volt/VAr Optimization

Using Power Flow

The Oracle Utilities Network Management System - Power Flow Extensions enable engineering analysis of the electrical distribution system for use in the operations and control center rather than for design or planning purposes. They assess the equipment loading and feeder voltage profiles for selected portions of the electrical network, and provide overload, fault, and voltage violation information for review.

Power Flow functionality allows you to view the results of the power flow solution, enter and evaluate solution options, and modify execution parameters.

Note: Power Flow solutions may be returned as 'Non-Converged' when there are errors in the data model. That section of the network is disabled for Power Flow solutions until the island is re-enabled manually or the model is updated. See Chapter 17, Feeder Load Management for more information on feeder status and re-enabling a non-converged island.

This section includes the following topics:

• Viewer Power Flow Information Visualization
• Real-Time Power Flow Updates
• Viewing Power Flow Results in Study Mode
• Viewer Power Flow Information Visualization
• Study Session Parameters for Power Flow
• Power Flow Real-Time Options
• Study Session Parameters for Power Flow
• Using Power Flow with Look Ahead
Viewer Power Flow Information Visualization

In addition to the standard feeder and phase views, the Viewer provides options for visualizing the power flow information for:

- **Currents**: the current range.

![Current Legend](image)

- **Voltage Per Unit**: the per unit voltage range.

![Voltage Per Unit Legend](image)

- **Nominal Voltages**: the nominal voltage range.

![Nominal Voltage Legend](image)

**Flow Direction**

The viewer will render any of the view options with flow direction by selecting Show Flow Direction from the Options menu (Shift-F). The example below shows Current with flow direction enabled.
Real-Time Power Flow Updates

When a switching operation occurs in the system, it may take a few seconds before analog SCADA measurements update to reflect the new configuration. For this reason, the real-time power flow will not update instantaneously after a topology change, but will wait a configured number of seconds (the default is 30) before a resolve is triggered. By then, it is assumed that the system measurements are again stable. Clicking on the power flow results during the delay will result in a Power Flow Results Pending message being displayed.

Note: The delay period is set in the SCADA_DELAY_TIME rule. Administrative users can view or change this setting on the Configuration Assistant Event Management Rules Tab, in the Power Flow Related Rules category and Feeder Load Management subcategory.

Viewing Power Flow Results in Real-Time

The Viewer's Device Details functionality (see Displaying Device Details on page 6-32) displays power flow calculation information. As each object is selected in the Viewer, the Power Flow Results information updates with the calculated feeder voltages and equipment flows for the selected object. In real-time mode, Power Flow is working all the time, recalculating results dynamically. Device Details shows results from the latest calculations.

To view the Power Flow results for a device in real-time, follow these steps:

1. Start the Viewer. If the Viewer is in Study Mode, click the button to set the Mode to Real-Time.
2. Click to enable Device Details, if not already enabled.
3. Click the device.

The latest results are displayed on the Power Flow Results tab.

Note: To view the parameters used in Power Calculations, click the toolbar button or select Power Flow Real-Time Options from the Options menu. See Power Flow Real-Time Options on page 16-6.
Power Flow Status Messages

The solution status is displayed at the bottom of the Device Details balloon. Status messages are provided to better alert you of the quality of the power flow solution being generated. Status messages for the NMS product configuration:

- **Power Flow Solution Pending** indicates that the power flow solutions are currently paused due to recent system topology changes and results will not be available until the configured delay has ended.

- **Power Flow Solved** indicates that the power flow calculations have completed successfully and the results are valid.

- **Non-Converged Power Flow Solution** indicates that Power Flow cannot find a stable solution since each iteration of the power flow algorithm yields a changing result.

- **Power Flow Not Solved - Suspect SCADA data** indicates that power flow solution failed to solve successfully due to SCADA data irregularities. See Chapter 17, Feeder Load Management for details on identifying SCADA data irregularities.

- **Power Flow Not Solved - Data Model Error** indicates there is an issue with some part of the data model that will not allow a reasonable solution to the power flow calculation.

- **De-energized Device** indicates the selected device is deenergized so there is no solution.

Understanding the Power Flow Results Tab

The Power Flow Results tab displays the power flow calculations in a tabular format. The date and time the last power flow solution was requested for the selected device appears in the bottom right corner of the balloon dialog.

- The **Voltage Display Type** used in the power flow calculation is displayed. You can change this to any of the following:
  - Secondary Base Voltage
  - Nominal Base Voltage
  - Voltage Percent

- The **Phase** column displays the device phase.
- The **kV** column contains calculated voltage in the units selected above.
- The **kW** column contains the calculated voltage in the units selected above.
- The **kVar** column contains the phase reactive power flow.
- The **Amps** column contains the phase current.
- The **Limit** column contains the phase current limit (in amps).

**Notes:**
- Voltage and current violations are highlighted in red. Voltage and current warnings are highlighted in yellow. Amps for backfeeds are highlighted gray.
- In Study Mode, the Power Flow Results tab also displays a **Refresh** button. Clicking this button displays the Study Session Parameters window so you can change the Power Flow Options.

### Power Flow Real-Time Options

To view the Real-Time Power Flow options, click the **Power Flow Options** toolbar button from the Viewer or the Feeder Load Management Tool. (You can also select **Power Flow Options** from the Options menu in either application.)

The Power Flow Real-Time Options dialog displays the limit type (emergency or normal) and the high and low limit values. It also displays the load scale factor values for each day. The current day's scale factor displays with a highlighted (pink) background. Non-administrative user types can view, but not edit, the options on this window; click **Exit** to close the window.

**Administrative User: Full Resolve**

Administrative Users can change the load scale factors, save their changes, and then start a full Feeder Load Management resolve by clicking **Full Resolve**. If you have unsaved changes, the system will prompt you to save. The resolve starts immediately and the window closes.

### Viewing Power Flow Results in Study Mode

In Study Mode, Power Flow results are calculated each time you display the Device Details Power Flow Results tab. Results are also calculated when you click the **Apply** button on the Study Session Parameters dialog, which is available from either the Feeder Load Management tool or the Power Flow Balloon.

To view Power Flow results for a device in study mode, follow these steps:

1. Start the Viewer and enable Device Details.
2. Set the Viewer to Study Mode. (When you change to Study Mode, the system prompts you to set the Study Session Parameters, as described in the next section.)
3. Select the device for which you want to view Power Flow results. (Click the left mouse button to select.) The Device Details dialog appears.
4. Click the Power Flow Results tab. See **Study Session Parameters for Power Flow** on page 16-7 for descriptions of the fields on this tab.
5. Click the **button to view or modify the Study Session Parameters. See **Study Session Parameters for Power Flow** on page 16-7.
Study Session Parameters for Power Flow

The Study Session Parameters window for Power Flow is displayed automatically the first time you switch to Study Mode or to the Power Flow Results tab on the device details balloon dialog in Study Mode. This allows you to quickly view and confirm the options being used. After that, you can display Power Flow Results for devices without confirming the options each time. If you change the options after your initial confirmation, press the Refresh button on the Power Flow Results tab to display the Study Session Parameters window.

Study Session Parameters are described below:

- **Day Type** lists the available types of day. Typically these will be configured as Weekday and Weekend, but may include other day types such as Holidays, Seasonal Peaks, etc.
- **Hour** is the hour to use for calculating results (0-23).
- **Limit Type** is either Normal or Emergency.
- **High Voltage Limit** is the high voltage to use for reporting limit violations.
- **Low Voltage Limit** is the low voltage limit to use.

The following actions are available from the Study Session Parameters window:

- To save the values entered on this window, click **Save**. The next time you open this dialog, the saved values will be used.
- To request a Power Flow solution using the values entered on this window, click **Apply**. When the system is finished calculating the results, the Study Session Parameters window is closed and the results are displayed in the Power Flow Results tab on the balloon details dialog.
  
  **Note:** Values are not saved when you apply them. The next time you open this dialog, the last saved values (rather than the last applied values) will be displayed. If no values were previously saved, real-time values will be used.
- To restore real-time values, click **Restore**. If you want to request a solution for the restored values, click **Apply** after restoring. If you want to save the restored values, click **Save** after restoring.
- To change the options and request a new solution, click the **Refresh** button on the Power Flow Results tab on the balloon details dialog, then edit the study session parameters and click **Apply** again.
- To close the dialog without any action, click **Cancel**.

Using Power Flow with Look Ahead

During switching operations, the Look Ahead window allows you to preview the results of switching actions before you perform them. The basic Oracle Utilities Network Management System Operator's Workspace Look Ahead window displays information including customers dropped/picked up, critical customers dropped/picked up, and load kVA.

With Power Flow Extensions, the Look Ahead window also includes information about the power flow solution, including the voltage, angle, and current changes that will result from a switching operation. The number of voltage and conductor violations is displayed at the top of the Look Ahead panel.

When you select an operation from the Control Tool, you can click the **Run Power Flow** button on the Look Ahead window to see what the effect would be if you completed the operation. The results are displayed at the top of the Look Ahead window and any violations resulting from the action are displayed in the **Violations Tab** tab. For information about the Look Ahead window, see **Using the Look Ahead Window** on page 6-64.
Using Suggested Switching

Product Name Suggested Switching helps you generate switching steps for two fundamental types of scenarios:

- **Deenergizing and isolating an energized device.**
  Suggested Switching produces steps to isolate and deenergize devices while minimizing the amount of resulting dropped load.

- **Restoring power to a deenergized device.**
  Suggested Switching produces restoration steps by solving the power flow for each eligible tie point with adjacent feeders, in order to determine the remaining feeder capacity and the overloads after the deenergized section is picked up.

### Suggested Switching Scenarios

- **Isolate Only**: A fault has occurred on a device or emergency maintenance is needed on a device. Suggested Switching can be used to generate the optimal switching steps to completely isolate the device from the system and evaluate the loads to be lost if no further restoration actions are implemented.

- **Isolate and Restore**: Suggested switching can be used to isolate a device from the system and restore downstream sections. If the selected device is already de-energized then upstream sections may also be restored.

- **Load Restore**: A deenergized area caused by planned or actual outages must be restored. Suggested Switching can be used to generate recommended switching plans to try to restore the loads as much as possible, and operate switches as little as possible.

- **Feeder Unloading**: A feeder is highly over-loaded, and some of its loading must be transferred to neighboring feeders or sources to avoid equipment damage or low voltages on the feeder. Based on system topology configurations, Suggested Switching will determine the optimal switching plans to transfer the required amount of loads from the specified feeder.

- **Substation Switching**
  - **Breakers**: One or more substation breakers need to be taken out of service for maintenance, so the feeders supplied from these breakers must be fed from alternate sources. Suggested Switching will create a plan whereby these breakers can be opened and the load on the feeders can be transferred to alternate supplies.

  - **Bus Section**: One of the bus sections needs to be taken out of service for maintenance, so all feeders fed from that bus section must be transferred to adjacent bus sections or substations. Suggested Switching can be used to identify which feeders should be transferred and recommend optimal plans to restore the supplied loads.

  - **Power Transformer**: A substation has two parallel power transformers, and one transformer needs to be taken out of service. Suggested Switching can be used to generate optimal switching plans to maximally transfer all existing feeders supplied by the transformer to adjacent power transformers or adjacent substations.
Using the Suggested Switching Tool

You can use the Suggested Switching tool to generate a set of steps that can be inserted into a new switching sheet or appended to an existing switching sheet.

Appending Steps to an Existing Switching Sheet

If you want to add steps to an existing sheet, do the following before you run the Suggested Switching tool:

2. Create or select a planned switching sheet to append the optimization plan steps.
3. Click the Record button to enable recording. (This is required in order for optimization steps to be appended from the wizard.)

Selecting Devices

1. Select one or more devices in the Viewer, based on the switching scenario you want to perform:
   - **Isolate Only** - Select a single or multiple energized or de-energized devices. Optimum performance with multiple devices occurs if the devices are near each in the model.
   - **Isolate and Restore** - Select a single or multiple energized or de-energized devices. Optimum performance with multiple devices occurs if the devices are near each in the model.
   - **Restore** - Select a single de-energized device.
   - **Feeder Unloading** - Select one or more devices that identify a single feeder.
   - **Substation Switching** - Select one or more devices of the correct type, such as power transformers or breakers.

   **Note:** To select more than one device, press the CTRL key while clicking the devices in the Viewer.

Starting the Suggested Switching Tool

The Suggested Switching tool uses a wizard approach that steps you through a series of pages to gather input, generate plan options, and, finally, provide the results of the chosen plan for use in a new or existing switching sheet. To start the Suggested Switching wizard:

1. With the device(s) selected, select **Suggested Switching...** from the Viewer DMS menu.

Understanding the Suggested Switching Tool Window

The Suggested Switching window is divided into three areas:

1. **The Context Panel (left):** shows the steps in the wizard. Completed steps are shown in normal text, the current step is bolded, and the remaining steps are grayed out.
2. **The Main Panel (right):** provides the user options or results of wizard.
3. **The Button Panel (lower):** contains the following buttons:
   - **< Back:** Moves the wizard back to the previous page.
   - **Next >:** Moves the wizard to the next page, as listed in the context panel on the left side of the window.
   - **Cancel:** closes the Suggested Switching wizard. (Note that any selections or changes made to parameters on any of the pages will be lost.)
   - **Help...:** Opens the online help system to the Suggested Switching tool help content.
Selecting a Plan Type

Plan Type is the first page of the Suggested Switching wizard. It allows you to select the type of suggested switching operation to perform. Plan Types will be desensitized if they are not valid for the selected device(s).

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Description</th>
<th>Pages in Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isolate Only</td>
<td>Isolate the selected device(s).</td>
<td>Plan Type Plans Summary</td>
</tr>
<tr>
<td>Isolate and Restore</td>
<td>Isolate the selected device(s) and try to restore as many downstream sections as possible.</td>
<td>Plan Type Load Scenario Constraints Feeders Plans Summary</td>
</tr>
<tr>
<td>Restore</td>
<td>Restore the selected deenergized device(s).</td>
<td>Plan Type Load Scenario Constraints Feeders Plans Summary</td>
</tr>
<tr>
<td>Feeder Unloading</td>
<td>Transfer load from a single feeder containing the selected devices.</td>
<td>Plan Type Unload Feeder Load Scenario Constraints Feeders Plans Summary</td>
</tr>
<tr>
<td>Substation Switching</td>
<td>Isolate one or more substation devices.</td>
<td>Plan Type Load Scenario Constraints Feeders Plans Summary</td>
</tr>
</tbody>
</table>

1. Select a Plan Type.

   **Note:** once a Plan Type is selected, the context panel will be updated to list the applicable pages in the wizard.

2. Click **Next** to proceed to the next step in the wizard.

Unload Feeder

The Unload Feeder page allows you to modify values for load to transfer from the feeder to adjacent feeders for each phase. The Unload Feeder page is **only** available when the Feeder Unloading plan type is selected.

1. Enter the load capacity in amps for A phase, if applicable.
2. Enter the available load capacity in amps for B phase, if applicable.
3. Enter the available load capacity in amps for C phase, if applicable.
4. Click **Next** to proceed.
Load Scenario

The Load Scenario page is used to verify or modify the power flow load and limits scenario, which will be used to determine the best plan options. When the window opens, the default values for load profile, scaling factor, and limits are visible in a read-only mode; to change the scenario, click the Modify button to open the Power Flow Study Mode Load Scenario dialog.

Power Flow Study Mode Load Scenario Dialog

The Power Flow Study Mode Load Scenario dialog allows you to (optionally) modify the power flow parameters used to generate the solutions.

1. Choose the Load Profile. The Load Profile provides two options:
   • Real Time is the default load scenario, which uses loading for present real-time system data.
   • Specific Period uses loading from the historical load profile for the day and hour you specify here. If you specify a value in the Scaling field, then loading will be scaled by this factor.

2. Set the Scaling Factor. The Scaling Factor field allows the loading parameters to be scaled by the factor entered.

3. Set Limits. The Limits field refines the scenario with:
   • Limit Type - defines whether the scenario is based on Normal or Emergency conditions.
   • Season - defines the scenario season (Spring, Summer, Fall, or Winter).
   • High (Hi) and low (Low) voltages limits.

4. Click OK to close the dialog and return focus to the Load Scenario page.

5. Click Next to proceed to the Constraints page.

Constraints

Constraints determine acceptable system conditions for the suggested switching results.

The Constraints page has two sections:

• Constraints: The Constraints section provides limits on the number of solutions and maximum search time for the scenarios.

• Objective Weights: The Objective Weights section ranks the importance of constraints on the solutions. Relative Weight field values are positive numbers; larger numbers are higher ranked and, therefore, have more weight when finding solutions.

1. (Optional) Modify the Constraints fields.
   • Maximum Number of Plans: sets the maximum number of solutions to generate.
   • Number of Steps: sets the maximum number of steps for an acceptable plan.
   • Maximum Time to Search: sets the maximum time that the system may search for solutions.
   • Only use SCADA devices: select to constrain Suggested Switching to only consider SCADA operable devices for the switching plans. This allows you to create plans that can be operated from the Control Room without sending a crew to the field.

2. (Optional) Modify the Objective Weights.
   • Minimum Feeder Voltage will try to avoid low voltages at any point on the feeder
   • Average Feeder Voltage will try to avoid low average voltages on a feeder
• **Distance to Feeder Head** will try to minimize the distance along neighboring feeders of tie switches used for load transfers

• **Feeder Remaining Capacity** will try to maximize the remaining feeder capacity of neighboring feeders

• **Tiepoint Remaining Capacity** will try to maximize the tie point capacity of tie switches used for switching

3. Click **Next** to proceed.

### Feeders

The Feeders page displays a list of tie switches to feeders that are adjacent to the selected feeder. Tie switches are displayed in priority order.

• If you do not want a feeder to be used for load transfers, uncheck the box in the **Use** column.

• To view a switch in the Viewer, select the switch in the list and click the **View...** button.

• To change the priority order of the tie switches, select a tie switch in the list and click the **Move Up** or **Move Down** button, as applicable. Switches higher in the list are given higher priority.

• Click **Next** to proceed.

The suggested switching algorithm computes the suggested switching plans based on settings from all the wizard pages that have been filled in to this point.

### Plans

The Plans page displays a list of plans generated by the Suggested Switching tool and overview information for each plan.

• **# Steps:** is the number of switching steps in the plan.

• **Affected Feeders:** lists the feeders affected by the plan.

• **Affected Switches:** lists the switches affected by the plan.

• **Violations Before:** the number of violations before the plan is implemented.

• **Violations After:** the number of violations if the plan is implemented.

**Note:** You may stop the system from generating additional plans by clicking the **Stop Solution** button. The button is only available when the system is still processing solutions (i.e., neither the **Maximum Number of Plans** or the **Maximum Time to Search** have been reached).

1. To view detailed result data and steps for a plan, select the plan in the Plans list and click the **Plan Details...** button, which will open the **Suggested Switching Plan Details** window.

### Suggested Switching Plan Details

The Suggested Switching Plan Details window provides information about the plan’s switching steps and feeder status.

• **Switching Steps Tab:** The Switching Steps tab shows the individual switching steps and the effects of each switching step on the feeder where its load is being transferred. Associated violations are shown in the Switching Step Violation tree to the right.

• **Feeder Changes Tab:** The Feeder Changes tab shows the net effect of all switching changes on each of the affected feeders. This view clearly shows the net change in violations before and after all switching steps are performed.

Click **Close** to return to the Plans page.
2. Once you have decided which plan to use, select it in the Plans list.

3. Click Next to proceed.

**Summary**

The Summary page displays the selected plan’s Switching Summary for your review and allows you to insert or append the switching steps into a switching sheet.

- To save these steps in a new switching plan, click the **Create Plan**... button. The wizard closes, and a new planned switching sheet opens in the Web Switching Management window.

- To insert these steps into a currently open switching sheet, click the **Append Steps**... button. The steps are inserted into the open sheet in the Web Switching Management window.

See **Planned Switching** on page 9-8 for more information about Web Switching Management.
Using Volt/VAr Optimization

This section includes the following topics:

- Overview
- Before You Begin
- Running the Volt/VAr Optimization Tool

Overview

Volt/VAr Optimization generates a set of optimal substation transformer tap positions and capacitor bank statuses to minimize power losses and maintain power quality as the system load changes.

The Volt/VAr Optimization tool uses a wizard approach that steps you through a series of screens to gather input and then presents the results. This allows you to maintain context and easily move backward and forward in the process as needed.

- Volt/VAr Optimization also allows you to specify a particular loading scenario against which to perform the Volt/VAr analysis. Based on the selected load scenario, Volt/VAr optimization uses the real-time load values or appropriately load values from the historic load profile for all load points in the analysis area. The user-selectable load scenarios are:
  - Real-time loads
  - Scaled loads
  - Peak loads
  - Specific period loads

In addition, you can specify the type of device controls to consider for the analysis.

Based on these settings, the tool generates a plan summary and detailed results for individual feeders, along with any violations or dropped loads. A set of implementation steps is also presented, showing substation transformer tap position and capacitor bank status changes. You can save these steps in a new switching sheet or insert them into an open switching sheet.

**Note:** Volt/Var Optimization uses Web Switching Management functionality and is only available if you are running Web Workspace with Web Switching Management. See Web Switching Management on page 15-1 for more information.

Before You Begin

You can use the Volt/VAr Optimization wizard to generate a set of steps that can be inserted into a new switching sheet or appended to an existing switching sheet. If you want to add steps to an existing sheet, do the following before you run the optimization tool:

1. Start Web Switching Management. (See Starting Web Switching Management on page 15-3.)
2. Create or select the planned switching sheet to which you want to append optimization plan steps.
3. Click the **Record** button to enable recording. This is required in order for optimization steps to be appended from the wizard.

Before you run the Volt/VAr Optimization tool, select one or more devices in the Viewer that identify which feeders you want to optimize. To select more than one device, hold down the CTRL key while clicking on devices.
Running the Volt/VAr Optimization Tool

To start the Volt/VAr Optimization tool, select one or more devices (to identify a set of feeders) in the Viewer and then select the Volt/VAr Optimization option from the DMS menu in the Web Workspace Viewer. (This option is only enabled if a device is currently selected.)

Each screen in the Volt/VAr Optimization wizard displays a context panel on the left side of the screen, which shows all the steps in the optimization process. Completed steps are shown in normal text, the current step is bolded, and the remaining steps are grayed out.

The wizard displays the following screens:

- Options Page
- Constraints Page
- Result Plan Page
  - Plan Details Page
- Summary Page

The buttons at the bottom of the dialog allow you to step forward and backward through the process or exit the tool.

Options Page

The first page of the wizard is the Options page, where you specify the basic parameters to use for the optimization. These parameters are described below:

- The **Objective** of the optimization is loss minimization.
- **Controls**:
  - **Transformer Taps** - Check this to allow the optimization to use transformer taps.
  - **Capacitor Banks** - Check this to allow the use of capacitor banks.
  - **Source Voltage** - Check this to allow the optimization to control source voltages.
- **Load Scenario Options**:
  - **Real Time Load** is the default load scenario, which uses loading for present real-time system data.
  - **Scaled Loads** uses real-time loading scaled by a factor you specify in the Scaling Factor field.
  - **Peak Loads** uses loading for the peak hour and day, based on the current day type, from the historical load profile.
  - **Specific Period Loads** uses loading from the historical load profile for the day and hour you specify here. If you specify a value in the Scaling field, then loading will be scaled by this factor.

Constraints Page

The second page of the wizard is the Constraints page, where you specify constraints, which determine acceptable system conditions, and Objective Weights, which determine the importance of different factors when performing the optimization.

- **Constraints**:
  - **Overload Limit Type** specifies the limit type, either Normal or Emergency.
- **Objective Weights** allows you to enter the relative weight of each constraint as a numerical value. Larger values have more importance.
• **Voltage Contrarians**: determines the emphasis to place on keeping voltages within limits.

• **Current Overload** determines the importance of avoiding overloads on devices such as conductors and transformers.

• **Capacitor Status Change** affects the likelihood of choosing operations which will change capacitor bank status.

• **Transformer Tap Change** affects the likelihood of the analysis choosing to change transformer tap settings.

• **Source Voltage Change** affects the likelihood of the analysis choosing to change source voltages.

**Result Plan Page**

The next page of the wizard gives an overview of the analysis results. The information on this page cannot be changed. Use the **Plan Details** button to display more detailed result data for individual feeders.

- **Plan Summary** shows loading, losses, and violations before and after optimization.
- The **Plan Implementation Steps** area lists the switching steps required to implement the optimization plan.
- The **Voltage Distribution on Affected Feeders** graph displays the voltage distribution on affected feeders before (in gray) and after (in blue) changes are made.
- Click the **Plan Details Button** to view details results. See the next section for details.

**Plan Details Page**

The Plan Details page shows detailed results for each feeder in the analysis.

When you select a feeder from the Feeders list on the top of the page, the Feeder Violations table shows any violations associated with the selected feeder.

To see the device associated with the violation, select a violation in the Feeder Violations list and click the **View...** button. (This button is enabled whenever a violation node is selected.)

**Summary Page**

The Summary page displays the implementation steps for the plan.

To save these steps in a new switching plan, click the **Create Plan...** button. The Volt/VAr Optimization wizard closes, and a new planned switching sheet opens in the Web Switching Management window.

To insert these steps into a currently open switching sheet, click the **Append Steps...** button. The steps are inserted into the open sheet in the Web Switching Management window.

See **Planned Switching** on page 15-10 for more information about Web Switching Management.
Chapter 17

Feeder Load Management

Overview

Feeder Load Management (FLM) allows you to manage energy delivery in the electric distribution system and identify problem areas. FLM monitors the vital signs of the distribution system and identifies areas of concern so that the distribution operator is forewarned and can efficiently focus attention where it is most needed. It allows for more rapid correction of existing problems and enables possibilities for problem avoidance, leading to both improved reliability and energy delivery performance.

FLM is cyclically executed and automatically triggered by pertinent changes in the electric distribution system, such as changes in SCADA measurements and/or switch status changes. FLM uses a combination of SCADA derived scaling factors, load profiles, and a globally supplied scaling factor to predict load for future forecasting.

Note: FLM will use SCADA supplied scaling factors (in addition to load profile data) for a configurable period of time before transitioning to using global scaling factors. FLM uses a linear transition between the SCADA scaling factor and the global scaling factor.

Feeder Load Management provides dynamically updated views of closest-in-time alarms, peak loads, and present loads of all the feeders. Feeder Load Management directs users to those feeders where capacity margins and/or device limits are at risk or violated.

You can view current load summaries, as well as Device Violations, Feeder Load Details, Tie Points Capacity Overview, Transformers, Capacitor Banks, and Equivalent Sources Details. You can initiate Feeder Load Management calculations in Study Mode with different load scale factors and topology to predict selected feeders performance for different switching scenarios.
Feeder Load Management Updates

Feeder Load Management information is dynamically updated after each FLM execution. FLM executes may be performed periodically and in response to changes in the electrical network. Time between FLM periodic executions, as well as other FLM execution parameters, is configurable. Administrative users can view or change this setting on the Configuration Assistant Event Management Rules Tab, in the Power Flow Related Rules category, and Feeder Load Management Rules subcategory.

Accessing Feeder Load Management Tools

You can access Feeder Load Management either from Web Workspace, Web Workspace with Web Switching Management, or Web DMS.

Note: Check with your system administrator to verify that your system has been configured to support Feeder Load Management and to obtain any special login instructions.

To start the Feeder Load Summary from Web Workspace or Web Workspace with Web Switching Management, select Feeder Load Summary from the Tools menu.

Logging in to the Web DMS Environment

The Web DMS environment allows the Operator's Workspace application to communicate and interact with the Feeder Load Management, Fault Location Analysis, and Web Switching Management applications.

To use Feeder Load Management from Web DMS, you must log into both Operator's Workspace and the Web DMS environment using the same user ID.

You can log in to the Operator's Workspace and the Web DMS environment in either order. (It does not matter which one you start first.) For instructions on logging into Operator's workspace, see Logging In on page 1-7.

To log in to the Web DMS environment:

1. Depending on how your system was installed, do one of the following:
   - Click the Web DMS icon found under the appropriate program group in your Windows Start Menu.
   - Double-click the Web DMS icon on your desktop.
   - Open a web browser and type the Web DMS URL in the browser's Address field.
     The Web DMS Login window displays.

2. Enter the user name you used to log into the Operator's Workspace application.

3. Enter the password.

4. Click the Validate button. The bottom portion of the Web DMS Login window sensitizes.

5. Select the appropriate User Type from the drop-down menu.

6. Click the Login button. Once you have successfully logged on, the Web DMS window is displayed. This window displays the connection status, and three buttons:
   - The Feeder Load Summary button opens the Feeder Load Summary window, which is described in the following section.
   - The User Preferences button opens the User Preferences dialog where the user can save current preferences or restore the default ones.
   - The Exit button closes the Web DMS window.
Using the Feeder Load Summary Window

Use the Feeder Load Summary window to monitor network feeders' performance. This window is dynamically updated to show the closest-in-time alarms, peak loads and present loads of all the feeders within the user's subscribed control zone authority. If the user subscribes to a single substation, Feeder Load Summary displays only feeders in that substation. If the user subscribes to the entire system, Feeder Load Summary displays all feeders in the entire system.

To display the Feeder Load Summary window, click the Feeder Load Summary button on the Web DMS window or select Feeder Load Summary from Web Workspace Tools menu. The following sections describe how to use the Feeder Load Summary window:

• Menu Options
• Toolbar
• Status Bar
• Feeder Load Summary Panels
  • Feeder Load Summary Table
  • Scale Factors Table
• Sorting and Filtering

Related Topics:
• Logging in to the Web DMS Environment
• Feeder Load Management

Menu Options

The Feeder Load Summary window provides the following pull-down menu options:

File Menu
• Select Print to print the Feeder Load Table's content.
• Select Exit to close the window:

View Menu
• Select the view you want to use:
  • Earliest Alarms (Ctrl-E): the Earliest Alarms list shows closest in time problems for each feeder. The list is sorted by the Date/Time column showing earlier problems first. If a feeder does not have any violations or warnings in the next 6 days, it will not be presented in the list.
  • Peak Loads (Ctrl-W): the Peak Loads list shows worst Feeder Condition for each feeder in the next 6 days. The list is sorted by the score showing worse problems first.
  • Present Loads (Ctrl-N): the Present Loads list shows the current loads, sorted by score.

Filter Menu
• Select the filter to use: All (all the feeders’ conditions), Violations Only, or Violations and Warnings.

Help Menu
• The Help menu displays the standard Help and About options.
Using the Feeder Load Summary Window

**Toolbar**

The Feeder Load Summary window provides the following toolbar options:

- ![Print](image) Click this to print the Feeder Load Summary table.

- ![Focus](image) Click this to focus the Viewer on a selected feeder. This button is disabled until you select a row(s) in the Feeder Load Summary table. If multiple rows are selected, the Viewer will focus on the first selected row's feeder. Click the name of the view you want to use. The currently displayed view is grayed.

- ![Open/Update](image) Click this to open/update the Feeder Load Management window. This button is disabled until you select a row(s) in the Feeder Load Summary table that has FLM data available. If multiple rows are selected, the Feeder Load Management window displays the details for multiple feeders.

- ![Balloon](image) Click this to toggle on/off the balloon dialog. When this button is toggled on and a Summary row is selected, a balloon dialog displays the selected feeder head's data source and data quality information. See Data Source and Data Quality on page 17-21 for more information.

- ![Close](image) Click this to close the Feeder Load Summary window.

- ![View Option](image) The view option menu allows you to select the list view.

- ![Auto Filter](image) Click this button to show only rows that match the selected cell. This button is disabled until you select a row in the Feeder Load Summary table. Once an auto filter is applied, this button is replaced by the Auto Filter Off button.

- ![Auto Filter Off](image) Click this button to remove a previously selected auto filter.

The toolbar also displays the current summary view name and the names of applied filters and sorts, as shown below:

**Filter: All  Sort: Date/Time (+)**

**Status Bar**

The Feeder Load Summary window status bar displays the user type: Administration, Full Operations, or View Only.

Only Administration users will see buttons on the status bar, as shown below:

**Administration**

Use the ![Save](image) button to save changed scale factors for future Feeder Load Management calculations.
Use the button to start a new Feeder Load Management calculation. If a calculation is already in progress, the system will return a message that a forecast is in progress and that changes will be reflected in the next solution, which will begin immediately after the in-progress calculation is completed.

**Feeder Load Summary Panels**

The Feeders Load Summary window is divided into two sections or panels, and each panel displays a table:

- **Feeder Load Summary Table**
- **Scale Factors Table**

**Feeder Load Summary Table**

The Feeder Load Summary table shows a list of feeders. By default, the Earliest Alarms view is displayed. Other available views are Peak Loads and Present Loads. To switch between views, click the appropriate toolbar button or select the appropriate option from the View menu.

The Feeder Load Management Summary table displays the following fields and buttons.

- **Substation** – the substation name.
- **Feeder** – the feeder name. This column displays a yellow background for feeders with abnormal data quality or/and data source for any of the phases. See Data Source and Data Quality on page 17-21 and Feeder/Device Condition Names and Colors on page B-5 for more details.
- **Phase** – phase with the maximum capacity utilization.
- **Util %** – feeder head utilization capacity.
- **Amps** – electrical current on the phase with the maximum capacity utilization.
- **KW** – active power on the phase with the maximum capacity utilization. This column is hidden by default. Right-click the table's header to open the Select Columns dialog, where you can select/unselect columns to display.
- **kVAr** – reactive power on the phase with the maximum capacity utilization. This column is hidden by default. Right-click the table's header to open the Select Columns dialog where you can select/unselect columns to display.
- **kV** – voltage on the phase with the maximum capacity utilization.
- **Feeder Condition** – violation or warning (if any) on a feeder. When multiple violations/warnings occur on a feeder, this column shows the highest-level violation. Traffic signal coloring is used for this column:
  
  Red = Violations Exist,
  Yellow = Warnings Exist,
  Green = No Warnings/Violations Exist.

  This column's values and coloring are configurable by changing the FLMSummary.xml file. See Feeder/Device Condition Names and Colors on page B-5 for a list of feeder/device conditions and their corresponding cell and text coloring.

- **Date/Time** – date and time for the displayed feeder condition.
- **Updated** – date and time of the last update for the feeder (only for Earliest Alarms and Peak Loads Views).
- **Score** – EDA score of the feeder at the time of the condition.
- # Alarms – total number of alarms on the feeder at the time.

Scale Factors Table
This table displays load week days’ scale factors for future Feeder Load Management forecasts calculations. The pink background highlights the current day’s scale factor. (Only administration users can edit the scale factors in this table.) This table is updated every time the Feeder Load Summary table is updated.

Sorting and Filtering
By default, the Earliest Alarms view’s rows are sorted by time in ascending order. The Peak Loads and Present Loads view’s rows are sorted by score in descending order. The Feeder Load Management Summary table supports Quick Sorting, Dynamic Filtering, and Auto Filtering.

Feeder Load Management Summary Updates
The FLM Summary window is dynamically updated after each FLM execution, which may be performed periodically or in response to changes in the electrical network. Time between FLM periodic executions, as well as other FLM execution parameters, is configurable. Administrative users can view or change this setting on the Configuration Assistant Event Management Rules Tab, in the Power Flow Related Rules category and Feeder Load Management subcategory.

Feeder Load Management
The Feeder Load Management window provides detailed information about feeder loads, device violations and warnings, tie points capacity, and regulation devices. It supports real-time and study mode.

This section includes the following topics:
- Accessing the Feeder Load Management Window
- Using the Feeder Load Management Window
- Viewing and Modifying Study Session Parameters
- Requesting a New Feeder Load Management Calculation

Related Topics:
- Logging in to the Web DMS Environment
- Using the Feeder Load Summary Window

Accessing the Feeder Load Management Window
You can open the Feeder Load Management window from the Viewer or from the Feeder Load Summary window.

From a Viewer
To open the Feeder Load Management window from a Viewer, do one of the following:

- If you are using the Web Workspace Viewer, click the button on the Viewer toolbar.
- If you are using Operator's Workspace, select the Feeder Load Management button on the Control Tool started from the Viewer.

The Feeder Load Management mode is defined by the Viewer's mode.

Note: Feeder Load Management can be disabled for some of the feeders during the Model Build (see Model Build Guide for more information). If Feeder Load Management is disabled for a feeder, the Feeder Load
Management button will be disabled when that feeder is selected in the Web Workspace Viewer.
Feeder Load Management

From Operator’s Workspace Control Tool (Web DMS Mode)
To open the Feeder Load Management window from the Operator’s Workspace Control Tool, select the Feeder Load Management button on the Control Tool. The Feeder Load Management window opens for the device. The Feeder Load Management mode is defined by the Viewer's mode.

**Note**: Feeder Load Management can be disabled for some of the feeders during the Model Build. If you click the Feeder Load Management button for such a feeder, the system displays the following message: “Feeder Load Management is disabled for the selected feeder(s)”.

From the Feeder Load Summary Window
From the Feeder Load Summary window, you can open the Feeder Load Management window for a single feeder or for multiple feeders.

- To open the Feeder Load Management window for a single feeder, double-click the corresponding row in the Feeder Load Summary table or right-click the row and select Feeder Load Mgmt Tool or Feeder Load Mgmt Tool 2 from the pop-up menu.
- To open the window for multiple feeders, select the corresponding rows in the Feeder Load Summary Table and click the button on the toolbar.

The Feeder Load Management window opens in real-time mode. Once the window is open, you can switch modes by pressing the corresponding button on the toolbar.

**Note**: The system allows you to have two open Feeder Load Management Tools at any time. Multiple Feeder Load Management Tools can be used to compare the details for different feeders.

Using the Feeder Load Management Window
Use the Feeder Load Management window to view detailed information about feeder loads, device violations and warnings, tie points capacity, and regulation devices. You can initiate Feeder Load Management calculations in Study Mode with different load scale factors and topology to predict selected feeders’ performance for different switching scenarios.

The Feeder Load Management window displays a pull-down menu, toolbar, status bar, and two views. It has two modes: study and real-time. Each of these components is described in the sections that follow:

- **Menus and Toolbar**
- **Options Menu**
- **Status Bar**
- **Graphical View**
- **Feeder Load Overview View**
- **Feeder Load Management Details**
- **Using Real-Time and Study Mode**
- **Viewing and Modifying Study Session Parameters**
- **Requesting a New Feeder Load Management Calculation**
- **Selecting Columns to Display**
- **Data Source and Data Quality**
Related Topics:
- Overview
- Logging in to the Web DMS Environment
- Accessing the Feeder Load Management Window
- Using the Feeder Load Summary Window

Menus and Toolbar
The Feeder Load Management window provides the following pull-down menu options and toolbar options.

File Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td>Closes the Feeder Load Management window.</td>
<td></td>
</tr>
</tbody>
</table>

Filter Menu
Select the filter to use for limiting the feeders displayed in the Feeder Load Overview table. Available filters are:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Displays all data.</td>
<td>--</td>
</tr>
<tr>
<td>Present Measurements</td>
<td>Displays only data for the present time.</td>
<td>--</td>
</tr>
<tr>
<td>Hourly Forecasts</td>
<td>Displays only forecasts for the next 24 hours.</td>
<td>--</td>
</tr>
<tr>
<td>Daily Peaks</td>
<td>Displays only daily peak forecasts for the next 6 days.</td>
<td>--</td>
</tr>
</tbody>
</table>

Actions Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real Time</td>
<td>Switches to real-time mode. (This option is grayed if Real-Time Mode is active.)</td>
<td></td>
</tr>
<tr>
<td>Study Mode</td>
<td>Switches to study mode. (This option is grayed if Study Mode is active.)</td>
<td></td>
</tr>
<tr>
<td>Re-enable Island</td>
<td>The <strong>Re-enable Island</strong> action is enabled for Administration users when selecting a row with a Non-Convergent solution. The action tells PFService to attempt to solve the island for the next forecast.</td>
<td>--</td>
</tr>
</tbody>
</table>
Options Menu

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Flow Options...</td>
<td>Allows you to configure Real-Time Power Flow Options if you are in real-time mode. If you are in Study Mode, click this button to configure Study Mode Load Scenario.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Select Columns...</td>
<td>Opens the Select Columns to Display dialog for you to select which columns you want to appear in the table on the Feeder Load Management window. If a column is not checked, it will be displayed in the Additional Columns balloon details window rather than on the main window.</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>

Help Menu

The Help menu provides standard Help and About options.

Status Bar

The status bar displays at the bottom of the Feeder Load Management window. It provides the following information:

- Indicates that the tool is currently in real-time mode.
- Indicates that the tool is currently in study mode.
- Indicates that real-time updates are available to currently displayed data. To refresh all currently displayed real-time data on the Feeder Load Management window, click the button. Note that this button is disabled when there are no updates available or when the Feeder Load Management Tool is in study mode.
- Indicates that the data displayed in the tool is current.

Using Real-Time and Study Mode

If you start or update the Feeder Load Management Tool from the Viewer, the tool's mode is defined by the Viewer's mode.

If you start or update the tool from the Feeder Load Summary window, the tool opens in real-time mode. Once the tool is open, you can switch modes by pressing the corresponding button on the toolbar or selecting the appropriate menu option.

When you start the tool in Study Mode or switch from real-time to study mode inside the tool, the Power Flow Study Mode Load Scenario dialog prompts you to select the Load Profile from either the real-time system or from a specific period (hour and type of day).

Graphical View

The Graphical View tab is displayed when you initially start the Feeder Load Management tool. This view allows you to quickly see the trends in the forecasted data.

This view shows five different graphs:

- Feeder Head Current
- Total Feeder Violations
- Feeder Head Voltages
• Feeder Head Real Power
• Feeder Head Reactive Power

For the currents, voltages, and power graphs, the bar graphs show three bars, representing results data for three phases.

Use the Feeder selection box at top of tab to display data for a different feeder, if the Feeder Load Management Tool is showing results for more than one feeder.

When you hover over a point on a graph, a pop-up box displays the actual data values, as shown below:

• The X axis displays the time of the forecast, with values for real-time loading, 24-hour forecast values, and 6 daily peak forecasts.
• The axis label colors are based on forecast type and are consistent with the colors used on the Date/Time column of the tabular display.
• Use the slider between the left side of the tab (displaying the Current and Violations) and the right side of the tab (displaying Voltage and Power) to resize the graphs.

Feeder Load Overview View

The Feeder Load Overview provides feeder load data for the feeder(s) that were selected when the Feeder Load Management window was initiated or updated (either from the Viewer or the Feeder Load Summary window).

In real-time mode, the Feeder Load Overview displays:
• Present measurements (Date/Time column values in green),
Next 24 hours forecasts (Date/Time column values in black), and
Daily peak forecasts for 6 days after current day (Date/Time column values in blue).

In Study Mode, the Feeder Load Overview displays current study session data calculated by the Feeder Load Management tool based on the user’s request from the **Viewing and Modifying Study Session Parameters**.

This panel includes a table and a toolbar. The table includes the following columns:

- **Substation** – The substation name.
- **Feeder** – The feeder name. This column displays a yellow background for rows with abnormal data source or/and data quality for any of the phases. See **Feeder/Device Condition Names and Colors** on page B-5 for more details.
- **Amps A** – Phase A feeder head load and utilization capacity.
- **Amps B** – Phase B feeder head load and utilization capacity.
- **Amps C** – Phase C feeder head load and utilization capacity.
- **Limit Device (%)** - device name and usage percentage for a phase limiting device with the biggest usage. Visible by default.
- **Limit Device A (%)** - Phase A limiting device name and usage percentage. Hidden by default.
- **Limit Device B (%)** - Phase B limiting device name and usage percentage. Hidden by default.
- **Limit Device C (%)** - Phase C limiting device name and usage percentage. Hidden by default.
- **kW** - Total kW for all phases
- **kW A** – Feeder Head Phase A Active Power. This column is hidden by default in the main table and appears in the Additional Columns balloon.
- **kW B** – Feeder Head Phase B Active Power. This column is hidden by default in the main table and appears in the Additional Columns balloon.
- **kW C** – Feeder Head Phase C Active Power. This column is hidden by default in the main table and appears in the Additional Columns balloon.
- **kVar** - Total kVAr for all phases.
- **kVar A** – Feeder Head Phase A Reactive Power. This column is hidden by default in the main table and appears in the Additional Columns balloon.
- **kVar B** – Feeder Head Phase B Reactive Power. This column is hidden by default in the main table and appears in the Additional Columns balloon.
- **kVar C** – Feeder Head Phase C Reactive Power. This column is hidden by default in the main table and appears in the Additional Columns balloon.
- **kV A** – Feeder Head Phase A Voltage.
- **kV B** – Feeder Head Phase B Voltage.
- **kV C** – Feeder Head Phase C Voltage.
- **Loss** – Power loss for the feeder.

**Note:** Some fields are displayed in the table by default, and others appear in the Additional Columns balloon dialog by default. Use the **Set Columns...** option on the Options menu to configure which fields you want to appear in the table on the main window and which ones you want to appear in the balloon dialog.
• **Feeder Condition** – The violation or warning (if any) on a feeder. See Feeder/Device Condition Names and Colors on page B-5 for the range of values and colors for this column. When multiple violations/warnings occur on a feeder, this column shows the highest-level violation.

• **Date/Time** – The date and time for the displayed feeder condition.

• **Score** – The EDA score of the feeder at the time of the condition.

  - The number of conductor overloads.

  - The number of switch overloads.

  - The number of feeder capacity violations.

  - The number of service transformer overloads.

  - The number of power transformer overloads.

  - The number of voltage violations.

  - The number of backfeeds.

• **Source A** - Phase A source. This column is hidden by default in the main table and appears in the Additional Columns balloon. See Selecting Columns to Display for more details.

• **Source B** - Phase B source. This column is hidden by default in the main table and appears in the Additional Columns balloon.

• **Source C** - Phase C source. This column is hidden by default in the main table and appears in the Additional Columns balloon.

• **Quality A** - Phase A quality code. This column is hidden by default in the main table and appears in the Additional Columns balloon.

• **Quality B** - Phase B quality code. This column is hidden by default in the main table and appears in the Additional Columns balloon.

• **Quality C** - Phase C quality code. This column is hidden by default in the main table and appears in the Additional Columns balloon.

**Toolbar**

The Feeder Load Overview Panel toolbar provides the following options:

• Click to open the Feeder Load Management Details for the selected row.

• Click to focus the Viewer on a selected feeder. This button is disabled until the user selects a row in the Feeder Load Overview table.

• Click to print the Feeder Load Overview table.

• Click this to toggle on/off the balloon dialog. When this button is toggled on and a Load Overview row is selected, a balloon dialog displays the selected row’s hidden columns.

• Click this button to show only rows that match the selected cell. Once an auto filter is applied, this button is replaced by the Auto Filter Off button.
Sorting and Filtering

The Feeder Load Management tabular view supports **Quick Sorting**, **Dynamic Filtering**, and **Auto Filtering**.

Selecting Columns to Display

You can choose which columns of data you want to appear in the tables on the Feeder Load Management Tabular View tab. This allows you to focus on particular information.

To select columns for display, follow these steps:

1. Choose **Select Columns...** from the Feeder Load Management Actions menu or right-click the Feeder Load Management table header and choose **Select Columns...** from the pop-up menu. A list of available columns is displayed. Checked columns are currently displayed.
2. To add a column that is not currently displayed, click in the checkbox next to the column name.
3. To remove a column that is currently displayed, click to uncheck the box.
4. Click **OK**.
5. If you want to save these columns settings so they will be used in future sessions, select **User Preferences** from the Web Workspace Tools menu, and then click **Save**.

Displaying Data for Hidden Columns

If you have one or more columns currently hidden from view, you can use the balloon dialog to display the hidden data. Follow these steps:

1. First, make sure that the balloon dialog is enabled for the table containing the hidden columns.

   If not currently enabled, click the button in the panel's toolbar.

   **Note:** If all columns are currently displayed in the table, the balloon dialog button is disabled.

2. Click on a specific cell or row in the table. The balloon dialog displays all hidden columns and data in table format, as shown below:
Viewing the Limiting Device by Phase
To view the limiting device in the viewer, right-click the Feeder Load Overview row and select from the View Limit Device Phase options for the applicable phase (e.g., View Limit Device Phase A). Viewer 1 will focus on the device.

Starting a Study Session for Selected Row Profile
Each row in the Feeder Load Management window corresponds to a specific network condition. By selecting Study Session for Selected Row Profile from the right-click option menu, you can go directly into the Power Flow Study Mode Load Scenario to begin a study session in the Viewer based on the load profile of the row.

Note that if your system is configured to use the FLM_SCADA_ONLY and the FLM_PROFILE_ONLY SRS Rules, real-time SCADA data will affect some real-time forecast rows. In these cases, results seen in the Study Mode Viewer will not exactly match the Feeder Load Management row because the Viewer only uses the load profile.

Feeder Load Management Details
The Feeder Load Management Details window provides information about a selected row in the Feeder Load Management Feeder Load Overview View. It is accessed by double-clicking the row or by clicking the button.

The Feeder Load Management Details window has six possible tabbed data views. Any views that do not return data will be desensitized.

- **Violations** – displays identified device overload violations and energy assessment warnings for the feeder selected in the Feeder Load Overview View.
- **Tie Points** – displays all three-phase open tie points for the feeder selected in the Feeder Load Overview View.
- **Transformers** – displays all Transformers electrically connected to feeder selected on the Feeder Load Overview View.
- **Capacitors** – displays all downstream capacitor banks for the feeder selected on the Feeder Load Overview View.
- **Equivalent Sources** – displays all sources electrically connected to the feeder selected on the Feeder Load Overview View.
• **Load Details** – displays SCADA measurements for applicable devices.

### Violations

The **Violations** tab displays identified device overload violations and energy assessment warnings for the feeder selected in the **Feeder Load Overview View** panel.

The Violations data includes the following columns:

- **Device** – The device’s name
- **Violation** – The violation or warning name. See **Feeder/Device Condition Names and Colors** on page B-5 for range of values and colors for this column.
- **Phase** – The phase that the violation is on
- **Value** – The violation/warning value
- **%** – Value percent of limit. The Violations table is sorted based on this column.
- **Limit** – The device limit for violated attribute.
- **Units** – The validation type unit (i.e., A, kVA, kVAr, kV).

### Violations Toolbar

The Violations toolbar provides the following options:

- Click 🕵️ to focus the Viewer on the selected device.
- Click 📨 to print the table.
- **Violations Only**, **Warnings Only**, or **Violations and Warnings** options menu to select the data criteria.
- Use the check boxes (see below) to display the violations and/or warnings based on the chosen criteria. The number of each type is listed to the right of the name.

### Tie Points

The **Tie Points** tab displays all three-phase open tie points for the feeder selected in the **Feeder Load Overview View**. A tie point is a three-phase open switch of an accepted and configured set of switch classes. The open switch doesn’t need to be in its nominal position.

The Tie Points Capacity table includes the following columns:

- **Tie Point** – The tie point name
- **To Feeder** - The adjacent feeder that will be connected to the current feeder if the tie point is closed.
- **To Substation** - The **To Feeder**'s substation name
- **To Feeder Amps A** - To Feeder Phase A Current
- **To Feeder Amps B** - To Feeder Phase B Current
- **To Feeder Amps C** - To Feeder Phase C Current
- **Pickup Amps A** - Phase A current pickup capacity
- **Pickup Amps B** - Phase B current pickup capacity
- **Pickup Amps C** - Phase C current pickup capacity
• **Limit Device Phase A** - ID of limiting device for Phase A.
• **Limit Device Phase B** - ID of limiting device for Phase B.
• **Limit Device Phase C** - ID of limiting device for Phase C.

**Tie Points Toolbar**
The Feeder Tie Points Capacity Overview toolbar provides the following options:

• Click to focus the Viewer on a selected feeder. This button is disabled until the user selects a row in the Tie Points Capacity table.

• Click to open Feeder Load Management 2 for the feeder listed in the To Feeder column of the selected row. This button is disabled until the user selects a row in the Tie Points Capacity Overview table. If Feeder Load Management 2 is already open, it is updated with the data for the “To Feeder.”

• Click to print the Tie Points table.

**Transformers**
The Transformers tab displays all Transformers electrically connected to feeder selected on the Feeder Load Overview View.

The Transformer Details table includes the following columns:

- **Device** – The device name
- **kV A** – Device Phase A Voltage
- **kV B** – Device Phase B Voltage
- **kV C** – Device Phase C Voltage
- **Voltage Setpoint** - The regulation set point. Administration and Full Operations users can change the value of this column when the Regulation Type is not “No Tap” or “Fixed Tap” and the Automatic Control is on.
- **Tap Step** - The tap step position. Administration and Full Operations users can change the value of this column to a value between Min Tap Step and Max Tap Step when the Regulation Type is not “No Tap” and the Automatic Control is off.
- **Min Tap Step** - The minimum tap step position
- **Max Tap Step** - The maximum tap step position
- **Regulation Type** – The regulation type
- **Automatic Control** – Administration and Full Operations users can switch the value of this column between on and off when the Regulation Type is not “No Tap” or “Fixed Tap.”
Capacitors

This tab displays all downstream capacitor banks for the feeder selected on the Feeder Load Overview View.

The Capacitors table includes the following columns:

- **Note**: Administration and Full Operations users can change some of regulation devices parameters in Real-Time Mode for non-SCADA devices. Both SCADA and non-SCADA devices settings can be edited in Study Mode. Editable cells display a pink background.

Press the button on the tab's toolbar to save the changes and trigger resolve for the selected feeder. Editing in Real-Time Mode is available only when a present load row is selected in the Feeder Load Overview table.

- **Device** – The device name
- **kVar A** – Device Phase A Reactive Power
- **kVar B** – Device Phase B Reactive Power
- **kVar C** – Device Phase C Reactive Power
- **On Threshold** - The on threshold. Administration and Full Operations users can change the value of this column when the Regulation Type is not fixed and the Automatic Control is on.
- **Off Threshold** - The off threshold. Administration and Full Operations users can change the value of this column when the Regulation Type is not fixed and the Automatic Control is on.
- **# Energized Capacitors** – The number of energized capacitors. Administration and Full Operations users can change the value of this column to a value between 0 and # Total Capacitors when the Automatic Control is off.
- **# Total Capacitors** – The total number of capacitors
- **Regulation Type** – The capacitor regulation type. The regulation types is displayed as one of the following: Fixed, Bus Voltage, Line Current, Line VAR, Line Power Factor, or Temperature.
- **Measurement Attribute** – The monitored attribute of regulated bus voltage, line flow, or area time/temperature.
- **Automatic Control** – Administration and Full Operations users can switch the value of this column between on and off when the Regulation Type is not fixed.

Equivalent Sources

This tab displays all sources electrically connected to the feeder selected on the Feeder Load Overview View.

The Equivalent Sources table includes the following columns:

- **Source Name** – The name of the source
- **kW A** – Source Phase A Active Power
- **kW B** – Source Phase B Active Power

Note: Administration and Full Operations users can change some of regulation devices parameters in Real-Time Mode for non-SCADA devices. Both SCADA and non-SCADA devices settings can be edited in Study Mode. Editable cells display a pink background.

Press the button on the tab's toolbar to save the changes and trigger resolve for the selected feeder. Editing in Real-Time Mode is available only when a present load row is selected in the Feeder Load Overview table.
- **kW C** – Source Phase C Active Power
- **kVAR A** – Source Phase A Reactive Power
- **kVAR B** – Source Phase B Reactive Power
- **kVAR C** – Source Phase C Reactive Power
- **Amps A** – Source Phase A Current
- **Amps B** – Source Phase B Current
- **Amps C** – Source Phase C Current
- **kV** - Administration and Full Operations users can change the value of this column for non-SCADA devices. The user can edit measurements for SCADA devices in the SCADA Summary. To open the SCADA Summary window, right-click a row for SCADA device and select the **SCADA Summary** in the popup menu.
- **Angle** - Administration and Full Operations users can change the value of this column for non-SCADA devices.
- **Validity** - Data validity. Possible values: Valid, Suspect, or Invalid.

### Load Details

The Load Details tab displays all sources electrically connected to the feeder selected on the [Feeder Load Overview View](#). The feeder head will typically characterize each feeder and 3 to 5 closed sectionalizing devices. Some of these sectionalizing devices will have measurements and may be supervisory control points. Note: This panel is available only when a present load row is selected in the Feeder Load Overview table.

The Load Details includes the Feeder Load Details table and a toolbar. The Load Details table includes the following columns:

- **Device Name** – The name of the device
- **Amps A** – Source Phase A Current
- **Amps B** – Source Phase B Current
- **Amps C** – Source Phase C Current
- **kW A** – Source Phase A Active Power
- **kW B** – Source Phase B Active Power
- **kW C** – Source Phase C Active Power
- **kVAR A** – Source Phase A Reactive Power
- **kVAR B** – Source Phase B Reactive Power
- **kVAR C** – Source Phase C Reactive Power
- **kV A** – Source
- **kV B** – Source
- **kV C** – Source
- **Quality A** – Phase A SCADA data quality
- **Quality B** – Phase B SCADA data quality
- **Quality C** – Phase C SCADA data quality
Viewing and Modifying Study Session Parameters

The Study Session Parameters dialog allows you to request a new Feeder Load Management calculation for the current study session's topology. You can specify power flow options, the start date and time, type, and number of forecasts to calculate. You can also change the scale factor for any day of a week.

An existing study session is used as the Feeder Load Management Tool Study Session or, if none exists, a new study session is created based on the real-time data. The user can reset the study session from the Viewer. The session can be reset to nominal or real-time data. The Feeder Load Management mode does not change when the Viewer switches between real-time and study mode.

To display the Study Session Parameters dialog, do one of the following:

- In real-time mode, click the button on the Feeder Load Management Tool toolbar or select Study Mode from the Actions menu.

- In study mode, click the button on the Feeder Load Management Tool toolbar or select FLM and Power Flow Options from the Actions menu.

The Study Session Parameter dialog displays the following fields and buttons:

Feeder Load Management Options Panel

- **Start Date/Time** - The start date and time for the calculation. Requested calculations must be within a week (7 days) of the current date/time.

- **Hourly Forecasts / Daily Peak Forecasts** - The type of forecast to calculate. You can request either hourly or daily peaks forecasts calculations (but not both).

- **Number of Hourly Forecasts** - The number of hourly forecasts to calculate. This value must be between 1 and 24. (This value is used only if Hourly Forecasts is selected above.)

- **Number of Daily Forecasts** - The number of daily forecasts to calculate. This value must be between 1 and 7. (This value is used only if Daily Peak Forecasts is selected above.)

Limits Panel

- **Limit Type** - Indicates the limit type, either Normal or Emergency.

- **Season** - Indicates the season, such as Spring, Summer, etc.

- **Voltage Limits** - Specifies high and low voltage limits.

- **Modify Button** - opens the Power Flow Study Mode Load Scenario dialog with the option to change the limits.

Scale Factors (Sunday through Saturday) - The scale factors to use for each day of the week.

Buttons

- **Reset to Defaults** - Click this to reset to real-time values.

- **OK** - Click this to request the calculation for the selected feeders. Once the calculation is finished, the dialog will close and the data will be loaded to the Feeder Load Overview View.

- **Cancel** - Click this to exit the Study Session Parameters dialog.
Requesting a New Feeder Load Management Calculation

To request a new Feeder Load Management Study Mode calculation, follow these steps:

1. Do one of the following to open the Study Session Parameters dialog:
   - In real-time mode, click the button on the Feeder Load Management toolbar or select Study Mode from the Actions menu.
   - In study mode, click the button on the Feeder Load Management toolbar or select Study Session Parameters from the Actions menu.

2. Complete the fields on the Study Session Parameters dialog.

3. Click the Apply button. The results of the calculation are displayed on the Feeder Load Management Overview Panel.

4. View other Feeder Load Management Window Panels for more information.

Data Source and Data Quality

Possible sources of data for a feeder head are Default, SCADA, or Manual Entry. SCADA is considered to be the normal source; the other two are considered abnormal.

Possible data quality values:

• Valid – data is valid.
• Suspect – there are inconsistencies in the data that the system cannot reconcile, which indicates a possible misconfiguration of SCADA or model data.
• Invalid – the SCADA system has reported a measurement as being unusable.
• Load – indicates a measurement is suspect because the system is unable to scale the loads to match it.
• Profile – indicates a potential mismatch between modeled load profile Power Factor and the value determined from SCADA. Incorrectly modeled Cap banks can also trigger this value.
• Filtered – Value from SCADA was not used to scale Power Flow solution.

A yellow background for a feeder name in Feeder Load Summary or Feeder Load Overview indicates that the feeder head data source or/and quality is abnormal.

Data source, quality, and alarm counts are not included in the Feeder Load Management table by default. To see this additional information, enable balloon details and then click a row in the table.

See Also

• Power Flow Status Messages on page 16-5.
• Feeder/Device Condition Names and Colors on page B-5.
Identifying Devices with SCADA Suspect and SCADA Non-Converged Results

After finding that a power flow will not solve due to a suspect SCADA data, you can use FLM to identify the devices that are returning bad data. You may identify the problem by viewing a device in the Viewer and seeing that the Power Flow will not solve or by seeing a Suspect SCADA feeder condition in the Feeder Load Summary, as shown below.

1. Once you have opened FLM, notice the row with the Suspect SCADA condition.

2. Select the row and click the Feeder Load Management Details button.
3. Select a row with Suspect data and click the target button to focus the Viewer on the device.

4. The evaluation of the SCADA data issue is dependent on the situation and your SCADA implementation, but in this example we find that the device is reporting higher current values on all phases than the next upstream device:
This chapter describes Fault location, Isolation, and Service Restoration (FLISR) functionality.

Note: The features described in this chapter are specific to the Fault Location, Isolation, and Service Restoration functionality. For information about the Fault Location Analysis feature, see Fault Location Analysis on page 19-1.

This chapter includes the following topics:

- Overview
- Setting the FLISR Mode
- Using FLISR with Work Agenda
- Using the FLISR Report Tool
- Viewing FLISR Disabled Devices
- Viewing FLISR Conditions
- Using the FLISR Flow Summary Window

Overview

The Oracle Utilities Network Management System – Fault Location, Isolation and Service Restoration (FLISR) responds to protection trips of SCADA monitored and controlled switches (i.e., feeder circuit breakers (CB) and downstream reclosers (ACR)). FLISR automatically identifies the faulted section using the telemetered Protection Trip and Fault Indication flags and then (in Auto Mode) automatically schedules the isolation and restoration actions to restore the non-faulted areas de-energized by isolating the fault. In Manual Mode, FLISR will present the isolation and restoration actions for execution by the user.

Note: FLISR requires switching management functionality. You can run FLISR in either of the following environments:

- Web Workspace with Web Switching Management
- Operator's Workspace and Switching Management

The following figures show the sequence of events in a FLISR scenario.

The first figure shows the various scenarios in the momentary processing. The scenarios are:

1. A breaker trips and is followed a short time later by a reclose operation.
2. A breaker trips and is followed by a recloser lockout.
3. A breaker trips but the device has no recloser lockout signal available. FLISR waits a configurable amount of time and, in the absence of a close operation, assumes lockout to have occurred.

### Momentary Processing

<table>
<thead>
<tr>
<th>Scenario 1: Device OPEN</th>
<th>Scenario 2: Lockout Signaled</th>
<th>Scenario 3: Timer Expired</th>
</tr>
</thead>
</table>

**Note:** RO (Real Outage) is created only if customer supply nodes are de-energized as a result of the operation.

Once an RO is created, the FLISR processing sequence shown in the following figure is initiated.

### FLISR Time Line

The control sequence (starting at around 25 seconds) is only performed in automatic mode. In manual mode an operator must initiate the control sequence.
Timings in the above diagram are only indicative. Actual values will depend on the complexity of the solution required and the responsiveness of the isolate/restore controls sent to SCADA. The following timings are deterministic:

- The delay allowed for demand scans. This is configurable and defaults to 10 seconds.
- The maximum solution time allowed in automatic mode. This is configurable and defaults to 15 seconds. If the solution takes longer to solve than this time, FLISR will not automatically execute the control sequence. The option for an operator to manually initiate the control sequence is preserved.
- Maximum time allowed for automatic operations after the lockout is: Demand scan delay + maximum solution time. The default configuration is 25 seconds.
- Wait times for Recloser operations. These are 20 seconds.
- Any error conditions detected during process are logged in the Event Log.

Setting the FLISR Mode

FLISR supports three different modes of operation:

- **Disable** - Disables FLISR from calculating, generating or executing a restoration plan. FLISR still automatically performs disables/enables functions.
- **Manual** - Places FLISR in manual mode, where restoration plans are automatically generated but must be manually executed by the operator via a switching sheet generated from the FLISR Tool.
- **Automatic** - Places FLISR in Automatic Mode, which automatically generates and executes switching sheets.

To set the FLISR mode if you are using FLISR with Web Switching Management, select **FLISR Mode** from the Tools menu in Web Workspace with Web Switching Management, and then select the desired mode (Disable, Manual, or Automatic).

To set the FLISR mode if you are using FLISR with Switching Management, select the **Disable**, Manual, or Automatic button in the FLISR Control Toolbox in the Environment Manager. A status field is available on the Environment Manager panel, which indicates FLISR Mode: Disabled, FLISR Mode: Manual or FLISR Mode: Automatic.
Enabling and Disabling FLISR Devices from the Control Tool

You can enable or disable devices for FLISR actions by clicking the Enable FLISR or Disable FLISR buttons from the Control Tool. These buttons are displayed for all FLISR devices.

When a FLISR device is disabled, a condition flag is shown on the Viewer adjacent to the device as shown in the following figure:

Note: Disabling a Circuit Breaker or a Recloser will implicitly disable all downstream FLISR actions. Disabling a non-reclosing device (i.e., a simple sectionalizer) will only disable the individual device.

Using FLISR with Work Agenda

The Work Agenda is the starting point for viewing the status and results of the FLISR calculations. Each outage row is color-coded to represent the FLISR status of a job.

The background color of the “Event #” field in the Work Agenda list indicates the FLISR status:

- **Yellow** - The job is currently being processed as a FLISR job and a solution is being searched for.
- **Green** - A FLISR solution has been found for the job.
- **Light Red** - A FLISR solution has been found but it overloads the restoring feeder – manual intervention will be required.
- **None** - No FLISR solution can be found for this job.
Using the FLISR Report Tool

The FLISR report tool summarizes the SCADA devices and their signals and the recommended restoration plans.

If you are using FLISR with Web Switching Management, do the following to start the FLISR tool:

- Select a FLISR event in the Web Workspace with Web Switching Management Work Agenda. Right-click the event and select **FLISR Report...** from the pop-up menu or select **FLISR Report...** from the Actions menu. The Fault Location, Isolation, and Service Restoration Tool window opens for the selected event.

  **Note:** These options are only available if the selected event is a FLISR event.

If you are using FLISR with Switching Management, select the outage and select the **FLISR Report Tool** option from the Work Agenda’s **Actions Menu**.

The Fault Location, Isolation, and Service Restoration window opens, displaying the following information:

- **SCADA Measurements.** This summarizes the status of all FLISR devices downstream of the tripped device.
  - **Device Name** displays the alias of the device. Select the row that will allow you to “target” the isolation switch in the Viewer.
  - **Status** displays the tripped/closed status of all associated SCADA devices.
  - **Previous Amps** displays the pre-fault amps through the associated SCADA devices. This is calculated from the pre-fault MW and pre-fault MVAr.
  - **Fault Indicator** displays the fault indication status of all associated SCADA devices.
  - **Lockout Status** displays the reclose lockout status of all associated SCADA devices.
  - **Previous MW** displays the pre-fault MW through all associated SCADA devices.
  - **Previous MVAr** displays the pre-fault MVAr through all associated SCADA devices.
  - **Quality** displays the relevant SCADA status of the associated SCADA device’s status, reclose lockout, fault indication, and analog signals.

- **FLISR Plans**
  - **Isolation Switch** displays the alias of the SCADA device used as the isolation point, in the FLISR-generated restoration plan.
  - **Pickup Amps** displays the expected amps (load) in the section except the isolation switch, which is to be transferred to another feeder.
  - **Preferred Restore Option** allows you to select/deselect a FLISR restoration plan. This is displayed only if you are using FLISR with Switching Management. In FLISR with Web Switching Management, a checkbox appears to the right of the Isolation Switch column, which serves the same purpose.
  - **Restore Switch** displays the alias of the SCADA device used as the restoration point in the FLISR-generated restoration plan.
  - **Feeder** displays the feeder name to which supply is being transferred.
  - **Before Fdr Amps** displays the amps on the feeder to which supply is being transferred.
  - **After Fdr Amps** displays the expected amps (load) on the feeder to which supply is being transferred after the transfer.
  - **Limit Device** displays the highest loaded limiting object type.
• **Expected Limit Object Amps** displays the expected highest loaded limiting object amps after the restoration. (This field is displayed in a balloon dialog if you are running FLISR for Web Workspace with Web Switching Management.)

• **% of Rating** displays load as a percentage of limiting object rating. (This field is displayed in a balloon dialog if you are running FLISR for Web Workspace with Web Switching Management.)

**FLISR Report Tool Menus and Toolbar**

This section describes the toolbars and menu options available when you are running FLISR with either Web Workspace with Web Switching Management or Switching Management. Note that some options apply only to one environment and some options exist in both environments but may be accessed differently.

**File Menu**

• The **Print** option prints the contents of the window. (Web Workspace with Web Switching Management version only).

• The **Exit** option exits the FLISR tool.

**Actions Menu**

• The **Generate Switch Plan** option generates a switch plan for the selected isolate/restore sequences when FLISR is in Manual mode or when an overloaded plan is detected under Auto mode.

• The **Enable Balloon Details** option toggles the balloon details on and off. When enabled, a balloon dialog displays details about the selected item. For Limit Devices, the balloon dialog displays the Limit Device Amps, % of Rating, and Margin. (Web Workspace with Web Switching Management only)

• The **Branch Flows** option opens the FLISR Flow Summary window. (In Web Workspace with Web Switching Management, this is a right-click menu option.)

• The **View Limit** option displays (focuses) on the Viewer the highest expected limiting device for the selected restore sequence. (In Web Workspace with Web Switching Management, this is a right-click menu option.)

• The **View Feeders** option loads all the affected feeders for the selected isolate/restore sequences into Viewer 1. (In Web Workspace with Web Switching Management, this is a right-click menu option.)

**Right-Click Menu Options**

These options are displayed when you right-click a row in the FLISR tool when you are using Web Workspace with Web Switching Management.

• **View...** displays (focuses) the Viewer on the selected device.

• **SCADA Summary...** displays the SCADA Summary window for the selected row in the SCADA Measurements table.

• **Flow Summary...** opens the FLISR Flow Summary. This option is only available when a row is selected in the FLISR Plans list.

• **View Isolate Switch...** focuses the Viewer on the affected feeders for the selected isolate sequences. This option is only available for the selected row's isolation switch.

• **View Restore Switch...** focuses the Viewer on the affected feeders for the selected restore sequences. This option is only available for the selected row's restoration switch.

• **View Limit Device...** focuses the Viewer on the highest expected limiting device for the selected restore sequence.
Related Topics

- Executing FLISR in Automatic Mode
- Generating a Switch Plan (Manual Mode)
- Setting the FLISR Mode
- Viewing FLISR Disabled Devices
- Viewing FLISR Conditions
- Using the FLISR Flow Summary Window

Executing FLISR in Automatic Mode

In Automatic mode, FLISR can create and execute a switch plan without operator intervention as follows:

1. A fault occurs and a section is isolated.
2. FLISR completes its analysis and produces its solutions.
3. FLISR selects the best combination, based on a set of rules such as preferring to restore load to the same Zone Substation and avoiding overloads.
4. FLISR creates a plan and executes all steps in the plan automatically.
5. An operator can view the plan during and after execution. If the switch sheet is called up during the automatic execution, it will have been placed in View Only mode. The switching sheet may be manually augmented with additional steps after the automatic execution has completed. The switch sheet will behave like a normal Fault switch sheet after the FLISR generated steps are completed or have failed (after it is taken out of View Only mode).

After FLISR calculations have been made, the corresponding switching sheet may be called up from the Switching... option in the Work Agenda. It is possible that when you call the switch sheet up you will see the switch sheet still executing.

FLISR Automatic Mode with overloads

FLISR automatic mode with overloads works as follows:

1. A fault occurs and a section is isolated.
2. FLISR completes its analysis and produces its solutions. One of the preferred restoration scenarios includes overloading the restoration feeder.
3. FLISR selects alternate restoration scenarios. This might mean skipping a preferred feeder to avoid the overloads and selecting a different feeder that has more capacity.
4. A plan is created and all steps in the plan are executed.
5. An operator can view the plan during and after execution as described above.

Generating a Switch Plan for Overload Case

In the case where the restoration plan would result in overloads either in the restoring feeder or the section being transferred, the user must apply an override to generate the Switch Plan.

The checkbox must be selected for the plan you want to use. The system prompts you for confirmation. In automatic mode, plans with overloads are not executed automatically and must be run by the user in manually (from the switching sheet via the Execute FLISR Steps action).
Generating a Switch Plan (Manual Mode)

In manual mode, you can generate a switching sheet from the FLISR tool and then execute the steps in Switching Management or Web Workspace with Web Switching Management.

Here's how the process works:

1. A fault occurs and a section is isolated.
2. FLISR completes its analysis and produces its solutions.
3. The operator inspects the FLISR solutions and either accepts the default scenarios or decides to adjust the scenarios.
4. The operator instructs FLISR to generate the plan.
5. The operator reviews the plan.
6. The operator can choose to do one of the following:
   - Instruct, Complete and/or fail each step manually, or
   - Choose to let FLISR execute all steps in the plan.

FLISR with Web Switching Management

If you are running FLISR in Web Workspace with Web Switching Management, follow these steps to generate the switching sheet from the Fault Location, Isolation, and Service Restoration window:

1. In the FLISR Plans table, click the checkbox for the plans you want to generate. (The checkbox appears in the column to the right of the Isolate Switch column.)
2. Click the Generate Switch Plan toolbar button or select Generate Switch Plan from the Actions menu. The FLISR Event to Sheet List dialog opens.
3. Click the Generate Switch Plan button. The switching sheet is displayed, with the switch steps already inserted.

   **Note:** If there is an existing sheet already associated with this FLISR outage, the FLISR Event to Sheet List dialog opens. Choose a sheet from the list. Indicate whether the steps should be appended to the existing plan and whether the existing sheet should be overwritten. The switching sheet will be displayed with the FLISR-generated steps, based on the options selected.

4. From the Switching Sheet Editor window, choose one of the following options on the Action menu.
   - **Execute FLISR Steps** - Executes all FLISR switch steps after prompting for confirmation. Note that separate isolation/restoration sequences will be executed in parallel.
   - **Clear FLISR Conditions** - Clears the FLISR operated Flags from the Viewer for this Switch Sheet.

FLISR with Switching Management

If you are running FLISR with Switching Management, follow these steps to generate the switching sheet from the FLISR Report Tool:

1. Select the ‘Preferred Restore Options’ boxes for the plans to be generated. The box changes the text to ‘Yes’ and the background to green.
2. Click the Generate Switch Plan button. A Switch Sheet Editor page will pop up with the switch steps already inserted.

   If there is an existing sheet already associated with this FLISR outage, you are prompted with a set of dialog boxes asking whether the existing sheet should be overwritten and whether the steps should be appended to the existing plan.
• **Sheets exist for this outage** dialog
  - If the existing associated sheet is required (or you don’t want to create a new sheet), select **Yes**.
  - If a new sheet is to be generated or an existing sheet is to be appended to, select **No**.

• **Append Steps to Existing Sheet** dialog:
  - If a new sheet is to be generated, select **No**. This feature is used in Manual Mode to overwrite unexecuted switch sheets.
  - If steps are to be added to a existing switching sheet, select **Yes**. This feature is applicable when a user wants to execute a overloaded isolate/restore option on a plan that was already executed for the non-overloaded isolate/restore options – see Overload Case below.

• **Overwrite steps in existing sheet** dialog:
  - If you selected No for ‘Append Steps to Existing Sheet’ dialog then you are prompted to confirm. If you want to replace all the steps in the existing sheet, select **Yes**.
  - If you want to cancel, select **No**.

Depending on the options selected above, the Switch Sheet Editor will display the switch sheet with the FLISR generated steps.

3. From the Switch Sheet Editor window, choose one of the following options on the **Action** menu.

• **Execute FLISR Steps** - Executes all FLISR switch step. An additional confirmation prompt, is provided to confirm the execution. Note that separate isolation/restoration sequences will be executed in parallel.

• **Clear FLISR Conditions** - Clears the FLISR operated Flags from the Viewer for this Switch Sheet.

---

**Viewing FLISR Disabled Devices**

The system allows you to view devices that have been individually disabled from FLISR operations. There are several scenarios for disabling FLISR on a device.

• Devices can be enabled/disabled through actions on the device’s control tool

• Disabling a circuit breaker (and/or recloser) automatically disables all downstream devices along a radial feeder. Each device is checked during FLISR execution for upstream disabled breakers or reclosers.

• Disabling a sectionalizer disables just the individual device.

• Suppressing reclose features of a recloser or circuit breaker will also disable FLISR on the device.

• An explicit FLISR Disable SCADA point can be mapped to a device. When set (typically through a SCADA calculated point), FLISR will be disabled on that device.

• A device can be disabled in multiple fashions; only when all disabling conditions are removed will the device become active again.

• A device can only be enabled by removing the corresponding disabling constraint. For example it is not possible to manually enable a device that has been automatically disabled due to reclose suppression.

• Disabled devices are marked with a “FLISR Disabled” condition, shown in the Viewer and summarized in this display window.
If you are running FLISR with Web Switching Management, select Condition Summaries... from the Web Workspace with Web Switching Management Tools menu. To see only FLISR disabled devices, select FLISR Disabled from the Filter menu. See Condition Summaries on page 6-73.

If you are using FLISR with Switching Management, select FLISR Disable Summary from the FLISR Control toolbox. The FLISR Disable Summary window opens, displaying the following information.

- The Cond # column displays the number of the associated condition used to show the device as disabled.
- The User column displays the user name of the disabling user.
- The Date Created column displays the date of the disabling event.
- The Substation column displays the substation that the disabled device is connected to.
- The Feeder column displays the feeder that the disabled device is on.
- The Device column displays the name for this device.

Buttons
- The Refresh button is used to manually refresh the information displayed on the screen.
- The View button displays the selected device in Viewer 1 by focusing the Viewer on the device corresponding to the selected row.
- The Exit button closes the FLISR Disable Summary window.

Viewing FLISR Conditions

You can view all devices that have FLISR action conditions associated with them.

If you are using FLISR with Web Switching Management, select Condition Summaries... from the Web Workspace with Web Switching Management Tools menu. To see only FLISR disabled devices, select FLISR Actions from the Filter menu. See Condition Summaries on page 6-73 for more information.

If you are using FLISR with Switching Management, select FLISR Conditions Summary from the FLISR Control toolbox. The summary window opens, displaying all FLISR action conditions.

Using the FLISR Flow Summary Window

The FLISR Flow Summary window displays the calculated flows in the restoration path and in the de-energized section that will be transferred.

To open this window, right-click a row in the FLISR Plans section of the Fault Location, Isolation, and Service Restoration window, then select Flow Summary... from the pop-up menu.

The Flow Summary window displays the following fields and buttons:

- **Device Name** is the alias of the object in the restoration path or de-energized section.
- **Type** is object type: Cond = conductor, Switch = switch, Fuse = fuse.
- **Flow** is the flow in amps through the object.
- **Limit** is the limit in amps for the object.
- **% Rating** is the expected load flow through the object as a percentage of the object’s rating.
- **Margin** is the available capacity in amps for the object.
- **Internal** is set to ‘Y’ if the object is part of the faulted (de-energized) feeder or ‘N’ if it is part of the restoring feeder.
• The **Focus** toolbar button displays the branch flow in the Viewer, with the selected object flashing.

**Related Topics**

• Using FLISR with Work Agenda
• Executing FLISR in Automatic Mode
• Generating a Switch Plan (Manual Mode)
• Setting the FLISR Mode
• Viewing FLISR Disabled Devices
• Viewing FLISR Conditions
Oracle Utilities Network Management System’s Fault Location Analysis (FLA) uses fault-related SCADA measurements to identify probable fault locations. This information can be used to dispatch crews to targeted locations, thus shortening outage duration and restoration time.

**Note:** Fault Location Analysis is only available if your system supports SCADA extensions.

This chapter covers the following topics:

- Fault Location Process Overview
- Logging in to the Web DMS Environment
- Using the Fault Location Analysis Tool
- Viewing Fault Events in the Work Agenda
- Viewing Fault Locations in the Viewer

## Fault Location Process Overview

The Fault Location process is as follows:

- When the system receives a message of a fault occurrence, FLA automatically retrieves fault information from relays and fault indicators (if available) and logs a new event in the Work Agenda.
- FLA uses fault information and circuit parameters to calculate potential fault locations for fault events. Potential fault locations are displayed in the Viewer.
- When FLA is started from the Work Agenda, it displays analysis details about fault events, including SCADA measurements and probable fault locations.
- If more than one fault location is identified for a specific fault event, the user may have to correct a calculated fault location after the actual fault location is identified by crew members on site.
- Optionally, the user may change one or more analysis parameters and then have FLA recalculate the fault locations using the modified parameters. The user can confirm or clear (discard) calculated fault locations as appropriate.
Fault Location Algorithm

The algorithms used by FLA are different from those used for a regular short-circuit analysis. When performing a short-circuit analysis, where you are determining fault currents, you have more information since you know where the fault is. In that case, the model is solved with a known fault type at a known location. The fault currents at the target location are determined by the source voltage, source impedance, and all conductor impedances along the path to the fault.

With FLA, only the fault currents at the breaker are known and the fault location must be extrapolated. The short-circuit analysis is performed with the fault placed at the breaker and the fault currents determined for that scenario. These should be higher than the fault currents reported by SCADA. For example, if SCADA is reporting 2500 Amps at the breaker and the solution is reporting 3000 Amps, we know that there is more impedance in the path to the fault that would account for the 500 Amps difference. We calculate the impedance that would cause the difference and trace down the feeder summing up conductor impedances until we arrive at a location that equates to the target impedance.

One significant difference between the two scenarios is that by placing the fault at the breaker, we are removing all downstream load from consideration. Whereas in FLA the fault is actually downstream, so the breaker fault currents will have a component that is for the load that is between the breaker and the fault. The assumption that is made is that that component is insignificant; however, in reality, the further down the feeder the FLA fault is, the more significant that component becomes. This may or may not have a significant impact on the results because the fault will pull down the breaker voltage.

Using the Fault Location Analysis Tool

Fault Location Analysis displays possible fault locations and the SCADA data involved in the Fault Location analysis. This tool also allows you to change one or more analysis parameters and recompute fault locations. Finally, you can use the tool to confirm or discard calculated locations.

This section includes the following topics:

- Logging in to the Web DMS Environment
- Using the Fault Location Analysis Tool
- Confirming Fault Locations
- Marking Fault Locations as Incorrect
- Correcting a Fault Location

Logging in to the Web DMS Environment

Fault Location Analysis is available when logged into the Web Workspace and when running the Operator's Workspace and the Web DMS.

Note: Check with your system administrator to verify that your system has been configured to support Fault Location Analysis and to obtain any special login instructions.

If using the Operator's Workspace and the Web DMS, you must login to both environments using the same user ID; it does not matter which environment is started first. For instructions on logging into Operator's workspace, see Logging In on page 1-7.

To log in to the Web DMS environment:

1. Depending on how your system was installed, do one of the following:
   - Click the Web DMS icon found under the appropriate program group in your Windows Start Menu.
   - Double-click the Web DMS icon on your desktop.
Open a web browser and type the Web DMS URL in the browser's Address field. The Web DMS Login window displays.

2. Enter the user name you used to log into the Operator's Workspace application.

3. Enter the password.

4. Click the Validate button. The bottom portion of the Web DMS Login window sensitizes.

5. Select the appropriate User Type from the drop-down menu.

6. Click the Login button. Once you have successfully logged on, the Web DMS window is displayed. You are now ready to begin using the Fault Location Analysis tool, as described in the next section.

**Using the Fault Location Analysis Tool**

The Fault Location Analysis window displays possible fault locations and the SCADA data involved in the Fault Location Analysis.

To open the Fault Location Analysis window from the Operator's Workspace Work Agenda, select an event in the Work Agenda and select Fault Location Analysis... from the Actions menu.

**Menu Options and Toolbar Buttons**

### File Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Toolbar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Opens the Print Preview dialog.</td>
<td>![Print Icon]</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Fault Location Analysis window.</td>
<td>![Exit Icon]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Toolbar Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fault Location Analysis Help</td>
<td>Opens online help content for Fault Location Analysis.</td>
<td>--</td>
</tr>
<tr>
<td>(F1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>About Fault Location Analysis</td>
<td>Opens the About dialog with information on the release version and related system information.</td>
<td>--</td>
</tr>
</tbody>
</table>
Using the Fault Location Analysis Tool

Information Display
Fault Location Analysis provides the following information panes:

- SCADA Measurements
- Possible Fault Locations

SCADA Measurements
The SCADA Measurements pane provides fault-related SCADA measurements used to identify probable fault locations. The

- The Device column contains the name of the device reporting the SCADA measurements.
- The Status column contains the status of the device.
- The Fault Ind column contains the fault indicator (Yes or No).
- The Lockout Ind column contains the lockout indicator (Yes, No, or N/A).
- The Qual column contains Quality codes for the measurement that indicate the quality of the SCADA measurement (e.g., out of scan, inhibited, manual override). Several quality codes can be listed.
- The Amps columns contain the calculated current flow from the source.

Context Menu Options - If you right-click a row in the SCADA Measurements section, a context menu displays the following options:

- SCADA Summary... - Opens the SCADA Summary.
- View - Displays the device in the Viewer.

Possible Fault Location
The Possible Fault Location pane provides the list of devices identified by the Fault Location Analysis tool as possible fault locations. If no valid fault locations are found, a single “Undetermined Fault” record is listed.

- The Status column contains the status of the fault location: Possible Fault, Confirmed Fault-Out, or Fault Incorrect.
- The Fault Type column contains the fault type: Phase A to Ground, Phase A to Phase C, etc.
- The Fault Device column contains the fault device name.
- The Phases column contains the faulted phases.
- The Location column contains distance from the device to the upstream switch.
- The GPS (X,Y) column contains the X,Y coordinates of the predicted fault.

Context Menu Options - If you right-click a row in the Possible Fault Locations section, a context menu displays the following options:

- Confirm Fault - Marks the device as Confirmed and marks all other devices in the list as Incorrect (not the correct fault location).
- Mark Incorrect - Marks the devices as Incorrect (not the correct fault location).
- Correct Fault... - Displays the Correct Fault Location window, which allows you to manually edit the fault location. See Correcting a Fault Location on page 19-5.
- View... - Displays the selected device in the Viewer.
Confirming Fault Locations

To confirm a fault location:

1. Select the device you want to confirm from the Possible Fault Location section on the Fault Location Analysis window. (See Using the Fault Location Analysis Tool on page 19-3.)

2. Click the right mouse button and select Confirm Fault from the pop-up menu. The selected device is marked as Confirmed and all other devices in the list are marked as Incorrect. The Confirmed Fault changes from a yellow X to a red X in the Viewer. The other Incorrect faults disappear from the Viewer.

Marking Fault Locations as Incorrect

To mark a possible fault location as incorrect:

1. Select the device you want to mark as incorrect from the Possible Fault Location section on the Fault Location Analysis window. (See Using the Fault Location Analysis Tool on page 19-3.)

2. Click the right mouse button and select Mark Incorrect from the pop-up menu. The selected device is marked as Incorrect and disappears from the Viewer.

Correcting a Fault Location

If none of the possible fault locations is correct, you can select the closest one and then correct the fault location details. The system creates a new fault location with the corrected information.

To correct a fault location:

1. Select the closest fault location from the Possible Fault Location section on the Fault Location Analysis window. (See Using the Fault Location Analysis Tool on page 19-3.)

2. Click the right mouse button and select Correct Fault… from the pop-up menu. The Correct Fault Location window is displayed. The Status of the new fault location is set to Corrected Fault and is not editable.

3. Enter the correct values for the following fields:
   
   - **Fault Type** - The specific fault type, such as Phase A to Ground or Phase C to Phase A.
   
   - **Fault Device** - The faulted object. This is the device alias for the conductor selected in the Viewer.
   
   - **Distance** - The distance to the referenced device.

   **Note:** The reference device field populates with the first upstream switch. The Change Reference Device button enables. The system automatically displays the first upstream switch for the selected fault device. You can reference a different device by selecting the device in the Viewer and then clicking the Change Reference Device button on the Correct Fault Location dialog. The system populates the Reference Device field with the selected device. Click OK to accept this device or click Cancel if this is not the correct device.

   - **Description** - A brief description of the fault. This text will be displayed in a balloon dialog on the Possible Fault Locations table for Corrected Fault rows.

4. Click OK. All existing fault locations are flagged as incorrect, and a new location is added that matches your entries.

A new fault location symbol appears in the Viewer at the location indicated by the Distance and Reference Device fields. Any existing fault location symbols in the Viewer are removed.
Viewing Fault Events in the Work Agenda

See the preceding section for details on opening the Fault Location Analysis window from the Work Agenda.

Fault Events appear in the Work Agenda as follows:

- The **Status** column displays “F-NEW.”
- The **# Out** column (number of customers experiencing outage) is 0.
- The **Evt Type** is “FAULT.”
- The **Pred Type** is “Revised Prediction.”
- No phases are listed as out.
- All device-related fields, such as the control zone information, appear as they would for any other event.

Viewing Fault Locations in the Viewer

You can select any device listed on the Fault Location Analysis window and display its calculated locations in the Viewer. Right-click the device, then select **View...** from the pop-up menu. The following illustrations provide examples of how possible fault locations appear in the Viewer.

- **Fault Current Events in the Viewer**
- **Fault Indicator Call Symbols in the Viewer**

Fault Locations in the Viewer

The following figure shows the location where the SCADA measurements were taken, as indicated by a white diamond in a blue circle. Right-clicking this symbol will bring up a popup menu that can provide more details on the fault event.
Fault Indicator Call Symbols in the Viewer

Possible fault locations are indicated by white diamonds with black border and red or orange cross inside the diamond. An orange cross (X) represents confirmed fault location while a red cross symbol represents an incorrect fault location.

Right clicking the symbol will bring up a popup menu that will provide more tools for further analysis.
Appendix A

Event Status and Event Type Codes

This appendix lists and describes coded information that appears in Oracle Utilities Network Management System screens, including:

- Event Status Codes
- Event Type Codes

Event Status Codes

Work Agenda Trouble Events Lists display the current status of each event listed. The event status is also displayed on the Call Information window. Below is a complete list of event status codes and their descriptions:

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASN</td>
<td>Crew is assigned to the event</td>
</tr>
<tr>
<td>C-CNL</td>
<td>Event has been cancelled by a “cancel call” trouble code, but a crew is still associated with the event. (You must then use the Cancel Event button to transition the event to CNL status.)</td>
</tr>
<tr>
<td>CMP</td>
<td>Event has been completed (job and event details are complete)</td>
</tr>
<tr>
<td>CNL</td>
<td>Event has been cancelled by a user (using the Cancel Event button in the Work Agenda window)</td>
</tr>
<tr>
<td>CRT</td>
<td>Acknowledged critical meet</td>
</tr>
<tr>
<td>ENR</td>
<td>Crew is en route to the event</td>
</tr>
<tr>
<td>F-ASN</td>
<td>Crew is assigned to the fault current event</td>
</tr>
<tr>
<td>F-CMP</td>
<td>Fault current event has been completed (job and event details are complete)</td>
</tr>
<tr>
<td>F-CNL</td>
<td>Fault current event has been cancelled</td>
</tr>
<tr>
<td>F-ENR</td>
<td>Crew is enroute to the fault current event</td>
</tr>
<tr>
<td>F-NEW</td>
<td>New fault current event</td>
</tr>
<tr>
<td>F-ONS</td>
<td>Crew is onsite at the fault current event</td>
</tr>
<tr>
<td>INC</td>
<td>Event has been completed, but information needs to be entered in the Event Details window</td>
</tr>
<tr>
<td>Status Code</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>M-CMP</td>
<td>Momentary event has been completed (job and event details are complete)</td>
</tr>
<tr>
<td>M-INC</td>
<td>Momentary event has been restored, but information needs to be entered in the Event Details window</td>
</tr>
<tr>
<td>M-NEW</td>
<td>New unacknowledged momentary event</td>
</tr>
<tr>
<td>MNP</td>
<td>Maintenance pending</td>
</tr>
<tr>
<td>M-RCVD</td>
<td>Momentary event was received by mobile system and receipt was acknowledged by the MQ adapter.</td>
</tr>
<tr>
<td>M-SNT</td>
<td>Unassigned (acknowledged) momentary event manually sent to the mobile system</td>
</tr>
<tr>
<td>M-UAS</td>
<td>Unassigned (acknowledged) momentary event</td>
</tr>
<tr>
<td>NEW</td>
<td>New unacknowledged event</td>
</tr>
<tr>
<td>NFY</td>
<td>Notify alarm</td>
</tr>
<tr>
<td>ONS</td>
<td>Crew is onsite at the event</td>
</tr>
<tr>
<td>P-CMP</td>
<td>Planned event has been completed (job and event details are complete)</td>
</tr>
<tr>
<td>P-INC</td>
<td>Planned job has been completed, but information needs to be entered in the Event Details window</td>
</tr>
<tr>
<td>P-NEW</td>
<td>New unacknowledged planned event</td>
</tr>
<tr>
<td>P-RCVD</td>
<td>Planned event was received by mobile system and receipt was acknowledged by the MQ adapter.</td>
</tr>
<tr>
<td>P-SNT</td>
<td>Unassigned (acknowledged) planned event manually sent to the mobile system</td>
</tr>
<tr>
<td>P-UAS</td>
<td>Unassigned (acknowledged) planned event</td>
</tr>
<tr>
<td>RCVD</td>
<td>Order was received by mobile system and receipt was acknowledged by the MQ adapter.</td>
</tr>
<tr>
<td>RED</td>
<td>New critical meet</td>
</tr>
<tr>
<td>RSCH</td>
<td>Rescheduled meet</td>
</tr>
<tr>
<td>RST</td>
<td>Event has been restored and a crew is still associated with the event</td>
</tr>
<tr>
<td>S-ASN</td>
<td>Crew is assigned to the SCADA event</td>
</tr>
<tr>
<td>S-CMP</td>
<td>SCADA event has been completed (job and event details are complete)</td>
</tr>
<tr>
<td>S-ENR</td>
<td>Crew is en route to the SCADA event</td>
</tr>
<tr>
<td>S-INC</td>
<td>SCADA event has been completed, but information needs to be entered in the Event Details window</td>
</tr>
<tr>
<td>S-MNP</td>
<td>Maintenance pending (SCADA event)</td>
</tr>
<tr>
<td>S-NEW</td>
<td>New unacknowledged SCADA event</td>
</tr>
</tbody>
</table>
### Event Type Codes

Event Type codes are displayed on the Trouble Call Entry Lists. Below is a complete list of event type codes and their descriptions:

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCO</td>
<td>confirmed secondary outage</td>
</tr>
</tbody>
</table>

---

**Event Status and Event Type Codes A-3**
<table>
<thead>
<tr>
<th>Event Type Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSVO</td>
<td>confirmed service outage</td>
</tr>
<tr>
<td>FUZZY</td>
<td>fuzzy event</td>
</tr>
<tr>
<td>NFY</td>
<td>notify alarm</td>
</tr>
<tr>
<td>NON</td>
<td>non-outage</td>
</tr>
<tr>
<td>PDO</td>
<td>probable device outage</td>
</tr>
<tr>
<td>PLAN</td>
<td>planned outage</td>
</tr>
<tr>
<td>PMO</td>
<td>probable momentary outage</td>
</tr>
<tr>
<td>PSO</td>
<td>probable service outage</td>
</tr>
<tr>
<td>RDO</td>
<td>real device outage</td>
</tr>
<tr>
<td>RMO</td>
<td>real momentary outage</td>
</tr>
<tr>
<td>MEET</td>
<td>meet</td>
</tr>
<tr>
<td>SWP</td>
<td>switching job</td>
</tr>
</tbody>
</table>
Appendix B

Color Coding

This appendix lists and describes color coding that appears in Oracle Utilities Network Management System screens, including:

- Crew Status
- Event Status
- FLISR Status
- Conductor Symbology
- Callback Status
- Feeder/Device Condition Names and Colors

Note: All color coding is configurable and your site may use different colors than those shown in this appendix.

Crew Status

The table below describes the default color coding used on the Crew Actions and Crew List windows to indicate crew status. These colors are also used for AVL crew symbols in the Viewer.

<table>
<thead>
<tr>
<th>Color</th>
<th>Crew Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>En Route</td>
</tr>
<tr>
<td>Dark Green</td>
<td>Onsite</td>
</tr>
<tr>
<td>Yellow</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Cyan</td>
<td>Assigned</td>
</tr>
<tr>
<td>Orange</td>
<td>Suspended</td>
</tr>
<tr>
<td>Brown</td>
<td>Crew has no control zone (i.e., the crew’s assigned control zone has been removed from the control zone hierarchy).</td>
</tr>
<tr>
<td>White</td>
<td>Available</td>
</tr>
</tbody>
</table>
The table below identifies the color coding used on the Work Agenda list to indicate the event status.

<table>
<thead>
<tr>
<th>Row Color</th>
<th>Event Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>White text on dark red background</td>
<td>NEW</td>
</tr>
<tr>
<td>White text on light red background</td>
<td>M-NEW</td>
</tr>
<tr>
<td>White text on red-orange background</td>
<td>P-NEW</td>
</tr>
<tr>
<td>White text on red background</td>
<td>S-NEW</td>
</tr>
<tr>
<td>White text on bright red background</td>
<td>RED</td>
</tr>
<tr>
<td>Red text on white background</td>
<td>NFY</td>
</tr>
<tr>
<td>Black text on yellow background</td>
<td>SNT</td>
</tr>
<tr>
<td></td>
<td>UAS</td>
</tr>
<tr>
<td>Black text on pale yellow background</td>
<td>M-SNT</td>
</tr>
<tr>
<td></td>
<td>M-UAS</td>
</tr>
<tr>
<td>Black text on gold background</td>
<td>P-SNT</td>
</tr>
<tr>
<td></td>
<td>P-UAS</td>
</tr>
<tr>
<td></td>
<td>W-SNT</td>
</tr>
<tr>
<td></td>
<td>W-UAS</td>
</tr>
<tr>
<td>Black text on dark gold background</td>
<td>S-SNT</td>
</tr>
<tr>
<td></td>
<td>S-UAS</td>
</tr>
<tr>
<td>Black text on cyan background</td>
<td>ASN</td>
</tr>
<tr>
<td></td>
<td>S-ASN</td>
</tr>
<tr>
<td></td>
<td>W-ASN</td>
</tr>
<tr>
<td>Black text on green background</td>
<td>ENR</td>
</tr>
<tr>
<td></td>
<td>S-ENR</td>
</tr>
<tr>
<td></td>
<td>W-ENR</td>
</tr>
<tr>
<td>Black text on dark green background</td>
<td>ONS</td>
</tr>
<tr>
<td></td>
<td>S-ONS</td>
</tr>
<tr>
<td></td>
<td>W-ONS</td>
</tr>
<tr>
<td>White text on blue background</td>
<td>RST</td>
</tr>
<tr>
<td></td>
<td>S-RST</td>
</tr>
</tbody>
</table>
The Work Agenda is the starting point for viewing the status and results of the FLISR calculations. Each outage row is color-coded to represent the FLISR status of a job. The background color of the “Event #” field in the Work Agenda list indicates the FLISR status:

- **Yellow** - The job is currently being processed as a FLISR job and a solution is being searched for.
- **Green** - A FLISR solution has been found for the job.
- **Light Red** - A FLISR solution has been found but it overloads the restoring feeder – manual intervention will be required.
- **None** - No FLISR solution can be found for this job.
Conductor Symbology

In the Viewer, conductor symbology changes color and line style (e.g., pattern, thickness) for different types of conductors and topology states. Conductor symbology is configurable. The following table shows the default color coding used for conductor symbology:

<table>
<thead>
<tr>
<th>Line Style</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thin</td>
<td>Red</td>
<td>A Phase</td>
</tr>
<tr>
<td>Thin</td>
<td>Yellow</td>
<td>B Phase</td>
</tr>
<tr>
<td>Thin</td>
<td>Blue</td>
<td>C Phase</td>
</tr>
<tr>
<td>Dashed</td>
<td>Black and white</td>
<td>De-energization</td>
</tr>
<tr>
<td>Dashed</td>
<td>Black and gray</td>
<td>Partial energization</td>
</tr>
<tr>
<td>Thick</td>
<td>Light blue overlay</td>
<td>In Trace mode, indicates a conductor that is part of the path from a selected device</td>
</tr>
<tr>
<td>Thick</td>
<td>Dark pink</td>
<td>Grounded</td>
</tr>
<tr>
<td>Thick</td>
<td>Dark red</td>
<td>Different color codes for individual phases</td>
</tr>
<tr>
<td>Thick</td>
<td>Magenta overlay</td>
<td>Loop, bi-directional flow</td>
</tr>
<tr>
<td>Thick</td>
<td>Purple overlay</td>
<td>Parallel</td>
</tr>
<tr>
<td>Solid</td>
<td>Varies</td>
<td>Overhead line.</td>
</tr>
<tr>
<td>Dashed</td>
<td>Varies</td>
<td>Underground cable.</td>
</tr>
</tbody>
</table>

Callback Status

The Callback Status field on the Perform Callbacks List Window and the Perform Next Callback window is color-coded to indicate whether a callback attempt has been made and the result of the last attempt. The following table shows the default color coding used for callback status:

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>White</td>
<td><strong>Not Called</strong> - indicates you have not yet called the customer (default). The callback remains in the callbacks list.</td>
</tr>
<tr>
<td>Blue</td>
<td><strong>Restored</strong> - indicates the customer confirmed their service was restored. The callback is considered complete and is removed from the callbacks list the next time it is brought up.</td>
</tr>
<tr>
<td>Red</td>
<td><strong>Not Restored</strong> - indicates you called the customer, and the customer indicated that service was not restored. The callback is considered complete and is removed from the callbacks list the next time it is brought up. The call is re-introduced into the Oracle Utilities Network Management System for re-analysis and restoration and a new callback will be generated when that event is restored.</td>
</tr>
</tbody>
</table>
Feeder/Device Condition Names and Colors

The Feeder Load Summary and Feeder Load Management windows use color coding to indicate violations or warnings associated with feeders and devices. The following table lists the feeder/device condition number, name, and corresponding cell background and text coloring.

<table>
<thead>
<tr>
<th>Condition Number</th>
<th>Condition Name</th>
<th>Condition Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.</td>
<td>Normal</td>
<td>Black text on Green background</td>
</tr>
<tr>
<td>1.</td>
<td>Backfeed Warning</td>
<td>Black text on Yellow background</td>
</tr>
<tr>
<td>2.</td>
<td>Not currently used</td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td>Under Voltage Warning</td>
<td>Black text on Yellow background</td>
</tr>
<tr>
<td>4.</td>
<td>Over Voltage Warning</td>
<td>Black text on Yellow background</td>
</tr>
<tr>
<td>5.</td>
<td>Switch Overload Warning</td>
<td>Black text on Yellow background</td>
</tr>
<tr>
<td>6.</td>
<td>DistTrans Overload Warning</td>
<td>Black text on Yellow background</td>
</tr>
<tr>
<td>7.</td>
<td>Feeder Capacity Warning</td>
<td>Black text on Yellow background</td>
</tr>
<tr>
<td>8.</td>
<td>Conductor Overload Warning</td>
<td>Black text on Yellow background</td>
</tr>
<tr>
<td>9.</td>
<td>PowerTrans Overload Warning</td>
<td>Black text on Yellow background</td>
</tr>
<tr>
<td>10.</td>
<td>Not a valid violation type, used to distinguish between warnings and violations</td>
<td></td>
</tr>
<tr>
<td>11.</td>
<td>Backfeed</td>
<td>Black text on Light Gray background</td>
</tr>
<tr>
<td>12.</td>
<td>Not currently used</td>
<td></td>
</tr>
<tr>
<td>13.</td>
<td>Under Voltage</td>
<td>Black text on Light Brown background</td>
</tr>
<tr>
<td>14.</td>
<td>Over Voltage</td>
<td>Black text on Gold background</td>
</tr>
<tr>
<td>15.</td>
<td>Switch Overload</td>
<td>Black text on Cyan background</td>
</tr>
<tr>
<td>16.</td>
<td>DistTrans Overload</td>
<td>Black text on Magenta background</td>
</tr>
<tr>
<td>17.</td>
<td>Feeder Capacity</td>
<td>Black text on Pink background</td>
</tr>
<tr>
<td>18.</td>
<td>Conductor Overload</td>
<td>White text on Orange background</td>
</tr>
<tr>
<td>19.</td>
<td>PowerTrans Overload</td>
<td>White text on Red background</td>
</tr>
<tr>
<td>Condition Number</td>
<td>Condition Name</td>
<td>Condition Color</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>20.</td>
<td>Model Error</td>
<td>Black text on Red background</td>
</tr>
<tr>
<td>21.</td>
<td>Non-converged</td>
<td>Black text on Red background</td>
</tr>
<tr>
<td>22.</td>
<td>SCADA Non-converged</td>
<td>Black text on Yellow background</td>
</tr>
<tr>
<td>23.</td>
<td>SCADA Suspect</td>
<td>Black text on Red background</td>
</tr>
</tbody>
</table>
Symbols
SAIDI 12-21

A
Abnormal Device Summary 1-56
Abnormal Devices 6-78
abnormal devices 6-68
Abnormal Devices table 1-53
abort step 15-21
acknowledge alarms 6-82
Active Job Info 6-31, 7-36
Active Job Information 2-44
Active Job Information window 2-44
Adding Crew Groups 10-28
addresses
saving all 15-20
Administration
user type 1-8
Administration Environment 1-67
Administration Environment Manager 1-67
Administrative Tools 1-11
aggregate steps 15-32
alarm
control zone 1-13
Alarms and Devices Lists 6-78
Alerts 2-13
Alt. Finish Date 15-15
Alt. Start Date 15-15
AMR Customer List 1-44, 7-20
AMR Customers View 2-60
AMR Requests 2-26, 7-19
completing 2-28
AMR Requests List 2-26
annunciators 1-9
Approved state 15-17
ASN/ENR Date 15-26
Assigned Crew Information 15-64
associating calls with devices 2-12
ATO Customers 6-67
ATO Customers panel 1-52
ATO disable 1-40, 1-42
ATO re-enable 1-42
Attributes window 1-66
audio notification 6-82
audit log 15-51
Authority 1-12, 6-9
Automatic Control 17-17, 17-18
Average Feeder Voltage 16-11
average interruption duration index 12-21
average interruption frequency index 12-22
AVL crews 2-47

B
block header 15-24
blocks
adding 15-24, 15-30
Breakers 16-8
Build Status (model build patches) 3-4
Bus Section 16-8

C
Calculating Crew Resources 10-35
Calculating Estimates in Study Mode 10-39
Call Display 6-61
Call History 8-3, 8-8
Call Info 7-49
Call Information Window 2-62
Call Pattern 1-43
Call Patterns 1-43
callback status color coding B-4
callers view 7-43
calls
associating with devices 2-12
ungrouping 2-58
Camera 1-17, 1-19, 1-33
Camera window 1-33
CANCELED state 15-17
cancelling a call 8-14
Capacitor Status Change 16-16
Capacitors Tab 17-18
Change Rule Set 1-13
Changing Storm Levels 10-20
Changing Storm Types 10-20
Charge Number 15-14
Check Rejected state 15-17
Checked state 15-17
check-in button 15-8
Clearance safety documents 15-61
clearing Planned Date 15-24
clearing the clipboard 15-23
closing devices 1-40
Clues 7-45
Color Coding
  Outage 7-10
color coding
  callback status B-4
  conductor symbology B-4
crew actions 2-37
crew status B-1
event status B-2
feeder/device conditions B-5
outage 2-20
colors
  conductor 1-20
Comments (Steps tab) 15-20
comments steps 15-28
Commissioning 1-34
commissioning devices 1-34
Commissioning Tool 1-35, 6-49
Company Summary 2-63
Complete to Here 15-23
Completed Date 15-11
Completed Date (Steps tab) 15-20
Completed state 15-18
completing steps 15-21
completing switching sheets 15-38
condition colors B-5
condition names B-5
Condition Summary 6-73
condition symbols 1-28
Conditions panel 1-52
Conditions Summary 6-73
conductor coloring 1-20
conductor symbology 1-28, 6-42, 6-43
  color coding B-4
collectors 1-46
Configuration Assistant
  inactivating a user 4-14
confirm model changes 15-22
Confirm Outages 7-9
Confirmed Secondary Outage 2-21, 7-11
Confirmed Service Outage 2-21, 7-10
Contact Manager Tab 11-5
Control Tool 1-36, 6-53, 15-28
  opening a switching sheet from 15-56
Control Tool (Ops) 1-36
Control Zone 2-33
control zone authority 1-13
control zone groups 1-14
copying and pasting steps 15-28
copying steps 15-23
Counts panel 1-51
Create Event 2-23, 6-15
Create Event window 2-23
Create Nested Outage 6-66
creating a planned switching sheet 15-11
Crew 15-63
crew
  AVL 2-47
  Crew Actions 2-37, 7-25, 15-36
  Crew Administration 2-32
Crew Administration lists 2-33
Crew Availability 7-31
Crew Icons 15-56
Crew ID 2-42, 15-26
Crew Info 7-27, 7-34, 15-26
Crew Information 2-42
Crew Information Panel 10-24
Crew List 2-40, 7-28
  filtering 2-41
Crew Makeup 2-35, 7-32
Crew Operations
  user type 1-8
Crew Options 6-30
Crew Size 2-40
crew status color coding B-1
Crew Type 2-40
Crew Will Restore 15-15
Crew Will Switch 15-15
Crews
  Moving to Another Device 7-37
  Releasing 7-38
    Release Crew(s) 6-19
crews
  activating 2-33
  assigning 2-38
  associating to switching sheets 15-36
  AVL 2-47
  changing availability 2-38
  color coding 2-40
  creating 2-35
  crew size 2-40
  crew type 2-40
  deleting 2-34
  editing 2-36
  filtering 2-36
  finding event 2-39
  inactivating 2-34
  managing 2-31
  moving 1-43, 2-45, 2-47
  placing en route 2-38, 2-43, 2-45
  pre-assigning to steps 15-37
  releasing 1-44, 2-46
  removing personnel 2-36
  removing vehicle 2-36
  searching 2-41
  suspending 2-46, 7-39
  transferring 2-34
  unassigning 2-43
crews and events header
  showing or hiding 15-24
Crews list 15-25, 15-26
Critical Customer View 2-59
Critical Customers 6-68
critical customers 1-53
Cross Phase 1-48
Customer
  interrupted 15-43
  isolated 15-43
  restored 15-43
Customer Hours 12-21
Customer List 1-44
Customer Minutes of Interruption 12-21
customers
  moving to another device 7-44
  moving to different device 2-57

Customers View 2-58
Cut Phase 1-46
cutting steps 15-23

D
Daily Peak Forecasts 17-20
Damage Assessment 2-23, 2-24
Damage Assessments 7-16
  associating to devices 6-72
Damage Location 2-24
Damage Report 2-23
Damage Specifics 2-24
Data Quality 17-21
Data Source 17-21
DB Query 1-60
Deactivate Crew 7-29
Declutter 1-30
declutter 6-46
decommissioning devices 1-34
Default ERT Editor 1-68
Default ERT Editor Window 1-68
Defective Equipment 2-15
Defining the Storm 10-17
Deleted state 15-18
deleting
  steps 15-23
Deleting Crew Groups 10-31
Description of Work 15-15
Device 15-11
Device (Request tab) 15-14
device address (Steps tab) 15-20
device addresses
  updating 15-20
device attribute information 1-66
Device Attributes 1-46
device attributes 1-46
device conditions
  color coding B-5
Device Details
  SCADA 13-5
device list
  editing (safety documents) 15-66
Device Notes 6-59
Device Notes dialog
  notes 6-59
device operations 1-38
Device Operations List 6-79
Device Operations list 1-53
devices
  associating calls 2-12
  associating documents 1-70
  commissioning and decommissioning 1-34
  finding and replacing 15-33
  focusing on in Viewer 15-35
  grounding 1-42
  moving customers 2-57
  opening and closing 1-40
  operating phases 1-40
  placing tags 1-41
  removing 15-23
  removing ground 1-42
  removing tags 1-41
  unlinking from safety document 15-23
Disable ATO 1-40
disabling ATOs 6-58
Dispatch Information 2-44
Distance from Upstream Switch 19-4
documents
  associating to devices 6-70
Drag and Drop Dispatch 7-39
Draw Link Window 1-69
Drop Assignment 2-43
Drop Counts 6-67

E
Edit Clues 7-43
Editing Conductors 1-46
Editing Crew Groups 10-30
Email dialog 2-62
e-mailing customers 2-62
e-mailing switching plans (Ops) 14-26
e-mailing switching sheets 15-51
Emergency Cable 1-48
emergency switching 15-58
e-mailing switching sheets 15-2
en route 7-30, 7-39
End Date (Impacted Customers) 15-48
Energized capacitors 17-18
Environment Manager 1-8
Equipment Failure panel 2-17
Equivalent Sources Tab 17-18
Error state 15-18
ERT 15-15, 15-36
  System-wide 7-22
  updating 14-29
  Updating for Event 7-21
ERT Editor 1-68
ERT Overrides 10-12
ERT to Report 8-5
event associations 15-25, 15-59
  adding 15-25, 15-37
  grouping 15-60
  removing 15-26, 15-37
Event Details 1-44, 2-13, 7-3, 15-26, 15-56
Event Details Window 2-14
Event History 2-54
Event Log 7-22
Event Recorder 2-22
event status codes A-1
  event status color coding B-1, B-2
event type codes A-3
events
  adding comments 2-23
  creating 6-15
  finding 2-16
  finding crew 2-39
  grouping 2-9
  updating 2-45
Events and Crews list 15-25
events header showing or hiding 15-24
Events list 15-25
Exclude from Interruption Indices 2-16
Executed By 15-20
Executed state 15-18
Exiting Storm Mode 10-33
Exiting Study Mode 10-40
external documents adding 15-53
adding to switching sheets 15-52
editing 15-53
opening 15-53
removing 15-53
saving to another location 15-53
External Documents tab 15-7, 15-52

F
failed step 15-21
fault indicator 19-4
Fault location 18-1
Fault Location Analysis Tool 19-2
Fault Location overview 19-1
fault locations confirming 19-5
marking incorrect 19-5
fault outages in Viewer 19-6
Feeder 15-11
Feeder (Request tab) 15-15
Feeder (safety document) 15-64
Feeder Condition 17-5, 17-13
feeder conditions color coding B-5
Feeder Focus 1-19, 1-24, 6-39
Feeder Load Management 6-28, 17-6
Feeder Load Management Tool starting 17-6
Feeder Load Management window 17-8
Feeder Load Overview Panel Toolbar 17-13
feeder load summary filtering the list 17-6, 17-14
Feeder Load Summary Table 17-5
Feeder Tie Points Capacity Overview 17-16
Feeder Voltage 16-11
Filter Dialog 6-12, 7-26
filtering 6-14
filtering data 1-3
filtering the switching sheet list 15-12
filters (user-defined) 1-6
Find Event Dialog 2-16
finding and replacing 15-22, 15-33
Finish Date 15-15
FLISR 1-11, 18-1
automatic mode 18-7
Conditions Summary 18-10
Disable Summary Window 18-9
enabling/disabling devices 18-4
Flow Summary Window 18-10
generating switch plan from 18-8
Report Tool 18-5
focusing on devices 15-20, 15-35

G
GIS Data Extraction 3-1
Global Overlaps 15-72
go-back steps 15-23
creating 15-29
Ground Devices and Phases 15-64
grounding a Device 1-42
grounding devices 1-42
grounds placing 6-57
Grounds Required 15-15
Group Manager Tab 11-3
grouping steps 15-24, 15-31

H
header showing or hiding 15-24
hidden objects 1-30
Highlight Event 1-43
Hold safety documents 15-61
Hold/Pending state 15-17
Hot safety documents 15-61
Hourly Forecasts 17-20
How Storm Management Works 10-44

I
image annotating 5-1
capturing 5-1
e-mailing 5-4
printing 5-4
saving 5-1
Impacted Customer list deleting customers from 15-46
generating 15-45
impacted customers (Ops Switching Management) 14-23
Impacted Customers indicator 15-8
Impacted Customers tab 15-7, 15-43
implementing switching sheets 15-35
Importing Crews 10-26
Importing Crews and Parameters 10-37
In Progress state 15-17
Inaccessible 7-17
Information Note safety documents 15-61
Inhibit 6-76
In-line Jumper 1-48
Instruct Close 1-38
Instruct Open 1-38
Instruct Place Ground 1-39
Instruct Place Tag 1-39
Index-6

Operation field (Steps tab) 15-19
Operator's Workspace 1-2
Operator's Workspace
  logging in 1-7
Operators Workspace Viewer 1-15
Outage Augmentation 1-17
Outage Correction 2-28
  user type 1-8
outages
  confirmed 2-21, 7-10
  momentary 1-49
Outages Summary 8-14
overlapping plans (Ops) 14-28
overlaps
  checking for 15-47
Overlaps indicator 15-8
Overlaps list
  updating 15-48
Overlaps tab 6-5, 15-6, 15-7, 15-47
Overload Limit Season 16-11
Owner (Request tab) 15-14
ownership 15-16
  taking or relinquishing 15-16

P
Pan Bars 1-18
  pan compass 6-26
Pan Control 1-23
  panning 6-36
Parameter Manager 11-8
Partial Restoration Log 2-14
Partition and Work Order Information 1-66
past steps 15-23
Patch Build Log 3-6
Patch Build Report 3-7
patches (model build) 3-1, 3-3
Peak Loads 16-15
Pending Actions 3-3
Pending Devices 1-35
pending devices 6-51
Pending Maps 3-3, 3-6
personnel
  removing from crew 2-36
Phase Operations 1-37
Phase Wire Down 1-46
phases
  operating 1-40
Phases field (Steps tab) 15-19
Pickup Counts 6-67
Place Ground 1-39
Place Safety Flag 1-39
Place Tag 1-39
placing tags 1-41
Placing Tags on Devices 1-41
Plan Details 16-16
Plan Implementation Steps 16-16
Plan Summary 16-16
Planned Date
  clearing 15-24
Planned Date (Steps tab) 15-19
planned switching (Ops) 14-17
Possible Fault Locations 19-4
Post-Completion Edit Log 2-16
Power Flow 16-1
  Full Resolve 16-6
  Resolve 16-6
  Study Mode Load Scenario 16-11
  updates 16-4
  with Look Ahead 16-7
Power Flow Real-Time Options 6-29
Power Flow Results 16-2, 16-4
Power Flow Status
  de-energized device 16-5
  non-converged 16-5
  power flow not solved
    data model error 16-5
    solution pending 16-5
solved 16-5
Power Transformer 16-8
P-P Cross Phase 1-48
P-P Jumper 1-48
Pre-Created Switching Sheets 15-11
Prediction 2-19
Preferences
  Viewer 1-30
Prepared state 15-16
Preprocessing 3-1
Preprocessor Log 3-6
printing switching sheets 15-37
Priority 2-50

R
RDBMS 3-1
Real-Time Mode 1-37
real-time mode 1-25, 15-3, 15-8
  starting or stopping 15-22
Reason for Exclusion 2-16
record mode 15-8, 15-20
Record Safety Dialog 14-21
recorded steps 15-27
recording emergency operations 15-59
Redliner Window 5-1
Region Summary 2-64
Release Temp Zone 2-32, 2-33
releasing crews 1-44
Reliability Indices Reports 12-14
Remedy 2-16
Remove Ground 1-39
Remove Safety Flag 1-39
Remove Tag 1-39
Removing a Ground from a Device 1-42, 6-57
removing devices 15-23
removing grounds 1-42
removing tags 1-41
Removing Tags from Devices 1-41
Repredict 6-53
Repredict Downstream 1-44
Repredict Upstream 1-44
Repredict Upstream/Downstream 1-44
Request List tab 14-16
Request Rejected state 15-16
Request tab 15-7, 15-13, 15-14
Requested By 15-14
Requested state 15-16
requesting switching sheets 15-13
Required Material 2-25, 7-18
Reset Operation Text 15-28
resetting study session 15-22
Restored 15-44
Restoring a Customer 7-11
restoring a customer 2-22
revisions 15-41, 15-49
rule sets 2-49, 7-41
safety documents 15-61
adding to steps 15-23, 15-63
completing 15-69
issuing 15-67
opening existing 15-68
releasing 15-68
types 15-61
safety documents dialog 15-64
Safety Documents tab 15-8, 15-63
SAIFI 12-22
SCADA Alarms List 6-79
SCADA Device Details 13-5
SCADA Measurements 13-2, 19-4
SCADA measurements
adding comments 1-58
manual entry and override 1-59
SCADA Summary 1-57, 6-75
SCADA symbology 6-44
Scale Factors 17-20
Scale Factors Table 17-6
Scaled Loads 16-11, 16-15
scheduling planned master events 15-35
Scheduled state 15-17
Schematics 1-34
schematics 1-34
Secondary Outages 1-44
Service Restoration 18-1
Service/Secondary Outage Manager 2-19
Setpoint 17-17
Sheet # field 15-47
Sheet Revision 15-51
Sheet State 15-51
silence alarms 6-82
silent mode 15-23
software" 1-2
Sort Dialog 6-11
sorting 6-12
user-defined 1-4
sorting data 1-3
sorting the switching sheet list 15-12
Sound Search 8-4
Source Voltage Change 16-16
SQL Window 1-61
SqlA 1-67
SqlX (Database Query) Window 1-61
SqlX Database Query 1-61
Start Date 15-15
Start Date (Impacted Customers) 15-48
state
changing switching sheet state 15-16
states
switching sheet 15-2
status bar 15-8
status codes A-1
Step# 15-19
steps
aborting 15-21
adding 15-24
adding after indicator 15-24
adding comment steps 15-28
adding from Control Tool 15-27
aggregate 15-32
comment 15-28
completing 15-21
copying 15-23
copying and pasting 15-28
copying as go-backs 15-23
cutting 15-23
deleting 15-23
delaying 15-33
grouping 15-24
grouping and ungrouping 15-31
instructing 15-21
marking as failed 15-21
mating 15-23
pre-assigning to crews 15-37
replaying 15-35
ungrouping 15-24
Steps tab 15-7, 15-18
Steps tab header 15-25
Street Light 2-50
Study Mode 1-37
study mode 1-25, 15-3, 15-8, 15-35
study session
starting 15-22
Study Session Parameters 16-7, 17-20
Submit Call 8-3
Subscribe 1-13, 6-10
SubStation 15-11
Substation 15-14, 17-5, 17-12
Substation Suggested Switching 16-8
Suggested Switching 6-28, 16-8
Scenarios 16-8
Feeder Unloading 16-8
Isolate and Restore 16-8
Isolate Only 16-8
Load Restore 16-8
Substation Switching 16-8
Using the Wizard 16-9
Summary windows 1-54
Supply Point Selection 1-17
Supply Points Mode 6-30
Supply Points View 2-60, 7-42, 7-46
suspend crew 7-39
sustained interruptions 12-22
Switch Sheet Editor (Ops) 14-4
switch sheet owner 15-16
Switching Management (Ops) 14-1
Switching Management tabs 15-7
Switching Operations
  user type 1-8
Switching Overlaps Window 14-28
switching plans (Ops) 14-2
  creating 14-17
  creating steps 14-19
  editing 14-21
  emailing 14-26
  emergency switching 14-31
  impacted customers 14-23
  implementing 14-29
  instructing and completing steps 14-29
  modes 14-3
  opening 14-18
  overlapping switching plans 14-28
  recording emergency steps 14-31
  states 14-2
  viewing areas 14-27
Switching Prep
  user type 1-8
  switching requests 14-12
  switching sheet
    locking 15-9
  switching sheets
    adding external documents 15-52
    changing state 15-16
    completing 15-38
    copy as 15-6, 15-57
    copying 15-57
    emailing 15-51
    emergency 15-58
    filtering the list 15-12
    implementing 15-35
    instructing 15-38
    issuing 15-36
    printing 15-37
    reviewing in study mode 15-35
    scheduling 15-35
    sorting the list 15-12
    states 15-2
    status 15-11
    step states 15-27
    types 15-2, 15-11
    versions 15-41
Symbology 6-41
symbology 1-27
  conductor 1-28
System Alarms List 6-79
Systems Alarm list 1-56

T
Tag Points Devices 15-64
Tag Summary 1-55
Tag/Flag 1-39
Tagging Devices 6-56
tagging devices 1-39, 6-56
taking ownership 15-15
Tap Step 17-17
target in viewer 15-20
  templates 15-2
    create a sheet from a template 15-13
    creating 15-13
  Tie Point Capacity Window 16-14
  Tiepoint Remaining Capacity 16-12
  Toggle Mobile Off 2-32
toolbox 1-10
Topology Model 1-65
Topology View 1-60
Topology View Window 1-64
Total Capacitors 17-18
Trace Dialog 1-31, 6-47
Tracking/Audit Log tab 15-8, 15-40, 15-50
Transformers Tap Change 16-16
Transformers Tab 17-17
trouble calls
  entering 2-50, 2-51
  Trouble Info 7-42, 15-26
  Trouble Information 2-55
  Trouble Information Window 2-55
  Trouble Maintenance 1-8
  Trouble Management 1-43
  Trouble Operations 1-8
  Trouble Summaries 2-63

U
Unassigned Callbacks 9-14
ungrouping steps 15-24, 15-31
unlink device from safety document 15-23
Unload Maps 1-17, 1-18
Unsubscribe 1-13, 6-10
Update Event 1-44
User Log 6-83
User Preferences 6-14
user types 1-8
user-defined sort 1-4
Using the SCADA Summary 13-3
Utility Error 2-15

V
Vegetation 2-15
vehicle
  removing from crew 2-36
vehicles
  searching 2-42
Version 15-19
version indicator 15-8
versioning 15-41
versions 15-9
view areas
  auto-loading 15-49, 15-50
  creating 1-72
  deleting 1-72
  loading 15-50
  reloading all marked for auto-load 15-50
  saving 15-49, 15-50
  saving and loading 15-49
View Areas tab 15-7
  View Areas Window 1-71
  View Areas Window 1-71
  View Call Pattern 1-43
View Conditions 6-68
View Only
  user type 1-8
Viewer
  displaying fault outages 19-6
  focusing on devices 15-35
  Operator's Workspace 1-11, 1-15
  Web Workspace 6-25
viewing areas 14-27
Viewing Attribute Information 1-66
Viewing Call Information 2-61
Viewing Device Attributes 1-46
Viewing Model Changes 1-65
Viewing the Device Operations List 1-53
Viewing the Systems Alarm List 1-56
Viewing Trouble Summaries 2-63
Violation 6-69, 17-16
Violations 17-21
violations 6-68
  viewing 6-68
Volt/Var Optimization 6-28, 16-14
Volt/Var Optimization 16-14
Voltage 15-15
Voltage Contrarians 16-16
Voltage Distribution on Affected Feeders 16-16
Voltage Setpoint 17-17

W
Warning Tag safety documents 15-62
Web Call Entry 8-1
Web Callbacks 9-1
Web DMS 17-2
Web Request 14-12
Web Workspace 6-1
What Tool Dialog Box 1-63
Work Agenda 1-43
Work Agenda Events List 15-36
Work Agenda Jobs Lists 15-56
Work Order Information 1-66

Z
  zoom slider 6-26
  zooming 6-36